XenApp and XenDesktop 7.8

May 06, 2016

What's new

Fixed issues in XenApp 7.8 and XenDesktop 7.8
Known issues
Features not in this release
Third party notices

System requirements

Technical overview

Concepts and components
Active Directory
Databases
Delivery methods
Reference Architectures
Design Guides
Implementation Guides

Install and configure

Prepare to install
Install using the graphical interface
Install using the command line
Install VDAs using scripts
Install Red Hat Linux VDAs
Install SUSE Linux VDAs
Create a Site
Create Machine Catalogs
Manage Machine Catalogs
Create Delivery Groups
Manage Delivery Groups
Remote PC Access
App-V
AppDisks
Local App Access and URL redirection
XenApp Secure Browser
Server VDI
Personal vDisk
Remove components

Upgrade and migrate
Upgrade a deployment
Migrate XenApp 6.x
Migrate XenDesktop 4

Secure
Security considerations and best practices
Delegated Administration
Smart cards
Transport Layer Security (TLS)
Getting Started with Citrix XenApp and XenDesktop Security

Print
Printing configuration example
Best practices, security considerations, and default operations
Printing policies and preferences
Provision printers
Maintain the printing environment

HDX
Thinwire Compatibility Mode
Framehawk virtual channel
HDX 3D Pro
Flash Redirection
Host to client redirection
GPU acceleration for Windows Desktop OS
GPU acceleration for Windows Server OS
OpenGL Software Accelerator
Audio features
Network traffic priorities
USB and client drive considerations

Policies

Work with policies
Policy templates
Create policies
Compare, prioritize, model, and troubleshoot policies
Default policy settings
Policy settings reference

Manage

Licensing
Zones
Connections and resources
Connection leasing
Virtual IP and virtual loopback
Delivery Controllers
Sessions
Use Search in Studio
Tags
IPv4/IPv6 support
Client folder redirection
User profiles
Citrix Insight Services

Monitor

Session Recording
Configuration Logging
Monitor Personal vDisks

Director

Advanced configuration
Monitor deployments
Alerts and notifications
Delegated Administration and Director
Secure Director deployment
Configure permissions for VDAs earlier than XenDesktop 7
Configure HDX Insight
Troubleshoot user issues

SDKs and APIs

Monitor Service OData API

FIPS Sample Deployments

Citrix SCOM Management Pack for XenApp and XenDesktop
Citrix SCOM Management Pack for License Server
What's new

Mar 23, 2016

In this article:

- About this release
- XenApp and XenDesktop 7.8
- Virtual Delivery Agents (VDAs) 7.8
- HDX Technologies
- Session Recording

About this release

The XenApp and XenDesktop 7.8 release comprises new Windows and Linux VDA versions along with new versions of several XenApp and XenDesktop core components. You can:

- **Install or upgrade a XenApp or XenDesktop Site**
  
  Use the ISO for this release to install or upgrade all the core components and VDAs. This allows you to use all of the latest features, summarized below. For instructions, see the [Prepare to install or Upgrade a deployment](https://docs.citrix.com) article.

- **Install or upgrade VDAs in an existing Site**
  
  If you have a XenApp or XenDesktop deployment, and aren't ready to upgrade your core components, you can still use several of the latest HDX and other features by installing (or upgrading to) a new VDA. This is often helpful when you want to test enhancements in a non-production environment. New and updated features in the VDAs are summarized below. For instructions, see the following articles:

  - [Install or upgrade VDAs using a graphical interface of the standalone VDA installer](https://docs.citrix.com)
  - [Install or upgrade VDAs from the command line interface of the standalone VDA installer](https://docs.citrix.com)

The XenApp and XenDesktop download pages for this release also include updated versions of the following software. For feature information and installation instructions, see the component's documentation.

- AppDNA
- StoreFront
- Provisioning Services
- Licensing

XenApp and XenDesktop 7.8

The product release includes the following new and enhanced features.

- **Secure Browser**

  Leverage the Lifecycle Management Blueprint for the XenApp Secure Browser to simplify the deployment. As part of
the XenApp Version 7.8 launch, all existing XenApp and XenDesktop customers with active Software Maintenance (SWM) or Subscription Advantage (SA) have access to the Deploy edition of Citrix Lifecycle Management.

For more information, refer to Deploying XenApp Secure Browser Edition.

- **AppDisks**

  The new AppDisks feature separates applications and groups of applications from a master image's OS, enabling you to manage them independently. You can now manage the applications as a distinct entity: an AppDisk.

  AppDisks differ from other application-provisioning technologies in two ways: isolation and change management. Unlike Microsoft App-V, an AppDisk does not isolate applications; it separates them. Change management (updating master images and testing the compatibility of updates with installed applications) can be a significant expense to organizations. Using AppDNA with AppDisks provides this change management capability. AppDNA identifies potential issues with image updates and suggests remediation steps.

  For more information, see the **AppDisks** article.

- **Enhanced support for Microsoft Application Virtualization (App-V)**

  You can now deliver Microsoft App-V applications to users without having to configure and manage Microsoft App-V management and publishing servers in Studio. Instead, you can import App-V packages directly from a network share to an Application Library held by Citrix Studio. App-V applications can be delivered through Delivery Groups to users from this library, just like other applications discovered from a master image or from Microsoft App-V servers, if you have them. The new "single admin" management method can be used instead of, or in addition to, the existing "dual admin" management method.

  For more information, see the **App-V** article.

- **Applications node in Studio**

  The new Applications node in the Studio navigation pane provides a central way to manage all of your applications, regardless of Delivery Group assignment. One of its key benefits is the ability to add applications to more than one Delivery Group at one time.

  In earlier releases, to manage applications, you selected a Delivery Group in the Studio navigation pane, and then selected the Applications tab in the middle pane. Now, you simply select Applications in the navigation pane.

  When you add an application to more than one Delivery Group, you can specify the priority of each Delivery Group (0 is the highest); XenApp or XenDesktop will attempt to launch the application from the highest-priority Delivery Group; if that is not possible, the application in the second-highest Delivery Group will be launched, and so on.

  The Add Application wizard offers a dropdown from which you select the source of applications: a machine created in the Machine Catalog, an App-V package, an application you have already added to the Site (perhaps in another Delivery Group), or a manually-defined application.

  For more information, see the **Manage applications** and **Create Delivery Groups** articles.

- **Updated Create Delivery Group wizard and Edit Delivery Group interface**

  In previous versions, the Create Delivery Group wizard included a page for specifying the delivery type (applications and desktops, applications only, or desktops only). In this version, the **Delivery Type** page is displayed only if you selected a...
Machine Catalog containing assigned desktop OS machines; in that case, you can specify whether the machines in that catalog will deliver desktops or applications. For all other machine types, the machines in the group can deliver applications and desktops. In some cases, you can change the delivery type later by editing the Delivery Group.

In previous versions, the Create Delivery Group wizard included a page for specifying a StoreFront address. In this version, the StoreFront page no longer appears in the Create Delivery Group wizard. It is assumed you will provide a StoreFront server address from the StoreFront node in Studio. You can also specify StoreFront information later by editing the Delivery Group.

The Applications page in the Create Delivery Group wizard now offers a new dropdown from which you select the source of applications you’re adding to the Delivery Group: a machine created in the Machine Catalog you selected, an App-V package, an application you have already added to the Site (perhaps in another Delivery Group), or a manually-defined application.

The Desktops (or Desktop Assignment Rules) page enables you to specify which users or groups can launch a VM, use a desktop, or have a desktop assigned. If the Delivery Group contains machines from a static assigned catalog, you can also specify the maximum number of desktops per user.

The Summary page now includes an optional description field that is displayed in Citrix Receiver. You can change this description later by editing the Delivery Group.

For more information, see the Create Delivery Groups and Manage applications articles.

- **Improved tag interface in Studio**

  Tags are strings that identify items such as machines, applications, Delivery Groups, and policies. After adding a tag to an item, you can tailor search queries and policy assignments to apply only to items that have a specified tag.

  In previous versions, one dialog box was available for adding and editing tags, and tags could be assigned only to policies. This version offers a more robust and easy-to-use interface, as well as wider applicability.

  For more information, see the Tags article.

- **Requirements, installation, and configuration updates**

  In addition to the following items, see the Virtual Delivery Agents (VDAs) section of this article for changes in the 7.8 VDAs and in the VDA installers.

  Internet Explorer version support for Citrix Director and the HDX Flash Redirection feature has been updated. Although you can use any of the versions noted in the System requirements article, Microsoft supports (and Citrix recommends using) version 11.

  For components with a Microsoft .NET Framework prerequisite, the installers will deploy .NET 4.5.2 if the machine has .NET Framework 4.5.1 or lower (or no .NET Framework) installed. This includes the Delivery Controller, Studio, Director, and VDAs.

  You can install a Delivery Controller, Studio, Director, and the Windows VDAs on servers running Windows Server 2016 Technology Preview; however, support is experimental and not for production use.

  The Site creation wizard has changed. The new Additional Features page lists items you can select to customize your Site. When you select the check box for an item that requires information, a configuration box appears. In earlier releases, App-V information was on a separate page in the Site creation wizard. AppDNA integration with AppDisks is
new in this release.

**AppDNA Integration:** If you will be using AppDisks and have installed AppDNA, enable this feature to allow analysis of applications and OSs, review compatibility issues, and then take remedial actions to resolve those issues. For more information, see the AppDisks article.

**App-V Publishing:** Enable this feature if you will use applications from packages on App-V servers. If you will use only applications from App-V packages on network share locations, you do not need to enable this feature. You can also enable/disable and configure this feature later in Studio. For more information, see the App-V article.

When creating a Machine Catalog that uses a master image on a hypervisor or cloud service provider, Studio provides an enhanced reminder to install a VDA on the image. If the VDA is omitted, the catalog creation fails after an often-lengthy interval.

- **Call Home**

  Citrix Call Home performs periodic collections of your system and product configuration, plus performance, error, and other information. This information is sent to Citrix Insight Services for proactive analysis and resolution.

  For details, see the Citrix Insight Services article.

- **Citrix Insight Services link available from within Director**

  You can access Citrix Insight Services (CIS) from the User drop-down in Director to access additional diagnostic insights. The data available in CIS comes from sources including Call Home and Citrix Scout.

- **VMware SSL thumbprint**

  The VMware SSL thumbprint feature addresses a frequently-reported error when creating a host connection to a VMware vSphere hypervisor. Previously, administrators had to manually create a trust relationship between the Delivery Controllers in the Site and the hypervisor's certificate before creating a connection. The VMware SSL thumbprint feature removes that manual requirement: the untrusted certificate's thumbprint is stored on the Site database so that the hypervisor can be continuously identified as trusted by XenApp and XenDesktop, even if not by the Controllers.

  When creating a vSphere host connection in Studio, a dialog box allows you to view the certificate of the machine you are connecting to. You can then choose whether to trust it.

**Virtual Delivery Agents (VDAs) 7.8**

Version 7.8 of the VDA for Server OS and the VDA for Desktop OS include the following enhancements:

- **Linux VDA version 1.2, with the following features and enhancements:**
  - HDX 3D Pro for Linux
  - Local printing support
  - HDX real time audio playback and input
  - Localization in Tier 1 and Tier 2 languages
  - **App-V and Framehawk installer options.** The VDA installers offer two additional items you can select on the Features page in the graphical interface or specify on the command line.
Framehawk. Opens UDP ports 3224-3324. Framehawk uses a bidirectional UDP port range (default is 3224-3324) to exchange Framehawk display channel data with Citrix Receiver. For more information, see [Framehawk virtual channel](#).

**Citrix App-V Publishing Components.** Installs components required if you will use applications from Microsoft App-V packages. For more information, see [App-V](#).

- **HDX 3D Pro product edition availability.** HDX 3D Pro is now available in the VDA for Windows Desktop OS and Linux VDAs in all XenApp 7.8 and XenDesktop 7.8 product editions. In earlier releases, only certain product editions supported the 3D Pro VDA. HDX 3D Pro is not currently supported on Windows 10.
- **KACD .MSI file included in VDA packages.** This file is included to support future customization of authentication. This file was not included with earlier releases.

### HDX technologies

The following new and enhanced HDX technologies features are included in the VDAs:

- **Framehawk support for HDX 3D Pro VDI.** HDX 3D Pro support for the Framehawk virtual channel is extended from XenApp to XenDesktop VDI. This gives users greater flexibility to view large CAD models while on the move on a corporate or public wireless network, or working from an offshore location over a high latency connection. For more information on Framehawk, see [Framehawk virtual channel](#).
- **Framehawk server scalability improvements.** Over 40% average reduction in memory footprint. Up to 20% increase in CPU efficiency.
- **Framehawk touch scrolling improvements.** Over 50% improvement in bandwidth efficiency when scrolling via touch input. Significantly increased frame rate resulting in a smoother user experience.
- **GPU acceleration for DirectX windowed applications on Windows 10 VDAs.** This release adds support for GPU acceleration for DirectX 10, 11 and 12 windowed applications on Windows 10 VDAs.
- **Thinwire Build to lossless enhancements.** The Build to lossless visual quality for Thinwire has been updated to sharpen fuzzy imagery at a faster rate than delivered in XenApp and XenDesktop 7.6 FP3, and to improve lossy or lossless frame detection. For the main Thinwire article, see [Thinwire Compatibility Mode](#).
- **Reduced VDA memory footprint in Thinwire.** The graphics encoder processing pipeline now eliminates the use of an intermediate frame buffer when running Thinwire without video codec compression.
- **Clientname passthrough in double-hop sessions.** Applications can use the updated WFAPI SDK to query the client endpoint name and pass this information from any Citrix Receiver to published desktops (XenApp/XenDesktop) and through to a XenApp application (a “double-hop”). This clientname awareness in the XenApp session means that users can seamlessly roam from location to location, and the “double-hop” application will be notified of the change in clientname without having to disconnect or reconnect the session. For more information on how to write conforming applications, see the [WFAPI SDK documentation](#) or defer to your application SI/ISV.

### Session Recording

Session Recording 7.8.0 includes support for Platinum XenApp 7.8 and XenDesktop 7.8. This support includes:

- Session recording support from a Desktop OS VDA. Record on-screen activity of a user session hosted from a Desktop OS VDA over any type of connection, subject to corporate policy and regulatory compliance.
- Record sessions on remote PC. Support for recording sessions in Remote PC Access.
- Delivery Group rules.
- Keyword filtering during rule configuration.
- Special handling for unsupported graphics modes.
- Windows 10 support.
- Thinwire Compatibility Mode support.

For more information, see the Session Recording articles.
Fixed issues in XenApp 7.8 and XenDesktop 7.8

The following issues have been fixed since Version 7.7:

Broker Agent

- Attempts to register a VDA set to a Turkish system locale can fail and produce a 1048 error.
  
  [#LC2704]

- If you add a file to a user device folder while the associated published application is running and then try to open the file from within the application, the file might not appear in the application's Open File Dialog - even after clicking the refresh button.

  [#LC4073]

- If the Site data store is unavailable, reconnection attempts can fail even if the Controller is in leased connection mode.

  [#LC4077]

Citrix Director

- When attempting to end a process running in a user session from Citrix Director, the following error message can appear:

  "Action failed. Data source unresponsive or reported an error. View server event logs for further information."

  [#LC4384]

Citrix Studio

- Applications that use App-V integration might not use the correct working directory.

  [#LC1623]

- This fix addresses a memory leak in Citrix Studio that occurs while running App-V app discovery.

  [#LC2559]

- Citrix Studio might become unresponsive while closing PowerShell resources.

  [#LC3612]

- Reports appear blank when you run the Policy Modeling wizard in Citrix Studio.

  [#LC3726]

- Attempts to publish an application in Citrix Studio 7.7 by using command line arguments that contain quotations (") might result in an error message.

  [#LC4525]
When executing Set-BrokerDBConnection and related commands, the associated configuration logging entries in Citrix Studio list the corresponding "Main Task" with a status of "In Progress," and the status is not updated when the task completes.

[#LC3479]

Group Policy Management

- The Citrix Policy processing might stop responding, which causes user sessions to become unresponsive. When this occurs, connection requests to Receiver and Remote Desktop (RDP) fail.

[#LA4969]

- When multiple users create policies in a multiple studio session, the latest policy created overwrites the earlier policy when Desktop Studio is refreshed.

[#LA5533]

- The Citrix Policy Engine might cause the server to become unresponsive. When this occurs, Citrix Receiver and RDP connection requests fail.

[#LC1817]

- With this enhancement, modeling reports created by the Citrix Group Policy Modeling wizard appear in Citrix Studio's middle pane - without the need to click "View Modeling Report."

[#LC2189]

- When running the Group Policy Modeling wizard on the policies node of AppCenter as a domain user, applied user and computer policies might not be visible.

[#LC3284]

- Reports appear blank when you run the Policy Modeling wizard in Citrix Studio.

[#LC3726]

Licensing

- Citrix Studio displays the licensing models in Spanish for license servers set to a French system locale.

[#LC3450]

PowerShell SDK

- Attempts to provision additional resources to a multi-tenant offering in App Orchestration 2.6 can fail if the offering already contains two or more tenants.

[#LC4170]

Session Recording

- Recordings of Microsoft Paint sessions do not play back correctly in the Session Recording Player.

[#604700]
An error occurs when you play back a session that was recorded on a multiple-monitor user device. [#6051290]

Session Recording does not support published applications named Desktop. Such applications cannot be added into the recording rules in the Policy Console. [#588707]

You might receive an **Installation failed** error in these two cases. You can ignore the message, but to avoid receiving the message, restart the machine before reinstalling the Session Recording components. [#544579]

- Uninstalled the Session Recording components, and then reinstalled them without restarting the machine.
- Installation failed and rollback happened, and then you tried to reinstall the Session Recording components without restarting the machine.

**Provisioning Services 7.8**

**StoreFront 3.5**

**VDA for Desktop OS**

- Under certain conditions, desktop sessions connecting through session reliability might experience loss of audio connectivity. [#LC1257]

- The Ctxgfx.exe process can become unresponsive. [#LC2410]

- If you are in a Citrix GoToMeeting running inside a VDA session and are made presenter, your mouse pointer might start to flicker. This occurs when the "Legacy graphics mode" policy setting is disabled for the session. [#LC3033]

- Attempts to install a VDA fail when the local users and remote desktop groups contain domain user objects. The issue does not occur if the local and remote desktop users group contains local or domain groups objects. [#LC3100]

- In VDA sessions for which you enable Local App Access, the screensaver fails to get activated. [#LC3182]

- The mouse cursor might not be visible in a HDX 3D Pro session when it is redirected using Generic USB Redirection.
The operating system experiences an error on picadmsys and a blue screen appears with stop code 0x20.

The Citrix Device Redirector service might fail to complete an I/O operation and the following error message appears in the Event Viewer:

"The Citrix Device Redirector service could not complete an I/O operation with Redirector Bus."

SSL connections (HTTPS) might not work properly in a VDA session.

When an administrator attempts to access a virtual machine from Hyper-V console, while there is a disconnected but active session, a black screen appears. The issue occurs in deployments that use XPDM drivers.

Attempts to restart the Citrix Device Redirector Service from within a VDA or RDP session can cause the service to remain in an unresponsive state rather than actually restarting.

A maximized published application window might cover the user device session's taskbar for session roaming from a device with a different display resolution.

The WFICA32.exe process might keep a file locked even after the file was closed by the associated published application. As a result, the file cannot be edited for a while.

A VDA might stop accepting connections. After enabling the "Legacy graphics mode" policy, the VDA starts accepting connections again.

Seamless applications can become unresponsive and their icon in the Windows taskbar reverts to the generic Citrix Receiver icon.

With the Citrix Windows XP Display Driver Model (XPDM) display driver enabled, the mouse shadow setting is always enabled even though it is disabled in the Control Panel.

When using Microsoft Internet Explorer on an HDX 3D Pro desktop, the mouse cursor does not revert from the "Horizontal resize" to the "Normal" shape when you move the cursor back inside the window from the left edge position.
- A deadlock on picadm.sys can cause published applications to become unresponsive.
- With Excelhook enabled, minimizing and then restoring an Excel workbook can cause the Excel window to lose focus.
- The operating system experiences an error on picadm.sys and a blue screen appears with stop code 0x50.
- In HDX 3D Pro dual-monitor configurations, locking Windows on one monitor can fail to blank the screen on the second monitor. The issue occurs after disconnecting from a dual-monitor client session, then reconnecting from a single monitor client, then disconnecting from the session, then reconnecting from the dual-monitor client.
- Attempts to use the attrib command to change file attributes of files on mapped client drives might fail.
- When you close a seamless published application, the focus goes to another published application rather than honoring windows in the typical Windows Z-order.
- After upgrading a VDA for Desktop OS to Version 7.6.300, the VDA can experience a fatal exception, displaying a blue screen when users log in.
- After upgrading a VDA for Desktop or Server OS to Version 7.6.300, the Citrix Print Manager Service (CpSvc.exe) can exit unexpectedly upon logoff.
- For users with non-persistent profiles, published App-V applications can take an excessive amount of time to launch on machines with PowerShell 3.0 or later installed.
- The mouse pointer might not assume the proper shape when the mouse is positioned at the edge of a Microsoft Notepad application window.

To enable this fix, you must set the following registry key:

- **On 32-bit Windows:**
  - HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\HDX3D
  - Name: EnableUnknownCursorHandling
  - Type: REG_DWORD
  - Value: 1
- **On 64-bit Windows.**
  HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\HDX3D
  Name: EnableUnknownCursorHandling
  Type: REG_DWORD
  Value: 1
  [#LC4160]

- The VDA might become unresponsive at the "Welcome" screen due to a deadlock on picadmsys.
  [#LC4195]

- VDAs can experience a fatal exception, displaying a blue screen, on picadd.sys.
  [#LC4207]

- With Generic USB Redirection enabled, each time a generic redirected USB device is physically disconnected and reconnected within a session, it is treated as a new device. As a result, each time you reconnect such a USB device, an additional GUID is created for it.
  [#LC4259]

- Attempts to resize the session screen resolution can fail intermittently, leaving the DesktopViewer window grayed out.
  [#LC4261]

- The operating system experiences an error on picadmsys and a blue screen appears with stop code 0x000000C1.
  [#LC4334]

- With Local App Access enabled, clicking an application shortcut after reconnecting to a disconnected session can fail to start the associated application.
  [#LC4362]

### VDA for Server OS

- Attempts to install a VDA fail when the local users and remote desktop groups contain domain user objects. The issue does not occur if the local and remote desktop users group contains local or domain groups objects.
  [#LC3100]

- If you are in a Citrix GoToMeeting running inside a VDA session and are made presenter, your mouse pointer might start to flicker. This occurs when the "Legacy graphics mode" policy setting is disabled for the session.
  [#LC3033]

- When reading a file from a mapped client drive, the old, cached file length might be returned if the file length was changed outside of the client session.

  To enable the fix, set the following registry value to "0":

  HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\picadm\Parameters
  Name: CacheTimeout
  Type: REG_DWORD
Value: Default value is 60 seconds. If CacheTimeOut is set to "0," the file length is reloaded immediately and if not it is loaded after the defined timeout.

[#LC3167]

- In VDA sessions for which you enable Local App Access, the screensaver fails to get activated.
  
  [#LC3182]

- This enhancement removes the requirement from the Shadow Taskbar (cshadow.exe) to authenticate to a primary domain controller. With this fix, the taskbar queries regular domain controllers.
  
  [#LC3381]

- The operating system experiences an error on picadmsys and a blue screen appears with stop code 0x20.
  
  [#LC3473]

- The Citrix Device Redirector service might fail to complete an I/O operation and the following error message appears in the Event Viewer:

  "The Citrix Device Redirector service could not complete an IO operation with Redirector Bus."
  
  [#LC3497]

- SSL connections (HTTPS) might not work properly in a VDA session.
  
  [#LC3535]

- Attempts to restart the Citrix Device Redirector Service from within a VDA or RDP session can cause the service to remain in an unresponsive state rather than actually restarting.
  
  [#LC3544]

- Servers can experience a fatal exception on picadmsys with bugcheck code 0x20.
  
  [#LC3564]

- A maximized published application window might cover the user device session's taskbar for session roaming from a device with a different display resolution.
  
  [#LC3671]

- The WFICA32.exe process might keep a file locked even after the file was closed by the associated published application. As a result, the file cannot be edited for a while.
  
  [#LC3724]

- Seamless applications can become unresponsive and their icon in the Windows taskbar reverts to the generic Citrix Receiver icon.
  
  [#LC3783]

- The mouse pointer might not assume the proper contextual shape when moving it inside a third-party CAD application.
A deadlock on picadm.sys can cause published applications to become unresponsive.

With Excelhook enabled, minimizing and then restoring an Excel workbook can cause the Excel window to lose focus.

Attempts to append data to files on a mapped client drive might fail when the files are opened by users with write-only permissions. The issue occurs when running the PowerShell command "get-process | out-file -filepath "\client\c$\temp\proclist.txt" -Append" for the second time.

The operating system experiences an error on picadm.sys and a blue screen appears with stop code 0x50.

Attempts to use the attrib command to change file attributes of files on mapped client drives might fail.

When you close a seamless published application, the focus goes to another published application rather than honoring windows in the typical Windows Z-order.

After upgrading a VDA for Desktop OS to Version 7.6.300, the VDA can experience a fatal exception, displaying a blue screen when users log in.

After upgrading a VDA for Desktop or Server OS to Version 7.6.300, the Citrix Print Manager Service (CpSvc.exe) can exit unexpectedly upon logoff.

On servers with XenApp 6.5 Hotfix Rollup Pack 6 installed, certain third-party applications might fail to start in an RDP session.

For users with non-persistent profiles, published App-V applications can take an excessive amount of time to launch on machines with PowerShell 3.0 or later installed.

The VDA might become unresponsive at the "Welcome" screen due to a deadlock on picadm.sys.

VDAs can experience a fatal exception, displaying a blue screen, on picadd.sys.
With USB Redirection enabled, each time certain redirected USB devices are disconnected and reconnected within a session, they are treated as new devices. As a result, each time you reconnect such a USB device, an additional GUID is created for it.

COM port mapping can fail intermittently after upgrading to Version 7.6.300 of the VDA for Server OS.

The operating system experiences an error on picadmsys and a blue screen appears with stop code 0x000000C1.

With Local App Access enabled, clicking an application shortcut after reconnecting to a disconnected session can fail to start the associated application.

After installing Microsoft Hotfix KB3124266 (for Windows 10) or KB3124263 (for Windows 10 Version 1511), attempts to log on to a XenDesktop VDA 7.6.300 or 7.7 running on Windows 10 might fail. For more information see, Knowledge Center article CTX205398.

**Note:** If you have already installed KB3124266 or KB3124263 and want to apply this update, do the following:

1. Reboot and log in to the Windows 10 machine using Safe Mode and uninstall KB3124266 or KB3124263
2. Reboot the Windows 10 machine and install this update.
3. Reinstall KB3124266 or KB3124263.
Known issues

Aug 11, 2016

The following caution applies to any workaround that suggests changing a registry entry.

**Caution:** Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

XenApp and XenDesktop

The XenApp 7.8 and XenDesktop 7.8 release contains the following issues:

- Using the mouse wheel to scroll and click inside a Framehawk session may not produce the expected results. Current workaround is to use different mouse. [#618657]
- The AppDisk sealing process can take excessive time and CPU use, because a driver reads every file's metadata, which causes the virus checker to check every bit on the disk. To avoid this, before starting the sealing process, add CtxPvD.exe and CtxPvDSvc.exe to the exclusion list of your antivirus program. These files are located in `c:\Program Files\Citrix\personal vDisk\bin`. Disabling your antivirus program is not recommended. [#602819]
- Creating or deleting AppDisks in a VMware virtualization environment may fail if the VMware user account has permissions set at only the DataCenter level. As a workaround, ensure that the VMware user account has at least an empty role (that is, with no privileges) assigned at the vCenter level. If this is done, the required permissions may still be set at the DataCenter level [625416]
- Browser add-ons for Local App Access and URL redirection cannot be enabled using NPAPI interfaces for Firefox and Chrome, as noted in the linked software support articles. This is a known issue and customers are encouraged to use Internet Explorer as a workaround. [#620101]
- Screen corruption can occur when connected to a high resolution monitor (e.g. 4096 x 2160) using the VDA for Windows Desktop OS on Windows 7 with Aero enabled but without graphics hardware acceleration (GPU). To work around this issue, change the desktop theme to a non-Aero theme or reduce the resolution. [#618121]
- If you are enrolled in Call Home, and your Controller, StoreFront, and VDA are installed on the same server, uninstalling any one of those components will likely also remove the Call Home component from that server. Workaround: re-enroll in Call Home. [#616142]
- After upgrading from version 7.5 (or from 7.6 if that was an upgrade from 7.5), Studio or the High Level SDK may fail to start because the file FMAUtils.dll failed to install. The Site upgrade failure includes the message: “Could not load file or assembly 'FMAUtils, Version ... The system cannot find the file specified.” Workaround: Complete a repair install of the Studio MSI ([XDInstallerRoot]\x64\DesktopStudio\DesktopStudio_x64.msi) or High Level SDK MSI ([XDInstallerRoot]\x64\Citrix Desktop Delivery Controller\XDPoshSnapin.msi). [#617897]
- When publishing with App-V, applications with names containing an underscore (_) might not launch. [#618488]
- During Site creation, if you import licenses to the local machine, they may not display (this issue does not occur if you already imported licenses to an external machine). If this happens, complete the Site creation. In Studio, check Configuration > Licensing to ensure your product edition is properly set (the default is Platinum). The imported licenses will appear within approximately five minutes. [#618538]
- If you remove a Controller from a Site, a later attempt to move a Machine Catalog to a different zone might fail. Workaround: Use the Set-BrokerHypervisorConnection -PreferredController cmdlet and specify either a null value to trigger the automatic election of a preferred Controller (Get-BrokerHypervisorConnection -PreferredController $null | Set-BrokerHypervisorConnection -PreferredController $null), or a specific Controller. [#619345]
- If you created tags for applications in a previous version, they will not be visible in Studio after you upgrade to this version. (Those tags were originally stored in application metadata rather than as tag objects.) However, if you have scripts that use those tags, the tags will still work in the scripts. [#620041]
- When a XenDesktop Site is in leased connection mode, if provisioned resources have been rebooted, users cannot establish a session to these resources until the Site comes out of leased connection mode (until the Controller is able to reach the Site database again). [#621521]
- After a Site returns to normal operations after being in leased connection mode (due to Site database unavailability), Studio may continue to show VMs in an 'unknown' state and host connections in an 'unavailable' state. Workaround: Turn on maintenance mode for the affected connections, wait approximately 30 seconds, and then turn maintenance mode off. This will restore the correct state displays and available power actions. [#620941]
- This issue affects only machines on VMware hypervisors. When deleting machines from a Delivery Group that had AppDisks attached, the AppDisk may be deleted from the hypervisor storage when the last machine is deleted from the hypervisor. This occurs only when AppDisks...
remain attached to the machine when the machine is deleted. To avoid this, complete the following tasks from Studio to ensure that the AppDisks are not attached to the last machine to be deleted.

1. Delete all but the last machine from the Machine Catalog (and then manually delete the corresponding VMs if using Provisioning Services).
2. Power on the last machine. (Be sure to do this from Studio, not from the hypervisor.)
3. Shut down the last machine.
4. Delete the last machine (and then manually delete the corresponding VM if using Provisioning Services).

[#621002]

**Windows Server 2016 Tech Preview**

You can access a list of issues identified when using this XenApp and XenDesktop release with Windows Server 2016 Tech Preview in the [Windows Server 2016 Tech Preview forum](https://docs.citrix.com) (Citrix account logon required).

**Other components**

Components available separately on the XenApp and XenDesktop download pages have the following known issues.

**Session Recording**

- The installation of the Session Recording Server components fails with error codes 2503 and 2502. Resolution: Check the access control list (ACL) of folder C:\windows\Temp to ensure the Local Users and Groups > Groups > Users has write permission for this folder. If not, manually add write permission. [#611487]
- Because Session Recording does not support Framehawk display mode, sessions in Framehawk display mode cannot be recorded and played back correctly. Sessions recorded in that mode might not contain the sessions activities. [#622085]
- The rollover setting does not apply to VDI desktop sessions for XenDesktop 7.8 and Session Recording Agent. In those cases, each recording file has a maximum size limit of 1GB and activities are not recorded after that limit is reached. [#584890]
- When Machine Creation Services (MCS) or Provisioning Services creates multiple VDAs with configured master image and Microsoft Message Queuing (MSMQ) installed, those VDAs have the same QMId. This might cause various issues, such as:
  - Sessions might not be recorded even if the recording agreement is accepted.
  - The session logoff signal might not be received by the Session Recording server, which leads to the session always in Live status. [#528678]

The workaround to create a unique and persistent QMId for each VDA differs depending on the deploy methods.

No extra actions are required if Desktop OS VDAs with the Session Recording agent installed will be created with PVS 7.7 or newer in static desktop mode; for example, configured to make all changes persistent with a separate Personal vDisk or local disk of the VDA.

For Server OS VDAs created by MCS or PVS or dedicated Desktop OS VDAs created by MCS in static desktop
mode, for example, configured to make all changes persistent with a separate Personal vDisk or local disk of VDA, use a script (GenQMID.ps1) to modify the QMId at system startup.

For Desktop OS VDAs created by MCS or PVS and configured to discard all changes when user logs off, use another script (GenRandomQMID.ps1) to modify the QMId at system startup. Modify power management strategy to ensure that enough VDAs are running before users' login attempts.

To use the script, do the following:

1. Make sure the execution policy is set to RemoteSigned or Unrestricted, in PowerShell.

   ```powershell
   Set-ExecutionPolicy RemoteSigned
   ```

2. Create a scheduled task and set the trigger as At system startup and run with SYSTEM account on the Provisioning Services or MCS master image machine.

3. Add the command as a startup task.

   ```powershell
   powershell.exe -file C:\GenQMID.ps1
   OR
   powershell .exe -file C:\GenRandomQMID.ps1
   ```

**Summary of the GenQMID.ps1:**

1. Generate the QMId based on the hash value of the machine UUID.
2. Stop related services, including CitrixSmAudAgent and MSMQ.
3. Start services that stopped previously to apply QMId's change.

```powershell
function ConvertHexStringToByte($theString)
{
    $bytes = New-Object Byte[] ($theString.Length / 2)
    for ($i = 0; $i -lt $theString.Length; $i += 2) {
        $bytes[$i / 2] = [System.Convert]:ToByte($theString.Substring($i, 2), 16)
    }
    return $bytes
}
```

Try {

```powershell
GENQMID.PS1 FOR REFERENCE
COPY
```
# Get UUID of machine

$strUUID = (Get-WmiObject -Class Win32_ComputerSystemProduct | Select-Object -Property UUID).UUID

# Remove "-"

$strUUID = $strUUID.ToString().Replace("-", "")

# Convert string to bytes

$UUID = ConvertHexStringToByte($strUUID)

# Set UUID as QMId

$new_QMID = $UUID

}

Catch {

# IF exception occurred, just use MD5 digest of FQDN as QMID

# Get FQDN

$fqdn = [System.Net.Dns]:.GetHostBy_Name(($env:computerName)).HostName

# Calculate MD5 hash of FQDN

$md5 = new-object -TypeName System.Security.Cryptography.MD5CryptoServiceProvider

# Set md5 digest as QMID

$utf8 = new-object -TypeName System.Text.UTF8Encoding
$new_QMID = $md5.ComputeHash($utf8.GetBytes($fqdn))

} # Write new_QMID into registry

Set-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters\MachineCache -Name "QMId" -Value $new_QMID

# Restart MSMQ to adopt new QMId

# Get dependent services

$depServices = Get-Service -name MSMQ -dependentservices | Select -Property Name

Restart-Service -force MSMQ

# Start dependent services

if ($depServices -ne $null) {

t foreach ($depService in $depServices) {

    $startMode = Get-WmiObject win32_service -filter "NAME = '$($depService.Name)'" | Select -Property StartMode

    if ($startMode.StartMode -eq "Auto") {

        Start-Service $depService.Name

    }

} # Summary of the GenRandomQMID.ps1:
1. Remove current QMId from registry.
2. Add SysPrep = 1 in HKLM\Software\Microsoft\MSMQ\Parameters.
3. Stop related services, including CitrixSmAudAgent and MSMQ.
4. Start services that stopped previously to generate a random QMId.

GENRANDOMQMID.PS1 for reference

```powershell
# Remove old QMId from registry and set SysPrep flag for MSMQ
Remove-Itemproperty -Path HKLM:Software\Microsoft\MSMQ\Parameters\MachineCache -Name QMId -Force
Set-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters -Name "SysPrep" -Type DWord -Value 1

# Get dependent services
$depServices = Get-Service -name MSMQ -dependentservices | Select -Property Name

# Restart MSMQ to get a new QMId
Restart-Service -force MSMQ

# Start dependent services
if ($depServices -ne $null) {
    foreach ($depService in $depServices) {
        $startMode = Get-WmiObject win32_service -filter "NAME = '$($depService.Name)'" | Select -Property StartMode
        if ($startMode.StartMode -eq "Auto") {
            Start-Service $depService.Name
        }
    }
}
```

When recording a session with a resolution higher than or equal to 4096 x 4096, there might be fragments in the recording appearance. [#524973]

When you change your XenApp or XenDesktop license type, the change does not take effect immediately for Session Recording. Workaround: Restart the VDA machine. [#532393]

Limitation for Session Recording to support the Pre-Launched application sessions [#561109]

Problem:
- If the active policy tries to match the application name, the application launched in the pre-launched session will not be matched, which results in the session not being recorded.
- If the active policy records every application, when the user logs into the Windows Receiver (at the same time the pre-launched session is established) a notification for recording will appear and the empty session and any applications that will be launched in this session later will be recorded.

Workaround:
- Publish the applications in separate Delivery Groups according to their recording policy. Do not use the application name as the recording condition. This will ensure pre-launch sessions will be recorded. However, notifications will still appear.
Features not in this release

Feb 24, 2016

Tip: If your most recent experience is with XenApp 6.5 (or earlier XenApp releases), you should also review the architectural, terminology, and element differences described here.

The following features are not currently provided or are no longer supported.

- **Launch touch-optimized desktop** - This setting has been disabled for Windows 10 machines. For more information, see Mobile experience policy settings.
- **Secure ICA encryption below 128-bit** - In releases earlier than 7.x, Secure ICA could encrypt client connections for basic, 40-bit, 56-bit, and 128-bit encryption. In 7.x releases, Secure ICA encryption is available only for 128-bit encryption.
- **Legacy printing** - The following printing features are not supported in 7.x releases:
  - Backward compatibility for DOS clients and 16-bit printers, including legacy client printer name.
  - Support for printers connected to Windows 95 and Windows NT operating systems, including enhanced extended printer properties and Win32FavorRetainedSetting.
  - Ability to enable or disable auto-retained and auto-restored printers.
  - DefaultPrtmFlg, a registry setting for servers that is used to enable or disable auto-retained and auto-restored printers, which store in user profiles on the server.
- **Secure Gateway** - In releases earlier than 7.x, Secure Gateway was an option to provide secure connections between the server and user devices. NetScaler Gateway is the replacement option for securing external connections.
- **Shadowing users** - In releases earlier than 7.x, administrators set policies to control user-to-user shadowing. In 7.x releases, shadowing end-users is an integrated feature of the Director component, which uses Windows Remote Assistance to allow administrators to shadow and troubleshoot issues for delivered seamless applications and virtual desktops.
- **Power and Capacity Management** - In releases earlier than 7.x, the Power and Capacity Management feature could be used to help reduce power consumption and manage server capacity. The Microsoft Configuration Manager is the replacement tool for this function.
- **Flash v1 Redirection** - Clients that do not support second generation Flash Redirection (including Citrix Receiver for Windows earlier than 3.0, Citrix Receiver for Linux earlier than 11.100, and Citrix Online Plug-in 12.1) will fall back to server-side rendering for legacy Flash Redirection features. VDAs included with 7.x releases support second generation Flash Redirection features.
- **Local Text Echo** - This feature was used with earlier Windows application technologies to accelerate the display of input text on user devices on high latency connections. It is not included in 7.x releases due to improvements to the graphics subsystem and HDX SuperCodec.
- **Smart Auditor** - In releases earlier than 7.x, Smart Auditor allowed you to record on-screen activity of a user's session. Beginning with 7.6 Feature Pack 1, this functionality is provided by Session Recording.
- **Single Sign-on** - This feature, which provides password security, is not supported for Windows 8 and Windows Server 2012 environments. It is still supported for Windows 2008 R2 and Windows 7 environments, but is not included with 7.x releases. You can locate it on the Citrix download website: http://citrix.com/downloads.
- **Oracle database support** - 7.x releases require a SQL Server database.
- **Health Monitoring and Recovery (HMR)** - In releases earlier than 7.x, HMR could run tests on the servers in a server farm to monitor their state and discover any health risks. In 7.x releases, Director offers a centralized view of system health by presenting monitoring and alerting for the entire infrastructure from within the Director console.
- **Custom ICA files** - Custom ICA files were used to enable direct connection from user devices (with the ICA file) to a specific machine. In 7.x releases, this feature is disabled by default, but can be enabled for normal usage using a local...
group or can be used in high-availability mode if the Controller becomes unavailable.

- **Management Pack for System Center Operations Manager (SCOM) 2007** - The management pack, which monitored the activity of farms using SCOM, does not support 7.x releases.

- **CNAME function** - The CNAME function was enabled by default in releases earlier than 7.x. Deployments depending on CNAME records for FQDN rerouting and the use of NETBIOS names might fail. In 7.x releases, Delivery Controller auto-update is the replacement feature that dynamically updates the list of Controllers and automatically notifies VDAs when Controllers are added to and removed from the Site. The Controller auto-update feature is enabled by default in Citrix policies, but can be disabled by creating a policy. Alternatively, you can re-enable the CNAME function in the registry to continue with your existing deployment and allow FQDN rerouting and the use of NETBIOS names. For more information, see CTX137960.

- **Quick Deploy wizard** - In Studio releases earlier than 7.x, this option allowed a fast deployment of a fully installed XenDesktop deployment. The new simplified installation and configuration workflow in 7.x releases eliminates the need for the Quick Deploy wizard option.

- **Remote PC Service configuration file and PowerShell script for automatic administration** - Remote PC is now integrated into Studio and the Controller.

- **Workflow Studio** - In releases earlier than 7.x, Workflow Studio was the graphical interface for workflow composition for XenDesktop. The feature is not supported in 7.x releases.

- **Color depth** - In Studio releases earlier than 7.6, you specified color depth in a Delivery Group's User Settings. Beginning in version 7.6, color depth for the Delivery Group can be set using the New-BrokerDesktopGroup or Set-BrokerDesktopGroup PowerShell cmdlet.

- **Launching of non-published programs during client connection** - In releases earlier than 7.x, this Citrix policy setting specified whether to launch initial applications or published applications through ICA or RDP on the server. In 7.x releases, this setting specifies only whether to launch initial applications or published applications through RDP on the server.

- **Desktop launches** - In releases earlier than 7.x, this Citrix policy setting specified whether non-administrative users can connect to a desktop session. In 7.x releases, non-administrative users must be in a VDA machine's Direct Access Users group to connect to sessions on that VDA. The **Desktop launches** setting enables non-administrative users in a VDA's Direct Access Users group to connect to the VDA using an ICA connection. The **Desktop launches** setting has no effect on RDP connections; users an VDA's Direct Access Users group can connect to the VDA using an RDP connection whether or not this setting is enabled.

Features not in Citrix Receiver or that have different default values

- **COM Port Mapping** — COM Port Mapping allowed or prevented access to COM ports on the user device. COM Port Mapping was previously enabled by default. In 7.x releases of XenDesktop and XenApp, COM Port Mapping is disabled by default. For details, see Configure COM Port and LPT Port Redirection settings using the registry.

- **LPT Port Mapping** — LPT Port Mapping controls the access of legacy applications to LPT ports. LPT Port Mapping was previously enabled by default. In 7.x releases, LPT Port Mapping is disabled by default.

- **PCM Audio Codec** — Only HTML5 clients support the PCM Audio Codec in 7.x releases.

- **Support for Microsoft ActiveSync.**

- **Proxy Support for Older Versions** — This includes:
  - Oracle iPlanet Proxy Server 4.0.14 (Windows Server 2003)
  - Squid Proxy Server 3.1.14 (Ubuntu Linux Server 11.10)
Third party notices

Mar 23, 2016
This release of XenApp and XenDesktop may include third party software licensed under the terms defined in the following documents:

- XenApp 7.8 and XenDesktop 7.8 Third Party Notices
- FLEXnet Publisher Documentation Supplement: Third Party and Open Source Software used in FlexNet Publisher 11.13.1
- Linux Virtual Desktop Version 1.2 Third Party Notices
System requirements

Sep 14, 2016
In this article:

- Delivery Controller
- Databases
- Citrix Studio
- Citrix Director
- Virtual Delivery Agent (VDA) for Desktop OS
- Virtual Delivery Agent (VDA) for Server OS
- Hosts / virtualization resources
- Active Directory functional levels
- HDX
- Session Recording
- Universal Print Server
- Other

Introduction

The system requirements in this document were valid when this product version released; updates are made periodically. System requirements components not covered here (such as StoreFront, host systems, Citrix Receivers and plug-ins, and Provisioning Services) are described in their respective documentation.

**Important:** Review [Prepare to install](#) before beginning an installation.

Unless otherwise noted, the component installer deploys software prerequisites automatically (such as .NET and C++ packages) if the required versions are not detected on the machine. The Citrix installation media also contains some of this prerequisite software.

The installation media contains several third-party components. Before using the Citrix software, check for security updates from the third party, and install them.

The disk space values are estimates only, and are in addition to space needed for the product image, operating system, and other software.

If you install all the core components (Controller with SQL Server Express, Studio, Director, StoreFront, and Licensing) on a single server, you need a minimum of 4 GB of RAM to evaluate the product; more is recommended when running an environment for users. Performance will vary depending on your exact configuration, including the number of users, applications, desktops, and other factors.

For globalization information, see [CTX119253](#).

Delivery Controller

Supported operating systems:
Windows Server 2016 current Technology Preview: Support for this operating system in this release is experimental and not for production use
Windows Server 2012 R2, Standard and Datacenter Editions
Windows Server 2012, Standard and Datacenter Editions
Windows Server 2008 R2 SP1, Standard, Enterprise, and Datacenter Editions

Requirements:

- Microsoft .NET Framework 3.5.1 (Windows Server 2008 R2 only).
- Microsoft .NET Framework 4.5.2 (4.6 is also supported).
- Windows PowerShell 2.0 (included with Windows Server 2008 R2) or 3.0 (included with Windows Server 2016 TechnologyPreview, Windows Server 2012 R2 and Windows Server 2012).
- Visual C++ 2008 SP1 Redistributable package.
- Disk space: 100 MB.

The use of optional features increases disk space requirements. For example, the amount of space for connection leasing (which is enabled by default) depends on the number of users, applications, and the mode: 100,000 RDS users with 100 recently-used applications require approximately 3 GB for connection leases; deployments with more applications may require more space. For dedicated VDI desktops, 40,000 desktops require at least 400-500 MB. In any instance, Citrix suggests providing several GBs of additional space.

Databases

Supported Microsoft SQL Server versions for the Site Configuration, Configuration Logging, and Monitoring databases:

- SQL Server 2016, Express, Standard, and Enterprise Editions.
- SQL Server 2014 through SP2, Express, Standard, and Enterprise Editions.
- SQL Server 2012 through SP3, Express, Standard, and Enterprise Editions. By default, SQL Server 2012 SP2 Express is installed when installing the Controller, if an existing supported SQL Server installation is not detected.
- SQL Server 2008 R2 SP2 and SP3, Express, Standard, Enterprise, and Datacenter Editions.

The following database features are supported (except for SQL Server Express, which supports only standalone mode):

- SQL Server Clustered Instances
- SQL Server Mirroring
- SQL Server 2012 AlwaysOn Availability Groups

Windows authentication is required for connections between the Controller and the SQL Server database.

For more information, see the Databases article and CTX114501.

Citrix Studio

Supported operating systems:

- Windows 10, Professional, Enterprise, and Educational Editions
- Windows 8.1, Professional and Enterprise Editions
- Windows 8, Professional and Enterprise Editions
- Windows 7 Professional, Enterprise, and Ultimate Editions
- Windows Server 2016 current Technology Preview: Support in this release is experimental and not for production use
- Windows Server 2012 R2, Standard and Datacenter Editions
- Windows Server 2012, Standard and Datacenter Editions
- Windows Server 2008 R2 SP1, Standard, Enterprise, and Datacenter Editions

Requirements:

- Disk space: 75 MB
- Microsoft .NET Framework 4.5.2 (4.6 is also supported)
- Microsoft .NET Framework 3.5 SP1 (Windows Server 2008 R2 and Windows 7 only)
- Microsoft Management Console 3.0 (included with all supported operating systems)

**Citrix Director**

Supported operating systems:

- Windows Server 2016 current Technology Preview: Support in this release is experimental and not for production use
- Windows Server 2012 R2, Standard and Datacenter Editions
- Windows Server 2012, Standard and Datacenter Editions
- Windows Server 2008 R2 SP1, Standard, Enterprise, and Datacenter Editions

Requirements:

- Disk space: 140 MB.
- Microsoft .NET Framework 4.5.2 (4.6 is also supported).
- Microsoft .NET Framework 3.5 SP1 (Windows Server 2008 R2 only)
- Microsoft Internet Information Services (IIS) 7.0 and ASP.NET 2.0. Ensure that the IIS server role has the Static Content role service installed. If these are not already installed, you are prompted for the Windows Server installation media, then they are installed for you.

System Center Operations Manager (SCOM) integration requirements:

- Windows Server 2012 R2
- System Center 2012 R2 Operations Manager

Supported browsers for viewing Director:

- Internet Explorer 11. You can use Internet Explorer 10, but Microsoft supports (and Citrix recommends using) version 11. Compatibility mode is not supported for Internet Explorer. You must use the recommended browser settings to access Director. When you install Internet Explorer, accept the default to use the recommended security and compatibility settings. If you already installed the browser and chose not to use the recommended settings, go to Tools > Internet Options > Advanced > Reset and follow the instructions.
- Microsoft Edge.
- Firefox ESR (Extended Support Release).
- Chrome.
Virtual Delivery Agent (VDA) for Desktop OS

Supported operating systems:

- Window 10, Professional, Enterprise, and Educational Editions. (The following features are not supported on Windows 10: HDX 3D Pro, GPU acceleration, Desktop composition redirection, Legacy graphics mode, Secure boot, Publishing universal Windows apps using VM hosted apps)
- Windows 8.1, Professional and Enterprise Editions
- Windows 8, Professional and Enterprise Editions
- Windows 7 SP1, Professional, Enterprise, and Ultimate Editions

To use the Server VDI feature, you can use the command line interface to install a VDA for Windows Desktop OS on a supported server operating system; see the Server VDI article for guidance.

- Windows Server 2016 current Technology Preview: Support in this release is experimental and not for production use
- Windows Server 2012 R2, Standard and Datacenter Editions
- Windows Server 2012, Standard and Datacenter Editions
- Windows Server 2008 R2 SP1, Standard, Enterprise, and Datacenter Editions

Requirements:

- Microsoft .NET Framework 4.5.2 (4.6 is also supported)
- Microsoft .NET Framework 3.5.1 (Windows 7 only)
- Microsoft Visual C++ 2008 SP1, 2010 SP1, and 2013 Runtimes (32-bit and 64-bit)

Remote PC Access uses this VDA, which you install on physical office PCs.

Several multimedia acceleration features (such as HDX MediaStream Windows Media Redirection) require that Microsoft Media Foundation be installed on the machine on which you install the VDA. If the machine does not have Media Foundation installed, the multimedia acceleration features will not be installed and will not work. Do not remove Media Foundation from the machine after installing the Citrix software; otherwise, users will not be able to log on to the machine. On most supported Windows desktop OS editions, Media Foundation support is already installed and cannot be removed. However, N editions do not include certain media-related technologies; you can obtain that software from Microsoft or a third party.

During VDA installation, you can choose to install the HDX 3D Pro version of the VDA for Windows Desktop OS. That version is particularly suited for use with DirectX and OpenGL-driven applications and with rich media such as video. Note that this is not supported for Windows 10. See the HDX 3D Pro section for additional support information.

You cannot install a current version of the VDA on a machine running Windows XP or Windows Vista; however, you can install an earlier Virtual Desktop Agent version on those operating systems if needed. See CTX140941 for details. The Remote PC Access version in this release is not supported on Windows Vista operating systems.

Virtual Delivery Agent (VDA) for Server OS

Supported operating systems:

https://docs.citrix.com
The installer automatically deploys the following requirements, which are also available on the Citrix installation media in the Support folders:

- Microsoft .NET Framework 4.5.2 (4.6 is also supported)
- Microsoft .NET Framework 3.5.1 (Windows Server 2008 R2 only)
- Microsoft Visual C++ 2008 SP1, 2010 SP1, and 2013 Runtimes (32-bit and 64-bit)

The installer automatically installs and enables Remote Desktop Services role services, if they are not already installed and enabled.

Several multimedia acceleration features (such as HDX MediaStream Windows Media Redirection) require that the Microsoft Media Foundation be installed on the machine on which you install the VDA. If the machine does not have Media Foundation installed, the multimedia acceleration features will not be installed and will not work. Do not remove Media Foundation from the machine after installing the Citrix software; otherwise, users will not be able to log on to the machine.

On most Windows Server 2012 R2, Windows Server 2012, and Windows Server 2008 R2 editions, the Media Foundation feature is installed through the Server Manager (for Windows Server 2012 R2 and Windows Server 2012: ServerMediaFoundation; for Windows Server 2008 R2: DesktopExperience). However, N editions do not include certain media-related technologies; you can obtain that software from Microsoft or a third party.

Hosts / virtualization resources

Some XenApp and XenDesktop features may not be supported on all host platforms or all platform versions. For example, AppDisks are supported with XenServer and VMware hosts. See the feature documentation for details.

Supported host platforms:

XenServer

- XenServer 6.5 and SP1
- XenServer 6.2 SP1 plus hotfixes (you must apply SP1 to enable application of future hotfixes)
- XenServer 6.1

VMware vSphere. No support is provided for vSphere vCenter Linked Mode operation.

- VMware vSphere 6.0 and Update 1
- VMware vSphere 5.5 and Updates 1 through 3
- VMware vSphere 5.1 Updates 2 and 3
- VMware vSphere 5.0 Updates 2 and 3
- VMware vCenter 5.5 / 6 appliance

System Center Virtual Machine Manager. Includes any version of Hyper-V that can register with the supported System Center Virtual Machine Manager versions.

- System Center Virtual Machine Manager 2012 R2
Nutanix Acropolis 4.5. Several XenApp and XenDesktop features are not available when using this platform; see CTX202032 for details. For more information on the use of the product with Acropolis, see https://portal.nutanix.com/#/page/docs.

Supported cloud environments:

Amazon Web Services (AWS)
- You can provision applications and desktops on supported Windows server operating systems.
- SQL Server 2012 Enterprise is not available on AWS.
- AWS does not offer desktop operating system instances.
- The Amazon Relational Database Service (RDS) is not supported.
- See the AWS documentation for additional information.

Citrix CloudPlatform
- The minimum supported version is 4.2.1 with hotfixes 4.2.1-4.
- Deployments were tested using XenServer 6.2 (with Service Pack 1 and hotfix XS62ESP1003) and vSphere 5.1 hypervisors.
- CloudPlatform does not support Hyper-V hypervisors.
- CloudPlatform 4.3.0.1 supports VMware vSphere 5.5.
- See the CloudPlatform documentation (including the Release Notes for your CloudPlatform version) for additional support and Linux-based system requirements information.

Microsoft Azure
- The Remote PC Access Wake on LAN feature requires Microsoft System Center Configuration Manager 2012.

Active Directory functional levels

The following functional levels for the Active Directory forest and domain are supported:
- Windows Server 2012 R2
- Windows Server 2012
- Windows Server 2008 R2
- Windows Server 2008
- Windows Server 2003
- Windows 2000 native (not supported for domain controllers)

HDX

UDP audio for Multi-Stream ICA is supported on Receiver for Windows and Citrix Receiver for Linux 13.

Echo cancellation is supported on Citrix Receiver for Windows.

See the specific HDX feature support and requirements below.
HDX Desktop Composition Redirection

The Windows user device or thin client must support or contain:

- DirectX 9
- Pixel Shader 2.0 (supported in hardware)
- 32 bits per pixel
- 1.5 GHz 32-bit or 64-bit processor
- 1 GB RAM
- 128 MB video memory on the graphic card or an integrated graphics processor

HDX queries the Windows device to verify that it has the required GPU capabilities, and then automatically reverts to server-side desktop composition if it does not. List the devices with the required GPU capabilities that do not meet the processor speed or RAM specifications in the GPO group for devices excluded from Desktop Composition Redirection.

The minimum available bandwidth is 1.5 Mbps; the recommended bandwidth is 5 Mbps. Those values incorporate end-to-end latency.

HDX Windows Media delivery

The following clients are supported for Windows Media client-side content fetching, Windows Media redirection, and realtime Windows Media multimedia transcoding: Citrix Receiver for Windows, Citrix Receiver for iOS, and Citrix Receiver for Linux.

To use Windows Media client-side content fetching on Windows 8 devices, set the Citrix Multimedia Redirector as a default program in Control Panel > Programs > Default Programs > Set your default programs, select Citrix Multimedia Redirector and click either Set this program as default or Choose defaults for this program. GPU transcoding requires an NVIDIA CUDA-enabled GPU with Compute Capability 1.1 or higher; see http://developer.nvidia.com/cuda/cuda-gpus.

HDX Flash Redirection

The following clients and Adobe Flash Players are supported:

- Citrix Receiver for Windows (for second generation Flash Redirection features) - Second generation Flash Redirection features require Adobe Flash Player for Other Browsers, sometimes referred to as an NPAPI (Netscape Plugin Application Programming Interface) Flash Player.
- Citrix Receiver for Linux (for second generation Flash Redirection features) - Second generation Flash Redirection features require Adobe Flash Player for other Linux or Adobe Flash Player for Ubuntu.
- Citrix Online plug-in 12.1 (for legacy Flash Redirection features) - Legacy Flash Redirection features require Adobe Flash Player for Windows Internet Explorer (sometimes referred to as an ActiveX player).

The major version number of the Flash Player on the user device must be greater than or equal to the major version number of the Flash Player on the server. If an earlier version of the Flash Player is installed on the user device, or if the Flash Player cannot be installed on the user device, Flash content is rendered on the server.

The machines running VDAs require:

- Adobe Flash Player for Windows Internet Explorer (the ActiveX player)
- Internet Explorer 11 (in non-Modern UI mode). You can use Internet Explorer versions 7-10, but Microsoft supports (and Citrix recommends using) version 11. Flash redirection requires Internet Explorer on the server, with other browsers, Flash content is rendered on the server.
Protected mode disabled in Internet Explorer (Tools > Internet Options > Security tab > Enable Protected Mode check box cleared). Restart Internet Explorer to effect the change.

HDX 3D Pro

When installing a VDA for Windows Desktop OS, you can choose to install the HDX 3D Pro version (exception: machines running Windows 10).

The physical or virtual machine hosting the application can use GPU Passthrough or Virtual GPU (vGPU):

- GPU Passthrough is available with Citrix XenServer. GPU Passthrough is also available with VMware vSphere and VMware ESX, where it is referred to as virtual Direct Graphics Acceleration (vDGA).
- vGPU is available with Citrix XenServer and VMware vSphere; see www.citrix.com/go/vGPU (Citrix My Account credentials required).

Citrix recommends that the host computer have at least 4 GB of RAM and four virtual CPUs with a clock speed of 2.3 GHz or higher.

Graphical Processing Unit (GPU):

- For CPU-based compression (including lossless compression), HDX 3D Pro supports any display adapter on the host computer that is compatible with the application being delivered.
- For optimized GPU frame buffer access using the NVIDIA GRID API, HDX 3D Pro requires NVIDIA Quadro cards with the latest NVIDIA drivers. The NVIDIA GRID delivers a high frame rate, resulting in a highly interactive user experience.
- For vGPU using XenServer, HDX 3D Pro requirements include NVIDIA GRID K1 and K2 cards.

User device:

- HDX 3D Pro supports all monitor resolutions that are supported by the GPU on the host computer. However, for optimum performance with the minimum recommended user device and GPU specifications, Citrix recommends a maximum monitor resolution for user devices of 1920 x 1200 pixels for LAN connections, and 1280 x 1024 pixels for WAN connections.
- Citrix recommends that user devices have at least 1 GB of RAM and a CPU with a clock speed of 1.6 GHz or higher. Use of the default deep compression codec, which is required on low-bandwidth connections, requires a more powerful CPU unless the decoding is done in hardware. For optimum performance, Citrix recommends that user devices have at least 2 GB of RAM and a dual-core CPU with a clock speed of 3 GHz or higher.
- For multi-monitor access, Citrix recommends user devices with quad-core CPUs.
- User devices do not need a GPU to access desktops or applications delivered with HDX 3D Pro.
- Citrix Receiver must be installed.

For more information, see the HDX 3D Pro articles and www.citrix.com/xenapp/3d.

HDX video conferencing requirements for webcam video compression


Supported video conferencing applications:

- Adobe Connect
- Cisco WebEx
- Citrix GoToMeeting HDFaces
To use Skype on a Windows client, edit the registry on the client and the server:

Client registry key HKEY_CURRENT_USER\Software\Citrix\HdxRealTime

Name: DefaultHeight, Type: REG_DWORD, Data: 240
Name: DefaultWidth, Type: REG_DWORD, Data: 320

Server registry key HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\Vd3d\Compatibility

Name: skype.exe, Type: REG_DWORD, Data: Set to 0

Other user device requirements:

- Appropriate hardware to produce sound.
- DirectShow-compatible webcam (use the webcam default settings). Webcams that are hardware encoding capable reduce client-side CPU usage.
- Webcam drivers, obtained from the camera manufacturer if possible.

Session Recording

This section documents the system requirements for the:

Session Recording administration components
Session Recording Agent
Session Recording Player

Session Recording administration components

The Session Recording administration components (Session Recording Database, Session Recording Server, and Session Recording Policy Console) can be installed on a single server or on different servers.

Session Recording Database

Supported operating systems:

- Microsoft Windows Server 2012 R2
- Microsoft Windows Server 2012
- Microsoft Windows Server 2008 R2 SP1

Supported Microsoft SQL Server versions:
Microsoft SQL Server 2014 Enterprise, Express, and Standard editions
Microsoft SQL Server 2012 SP2 Enterprise and Express editions
Microsoft SQL Server 2008 R2 SP3 Enterprise and Express editions

Requirement: .NET Framework Version 3.5 SP1 (Windows Server 2008 R2 only) or .NET Framework Version 4.5.2 or 4.6.

Session Recording Server

Supported operating systems:

- Microsoft Windows Server 2012 R2
- Microsoft Windows Server 2012
- Microsoft Windows Server 2008 R2 SP1

You must install prerequisites before installing the Session Recording Server. From the Server Manager, add the IIS role and select the following options:

- Application Development > ASP.NET 4.5 on Server 2012 and Server 2012 R2, ASP.NET on Server 2008 R2. Other components are automatically selected; click Add to accept the required roles.
- Security > Windows Authentication
- Management Tools > IIS 6 Management Compatibility: IIS 6 Metabase Compatibility, IIS 6 WMI Compatibility, IIS 6 Scripting Tools, IIS 6 Management Console

Other requirements:

- .NET Framework Version 3.5 SP1 (Windows Server 2008 R2 only) or .NET Framework Version 4.5.2 or 4.6.
- If the Session Recording Server uses HTTPS as its communications protocol, add a valid certificate. Session Recording uses HTTPS by default, which Citrix recommends.
- Microsoft Message Queuing (MSMQ), with Active Directory integration disabled, and MSMQ HTTP support enabled.

Session Recording Policy Console

Supported operating systems:

- Microsoft Windows Server 2012 R2
- Microsoft Windows Server 2012
- Microsoft Windows Server 2008 R2 SP1

Requirement: .NET Framework Version 3.5 SP 1 (Windows Server 2008 R2 only) or .NET Framework Version 4.5.2 or 4.6.

Session Recording Agent

Install the Session Recording Agent on every XenApp and XenDesktop server on which you want to record sessions.

Supported operating systems:

- Microsoft Windows Server 2012 R2
- Microsoft Windows Server 2012
- Microsoft Windows Server 2008 R2 SP1
- Microsoft Windows 10
- Microsoft Windows 8.1
• Microsoft Windows 8
• Microsoft Windows 7 SP1

Requirements:
• XenApp 7.8 or XenDesktop 7.8 with Platinum license
• .NET Framework Version 4.5.2 or 4.6
• Microsoft Message Queuing (MSMQ), with Active Directory integration disabled, and MSMQ HTTP support enabled

Session Recording Player

Supported operating systems:
• Microsoft Windows 10
• Microsoft Windows 8.1
• Microsoft Windows 8
• Microsoft Windows 7 SP1

Requirement: .NET Framework Version 3.5 SP1 (Windows 7 only), 4.5.2 or 4.6.

For optimal results, install Session Recording Player on a workstation with:
• Screen resolution of 1024 x 768
• Color depth of at least 32-bit
• 1GB RAM minimum; additional RAM and CPU/GPU resources can improve performance when playing graphics-intensive recordings, especially when recordings contain many animations

The seek response time depends on the size of the recording and your machine's hardware specification.

Universal Print Server

The Universal Print Server comprises client and server components. The UpsClient component is included in the VDA installation. You install the UpsServer component on each print server where shared printers reside that you want to provision with the Citrix Universal Print Driver in user sessions.

The UpsServer component is supported on:
• Windows Server 2012 R2 and 2012
• Windows Server 2008 R2 SP1
• Windows Server 2008 32-bit

Requirement: Microsoft Visual C++ 2013 Runtime

For VDAs for Windows Server OS, user authentication during printing operations requires the Universal Print Server to be joined to the same domain as the VDA.

Standalone client and server component packages are also available for download.

For more information, see the Provision printers article.
Other

Citrix recommends installing or upgrading to the component software versions provided on the installation media for this release.

- StoreFront requires 2 GB of memory. See the StoreFront documentation for system requirements. StoreFront 2.6 is the minimum supported version with this release.
- When using Provisioning Services with this release, the minimum supported Provisioning Services version is 7.0.
- The Citrix License Server requires 40 MB of disk space. See the licensing documentation for system requirements. Only Citrix License Server for Windows is supported. The minimum supported version is 11.13.1.

The Microsoft Group Policy Management Console (GPMC) is required if you store Citrix policy information in Active Directory rather than the Site Configuration database. For more information, see the Microsoft documentation.

Multiple network interface cards are supported.

By default, the Citrix Receiver for Windows is installed when you install a VDA. For more information, see the Citrix Receiver for Windows documentation.

See the App-V article for supported versions of Microsoft App-V.

See the Local App Access article for supported browser information for Local App Access.

Client folder redirection - Supported operating systems:

- Client (with latest Citrix Receiver for Windows): Windows 7, Windows 8, and Windows 8.1
Technical overview

Feb 24, 2016

XenApp and XenDesktop are virtualization solutions that give IT control of virtual machines, applications, licensing, and security while providing anywhere access for any device.

XenApp and XenDesktop allow:
- End users to run applications and desktops independently of the device's operating system and interface.
- Administrators to manage the network and provide or restrict access from selected devices or from all devices.
- Administrators to manage an entire network from a single data center.

XenApp and XenDesktop share a unified architecture called FlexCast Management Architecture (FMA). FMA's key features are the ability to run multiple versions of XenApp or XenDesktop from a single Site and integrated provisioning.

FMA key components

A typical XenApp or XenDesktop environment consists of a few key technology components, which interact when users connect to applications and desktops, and log data about Site activity.

**Citrix Receiver:** A software client that is installed on the user device, supplies the connection to the virtual machine via TCP port 80 or 443, and communicates with StoreFront using the StoreFront Service API.

**Citrix StoreFront:** The interface that authenticates users, manages applications and desktops, and hosts the application store. StoreFront communicates with the Delivery Controller using XML.

**Delivery Controller:** The central management component of a XenApp or XenDesktop Site that consists of services that manage resources, applications, and desktops; and optimize and balance the loads of user connections.

**Virtual Delivery Agent (VDA):** An agent that is installed on machines running Windows server or Windows desktop operating systems that allows these machines and the resources they host to be made available to users. The VDA-installed machines running Windows server OS allow the machine to host multiple connections for multiple users and are connected to users on one of the following ports:
- TCP port 80 or port 443 if TLS is enabled
- TCP port 2598, if Citrix Gateway Protocol (CGP) is enabled, which enables session reliability
- TCP port 1494 if CGP is disabled or if the user is connecting with a legacy client

**Broker Service:** A Delivery Controller service that tracks which users are logged in and where, what session resources the users have, and if users need to reconnect to existing applications. The Broker Service executes PowerShell and communicates with the Broker agent over TCP port 80. It does not have the option to use TCP port 443.

**Broker agent:** An agent that hosts multiple plugins and collects real-time data. The Broker agent is located on the VDA and is connected to the Controller by TCP port 80. It does not have the option to use TCP port 443.

**Monitor Service:** A Delivery Controller component that collects historical data and puts it in the Site database by default. The Monitor Service communicates on TCP port 80 or 443.

**ICA File/Stack:** Bundled user information that is required to connect to the VDA.
**Site Database:** A Microsoft SQL Server database that stores data for the Delivery Controller, such as Site policies, Machine Catalogs, and Delivery Groups.

**NetScaler Gateway:** A data-access solution that provides secure access inside or outside the LAN's firewall with additional credentials.

**Citrix Director:** A web-based tool that allows administrators and help desk personnel to access real-time data from the broker agent, historical data from the Site database, and HDX data from NetScaler for troubleshooting and support. Director communicates with the Controller on TCP port 80 or 443.

**Citrix Studio:** A management console that allows administrators to configure and manage Sites, and gives access to real-time data from the broker agent. Studio communicates with the Controller on TCP port 80.

How typical deployments work

XenApp and XenDesktop Sites are made up of machines with dedicated roles that allow for scalability, high availability, and failover, and provide a solution that is secure by design. A XenApp or XenDesktop Site consists of VDA-installed servers and desktop machines, and the Delivery Controller, which manages access.

The VDA enables users to connect to desktops and applications. It is installed on server or desktop machines within the data center for most delivery methods, but it can also be installed on physical PCs for Remote PC Access.

The Controller is made up of independent Windows services that manage resources, applications, and desktops, and optimize and balance user connections. Each Site has one or more Controllers, and because sessions are dependent on latency, bandwidth, and network reliability, all Controllers ideally should be on the same LAN.

Users never directly access the Controller. The VDA serves as an intermediary between users and the Controller. When users log on to the Site using StoreFront, their credentials are passed through to the Broker Service, which obtains their profiles and available resources based on the policies set for them.
How user connections are handled

To start a XenApp or XenDesktop session, the user connects either via Citrix Receiver, which is installed on the user's device, or via Citrix Receiver for Web (RFW).

Within Citrix Receiver, the user selects the physical or virtual desktop or virtual application that is needed.

The user's credentials move through this pathway to access the Controller, which determines what resources are needed by communicating with a Broker Service. It is recommended for administrators to put a SSL certificate on StoreFront to encrypt the credentials coming from Receiver.

User connections

The Broker Service determines which desktops and applications the user is allowed to access.

Once the credentials are verified, the information about available apps or desktops is sent back to the user through the StoreFront-Citrix Receiver pathway. When the user selects applications or desktops from this list, that information goes back down the pathway to the Controller, which determines the proper VDA to host the specific applications or desktop.

The Controller sends a message to the VDA with the user's credentials and sends all the data about the user and the connection to the VDA. The VDA accepts the connection and sends the information back through the same pathways all the way to Citrix Receiver. Citrix Receiver bundles up all the information that has been generated in the session to create Independent Computing Architecture (ICA). file on the user's device if Citrix Receiver is installed locally or on Citrix RFW if accessed through the web. As long as the Site was properly set up, the credentials remain encrypted throughout this process.

The ICA file is copied to the user's device and establishes a direct connection between the device and the ICA stack running on the VDA. This connection bypasses the management infrastructure: Citrix Receiver, StoreFront, and Controller.

The connection between Citrix Receiver and the VDA uses the Citrix Gateway Protocol (CGP). If a connection is lost, the Session Reliability feature enables the user to reconnect to the VDA rather than having to relaunch through the
management infrastructure. Session Reliability can be enabled or disabled in Studio.

Once the client connects to the VDA, the VDA notifies the Controller that the user is logged on, and the Controller sends this information to the Site database and starts logging data in the Monitoring database.

How data access works

Every XenApp or XenDesktop session produces data that IT can access through Studio or Director. Studio allows administrators to access real-time data from the Broker Agent to better manage sites. Director has access to the same real-time data plus historical data stored in the Monitoring database as well as HDX data from NetScaler Gateway for help-desk support and troubleshooting purposes.

Within the Controller, the Broker Service reports session data for every session on the virtual machine providing real-time data. The Monitor Service also tracks the real-time data and stores it as historical data in the Monitoring database.

Studio can communicate only with the Broker Service; therefore, it has access only to real-time data. Director communicates with the Broker Service (through a plugin in the Broker Agent) to access the Site database.

Director can also access NetScaler Gateway to get information on the HDX data.

Related content

- Concepts and components
- Delivery methods
This illustration shows the key components in a typical XenApp or XenDesktop deployment, which is called a Site.

The components in this illustration are:

- **Delivery Controller**: The Delivery Controller is the central management component of any XenApp or XenDesktop Site. Each Site has one or more Delivery Controllers. It is installed on at least one server in the data center. (For Site reliability and availability, install the Controller on more than one server.) If your deployment includes virtual machines hosted on a hypervisor or cloud service, the Controller services communicate with the hypervisor to distribute applications and desktops, authenticate and manage user access, broker connections between users and their virtual desktops and applications, optimize use connections, and load-balance these connections. Each service's data is stored in the Site database.

The Controller manages the state of the desktops, starting and stopping them based on demand and administrative configuration. In some editions, the Controller allows you to install Profile management to manage user personalization settings in virtualized or physical Windows environments.

- **Database**: At least one Microsoft SQL Server database is required for every XenApp or XenDesktop Site to store all configuration and session information. This database stores the data collected and managed by the services that make up the Controller. Install the database within your data center, and ensure it has a persistent connection to the Controller.

- **Virtual Delivery Agent (VDA)**: The VDA is installed on each physical or virtual machine in your Site that you want to make available to users. It enables the machine to register with the Controller, which in turn allows the machine and the resources it is hosting to be made available to users. VDAs establish and manage the connection between the machine
and the user device, verify that a Citrix license is available for the user or session, and apply whatever policies have been configured for the session. The VDA communicates session information to the Broker Service in the Controller through the broker agent included in the VDA.

VDAs are available for Windows server and desktop operating systems. VDAs for Windows server operating systems allow multiple users to connect to the server at one time. VDAs for Windows desktop operating systems allow only one user to connect to the desktop at a time.

- **Citrix StoreFront**: StoreFront authenticates users to Sites hosting resources and manages stores of desktops and applications that users access. It hosts your enterprise application store, which lets you give users self-service access to desktops and applications you make available to them. It also keeps track of users' application subscriptions, shortcut names, and other data to ensure they have a consistent experience across multiple devices.

- **Citrix Receiver**: Installed on user devices and other endpoints, such as virtual desktops, Citrix Receiver provides users with quick, secure, self-service access to documents, applications, and desktops from any of the user's devices, including smartphones, tablets, and PCs. Citrix Receiver provides on-demand access to Windows, Web, and Software as a Service (SaaS) applications. For devices that cannot install Citrix Receiver software, Citrix Receiver for HTML5 provides a connection through a HTML5-compatible web browser.

- **Citrix Studio**: Studio is the management console that enables you to configure and manage your deployment, eliminating the need for separate management consoles for managing delivery of applications and desktops. Studio provides various wizards to guide you through the process of setting up your environment, creating your workloads to host applications and desktops, and assigning applications and desktops to users. You can also use Studio to allocate and track Citrix licenses for your Site. Studio gets the information it displays from the Broker Service in the Controller.

- **Citrix Director**: Director is a web-based tool that enables IT support and help desk teams to monitor an environment, troubleshoot issues before they become system-critical, and perform support tasks for end users. You can use one Director deployment to connect to and monitor multiple XenApp or XenDesktop Sites. Director shows session and Site information from:
  - Real-time session data from the Broker Service in the Controller, which include data the Broker Service gets from the broker agent in the VDA.
  - Historical Site data from Monitor Service in the Controller.
  - Data about HDX traffic (also known as ICA traffic) captured by HDX Insight from the NetScaler, if your deployment includes a NetScaler and your XenApp or XenDesktop edition includes HDX Insights.

You can also view and interact with a user's sessions using Windows Remote Assistance.

- **Citrix License Server**: The License Server manages your product licenses. It communicates with the Controller to manage licensing for each user's session and with Studio to allocate license files. You must create at least one license server to store and manage your license files.

- **Hypervisor**: The hypervisor hosts the virtual machines in your Site. These can be the virtual machines you use to host applications and desktops as well as virtual machines you use to host the XenApp and XenDesktop components. A hypervisor is installed on a host computer dedicated entirely to running the hypervisor and hosting virtual machines. Citrix XenServer hypervisor is included with XenApp and XenDesktop; you can use other supported hypervisors, such as Microsoft Hyper-V or VMware vSphere.

Although many implementations of XenApp and XenDesktop require a hypervisor, you don't need one to provide Remote
PC Access or when you are using Provisioning Services (included with some editions of XenApp and XenDesktop) instead of MCS to provision virtual machine.

These additional components, not shown in the illustration above, may also be included in typical XenApp or XenDesktop deployments:

- **Provisioning Services:** Provisioning Services is an optional component of XenApp and XenDesktop available with some editions. It provides an alternative to MCS for provisioning virtual machines. Whereas MCS creates copies of a master image, Provisioning Services streams the master image to user device. Provisioning Services doesn't require a hypervisor to do this, so you can use it to host physical machines. When Provisioning Services is included in a Site, it communicates with the Controller to provide users with resources.

- **NetScaler Gateway:** When users connect from outside the corporate firewall, this release can use Citrix NetScaler Gateway (formerly Access Gateway) technology to secure these connections with TLS. NetScaler Gateway or NetScaler VPX virtual appliance is an SSL VPN appliance that is deployed in the demilitarized zone (DMZ) to provide a single secure point of access through the corporate firewall.

- **Citrix CloudBridge:** In deployments where virtual desktops are delivered to users at remote locations such as branch offices, Citrix CloudBridge (formerly Citrix Branch Repeater or WANScaler) technology can be employed to optimize performance. Repeaters accelerate performance across wide-area networks, so with Repeaters in the network, users in the branch office experience LAN-like performance over the WAN. CloudBridge can prioritize different parts of the user experience so that, for example, the user experience does not degrade in the branch location when a large file or print job is sent over the network. HDX WAN Optimization with CloudBridge provides tokenized compression and data deduplication, dramatically reducing bandwidth requirements and improving performance. For more information, see the Citrix CloudBridge documentation.

### Setting up and assigning resources: Machine Catalogs and Delivery Groups

You set up the resources you want to provide to users with Machine Catalogs, but you designate which users have access to these resources with Delivery Groups.

**Machine Catalogs**

Machine Catalogs are collections of virtual or physical machines that you manage as a single entity. These machines, and the application or virtual desktops on them, are the resources you want to provide to your users. All the machines in a machine catalog have the same operating system and the same VDA installed. They also have the same applications or virtual desktops available on them. Typically, you create a master image and use it to create identical virtual machines in the catalog. When you create a machine catalog, you specify the type of machine and provisioning method for the machines in that catalog.

- **Server OS machines:** Virtual or physical machines based on a server operating system used for delivering XenApp published apps, also known as server-based hosted applications, and XenApp published desktops, also known as server-hosted desktops. These machines allow multiple users to connect to them at one time.

- **Desktop OS machines:** Virtual or physical machines based on a desktop operating system used for delivering VDI desktops (desktops running desktop operating systems that can be fully personalized, depending on the options you
choose), and VM-hosted apps (applications from desktop operating systems) and hosted physical desktops. Only one user at a time can connect each of these desktops.

- **Remote PC Access**: User devices that are included on a whitelist, enabling users to access resources on their office PCs remotely, from any device running Citrix Receiver. Remote PC Access enables you to manage access to office PCs through your XenDesktop deployment.

**Provisioning methods**

- **Machine Creation Services (MCS)**: A collection of services that create virtual servers and desktops from a master image on demand, optimizing storage utilization and providing a virtual machine to users every time they log on. MCS is fully integrated and administered in Citrix Studio.

- **Provisioning Services**: Enables computers to be provisioned and reprovisioned in real-time from a single shared-disk image. Provisioning Services manages target devices as a device collection. The desktop and applications are delivered from a Provisioning Services vDisk that is imaged from a master target device, which enables you to leverage the processing power of physical hardware or virtual machines. Provisioning Services is managed through its own console.

- **Existing images**: Applies to desktops and applications that you have already migrated to virtual machines in the data center. You must manage target devices on an individual basis or collectively using third-party electronic software distribution (ESD) tools.

**Delivery Groups**

Delivery Groups are collections of users given access to a common group of resources. Delivery Groups contain machines from your Machine Catalogs, and Active Directory users who have access to your Site. Often it makes sense to assign users to your Delivery Groups by their Active Directory group because both Active Directory groups and Delivery Groups are ways of grouping together users with similar requirements. Each Delivery Group can contain machines from more than one Machine Catalog, and each catalog can contribute machines to more than one Delivery Group, but each individual machine can only belong to one Delivery Group at a time. You can set up a Delivery Group to deliver applications, desktops, or both. You define which resources users in the Delivery Group can access. For example, if you want to deliver different applications to different users, one way to do this is to install all the applications you want to deliver on the master image for one Machine Catalog and create enough machines in that catalog to distribute among several Delivery Groups. Then you configure each Delivery Group to deliver a different subset of the applications installed on the machines.

**XenApp and XenDesktop 7.x differences from XenApp 6.5 and previous versions**

If you are familiar with XenApp 6.5 and previous versions of XenApp, it may be helpful to think of 7.x versions of XenApp and XenDesktop in terms of how they differ from those earlier versions.

**NOTE**: Throughout this section, 7.x refers to XenApp versions 7.5 or later, and XenDesktop versions 7 or later.

Although they are not exact equivalents, the following table helps map functional elements from XenApp 6.5 and previous versions to XenApp 7.x and XenDesktop 7.x:

<table>
<thead>
<tr>
<th>Instead of this in XenApp 6.5 and before:</th>
<th>Think of this in XenApp and XenDesktop 7.x:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Independent Management Architecture (IMA)</td>
<td>FlexCast Management Architecture (FMA)</td>
</tr>
</tbody>
</table>
XenApp 7.x and XenDesktop 7.x are based on FlexCast Management Architecture (FMA). FMA is a service-oriented architecture that allows interoperability and management modularity across Citrix technologies. FMA provides a platform for application delivery, mobility, services, flexible provisioning, and cloud management. FMA replaces the Independent Management Architecture (IMA) used in XenApp 6.5 and previous versions.

These are the key elements of FMA in terms of how they relate to elements of XenApp 6.5 and previous versions:

- **Delivery Sites:** Farms were the top-level objects in XenApp 6.5 and previous versions. In XenApp 7.x and XenDesktop 7.x, the Site is the highest level item. Sites offer applications and desktops to groups of users. FMA requires that you must be in a domain to deploy a Site. For example, to install the servers, your account must have local administrator privileges and be a domain user in the Active Directory.

- **Machine Catalogs and Delivery Groups:** Machines hosting applications in XenApp 6.5 and previous versions belonged to Worker Groups for efficient management of the applications and server software. Administrators could manage all applications and servers using Delivery Groups.

<table>
<thead>
<tr>
<th>Farm</th>
<th>Site</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worker Group</td>
<td>Machine Catalog</td>
</tr>
<tr>
<td>Worker</td>
<td>Delivery Group</td>
</tr>
<tr>
<td>Remote Desktop Services (RDS) or Terminal Services machine</td>
<td>Virtual Delivery Agent (VDA)</td>
</tr>
<tr>
<td>Zone and Data Collector</td>
<td>Delivery Controller</td>
</tr>
<tr>
<td>Delivery Services Console</td>
<td>Citrix Studio and Citrix Director</td>
</tr>
<tr>
<td>Publishing applications</td>
<td>Delivering applications</td>
</tr>
<tr>
<td>Data store</td>
<td>Database</td>
</tr>
<tr>
<td>Load Evaluator</td>
<td>Load Management Policy</td>
</tr>
<tr>
<td>Administrator</td>
<td>Delegated Administrator</td>
</tr>
<tr>
<td></td>
<td>Role</td>
</tr>
<tr>
<td></td>
<td>Scope</td>
</tr>
</tbody>
</table>
machines in a Worker Group as a single unit for their application management and load-balancing needs. Folders were used to organize applications and machines. In XenApp 7.x and XenDesktop 7.x, you use a combination of Machine Catalogs and Delivery Groups to manage machines, load balancing, and hosted applications or desktops. You can also use application folders.

- **Virtual Delivery Agents (VDAs):** In XenApp 6.5 and previous versions, worker machines in Worker Groups ran applications for the user and communicated with data collectors. In XenApp 7.x and XenDesktop 7.x, the VDA communicates with Delivery Controllers that manage the user connections.

- **Delivery Controllers:** In XenApp 6.5 and previous versions there was a zone master responsible for user connection requests and communication with hypervisors. In XenApp 7.x and XenDesktop 7.x, Controllers in the Site distribute and handle connection requests. In XenApp 6.5 and previous versions, zones provided a way to aggregate servers and replicate data across WAN connections. Although zones have no exact equivalent in XenApp 7.x and XenDesktop 7.x, the 7.x zones functionality enable you to help users in remote regions connect to resources without necessarily forcing their connections to traverse large segments of a WAN.

- **Citrix Studio and Citrix Director:** Use the Studio console to configure your environments and provide users with access to applications and desktops. Studio replaces the Delivery Services Console in XenApp 6.5 and previous versions. Administrators use Director to monitor the environment, shadow user devices, and troubleshoot IT issues. To shadow users, Windows Remote Assistance must be enabled; it is enabled by default when the VDA is installed.

- **Delivering applications:** XenApp 6.5 and previous versions used the Publish Application wizard to prepare applications and deliver them to users. In XenApp 7.x and XenDesktop 7.x, you use Studio to create and add applications to make them available to users who are included in a Delivery Group. Using Studio, you first configure a Site, create and specify Machine Catalogs, and then create Delivery Groups that use machines from those catalogs. The Delivery Groups determine which users have access to the applications you deliver.

- **Database:** XenApp 7.x and XenDesktop 7.x do not use the IMA data store for configuration information. They use a Microsoft SQL Server database to store configuration and session information.

- **Load Management Policy:** In XenApp 6.5 and previous versions, load evaluators use predefined measurements to determine the load on a machine. User connections can be matched to the machines with less load. In XenApp 7.x and XenDesktop 7.x, use load management policies for balancing loads across machines.

- **Delegated Administration:** In XenApp 6.5 and previous versions, you created custom administrators and assigned them permissions based on folders and objects. In XenApp 7.x and XenDesktop 7.x, custom administrators are based on role and scope pairs. A role represents a job function and has defined permissions associated with it to allow delegation. A scope represents a collection of objects. Built-in administrator roles have specific permissions sets, such as help desk, applications, hosting, and catalog. For example, help desk administrators can work only with individual users on specified sites, while full administrators can monitor the entire deployment and resolve systemwide IT issues.

The transition to FMA also means some features available in XenApp 6.5 and previous versions may be implemented differently or may require you to substitute other features, components, or tools to achieve the same goals.

<table>
<thead>
<tr>
<th>Instead of this in XenApp 6.5 and before:</th>
<th>Use this in XenApp and XenDesktop 7.x:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session prelaunch and session linger configured with policy settings</td>
<td>Session prelaunch and session linger configured by editing Delivery Group settings. As in XenApp 6.5, these features help users connect to applications quickly, by starting sessions before they are requested (session prelaunch) and keeping sessions active after a user closes all applications (session linger). In XenApp and XenDesktop 7.x, you enable these features for specified users by configuring these settings for existing Delivery groups. See Configure session prelaunch and session linger.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Support for unauthenticated (anonymous) users provided by granting rights to anonymous user when setting the properties of published applications</td>
<td>Support for unauthenticated (anonymous) users provided by configuring this option when setting user properties of a Delivery Group. See Users.</td>
</tr>
<tr>
<td>Local host cache permits a worker servers to function even when a connection to the data store is not available</td>
<td>Connection leasing enables users to connect and reconnect to their most recently used applications and desktops, even when the Site database is not available. The connection leasing feature supplements the SQL Server high availability best practices. See Connection leasing.</td>
</tr>
<tr>
<td>Application streaming</td>
<td>App-V delivers streamed applications, managed using Studio.</td>
</tr>
<tr>
<td>Web Interface</td>
<td>Citrix recommends you transition to StoreFront.</td>
</tr>
<tr>
<td>SmartAuditor</td>
<td>Use Session Recording. You can also use configuration logging to log all session activities from an administrative perspective.</td>
</tr>
</tbody>
</table>
Active Directory

Feb 24, 2016

Active Directory is required for authentication and authorization. The Kerberos infrastructure in Active Directory is used to guarantee the authenticity and confidentiality of communications with the Delivery Controllers. For information about Kerberos, see the Microsoft documentation.

The System requirements article lists the supported functional levels for the forest and domain. To use Policy Modeling, the domain controller must be running on Windows Server 2003 to Windows Server 2012 R2; this does not affect the domain functional level.

This product supports:

- Deployments in which the user accounts and computer accounts exist in domains in a single Active Directory forest. User and computer accounts can exist in arbitrary domains within a single forest. All domain functional levels and forest functional levels are supported in this type of deployment.

- Deployments in which user accounts exist in an Active Directory forest that is different from the Active Directory forest containing the computer accounts of the controllers and virtual desktops. In this type of deployment, the domains containing the Controller and virtual desktop computer accounts must trust the domains containing user accounts. Forest trusts or external trusts can be used. All domain functional levels and forest functional levels are supported in this type of deployment.

- Deployments in which the computer accounts for Controllers exist in an Active Directory forest that is different from one or more additional Active Directory forests that contain the computer accounts of the virtual desktops. In this type of deployment, a bi-directional trust must exist between the domains containing the Controller computer accounts and all domains containing the virtual desktop computer accounts. In this type of deployment, all domains containing Controller or virtual desktop computer accounts must be at “Windows 2000 native” functional level or higher. All forest functional levels are supported.

- Writable domain controllers. Read-only domain controllers are not supported.

Optionally, Virtual Delivery Agents (VDAs) can use information published in Active Directory to determine which Controllers they can register with (discovery). This method is supported primarily for backward compatibility, and is available only if the VDAs are in the same Active Directory forest as the Controllers. For information about this discovery method see the Delivery Controllers article and CTX118976.

Tip: Do not change the computer name or the domain membership of a Controller after the Site is configured.

Deploy in a multiple Active Directory forest environment

Note: This information applies to minimum version XenDesktop 7.1 and XenApp 7.5. It does not apply to earlier versions of XenDesktop or XenApp.

In an Active Directory environment with multiple forests, if one-way or two-way trusts are in place you can use DNS forwarders for name lookup and registration. To allow the appropriate Active Directory users to create computer accounts, use the Delegation of Control wizard. Refer to Microsoft documentation for more information about this wizard.

No reverse DNS zones are necessary in the DNS infrastructure if appropriate DNS forwarders are in place between forests.

The SupportMultipleForest key is necessary if the VDA and Controller are in separate forests, regardless of whether the Active Directory and NetBIOS names are different. The SupportMultipleForest key is only necessary on the VDA. Use the following information to add the registry key:
Caution: Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

- **HKEY_LOCAL_MACHINE\Software\Citrix\VirtualDesktopAgent\SupportMultipleForest**
  - Name: SupportMultipleForest
  - Type: REG_DWORD
  - Data: 0x00000001 (1)

You might need reverse DNS configuration if your DNS namespace is different than that of Active Directory.

If external trusts are in place during setup, the ListOfSIDs registry key is required. The ListOfSIDs registry key is also necessary if the Active Directory FQDN is different than the DNS FQDN or if the domain containing the Domain Controller has a different Netbios name than the Active Directory FQDN. To add the registry key, use the following information:

- For a 32-bit or 64-bit VDA, locate the registry key
  - **HKEY_LOCAL_MACHINE\Software\Citrix\VirtualDesktopAgent\ListOfSIDs**
  - Name: ListOfSIDs
  - Type: REG_SZ
  - Data: Security Identifier (SID) of the Controllers

When external trusts are in place, make the following changes on the VDA:

1. Locate the file `<ProgramFiles>\Citrix\Virtual Desktop Agent\brokeragentconfig.exe.config`.
2. Make a backup copy of the file.
3. Open the file in a text editing program such as Notepad.
4. Locate the text `allowNtlm="false"` and change the text to `allowNtlm="true"`.
5. Save the file.

After adding the ListOfSIDs registry key and editing the brokeragent.exe.config file, restart the Citrix Desktop Service to apply the changes.

The following table lists the supported trust types:

<table>
<thead>
<tr>
<th>Trust type</th>
<th>Transitivity</th>
<th>Direction</th>
<th>Supported in this release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent and child</td>
<td>Transitive</td>
<td>Two-way</td>
<td>Yes</td>
</tr>
<tr>
<td>Tree-root</td>
<td>Transitive</td>
<td>Two-way</td>
<td>Yes</td>
</tr>
<tr>
<td>External</td>
<td>Nontransitive</td>
<td>One-way or two-way</td>
<td>Yes</td>
</tr>
<tr>
<td>Forest</td>
<td>Transitive</td>
<td>One-way or two-way</td>
<td>Yes</td>
</tr>
<tr>
<td>Shortcut</td>
<td>Transitive</td>
<td>One-way or two-way</td>
<td>Yes</td>
</tr>
<tr>
<td>Realm</td>
<td>Transitive or nontransitive</td>
<td>One-way or two-way</td>
<td>No</td>
</tr>
</tbody>
</table>

For more information about complex Active Directory environments, see [CTX134971](https://docs.citrix.com).
Databases

Jul 07, 2016

A XenApp or XenDesktop Site uses three SQL Server databases:

- **Site** – (also known as Site Configuration) stores the running Site configuration, plus the current session state and connection information.
- **Configuration Logging** – (also known as Logging) stores information about Site configuration changes and administrative activities. This database is used when the Configuring Logging feature is enabled (default = enabled).
- **Monitoring** – stores data used by Director, such as session and connection information.

Each Delivery Controller communicates with the Site database; Windows authentication is required between the Controller and the databases. A Controller can be unplugged or turned off without affecting other Controllers in the Site. This means, however, that the Site database forms a single point of failure. If the database server fails, existing connections will continue to function until a user either logs off or disconnects. New connections cannot be established if the database server is unavailable, except in certain cases when connection leasing is configured.

Citrix recommends that you back up the databases regularly so that you can restore from the backup if the database server fails. The backup strategy for each database may differ. For instructions, see CTX135207.

If your Site contains more than one zone, the Site database should always be in the primary zone. Controllers in every zone communicate with that database.

High availability

There are several high availability solutions to consider for ensuring automatic failover:

- **AlwaysOn Availability Groups** — This enterprise-level high availability and disaster recovery solution introduced in SQL Server 2012 enables you to maximize availability for one or more databases. AlwaysOn Availability Groups requires that the SQL Server instances reside on Windows Server Failover Clustering (WSFC) nodes. For more information, see http://msdn.microsoft.com/en-us/library/hh510230.

- **SQL Server database mirroring** — Mirroring the database ensures that, should you lose the active database server, an automatic failover process happens in a matter of seconds, so that users are generally unaffected. This method is more expensive than other solutions because full SQL Server licenses are required on each database server; you cannot use SQL Server Express edition in a mirrored environment.

- **SQL clustering** — The Microsoft SQL clustering technology can be used to automatically allow one server to take over the tasks and responsibilities of another server that has failed. However, setting up this solution is more complicated, and the automatic failover process is typically slower than alternatives such as SQL mirroring.

- **Using the hypervisor's high availability features** — With this method, you deploy the database as a virtual machine and use your hypervisor's high availability features. This solution is less expensive than mirroring because it uses your existing hypervisor software and you can also use SQL Server Express edition. However, the automatic failover process is slower, as it can take time for a new machine to start for the database, which may interrupt the service to users.

**Note**: Installing a Controller on a node in an SQL clustering or SQL mirroring installation is not supported.

The connection leasing feature supplements the SQL Server high availability best practices by enabling users to connect and reconnect to their most recently used applications and desktops, even when the Site database is not available. For
If all Controllers in a Site fail, you can configure the VDAs to operate in high availability mode so that users can continue to access and use their desktops and applications. In high availability mode, the VDA accepts direct ICA connections from users, rather than connections brokered by the Controller. This feature should be used only on the rare occasion when communication with all Controllers fails; it is not an alternative to other high availability solutions. For more information, see CTX 127564.

## Install database software

By default, SQL Server Express edition is installed when you install the first Delivery Controller, if another SQL Server instance is not detected on that server. That default action is generally sufficient for proof-of-concept or pilot deployments; however, SQL Server Express does not support Microsoft high availability features.

This installation uses the default Windows service accounts and permissions. Refer to Microsoft documentation for details of these defaults, including the addition of Windows service accounts to the sysadmin role. The Controller uses the Network Service account in this configuration. The Controller does not require any additional SQL Server roles or permissions.

If required, you can select **Hide instance** for the database instance. When configuring the address of the database in Studio, enter the instance's static port number, rather than its name. Refer to Microsoft documentation for details about hiding an instance of SQL Server Database Engine.

Most production deployments, and any deployment that uses Microsoft high availability features, should use supported non-Express editions of SQL Server installed on machines other than the server where the first Controller is installed. The System requirements article lists the supported SQL Server versions. The databases can reside on one or more machines.

Make sure the SQL Server software is installed before creating a Site. You don't have to create the database, but if you do, it must be empty. Configuring Microsoft high availability technologies is also recommended.

Use Windows Update to keep SQL Server up-to-date.

## Set up the databases from the Site creation wizard

Specify the database names and addresses (location) on the **Databases** page in the Site creation wizard; see **Database address formats** below. To avoid potential errors when Director queries the Monitor Service, do not use whitespace in the name of the Monitoring database.

The **Databases** page offers two options for setting up the databases: automatic and using scripts. Generally, you can use the automatic option if you (the Studio user and Citrix administrator) have the required database privileges; see **Permissions required to set up databases** below.

You can change the location of a database later, after you create the Site; see **Change database locations** below.

To configure a Site to use a mirror database, complete the following and then proceed with the automatic or scripted setup procedures.

1. Install the SQL Server software on two servers, A and B.
2. On Server A, create the database intended to be used as the principal. Back up the database on Server A and then copy it to Server B.
3. On Server B, restore the backup file.
4. Start mirroring on Server A.

Tip: To verify mirroring after creating the Site, run the PowerShell cmdlet `get-configdbconnection` to ensure that the Failover Partner has been set in the connection string to the mirror.

If you later add, move, or remove a Delivery Controller in a mirrored database environment, see the Delivery Controllers article.

Automatic setup

If you have the required database privileges, select the “Create and set up databases from Studio” option on the Databases page of the Site creation wizard, and then provide the names and addresses of the principal databases.

If a database exists at an address you specify, it must be empty. If databases don't exist at a specified address, you are informed that a database cannot be found, and then asked if you want the database to be created for you. When you confirm that action, Studio automatically creates the databases, if needed, and then applies the initialization scripts for the principal and replica databases.

Scripted setup

If you do not have the required database privileges, someone with those permissions must help, such as a database administrator. Here's the sequence:

1. In the Site creation wizard, select the Generate scripts option. This generates six scripts: two for each of the three databases - one for each principal database and another for each replica. You can indicate where to store the scripts.
2. Give those scripts to your database administrator. The Site creation wizard stops automatically at this point; you’ll be prompted when you return later to continue the Site creation.

The database administrator then creates the databases. Each database should have the following characteristics:

- Use a collation that ends with "_CI_AS_KS". Citrix recommends using a collation that ends with "_100_CI_AS_KS".
- For optimum performance, enable the SQL Server Read-Committed Snapshot. For details, see CTX 137161.
- High availability features should be configured, if desired.
- To configure mirroring, first set the database to use the full recovery model (simple model is the default). Back up the principal database to a file and copy it to the mirror server. On the mirror database, restore the backup file to the mirror server. Then, start mirroring on the principal server.

The database administrator uses the SQLCMD command line utility or SQL Server Management Studio in SQLCMD mode to run each of the xxx_Replica.sql scripts on the high availability SQL Server database instances (if high availability is configured), and then run each of the xxx_Principal.sql scripts on the principal SQL Server database instances. See the Microsoft documentation for SQLCMD details.

When all the scripts complete successfully, the database administrator gives the Citrix administrator the three principal database addresses.

In Studio, you will be prompted to continue the Site creation, and are returned to the Databases page. Enter the addresses. If any of the servers hosting a database cannot be contacted, you’ll see an error message.
Permissions required to set up databases

You must be a local administrator and a domain user to create and initialize the databases (or change the database location). You must also have certain SQL Server permissions. The following permissions can be explicitly configured or acquired by Active Directory group membership. If your Studio user credentials do not include these permissions, you are prompted for SQL Server user credentials.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Purpose</th>
<th>Server role</th>
<th>Database role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a database</td>
<td>Create a suitable empty database</td>
<td>dbcreator</td>
<td></td>
</tr>
<tr>
<td>Create a schema</td>
<td>Create all service-specific schemas and add the first Controller to the Site</td>
<td>securityadmin *</td>
<td>db_owner</td>
</tr>
<tr>
<td>Add a Controller</td>
<td>Add a Controller (other than the first) to the Site</td>
<td>securityadmin *</td>
<td>db_owner</td>
</tr>
<tr>
<td>Add a Controller (mirror server)</td>
<td>Add a Controller login to the database server currently in the mirror role of a mirrored database</td>
<td>securityadmin *</td>
<td></td>
</tr>
<tr>
<td>Update a schema</td>
<td>Apply schema updates or hotfixes</td>
<td></td>
<td>db_owner</td>
</tr>
</tbody>
</table>

* While technically more restrictive, in practice, the securityadmin server role should be treated as equivalent to the sysadmin server role.

When using Studio to perform these operations, the user account must be a member of the sysadmin server role.

Database address formats

You can specify a database address in one of the following forms:

- ServerName
- ServerName\InstanceName
- ServerName:PortNumber

For an AlwaysOn Availability Group, specify the group's listener in the location field.

Change database locations

After you create a Site, you can change the location of the databases. When you change the location of a database:
- The data in the previous database is not imported to the new database.
- Logs cannot be aggregated from both databases when retrieving logs.
- The first log entry in the new database indicates that a database change occurred, but it does not identify the previous database.

You cannot change the location of the Configuration Logging database when mandatory logging is enabled.

To change the location of a database:

1. Make sure a supported version of Microsoft SQL Server is installed on the server where you want the database to reside. Set up high availability features as needed.
2. Select **Configuration** in the Studio navigation pane.
3. Select the database for which you want to specify a new location and then select **Change Database** in the Actions pane.
4. Specify the new location and the database name.
5. If you want Studio to create the database and you have the appropriate permissions, click **OK**. When prompted, click **OK**, and then Studio will create the database automatically. Studio attempts to access the database using your credentials; if that fails, you are prompted for the database user's credentials. Studio then uploads the database schema to the database. The credentials are retained only for the database creation time frame.
6. If you do not want Studio to create the database, or you do not have sufficient permissions, click **Generate script**. The generated scripts include instructions for manually creating the database and a mirror database, if needed. Before uploading the schema, ensure that the database is empty and that at least one user has permission to access and change the database.
Delivery methods

Feb 24, 2016

It's challenging to meet the needs of every user with one virtualization deployment. XenApp and XenDesktop allow administrators to customize the user experience with a variety of methods sometimes referred to as FlexCast models.

This collection of delivery methods — each with its own advantages and disadvantages — provide the best user experience in any use-case scenario.

Mobilize Windows applications on mobile devices

Touch-screen devices, such as tablets and smartphones, are now standard in mobility. These devices can cause problems when running Windows-based applications that typically utilize full-size screens and rely on right-click inputs for full functionality.

XenApp with Citrix Receiver offers a secure solution that allows mobile-device users access to all the functionality in their Windows-based apps without the cost of rewriting those apps for native mobile platforms.

The XenApp published apps delivery method utilizes HDX Mobile technology that solves the problems associated with mobilizing Windows applications. This method allows Windows applications to be refactored for a touch experience while maintaining features such as multitouch gestures, native menu controls, camera, and GPS functions. Many touch features are available natively in XenApp and XenDesktop and do not require any application source code changes to activate.

These features include:
- Automatic display of the keyboard when an editable field has the focus
- Larger picker control to replace Windows combo box control
- Multitouch gestures, such as pinch and zoom
- Inertia-sensed scrolling
- Touchpad or direct-cursor navigation

Reduce PC refresh costs

Upgrading physical machines is a daunting task many businesses face every three to five years, especially if the business needs to maintain the most up-to-date operating systems and applications. Growing businesses also face daunting overhead costs of adding new machines to their network.

The VDI Personal vDisk delivery method provides fully personalized desktop operating systems to single users on any machine or thin client using server resources. Administrators can create virtual machines whose resources — such as processing, memory, and storage — are stored in the network's data center.

This can extend the life of older machines, keep software up to date, and minimize downtime during upgrades.

Ensure secure access to virtual apps and desktops for contractors and partners

Network security is an ever-growing problem, especially when working with contractors, partners, and other third-party contingent workers who need access to a company’s apps and data. The workers may also need loaner laptops or other devices, which cause additional cost concerns.

Data, applications, and desktops are stored behind the firewall of the secure network with XenDesktop and XenApp, so the only thing the end user transmits is user-device inputs and outputs, such as keystrokes, mouse clicks, audio, and screen
updates. By maintaining these resources in a data center, XenDesktop and XenApp offer a more secure remote access solution than using the typical SSL VPN.

With a VDI with Personal vDisk deployment, administrators can utilize thin clients or users' personal devices by creating a virtual machine on a network server and providing a single-user desktop operating system. This allows IT to maintain security with third-party workers without the need of purchasing expensive equipment.

Accelerate Migration

When switching to a new operating system, IT can face the challenge of delivering legacy and incompatible applications.

With virtual-machine-hosted apps, users can run older applications through Citrix Receiver on the upgraded virtual machine without any compatibility issues. This allows IT additional time to resolve and test application compatibility issues, ease users into the transition, and make help desk calls more efficient.

Additional benefit for using XenDesktop during migration include:
- Reducing complexity for desktops
- Improving IT’s control
- Enhancing end-user flexibility in terms of device usage and workspace location

Enable designers and engineers by virtualizing professional 3-D graphics apps

Many design firms and manufacturing companies rely heavily on professional 3-D graphics applications. These companies face financial strain from the costs of powerful hardware to support this type of software and also logistic problems that come with the sharing of large design files via FTP, email, and similar ad hoc methods.

XenDesktop's hosted physical desktop delivery method provides a single desktop image to workstations and blade servers without the need of hypervisors to run graphic-intensive 3-D applications on a native operating system.

All files are saved in a central data center within the network, so sharing large design files to other users in the network is faster and more secure because the files are not being transferred from one workstation to another.

Transform call centers

Businesses that need large-scale call centers face the difficult challenge of maintaining adequate staffing for peak periods while not overprovisioning machines during less busy hours.

The Pooled VDI delivery method provides multiple users access to a standardized desktop dynamically at a minimal cost when provisioning a large number of users. The pooled machines are allocated on a per-session, first-come, first-served basis.

There is less day-to-day management of these virtual machines because any change made during the session is discarded when the user logs off. This also increases security.

The XenApp hosted desktops delivery method is another viable option for transforming call centers. This method hosts multiple user desktops on a single server-based operating system.

This is a more cost-efficient method than Pooled VDI, but with XenApp hosted desktops, users are restricted from installing applications, changing system settings, and restarting the server.
XenApp published apps and desktops

Sep 09, 2015
Use server OS machines to deliver XenApp published apps and published desktops.

Use case

- You want inexpensive server-based delivery to minimize the cost of delivering applications to a large number of users, while providing a secure, high-definition user experience.
- Your users perform well-defined tasks and do not require personalization or offline access to applications. Users may include task workers such as call center operators and retail workers, or users that share workstations.
- Application types: any application.

Benefits and considerations

- Manageable and scalable solution within your datacenter.
- Most cost effective application delivery solution.
- Hosted applications are managed centrally and users cannot modify the application, providing a user experience that is consistent, safe, and reliable.
- Users must be online to access their applications.

User experience

- User requests one or more applications from StoreFront, their Start menu, or a URL you provide to them.
- Applications are delivered virtually and display seamlessly in high definition on user devices.
- Depending on profile settings, user changes are saved when the user's application session ends. Otherwise, the changes are deleted.

Process, host, and deliver applications

- Application processing takes place on hosting machines, rather than on the user devices. The hosting machine can be a physical or a virtual machine.
- Applications and desktops reside on a server OS machine.
- Machines become available through Machine Catalogs.
- Machines from Machine Catalogs are organized into Delivery Groups that deliver the same set of applications to groups of users.
- Server OS machines support Delivery Groups that host either desktops or applications, or both.

Session management and assignment

- Server OS machines run multiple sessions from a single machine to deliver multiple applications and desktops to multiple, simultaneously connected users. Each user requires a single session from which they can run all their hosted applications.

For example, a user logs on and requests an application. One session on that machine becomes unavailable to other users. A second user logs on and requests an application which that machine hosts. A second session on the same machine is now unavailable. If both users request additional applications, no additional sessions are required because a user can run multiple application using the same session. If two more users log on and request desktops, and two sessions are available on that same machine, that single machine is now using four sessions to host four different users.
Within the Delivery Group to which a user is assigned, a machine on the least loaded server is selected. A machine with session availability is randomly assigned to deliver applications to a user when that user logs on.

To deliver XenApp published apps and desktops:

1. Install the applications you want to deliver on a master image running a supported Windows server OS.
2. Create a Machine Catalog for this master image or update an existing catalog with the master image.
3. Create a Delivery Group to deliver the applications and desktops to users. If you are delivering applications, select those you want to deliver.

See the installation and configuration articles for details.
VM hosted apps

Sep 09, 2015
Use Desktop OS machines to deliver VM hosted applications

Use Case

- You want a client-based application delivery solution that is secure, provides centralized management, and supports a large number of users per host server (or hypervisor), while providing users with applications that display seamlessly in high-definition.
- Your users are internal, external contractors, third-party collaborators, and other provisional team members. Your users do not require offline access to hosted applications.
- Application types: Applications that might not work well with other applications or might interact with the operation system, such as Microsoft .NET framework. These types of applications are ideal for hosting on virtual machines.

Applications running on older operating systems such as Windows XP or Windows Vista, and older architectures, such as 32-bit or 16-bit. By isolating each application on its own virtual machine, if one machine fails, it does not impact other users.

Benefits and considerations

- Applications and desktops on the master image are securely managed, hosted, and run on machines within your datacenter, providing a more cost effective application delivery solution.
- On log on, users can be randomly assigned to a machine within a Delivery Group that is configured to host the same application. You can also statically assign a single machine to deliver an application to a single user each time that user logs on. Statically assigned machines allow users to install and manage their own applications on the virtual machine.
- Running multiple sessions is not supported on desktop OS machines. Therefore, each user consumes a single machine within a Delivery Group when they log on, and users must be online to access their applications.
- This method may increase the amount of server resources for processing applications and increase the amount of storage for users' personal vDisks.

User experience

The same seamless application experience as hosting shared applications on Server OS machines.

Process, host, and deliver applications

The same as server OS machines except they are virtual desktop OS machines.

Session management and assignment

- Desktop OS machines run a single desktop session from a single machine. When accessing applications only, a single user can use multiple applications (and is not limited to a single application) because the operating system sees each application as a new session.
- Within a Delivery Group, when users log on they can access either a statically assigned machine (each time the user logs on to the same machine), or a randomly assigned machine that is selected based on session availability.

To deliver VM hosted apps:

1. Install the applications you want to deliver on a master image running a supported Windows desktop OS.
2. Create a Machine Catalog for this master image or update an existing catalog with the master image.
3. When defining the desktop experience for the machine catalog, decide whether you want users to connect to a new VM each time they log in or connect to the same machine each time they log in.
4. Create a Delivery Group to deliver the application to users.
5. From the list of application installed, select the application you want to deliver.

See the installation and configuration articles for details.
VDI desktops

Sep 09, 2015

Use Desktop OS machines to deliver VDI desktops.

VDI desktops are hosted on virtual machines and provide each user with a desktop operating system.

VDI desktops require more resources than XenApp published desktops, but do not require that applications installed on them support server-based operating systems. In additional, depending on the type of VDI desktop you choose, these desktop can be assigned to individual users and allow these users a high degree of personalization.

When you create a Machine Catalog for VDI desktops, you create one of these types of desktops:

- Random non-persistent desktops, also known as pooled VDI desktops. Each time a users logs on to use one of these desktops, they connect to a dynamically selected desktop in a pool of desktops based on a single master image. All changes to the desktop are lost when the machine reboots.
- Static non-persistent desktop. The first time a user logs on the use one off these desktops, the user is assigned a desktop from a pool of desktops based on a single master image. After the first use, each time a user logs in to use one of these desktop, the user connects to the same desktop that user was assigned on first use. All changes to the desktop are lost when the machine reboots.
- Static persistent, also known as VDI with Personal vDisk. Unlike other types of VDI desktops, these desktops can be fully personalized by users. The first time a user logs on the use one off these desktops, the user is assigned a desktop from a pool of desktops based on a single master image. After the first use, each time a user logs in to use one of these desktop, the user connects to the same desktop that user was assigned on first use. Changes to the desktop are retained when the machine reboots because they are stored in a Personal vDisk.

To deliver VDI desktops:

1. Create a master image running a supported Windows desktop OS.
2. Create a Machine Catalog for this master image or update an existing catalog with the master image. When defining the desktop experience for the machine catalog, decide whether you want users to connect to a new VM each time the log in or connect to the same machine each time they log in and specify how changes to the desktop are retained.
3. Create a Delivery Group to deliver the desktops to users.

See the installation and configuration articles for details.
Install and configure

Feb 24, 2016

Review the referenced articles before starting each deployment step, so that you will be familiar with what you see and specify during the deployment.

Use the following sequence to deploy XenApp or XenDesktop.

Prepare

Review the Prepare to install article, and complete any necessary tasks. That includes:

- Becoming familiar with XenApp and XenDesktop – the article tells you where to find information about concepts, features, differences from earlier releases, system requirements, and databases.
- Setting up your virtualization, hosting, or support environment, if you are using one.
- Setting up machines on which you’ll install components.
- Setting up the Active Directory environment.

This article also explains what information you will need to select or specify when you install components and enable features.

If you will be installing Linux VDAs, be sure to review Red Hat Linux VDAs and SUSE Linux VDAs before beginning the installation.

Install core components

Install the Delivery Controller, Citrix Studio, Citrix Director, Citrix License Server, and Citrix StoreFront. You can use a wizard-based graphical interface or a command line interface, which enables scripted installation. Both methods install most prerequisites automatically.

Create a Site

After you install the core components and launch Studio, you are automatically guided to create a Site using the Site creation wizard.

Install one or more Virtual Delivery Agents (VDAs)

Install a VDA on a machine running a Windows operating system, either on a master image you will use to create virtual machines or directly on each machine. You can use a graphical or command interface. Sample scripts are also provided if you want to install VDAs through Active Directory.

For machines with a Linux operating system, follow the instructions for installing a Red Hat Linux VDA or a SUSE Linux VDA.
For a Remote PC Access deployment, install a VDA for Desktop OS on each office PC; for efficiency, use the standalone VDA installer’s command line interface and your existing Electronic Software Distribution (ESD) methods.

Install other optional components

If you plan to use the Citrix Universal Print Server, install its server component on your print servers. You can use a graphical or command interface.

Optionally, integrate additional Citrix components into your XenApp or XenDesktop deployment. For example:

- Provisioning Services is an optional component of XenApp and XenDesktop that provisions machines by streaming a master image to target devices. See the Provisioning Services documentation.
- Citrix NetScaler Gateway is a secure application access solution that provides administrators granular application-level policy and action controls to secure access to applications and data. See the Citrix NetScaler Gateway documentation.
- Citrix CloudBridge is a set of appliances that optimize WAN performance. See the Citrix CloudBridge documentation.

Create a Machine Catalog

After you create a Site in Studio, you are guided to create a Machine Catalog.

A catalog can contain physical or virtual machines (VMs). Virtual machines can be created from a master image. If you are using a supported hypervisor or cloud service to provide VMs, you must first create a master image on that host. Then, when you create the catalog, you specify that image, which will be used when creating VMs.

Create a Delivery Group

After you create your first Machine Catalog in Studio, you are guided to create a Delivery Group.

A Delivery Group that specifies which users can access machines in a selected Machine Catalog and the applications available to those users.
Prepare to install

Feb 26, 2016
In this article:

- General installation guidance
- What to specify when installing core components
- VDA installation guidance
- What to specify when installing a VDA

General installation guidance

- If you are unfamiliar with the product and its components, review the Technical overview articles. If your current deployment is XenApp 6.x or earlier, the Concepts and components article explains the differences in the 7.x versions of XenApp and XenDesktop.
- When planning your deployment, review the security articles.
- Check the Known issues article for installation issues you might encounter.
- If you are using a supported hypervisor or cloud service to provide virtual machines for applications and desktops, you will configure the first connection to that host when you create a Site, after you install components. However, you can configure the virtualization environment at any time before then. See the information sources listed here.
- If you are using Microsoft System Center Configuration Manager to manage access to applications and desktops, see this article.
- If a component has a .NET prerequisite, the installer will deploy the required .NET version if it is not present. The .NET installation might require a restart of the machine.
- Review the Databases article to learn about the system databases and how to configure them. During Controller installation, you can choose whether to install Microsoft SQL Server 2012 Express on the same server. You configure most database information when you create a Site, after you install the components.
- When you install the Citrix License Server, that user account is automatically made a full administrator on the license server. See the Delegated Administration article for details.
- When you create objects before, during, and after installation, it is best practice to specify unique names for each object - for example networks, groups, catalogs, and resources.
- If a component does not install successfully, the process stops with an error message. Components that installed successfully are retained; you do not need to reinstall them.
- Citrix Studio starts automatically after it is installed. When using the graphical interface, you can disable this action on the final page of the wizard.
- You can use the installer included in the product ISO to install core components and Virtual Delivery Agents (VDAs); this is referred to as the "full-product installer." To install VDAs, you can use either the full-product installer or the standalone VDA installer, which is available on the product download site. Both installers offer graphical and command line interfaces.
- The product installation media contains sample scripts that install, upgrade, or remove VDAs for groups of machines in Active Directory. You can also apply the scripts to individual machines and use them to manage master images used by Machine Creation Services and Provisioning Services. For details, see the Install VDAs using scripts article.
- You can use the full-product installer to install the server component (UpsServer) of the Universal Print Server on your print servers, using either the graphical or command line interface. The product download site may also contain UpsServer download packages.
- The product ISO no longer includes versions of the Citrix Receiver for Mac and the Citrix Receiver for Linux. You (or your users) can download and install the Citrix Receivers from the Citrix website. Alternatively, you can make those Citrix Receivers available from your StoreFront server (see the Make Citrix Receiver installation files available on the server section in the StoreFront 3.0.x documentation, or the equivalent content in the StoreFront version you are using).

Permissions

You must be a domain user and a local administrator on the machines where you are installing components.

To use the standalone VDA installer, you must either have elevated administrative privileges before starting the installation, or use Run as administrator.
Configure your Active Directory domain before beginning an installation.

- The **System requirements** article lists the supported Active Directory functional levels. The **Active Directory** article contains additional support information.
- You must have at least one domain controller running Active Directory Domain Services.
- Do not attempt to install any components on a domain controller.
- Do not use a forward slash (/) when you specify Organizational Unit names in Studio.
- See the Microsoft documentation for Active Directory configuration instructions.

Where to install components

Decide where you will install the components, and then prepare the machines and operating systems.

- Review the **System requirements** article for supported operating systems and versions for the Controller, Studio, Citrix Director, virtualization resources (hosts), and VDAs. Most component prerequisites are installed automatically; exceptions are noted in that article. See the Citrix StoreFront and the Citrix License Server documents for their supported platforms.
- You can install the core components on the same server or on different servers. For example, to manage a smaller deployment remotely, you can install Studio on a different machine than the server where you installed the Controller. To accommodate future expansion, consider installing components on separate servers; for example, install the License Server and Director on different servers.
- You can install both the Delivery Controller and the Virtual Delivery Agent for Windows Server OS on the same server. To do this, launch the installer and select the Delivery Controller (plus any other core components you want on that machine); then launch the installer again and select the Virtual Delivery Agent for Windows Server OS.
- Do not install any components on a domain controller.
- Installing a Controller on a node in a SQL Server clustering installation, SQL Server mirroring installation, or on a server running Hyper-V is not supported.
- Do not install Studio on a server running XenApp 6.5 Feature Pack 2 for Windows Server 2008 R2 or any earlier version of XenApp.
- Be sure that each operating system has the latest updates.
- Be sure that all machines have synchronized system clocks. Synchronization is required by the Kerberos infrastructure that secures communication between the machines.

What to specify when installing core components

The following sections explain what you see and specify during installation. It follows the sequence of the **graphical interface wizard**; equivalent **command line** options are also provided. The installation articles provide details about how to launch the wizards and issue commands with options.

Features used with core components

Choose or specify whether to install Microsoft SQL Server Express. If you're not familiar with the databases, review the **Databases** article. (Command line option: /nosql to prevent installation)

When you install Director, Windows Remote Assistance is installed automatically. You can choose whether to enable shadowing in Windows Remote Assistance for use with Director user shadowing, and open TCP port 3389. By default, this is enabled. (Command line option: /no_remote_assistance)

Firewall ports for core components
By default, the following ports are opened automatically if the Windows Firewall Service is running, even if the firewall is not enabled. You can disable this default action and open the ports manually if you use a third-party firewall or no firewall, or if you prefer to do it yourself. For complete port information about this and other Citrix products, see CTX101810. (Command line option: /configure_firewall)

- Controller: TCP 80, 443
- Director: TCP 80, 443
- License Server: TCP 7279, 8082, 8083, 27000
- StoreFront: TCP 80, 443

### VDA installation guidance

- The VDA installers offer graphical and command line interfaces.
- Review the System requirements article for supported operating systems and versions for VDAs. Most component prerequisites are installed automatically; exceptions are noted in that article. When you install a VDA for Windows Server OS, Remote Desktop Services role services are automatically installed and enabled, if they are not already installed and enabled.
- If you installing a VDA on a Windows 7 or Windows Server 2008 R2 machine, verify that .NET 3.5.1 is installed before you start the VDA installation. The Restarts section below has addition installation prerequisite considerations.
- The Print Spooler Service is enabled by default on supported Windows servers. If you disable this service, you cannot successfully install a VDA for Windows Server OS, so make sure that this service is enabled before installing a VDA.
- Profile management is installed automatically during VDA installation. Although you can exclude it if you are using the command line interface, that exclusion will affect monitoring and troubleshooting of VDAs with Director.
- When you install the VDA, a new local user group called Direct Access Users is created automatically. On a VDA for Windows Desktop OS, this group applies only to RDP connections; on a VDA for Windows Server OS, this group applies to ICA and RDP connections.
- For Remote PC Access configurations, install the VDA for Windows Desktop OS on each physical office PC that users will access remotely. Do not enable the optimize feature.
- If you are installing a VDA on a machine running a supported Linux operating system, see Red Hat Linux VDAs or SUSE Linux VDAs for essential information.
- The VDA must have valid Controller addresses with which to communicate; otherwise, sessions cannot be established. You can specify Controller addresses when you install the VDA or later; just remember it must be done! For more information, see the Delivery Controller addresses section below.
- After you install a VDA for Server OS on a Windows Server 2012 R2 system, use the Kerberos Enable Tool (XASsonKerb.exe) to ensure the correct operation of Citrix Kerberos authentication. The tool is located in the Support > Tools > XASsonKerb folder on the installation media; you must have local administrator privileges to use the tool. Run xassonkerb.exe -install from a command prompt on the server. If you later apply an update that changes the registry location HKLM\System\CurrentControlSet\Control\LSA\OSConfig, run the command again. To see all available tool options, run the command with the -help parameter.

### Available VDA installers: full-product and standalone

You can install a VDA using the full-product installer or a standalone installation package. Both offer graphical and command line interfaces.

The full-product installer automatically detects your operating system and allows you to install only the Windows VDA supported on that system VDA for Windows Server OS or VDA for Windows Desktop OS.

### Standalone VDA installation package

The smaller standalone package more easily accommodates deployments using Electronic Software Distribution (ESD) packages that are staged or copied locally, have physical machines, or have remote offices. The standalone package is intended primarily for deployments that use command line (silent) installation; it supports the same command line parameters as the full-product installer. The package also offers a graphical interface that is equivalent to the full-product installer.
How to use the graphical interface for the standalone VDA installer.

How to use the command line interface for the standalone VDA installer.

There are two self-extracting standalone VDA installer packages: one for installation on supported server OS machines, and another for supported workstation (desktop) OS machines.

By default, files in the package are extracted to the Temp folder. More disk space is required on the machine when extracting to the Temp folder than when using the full-product installer. Files extracted to the Temp folder are not automatically deleted, but you can manually delete them (from C:\Windows\Temp\Ctx-* where * is a random Globally Unique Identifier) after the installation completes. Alternatively, you can use the /extract command with an absolute path.

If your deployment uses Microsoft System Center Configuration Manager, a VDA installation might appear to fail with exit code 3, even though the VDA installed successfully. To avoid the misleading message, you can wrap your installation in a CMD script or change the success codes in your Configuration Manager package. For more information, see the forum discussion at http://discussions.citrix.com/topic/350000-sccm-install-of-vda-71-fails-with-exit-code-3/.

Restarts

A restart is required at the end of the VDA installation.

If you want to minimize the number of additional restarts needed during the installation sequence:

- Ensure that a supported .NET Framework version is installed before beginning the VDA installation.
- For Windows Server OS machines, install and enable the RDS role services before installing the VDA.

Other prerequisites do not typically require machine restarts, so you can let the installer take care of those for you.

If you do not install prerequisites before beginning the VDA installation, and you specify the /noreboot option for a command line installation, you must manage the restarts. For example, when using automatic prerequisite deployment, the installer will suspend after installing RDS, waiting for a restart; be sure to run the command again after the restart, to continue with the VDA installation.

VDAs on unsupported Windows systems

The latest VDAs are not supported on Windows XP or Windows Vista systems; additionally, some of the features in this and other recent releases cannot be used on those operating systems. Citrix recommends you replace those systems with currently-supported Windows desktop OS versions and then install a VDA from this release. If you must continue to accommodate machines running Windows XP or Windows Vista, you can install an earlier Virtual Desktop Agent version (5.6 FP1 with certain hotfixes). See CTX140941 for details. Keep in mind that:

- You cannot install core components (Controller, Studio, Director, StoreFront, License Server) on a Windows XP or Windows Vista system.
- If you use Windows XP or Windows Vista systems, when you create a Machine Catalog containing those machines, be sure to choose the 5.6 FP1 entry in the “Select the VDA version installed...” listbox on the Master Image page.
- Remote PC Access is not supported on Windows Vista systems.
- Citrix support for Windows XP ended April 8, 2014 when Microsoft ended its extended support.
- Continuing to use older VDAs can affect feature availability and VDA registration with the Controller; see Mixed environment considerations.
What to specify when installing a VDA

The following sections explain what you specify during installation. It follows the sequence of the graphical interface wizard; equivalent command-line options are also provided. The installation articles provide details about how to launch the wizards or issue commands with options.

Check **VDA installation guidance** for tasks you may need to complete after VDA installation.

Environment

The VDA environment specifies how you will use the VDA:

- The default "master image" option indicates you will use Machine Creation Services (MCS) or Provisioning Services to create virtual machines based on a master image created in a hypervisor or cloud service. You install the VDA on the master image. (Command line option: /masterimage)
- The "Remote PC Access" option indicates you will install the VDA on a physical machine or on a VM that was provisioned without a VDA.

HDX 3D Pro (VDA for Windows Desktop OS version)

When you install a VDA for Windows Desktop OS, you are offered the option to install the standard or the HDX 3D Pro version of the VDA.

- The standard VDA is recommended for most desktops, including those enabled with Microsoft RemoteFX. This is the version installed by default.
- The VDA for HDX 3D Pro optimizes the performance of graphics-intensive programs and media-rich applications. It is recommended if the machine will access a graphics processor for 3D rendering. (Command line option: /enable_hdx_3d_pro)

Core Components (installation location and Citrix Receiver installation)

Components are installed in C:\Program Files\Citrix by default. You can specify a different location during installation, but it must have execute permissions for network service. (Command line option: /installdir to specify nondefault directory)

By default, Citrix Receiver for Windows is installed with the VDA. You can disable this default action. (Command line option: use "/components vda" to prevent Citrix Receiver installation)

Delivery Controller

You can specify the addresses (FQDNs) of installed Controllers either when you install the VDA (recommended) or later. Although you are not required to specify Controller addresses when you install a VDA, keep in mind that a VDA cannot register with a Controller without this information. If VDAs cannot register, users on machines containing those VDAs will be unable to access their applications and desktops. (Command line option: /controllers)

- If you specify Controller FQDNs when you install the VDA, the installer attempts to connect to the specified addresses. If the connection attempt fails, the installer provides informative messages.
- If you choose to specify Controller addresses later, the installer reminds you of that requirement. If you install a VDA without specifying a Controller address, you can either rerun the installer later or use Citrix Group Policy.

If you specify Controller addresses both during VDA installation and in Group Policy, the policy settings override settings
Remember that successful VDA registration also requires that the firewall ports used for communication with the Controller are open.

After you initially specify Controller locations (either when installing the VDA or later), you can use the auto-update feature to update VDAs when additional Controllers are installed.

For more information about how VDAs discover and register with Controllers, see the Delivery Controllers article.

Features

You can enable or disable the following features that are used with VDAs:

- **Optimize performance**: (Default = enabled) When this feature is selected, the optimization tool is used for VDAs running in a VM on a hypervisor. VM optimization includes disabling of file I/O, disabling background defragmentation, and reducing event log size. For more information, see CTX125874. Do not enable this option if you will be using Remote PC Access. (Command line option: /optimize)

- **Use Windows Remote Assistance**: (Default = enabled) When this feature is selected, Windows Remote Assistance is used with the user shadowing feature of Director, and Windows automatically opens TCP port 3389 in the firewall, even if you choose to open firewall ports manually. (Command line option: /enable_remote_assistance)

- **Use Real-Time Audio Transport for audio**: Default = enabled) When this feature is selected, UDP is used for audio packets, which can improve audio performance. (Command line option: /enable_real_time_transport)

- **Framehawk**: (Default = enabled) When selected, bidirectional UDP ports 3224-3324 are opened. (You can change the port range later with the “Framehawk display channel port range” Citrix policy setting; you must then open local firewall ports.) A UDP network path must be open on any internal (VDA to Citrix Receiver; or VDA to NetScaler Gateway) and external (NetScaler Gateway to Citrix Receiver) firewalls. If NetScaler Gateway is deployed, Framehawk datagrams are encrypted using DTLS (default UDP port 443). For more information, see the Framehawk article. (Command line option: /enable_framehawk_port)

- **Install Citrix App-V publishing components**: (Default: enabled) Select this feature if you will use applications from Microsoft App-V packages. For more information, see the App-V article. (Command line option: /install_appv)

- **Personal vDisk**: (Default = disabled; available only when installing a VDA for Desktop OS on a VM.) When this feature is selected, Personal vDisks can be used with a master image. For more information, see the Personal vDisks articles. (Command line option: /baseimage)

Firewall

By default, the following ports are opened automatically if the Windows Firewall Service is running, even if the firewall is not enabled. You can disable this default action and open the ports manually if you use a third-party firewall or no firewall, or if you prefer to do it yourself. For complete port information, see CTX101810. (Command line option: /enable_hdx_ports)

- **Controller Communications**: TCP 80, 1494, 2598, 8008. For communication between user devices and virtual desktops, configure inbound TCP on ports 1494 and 2598 as port exceptions. For security, Citrix recommends that you do not use these registered ports for anything other than the ICA protocol and the Common Gateway Protocol. For communication between Controllers and virtual desktops, configure inbound port 80 as a port exception.

- **Remote Assistance**: TCP 3389. Windows opens this port automatically if the Windows Remote Assistance feature is enabled on the previous page, even if you choose to open the ports manually.

- **Real Time Audio**: UDP 16500-16509.

- **Framehawk**: UDP 3224-3324.
Summary

After you review the information presented and click **Install**, the display shows the progress of the installation. After the installation completes, a machine restart is required before the VDA can be used.
## VMware virtualization environments

May 10, 2016

Follow this guidance if you use VMware to provide virtual machines.

### Install and configure your hypervisor

1. Install vCenter Server and the appropriate management tools. (No support is provided for vSphere vCenter Linked Mode operation.)
2. Create a VMware user account with the following permissions, at the DataCenter level, at a minimum. This account has permissions to create new VMs and is used to communicate with vCenter.

<table>
<thead>
<tr>
<th>SDK</th>
<th>User Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datastore.AllocateSpace</td>
<td>Datastore &gt; Allocate space</td>
</tr>
<tr>
<td>Datastore.Browse</td>
<td>Datastore &gt; Browse datastore</td>
</tr>
<tr>
<td>Datastore.FileManagement</td>
<td>Datastore &gt; Low level file operations</td>
</tr>
<tr>
<td>Network.Assign</td>
<td>Network &gt; Assign network</td>
</tr>
<tr>
<td>Resource.AssignVMToPool</td>
<td>Resource &gt; Assign virtual machine to resource pool</td>
</tr>
<tr>
<td>Task.Create</td>
<td>Tasks &gt; Create task</td>
</tr>
<tr>
<td>VirtualMachine.Config.AddRemoveDevice</td>
<td>Virtual machine &gt; Configuration &gt; Add or remove device</td>
</tr>
<tr>
<td>VirtualMachine.Config.AddExistingDisk</td>
<td>Virtual machine &gt; Configuration &gt; Add existing disk</td>
</tr>
<tr>
<td>VirtualMachine.Config.AddNewDisk</td>
<td>Virtual machine &gt; Configuration &gt; Add new disk</td>
</tr>
<tr>
<td>VirtualMachine.Config.CPUCount</td>
<td>Virtual machine &gt; Configuration &gt; Change CPU Count</td>
</tr>
<tr>
<td>VirtualMachine.Config.Memory</td>
<td>Virtual machine &gt; Configuration &gt; Memory</td>
</tr>
<tr>
<td>VirtualMachine.Config.RemoveDisk</td>
<td>Virtual machine &gt; Configuration &gt; Remove disk</td>
</tr>
</tbody>
</table>

[1] Install vCenter Server and the appropriate management tools. (No support is provided for vSphere vCenter Linked Mode operation.)

[2] Create a VMware user account with the following permissions, at the DataCenter level, at a minimum. This account has permissions to create new VMs and is used to communicate with vCenter.
<table>
<thead>
<tr>
<th><strong>SDK</strong></th>
<th><strong>User Interface</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.Config.Settings</td>
<td>Virtual machine &gt; Configuration &gt; Settings</td>
</tr>
<tr>
<td>VirtualMachine.Interact.Reset</td>
<td>Virtual machine &gt; Interaction &gt; Reset</td>
</tr>
<tr>
<td>VirtualMachine.Inventory.Create</td>
<td>Virtual machine &gt; Inventory &gt; Create new</td>
</tr>
<tr>
<td>VirtualMachine.Inventory.CreateFromExisting</td>
<td>Virtual machine &gt; Inventory &gt; Create from existing</td>
</tr>
<tr>
<td>VirtualMachine.Inventory.Delete</td>
<td>Virtual machine &gt; Inventory &gt; Remove</td>
</tr>
<tr>
<td>VirtualMachine.Inventory.Register</td>
<td>Virtual machine &gt; Inventory &gt; Register</td>
</tr>
<tr>
<td>VirtualMachine.Provisioning.Clone</td>
<td>Virtual machine &gt; Provisioning &gt; Clone virtual machine</td>
</tr>
<tr>
<td>VirtualMachine.Provisioning.CloneTemplate</td>
<td>Virtual machine &gt; Provisioning &gt; Clone template</td>
</tr>
<tr>
<td>VirtualMachine.Provisioning.GetVmFiles</td>
<td>Virtual machine &gt; Provisioning &gt; Allow virtual machine download</td>
</tr>
<tr>
<td>VirtualMachine.Provisioning.PutVmFiles</td>
<td>Virtual machine &gt; Provisioning &gt; Allow virtual machine files upload</td>
</tr>
<tr>
<td>VirtualMachine.Provisioning.DeployTemplate</td>
<td>Virtual machine &gt; Provisioning &gt; Deploy template</td>
</tr>
<tr>
<td>VirtualMachine.Provisioning.MarkAsVM</td>
<td>Virtual machine &gt; Provisioning &gt; Mark as virtual machine</td>
</tr>
<tr>
<td>VirtualMachine.State.CreateSnapshot</td>
<td>vSphere 5.0, Update 2 and vSphere 5.1, Update 1: Virtual machine &gt; State &gt; Create snapshot</td>
</tr>
<tr>
<td></td>
<td>vSphere 5.5: Virtual machine &gt; Snapshot management &gt; Create snapshot</td>
</tr>
<tr>
<td>VirtualMachine.State.RemoveSnapshot</td>
<td>vSphere 5.0, Update 2 and vSphere 5.1, Update 1: Virtual machine &gt; State &gt; Remove snapshot</td>
</tr>
<tr>
<td></td>
<td>vSphere 5.5: Virtual machine &gt; Snapshot management &gt; Remove snapshot</td>
</tr>
</tbody>
</table>
3. If you want the VMs you create to be tagged, add the following permissions for the user account:

<table>
<thead>
<tr>
<th>SDK</th>
<th>User Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.State.RevertToSnapshot</td>
<td>vSphere 5.0, Update 2 and vSphere 5.1, Update 1: Virtual machine &gt; State &gt; Revert to snapshot</td>
</tr>
<tr>
<td></td>
<td>vSphere 5.5: Virtual machine &gt; Snapshot management &gt; Revert to snapshot</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SDK</th>
<th>User Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global.ManageCustomFields</td>
<td>Global &gt; Manage custom attributes</td>
</tr>
<tr>
<td>Global.SetCustomField</td>
<td>Global &gt; Set custom attribute</td>
</tr>
</tbody>
</table>

To ensure that you use a clean base image for creating new VMs, tag VMs created with Machine Creation Services to exclude them from the list of VMs available to use as base images.

4. To create AppDisks, the user account must have the following additional permission:

<table>
<thead>
<tr>
<th>SDK</th>
<th>User Interface</th>
</tr>
</thead>
</table>

**Obtain and import a certificate**

To protect vSphere communications, Citrix recommends that you use HTTPS rather than HTTP. HTTPS requires digital certificates. Citrix recommends you use a digital certificate issued from a certificate authority in accordance with your organization’s security policy.

If you are unable to use a digital certificate issued from a certificate authority, and your organization’s security policy permits it, you can use the VMware-installed self-signed certificate. Add the VMware vCenter certificate to each Controller.

Follow this procedure:

1. Add the fully qualified domain name (FQDN) of the computer running vCenter Server to the hosts file on that server, located at %SystemRoot%/WINDOWS/system32/Drivers/etc/. This step is required only if the FQDN of the computer running vCenter Server is not already present in the domain name system.

2. Obtain the vCenter certificate using any of the following methods:

   - **From the vCenter server:**
     1. Copy the file rui.crt from the vCenter server to a location accessible on your Delivery Controllers.
     2. On the Controller, navigate to the location of the exported certificate and open the rui.crt file.
   - **Download the certificate using a web browser.** If you are using Internet Explorer, depending on your user account, you may need to right-click on Internet Explorer and choose Run as Administrator to download or install the certificate.
     1. Open your web browser and make a secure web connection to the vCenter server, for example https://server1.domain1.com
     2. Accept the security warnings.
     3. Click on the address bar where it shows the certificate error.
     4. View the certificate and click on the Details tab.
     5. Select Copy to file and export in .CER format, providing a name when prompted to do so.
     6. Save the exported certificate.
     7. Navigate to the location of the exported certificate and open the .CER file.
   - **Import directly from Internet Explorer running as an administrator:**
1. Open your web browser and make a secure web connection to the vCenter server; for example https://server1.domain1.com.
2. Accept the security warnings.
3. Click on the address bar where it shows the certificate error.
4. View the certificate.
   • Import the certificate into the certificate store on each of your Controllers:
     1. Click Install certificate, select Local Machine, and then click Next.
     2. Select Place all certificates in the following store, and then click Browse.
     3. If you are using Windows Server 2008 R2:
        1. Select the Show physical stores check box.
        2. Expand Trusted People.
        3. Select Local Computer.
        4. Click Next, then click Finish.
        If you are using Windows Server 2012 or Windows Server 2012 R2:
        1. Select Trusted People, then click OK.
        2. Click Next, then click Finish.

   Important: If you change the name of the vSphere server after installation, you must generate a new self-signed certificate on that server before importing the new certificate.

Create a master VM

Use a master VM to provide user desktops and applications. On your hypervisor:
1. Install a VDA on the master VM, selecting the option to optimize the desktop, which improves performance.
2. Take a snapshot of the master VM to use as a back-up.

Create virtual desktops

If you are using Studio to create VMs, rather than selecting an existing Machine Catalog, specify the following information when setting up your hosting infrastructure to create virtual desktops.
1. Select the VMware vSphere host type.
2. Enter the address of the access point for the vCenter SDK.
3. Enter the credentials for the VMware user account you set up earlier that has permissions to create new VMs. Specify the username in the form domain/username.

VMware SSL thumbprint

The VMware SSL thumbprint feature addresses a frequently-reported error when creating a host connection to a VMware vSphere hypervisor. Previously, administrators had to manually create a trust relationship between the Delivery Controllers in the Site and the hypervisor’s certificate before creating a connection. The VMware SSL thumbprint feature removes that manual requirement: the untrusted certificate's thumbprint is stored on the Site database so that the hypervisor can be continuously identified as trusted by XenApp or XenDesktop, even if not by the Controllers.

When creating a vSphere host connection in Studio, a dialog box allows you to view the certificate of the machine you are connecting to. You can then choose whether to trust it.
Microsoft System Center Virtual Machine Manager
virtualization environments

Sep 09, 2015
Follow this guidance if you use Hyper-V with Microsoft System Center Virtual Machine Manager (VMM) to provide virtual machines.

This release supports:

- **VMM 2012** — Provides improved management capabilities, letting you manage the entire virtualized datacenter as well as virtual machines. This release now orchestrates cluster host patching as well as integrating with Windows Server Update Services, allowing you to define baselines of patches that each host needs.

- **VMM 2012 SP1** — Provides performance improvements for Machine Creation Services (MCS) when using SMB 3.0 on file servers with clustered shared volumes and Storage Area Networks (SANs). These file shares provide low cost caching and reduced IO on the SAN storage improving the performance.

- **VMM 2012 R2** — Enables at-scale management of major Windows Server 2012 R2 capabilities, including running VM snapshots, dynamic VHDX resize, and Storage Spaces.

This release supports only Generation 1 virtual machines with VMM 2012 R2. Generation 2 virtual machines are not supported for Machine Creation Services (MCS) and Provisioning Services deployments. When creating VMs with MCS or Provisioning Services, Generation 2 VMs do not appear in the selection list for a master VM; they have Secure Boot enabled by default, which prevents the VDA from functioning properly.

Upgrade VMM

- **Upgrade from VMM 2012 to VMM 2012 SP1 or VMM 2012 R2**

A mixed Hyper-V cluster is not supported. An example of a mixed cluster is one in which half the cluster is running Hyper-V 2008 and the other is running Hyper-V 2012.

- **Upgrade from VMM 2008 R2 to VMM 2012 SP1**
  If you are upgrading from XenDesktop 5.6 on VMM 2008 R2, follow this sequence to avoid XenDesktop downtime.
  1. Upgrade VMM to 2012 (now running XenDesktop 5.6 and VMM 2012)
  2. Upgrade XenDesktop to the latest version (now running the latest XenDesktop and VMM 2012)
  3. Upgrade VMM from 2012 to 2012 SP1 (now running the latest XenDesktop and VMM 2012 SP1)

- **Upgrade from VMM 2012 SP1 to VMM 2012 R2**
  If you are starting from XenDesktop or XenApp 7.x on VMM 2012 SP1, follow this sequence to avoid XenDesktop downtime.
  1. Upgrade XenDesktop or XenApp to the latest version (now running the latest XenDesktop or XenApp, and VMM 2012 SP1)
  2. Upgrade VMM 2012 SP1 to 2012 R2 (now running the latest XenDesktop or XenApp, and VMM 2012 R2)

Installation and configuration summary

1. Install and configure a hypervisor.
   1. Install Microsoft Hyper-V server and VMM on your servers. All Delivery Controllers must be in the same forest as the
VMM servers.

2. Install the System Center Virtual Machine Manager console on all Controllers.

3. Verify the following account information:
   - The account you use to specify hosts in Studio is a VMM administrator or VMM delegated administrator for the relevant Hyper-V machines. If this account only has the delegated administrator role in VMM, the storage data is not listed in Studio during the host creation process.
   - The user account used for Studio integration must also be a member of the administrators local security group on each Hyper-V server to support VM life cycle management (such as VM creation, update, and deletion).

Note: Installing a Controller on a server running Hyper-V is not supported.

2. Create a master VM.
   1. Install a Virtual Delivery Agent on the master VM, and select the option to optimize the desktop. This improves performance.
   2. Take a snapshot of the master VM to use as a backup.

3. Create virtual desktops. If you are using MCS to create VMs, when creating a Site or a connection,
   1. Select the Microsoft virtualization host type.
   2. Enter the address as the fully qualified domain name of the host server.
   3. Enter the credentials for the administrator account you set up earlier that has permissions to create new VMs.
   4. In the Host Details dialog box, select the cluster or standalone host to use when creating new VMs.
      Important: Browse for and select a cluster or standalone host even if you are using a single Hyper-V host deployment.

MCS on SMB 3 file shares

For Machine Catalogs created with MCS on SMB 3 file shares for VM storage, make sure that credentials meet the following requirements so that calls from the Controller's Hypervisor Communications Library (HCL) connect successfully to SMB storage:

- VMM user credentials must include full read write access to the SMB storage.
- Storage virtual disk operations during VM life cycle events are performed through the Hyper-V server using the VMM user credentials.

When you use SMB as storage, enable the Authentication Credential Security Support Provider (CredSSP) from the Controller to individual Hyper-V machines when using VMM 2012 SP1 with Hyper-V on Windows Server 2012. For more information, see CTX137465.

Using a standard PowerShell V3 remote session, the HCL uses CredSSP to open a connection to the to Hyper-V machine. This feature passes Kerberos-encrypted user credentials to the Hyper-V machine, and the PowerShell commands in the session on the remote Hyper-V machine run with the credentials provided (in this case, those of the VMM user), so that communication commands to storage work correctly.

The following tasks use PowerShell scripts that originate in the HCL and are then sent to the Hyper-V machine to act on the SMB 3.0 storage.

- **Consolidate Master Image** - A master image creates a new MCS provisioning scheme (machine catalog). It clones and flattens the master VM ready for creating new VMs from the new disk created (and removes dependency on the original master VM).

  ConvertVirtualHardDisk on the root\virtualization\v2 namespace

  Example:
  ```powershell
  $ims = Get-WmiObject -class $class -namespace "root\virtualization\v2";
  $result = $ims.ConvertVirtualHardDisk($diskName, $vhdastext)
  ```
Create difference disk - Creates a difference disk from the master image generated by consolidating the master image. The difference disk is then attached to a new VM.

CreateVirtualHardDisk on the root\virtualization\v2 namespace

Example:
```
$ims = Get-WmiObject -class $class -namespace "root\virtualization\v2";
$result = $ims.CreateVirtualHardDisk($vhdastext);
```

Upload identity disks - The HCL cannot directly upload the identity disk to SMB storage. Therefore, the Hyper-V machine must upload and copy the identity disk to the storage. Because the Hyper-V machine cannot read the disk from the Controller, the HCL must first copy the identity disk through the Hyper-V machine as follows.

1. The HCL uploads the Identity to the Hyper-V machine through the administrator share.
2. The Hyper-V machine copies the disk to the SMB storage through a PowerShell script running in the PowerShell remote session. A folder is created on the Hyper-V machine and the permissions on that folder are locked for the VMM user only (through the remote PowerShell connection).
3. The HCL deletes the file from the administrator share.
4. When the HCL completes the identity disk upload to the Hyper-V machine, the remote PowerShell session copies the identity disks to SMB storage and then deletes it from the Hyper-V machine.

The identity disk folder is recreated if it is deleted so that it is available for reuse.

Download identity disks - As with uploads, the identity disks pass through the Hyper-V machine to the HCL. The following process creates a folder that only has VMM user permissions on the Hyper-V server if it does not exist.

1. The HyperV machine copies the disk from the SMB storage to local Hyper-V storage through a PowerShell script running in the PowerShell V3 remote session.
2. HCL reads the disk from the Hyper-V machine's administrator share into memory.
3. HCL deletes the file from the administrator share.

Personal vDisk creation - If the administrator creates the VM in a Personal vDisk machine catalog, you must create an empty disk (PvD).

The call to create an empty disk does not require direct access to the storage. If you have PvD disks that reside on different storage than the main or operating system disk, then the use remote PowerShell to create the PvD in a directory folder that has the same name of the VM from which it was created. For CSV orLocalStorage, do not use remote PowerShell. Creating the directory before creating an empty disk avoids VMM command failure.

From the Hyper-V machine, perform a mkdir on the storage.
Microsoft Azure virtualization environments

Oct 23, 2015

Connection configuration

When using Studio to create a Microsoft Azure connection, you need information from the Microsoft Azure Publish Settings file. The information in that XML file for each subscription looks similar to the sample below (your actual management certificate will be much longer):

```
<Subscription
  ServiceManagementUrl="https://management.core.windows.net"
  Id="o1455234-0r10-nb93-at53-21zx6b87aabb7p"
  Name="Test1"
  ManagementCertificate=";alkjdflaksdfj;akjsdfl;akjsdfl; sdjfklasdfilaskjdfkluqweiopruaiopdfaklsdjfjsdlf;asdkl;jfjeriou" />
```

The following procedure assumes you are creating a connection from Studio, and have launched either the Site creation wizard or the connection creation wizard.

1. In a browser, go to https://manage.windowsazure.com/publishsettings/index.
2. Download the Publish Settings file.
3. In Studio, on the Connection page of the wizard, after you select the Microsoft Azure connection type, click Import.
4. If you have more than one subscription, you are prompted to select the subscription you want.

The ID and certificate are automatically and silently imported into Studio.

Power actions using a connection are subject to thresholds. Generally, the default values are appropriate and should not be changed. However, you can edit a connection and change them (you cannot change these values when you create the connection). For details, see Edit a connection.

Virtual machines

When creating a Machine Catalog in Studio, selecting the size of each virtual machine depends on the options presented by Studio, the cost and performance of the selected VM instance type, and scalability.

Studio presents all of the VM instance options that Microsoft Azure makes available in a selected region; Citrix cannot change this presentation. Therefore, you should be familiar with your applications and their CPU, memory, and I/O requirements. Several choices are available at different price and performance points; see the following Microsoft articles to better understand the options.


Basic tier: VMs prefixed with "Basic" represent the basic disk. They are limited primarily by the Microsoft supported IOPS level of 300. These are not recommended for Desktop OS (VDI) or Server OS RDSH (Remote Desktop Session Host) workloads.
**Standard tier:** Standard tier VMs appear in four series: A, D, DS, and G.

<table>
<thead>
<tr>
<th>Series</th>
<th>Appear in Studio as</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Extra small, small, medium, large, extra large, A5, A6, A7, A8, A9, A10, A11. Medium and large are recommended to test using Desktop OS (VDI) or Server OS (RDSH) workloads, respectively.</td>
</tr>
<tr>
<td>D</td>
<td>Standard_D1, D2, D3, D4, D11, D12, D13, D14. These VMs offer SSD for temporary storage.</td>
</tr>
<tr>
<td>DS</td>
<td>Standard_DS1, DS2, DS3, DS4, DS11, DS12, DS13, DS14. These VMs offer local SSD storage for all disks.</td>
</tr>
<tr>
<td>G</td>
<td>Standard_G1 – G5. These VMs are for high performance computing.</td>
</tr>
</tbody>
</table>

**Cost and performance of VM instance types**


When working with cloud environments, it is important to understand your actual computing requirements. For proof of concept or other testing activities, it can be tempting to leverage the high-performance VM instance types. It may also be tempting to use the lowest-performing VMs to save on costs. The better goal is to use a VM appropriate for the task. Starting with the best-performing may not get the results you need, and will become very expensive over time - in some cases, within a week. For lower-performing VM instance types with a lower cost, the performance and usability may not be appropriate for the task.

For Desktop OS (VDI) or Server OS (RDSH) workloads, testing results using LoginVSI against its medium workload found that instance types Medium (A2) and Large (A3) offered the best price/performance ratio.

Medium (A2) and Large (A3 or A5) represent the best cost/performance for evaluating workloads. Anything smaller is not recommended. More capable VM series may offer your applications or users the performance and usability they demand; however, it is best to baseline against one of these three instance types to determine if the higher cost of a more capable VM instance type provides true value.

**Scalability**

Several constraints affect the scalability of catalogs in a hosting unit. Some constraints, such as the number of CPU cores in an Azure subscription, can be mitigated by contacting Microsoft Azure support to increase the default value (20). Others, such as the number of VMs in a virtual network per subscription (2048), cannot change.

Currently, Citrix supports 40 VMs in a catalog.

To scale up the number of VMs in a catalog or a host, contact Microsoft Azure support. The Microsoft Azure default limits prevent scaling beyond a certain number of VMs; however, this limit changes often, so check the latest information: [http://azure.microsoft.com/en-us/documentation/articles/azure-subscription-service-limits/](http://azure.microsoft.com/en-us/documentation/articles/azure-subscription-service-limits/).

A Microsoft Azure virtual network supports up to 2048 VMs.
Microsoft recommends a limit of 40 standard disk VM images per cloud service. When scaling, consider the number of cloud services required for the number of VMs in the entire connection. Also consider VMS needed to provide the hosted applications.

Contact Microsoft Azure support to determine if the default CPU core limitations must be increased to support your workloads.
Sites that use System Center Configuration Manager (Configuration Manager) 2012 to manage access to applications and desktops on physical devices can extend that use to XenApp or XenDesktop through these integration options.

- **Citrix Connector 7.5 for Configuration Manager 2012** – Citrix Connector provides a bridge between Configuration Manager and XenApp or XenDesktop. The Connector enables you to unify day-to-day operations across the physical environments you manage with Configuration Manager and the virtual environments you manage with XenApp or XenDesktop. For information about the Connector, see [Citrix Connector 7.5 for System Center Configuration Manager 2012](#).
- **Configuration Manager Wake Proxy feature** – Whether or not your environment includes Citrix Connector, the Remote PC Access Wake on LAN feature requires Configuration Manager. For more information, see below.
- **XenApp and XenDesktop properties** – XenApp and XenDesktop properties enable you to identify Citrix virtual desktops for management through Configuration Manager. These properties are automatically used by the Citrix Connector but can also be manually configured, as described in the following section.

Properties

Properties are available to Microsoft System Center Configuration Manager 2012 and 2012 R2 to manage virtual desktops.

Boolean properties displayed in Configuration Manager 2012 may appear as 1 or 0, not true or false.

The properties are available for the `Citrix_virtualDesktopInfo` class in the `Root\Citrix\DesktopInformation` namespace. Property names come from the Windows Management Instrumentation (WMI) provider.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AssignmentType</td>
<td>Sets the value of IsAssigned. Valid values:</td>
</tr>
<tr>
<td></td>
<td>- ClientIP</td>
</tr>
<tr>
<td></td>
<td>- ClientName</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- User – Sets IsAssigned to True</td>
</tr>
<tr>
<td>BrokerSiteName</td>
<td>Site; returns the same value as HostIdentifier.</td>
</tr>
<tr>
<td>DesktopCatalogName</td>
<td>Machine Catalog associated with the desktop.</td>
</tr>
<tr>
<td>DesktopGroupName</td>
<td>Delivery Group associated with the desktop.</td>
</tr>
<tr>
<td>HostIdentifier</td>
<td>Site; returns the same value as BrokerSiteName.</td>
</tr>
<tr>
<td>IsAssigned</td>
<td>True to assign the desktop to a user. set to False for a random desktop.</td>
</tr>
</tbody>
</table>
### Property | Description
--- | ---
IsMasterImage | Allows decisions about the environment. For example, you may want to install applications on the Master Image and not on the provisioned machines, especially if those machines are in a clean state on boot machines. Valid values are:
- True on a VM that is used as a master image (this value is set during installation based on a selection).
- Cleared on a VM that is provisioned from that image.
IsVirtualMachine | True for a virtual machine, false for a physical machine.
OSChangesPersist | False if the desktop operating system image is reset to a clean state every time it is restarted; otherwise, true.
PersistentDataLocation | The location where Configuration Manager stores persistent data. This is not accessible to users.
PersonalVDiskDriveLetter | For a desktop with a Personal vDisk, the drive letter you assign to the Personal vDisk.
BrokerSiteName, DesktopCatalogName, DesktopGroupName, HostIdentifier | Determined when the desktop registers with the Controller; they are null for a desktop that has not fully registered.

To collect the properties, run a hardware inventory in Configuration Manager. To view the properties, use the Configuration Manager Resource Explorer. In these instances, the names may include spaces or vary slightly from the property names. For example, **BrokerSiteName** may appear as Broker Site Name. For information about the following tasks, see [http://support.citrix.com/article/ctx140905](http://support.citrix.com/article/ctx140905).

- Configure Configuration Manager to collect Citrix WMI properties from the Citrix VDA
- Create query-based device collections using Citrix WMI properties
- Create global conditions based on Citrix WMI properties
- Use global conditions to define application deployment type requirements

You can also use Microsoft properties in the Microsoft class CCM_DesktopMachine in the Root\ccm_vdi namespace. For more information, see the Microsoft documentation.

### Configuration Manager and Remote PC Access Wake on LAN

To configure the Remote PC Access Wake on LAN feature, complete the following before installing a VDA on the office PCs and using Studio to create or update the Remote PC Access deployment:

- Configure Configuration Manager 2012 within the organization, and then deploy the Configuration Manager client to all Remote PC Access machines, allowing time for the scheduled SCCM inventory cycle to run (or forcing one manually, if required). The access credentials you specify in Studio to configure the connection to Configuration Manager must include collections in the scope and the Remote Tools Operator role.
- For Intel Active Management Technology (AMT) support:
- The minimum supported version on the PC must be AMT 3.2.1.
- Provision the PC for AMT use with certificates and associated provisioning processes.
- For Configuration Manager Wake Proxy and/or magic packet support:
  - Configure Wake on LAN in each PC's BIOS settings.
  - For Configuration Manager Wake Proxy support, enable the option in Configuration Manager. For each subnet in the organization that contains PCs that will use the Remote PC Access Wake on LAN feature, ensure that three or more machines can serve as sentinel machines.
  - For magic packet support, configure network routers and firewalls to allow magic packets to be sent, using either a subnet-directed broadcast or unicast.

After you install the VDA on office PCs, enable or disable power management when you create the Remote PC Access deployment in Studio.
- If you enable power management, specify connection details: the Configuration Manager address and access credentials, plus a name.
- If you do not enable power management, you can add a power management (Configuration Manager) connection later and then edit a Remote PC Access machine catalog to enable power management and specify the new power management connection.

You can edit a power management connection to configure the use of the Configuration Manager Wake Proxy and magic packets, as well as change the packet transmission method.

See the Remote PC Access article for more information.
Install using the graphical interface

Feb 24, 2016

Note: This article applies to installing components on machines with Windows operating systems. For information about VDAs for Linux operating systems, see Red Hat Linux VDAs and SUSE Linux VDAs.

In this article:

- Introduction
- Use the full-product installer
- Use the standalone VDA installer
- Customize a VDA

Introduction

Important: Before beginning any installation, review the Prepare to install article, which describes the installers and things you should be familiar with before installation. It also guides you through items you will see and specify in the graphical interface wizard. This article describes how to launch the graphical interface in a product installer.

You can use the graphical interface to:

- Install one or more core components: Delivery Controller, Citrix Studio, Citrix Director, License Server, and StoreFront.
- Install a Virtual Delivery Agent (VDA) on a master image or on a virtual or physical machine. You can also customize scripts provided on the media and then use them to install and remove VDAs in Active Directory.
- Customize a previously-installed VDA.
- Install a Universal Print Server server component. The Controller already has the Universal Print Server client functionality; you need only install the UpsServer component on the print servers in your environment. After you install the component, follow the configuration instructions in the Configure printers article.
- Upgrade components; see the Upgrade a deployment article.

Both the full-product installer and the standalone VDA installer have a graphical interface.

Use the full-product installer

You can use the full-product installer to install core components, VDAs, and the Universal Print Server server component.

1. Download the product package from Citrix. Citrix account credentials are required to access the download site.
3. Log on to the server where you are installing the components, using a local administrator account.
4. Insert the DVD in the drive or mount the ISO file. If the installer does not launch automatically, double-click the AutoSelect application or the mounted drive.
5. Choose whether to install XenApp or XenDesktop.
6. Select the component you want to install:

   - If you are just getting started, select Delivery Controller in the left column. As the wizard continues, you can choose which components to install on the machine where you are running the installer (Delivery Controller, Studio, Director, License Server, StoreFront).
If you have already installed some components and want to extend your deployment, click the component you want to install from the right column. This column offers core components and the Universal Print Server.

To install a VDA, click the available VDA entry in the middle column; the installer knows which one is right for the operating system where you're running the installer.

Follow the wizard. Remember: the Prepare to install article provides guidance about information you see and specify in the wizard. If you are installing a VDA, an automatic restart is enabled by default when the installation completes; the restart is required before the VDA can be used in a Site.

Use the standalone VDA installer

**Important:** The Prepare to install article provides guidance about information you see and specify during installation, especially about handling restarts and extraction space when using the standalone VDA installer.

Citrix account credentials are required to access the download site. You must either have elevated administrative privileges before starting the installation or use Run as administrator. Disable User Account Control (UAC).

1. Download the appropriate package from Citrix: VDAServerSetup.exe (for server OS machines), or VDAWorkstationSetup.exe (for desktop OS machines). For single user, single server OS deployments (for example, delivering Windows Server 2012 to one user for web development), use the VDAWorkstationSetup.exe package. For more information, see the Server VDI article.

2. Right-click the package and choose Run as administrator.

3. Follow the wizard. An automatic restart is enabled by default when the installation completes; the restart is required before the VDA can be used in a Site.

Customize a VDA

If you want to customize a VDA that you've already installed:

1. From the Windows feature for removing or changing programs, select Citrix Virtual Delivery Agent <version>, then right-click and select Change.

2. Select Customize Virtual Delivery Agent Settings. When the installer launches, you can change the Controller addresses, TCP/IP port to register with the Controller (default = 80), or whether to automatically open Windows Firewall port exceptions.
Install using the command line

Sep 16, 2016

Note: This article applies to installing components on machines with Windows operating systems. For information about VDAs for Linux operating systems, see Red Hat Linux VDAs and SUSE Linux VDAs.

In this article:

- Introduction
- Use the full-product installer
- Use the standalone VDA installer
- Customize a VDA using the command line
- Command line options for installing core components
- Command line options for installing a VDA
- Install the Universal Print Server using the command line

Introduction

Important: Before beginning any installation, review the Prepare to install article, which describes the installers and things you should be familiar with before installation. It also guides you through options you can include with a command. This article describes how to launch the command line interface in a product installer.

You can use a command line interface to:

- Install one or more core components: Delivery Controller, Citrix Studio, Citrix Director, License Server, and StoreFront.
- Install a Virtual Delivery Agent (VDA) on a master image or on a virtual or physical machine. You can also customize scripts provided on the media and then use them to install and remove VDAs in Active Directory.
- Customize a previously-installed VDA.
- Install a Universal Print Server, which provisions network session printers. The Controller already has the Universal Print Server functionality; you need only install the Universal Print Server on the print servers in your environment.
- Upgrade components; see the Upgrade a deployment article.

You can also remove components from this version that you previously installed by using the /remove or /removeall options. For details, see the Remove components article.

To see command execution progress and return values, you must be the original administrator or use Run as administrator. For more information, see the Microsoft command documentation.

Both the full-product installer and the standalone VDA installer have a command line interface.

If you use the sample scripts provided to install, upgrade, or remove VDAs machines in Active Directory, you can specify VDA configuration options listed below in the Command line options for installing a VDA section. For information about the sample scripts, see the Install VDAs using scripts article.

Use the full-product installer

You can install core components and VDAs with the full-product installer.

- Download the product package from Citrix. Citrix account credentials are required to access the download site.
Unzip the file. Optionally, burn a DVD of the ISO file.

Log on to the server where you are installing the components, using a local administrator account.

Insert the DVD in the drive or mount the ISO file.

From the \x64\XenDesktop Setup directory on the media:

To install core components, run the XenDesktopServerSetup.exe command. Use options listed in the Command line options for installing core components section below.

To install a VDA, run the XenDesktopVDASetup.exe command. Use options listed in the Command line options for installing a VDA section below.

Examples installing core components with the full product installer

Example 1: The following command installs a XenDesktop Controller, Studio, Citrix Licensing, and SQL Server Express on the server. Ports required for component communications will be opened automatically.

```
\x64\XenDesktop Setup\XenDesktopServerSetup.exe /components controller,desktopstudio,licenseserver /configure_firewall
```

Example 2: The following command installs a XenApp Controller, Studio, and SQL Server Express on the server. Ports required for component communication will be opened automatically.

```
\x64\XenDesktop Setup\XenDesktopServerSetup.exe /xenapp /components controller,desktopstudio /configure_firewall
```

Examples installing a VDA with the full product installer

Example 1: The following command installs a VDA for Windows Desktop OS and Citrix Receiver to the default location on a VM. This VDA will be used as a master image. The VDA will register initially with the Controller on the server named 'Contr-Main' in the domain 'mydomain,' and will use Personal vDisks, the optimization feature, and Windows Remote Assistance.

```
\x64\XenDesktop Setup\XenDesktopVdaSetup.exe /quiet /components vda,plugins /controllers "Contr-Main.mydomain.local" /enable_hdx_ports /optimize /masterimage /baseimage /enable_remote_assistance
```

Example 2: The following command installs a VDA for Windows Desktop OS and Citrix Receiver to the default location on an office PC that will be used with Remote PC Access. The machine will not be restarted after the VDA is installed; however, a restart is required before the VDA can be used. The VDA will register initially with the Controller on the server named 'Contr-East' in the domain 'mydomain,' and will use UDP for audio packets. HDX ports will be opened if the Windows Firewall service is detected.

```
\x64\XenDesktop Setup\XenDesktopVdaSetup.exe /quiet /components vda,plugins /controllers "Contr-East.mydomain.local" /enable_hdx_ports /enable_real_time_transport /noreboot
```

Use the standalone VDA installer

**Important:** The Prepare to install article provides guidance about information you see and specify during installation, especially about handling restarts and extraction space when using the standalone VDA installer.

Citrix account credentials are required to access the download site. You must either have elevated administrative privileges before starting the installation or use Run as administrator.
1. Download the appropriate package from Citrix: **VDAServerSetup.exe** (for server OS machines) or **VDAWorkstationSetup.exe** (for desktop OS machines). For single user, single server OS deployments (for example, delivering Windows Server 2012 to one user for web development), use the VDAWorkstationSetup.exe package. For more information, see the Server VDI article.

2. Either extract the files from the package first and then run the installation command, or just run the package.

   To extract the files before installing them, use `/extract` with the absolute path; for example `\VDAServerSetup.exe /extract %temp%\CitrixVDAInstallMedia`. Then in a separate command, run the **XenDesktopVdaSetup.exe** command from the directory containing the extracted content (in the example above, `CitrixVDAInstallMedia`). Use the options listed in the Command line options for installing a VDA section below.

   To just run the downloaded package, run its name: **VDAServerSetup.exe** or **VDAWorkstationSetup.exe**. Use the options listed in the Command line options for installing a VDA section below. (If you are familiar with the full product installer: you run the downloaded standalone package as if it was the XenDesktop VdaSetup.exe command in everything except its name.)

**Example installing a VDA with the standalone VDA installer**

The following installation command is often used for Remote PC Access. It installs a VDA on a physical office PC, without installing Citrix Receiver or Citrix Profile Manager. The machine will not automatically be restarted after the VDA is installed; however, a restart is required before the VDA can be used. The VDA will register initially with the Controller on the server named 'Contr-East'. Ports will be opened if the Windows Firewall Service is detected.

   VDAWorkstationSetup.exe /quiet /components vda /exclude "Citrix User Profile Manager" /controllers "Contr-East.domain.com" /enable_hdx_ports /noreboot

**Note**

Excluding Citrix Profile management from the installation (Using the `/exclude "Citrix User Profile Manager"` option) will affect monitoring and troubleshooting of VDAs with Citrix Director. On the User details and EndPoint pages, the Personalization panel and the Logon Duration panel will fail. On the Dashboard and Trends pages, the Average Logon Duration panel will display data only for machines that have Profile management installed.

Even if you are using a third party user profile management solution, it is recommended that you install and run the Citrix Profile management Service to avoid loss of monitoring and troubleshooting in Citrix Director (enabling the Citrix Profile management Service is not required).

**Customize a VDA using the command line**

After you install a VDA, you can customize several settings. From the `\x64\XenDesktop Setup` directory on the product media, run the **XenDesktopVdaSetup.exe** command, using one or more of the following options, which are described in the Command line options for installing a VDA section below.

- `/reconfigure` - this option is required when customizing a VDA
- `/h` or `/help`
- `/quiet`
- `/noreboot`
Command line options for installing core components

The following table lists the valid options for the `XenDesktopServerSetup.exe` command.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| /components component [component]... | Comma-separated list of components to install or remove. Valid values are:  
  - CONTROLLER – Controller  
  - DESKTOPSTUDIO – Studio  
  - DESKTOPDIRECTOR – Director  
  - LICENSESERVER - Citrix License Server  
  - STOREFRONT – StoreFront  
  
  If this option is omitted, all components are installed (or removed, if the /remove option is also specified). |
| /configure_firewall           | Opens all ports in the Windows firewall needed by components being installed, if the Windows Firewall Service is running, even if the firewall is not enabled. If you are using a third-party firewall or no firewall, you must manually open the ports. |
| /help or /h                  | Displays command help. |
| /installdir directory        | Existing empty directory where components will be installed. Default = c:\Program Files\Citrix. |
| /logpath path                | Log file location. The specified folder must already exist; the installer does not create it. Default = "%TEMP%\Citrix\XenDesktop Installer" |
| /no_remote_assistance        | (Valid only when installing Director) Disables the user shadowing feature that uses Windows Remote Assistance. |
| /noreboot                    | Prevents a restart after installation. (For most core components, a restart is not enabled by default.) |
| /nosql                       | Prevents installation of Microsoft SQL Server Express on the server where you are installing the Controller. If this option is omitted, SQL Server Express will be... |
/quiet or /passive  
No user interface appears during the installation. The only evidence of the installation process is in Windows Task Manager. If this option is omitted, the graphical interface launches.

/remove  
Removes the core components specified with the /components option.

/removeall  
Removes all installed core components.

/tempdir directory  
Directory that holds temporary files during installation. Default = c:\Windows\Temp.

/xenapp  
Installs XenApp. If this option is omitted, XenDesktop is installed.

### Command line options for installing a VDA

The following table lists the valid options for the XenDesktopVDASetup.exe command.

When installing a VDA for use with Remote PC Access, specify only options that are valid on physical machines (not VMs or master images) and for VDAs for Windows Desktop OS.

Unless otherwise noted, options apply to physical and virtual machines, and to VDAs for Windows Desktop OS and VDAs for Windows Server OS.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/baseimage</td>
<td>(Valid only when installing a VDA for Windows Desktop OS on a VM.) Enables the use of Personal vDisks with a master image. For more information, see the Personal vDisks articles.</td>
</tr>
</tbody>
</table>
| /components component[,component]   | Comma-separated list of components to install or remove. Valid values are:  
  - VDA - installs the VDA  
  - PLUGINS - installs the Citrix Receiver for Windows (CitrixReceiver.exe)  
  For example, to install the VDA but not Citrix Receiver, specify /components vda.  
  If this option is omitted, all components are installed. |
<p>| /controllers &quot;controller [controller] [...][]&quot; | Space-separated Fully Qualified Domain Names (FQDNs) of Controllers with which the VDA can communicate, enclosed in quotation marks. Do not specify both the /site_guid and /controllers options.                     |
| /enable_framehawk_port              | Opens the UDP ports used by Framehawk. Default = false                                                                                                                                                    |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/enable_hdx_3d_pro</td>
<td>Installs the VDA for HDX 3D Pro. For more information, see the HDX 3D Pro article.</td>
</tr>
<tr>
<td>/enable_hdx_ports</td>
<td>Opens ports in the Windows firewall required by the Controller and features you specified (Windows Remote Assistance, real-time transport, and optimize), if the Windows Firewall Service is detected, even if the firewall is not enabled. If you are using a different firewall or no firewall, you must configure the firewall manually.</td>
</tr>
<tr>
<td>/enable_real_time_transport</td>
<td>Enables or disables use of UDP for audio packets (Real-Time Audio Transport for audio). Enabling this feature can improve audio performance. Include the /enable_hdx_ports option if you want the UDP ports opened automatically if the Windows Firewall Service is detected.</td>
</tr>
<tr>
<td>/enable_remote_assistance</td>
<td>Enables the shadowing feature in Windows Remote Assistance for use with Director. If you specify this option, Windows opens TCP port 3389 in the firewall, even if you omit the /enable_hdx_ports option.</td>
</tr>
</tbody>
</table>
| /exclude "component","component" | Prevents installation of one of more comma-separated optional components, enclosed in quotation marks. For example, installing or upgrading a VDA on an image that is not managed by Machine Creation Services does not require the Personal vDisk or Machine Identity Service components. Valid values are:  
  - Personal vDisk  
  - Machine Identity Service  
  - Citrix User Profile Manager  
  Excluding Citrix Profile management from the VDA installation will affect monitoring and troubleshooting VDAs with Citrix Director. On the User details and EndPoint pages, the Personalization panel and the Logon Duration panel will fail. On the Dashboard and Trends pages, the Average Logon Duration panel will display data only for machines that have Profile management installed. |
| /h or /help                         | Displays command help.                                                                                                                                 |
| /installdir directory               | Existing empty directory where components will be installed. Default = c:\Program Files\Citrix.                                                                 |
| /installwithsecurebootenabled      | Allows VDA installation when Secure Boot is enabled. If this option is omitted, a warning displays that Secure Boot must be disabled to successfully install a VDA. (This option is not available in the graphical interface.) |
| /logpath path                      | Log file location. The specified folder must already exist; the installer does not create it. (This option is not available in the graphical interface.) Default = "%TEMP%\Citrix\XenDesktop Installer" |
| /masterimage                       | (Valid only when installing a VDA on a VM.) Sets up the VDA as a master image.                                                                 |
| /no_appv                           | Prevents installation of the Citrix App-V components. For more information, see the App-V article.                                                                 |
| /nocitrixwddm                      | (Valid only on Windows 7 machines that do not include a WDDM driver.) Disables installation of the Citrix WDDM driver.                                                                              |
| /nodesktopexperience               | (Valid only when installing a VDA for Windows Server OS.) Prevents enabling of the Enhanced
Desktop Experience feature. This feature is also controlled with the Enhanced Desktop Experience Citrix policy setting.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/noreboot</td>
<td>Prevents a restart after installation. The VDA will not be fully available for use until after a restart.</td>
</tr>
<tr>
<td>/optimize</td>
<td>Enables optimization for VDAs running in a VM on a hypervisor. VM optimization includes disabling offline files, disabling background defragmentation, and reducing event log size. Do not specify this option for Remote PC Access. For more information about the optimization tool, see CTX125874.</td>
</tr>
<tr>
<td>/portnumber port</td>
<td>(Valid only if the /reconfig option is specified.) Port number to enable for communications between the VDA and the Controller. The previously-configured port is disabled, unless it is port 80.</td>
</tr>
<tr>
<td>/quiet or /passive</td>
<td>No user interface appears during the installation. The only evidence of the installation and configuration process is in Windows Task Manager. If this option is omitted, the graphical interface launches.</td>
</tr>
<tr>
<td>/reconfig</td>
<td>Customizes previously-configured VDA settings when used with the /portnumber, /controllers, or /enable_hdx_ports options. If you specify this option without also specifying the /quiet option, the graphical interface for customizing the VDA launches.</td>
</tr>
<tr>
<td>/remotepc</td>
<td>Prevents installation of the following components on a desktop (workstation) OS:</td>
</tr>
<tr>
<td></td>
<td>- App V Component - Citrix Personalization for App-V - VDA</td>
</tr>
<tr>
<td></td>
<td>- UpmComponent - Citrix User Profile Manager</td>
</tr>
<tr>
<td></td>
<td>- UpmVdaPlugin Component - Citrix User Profile Manager WMI Plugin</td>
</tr>
<tr>
<td></td>
<td>- Mps Component - Machine Identity Service</td>
</tr>
<tr>
<td></td>
<td>- VDisk Component - Personal vDisk</td>
</tr>
<tr>
<td></td>
<td>During an upgrade, if any of these components are installed, the installer detects and upgrades them.</td>
</tr>
<tr>
<td>/remove</td>
<td>Removes the components specified with the /components option.</td>
</tr>
<tr>
<td>/removeall</td>
<td>Removes all installed VDA components.</td>
</tr>
<tr>
<td>/servervdi</td>
<td>Installs a VDA for Windows Desktop OS on a supported Windows Server. Omit this option when installing a VDA for Windows Server OS on a Windows Server. Before using this option, see the Server VDI article. (This option is not available in the graphical interface.)</td>
</tr>
<tr>
<td>/site_guid guid</td>
<td>Globally Unique Identifier of the site Active Directory Organizational Unit (OU). This associates a virtual desktop with a Site when you are using Active Directory for discovery (auto-update is the recommended and default discovery method). The site GUID is a site property displayed in Studio. Do not specify both the /site_guid and /controllers options.</td>
</tr>
<tr>
<td>/tempdir directory</td>
<td>Directory to hold temporary files during installation. (This option is not available in the graphical interface.) Default = C:\Windows\Temp.</td>
</tr>
</tbody>
</table>

https://docs.citrix.com  © 1999-2017 Citrix Systems, Inc. All rights reserved.  p.97
Install the Universal Print Server using the command line

**Note:** If you are installing the UpsServer component on a 32-bit Windows 2008 server, read this first.

Run one of the following commands on each print server:

- On a supported 32-bit operating system: From the `\x86\Universal Print Server\` directory on the Citrix installation media, run `UpsServer_x86.msi`.
- On a supported 64-bit operating system: From the `\x64\Universal Print Server\` directory on the Citrix installation media, run `UpsServer_x64.msi`.

Citrix recommends that you include the command option `/ENABLE_CEIP` set to 1 to opt in to the Citrix Customer Experience Improvement Program (CEIP). For example:

```
msiexec /i UpsServer.msi ENABLE_CEIP=1
```

When you opt in, anonymous statistics and usage information are sent to Citrix to help improve the quality and performance of Citrix products.

After you install the Universal Print Server component on your print servers, configure it using the guidance in the Provision printers article.

Before installing the Universal Print Server on a 32-bit Windows 2008 server

Before deploying `UpsServer_x86.msi` on a 32-bit Windows 2008 machine, you must adjust the Minimum Version for Windows Installer for the `cdf_x86.msi` and `UpsServer_x86.msi`, using either Visual Basic scripts or a tool such as Orca.

1. Copy the 32-bit versions of the CDF and UPS MSI files (`cdf_x86.msi` and `UpsServer_x86.msi`) to a temp folder.
2. Install the WiSumInf.vbs script or the Orca tool, both available in the Windows SDK Components for Windows Installer Developers package. For information about the script, see the MSDN article Manage Summary Information.
3. Modify the Minimum Version for the Windows Installer using one of the following methods:

   Using the WiSumInf.vbs script: Copy WiSumInf.vbs to the same temp folder with the two Citrix msi's. Then, run the script for each package with the parameters `WiSumInf.vbs cdf_x86.msi Pages=405` and `WiSumInf.vbs UpsServer_x86.msi Pages=405`.

   Using Orca: Open each of the `cdf_x86.msi` and `UpsServer_x86.msi` packages, go to the View menu > Summary Information, and change the value of the Schema textbox to 405.

After completing the above procedure, install the Universal Print Server on the print server.
Install VDAs using scripts

Sep 29, 2015

Note: This article applies to installing components on machines with Windows operating systems. For information about VDAs for Linux operating systems, see Red Hat Linux VDAs and SUSE Linux VDAs.

The installation media contains sample scripts that install, upgrade, or remove Virtual Delivery Agents (VDAs) for groups of machines in Active Directory. You can also apply the scripts to individual machines, and use them to maintain master images used by Machine Creation Services and Provisioning Services.

Required access:

- The scripts need Everyone Read access to the network share where the VDA installation command is located. The installation command is XenDesktopVdaSetup.exe from the full product ISO, or VDAWorkstationSetup.exe or VDAServerSetup.exe from the standalone installer.
- Logging details are stored on each local machine. If you also want to log results centrally for review and analysis, the scripts need Everyone Read and Write access to the appropriate network share.

To check the results of running a script, examine the central log share. Captured logs include the script log, the installer log, and the MSI installation logs. Each installation or removal attempt is recorded in a time-stamped folder. The folder title indicates if the operation was successful with the prefix PASS or FAIL. You can use standard directory search tools to quickly find a failed installation or removal in the central log share, rather than searching locally on the target machines.

Important: Before beginning any installation, read and complete the tasks in the Prepare to install article.

To install or upgrade VDAs using the script

1. Obtain the sample script InstallVDA.bat from \Support\AdDeploy\ on the installation media. Citrix recommends that you make a backup of the original script before customizing it.
2. Edit the script:
   - Specify the version of the VDA to install: SET DESIREDVERSION. For example, version 7 can be specified as 7.0; the full value can be found on the installation media in the ProductVersion.txt file (such as 7.0.0.3018); however, a complete match is not required.
   - Specify the network share location from which the installer will be invoked. Point to the root of the layout (the highest point of the tree): the appropriate version of the installer (32-bit or 64-bit) will be called automatically when the script runs. For example: SET DEPLOYSHARE=\fileserver1\share1.
   - Optionally, specify a network share location for storing centralized logs. For example: SET LOGSHARE=\fileserver1\log1.
   - Specify VDA configuration options as described in the Install using the command line article. The /quiet and /noreboot options are included by default in the script and are required: SET COMMANDLINEOPTIONS=\QUIET /NOREBOOT.
3. Using Group Policy Startup Scripts, assign the script to the OU in Active Directory where your machines are located. This OU should contain only machines on which you want to install the VDA. When the machines in the OU are restarted, the script runs on all of them, installing a VDA on each machine that has a supported operating system.

To remove VDAs using the script

1. Obtain the sample script UninstallVDA.bat from \Support\AdDeploy\ on the installation media. Citrix recommends that you make a backup of the original script before customizing it.
2. Edit the script.
Specify the version of the VDA to remove: SET CHECK_VDA_VERSION. For example, version 7 can be specified as 7.0; the full value can be found on the installation media in the ProductVersion.txt file (such as 7.0.0.3018); however, a complete match is not required.

Optionally, specify a network share location for storing centralized logs.

3. Using Group Policy Startup Scripts, assign the script to the OU in Active Directory where your machines are located. This OU should contain only machines from which you want to remove the VDA. When the machines in the OU are restarted, the script runs on all of them, removing a VDA from each machine.

Troubleshooting

The script generates internal log files that describe script execution progress. The script copies a Kickoff_VDA_Startup_Script log to the central log share within seconds of starting the deployment to the machine, so that you can verify that the overall process is working. If this log is not copied to the central log share as expected, you can troubleshoot further by inspecting the local machine: the script places two debugging log files in the %temp% folder on each machine, for early troubleshooting:

- Kickoff_VDA_Startup_Script_<DateTimeStamp>.log
- VDA_Install_ProcessLog_<DateTimeStamp>.log

Review the content of these logs to ensure that the script is:

- Running as expected.
- Properly detecting the target operating system.
- Correctly configured to point to the ROOT of the DEPLOYSHARE share (contains the file named AutoSelect.exe).
- Capable of authenticating to both the DEPLOYSHARE and LOG shares.
Install Red Hat Linux VDAs

Mar 24, 2016

You can create Linux virtual desktops based on a Red Hat distribution. Prepare your Linux virtual machines, install the new Linux VDA software on them, configure your Delivery Controller, and then use Studio to make the desktops available to users.

For details, see the following document.

PDF of installation and setup instructions for Red Hat Linux VDAs version 1.2.

Note

The Linux shell commands used in this document have been verified to work with the GNU Bash shell.

The article includes the following sections:

- System requirements
- Configure delivery controllers
- Prepare Linux machines for VDA installation
- Configure Linux machine catalog and delivery group
- Install Linux VDA software
- Run VDA software
- Uninstall Linux VDA software
- Troubleshooting
- Known issues
- Glossary

System requirements

Linux distributions

The following Linux distributions are supported by the Linux Virtual Desktop product:

- SUSE Linux Enterprise:
  - Desktop 11 Service Pack 4
  - Desktop 12 Service Pack 1
  - Server 11 Service Pack 4
  - Server 12 Service Pack 1
- Red Hat Enterprise Linux
  - Workstation 6.7
  - Workstation 7.2
  - Server 6.7
  - Server 7.2
Note
In all cases, the processor architecture supported is x86-64.

XenDesktop
The following versions of XenDesktop are supported by the Linux VDA:

- XenDesktop 7.1
- XenDesktop 7.5
- XenDesktop 7.6
- XenDesktop 7.7
- XenDesktop 7.8

The configuration process for Linux VDAs differs slightly than for Windows VDAs. However, any Delivery Controller farm is capable of brokering both Windows and Linux desktops.

Note
The Linux VDA is incompatible with XenDesktop version 7.0 or earlier.

Citrix Receiver
The following versions of Citrix Receiver are supported:

- Citrix Receiver for Windows version 4.4 or newer (this equates to v14.4 of wfica32.exe)
- Citrix Receiver for Linux version 13.3 or newer
- Citrix Receiver for Mac OSX version 12.1 or newer
- Citrix Receiver for Android version 3.8 or newer
- Citrix Receiver for iOS version 6.1.4 or newer
- Citrix Receiver for Chrome/HTML5 version 1.9 (only via Access Gateway)

Hypervisors
The following hypervisors for hosting Linux VDA guest VMs are supported:

- XenServer
- VMware ESX and ESXi
- Microsoft Hyper-V

Bare metal hosting is also supported.

Tip
Refer to the hypervisor vendor's documentation for the list of supported platforms.
Active Directory integration packages

The following Active Directory integration packages or products are supported by the Linux VDA:

- Samba Winbind
- Quest Authentication Services v4.1 or newer
- Centrify DirectControl

Tip

Refer to the Active Directory Integration package vendor's documentation for the list of supported platforms.

HDX 3D Pro

The following hypervisors, Linux Distributions and NVIDIA GRID™ GPU are required to support HDX 3D Pro.

Hypervisors

The following hypervisors are supported:

- XenServer
- VMware ESX and ESXi

Linux distributions

The following Linux distribution supports HDX 3D Pro:

- Red Hat Enterprise Linux - Workstation 7.2

GPU

The following GPUs are supported:

- NVIDIA GRID™ 3.0 - Tesla M60
- NVIDIA GRID™ - K2

Configure delivery controllers

XenDesktop 7.7 or higher includes the necessary changes to support Linux Virtual Desktop, however, for previous versions a hotfix or update script is required. The installation and verification of these are provided in this section.

Update delivery controller configuration

For XenDesktop 7.6 SP2, apply the Hotfix Update 2 to update the Broker for Linux Virtual Desktops. Hotfixes Update 2 is available here:

- CTX142438: Hotfix Update 2 - For Delivery Controller 7.6 (32-bit) – English
- CTX142439: Hotfix Update 2 - For Delivery Controller 7.6 (64-bit) – English
For earlier versions of XenDesktop, a PowerShell script named **Update-BrokerServiceConfig.ps1** is provided which updates the broker service configuration. This is available in the following package:

- citrix-linuxvda-scripts-1.2.0.zip

Repeat the following steps on every Delivery Controller in the farm:

1. Copy the **Update-BrokerServiceConfig.ps1** script to the Delivery Controller machine.
2. Open a Windows PowerShell console in the context of the local administrator.
3. Browse to the folder containing the script.
4. Execute the script:

   ```powershell
   \Update-BrokerServiceConfig.ps1
   ```

**Note**

By default, PowerShell is configured to prevent the execution of PowerShell scripts. If the script fails to run, you may need to change the PowerShell execution policy before trying again:

   ```powershell
   Set-ExecutionPolicy Unrestricted
   ```

The **Update-BrokerServiceConfig.ps1** script updates the Broker service configuration file with new WCF endpoints required by the Linux VDA and restarts the broker service. The script determines the location of the broker service configuration file automatically. A backup of the original configuration file is created in the same directory with the extension `.prelinux`.

These changes will have no impact on the brokering of Windows VDA’s configured to use the same Delivery Controller farm. This allows for a single Controller farm to manage and broker sessions to both Windows and Linux VDAs seamlessly.

**Verify delivery controller configuration**

To verify whether the required configuration changes have been applied to a Delivery Controller, confirm the string **EndpointLinux** appears five times in the file:

   ```text
   %PROGRAMFILES%\Citrix\Broker\Service\BrokerService.exe.config
   ```

From the Windows command prompt, logged on as a local administrator:

   ```cmd
   cd "%PROGRAMFILES%\Citrix\Broker\Service\"
   findstr EndpointLinux BrokerService.exe.config
   ```

**Prepare the Linux machine for VDA installation**

**Verify the network configuration**

Citrix recommends that the network is connected and properly configured correctly before proceeding.

**RHEL 6 only: Set the hostname**
To ensure that the hostname of the machine is reported correctly, change the `/etc/sysconfig/network` file to contain only the hostname of the machine.

```
HOSTNAME=hostname
```

**RHEL 7 Only: Set the hostname**

To ensure that the hostname of the machine is reported correctly, change the `/etc/hostname` file to contain only the hostname of the machine.

**Assign a loopback address to the hostname**

To ensure that the DNS domain name and FQDN of the machine are reported back correctly, change the following line of the `/etc/hosts` file to include the FQDN and hostname as the first two entries:

```
127.0.0.1  hostname-fqdn hostname localhost localhost.localdomain localhost4 localhost4.localdomain4
```

For example:

```
127.0.0.1  vda01.example.com vda01 localhost localhost.localdomain localhost4 localhost4.localdomain4
```

Remove any other references to `hostname-fqdn` or `hostname` from other entries in the file.

**Note**

The Linux VDA currently does not support NetBIOS name truncation, therefore the hostname must not exceed 15 characters.

**Check the hostname**

Verify that the hostname is set correctly:

```
hostname
```

This should return only the machine's host name and not its fully qualified domain name (FQDN).

Verify that the FQDN is set correctly:

```
hostname -f
```

This should return the machine's FQDN.

**Check name resolution and service reachability**

Verify that you can resolve the FQDN and ping the domain controller and XenDesktop Delivery Controller:

```
nsllookup domain-controller-fqdn
ping domain-controller-fqdn
nslookup delivery-controller-fqdn
```
ping `delivery-controller-fqdn`

If you cannot resolve the FQDN or ping either of these machines, review the steps before proceeding.

Configure clock synchronization (NTP)

Maintaining accurate clock synchronization between the VDAs, XenDesktop Controllers and domain controllers is crucial. Hosting the Linux VDA as a virtual machine can cause clock skew problems. For this reason, synchronizing time with a remote time service is preferred.

RHEL 6.x and earlier releases use the NTP daemon (ntpd) for clock synchronization, whereas a default RHEL 7.x environment uses the newer Chrony daemon (chronyd) instead. The configuration and operational process between the two services is similar.

RHEL 6 only: Configure NTP service

As root, edit `/etc/ntp.conf` and add a server entry for each remote time server:

```
server peer1-fqdn-or-ip-address iburst
server peer2-fqdn-or-ip-address iburst
```

In a typical deployment, time should be synchronized from the local domain controllers and not directly from public NTP pool servers. Add a server entry for each Active Directory domain controller in the domain.

Remove any other `server` entries listed including loopback IP address, localhost, and public server `*.pool.ntp.org` entries.

Save changes and restart the NTP daemon:

```
sudo /sbin/service ntpd restart
```

RHEL 7 only: Chrony service

As root, edit `/etc/chrony.conf` and add a server entry for each remote time server:

```
server peer1-fqdn-or-ip-address iburst
server peer2-fqdn-or-ip-address iburst
```

In a typical deployment, time should be synchronized from the local domain controllers and not directly from public NTP pool servers. Add a server entry for each Active Directory domain controller in the domain.

Remove any other server entries listed including loopback IP address, localhost, and public server `*.pool.ntp.org` entries.

Save changes and restart the Chrony daemon:

```
sudo /sbin/service chronyd restart
```

Disable network proxy authentication popup

There is a specific RHEL 6 issue that causes users to receive a popup asking for the root password after logging on.

To resolve this issue, as root, create the file `/etc/polkit-1/localauthority/30-site.d/20-no-show-proxy-dialog.pkla` in a text editor and add the following content:
Install OpenJDK

The Linux VDA is dependent on OpenJDK. The runtime environment should have been installed as part of the operating system installation.

RHEL 6 only: OpenJDK 1.7

Confirm the correct version with:

```bash
sudo yum info java-1.7.0-openjdk
```

The pre-packaged OpenJDK may be an earlier version. Update to the latest version as required:

```bash
sudo yum -y update java-1.7.0-openjdk
```

Set the `JAVA_HOME` environment variable by adding the following line to `~/.bashrc` file:

```bash
export JAVA_HOME=/usr/lib/jvm/java
```

Open a new shell and verify the version of Java:

```bash
java –version
```

RHEL 7.0 only: OpenJDK 1.8

Confirm the correct version with:

```bash
sudo yum info java-1.8.0-openjdk
```

The pre-packaged OpenJDK may be an earlier version. Update to the latest version as required:

```bash
sudo yum -y update java-1.8.0-openjdk
```

Set the `JAVA_HOME` environment variable by adding the following line to `~/.bashrc` file:

```bash
export JAVA_HOME=/usr/lib/jvm/java
```
Open a new shell and verify the version of Java:

```
java --version
```

**Tip**

To avoid problems, make sure you only installed either OpenJDK version 1.7.0 or 1.8.0. Remove all other versions of Java on your system.

Install PostgreSQL

The Linux VDA requires either PostgreSQL 8.4 or newer on RHEL 6 or PostgreSQL version 9.2 or newer on RHEL 7.

Install the following packages:

```
sudo yum -y install postgresql-server
sudo yum -y install postgresql-jdbc
```

The following post-installation step is required to initialize the database and ensure service starts on boot. This will create database files under `/var/lib/pgsql/data`. This command differs between PostgreSQL 8 and 9.

**RHEL 6 only: PostgreSQL 8**

```
sudo /sbin/service postgresql initdb
```

**RHEL 7 only: PostgreSQL 9**

```
sudo postgresql-setup initdb
```

Start PostgreSQL

For either version PostgreSQL, configure the service to start on boot, and to start now:

```
sudo /sbin/chkconfig postgresql on
sudo /sbin/service postgresql start
```

Check the version of PostgreSQL using:

```
psql --version
```

Verify that the data directory is set using the `psql` command-line utility:

```
sudo -u postgres psql -c 'show data_directory'
```

Install Motif

The Linux VDA requires either the motif or openmotif package, depending on the distribution.

**RHEL 6 only: Open Motif**
sudo yum -y install openmotif

RHEL 7 only: Motif

sudo yum -y install motif

Install printing support

The Linux VDA requires both cups and foomatic filters.

RHEL 6 only: Printing support

sudo yum -y install cups
sudo yum -y install foomatic

RHEL 7 only: Printing support

sudo yum -y install cups
sudo yum -y install foomatic-filters

Install other packages

Install the other required packages:

sudo yum -y install redhat-lsb-core
sudo yum -y install ImageMagick

Prepare the Linux VM for hypervisor

Some changes are required when running the Linux VDA as a virtual machine on a supported hypervisor. Make the following changes according to the hypervisor platform in use. No changes are required if you are running the Linux machine on bare metal hardware.

Fix time synchronization on Citrix XenServer

If the XenServer Time Sync feature is enabled, within each paravirtualized Linux VM you will experience issues with NTP and XenServer both trying to manage the system clock. To avoid the clock becoming out of sync with other servers, the system clock within each Linux guest must be synchronized with NTP. This requires disabling host time synchronization. No changes are required in HVM mode.

On some Linux distributions, if you are running a paravirtualized Linux kernel with XenServer Tools installed, you can check whether the XenServer Time Sync feature is present and enabled from within the Linux VM:

su -

    cat /proc/sys/xen/independent_wallclock

This will return either:

- 0 - The time sync feature is enabled, and needs to be disabled.
- 1 - The time sync feature is disabled, and no further action is required.
If the `/proc/sys/xen/indepent_wallclock` file is not present, the following steps are not required.

If enabled, disable the time sync feature by writing 1 to the file:

```bash
sudo echo 1 > /proc/sys/xen/independent_wallclock
```

To make this change permanent and persist after reboot, edit the `/etc/sysctl.conf` file and add the line:

```
xen.independent_wallclock = 1
```

To verify these changes, reboot the system:

```bash
reboot
```

After reboot, check that this has been set correctly:

```bash
su -

cat /proc/sys/xen/independent_wallclock
```

This should return the value 1.

**Fix time synchronization on Microsoft Hyper-V**

Linux VMs with Hyper-V Linux Integration Services installed can leverage the Hyper-V time synchronization feature to use the host operating system's time. To ensure the system clock remains accurate, this feature should be enabled alongside NTP services.

From the management operating system:

1. Open the Hyper-V Manager console.
2. For the settings of a Linux VM, select **Integration Services**.
3. Ensure **Time synchronization** is selected.

**Note**

This approach is different from VMware and XenServer, where host time synchronization is disabled to avoid conflicts with NTP.

Hyper-V time synchronization can co-exist and supplement NTP time synchronization.

**Fix time synchronization on ESX and ESXi**

If the VMware Time Synchronization feature is enabled, within each paravirtualized Linux VM you will experience issues with NTP and the hypervisor both trying to synchronize the system clock. To avoid the clock becoming out of sync with other servers, the system clock within each Linux guest must be synchronized with NTP. This requires disabling host time synchronization.

If you are running a paravirtualized Linux kernel with VMware Tools installed:

1. Open the vSphere Client.
2. Edit settings for the Linux VM.
3. In the Virtual Machine Properties dialog, open the Options tab.
4. Select VMware Tools.
5. In the Advanced box, uncheck Synchronize guest time with host.

Add Linux machine to Windows domain

There are a number of methods for adding Linux machines to the Active Directory domain that are supported by XenDesktop for Linux:

- Samba Winbind
- Quest Authentication Service
- Centrify DirectControl

Follow the instructions below for your chosen method.

Samba Winbind

Install or Update Required Packages

Install or update the required packages:

```
sudo yum -y install samba-winbind \
    samba-winbind-clients \
    krb5-workstation \
    authconfig \
    oddjob-mkhomedir
```

Enable Winbind Daemon to Start on Boot

The Winbind daemon must be configured to start on boot:

```
sudo /sbin/chkconfig winbind on
```

Configure Winbind Authentication

Configure the machine for Kerberos authentication using Winbind:

```
sudo authconfig \
    --disablecache \
    --disablesessd \
    --disablessdauth \
    --enablewinbind \
    --enablewinbindauth \
    --disablewinbindoffline \
```
Where **REALM** is the Kerberos realm name in upper-case and **domain** is the short NetBIOS name of the Active Directory domain.

If DNS-based lookups of the KDC server and realm name is required, add the following two options to the above command:

```
--enablekrb5kdcdns --enablekrb5realmdns
```

Ignore any errors returned from the `authconfig` command about the winbind service failing to start. These are due to `authconfig` trying to start the winbind service without the machine yet being joined to the domain.

Open `/etc/samba/smb.conf` and add the following entries under the `[Global]` section, but after the section generated by the `authconfig` tool.

```
kerberos method = secrets and keytab
winbind refresh tickets = true
```

The system keytab file `/etc/krb5.keytab` is required by the Linux VDA to authenticate and register with the Delivery Controller. The `kerberos method` setting above will force Winbind to create the system keytab file when the machine is first joined to the domain.

**Join Windows Domain**

This requires that your domain controller is reachable and you have a Active Directory user account with permissions to add computers to the domain.

```
sudo net ads join REALM -U user
```

Where **REALM** is the Kerberos realm name in upper-case, and user is a domain user with permissions to add computers to the domain.

**Configure PAM for Winbind**

By default, the configuration for the Winbind PAM module (`pam_winbind`) does not enable Kerberos ticket caching and home directory creation. Open `/etc/security/pam_winbind.conf` and add or change the following entries under the `[Global]` section:

```
krb5_auth = yes
krb5_ccache_type = FILE
```
mkhomedir = yes

Ensure any leading semi-colons from each setting are removed. These changes require restarting the Winbind daemon:

```
sudo /sbin/service winbind restart
```

**Tip**
The winbind daemon will only stay running if the machine is joined to a domain.

Open `/etc/krb5.conf` and change the following setting under the `[libdefaults]` section from KEYRING to FILE type:

```
default_ccache_name = FILE:/tmp/krb5cc_%{uid}
```

**Verify Domain Membership**
The XenDesktop Controller requires that all VDA machines, whether Windows or Linux, have a computer object in Active Directory.

Verify the machine is joined to a domain using Samba's `net ads` command:

```
sudo net ads testjoin
```

Additional domain and computer object information can be verified with:

```
sudo net ads info
```

**Verify Kerberos Configuration**
To verify Kerberos is configured correctly for use with the Linux VDA, check that the system keytab file has been created and contains valid keys:

```
sudo klist -ke
```

This should display the list of keys available for the various combinations of principal names and cipher suites. Run the Kerberos `kinit` command to authenticate the machine with the domain controller using these keys:

```
sudo kinit -k MACHINE\$@REALM
```

The machine and realm names must be specified in uppercase, and the dollar sign ($) must be escaped with a backslash (\) to prevent shell substitution. In some environments the DNS domain name is different from the Kerberos realm name; ensure the realm name is used. If this command is successful, no output is displayed.

Verify that the TGT ticket for the machine account has been cached using:

```
sudo klist
```

Examine the machine's account details using:

```
sudo net ads status
```

**Verify User Authentication**
Use the `wbinfo` tool to verify that domain users can authenticate with the domain:

```
wbinfo --krb5auth=domain\username%password
```

The domain specified here is the AD domain name, not the Kerberos realm name. For the bash shell, the backslash (\) character must be escaped with another backslash. This command will return a message indicating success or failure.

To verify that the Winbind PAM module is configured correctly, logon locally with a domain user account that has not logged onto the machine previously.

```
ssh localhost -l domain\username
```

```
id -u
```

Check that a corresponding Kerberos credential cache file was created for the uid returned by the `id -u` command:

```
ls /tmp/krb5cc_uid
```

Check that the tickets in the user's Kerberos credential cache are valid and not expired:

```
klist
```

Exit the session:

```
exit
```

A similar test can be performed by logging onto the Gnome or KDE console directly.

**Quest authentication service**

**Configure Quest on Domain Controller**

This assumes you have installed and configured the Quest software on the Active Directory domain controllers, and have been granted administrative privileges to create computer objects in Active Directory.

**Enable Domain Users to Logon to Linux VDA Machines**

For each domain user that needs to establish HDX sessions on a Linux VDA machine:

1. In the Active Directory Users and Computers management console, open Active Directory user properties for that user account.
2. Select **Unix Account** tab.
3. Check **Unix-enabled**.
4. Set the **Primary GID Number** to the group ID of an actual domain user group.

**Note**

These instructions are equivalent for setting up domain users for logon using the console, RDP, SSH or any other remoting protocol.

**Configure Quest on Linux VDA**
Workaround SELinux Policy Enforcement

The default RHEL environment has SELinux fully enforced. This interferes with the Unix domain socket IPC mechanisms used by Quest and prevents domain users from logging on.

There are a few ways to workaround outlined here.

The easiest is to disable SELinux. As root, edit /etc/selinux/config and change the SELinux setting:

```
SELINUX=disabled
```

This change requires a reboot:

```
reboot
```

**Important**

Use this setting carefully. Reenabling SELinux policy enforcement after disabling can cause a complete lockout, even for the root user and other local users.

Configure VAS daemon

Auto-renewal of Kerberos tickets needs to be enabled and disconnected; authentication (offline logon) needs to be disabled:

```
sudo /opt/quest/bin/vastool configure vas vasd \ 
    auto-ticket-renew-interval 32400
```

```
sudo /opt/quest/bin/vastool configure vas vas_auth \ 
    allow-disconnected-auth false
```

This sets the renewal interval to 9 hours (32400 seconds) which is an hour less than the default 10 hour ticket lifetime. Set this parameter to a lower value on systems with a shorter ticket lifetime.

Configure PAM and NSS

Quest requires that PAM and NSS be manually configured to enable domain user login via HDX and other services such as su, ssh, and RDP. To configure PAM and NSS:

```
sudo /opt/quest/bin/vastool configure pam
```

```
sudo /opt/quest/bin/vastool configure nss
```

Join Windows Domain

Join the Linux machine to the Active Directory domain using the Quest vastool command:

```
sudo /opt/quest/bin/vastool -u user join domain-name
```

The user is any domain user with permissions to join computers to the Active Directory domain. The domain-name is the
DNS name of the domain; for example, example.com.

**Verify Domain Membership**

The XenDesktop Controller requires that all VDA machines, whether Windows or Linux, have a computer object in Active Directory. To verify that a Quest-joined Linux machine is on the domain:

```
sudo /opt/quest/bin/vastool info domain
```

If the machine is joined to a domain this will return the domain name. If not joined, you will see the following error:

```
ERROR: No domain could be found.
ERROR: VAS_ERR_CONFIG: at ctx.c:414 in _ctx_init_default_realm
default_realm not configured in vas.conf. Computer may not be joined to domain
```

**Verify User Authentication**

To verify that Quest can authenticate domain users using PAM, logon with a domain user account that has not logged onto the machine previously:

```
ssh localhost -l domain\username
```

```
id -u
```

Check that a corresponding Kerberos credential cache file was created for the UID returned by the `id -u` command:

```
ls /tmp/krb5cc_uid
```

Check that the tickets in user's Kerberos credential cache are valid and not expired:

```
/opt/quest/bin/vastool klist
```

Exit the session:

```
exit
```

A similar test can be performed by logging onto the Gnome or KDE console directly.

**Centrify DirectControl**

**Join Windows Domain**

With the Centrify DirectControl Agent installed, join the Linux machine to the Active Directory domain using the Centrify `adjoin` command:

```
su -
adjoin -w -V -u user domain-name
```

The `user` parameter is any Active Directory domain user with permissions to join computers to the Active Directory domain. The `domain-name` parameter is the name of the domain to join the Linux machine to.

**Verify Domain Membership**

The XenDesktop Controller requires that all VDA machines, whether Windows or Linux, have a computer object in Active Directory. To verify that a Centrify-joined Linux machine is on the domain:
su -

adinfo

Check that the **joined to domain** value is valid and the **CentrifyDC mode** returns **connected**. If the mode remains stuck in the starting state, then the Centrify client is experiencing server connection or authentication problems.

More comprehensive system and diagnostic information is available using:

- `adinfo --sysinfo all`
- `adinfo --diag`

To test connectivity to the various Active Directory and Kerberos services:

- `adinfo --test`

**Install NVIDIA GRID drivers**

To enable HDX 3D Pro, additional installation steps are required to install the required graphics drivers on the hypervisor as well as to the VDA machines.

Configure the following:

1. Citrix XenServer
2. VMware ESX

Follow the instructions for your chosen hypervisor.

**Citrix XenServer**

This detailed section walks through the install and configuration of the NVIDIA GRID drivers on **Citrix XenServer**.

**VMware ESX**

Follow the information contained in this guide to install and configure the NVIDIA GRID drivers for **VMware ESX**.

**VDA Machines**

Follow these steps to install and configure the drivers for each of the Linux VM guests:

1. Before starting ensure the Linux VM is shutdown.
2. In XenCenter, add a GPU in GPU Passthrough mode to the VM.
3. Start the RHEL VM.

To prepare the machine for the NVIDIA GRID drivers the following steps are required:

- `# yum install gcc`
- `# yum install "kernel-devel-uname-r == $(uname -r)"`
- `# systemctl set-default multi-user.target`

Once complete, follow the steps in the **Red Hat Enterprise Linux document** to install the NVIDIA GRID Driver.

---

**Note**
During the GPU driver install, select the default ("no") for each question.

**Important**

Once GPU Passthrough has been enabled, the Linux VM is no longer accessable via XenCenter so you will need to use SSH to connect.

In order to verify if the NVIDIA GRID™ graphics driver is installed correctly, run “nvidia-smi”; the results should resemble:

```
nvidia-smi
```

```
+----------------------------+-------------------------+-------------------------+-------------------------+-------------------------+--------------------------+--------------------------+--------------------------+--------------------------+
| NVIDIA-SMI 352.70          | Driver Version: 352.70  |
|----------------------------|-------------------------+-------------------------+-------------------------+-------------------------+--------------------------+--------------------------+--------------------------+
| GPU Name | Persistence-M | Bus-Id | Disp.A | Volatile Uncorr. ECC | Fan | Temp | Perf | Pwr:Usage/Cap | Memory-Usage | GPU-Util | Compute M. |                          |
|----------------------------|-------------------------+-------------------------+-------------------------+-------------------------+--------------------------+--------------------------+--------------------------+--------------------------|
| 0 Tesla M60 | Off | 0000:00:05.0 | Off | Off | 0% | Default |                          |
| N/A | 20C | P0 | 37W / 150W | 19MiB / 8191MiB | 0% | Default |                          |
|----------------------------|-------------------------+-------------------------+-------------------------+-------------------------+--------------------------+--------------------------+--------------------------+--------------------------|

Set the correct configuration for the card:

```
/etc/X11/ctx-nvidia.sh
```

To take advantage of large resolutions and multimonitor capabilities you will need a valid NVIDIA license. To apply the license follow the product documentation from “GRID Licensing Guide.pdf - DU-07757-001 September 2015”.

**Configure Linux machine catalog and delivery group**

**Add a Linux machine to the machine catalog**

The process for creating machine catalogs and adding Linux VDA machines is very similar to the traditional Windows VDA approach. Refer to the online [Citrix Product documentation](https://docs.citrix.com) for a more complete description of how to complete these tasks.

For creating machine catalogs that contain Linux VDA machines, there are a few restrictions that differentiates the process from creating machine catalogs for Windows VDA machines:
For operating system, select:
- Window Server OS or Server OS option for a hosted shared desktops delivery model.
- Windows Desktop OS or Desktop OS option for a VDI dedicated desktop delivery model.
- Ensure machines are set as not power managed.
- As PVS and MCS are not supported for Linux VDAs, choose the Another service or technology (existing images) deployment method.
- Do not mix Linux and Windows VDA machines in the same machine catalog.

Note
Early versions of Citrix Studio did not support the notion of a "Linux OS"; however, selecting the Windows Server OS or Server OS option implies an equivalent hosted shared desktops delivery model. Selecting the Windows Desktop OS or Desktop OS option implies a XenDesktop single user per machine delivery model.

The Citrix documentation for creating machine catalogs is referenced below:

- XenDesktop 7.1
- XenDesktop 7.5
- XenDesktop 7.6
- XenDesktop 7.7
- XenDesktop 7.8

Earlier versions of XenDesktop are not supported.

Tip
If a machine leaves and is rejoined to the Active Directory domain, the machine will need to be removed and re-added again to the machine catalog.

Add a delivery group
The process for creating a delivery group and adding machine catalogs containing Linux VDA machines is almost identical for Windows VDA machines. Refer to the online Citrix Product documentation for a more complete description of how to complete these tasks.

For creating delivery groups that contain Linux VDA machine catalogs, the following restrictions apply:

- For delivery type, select Desktops. Linux VDA machines do not support application delivery.
- Ensure the AD users and groups you select have been properly configured to logon to the Linux VDA machines.
- Do not allow logon of unauthenticated (anonymous) users.
- Do not mix the delivery group with machine catalogs that contain Windows machines.

The Citrix documentation for creating delivery groups is referenced below:

- XenDesktop 7.1
- XenDesktop 7.5
Earlier versions of XenDesktop are not supported.

Install the Linux VDA software

Uninstall the old version

If you have previously installed a version of the Linux VDA older than v1.0, you should uninstall it before installing the new version.

Stop the Linux VDA services:

```bash
sudo /sbin/service ctxvda stop
sudo /sbin/service ctxhdx stop
```

Uninstall the package:

```bash
sudo rpm -e XenDesktopVDA
```

Important

Upgrading from the Tech Preview to v1.0, v1.1 or 1.2 is not supported.

Install the Linux VDA

Install the Linux VDA software using the RPM package manager:

**For RHEL 6:**

```bash
sudo rpm -i XenDesktopVDA-1.2.0.282-1.el6.x86_64.rpm
```

**For RHEL 7.2:**

```bash
sudo rpm -i XenDesktopVDA-1.2.0.282-1.el7.x86_64.rpm
```

Important

After installing the Linux VDA, Citrix recommends that you run the following command to enhance security:

```bash
sudo sed -i '/ip addr | awk /a xhost -"LOCAL:"
```

Upgrade the Linux VDA
If you have previously installed v1.1 of the Linux VDA, upgrade the Linux VDA software using the RPM package manager:

**For RHEL 6:**

```
sudo rpm -U XenDesktopVDA-1.2.0.282-1.el6.x86_64.rpm
```

**For RHEL 7.2:**

```
sudo rpm -U XenDesktopVDA-1.2.0.282-1.el7.x86_64.rpm
```

**Important**

After upgrading the Linux VDA, Citrix recommends that you run the following command to enhance security:

```
sudo sed -i '/ip addr | awk /a xhost "-LOCAL:"' /usr/local/bin/ctxsession.sh
```

Configure the Linux VDA

After installing the package you will need to configure the Linux VDA by running the ctxsetup.sh script. If you have upgraded the package you will need to run the ctxsetup.sh script to finalise your upgrade. Before making any changes, this script will verify the environment and ensure all dependencies are installed. If required, this script can be re-run at any time to change settings.

The script can either be run manually with prompting or automatically with pre-configured responses. Review help about this script before proceeding:

```
sudo /usr/local/sbin/ctxsetup.sh –help
```

**Prompted configuration**

Run a manual configuration with prompted questions:

```
sudo /usr/local/sbin/ctxsetup.sh
```

**Automated configuration**

For an automated install, the options required by the setup script can be provided with environment variables. If all of the required variables are present then the script will not prompt the user for any information, allowing the installation process to be scripted.

Supported environment variables include:

- `CTX_XDL_SUPPORT_DDC_AS_CNAME = Y | N` - The Virtual Delivery Agent supports specifying a Delivery Controller name using a DNS CNAME record. This is typically set to N.
- `CTX_XDL_DDC_LIST = list-ddc-fqdns` - The Virtual Delivery Agent requires a space-separated list of Delivery Controller Fully Qualified Domain Names (FQDNs) to use for registering with a Delivery. At least one FQDN or CNAME alias must be specified.
- `CTX_XDL_VDA_PORT = port-number` - The Virtual Delivery Agent communicates with Delivery Controllers using a TCP/IP port. This is typically port 80.
- `CTX_XDL_REGISTER_SERVICE = Y | N` - The Linux Virtual Desktop services support starting during boot. This is typically
set to Y.
- **CTX_XDL_ADD_FIREWALL_RULES = Y | N** – The Linux Virtual Desktop services require incoming network connections to be allowed through the system firewall. You can automatically open the required ports (by default ports 80 and 1494) in the system firewall for the Linux Virtual Desktop. This is typically set to Y.
- **CTX_XDL_AD_INTEGRATION = 1 | 2 | 3** – The Virtual Delivery Agent requires Kerberos configuration settings to authenticate with the Delivery Controllers. The Kerberos configuration is determined from the installed and configured Active Directory integration tool on the system. Specify the supported Active Directory integration method to use:
  - 1 - Samba Winbind
  - 2 - Quest Authentication Service
  - 3 – Centrify DirectControl
- **CTX_XDL_HDX_3D_PRO= Y | N** – Linux Virtual Desktop supports HDX 3D Pro, a set of graphics acceleration technologies designed to optimize the virtualization of rich graphics applications. HDX 3D Pro requires a compatible NVIDIA Grid graphics card to be installed. If HDX 3D Pro is selected the Virtual Delivery Agent will be configured for VDI desktops (single-session) mode – (i.e. CTX_XDL_VDI_MODE=Y). This is not supported on SUSE. Ensure this value is set to N.
- **CTX_XDL_VDI_MODE= Y | N** - Whether to configure the machine as a dedicated desktop delivery model (VDI) or hosted shared desktop delivery model. For HDX 3D Pro environments this needs to be set to Y. This is typically set to N.
- **CTX_XDL_SITE_NAME= dns-name** – The Virtual Delivery Agent discovers LDAP servers using DNS, querying for LDAP service records. To limit the DNS search results to a local site, a DNS site name may be specified. This is typically empty [none].
- **CTX_XDL_LDAP_LIST= list-ldap-servers** – The Virtual Delivery Agent by default queries DNS to discover LDAP servers, however if DNS is unable to provide LDAP service records, you may provide a space-separated list of LDAP Fully Qualified Domain Names (FQDNs) with LDAP port (e.g. ad1.mycompany.com:389). This is typically empty [none].
- **CTX_XDL_SEARCH_BASE= search-base** – The Virtual Delivery Agent by default queries LDAP using a search base set to the root of the Active Directory Domain (e.g. DC=mycompany,DC=com), however to improve search performance, a search base may be specified (e.g. OU=VDI,DC=mycompany,DC=com). This is typically empty [none].
- **CTX_XDL_START_SERVICE = Y | N** - Whether or not the Linux VDA services are started when the Linux VDA configuration is complete. This is typically set to Y.

Set the environment variable and run the configure script:

```bash
export CTX_XDL_SUPPORT_DDC_AS_CNAME=Y|N
export CTX_XDL_DDC_LIST=list-ddc-fqdns
export CTX_XDL_VDA_PORT=port-number
export CTX_XDL_REGISTER_SERVICE=Y|N
export CTX_XDL_ADD_FIREWALL_RULES=Y|N
export CTX_XDL_AD_INTEGRATION=1|2|3
export CTX_XDL_HDX_3D_PRO=Y|N
export CTX_XDL_VDI_MODE=Y|N
export CTX_XDL_SITE_NAME=dns-name
export CTX_XDL_LDAP_LIST=list-ldap-servers
```

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.122
You must provide the -E option with sudo to pass the existing environment variables to the new shell it creates. Citrix recommends that you create a shell script file from the commands above with #!/bin/bash on the first line.

Alternatively, all parameters can be specified with a single command:

```bash
sudo CTX_XDL_SUPPORT_DDC_AS_CNAME=Y|N
CTX_XDL_DDC_LIST=list-ddc-fqdns
CTX_XDL_VDA_PORT=port-number
CTX_XDL_REGISTER_SERVICE=Y|N
CTX_XDL_ADD_FIREWALL_RULES=Y|N
CTX_XDL_AD_INTEGRATION=1|2|3
CTX_XDL_HDX_3D_PRO=Y|N
CTX_XDL_VDI_MODE=Y|N
CTX_XDL_SITE_NAME=dns-name
CTX_XDL_LDAP_LIST=list-ldap-servers
CTX_XDL_SEARCH_BASE=search-base
CTX_XDL_STARTSERVICE=Y|N
/usr/local/sbin/ctxsetup.sh
```

Remove configuration changes

In some scenarios it may be necessary to remove the configuration changes made by the `ctxsetup.sh` script without uninstalling the Linux VDA package.

Review help about this script before proceeding:

```bash
sudo /usr/local/sbin/ctxcleanup.sh --help
```

To remove configuration changes:

```bash
sudo /usr/local/sbin/ctxcleanup.sh
```

**Important**

This script will delete all configuration data from the database and will make the Linux VDA inoperable.
Configuration logs

The `ctxsetup.sh` and `ctxcleanup.sh` scripts will display errors on the console, with additional information written to a configuration log file:

```
/tmp/xdl.configure.log
```

Restart the Linux VDA services to have the changes take effect.

Run the VDA software

Once you have configured the Linux VDA using the `ctxsetup.sh` script, you use the following commands to control the Linux VDA.

Start the Linux VDA

To start the Linux VDA services:

```
sudo /sbin/service ctxhdx start
sudo /sbin/service ctxvda start
```

Stop the Linux VDA

To stop the Linux VDA services:

```
sudo /sbin/service ctxvda stop
sudo /sbin/service ctxhdx stop
```

Restart the Linux VDA

To restart the Linux VDA services:

```
sudo /sbin/service ctxvda stop
sudo /sbin/service ctxhdx restart
sudo /sbin/service ctxvda start
```

Check the Linux VDA status

To check the running state of the Linux VDA services:

```
sudo /sbin/service ctxvda status
sudo /sbin/service ctxhdx status
```

Uninstall the Linux VDA software

Query Linux VDA installation status
To check whether the Linux VDA is installed and to view the version of the package installed:

```
rpm -q XenDesktopVDA
```

To view more detailed information:

```
rpm –qi XenDesktopVDA
```

**Note**

Uninstalling the Linux VDA software will delete the associated PostgreSQL and other configuration data. However, the PostgreSQL package and other dependent packages that were setup prior to the installation of the Linux VDA will not be removed.

Remove dependent packages

This article does not cover the removal of dependent packages including PostgreSQL.

**Troubleshooting**

**Check the Linux machine has been prepared correctly**

The most common issues are a direct result of Linux machine misconfiguration, mainly around networking, NTP time server configuration or Active Directory domain membership. Fixing the Linux machine’s configuration will often resolve issues with the VDA software.

**Configure logging and tracing**

The broker agent and the HDX Service log to syslog. Citrix support have a set of tools that can enable addition trace during a support call.

**HDX Service logging**

The HDX Service is configured to log to syslog out-of-the-box and no further configuration is needed.

**Broker Agent logging**

The broker agent (also known as the ctxvda service) writes log data to syslog via network sockets. This may not be configured out-of-the-box. To enable the broker agent logging to syslog logging, the following configuration is required.

Edit the `/etc/rsyslog.conf` file and add the following lines:

```
$ModLoad imudp
$UDPServerRun 514
```

Save and close the `rsyslog.conf` file. Restart the rsyslog service to have the change take affect:

```
sudo /sbin/service rsyslog restart
```

**What to try if HDX sessions won't start**
Ensure you have no orphaned processes which might be preventing new sessions from starting:

```bash
sudo pkill -9 ctxhdx
sudo pkill -9 ctxgfx
sudo pkill -9 ctxlogin
sudo pkill -9 ctxvfb
```

Restart the Linux VDA services and retry connection.

**Verify ownership and permissions of key directories and files**

Check the file ownership and permission of the following directories and files:

- `/var` - Owner: root, Group: root, Permissions: 0755
- `/var/xdl` - Owner: ctxsrvr, Group: ctxadm, Permissions: 0755
- `/var/xdl/.isacagent` - Owner: root, Group: root, Permissions: 0666
- `/var/xdl/.winsta` - Owner: ctxsrvr, Group: ctxadm, Permissions: 0777
- `/var/xdl/vda` - Owner: root, Group: root, Permissions: 0755

**HDX 3D Pro multi-monitor redraw issues**

If you are seeing redraw issues on screens other than the primary monitor check that the NVIDIA GRID license is available.

**Audio is not being heard**

Check that the volume control on the device running the Citrix Receiver as well as the Linux desktop are not muted or set to a low level.

Check that audio is enabled on the Linux VDA. Use the ctxreg tool to query the value of the configuration item fDisableCam:

```bash
sudo ctxreg read -k "HKLM\System\CurrentControlSet\Control\Citrix\WinStations\tcp" -v fDisableCam
```

A value of 0x1 means audio is disabled. To enable, set fDisableCam to 0x0:

```bash
sudo ctxreg update -k "HKLM\System\CurrentControlSet\Control\Citrix\WinStations\tcp" -v fDisableCam -d 0x00000000
```

If audio is still not being heard check that the Citrix audio sink is loaded by pulseaudio. This PulseAudio module is loaded into the pulseaudio daemon at session start. Use the pacmd tool to check the Citrix audio sink is loaded:

```bash
pacmd list-sinks
```

If the Citrix audio sink is loaded, the output should be:

- `name: <CitrixAudioSink>`
- `driver: <module-ctx-sink.c>`

If Citrix audio sink is not loaded, kill the ctxaudio process and restart it.

**Audio is not being recorded**
Check that audio is enabled on the Linux VDA and audio recording is enabled on the ICA client. If audio is still not being recorded check that the Citrix audio source is loaded by pulseaudio. If audio recording is enabled on the ICA client, this PulseAudio module will be loaded into the pluseaudio daemon at session start. Use the pacmd tool to check the Citrix audio source is loaded:

```
pacmd list-sources
```

If the Citrix audio source is loaded, the output should be:

```
name: <CitrixAudioSource>
driver: <module-ctx-source.c>
```

If the Citrix audio source is not loaded, kill the ctxaudio process and restart it.

**Unable to Print**

There are a number of items to check if printing is not working correctly. The print daemon is a per session process and should be running for the length of the session. Check that the printing daemon is running.

```
ps –ef | grep ctxlpmngt
```

If the ctxlpmngt process is not running manually start ctxlpmngt from a command line.

If printing is still not working the next item to check in the CUPS framework. The ctxcups service is for printer management and communicates with the Linux CUPS framework. This is a single process per machine and can be checked by:

```
service ctxcups status
```

If the service is not running, start it manually:

```
service ctxcups start
```

**Print output is garbled**

Garbled output can be caused by an incompatible printer driver. A per user driver configuration is available and can be configured by editing the ~/.CtxlpProfile configuration file.

```
[DEFAULT_PRINTER]
printername=
model=
ppdpath=
drivertype=
```

The printername is a field containing the name of the current client side default printer. This is a read-only value and should not be edited.

**Important**
The fields **ppdpath**, **model** and **drivertype** should not be set at the same time as only one takes effect for the mapped printer.

If the Universal Printer driver is not compatible with the client printer, the model of native printer driver can be configured with the **model**= option. The current model name of the printer can be found with the `lpinfo` command.

```
lpinfo -m
...
```

```
xerox/ph3115.ppd.gz Xerox Phaser 3115, SpliX V. 2.0.0
xerox/ph3115fr.ppd.gz Xerox Phaser 3115, SpliX V. 2.0.0
xerox/ph3115pt.ppd.gz Xerox Phaser 3115, SpliX V. 2.0.0
...
```

The model can then be set to match the printer:

```
Model=xerox/ph3115.ppd.gz
```

If the Universal Printer driver is not compatible with client printer, the ppd file path of native printer driver can be configured. The value of ppdpath is the absolute path of native printer driver file.

For example, there is a ppd driver under `/home/tester/NATIVE_PRINTER_DRIVER.ppd`.

```
ppdpath=/home/tester/NATIVE_PRINTER_DRIVER.ppd
```

There are three types of Universal Printer Driver supplied by Citrix (postscript, pcl5 and pcl6). These can configured in the driver type if no native printer driver is available.

For example, if client default printer driver type is PCL5.

```
drivertype=pcl5
```

**Note**

Citrix Receiver for Mac and Citrix Receiver for Linux only support Postscript printers and so the PCL5 and PCL6 Universal Printer Drivers are not applicable. In this situation, ppdpath or the model of native printer driver has to be set to a non-Postscript printer.

**Known issues**

**Citrix Receiver for Android CAPS LOCK state can be reversed when session roaming**

The CAPS LOCK state may be lost when roaming an existing connection to the Citrix Receiver for Android. The workaround is to use the shift key on the extended keyboard to switch between upper case and lower case.

**Shortcut keys with ALT do not always work when connecting to a Linux VDA using the Citrix Receiver for Mac**
The Citrix Receiver for Mac send AltGr for both left and right Options/Alt keys by default. It is possible to change this within the Citrix Receiver settings but the results vary with different applications.

**Newer X client libraries can cause keyboard mapping issues on SuSE Linux Enterprise Desktop 11**

Newer versions of the xorg-x11-libX11 packages on SuSE Linux Enterprise Desktop 11 may have problems handling keyboard mapping changes, which in tum may cause issues with keyboard functionality inside an HDX session. This can happen when the installed version of the packages is in the range 7.4-5.11.11 to 7.4-5.11.15.1.

The workaround is to rollback to the stock SP3 version of the xorg-x11-libX11 package, this will enable keyboard mapping changes to work as normal. For example:

```
rpm -i --force xorg-x11-libX11-7.4-5.9.1
rpm -i --force xorg-x11-libX11-32bit-7.4-5.9.1
rpm -e xorg-x11-libX11-7.4-5.11.15.1
rpm -e xorg-x11-libX11-32bit-7.4-5.11.15.1
```

This needs to be done before a user logs on to the machine – if this is done while a session is active, these settings will not take affect until the user next logs in.

If upgrading from stock SP3, the above xorg-x11-libX11 packages can be locked to the current installed version so that they won't be changed during the upgrade. Before upgrading, run the following before proceeding with the upgrade as normal:

```
zypper al xorg-x11-libX11
zypper al xorg-x11-libX11-32bit
```

**Long session launches may occur when using Linux VDA with a Delivery Controller from XenDesktop v7.1**

The slow launch is caused by the presence of CGP settings in the ICA file generated by the v7.1 Delivery Controller. When these settings are present, Citrix Receiver attempts to establish a connection on TCP port 2598. The default firewall settings on some Linux distributions, such as SLED 12, is to drop the TCP SYN packets, resulting in a timeout and hence a long session launch. The workaround is to configure the firewall on the Linux VDA to reject the TCP SYN on port 2598. This issue has been addressed in newer versions of the Delivery Controller.

**Registration fails when Linux VDA is rejoined to the domain**

Under certain circumstances, when a Linux VDA is rejoined to the domain and a fresh set of Kerberos keys are generated, the Broker fails to establish a security context with the VDA. This is often caused by the Broker using a cached out-of-date VDA service ticket based on the previous set of Kerberos keys. This won't stop the VDA from connecting to the Broker, but the Broker will not be able to establish a return security context to the VDA. The usual symptom is that the VDA registration fails.

This problem will eventually resolve itself when the VDA service ticket eventually expires and is renewed, but service tickets are usually long-lived. This could potentially be hours.

The solution is to clear the Broker's ticket cache. You could simply reboot the broker or run the following on the Broker from a command prompt as Administrator:

```
klist -li 0x3e4 purge
```
This will purge all service tickets in the LSA cache held by the Network Service principal under which the Citrix Broker Service runs. This will remove service tickets for other VDAs and potentially other services. However, this is harmless – these service tickets will simply be reacquired from the KDC when needed again.

**Lock screen icon missing when using HDX 3D Pro with GNOME**

When the NVIDIA Grid drivers are active Gnome Desktop Manager (GDM) is not active and the GDM lock screen capability is not available.

**Audio plug-n-play not supported**

It is recommended that any audio capture device is connected to the client machine before starting to record audio in the ICA session. If a device is attached after the audio recording application has started the application may become unresponsive. If this issue occurs just restart the application. A similar issue may occur if a capture device is unplugged while recording.

**Audio Distortion**

Windows 10 Receiver may experience audio distortion during audio recording.

**CTXPS driver isn’t compatible with some PLC printers**

If you see printing output corruptions set the printer driver to native printer driver provided by the manufacturer.

**Slow printing performance for large documents**

When you print a large document on a local client printer, the print file is transferred over the server connection. On slow connections, this may take a long time.

**Printer and print job notifications seen from other sessions.**

Linux does not have the same session concept as the Windows Operating system. Therefore all users get system wide notifications. The administrator can disable these notifications by modifying the CUPS configuration file, `/etc/cups/cupsd.conf`.

Find the current policy name configured in the file.

```
DefaultPolicy default
```

If the policy name is default, then add the following lines into default policy XML block.

```
<Policy default>
    # Job/subscription privacy...
    JobPrivateAccess default
    JobPrivateValues default
    SubscriptionPrivateAccess default
    SubscriptionPrivateValues default
    ...
    ...
</Policy>
```
<Limit Create-Printer-Subscription>
    Require user @OWNER
    Order deny,allow
</Limit>

<LIMIT All>
    Order deny,allow
</Limit>

</Policy>

Glossary

Broker - XenDesktop component responsible for brokering HDX sessions to the different VDAs within a XenDesktop deployment. Also known as the DDC or XenDesktop Controller.

Broker Agent - Component on the Linux VDA machine providing the desktop to be delivered. The Broker Agent communicates with the Broker to enable the brokering of sessions. It is composed of two key components, the VDA Service and the HDX Service.

Citrix Director - Citrix helpdesk/support console for monitoring and controlling XenDesktop VDAs.

Citrix Studio - Citrix administration console used to configure XenDesktop.

DDC - XenDesktop Desktop Delivery Controller. Also known as the Broker or Delivery Controller.

FQDN – Fully Qualified Domain Name

HDX - High Definition Experience protocol. Formerly known as the Citrix ICA protocol.

HDX Service - The Linux service (ctxhdx) that remotes the virtual Linux desktop via the HDX protocol. It communicates with the VDA service to enable the brokering of sessions.

RHEL - Red Hat Enterprise Linux. A commercial Linux distribution provided by Red Hat.

SLED - SUSE Linux Enterprise Desktop. A commercial Linux distribution provided by Novell.

SLES - SUSE Linux Enterprise Server. A commercial Linux distribution provided by Novell.

VDA - Virtual Delivery Agent.

VDA Service - The Linux service (ctxvda) that communicates with the Broker to enable the brokering of sessions. It also communicates with the HDX Service for remote session delivery.
Install SUSE Linux VDAs

Mar 28, 2016
You can create Linux virtual desktops based on a SUSE distribution. Prepare your Linux virtual machines, install the new Linux VDA software on them, configure your Delivery Controller, and then use Studio to make the desktops available to users.

For details, see the following document.

Note
The Linux shell commands used in this document have been verified to work with the GNU Bash shell.

The article includes the following sections:

- System requirements
- Configure delivery controllers
- Prepare Linux machines for VDA installation
- Configure Linux machine catalog and delivery group
- Install Linux VDA software
- Run VDA software
- Uninstall Linux VDA software
- Troubleshooting
- Known issues
- Glossary

System requirements

Linux distributions
The following Linux distributions are supported by the Linux Virtual Desktop product:

- SUSE Linux Enterprise:
  - Desktop 11 Service Pack 4
  - Desktop 12 Service Pack 1
  - Server 11 Service Pack 4
  - Server 12 Service Pack 1
- Red Hat Enterprise Linux
  - Workstation 6.7
  - Workstation 7.2
  - Server 6.7
Note

In all cases, the processor architecture supported is x86-64.

XenDesktop

The following versions of XenDesktop are supported by the Linux VDA:

- XenDesktop 7.1
- XenDesktop 7.5
- XenDesktop 7.6
- XenDesktop 7.7
- XenDesktop 7.8

The configuration process for Linux VDAs differs slightly than for Windows VDAs. However, any Delivery Controller farm is capable of brokering both Windows and Linux desktops.

Note

The Linux VDA is incompatible with XenDesktop version 7.0 or earlier.

Citrix Receiver

The following versions of Citrix Receiver are supported:

- Citrix Receiver for Windows version 4.4 or newer (this equates to v14.4 of wfica32.exe)
- Citrix Receiver for Linux version 13.3 or newer
- Citrix Receiver for Mac OSX version 12.1 or newer
- Citrix Receiver for Android version 3.8 or newer
- Citrix Receiver for iOS version 6.14 or newer
- Citrix Receiver for Chrome/HTML5 version 1.9 (only via Access Gateway)

Hypervisors

The following hypervisors for hosting Linux VDA guest VMs are supported:

- XenServer
- VMware ESX and ESXi
- Microsoft Hyper-V

Bare metal hosting is also supported.

Tip

Refer to the hypervisor vendor’s documentation for the list of supported platforms.
Active Directory Integration Packages

The following Active Directory integration packages or products are supported by the Linux VDA:

- Samba Winbind
- Quest Authentication Services v4.1 or newer
- Centrify DirectControl

Tip
Refer to the Active Directory Integration package vendor’s documentation for the list of supported platforms.

Configure delivery controllers

XenDesktop 7.7 or higher includes the necessary changes to support Linux Virtual Desktop, however, for previous versions a hotfix or update script is required. The installation and verification of these are provided in this section.

Update delivery controller configuration

For XenDesktop 7.6 SP2, apply the Hotfix Update 2 to update the Broker for Linux Virtual Desktops. Hotfixes Update 2 is available here:

- CTX142438: Hotfix Update 2 - For Delivery Controller 7.6 (32-bit) – English
- CTX142439: Hotfix Update 2 - For Delivery Controller 7.6 (64-bit) – English

For earlier versions of XenDesktop, a PowerShell script named \texttt{Update-BrokerServiceConfig.ps1} is provided which updates the broker service configuration. This is available in the following package:

- citrix-linuxvda-scripts-1.2.0.zip

Repeat the following steps on every Delivery Controller in the farm:

1. Copy the \texttt{Update-BrokerServiceConfig.ps1} script to the Delivery Controller machine.
2. Open a Windows PowerShell console in the context of the local administrator.
3. Browse to the folder containing the script.
4. Execute the script:

\texttt{.\\Update-BrokerServiceConfig.ps1}

Note

By default, PowerShell is configured to prevent the execution of PowerShell scripts. If the script fails to run, you may need to change the PowerShell execution policy before trying again:

\texttt{Set-ExecutionPolicy Unrestricted}
The **Update-BrokerServiceConfig.ps1** script updates the Broker service configuration file with new WCF endpoints required by the Linux VDA and restarts the broker service. The script determines the location of the broker service configuration file automatically. A backup of the original configuration file is created in the same directory with the extension `.prelinux`.

These changes will have no impact on the brokering of Windows VDA's configured to use the same Delivery Controller farm. This allows for a single Controller farm to manage and broker sessions to both Windows and Linux VDAs seamlessly.

Verify delivery controller configuration

To verify whether the required configuration changes have been applied to a Delivery Controller, confirm the string `EndpointLinux` appears five times in the file:

```
%PROGRAMFILES%\Citrix\Broker\Service\BrokerService.exe.config
```

From the Windows command prompt, logged on as a local administrator:

```
findstr EndpointLinux BrokerService.exe.config
```

Prepare Linux machine for VDA installation

Launch YaST tool

The SUSE Linux Enterprise YaST tool is used for configuring all aspects of the operating system.

To launch the text-based YaST tool:

```
su -
yast
```

Alternatively, launch the UI-based YaST tool:

```
su -
yast2 &
```

Configure networking

The following sections provide information on configuring the various networking settings and services used by the Linux VDA. Configuring networking should be carried out via the YaST tool, not via other methods such as Network Manager. These instructions are based on using the UI-based YaST tool; the text-based YaST tool can be used but has a different method of navigation which is not documented here.

Configure hostname and DNS

1. Open YaST Network Settings.
2. SLED 12 Only: On the **Global Options** tab, change the **Network Setup Method** to **Wicked Service**.
3. Open the **Hostname/DNS** tab.
4. Uncheck **Change hostname via DHCP**.
5. Check **Assign Hostname to Loopback IP**.
6. Edit the following to reflect your networking setup:
   
   - Hostname – Add the DNS hostname of the machine.
   - Domain Name – Add the DNS domain name of the machine.
   - Name Server – Add the IP address of the DNS server. This is typically the IP address of the AD Domain Controller.
   - Domain Search list – Add the DNS domain name.

   **Note**
   
   The Linux VDA currently does not support NetBIOS name truncation, therefore the hostname must not exceed 15 characters.

**Disable multicast DNS**

On SLED only, the default settings have multicast DNS (mDNS) enabled, which can lead to inconsistent name resolution results. mDNS is not enabled on SLES by default, so no action is required.

To disable mDNS, edit /etc/nsswitch.conf and change the line containing:

    hosts: files mdns_minimal [NOTFOUND=return] dns

To:

    hosts: files dns

**Check the hostname**

Verify that the hostname is set correctly:

    hostname

This should return only the machine's host name and not its fully qualified domain name (FQDN).

Verify that the FQDN is set correctly:

    hostname -f

This should return the machine's FQDN.

**Check name resolution and service reachability**

Verify that you can resolve the FQDN and ping the domain controller and XenDesktop Delivery Controller:

    nslookup domain-controller-fqdn
    ping domain-controller-fqdn
    nslookup delivery-controller-fqdn
    ping delivery-controller-fqdn

If you cannot resolve the FQDN or ping either of these machines, review the steps before proceeding.
Configure NTP service

Maintaining accurate clock synchronization between the VDAs, XenDesktop Controllers and domain controllers is crucial. Hosting the Linux VDA as a virtual machine can cause clock skew problems. For this reason, maintaining time using a remote NTP service is preferred. Some changes might be required to the default NTP settings:

1. Open YaST NTP Configuration and select the General Settings tab.
2. In the Start NTP Daemon section, check Now and on Boot.
3. If present, select the Undisciplined Local Clock (LOCAL) item and click Delete.
4. Add an entry for an NTP server by clicking Add.
5. Select the Server Type and click Next.
6. Enter the DNS name of the NTP server in the Address field. This service is normally hosted on the Active Directory domain controller.
7. Leave the Options field unchanged.
8. Click Test to check that the NTP service is reachable.
9. Click OK through the set of windows to save the changes.

Note
For SLES 12 implementations, if the NTP daemon fails to start, this might be due to a known SUSE issue with AppArmor policies. Follow the resolution here for additional information.

Install Linux VDA dependent packages

The Linux VDA software for Suse Linux Enterprise is dependent on the following packages:

- PostgreSQL
  - SLED/SLES 11: Version 9.1 or newer
  - SLED/SLES 12: Version 9.3 or newer
- OpenJDK 1.7.0
- OpenMotif Runtime Environment 2.3.1 or newer
- Cups
  - SLED/SLES 11: Version 1.3.7 or newer
  - SLED/SLES 12: Version 1.6.0 or newer
- Foomatic filters
  - SLED/SLES 11: Version 3.0.0 or newer
  - SLED/SLES 12: Version 1.0.0 or newer
- ImageMagick
  - SLED/SLES 11: Version 6.4.3.6 or newer
  - SLED/SLES 12: Version 6.8 or newer

Add repositories

Some required packages are not available in all Suse Linux Enterprise repositories:

- SLED 11: PostgreSQL is available for SLES 11 but not SLED 11.
- SLED 11: OpenJDK and OpenMotif are available for SLED 11 but not SLES 11.
- SLED 12: PostgreSQL is available for SLES 12 but not SLED 12. ImageMagick is available via the SLE 12 SDK ISO or online
SLES 12: There are no issues; all packages are available. ImageMagick is available via the SLE 12 SDK ISO or online repository.

To resolve this, the recommended approach is to obtain missing packages from the media for the alternate edition of SLE from which you are installing. That is, on SLED install missing packages from the SLES media, and on SLES install missing packages from the SLED media. The approach described below mounts both SLED and SLES ISO media files and adds repositories.

<table>
<thead>
<tr>
<th>Edition</th>
<th>Command</th>
</tr>
</thead>
</table>
| SLED 11    | sudo mkdir -p /mnt/sles  
|            | sudo mount -t iso9660 \                  |
|            | path-to-iso/SLES-11-SP3-DVD-x86_64-GM-DVD1.iso /mnt/sles  
|            | sudo zypper ar -f /mnt/sles sles           |
| SLES 11    | sudo mkdir -p /mnt/sled  
|            | sudo mount -t iso9660 \                  |
|            | path-to-iso/SLED-11-SP3-DVD-x86_64-GM-DVD1.iso /mnt/sled  
|            | sudo zypper ar -f /mnt/sled sled          |
| SLED 12    | sudo mkdir -p /mnt/sles  
|            | sudo mount -t iso9660 \                  |
|            | path-to-iso/SLES-12-DVD-x86_64-GM-DVD1.iso /mnt/sles  
|            | sudo zypper ar -f /mnt/sles sles          |
| SLED/SLES 12| sudo mkdir -p /mnt/sdk  
|            | sudo mount -t iso9660 \                  |
|            | path-to-iso/SLE-12-SDK-DVD-x86_64-GM-DVD1.iso /mnt/sdk  
|            | sudo zypper ar -f /mnt/sdk sdk            |

Install Kerberos client

Install the Kerberos client for mutual authentication between the Linux VDA with the XenDesktop Controllers:

```
sudo zypper install krb5-client
```

The Kerberos client configuration is dependent on which Active Directory integration approach is used, which is described...
Install OpenJDK

The Linux VDA dependent on OpenJDK 1.7.0.

Tip

To avoid problems, make sure you only installed the 1.7.0 version of OpenJDK. Remove all other versions of Java on your system.

| SLED         | On SLED, the Java runtime environment should have been installed with the operating system. Confirm this with:  
|              |   sudo zypper info java-1_7_0-openjdk  
|              | Update to the latest version if status is reported as out-of-date:  
|              |   sudo zypper update java-1_7_0-openjdk  
|              | Check the Java version:  
|              |   java -version |

| SLES         | On SLES, the Java runtime environment needs to be installed:  
|              |   sudo zypper install java-1_7_0-openjdk  
|              | Check the Java version:  
|              |   java -version |

Install PostgreSQL

| SLED/SLES 11 | Install the packages:  
|              |   sudo zypper install libecpg6  
|              |   sudo zypper install postgresql?init  
|              |   sudo zypper install postgresql91  
|              |   sudo zypper install postgresql91?server  
|              |   sudo zypper install postgresql?jdbc  
|              | Some post-installation steps are required to initialize the database service and ensure PostgreSQL starts on boot:  
|              |   sudo /sbin/insserv postgresql |
### Install the PostgreSQL database server

**SLED/SLES 12**

Install the packages:

- `sudo zypper install postgresql-init`
- `sudo zypper install postgresql93-server`
- `sudo zypper install postgresql-jdbc`

Post-installation steps are required to initialize the database service and ensure PostgreSQL starts on boot:

- `sudo systemctl enable postgresql`
- `sudo systemctl restart postgresql`

Database files will reside under `/var/lib/pgsql/data`.

### Install the OpenMotif runtime environment

The Linux VDA requires either the motif or openmotif package, depending on the distribution.

**SLED/SLES 11**

Install the package:

- `sudo zypper install openmotif-libs`

**SLED/SLES 12**

Install the package:

- `sudo zypper install motif`

### Install printing support

The Linux VDA requires both cups and foomatic filters.

**SLED/SLES 11**

Install the packages:

- `sudo zypper install cups`
- `sudo zypper install foomatic-filters`

**SLED/SLES 12**

Install the packages:

- `sudo zypper install cups`
- `sudo zypper install cups-filters-foomatic-rip`
Install ImageMagick

Install the ImageMagick package:

    sudo zypper install ImageMagick

Remove repositories

With dependent packages installed, the alternative edition repositories setup earlier can now be removed and the media unmounted:

<table>
<thead>
<tr>
<th>Edition</th>
<th>Remove the following packages:</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLED 11</td>
<td>sudo zypper r sles</td>
</tr>
<tr>
<td></td>
<td>sudo umount /mnt/sles</td>
</tr>
<tr>
<td></td>
<td>sudo rmdir /mnt/sles</td>
</tr>
<tr>
<td>SLES 11</td>
<td>sudo zypper r sled</td>
</tr>
<tr>
<td></td>
<td>sudo umount /mnt/sled</td>
</tr>
<tr>
<td></td>
<td>sudo rmdir /mnt/sled</td>
</tr>
<tr>
<td>SLED 12</td>
<td>sudo zypper r sles</td>
</tr>
<tr>
<td></td>
<td>sudo umount /mnt/sles</td>
</tr>
<tr>
<td></td>
<td>sudo rmdir /mnt/sles</td>
</tr>
<tr>
<td>SLED/SLES 12</td>
<td>sudo zypper r sdk</td>
</tr>
<tr>
<td></td>
<td>sudo umount /mnt/sdk</td>
</tr>
<tr>
<td></td>
<td>sudo rmdir /mnt/sdk</td>
</tr>
</tbody>
</table>

Prepare Linux VM for Hypervisor

Some changes are required when running the Linux VDA as a virtual machine on a supported hypervisor. Make the following changes according to the hypervisor platform in use. No changes are required if you are running the Linux machine on bare metal hardware.

Fix time synchronization on Citrix XenServer

If the XenServer Time Sync feature is enabled, within each paravirtualized Linux VM you will experience issues with NTP and XenServer both trying to manage the system clock. To avoid the clock becoming out of sync with other servers, the system
clock within each Linux guest must be synchronized with NTP. This requires disabling host time synchronization. No changes are required in HVM mode.

On some Linux distributions, if you are running a paravirtualized Linux kernel with XenServer Tools installed, you can check whether the XenServer Time Sync feature is present and enabled from within the Linux VM:

```bash
su -

    cat /proc/sys/xen/independent_wallclock
```

This will return either:

- 0 - The time sync feature is enabled, and needs to be disabled.
- 1 - The time sync feature is disabled, and no further action is required.

If the `/proc/sys/xen/independent_wallclock` file is not present, the following steps are not required.

If enabled, disable the time sync feature by writing 1 to the file:

```bash
sudo echo 1 > /proc/sys/xen/independent_wallclock
```

To make this change permanent and persist after reboot, edit the `/etc/sysctl.conf` file and add the line:

```bash
xen.independent_wallclock = 1
```

To verify these changes, reboot the system:

```bash
reboot
```

After reboot, check that this has been set correctly:

```bash
su -

    cat /proc/sys/xen/independent_wallclock
```

This should return the value 1.

### Fix time synchronization on Microsoft Hyper-V

Linux VMs with Hyper-V Linux Integration Services installed can leverage the Hyper-V time synchronization feature to use the host operating system's time. To ensure the system clock remains accurate, this feature should be enabled alongside NTP services.

From the management operating system:

1. Open the Hyper-V Manager console.
2. For the settings of a Linux VM, select **Integration Services**.
3. Ensure **Time synchronization** is selected.

**Note**

This approach is different from VMware and XenServer, where host time synchronization is disabled to avoid conflicts with NTP. Hyper-V time synchronization can co-exist and supplement NTP time synchronization.
Fix time synchronization on ESX and ESXi

If the VMware Time Synchronization feature is enabled, within each paravirtualized Linux VM you will experience issues with NTP and the hypervisor both trying to synchronize the system clock. To avoid the clock becoming out of sync with other servers, the system clock within each Linux guest must be synchronized with NTP. This requires disabling host time synchronization.

If you are running a paravirtualized Linux kernel with VMware Tools installed:

1. Open the vSphere Client.
2. Edit settings for the Linux VM.
3. In the Virtual Machine Properties dialog, open the Options tab.
4. Select VMware Tools.
5. In the Advanced box, uncheck Synchronize guest time with host.

Add Linux machine to Windows domain

There are a number of methods for adding Linux machines to the Active Directory domain that are supported by XenDesktop for Linux:

- Samba Winbind
- Quest Authentication Service
- Centrify DirectControl

Follow the instructions below for your chosen method.

Samba Winbind

Join Windows Domain

This requires that your domain controller is reachable and you have an Active Directory user account with permissions to add machines to the domain:

1. Open YaST Windows Domain Membership.
2. Make the following changes:
   - Set the Domain or Workgroup to the name of your Active Directory domain or the IP address of the domain controller. Ensure the domain is entered in uppercase.
   - Check Also Use SMB information for Linux Authentication.
   - Check Create Home Directory on Login.
   - Check Single Sign-on for SSH.
   - Ensure Offline Authentication is not checked. This option is not compatible with the Linux VDA.
3. Click OK. If prompted to install some packages, click Install.
4. If a domain controller is found, it will ask whether you want to join the domain. Click Yes.
5. When prompted, enter the credentials of a domain user with permission to add computers to the domain and click OK.
6. A message indicating success is displayed.

7. If prompted to install some samba and krb5 packages, click Install.

YaST may have indicated that these changes will require some services to be restarted or the machine needs to be rebooted. It is advisable to reboot:

```
su -
reboot
```

**SLED/SLES 12 Only: Patch Kerberos credential cache name**

SLED/SLES 12 has changed the default Kerberos credential cache name specification from the usual FILE:/tmp/krb5cc_%{uid} to DIR:/run/user/%{uid}/krb5cc. This new DIR caching method is not compatible with the Linux VDA and must be manually changed. As root, edit /etc/krb5.conf and add the following setting under the [libdefaults] section if not set:

```
default_ccache_name = FILE:/tmp/krb5cc_%{uid}
```

**Verify domain membership**

The XenDesktop Controller requires that all VDA machines, whether Windows or Linux, have a computer object in Active Directory.

Verify that the machine is joined to a domain using Samba's `net ads` command:

```
sudo net ads testjoin
```

Verify additional domain and computer object information with:

```
sudo net ads info
```

**Verify the Kerberos configuration**

To verify Kerberos is configured correctly for use with the Linux VDA, check that the system keytab file has been created and contains valid keys:

```
sudo klist -ke
```

This should display the list of keys available for the various combinations of principal names and cipher suites. Run the Kerberos `kinit` command to authenticate the machine with the domain controller using these keys:

```
sudo kinit -k MACHINE\$@REALM
```

The machine and realm names must be specified in uppercase, and the dollar sign ($) must be escaped with a backslash (\) to prevent shell substitution. In some environments, the DNS domain name is different from the Kerberos realm name; ensure the realm name is used. If this command is successful, no output is displayed.

Verify that the TGT ticket for the machine account has been cached using:

```
sudo klist
```

Examine the machine account details using:

```
sudo net ads status
```
Verify user authentication

Use the wbinfo tool to verify that domain users can authenticate with the domain:

```
wbinfo --krb5auth=domain\username%password
```

The domain specified here is the AD domain name, not the Kerberos realm name. For the bash shell, the backslash (\) character must be escaped with another backslash. This command will return a message indicating success or failure.

To verify that the Winbind PAM module is configured correctly, logon locally with a domain user account that has not logged onto the machine previously:

```
ssh localhost -l domain\username
id -u
```

Check that a corresponding Kerberos credential cache file was created for the uid returned by the `id -u` command:

```
ls /tmp/krb5cc_uid
```

Check that the tickets in the user’s Kerberos credential cache are valid and not expired:

```
klist
```

Exit the session:

```
exit
```

A similar test can be performed by logging onto the Gnome or KDE console directly.

Quest authentication service

Configure Quest on Domain Controller

This assumes you have installed and configured the Quest software on the Active Directory domain controllers, and have been granted administrative privileges to create computer objects in Active Directory.

Enable Domain Users to Logon to Linux VDA Machines

For each domain user that needs to establish HDX sessions on a Linux VDA machine:

1. In the Active Directory Users and Computers management console, open Active Directory user properties for that user account.
2. Select Unix Account tab.
3. Check Unix-enabled.
4. Set the Primary GID Number to the group ID of an actual domain user group.

Note

These instructions are equivalent for setting up domain users for logon using the console, RDP, SSH or any other remoting protocol.
Configure Quest on Linux VDA

Configure VAS daemon

Auto-renewal of Kerberos tickets needs to be enabled and disconnected; authentication (offline logon) needs to be disabled:

```
sudo /opt/quest/bin/vastool configure vas vasd \
    auto-ticket-renew-interval 32400

sudo /opt/quest/bin/vastool configure vas vas_auth \
    allow-disconnected-auth false
```

This sets the renewal interval to 9 hours (32400 seconds) which is an hour less than the default 10 hour ticket lifetime. Set this parameter to a lower value on systems with a shorter Kerberos ticket lifetime.

Configure PAM and NSS

Quest requires that PAM and NSS be manually configured to enable domain user login via HDX and other services such as su, ssh, and RDP. To configure PAM and NSS:

```
sudo /opt/quest/bin/vastool configure pam

sudo /opt/quest/bin/vastool configure nss
```

Join Windows Domain

Join the Linux machine to the Active Directory domain using the Quest vastool command:

```
sudo /opt/quest/bin/vastool -u user join domain-name
```

The user is any domain user with permissions to join computers to the Active Directory domain. The domain-name is the DNS name of the domain; for example, example.com.

Verify Domain Membership

The XenDesktop Controller requires that all VDA machines, whether Windows or Linux, have a computer object in Active Directory. To verify that a Quest-joined Linux machine is on the domain:

```
sudo /opt/quest/bin/vastool info domain
```

If the machine is joined to a domain, the domain name is returned. If not joined, you will see the following error:

```
ERROR: No domain could be found.

ERROR: VAS_ERR_CONFIG: at ctx.c:414 in _ctx_init_default_realm

default_realm not configured in vas.conf. Computer may not be joined to domain
```

Verify User Authentication

To verify that Quest can authenticate domain users using PAM, logon with a domain user account that has not logged onto the machine previously:
ssh localhost -l domain\username
id -u

Check that a corresponding Kerberos credential cache file was created for the uid returned by the id -u command:

ls /tmp/krb5cc_uid

Check that the tickets in user's Kerberos credential cache are valid and not expired:

/opt/quest/bin/vastool klist

Exit the session:

exit

A similar test can be performed by logging onto the Gnome or KDE console directly.

Centrify DirectControl

Join Windows Domain

With the Centrify DirectControl Agent installed, join the Linux machine to the Active Directory domain using the Centrify adjoin command:

su –
adjoin -w -V -u user domain-name

The user parameter is any Active Directory domain user with permissions to join computers to the Active Directory domain. The domain-name parameter is the name of the domain to join the Linux machine to.

Verify Domain Membership

The XenDesktop Controller requires that all VDA machines, whether Windows or Linux, have a computer object in Active Directory. To verify that a Centrify-joined Linux machine is on the domain:

su –
adinfo

Check that the Joined to domain value is valid and the CentrifyDC mode returns connected. If the mode remains stuck in the starting state, then the Centrify client is experiencing server connection or authentication problems.

More comprehensive system and diagnostic information is available using:

adinfo --sysinfo all

adinfo –diag

To test connectivity to the various Active Directory and Kerberos services:

adinfo --test
Configure Linux machine catalog and delivery group

Add a Linux machine to the machine catalog

The process for creating machine catalogs and adding Linux VDA machines is very similar to the traditional Windows VDA approach. Refer to the online Citrix Product documentation for a more complete description of how to complete these tasks.

For creating machine catalogs that contain Linux VDA machines, there are a few restrictions that differentiates the process from creating machine catalogs for Windows VDA machines:

- For operating system, select:
  - Window Server OS or Server OS option for a hosted shared desktops delivery model.
  - Windows Desktop OS or Desktop OS option for a VDI dedicated desktop delivery model.
- Ensure machines are set as not power managed.
- As PVS and MCS are not supported for Linux VDAs, choose the Another service or technology (existing images) deployment method.
- Do not mix Linux and Windows VDA machines in the same machine catalog.

Note

Early versions of Citrix Studio did not support the notion of a "Linux OS"; however, selecting the Windows Server OS or Server OS option implies an equivalent hosted shared desktops delivery model. Selecting the Windows Desktop OS or Desktop OS option implies a XenDesktop single user per machine delivery model.

The Citrix documentation for creating machine catalogs is referenced below:

- XenDesktop 7.1
- XenDesktop 7.5
- XenDesktop 7.6
- XenDesktop 7.7
- XenDesktop 7.8

Earlier versions of XenDesktop are not supported.

Tip

If a machine leaves and is rejoined to the Active Directory domain, the machine will need to be removed and re-added again to the machine catalog.

Add a delivery group

The process for creating a delivery group and adding machine catalogs containing Linux VDA machines is almost identical for Windows VDA machines. Refer to the online Citrix Product documentation for a more complete description of how to complete these tasks.
For creating delivery groups that contain Linux VDA machine catalogs, the following restrictions apply:

- For delivery type, select Desktops. Linux VDA machines do not support application delivery.
- Ensure the AD users and groups you select have been properly configured to logon to the Linux VDA machines.
- Do not allow logon of unauthenticated (anonymous) users.
- Do not mix the delivery group with machine catalogs that contain Windows machines.

The Citrix documentation for creating delivery groups is referenced below:

- XenDesktop 7.1
- XenDesktop 7.5
- XenDesktop 7.6
- XenDesktop 7.7
- XenDesktop 7.8

Earlier versions of XenDesktop are not supported.

**Install the Linux VDA software**

**Uninstall the old version**

If you have previously installed a version of the Linux VDA older than v1.0, you should uninstall it before installing the new version.

Stop the Linux VDA services:

```
sudo /sbin/service ctxvda stop
sudo /sbin/service ctxhdx stop
```

Uninstall the package:

```
sudo rpm -e XenDesktopVDA
```

**Important**

Upgrading from the Tech Preview to v1.0, v1.1 or 1.2 is not supported.

**Install the Linux VDA**

Install the Linux VDA software using the RPM package manager:

**For SuSE 11:**

```
sudo rpm -i XenDesktopVDA-1.2.0.282-1x86_64.rpm
```

**For SuSE 12:**

```
sudo rpm -i XenDesktopVDA-1.2.0.282-1x86_64.rpm
```
Important
After installing the Linux VDA, Citrix recommends that you run the following command to enhance security:

    sudo sed -i '/ip addr | awk /a xhost"-LOCAL:"' /usr/local/bin/ctxsession.sh

Upgrade the Linux VDA
If you have previously installed v1.1 of the Linux VDA, upgrade the Linux VDA software using the RPM package manager:

For SuSE 11:

    sudo rpm -U XenDesktopVDA-1.2.0.282-1.x86_64.rpm

For SuSE 12:

    sudo rpm -U XenDesktopVDA-1.2.0.282-1.x86_64.rpm

Important
After upgrading the Linux VDA, Citrix recommends that you run the following command to enhance security:

    sudo sed -i '/ip addr | awk /a xhost"-LOCAL:"' /usr/local/bin/ctxsession.sh

Configure the Linux VDA
After installing the package you will need to configure the Linux VDA by running the `ctxsetup.sh` script. If you have upgraded the package you will need to run the `ctxsetup.sh` script to finalise your upgrade. Before making any changes, this script will verify the environment and ensure all dependencies are installed. If required, this script can be re-run at any time to change settings.

The script can either be run manually with prompting or automatically with pre-configured responses. Review help about this script before proceeding:

    sudo /usr/local/sbin/ctxsetup.sh --help

Prompted configuration
Run a manual configuration with prompted questions:

    sudo /usr/local/sbin/ctxsetup.sh

Automated configuration
For an automated install, the options required by the setup script can be provided with environment variables. If all of the required variables are present then the script will not prompt the user for any information, allowing the installation process to be scripted.

Supported environment variables include:
- `CTX_XDL_SUPPORT_DDC_AS_CNAME = Y | N` - The Virtual Delivery Agent supports specifying a Delivery Controller name using a DNS CNAME record. This is typically set to N.
- `CTX_XDL_DDC_LIST = list-ddc-fqdns` - The Virtual Delivery Agent requires a space-separated list of Delivery Controller Fully Qualified Domain Names (FQDNs) to use for registering with a Delivery. At least one FQDN or CNAME alias must be specified.
- `CTX_XDL_VDA_PORT = port-number` - The Virtual Delivery Agent communicates with Delivery Controllers using a TCP/IP port. This is typically port 80.
- `CTX_XDL_REGISTER_SERVICE = Y | N` - The Linux Virtual Desktop services support starting during boot. This is typically set to Y.
- `CTX_XDL_ADD_FIREWALL_RULES = Y | N` - The Linux Virtual Desktop services require incoming network connections to be allowed through the system firewall. You can automatically open the required ports (by default ports 80 and 1494) in the system firewall for the Linux Virtual Desktop. This is typically set to Y.
- `CTX_XDL_AD_INTEGRATION = 1 | 2 | 3` - The Virtual Delivery Agent requires Kerberos configuration settings to authenticate with the Delivery Controllers. The Kerberos configuration is determined from the installed and configured Active Directory integration tool on the system. Specify the supported Active Directory integration method to use:
  - 1 - Samba Winbind
  - 2 - Quest Authentication Service
  - 3 - Centrify DirectControl
- `CTX_XDL_HDX_3D_PRO = Y | N` - Linux Virtual Desktop supports HDX 3D Pro, a set of graphics acceleration technologies designed to optimize the virtualization of rich graphics applications. HDX 3D Pro requires a compatible NVIDIA Grid graphics card to be installed. If HDX 3D Pro is selected the Virtual Delivery Agent will be configured for VDI desktops (single-session) mode – (i.e. `CTX_XDL_VDI_MODE = Y`). This is not supported on SUSE. Ensure this value is set to N.
- `CTX_XDL_VDI_MODE = Y | N` - Whether to configure the machine as a dedicated desktop delivery model (VDI) or hosted shared desktop delivery model. For HDX 3D Pro environments this needs to be set to Y. This is typically set to N.
- `CTX_XDL_SITE_NAME = dns-name` - The Virtual Delivery Agent discovers LDAP servers using DNS, querying for LDAP service records. To limit the DNS search results to a local site, a DNS site name may be specified. This is typically empty [none].
- `CTX_XDL_LDAP_LIST = list-ldap-servers` - The Virtual Delivery Agent by default queries DNS to discover LDAP servers, however if DNS is unable to provide LDAP service records, you may provide a space-separated list of LDAP Fully Qualified Domain Names (FQDNs) with LDAP port (e.g. ad1.mycompany.com:389). This is typically empty [none].
- `CTX_XDL_SEARCH_BASE = search-base` - The Virtual Delivery Agent by default queries LDAP using a search base set to the root of the Active Directory Domain (e.g. DC=mycompany,DC=com), however to improve search performance, a search base may be specified (e.g. OU=VDI,DC=mycompany,DC=com). This is typically empty [none].
- `CTX_XDL_START_SERVICE = Y | N` - Whether or not the Linux VDA services are started when the Linux VDA configuration is complete. This is typically set to Y.

**Note**

HDX 3D Pro is not currently available on SUSE.

Set the environment variable and run the configure script:

```
export CTX_XDL_SUPPORT_DDC_AS_CNAME=Y|N
export CTX_XDL_DDC_LIST=list-ddc-fqdns
```
export CTX_XDL_VDA_PORT=port-number
export CTX_XDL_REGISTER_SERVICE=Y|N
export CTX_XDL_ADD_FIREWALL_RULES=Y|N
export CTX_XDL_AD_INTEGRATION=1|2|3
export CTX_XDL_HDX_3D_PRO=Y|N
export CTX_XDL_VDI_MODE=Y|N
export CTX_XDL_SITE_NAME=dns-name
export CTX_XDL_LDAP_LIST=list-ldap-servers
export CTX_XDL_SEARCH_BASE=search-base
export CTX_XDL_START_SERVICE=Y|N

sudo -E /usr/local/sbin/ctxsetup.sh

You must provide the -E option with sudo to pass the existing environment variables to the new shell it creates. Citrix recommends that you create a shell script file from the commands above with #!/bin/bash on the first line.

Alternatively, all parameters can be specified with a single command:

```
sudo CTX_XDL_SUPPORT_DDC_AS_CNAME=Y|N
    CTX_XDL_DDC_LIST=list-ddc-fqdns
    CTX_XDL_VDA_PORT=port-number
    CTX_XDL_REGISTER_SERVICE=Y|N
    CTX_XDL_ADD_FIREWALL_RULES=Y|N
    CTX_XDL_AD_INTEGRATION=1|2|3
    CTX_XDL_HDX_3D_PRO=Y|N
    CTX_XDL_VDI_MODE=Y|N
    CTX_XDL_SITE_NAME=dns-name
    CTX_XDL_LDAP_LIST=list-ldap-servers
    CTX_XDL_SEARCH_BASE=search-base
    CTX_XDL_START_SERVICE=Y|N

    /usr/local/sbin/ctxsetup.sh
```

Remove configuration changes

In some scenarios it may be necessary to remove the configuration changes made by the ctxsetup.sh script without
uninstalling the Linux VDA package.

Review help about this script before proceeding:

    sudo /usr/local/sbin/ctxcleanup.sh --help

To remove configuration changes:

    sudo /usr/local/sbin/ctxcleanup.sh

---

**Important**

This script will delete all configuration data from the database and will make the Linux VDA inoperable.

---

**Configuration logs**

The `ctxsetup.sh` and `ctxcleanup.sh` scripts will display errors on the console, with additional information written to a configuration log file:

    /tmp/xdl.configure.log

Restart the Linux VDA services to have the changes take affect.

**Run the VDA software**

Once you have configured the Linux VDA using the `ctxsetup.sh` script, you use the following commands to control the Linux VDA.

**Start the Linux VDA**

To start the Linux VDA services:

    sudo /sbin/service ctxhdx start
    sudo /sbin/service ctxvda start

**Stop the Linux VDA**

To stop the Linux VDA services:

    sudo /sbin/service ctxvda stop
    sudo /sbin/service ctxhdx stop

**Restart the Linux VDA**

To restart the Linux VDA services:

    sudo /sbin/service ctxvda stop
    sudo /sbin/service ctxhdx restart
sudo /sbin/service ctxvda start

Check the Linux VDA status
To check the running state of the Linux VDA services:
  sudo /sbin/service ctxvda status
  sudo /sbin/service ctxhdx status

Uninstall the Linux VDA software

Query Linux VDA installation status
To check whether the Linux VDA is installed and to view the version of the package installed:
  rpm -q XenDesktopVDA
To view more detailed information:
  rpm –qi XenDesktopVDA

Uninstall the Linux VDA
To uninstall the Linux VDA package:
  sudo rpm -e XenDesktopVDA

Note
Uninstalling the Linux VDA software will delete the associated PostgreSQL and other configuration data. However, the PostgreSQL package and other dependent packages that were setup prior to the installation of the Linux VDA will not be removed.

Remove dependent packages
This article does not cover the removal of dependent packages including PostgreSQL

Troubleshooting

Verify that the Linux machine has been prepared correctly
The most common issues are a direct result of Linux machine misconfiguration, mainly around networking, NTP time server configuration or Active Directory domain membership. Fixing the Linux machine’s configuration will often resolve issues with the VDA software.

Configure logging and tracing
The Broker Agent and the HDX Service log to syslog. Citrix Support provides a set of tools that can enable additional trace during a support call.

HDX Service Logging
The HDX Service is configured to log syslog out-of-the-box messages and no further configuration is needed.

**Broker Agent logging**

The Broker Agent (also known as the ctxvda service) writes log data to syslog via network sockets. This may not be configured out-of-the-box. To enable the Broker Agent logging to syslog logging, the following configuration is required:

**SLED/SLES 11**

Edit the `/etc/syslog-ng/syslog-ng.conf` file and add the following line in the `s_sys` section:

```plaintext
udp(ip(127.0.0.1) port(514));
```

Save and close the `syslog-ng.conf` file. Restart the syslog-ng service apply the change:

```plaintext
sudo service syslog-ng restart
```

**SLED/SLES 12**

Edit the `/etc/rsyslog.conf` file and add the following lines:

```plaintext
$ModLoad imudp
$UDPServerRun 514
```

Save and close the `rsyslog.conf` file. Restart the rsyslog service apply the change:

```plaintext
sudo service rsyslog restart
```

**What to try if HDX sessions won't start**

Ensure you have no orphaned processes which might be preventing new sessions from starting:

```plaintext
sudo pkill -9 ctxhdx
sudo pkill -9 ctxgfx
sudo pkill -9 ctxlogin
sudo pkill -9 ctxvfb
```

Restart the Linux VDA services and retry connection.

**Verify ownership and permissions of key directories and files**

Check the file ownership and permission of the following directories and files:

- `/var` - Owner: root, Group: root, Permissions: 0755
- `/var/xdl` - Owner: ctxsrvr, Group: ctxadm, Permissions: 0755
- `/var/xdl/.isacagent` - Owner: root, Group: root, Permissions: 0666
- `/var/xdl/.winsta` - Owner: ctxsrvr, Group: ctxadm, Permissions: 0777
- `/var/xdl/vda` - Owner: root, Group: root, Permissions: 0755

**Audio is not being heard**

Check that the volume control on the device running the Citrix Receiver as well as the Linux desktop are not muted or set...
to a low level.

Check that audio is enabled on the Linux VDA. Use the ctxreg tool to query the value of the configuration item fDisableCam:

    sudo ctxreg read -k "HKLM\System\CurrentControlSet\Control\Citrix\WinStations\tcp" -v fDisableCam

A value of 0x1 means audio is disabled. To enable, set fDisableCam to 0x0:

    sudo ctxreg update -k "HKLM\System\CurrentControlSet\Control\Citrix\WinStations\tcp" -v fDisableCam -d 0x00000000

If audio is still not being heard check that the Citrix audio sink is loaded by pulseaudio. This PulseAudio module is loaded into the pulseaudio daemon at session start. Use the pacmd tool to check the Citrix audio sink is loaded:

    pacmd list-sinks

If the Citrix audio sink is loaded, the output should be:

    name: <CitrixAudioSink>
    driver: <module-ctx-sink.c>

If Citrix audio sink is not loaded, kill the ctxaudio process and restart it.

Audio is not being recorded

Check that audio is enabled on the Linux VDA and audio recording is enabled on the ICA client. If audio is still not being recorded check that the Citrix audio source is loaded by pulseaudio. If audio recording is enabled on the ICA client, this PulseAudio module will be loaded into the pulseaudio daemon at session start. Use the pacmd tool to check the Citrix audio source is loaded:

    pacmd list-sources

If the Citrix audio source is loaded, the output should be:

    name: <CitrixAudioSource>
    driver: <module-ctx-source.c>

If the Citrix audio source is not loaded, kill the ctxaudio process and restart it.

Unable to print

There are a number of items to check if printing is not working correctly. The print daemon is a per session process and should be running for the length of the session. Check that the printing daemon is running.

    ps –ef | grep ctxlpmngt

If the ctxlpmngt process is not running manually start ctxlpmngt from a command line.

If printing is still not working the next item to check in the CUPS framework. The ctxcups service is for printer management and communicates with the Linux CUPS framework. This is a single process per machine and can be checked by:

    service ctxcups status
If the service is not running, start it manually:

    service ctxcups start

Print output is garbled

Garbled output can be caused by an incompatible printer driver. A per user driver configuration is available and can be configured by editing the ~/.CtxlpProfile configuration file.

```
[DEFAULT_PRINTER]
printername=
model=
ppdpath=
drivertype=
```

The printername is a field containing the name of the current client side default printer. This is a read-only value and should not be edited.

**Important**

The fields **ppdpath**, **model** and **drivertype** should not be set at the same time as only one takes effect for the mapped printer.

If the Universal Printer driver is not compatible with the client printer, the model of native printer driver can be configured with the model= option. The current model name of the printer can be found with the \(\text{lpinfo} \) command.

```
\text{lpinfo} \ -m
```

```
...
xerox/ph3115.ppd.gz Xerox Phaser 3115, SpliX V. 2.0.0
xerox/ph3115fr.ppd.gz Xerox Phaser 3115, SpliX V. 2.0.0
xerox/ph3115pt.ppd.gz Xerox Phaser 3115, SpliX V. 2.0.0
```

The model can then be set to match the printer:

```
Model=xerox/ph3115.ppd.gz
```

If the Universal Printer driver is not compatible with client printer, the ppd file path of native printer driver can be configured. The value of ppdpath is the absolute path of native printer driver file.

For example, there is a ppd driver under `/home/tester/NATIVE_PRINTER_DRIVER.ppd`.

```
ppdpath=/home/tester/NATIVE_PRINTER_DRIVER.ppd
```

There are three types of Universal Printer Driver supplied by Citrix (postscript, pcl5 and pcl6). These can configured in the
driver type if no native printer driver is available.

For example, if client default printer driver type is PCL5.

```
drivertype=pcl5
```

**Note**

Citrix Receiver for Mac and Citrix Receiver for Linux only support Postscript printers and so the PCL5 and PCL6 Universal Printer Drivers are not applicable. In this situation, ppdpath or the model of native printer driver has to be set to a non-Postscript printer.

### Known issues

**Citrix Receiver for Android CAPS LOCK state can be reversed when session roaming**

The CAPS LOCK state may be lost when roaming an existing connection to the Citrix Receiver for Android. The workaround is to use the shift key on the extended keyboard to switch between upper case and lower case.

**Shortcut keys with ALT do not always work when connecting to a Linux VDA using Citrix Receiver for Mac**

Citrix Receiver for Mac sends AltGr for both left and right Options/Alt keys by default. It is possible to change this within the Citrix Receiver settings but the results vary with different applications.

**Newer X client libraries can cause keyboard issues on SuSE Linux Enterprise Desktop 11**

Newer versions of the xorg-x11-libX11 packages on SuSE Linux Enterprise Desktop 11 may have problems handling keyboard mapping changes, which in turn may cause issues with keyboard functionality inside an HDX session. This can happen when the installed version of the packages is in the range 7.4-5.11.11 to 7.4-5.11.15.1.

The workaround is to rollback to the stock SP3 version of the xorg-x11-libX11 package, this enables keyboard mapping changes to work as normal. For example:

```
rpm -i --force xorg-x11-libX11-7.4-5.9.1
rpm -i --force xorg-x11-libX11-32bit-7.4-5.9.1
rpm -e xorg-x11-libX11-7.4-5.11.15.1
rpm -e xorg-x11-libX11-32bit-7.4-5.11.15.1
```

This needs to be done before a user logs on to the machine – if this is done while a session is active, these settings will not take affect until the user next logs in.

If upgrading from stock SP3, the above xorg-x11-libX11 packages can be locked to the current installed version so that they won't be changed during the upgrade. Before upgrading, run the following before proceeding with the upgrade as normal:

```
zypper al xorg-x11-libX11
zypper al xorg-x11-libX11-32bit
```
Long session launches may occur when using Linux VDA with a Delivery Controller from XenDesktop v7.1

The slow launch is caused by the presence of CGP settings in the ICA file generated by the v7.1 Delivery Controller. When these settings are present, Citrix Receiver attempts to establish a connection on TCP port 2598. The default firewall settings on some Linux distributions, such as SLED 12, is to drop the TCP SYN packets, resulting in a timeout and hence a long session launch. The workaround is to configure the firewall on the Linux VDA to reject the TCP SYN on port 2598. This issue has been addressed in newer versions of the Delivery Controller.

Registration fails when Linux VDA is rejoined to the domain

Under certain circumstances, when a Linux VDA is rejoined to the domain and a fresh set of Kerberos keys are generated, the Broker fails to establish a security context with the VDA. This is often caused by the Broker using a cached out-of-date VDA service ticket based on the previous set of Kerberos keys. This won’t stop the VDA from connecting to the Broker, but the Broker will not be able to establish a return security context to the VDA. The usual symptom is that the VDA registration fails.

This problem will eventually resolve itself when the VDA service ticket eventually expires and is renewed, but service tickets are usually long-lived. This could potentially take an inordinate amount of time.

The solution is to clear the Broker’s ticket cache. You could simply reboot the Broker or run the following on the Broker from a command prompt as Administrator:

```
klist -li 0x3e4 purge
```

This will purge all service tickets in the LSA cache held by the Network Service principal under which the Citrix Broker Service runs. This will remove service tickets for other VDAs and potentially other services. However, this is harmless – these service tickets will simply be reacquired from the KDC when needed again.

Audio plug-n-play not supported

It is recommended that any audio capture device is connected to the client machine before starting to record audio in the ICA session. If a device is attached after the audio recording application has started the application may become unresponsive. If this issue occurs just restart the application. A similar issue may occur if a capture device is unplugged while recording.

Audio Distortion

Windows 10 Receiver may experience audio distortion during audio recording.

CTXPS driver isn’t compatible with some PLC printers

If you see printing output corruptions set the printer driver to native printer driver provided by the manufacturer.

Slow printing performance for large documents

When you print a large document on a local client printer, the print file is transferred over the server connection. On slow connections, this may take a long time.

Printer and print job notifications seen from other sessions

Linux does not have the same session concept as the Windows Operating system. Therefore all users get system wide notifications. The administrator can disable these notifications by modifying the CUPS configuration file.
/etc/cups/cupsd.conf.

Find the current policy name configured in the file:

DefaultPolicy default

If the policy name is default, then add the following lines into default policy XML block.

```xml
<Policy default>
    # Job/subscription privacy...
    JobPrivateAccess default
    JobPrivateValues default
    SubscriptionPrivateAccess default
    SubscriptionPrivateValues default
    ...
    ...

    <Limit Create-Printer-Subscription>
        Require user @OWNER
        Order deny,allow
    </Limit>

    <Limit All>
        Order deny,allow
    </Limit>

</Policy>
```

**Glossary**

Broker - XenDesktop component responsible for brokering HDX sessions to the different VDAs within a XenDesktop deployment. Also known as the DDC or XenDesktop Controller.

Broker Agent - Component on the Linux VDA machine providing the desktop to be delivered. The Broker Agent communicates with the Broker to enable the brokering of sessions. It is composed of two key components, the VDA Service and the HDX Service.

Citrix Director - Citrix helpdesk/support console for monitoring and controlling XenDesktop VDAs.

Citrix Studio - Citrix administration console used to configure XenDesktop.

DDC - XenDesktop Desktop Delivery Controller. Also known as the Broker or Delivery Controller.

FQDN – Fully Qualified Domain Name
HDX - High Definition Experience protocol. Formerly known as the Citrix ICA protocol.

HDX Service - The Linux service (ctxhdx) that remotes the virtual Linux desktop via the HDX protocol. It communicates with the VDA service to enable the brokering of sessions.

RHEL - Red Hat Enterprise Linux. A commercial Linux distribution provided by Red Hat.

SLED - SUSE Linux Enterprise Desktop. A commercial Linux distribution provided by Novell.

SLES - SUSE Linux Enterprise Server. A commercial Linux distribution provided by Novell.

VDA - Virtual Delivery Agent.

VDA Service - The Linux service (ctxvda) that communicates with the Broker to enable the brokering of sessions. It also communicates with the HDX Service for remote session delivery.
Create a Site

Sep 14, 2016

A Site is the name you give to a XenApp or XenDesktop deployment. It comprises the Delivery Controllers and other core components, Virtual Delivery Agents (VDAs), connections to hosts (if used), plus the Machine Catalogs and Delivery Groups you create and manage. You create the Site after you install the core components and before creating your first Machine Catalog and Delivery Group.

Review this article before you start the Site creation wizard; it includes tasks to complete and decisions to consider before actually creating the Site.

Site creation wizard

Open Studio if it is not already open. You're automatically guided to the action that starts the Site creation wizard. The wizard pages cover the following configuration areas:

Site type and name

There are two Site types; choose one:

- **Application and desktop delivery Site.** When you create an application and desktop delivery Site, you can further choose to create a full deployment Site (recommended) or an empty Site. An empty Site is only partially configured, and is usually created by advanced administrators.
- **Remote PC Access Site.** A Remote PC Access Site allows designated users to remotely access their office PCs through a secure connection.

If you create an application and desktop delivery deployment now, you can add a Remote PC Access deployment later. Conversely, if you create a Remote PC Access deployment now, you can add a full deployment later.

Type a name for the Site. After the Site is created, its name appears at the top of the Studio navigation pane: Citrix Studio (site-name).

Databases

The Databases page contains selections for setting up the Site, Monitoring, and Configuration Logging databases. For details about database setup choices and requirements, see the Databases article.

If you will not be using a default SQL Server Express Edition installation, make sure the SQL Server software is installed on the machines before you create a Site; the System requirements article lists the supported versions.

If you want to add more Delivery Controllers to the Site, and have already installed the Controller software on other servers, you can add them to the Site from this page in the Site creation wizard. If you plan to generate scripts that will set up the databases, add the Controllers before you generate the scripts.

Licensing

Consider whether you will use existing licenses or the 30-day free trial license that allows you to add license files later. You can also add or download license files from within the Site creation wizard. For more information, see the Licensing documentation.
Specify the License Server address in the form name[\port]. The name must be a Fully Qualified Domain Name (FQDN), NetBIOS, or IP address; FQDN is recommended. If you omit the port number, the default is 27000. Click Connect. You cannot proceed to the next page in the wizard until a successful connection is made to the License Server.

Power management (Remote PC Access only)

See the Remote PC Access section below.

Host connection, network, and storage

If you will be using VMs on a hypervisor or cloud service to provide applications and desktops, set up that host environment before creating the Site. (See the information sources listed below.)

You create the first connection to a host in the Site creation wizard; you can modify that connection and create additional connections later. If you are not using a virtualization host, or if you will use Studio to manage user desktops hosted on dedicated blade PCs, select the connection type None.

If you are configuring a Remote PC Access Site and plan to use the Wake on LAN feature, select the Microsoft System Center Configuration Manager host type.

Specify whether you will use Machine Creation Services (MCS) or other tools to create VMs on the host.

After you select the connection type and tools, subsequent pages in the wizard specify the storage information and network the connection will use; these form the resources for a connection. After you create the Site, the resources name identifies that storage and network combination in Studio for that connection.

- Specify whether you will use shared or local storage on the host. Shared storage is available through the networks you select. If you use shared storage with XenServer, you can enable the use of IntelliCache to reduce load on the storage device; see the Connections article for more information.
- If you will be creating Desktop OS machines, specify whether you will use Personal vDisks and select the storage they will use. Personal vDisks can use the same storage as the VMs, or different storage. For more information, see the Personal vDisk articles.
- Select which available networks the VMs will use.

Connection type information sources

VMware

- VMware virtualization environment article.
- VMware product documentation.

Microsoft Hyper-V

- Microsoft System Center Virtual Machine Manager virtualization environment article.
- Microsoft documentation.

Microsoft Azure

- Microsoft Azure virtualization environments article.
- Microsoft documentation.
- When you create a connection in Studio, you can automatically import information from a Publish Settings file you downloaded from https://manage.windowsazure.com/publishsettings/index.

Amazon Web Services (AWS)

- AWS documentation.
When you create a connection in Studio, you must provide the API key and secret key values. You can export the key file containing those values from AWS and then import them. You must also provide the region, availability zone, VPC name, subnet addresses, domain name, security group names, and credentials.

The credentials file for the root AWS account (retrieved from the AWS console) is not formatted the same as credentials files downloaded for standard AWS users. Therefore, Studio cannot use the file to populate the API key and secret key fields. Ensure that you are using AWS IAM credentials files.

Citrix CloudPlatform

- Citrix CloudPlatform documentation.
- When you create a connection in Studio, you must provide the API key and secret key values. You can export the key file containing those values from CloudPlatform and then import those values.

Citrix XenServer

- Citrix XenServer documentation.
- When you create a connection in Studio, you must provide the credentials for a VM Power Admin or higher-level user.
- Citrix recommends using HTTPS to secure communications with XenServer. To use HTTPS, you must replace the default SSL certificate installed on XenServer; see CTX128656.
- You can configure high availability if it is enabled on the XenServer. Citrix recommends that you select all servers in the pool (from Edit High Availability) to allow communication with XenServer if the pool master fails.
- You can select a GPU type and group, or passthrough, if the XenServer supports vGPU. The display indicates if the selection has dedicated GPU resources.

Additional Features

You can select additional features to customize your Site. When you select the check box for an item that requires information, a configuration box appears.

**AppDNA Integration**

If you will be using AppDisks and have installed AppDNA, select this feature to allow analysis of applications in the AppDisks, review compatibility issues, and then take remedial actions to resolve those issues. For more information, see the AppDisks article.

**App-V Publishing**

Select this feature if you will use applications from Microsoft App-V packages that are located on App-V servers. When you select this check box, you are prompted to provide the URL of the App-V management server, and the URL and port number of the App-V publishing server.

If you will use applications from App-V packages on network share locations only, you do not need to select this feature.

You can also enable/disable and configure this feature later in Studio. For more information, see the App-V article.

**Remote PC Access**

If you are using the Wake on LAN feature, complete the configuration steps on the Microsoft System Center Configuration Manager before creating the Site. For details, see the Microsoft System Center Configuration Manager article.

When you create a Remote PC Access Site:

- If you're using the Wake on LAN feature, specify the Microsoft System Center Configuration Manager address, credential, and connection information on the Power Management page.
- Specify users or user groups on the Users page; there is no default action that automatically adds all users. Also specify
machine accounts (domain and OU) information on the **Machine Accounts** page of the wizard.

To add user information, click **Add Users**. Select users and user groups, and then click **Add users**.

To add machine accounts information, click **Add machine accounts**. Select machine accounts, and then click **Add machine accounts**. Click **Add OUs**. Select the domain and Organizational Units, and indicate if items in subfolders should be included. Click **Add OUs**.

**Note:** When you create a Remote PC Access Site, a Machine Catalog named Remote PC User Machine Accounts is created automatically, containing all the machine accounts you added in the Site creation wizard. A Delivery Group named Remote PC User Desktops is created automatically, containing all the users and user groups you added.

**Good to know**

- The Site creation wizard asks if you want to participate in the Citrix Customer Experience Improvement Program. When you join this program, anonymous statistics and usage information is sent to Citrix; for details, see [http://more.citrix.com/XD-CEIP](http://more.citrix.com/XD-CEIP).
- The last page of the Site creation wizard summarizes the information you specified. Use the **Back** button if you want to change anything. When you've finished, click **Create** and the Site creation will begin.
- The user who creates a Site becomes a Full Administrator; for more information, see the [Delegated Administration](#) article.

**Test a Site configuration**

You can view an HTML report of the Site test results.

To run the tests after you create the Site, select **Citrix Studio (Site site-name)** at the top of the navigation pane, and then click **Test site** in the center pane.
Create Machine Catalogs

Feb 24, 2016

Collections of physical or virtual machines are managed as a single entity called a Machine Catalog. All of the machines in a Machine Catalog have the same type of operating system: server or desktop. A catalog containing server OS machines can contain either Windows or Linux machines, not both.

Studio guides you to create the first Machine Catalog after you create the Site. After you create the first Machine Catalog, Studio guides you to create your first Delivery Group. Later, you can change the catalog you created, and create more catalogs.

Overview

When you create a catalog that will contain VMs, you specify how those VMs will be provisioned: you can use tools supported by Studio, such as Machine Creations Services (MCS) or Provisioning Services, or you can use your own tools to provide machines. If your machines are already provided for you (so you do not need to use master images), you still create one or more Machine Catalogs for your machines.

- If you are using Provisioning Services to create machines, see the Provisioning Services documentation for instructions.
- If you choose MCS to provision VMs, you provide a master image (or snapshot) as a guide to create identical VMs in the catalog. Before you create the catalog, you first use tools on your hypervisor or cloud service to create and configure the master image - this includes installing a Virtual Delivery Agent (VDA) on the image. Then, when you create the Machine Catalog in Studio, you select that image (or a snapshot of it), specify the number of VMs to create in the catalog, and configure additional information.

When using MCS or PVS to create your first Machine Catalog, you use the host connection that you configured when you created the Site. Later (after you create your first Machine Catalog and Delivery Group), you can change information about that connection or create additional connections.

After you complete the Machine Catalog creation wizard, tests run automatically to ensure that it is configured correctly. When the tests complete, you can view a test report. Later, you can run the tests at any time from Citrix Studio site-name in the Studio navigation pane.

Tip: If you are creating a catalog using the PowerShell SDK directly, rather than Studio, you can specify a hypervisor template (VMTemplates), as an alternative to an image or a snapshot of an image.

If you have Windows XP or Windows Vista machines, they must use an earlier VDA version, and will not be able to use the latest product features. If you cannot upgrade those machines to a supported Windows operating system version, Citrix recommends you keep them in a separate Machine Catalog.

MCS catalog creation summary

Here’s a brief overview of MCS actions after you provide information in the Create Machine Catalog wizard.

- If you selected a master image (rather than a snapshot) in the wizard, MCS creates a snapshot.
- MCS creates a full copy of the snapshot and places this on each storage location defined in the host connection.
- MCS adds the desktops to Active Directory, which creates unique identities.
- MCS creates the number of VMs specified in the wizard, with two disks defined for each VM. In addition to the two
disks per VM, a master is also stored in the same storage location. If you have multiple storage locations defined, each gets the following disk types:

- The full copy of the snapshot (noted above), which is read-only and shared across the VMs just created.
- A unique 16 MB identity disk that gives each VM a unique identity. Each VM gets an identity disk.
- A unique difference disk to store writes made to the VM. This disk is thin provisioned (if supported by the host storage) and increases to the maximum size of the master image, if required. Each VM gets a difference disk. This is the disk that holds changes made during sessions - it is permanent for dedicated desktops; for pooled desktops, it is deleted and a new one created after each restart.

Prepare a master image on the hypervisor or cloud service

**Tip:** Need connection type information sources? Go [here](#).

The master image contains the operating system, non-virtualized applications, VDA, and other software.

**Good to know:**

- A master image can also be known as a clone image, golden image, base VM, or base image. Host vendors and cloud service providers may use different terms.
- When using Provisioning Services, you can use a master image or a physical computer as the master target device. Provisioning Services uses different terminology than MCS to refer to images; see its documentation for details.
- Make sure your host has sufficient processors, memory, and storage to accommodate the number of machines you will create.
- Configure the correct amount of hard disk space required for desktops and applications, because that value cannot be changed later or in the Machine Catalog.
- Remote PC Access Machine Catalogs do not use master images.
- Microsoft KMS activation considerations when using MCS:
  - If your deployment includes 7.x VDAs with a XenServer 6.1 or 6.2, vSphere, or Microsoft System Center Virtual Machine Manager host, you do not need to manually re-arm Microsoft Windows or Microsoft Office.
  - If your deployment includes a 5.x VDA with a XenServer 6.0.2 host, see [CTX128580](#).
- Install and configure the following software on the master image:
  - Integration tools for your hypervisor (such as XenServer Tools, Hyper-V Integration Services, or VMware tools). If you omit this step, your applications and desktops might not function correctly.
  - A VDA - Citrix recommends installing the latest version to allow access to the newest features. Failure to install a VDA on the master image will cause the catalog creation to fail.
  - Third-party tools as needed, such as anti-virus software or electronic software distribution agents. Configure services with settings that are appropriate for users and the machine type (such as updating features).
  - Third-party applications that you are not virtualizing. Citrix recommends virtualizing applications because it significantly reduces costs by eliminating the need to update the master image after adding or reconfiguring an application. In addition, fewer installed applications reduce the size of the master image hard disks, which saves storage costs.
  - App-V clients with the recommended settings, if you plan to publish App-V applications. The App-V client is available from Microsoft.
  - When using MCS, and you will localize Microsoft Windows, install the locales and language packs. During provisioning, when a snapshot is created, the provisioned VMs use the installed locales and language packs.

**Important:** If you are using Provisioning Services or MCS, do not run Sysprep on master images.

To prepare a master image:

1. Using your hypervisor’s management tool, create a new master image and then install the operating system, plus all service packs and updates. The number of vCPUs and amount of memory are not critical at this point because you can change those values when you create the Machine Catalog. However, be sure to configure the amount of hard disk space required for desktops and applications, because that value cannot be changed later or in the Machine Catalog.
2. Make sure that the hard disk is attached at device location 0. Most standard master image templates configure this location by default, but some custom templates may not.
3. Install and configure the software listed above on the master image.
4. When using Provisioning Services, create a VHD file for the vDisk from your master target device before you join the master target device to a domain. See the Provisioning Services documentation for details.

5. Join the master image to the domain where applications and desktops will be members, and make sure that the master image is available on the host where the machines will be created. Note that joining the master image to a domain is not required if you are using MCS: the provisioned machines are joined to the domain specified in the Create Machine Catalog wizard.

6. Citrix recommends that you create and name a snapshot of your master image so that it can be identified later. If you specify a master image rather than a snapshot when creating a Machine Catalog, Studio creates a snapshot, but you cannot name it.

Prepare a master image for GPU-capable machines on XenServer

When using XenServer for your hosting infrastructure, GPU-capable machines require a dedicated master image. Those VMs require video card drivers that support GPUs, and must be configured to allow the VM to operate with software that uses the GPU for operations.

1. In XenCenter, create a VM with standard VGA, networks, and vCPU.
2. Update the VM configuration to enable GPU use (either Passthrough or vGPU).
3. Install a supported operating system and enable RDP.
4. Install XenServer Tools and NVIDIA drivers.
5. Turn off the Virtual Network Computing (VNC) Admin Console to optimize performance, and then restart the VM.
6. You are prompted to use RDP. Using RDP, install the VDA and then restart the VM.
7. Optionally, create a snapshot for the VM as a baseline template for other GPU master images.
8. Using RDP, install customer-specific applications that are configured in XenCenter and use GPU capabilities.

Create a Machine Catalog using Studio

Before you start the Machine Catalog creation wizard, review this section to learn about the choices you will make and information you will supply. When you start the wizard, some of the pages described below may not appear or they may have different titles, based on the selections you make.

**Important:** If you are using a master image, make sure you have installed a VDA on the image before creating the Machine Catalog.

From Studio:

- If you have created a Site but haven't yet created a Machine Catalog, Studio will guide you to the correct starting place to create a Machine Catalog.
- If you have already created a Machine Catalog and want to create another, select **Machine Catalogs** in the Studio navigation pane, and then select **Create Machine Catalog** in the Actions pane.

The wizard walks you through the items described below. The wizard pages you see may differ, depending on selections you make.

**Operating system**

Each catalog contains machines of only one type:

- **Server OS:** A Server OS catalog provides desktops and applications that can be shared by multiple users. The machines can be running supported versions of the Windows or Linux operating systems, but the catalog cannot contain both.
- **Desktop OS:** A Desktop OS catalog provides desktops and applications that are assigned to a variety of different users.
- **Remote PC Access:** A Remote PC Access catalog provides users with remote access to their physical office desktop machines. Remote PC Access does not require a VPN to provide security.
Machine management

The **Machine Management** page indicates how machines are managed and which tool you will use to deploy machines.

Choose whether or not machines in the catalog will be power managed through Studio.

- Machines are power managed through Studio or provisioned through a cloud environment, for example, VMs or blade PCs. This option is available only if you have a connection to a hypervisor or cloud service already configured.
- Machines are not power managed through Studio, for example, physical machines.

If you indicated that machines are power managed through Studio or provisioned through a cloud environment, choose which tool you will use to deploy machines.

- **Machine Creation Services (MCS)** – Uses a master image to create and manage virtual machines. Machine Catalogs in cloud environments use MCS. MCS is not available for physical machines.
- **Provisioning Services** – Manages target devices as a device collection. A Provisioning Services vDisk imaged from a master target device delivers desktops and applications. This option is not available for cloud deployments.
- **Other** – A tool that manages machines already in the data center. Citrix recommends you use Microsoft System Center Configuration Manager or another third-party application to ensure that the machines in the catalog are consistent.

Desktop types (desktop experience)

The **Desktop Experience** page (which appears only when creating a catalog containing Desktop OS machines) determines the type of desktops that will be created. The types differ according to whether or not they are assigned to a user, and what happens to any changes the user made when the machine restarts.

There are three types:

- **Pooled, random**: Desktops are assigned randomly – users connect to a new (random) desktop each time they log on. When a user logs off, the desktop becomes available for another user. When the desktop is restarted, any changes that were made are discarded.
- **Pooled, static**: Desktops are permanently assigned – users connect to the same (static) desktop each time they log on. When that user logs off, the desktop remains available only for that user. When the desktop is restarted, any changes that were made are discarded.
- **Dedicated**: Desktops are permanently assigned to a user. When that user logs off, the desktop remains available only for that user. When the desktop is restarted, any changes that were made are retained. You can save changes to a local VM disk or to a specified drive letter on a separate Personal vDisk.

Master image

Select the connection to the host hypervisor or cloud service, and then select the snapshot or VM created earlier. If you are creating the first Machine Catalog, the only available connection will be the one you configured when you created the Site.

**Remember:**

- If you are using Provisioning Services or MCS, do not run Sysprep on master images.
- If you specify a master image rather than a snapshot, Studio creates a snapshot, but you cannot name it.

To ensure you can use the latest product features, make sure the master image has the latest VDA version installed. Do not change the default **Select the VDA version installed** selection on the wizard page.
An error message appears if you select a snapshot or VM that is not compatible with the machine management technology you selected earlier in the wizard.

Security (cloud service environments)

Select one or more security groups for the VMs; these are shown only if the availability zone supports security groups.

Choose whether machines will use shared hardware or account-dedicated hardware.

Virtual machines, device collection, or VMs and users

The title of this page depends on the deployment method you chose on the Machine Management page.

- If you chose MCS, this page is titled Virtual Machines.
- If you chose Provisioning Services, this page is titled Device Collection.
- If you chose Other tools, this page is titled VMs and users.

On this page:

- Specify how many virtual machines to create.
- Choose the amount of memory (in MB) each machine will have. Each VM will have a 32 GB hard disk; this value is set in the master image and cannot be changed in the catalog.
- If you indicated on the Desktop Experience page that user changes to dedicated desktops should be saved on a separate Personal vDisk, specify the vDisk size in gigabytes and the drive letter.
- If your deployment contains more than one zone, you can select a zone for the catalog.

Network Interface Cards (NICs)

If you plan to use multiple NICs, associate a virtual network with each card. For example, you can assign one card to access a specific secure network, and another card to access a more commonly-used network. You can also add or remove NICs from this page.

Machine accounts

(Valid only for Remote PC Access catalogs) Specify the Active Directory machine accounts or Organizational Units (OUs) to add that correspond to users or user groups. Do not use a forward slash (/) in an OU name.

You can choose a previously-configured power management connection or elect not to use power management. If you want to use power management but a suitable connection hasn’t been configured yet, you can create that connection later and then edit the Machine Catalog to update the power management settings.

Computer accounts

Each machine in the catalog must have a corresponding Active Directory computer account. Indicate whether to create new accounts or use existing accounts, and the location for those accounts.

- If you create new accounts, you must have access to a domain administrator account for the domain where the machines will reside.

Specify the account naming scheme for the machines that will be created, using hash marks to indicate where sequential numbers or letters will appear. Do not use a forward slash (/) in an OU name. A name cannot begin with a number. For example, a naming scheme of PC-Sales-## (with 0-9 selected) results in computer accounts named PC-Sales-01, PC-Sales-02, PC-Sales-03, and so on.
If you use existing accounts, either browse to the accounts or click Import and specify a .csv file containing account names. The imported file content must use the format:

```
[ADComputerAccount]
ADcomputeraccountname.domain
...
```

Make sure that there are enough accounts for all the machines you're adding. Studio manages these accounts, so either allow Studio to reset the passwords for all the accounts or specify the account password, which must be the same for all accounts.

For catalogs containing physical machines or existing machines, select or import existing accounts and assign each machine to both an Active Directory computer account and to a user account.

For machines created with Provisioning Services, computer accounts for target devices are managed differently; see the Provisioning Services documentation.

**Name and description**

On the Summary page of the wizard, review the settings you specified. Enter a name and description for the catalog; this information appears in Studio.

After reviewing the information you specified, click **Finish** to start the catalog creation.
Manage Machine Catalogs

Feb 24, 2016
In this article:

- Introduction
- Add machines to a Machine Catalog
- Delete machines from a Machine Catalog
- Change a Machine Catalog description or change Remote PC Access settings
- Rename a Machine Catalog
- Move a Machine Catalog to another zone
- Delete a Machine Catalog
- Manage Active Directory computer accounts in a Machine Catalog
- Update a Machine Catalog
- Upgrade a Machine Catalog

Introduction

You can add or remove machines from a Machine Catalog, as well as rename, change the description, or manage a catalog's Active Directory computer accounts.

Maintaining catalogs can also include making sure each machine has the latest OS updates, anti-virus software updates, operating system upgrades, or configuration changes.

- For Machine Catalogs containing pooled random machines created using Machine Creation Services (MCS), you can maintain machines by updating the master image used in the catalog and then updating the machines. This enables you to efficiently update large numbers of user machines. For machines created using Provisioning Services, updates to machines are propagated through the vDisk. See the Provisioning Services documentation for details.
- For catalogs containing static, permanently assigned machines, and for Remote PC Access Machine catalogs, you manage updates to users' machines outside of Studio, either individually or collectively using third-party software distribution tools.

Add machines to a Machine Catalog

Before you start:

- Make sure the virtualization host (hypervisor or cloud service provider) has sufficient processors, memory, and storage to accommodate the additional machines.
- Make sure that you have enough unused Active Directory computer accounts. If you are using existing accounts, the number of machines you can add is limited by the number of accounts available.
- If you use Studio to create Active Directory computer accounts for the additional machines, you must have appropriate domain administrator permission.

To add machines to a catalog:

1. Select Machine Catalogs in the Studio navigation pane.
2. Select a Machine Catalog and then select Add machines in the Actions pane.
3. Select the number of virtual machines to add.
4. If there are insufficient existing Active Directory accounts for the number of VMs you are adding, select the domain and location where the accounts will be created. Specify an account naming scheme, using hash marks to indicate where sequential numbers or letters will appear. Do not use a forward slash (/) in an OU name. A name cannot begin with a number. For example, a naming scheme of PC-Sales-## (with 0-9 selected) results in computer accounts named PC-Sales-01, PC-Sales-02, PC-Sales-03, and so on.

5. If you use existing Active Directory accounts, either browse to the accounts or click **Import** and specify a .csv file containing account names. Make sure that there are enough accounts for all the machines you’re adding. Studio manages these accounts, so either allow Studio to reset the passwords for all the accounts, or specify the account password, which must be the same for all accounts.

The machines are created as a background process, and can take a lot of time when creating a large number of machines. Machine creation continues even if you close Studio.

**Delete machines from a Machine Catalog**

After you delete a machine from a Machine Catalog, users can no longer access it, so before deleting a machine, ensure that:

- User data is backed up or no longer required.
- All users are logged off. Turning on maintenance mode will stop new connections from being made to a machine.
- Machines are powered off.

To delete machines from a catalog:

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select a catalog and then select **View Machines** in the Actions pane.
3. Select one or more machines and then select **Delete** in the Actions pane.

Choose whether to delete the machines being removed. If you choose to delete the machines, indicate whether the Active Directory accounts for those machines should be retained, disabled, or deleted.

**Change a Machine Catalog description or change Remote PC Access settings**

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select a catalog and then select **Edit Machine Catalog** in the Actions pane.
3. (Remote PC Access catalogs only) On the **Power Management** page, you can change the power management settings and select a power management connection. On the **Organizational Units** page, add or remove Active Directory OUs.
4. On the **Description** page, change the catalog description.

**Rename a Machine Catalog**

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select a catalog and then select **Rename Machine Catalog** in the Actions pane.
3. Enter the new name.

**Move a Machine Catalog to a different zone**
If your Site has more than one zone, you can move a catalog from one zone to another.

**Caution:** Moving a catalog to a different zone than the hypervisor or cloud service containing the VMs in that catalog can affect performance.

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select a catalog and then select **Move** in the Actions pane.
3. Select the zone where you want to move the catalog.

## Delete a Machine Catalog

Before deleting a Machine Catalog, ensure that:

- All users are logged off and that no disconnected sessions are running.
- Maintenance mode is turned on for all machines in the catalog so that new connections cannot be made.
- All machines in the catalog are powered off.
- The catalog is not associated a Delivery Group – in other words, the Delivery Group does not contain machines from the catalog.

To delete a Machine Catalog:

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select a catalog and then select **Delete Machine Catalog** in the Actions pane.
3. Indicate whether the machines in the catalog should be deleted. If you choose to delete the machines, indicate whether the Active Directory computer accounts for those machines should be retained, disabled, or deleted.

## Manage Active Directory computer accounts in a Machine Catalog

To manage Active Directory accounts in a Machine Catalog, you can:

- Free unused machine accounts by removing Active Directory computer accounts from Desktop OS and Server OS Machine Catalogs. Those accounts can then be used for other machines.
- Add accounts so that when more machines are added to the catalog, the computer accounts are already in place. Do not use a forward slash (/) in an OU name.

To manage Active Directory accounts:

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select a catalog and then select **Manage AD accounts** in the Actions pane.
3. Choose whether to add or delete computer accounts. If you add accounts, specify what to do with the account passwords: either reset them all or enter a password that applies to all accounts. You might reset passwords if you do not know the current account passwords; you must have permission to perform a password reset. If you enter a password, the password will be changed on the accounts as they are imported. If you delete an account, choose whether the account in Active Directory should be kept, disabled, or deleted.

**Note:** You can also indicate whether Active Directory accounts should be retained, disabled, or deleted when you remove machines from a catalog or delete a catalog.

## Update a Machine Catalog
Citrix recommends that you save copies or snapshots of master images before you update the machines in the catalog. The database keeps an historical record of the master images used with each Machine Catalog. You can roll back (revert) machines in a catalog to use the previous version of the master image if users encounter problems with updates you deployed to their desktops, thereby minimizing user downtime. Do not delete, move, or rename master images; otherwise, you will not be able to revert a catalog to use them.

For catalogs that use Provisioning Services, you must publish a new vDisk to apply changes to the catalog. For details, see the Provisioning Services documentation.

After a machine is updated, it restarts automatically.

Update or create a new master image

**Tip:** Need connection type information sources? Go [here](#).

Before you update the Machine Catalog, either update an existing master image or create a new one on your host hypervisor.

1. On your hypervisor or cloud service provider, take a snapshot of the current VM and give the snapshot a meaningful name. This snapshot can be used to revert (roll back) machines in the catalog, if needed.
2. If necessary, power on the master image, and log on.
3. Install updates or make any required changes to the master image.
4. If the master image uses a personal vDisk, update the inventory.
5. Review these operating system optimization guides and apply the optimizations for your environment: [Windows 7 Optimization Guide](#) and [Windows 8/8.1 Virtual Desktop Optimization Guide](#).
6. Power off the VM.
7. Take a snapshot of the VM, and give the snapshot a meaningful name that will be recognized when the catalog is updated in Studio. Although Studio can create a snapshot, Citrix recommends that you create a snapshot using the hypervisor management console, and then select that snapshot in Studio. This enables you to provide a meaningful name and description rather than an automatically generated name. For GPU master images, you can change the master image only through the XenServer XenCenter console.

Update the catalog

To prepare and roll out the update to all machines in a catalog:

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select a catalog and then select **Update Machines** in the Actions pane.
3. On the **Master Image** page, select the host and the image you want to roll out.
4. On the **Rollout Strategy** page, choose when the machines in the Machine Catalog will be updated with the new master image: on the next shutdown or immediately. See below for details.
5. Verify the information on the **Summary** page and then click **Finish**. Each machine restarts automatically after it is updated.

**Tip:** If you are updating a catalog using the PowerShell SDK directly, rather than Studio, you can specify a hypervisor template (VMTemplates), as an alternative to an image or a snapshot of an image.

Rollout strategy

Updating the image on the next shutdown is provided when you are using the Citrix Connector for System Center Configuration Manager.

If you choose to update the image immediately, configure a distribution time and notifications.

- **Distribution time:** You can choose to update all machines at the same time, or specify the total length of time it should take to begin updating all machines in the catalog. An internal algorithm determines when each machine is updated and
restarted during that interval.

- **Notification:** In the left notification dropdown, choose whether to display a notification message on the machines before an update begins. By default, no message is displayed. If you choose to display a message 15 minutes before the update begins, you can choose (in the right dropdown) to repeat the message every five minutes after the initial message. By default, the message is not repeated. Unless you choose to update all machines at the same time, the notification message displays on each machine at the appropriate time before the update begins, calculated by an internal algorithm.

Roll back an update

After you roll out an updated/new master image, you can roll it back. This might be necessary if issues occur with the newly-updated machines. When you roll back, machines in the catalog are rolled back to the last working image. Any new features that require the newer image will no longer be available. As with the rollout, rolling back a machine includes a restart.

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select the catalog and then select **Rollback machine update** in the Actions pane.
3. Specify when to apply the earlier master image to machines, as described above for the rollout operation.

The rollback is applied only to machines that need to be reverted. For machines that have not been updated with the new/updated master image (for example, machines with users who have not logged off), users do not receive notification messages and are not forced to log off.

Upgrade a Machine Catalog or revert an upgrade

Upgrade the Machine Catalog after you upgrade the VDAs on the machines to a newer version. Citrix recommends upgrading all VDAs to the latest version to enable access to all the newest features.

Before upgrading a Machine Catalog:

- If you're using Provisioning Services, upgrade the VDA version in the Provisioning Services console.
- Start the upgraded machines so that they register with the Controller. This lets Studio determine that the machines in the Machine Catalog need upgrading.

To upgrade a Machine Catalog:

1. Select **Machine Catalogs** in the Studio navigation pane.
2. Select the catalog. The Details tab in the lower pane displays version information.
3. Select **Upgrade Catalog**. If Studio detects that the Machine Catalog needs upgrading, it displays a message. Follow the prompts. If one or more machines cannot be upgraded, a message explains why. Citrix recommends you resolve machine issues before upgrading the Machine Catalog to ensure that all machines function properly.

After the catalog upgrade completes, you can revert the machines to their previous VDA versions by selecting the catalog and then selecting **Undo** in the Actions pane.

**Note:** If you have Windows XP or Windows Vista machines, they must use an earlier VDA version, and will not be able to use the latest product features. If you cannot upgrade those machines to a currently supported Windows operating system, Citrix recommends you keep them in a separate catalog.
Create Delivery Groups

Feb 24, 2016

A Delivery Group is a collection of machines selected from one or more Machine Catalogs. The Delivery Group specifies which users can use those machines, plus the applications and/or desktops available to those users.

Creating a Delivery Group is the next step in configuring your deployment after creating a Site and creating a Machine Catalog. Later, you can change the initial settings in the first Delivery Group and create other Delivery Groups. There are also features and settings you can configure only when editing a Delivery Group, not when creating it.

For Remote PC Access, when you create a Site, a Delivery Group named Remote PC Access Desktops is automatically created.

To create a Delivery Group:

1. If you have created a Site and a Machine Catalog, but haven't yet created a Delivery Group, Studio will guide you to the correct starting place to create a Delivery Group. If you have already created a Delivery Group and want to create another, select Delivery Groups in the Studio navigation pane and then select Create Delivery Group in the Actions pane.
2. The Create Delivery Group wizard launches with an Introduction page, which you can remove from future launches of this wizard.
3. The wizard then guides you through the pages described below. When you are done with each page, click Next until you reach the final page.

Machines

Select a Machine Catalog and select the number of machines you want to use from that catalog.

Good to know:

- At least one machine must remain unused in a selected Machine Catalog.
- A Machine Catalog can be specified in more than one Delivery Group; however, a machine can be used in only one Delivery Group.
- A Delivery Group can use machines from more than one catalog; however, those catalogs must contain the same machine types (Server OS, Desktop OS, or Remote PC Access). In other words, you cannot mix machine types in a Delivery Group. Similarly, if your deployment has catalogs of Windows machines and catalogs of Linux machines, a Delivery Group can contain machines from either OS type, but not both.
- Citrix recommends that you install or upgrade all machines with the most recent VDA version, and then upgrade Machine Catalogs and Delivery Groups as needed. When creating a Delivery Group, if you select machines that have different VDA versions installed, the Delivery Group will be compatible with the earliest VDA version. (This is called the group's functional level.) For example, if one of the machines you select has VDA version 7.1 installed and other machines have the current version, all machines in the group can use only those features that were supported in VDA 7.1. This means that some features that require later VDA versions might not be available in that Delivery Group. For example, to use the AppDisks feature, the VDAs (and therefore the group's functional level) must be a minimum version 7.8.
- Each machine in a Remote PC Access Machine Catalog is automatically associated with a Delivery Group; when you create a Remote PC Access Site, a catalog named Remote PC Access Machines and a Delivery Group named Remote
**PC Access Desktops** are created automatically.

**Delivery type**

This page appears only if you chose a Machine Catalog containing static (assigned) desktop OS machines. Choose either Applications or Desktops on the Delivery Type page; you cannot enable both.

(If you selected machines from a Server OS or Desktop OS random (pooled) catalog, the delivery type is assumed to be applications and desktops: you can deliver applications, desktops, or both.)

**AppDisks**

To add an AppDisk, click Add. The Select AppDisks dialog box lists available AppDisks in the left column. The right column lists the applications on the AppDisk. (Selecting the Applications tab above the right column lists applications in a format similar to a Start menu; selecting the Installed packages tab lists applications in a format similar to the Programs and Features list.)

Select one or more checkboxes.

**Users**

Specify the users and user groups who can use the applications and desktops in the Delivery Group.

Where user lists are specified

Active Directory user lists are specified when you create or edit the following:

- A Site’s user access list, which is not configured through Studio. By default, the application entitlement policy rule includes everyone; see the PowerShell SDK BrokerAppEntitlementPolicyRule cmdlets for details.
- Delivery Groups.
- Applications.

The list of users who can access an application through StoreFront is formed by the intersection of the above user lists. For example, to restrict the ability to launch “Application A” to users in the Finance Department, you could:

- Use the default application entitlement policy rule that includes everyone.
- Configure the Delivery Group user list to allow all users to use any of the applications specified in the Delivery Group.
- Configure Application A’s properties to restrict its visibility to only Finance Department users.

Authenticated and unauthenticated users

There are two types of users: authenticated and unauthenticated (unauthenticated is also called anonymous). You can configure one or both types in a Delivery Group.

**Authenticated**

To access applications and desktops, the users and group members you specify by name must present credentials.
such as smart card or user name and password to StoreFront or Citrix Receiver. (For Delivery Groups containing Desktop OS machines, you can import user data (a list of users) later by editing the Delivery Group.)

**Unauthenticated (anonymous)**

For Delivery Groups containing Server OS machines, you can allow users to access applications and desktops without presenting credentials to StoreFront or Citrix Receiver. For example, at kiosks, the application might require credentials, but the Citrix access portal and tools do not. An Anonymous Users Group is created when you install the first Delivery Controller.

To grant access to unauthenticated users, each machine in the Delivery Group must have a VDA for Windows Server OS (minimum version 7.6) installed. When unauthenticated users are enabled, you must have an unauthenticated StoreFront store.

Unauthenticated user accounts are created on demand when a session is launched, and named AnonXYZ, in which XYZ is a unique three-digit value.

Unauthenticated user sessions have a default idle timeout of 10 minutes, and are logged off automatically when the client disconnects. Reconnection, roaming between clients, and Workspace Control are not supported.

The following table describes your choices on the Users page:

<table>
<thead>
<tr>
<th>Enable access for</th>
<th>Add/assign users and user groups?</th>
<th>Enable the &quot;Give access to unauthenticated users&quot; check box?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only authenticated users</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Only unauthenticated users</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Both authenticated and unauthenticated users</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Applications**

Good to know:

- You cannot add applications to Remote PC Access Delivery Groups.
- By default, new applications you add are placed in a folder named Applications. You can specify a different folder. For details, see the Manage Applications article.
- You can change the properties for an application when you add it to a Delivery Group, or later. For details, see the Manage Applications article.
- If you try to add an application and one with the same name already exists in that folder, you are prompted to rename the application you are adding. If you decline, the application is added with a suffix that makes it unique within that application folder.
- When you add an application to more than one Delivery Group, a visibility issue can occur if you do not have sufficient
permission to view the application in all of those Delivery Groups. In such cases, either consult an administrator with
greater permissions or have your scope extended to include all the Delivery Groups to which the application was added.

- If you publish two applications with the same name to the same users, change the Application name (for user) property
  in Studio; otherwise, users will see duplicate names in Receiver.

Click the Add dropdown to display the application sources.

- From Start menu: Applications that are discovered on a machine created from the master image in the selected
catalog. When you select this source, a new page launches with a list of discovered applications; select those you want
to add and then click OK.

- Manually defined: Applications located in the Site or elsewhere in your network. When you select this source, a new
  page launches where you type the path to the executable, working directory, optional command line arguments, and
display names for administrators and users. After entering this information, click OK.

- Existing: Applications previously added to the Site, perhaps in another Delivery Group. When you select this source, a
  new page launches with a list of discovered applications; select those you want to add and then click OK.

- App-V: Applications in App-V packages. When you select this source, a new page launches where you select the App-V
  server or the Application Library. Select the applications you want to add from the resulting display and then click OK.
  For more information, see the App-V article.

If an application source or application is not available or valid, it is either not visible or cannot be selected. For example, the
Existing source is not available if no applications have been added to the Site. Or, an application might not be compatible
with the supported session types on machines in the selected Machine Catalog.

**Desktops (or Desktop Assignment Rules)**

The title of this page depends on the Machine Catalog you chose earlier in the wizard:

- If you chose a Machine Catalog containing pooled machines, this page is titled Desktops.
- If you chose a Machine Catalog containing assigned machines and specified “Desktops” on the Delivery Type page, this
  page is titled Desktop User Assignments.
- If you chose a Machine Catalog containing assigned machines and specified “Applications” on the Delivery Type page,
  this page is titled Application Machine User Assignments.

Click Add. In the dialog box:

- In the Display name and Description fields, type the information to be displayed in Receiver.
- Using the radio buttons, indicate who can launch a desktop (for groups with pooled machines) or who will be assigned a
  machine when they launch the desktop (for groups with assigned machines). The users can be either everyone who can
  access this Delivery Group, or specific users and user groups.
- If the group contains assigned machines, specify the maximum number of desktops per user. This must be a value of one
  or greater.
- Enable or disable the desktop (for pooled machines) or desktop assignment rule (for assigned machines). Disabling a
desktop stops desktop delivery; disabling a desktop assignment rule stops desktop auto-assignment to users.
- When you are finished with the dialog box, click OK.

**Summary**
Enter a name for the Delivery Group. You can also (optionally) enter a description, which will appear in Receiver and in Studio.

Review the summary information and then click **Finish**. If you did not select any applications or specify any desktops to deliver, you are asked if you want to continue.
Manage Delivery Groups

Feb 24, 2016

Introduction

After creating a Delivery Group, you can change settings you specified when creating the group; you can also configure other settings that are not available when you create a Delivery Group.

See the following articles for additional Delivery Group management procedures:

- Manage applications
- Manage machines
- Manage sessions

Change user settings in a Delivery Group

The name of this page may appear as either User Settings or Basic Settings.

1. Select Delivery Groups in the Studio navigation pane.
2. Select a group and then select Edit Delivery Group in the Actions pane.
3. On the User Settings (or Basic Settings) page, change any of the following, and then click OK or Apply.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The text that StoreFront uses and that users see.</td>
</tr>
<tr>
<td>Enable Delivery Group</td>
<td>Whether or not the Delivery Group is enabled.</td>
</tr>
<tr>
<td>Desktops per user</td>
<td>(Assigned desktop OS machines only) The maximum number of shared desktops that a user can have active at the same time. In assign-on-first-use deployments, this value specifies how many desktops users can assign to themselves.</td>
</tr>
<tr>
<td>Time zone</td>
<td></td>
</tr>
<tr>
<td>Enable Secure ICA</td>
<td>Secures communications to and from machines in the Delivery Group using SecureICA, which encrypts the ICA protocol (default level is 128-bit; the level can be changed using the SDK). Citrix recommends using additional encryption methods such as TLS encryption when traversing public networks. Also, SecureICA does not check data integrity.</td>
</tr>
</tbody>
</table>

Add or remove users in a Delivery Group
For detailed information about users, see the Users section in the Create a Delivery Group article.

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a group and then select **Edit Delivery Group** in the Actions pane.
3. On the **Users** page, to add users, click **Add**, and then specify the users you want to add. To remove users, select one or more users and then click **Remove**. You can also select/clear the check box that enables or disables access by unauthenticated users.
4. Click **OK** or **Apply**.

**Import or export user lists**

For Delivery Groups containing physical Desktop OS machines, you can import user information from a .csv file after you create the Delivery Group. You can also export user information to a .csv file. The .csv file can contain data from a previous product version.

The first line in the .csv file must contain comma-separated column headings (in any order), which can include: ADComputerAccount, AssignedUser, VirtualMachine, and HostId. Subsequent lines in the file contain comma-separated data. The ADComputerAccount entries can be common names, IP addresses, distinguished names, or domain and computer name pairs.

To import or export user information:

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a Delivery Group, and then select **Edit Delivery Group** in the Actions pane.
3. On the Machine Allocation page, select **Import** list or **Export** list, and then browse to the file location.

**Change the delivery type of a Delivery Group**

The delivery type indicates what the group can deliver: applications, desktops, or both.

Before changing an **application only** or **desktops and applications** type to a **desktops only** type, delete all applications from the group.

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a group and then select **Edit Delivery Group** in the Actions pane.
3. On the Delivery Type page, select the delivery type you want.
4. Click **OK** or **Apply**.

**Change StoreFront information**

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a group and then select **Edit Delivery Group** in the Actions pane.
3. On the StoreFront page, select or add StoreFront URLs that will be used by the Citrix Receiver that is installed on each machine in the Delivery group.
4. Click **OK** or **Apply**.

You can also specify StoreFront server address by selecting **Configuration > StoreFront** in the Studio navigation pane.
Upgrade a Delivery Group or revert an upgrade

Upgrade a Delivery Group after you upgrade the VDAs on its machines and the Machine Catalogs containing the machines used in the Delivery Group.

Before you start the Delivery Group upgrade:

- If you use Provisioning Services, upgrade the VDA version in the Provisioning Services console.
- Start the machines containing the upgraded VDA so that they can register with a Delivery Controller. This process tells Studio what needs upgrading in the Delivery Group.
- If you must continue to use earlier VDA versions, newer product features may not be available. For more information, see the Upgrade articles.

To upgrade a Delivery Group:

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a group and then select **Upgrade Delivery Group** in the Actions pane. The **Upgrade Delivery Group** action appears only if Studio detects upgraded VDAs.

Before starting the upgrade process, Studio tells you which, if any, machines cannot be upgraded and why. You can then cancel the upgrade, resolve the machine issues, and then start the upgrade again.

After the upgrade completes, you can revert the machines to their previous states by selecting the Delivery Group and then selecting **Undo** in the Actions pane.

Manage Remote PC Access Delivery Groups

If a machine in a Remote PC Access Machine Catalog is not assigned to a user, Studio temporarily assigns the machine to a Delivery Group associated with that Machine Catalog. This temporary assignment enables the machine to be assigned to a user later.

The Delivery Group-to-Machine Catalog association has a priority value. Priority determines which Delivery Group that machine is assigned to when it registers with the system or when a user needs a machine assignment: the lower the value, the higher the priority. If a Remote PC Access Machine Catalog has multiple Delivery Group assignments, the software selects the match with the highest priority. You can set this priority value using the PowerShell SDK.

When first created, Remote PC Access Machine Catalogs are associated with a Delivery Group. This means that machine accounts or Organizational Units added to the catalog later can be added to the Delivery Group. This association can be switched off or on.

To add or remove a Remote PC Access Machine Catalog association with a Delivery Group:

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a Remote PC Access group.
3. In the Details section, select the **Machine Catalogs** tab and then select a Remote PC Access catalog.
4. To add or restore an association, select **Add Desktops**. To remove an association, select **Remove Association**.
Manage machines in Delivery Groups

Sep 09, 2014

Introduction

You can also manage machines in a Machine Catalog; see the Manage Machine Catalogs article.

Shut down and restart machines

This procedure is not supported for Remote PC Access machines.

1. Select Delivery Groups in the Studio navigation pane.
2. Select a group and then select View Machines in the Actions pane.
3. Select the machine and then select one of the following in the Actions pane (some options may not be available, depending on the machine state):
   - **Force shut down.** Forcibly powers off the machine and refreshes the list of machines.
   - **Restart.** Requests the operating system to shut down and then start the machine again. If the operating system cannot comply, the machine remains in its current state.
   - **Force restart.** Forcibly shuts down the operating system and then restarts the machine.
   - **Suspend.** Pauses the machine without shutting it down, and refreshes the list of machines.
   - **Shut down.** Requests the operating system to shut down.

For non-force actions, if the machine does not shut down within 10 minutes, it is powered off. If Windows attempts to install updates during the shutdown, there is a risk that the machine will be powered off before the updates finish.

Citrix recommends that you prevent Desktop OS machine users from selecting Shut down within a session. See the Microsoft policy documentation for details.

Power manage machines

You can power manage only virtual Desktop OS machines, not physical ones (including Remote PC Access machines). Desktop OS machines with GPU capabilities cannot be suspended, so power off operations fail. For Server OS machines, you can create a restart schedule, which is also described in this article.

In Delivery Groups containing pooled machines, virtual Desktop OS machines can be in one of the following states:

- Randomly allocated and in use
- Unallocated and unconnected.

In Delivery Groups containing static machines, virtual Desktop OS machines can be:

- Permanently allocated and in use
- Permanently allocated and unconnected (but ready)
- Unallocated and unconnected
During normal use, static Delivery Groups typically contain both permanently allocated and unallocated machines. Initially, all machines are unallocated (except for those manually allocated when the Delivery Group was created). As users connect, machines become permanently allocated. You can fully power manage the unallocated machines in those Delivery Groups, but only partially manage the permanently allocated machines.

**Pools and buffers:** For pooled Delivery Groups and static Delivery Groups with unallocated machines, a pool (in this instance) is a set of unallocated or temporarily allocated machines that are kept in a powered-on state, ready for users to connect; a user gets a machine immediately after log on. The pool size (the number of machines kept powered-on) is configurable by time of day. For static Delivery Groups, use the SDK to configure the pool.

A buffer is an additional standby set of unallocated machines that are turned on when the number of machines in the pool falls below a threshold that is a percentage of the Delivery Group size. For large Delivery Groups, a significant number of machines might be turned on when the threshold is exceeded, so plan Delivery Group sizes carefully or use the SDK to adjust the default buffer size.

**Power state timers:** You can use power state timers to suspend machines after users have disconnected for a specified amount of time. For examples, machines will suspend automatically outside of office hours if users have been disconnected for at least ten minutes. Random machines or machines with personal vDisks automatically shut down when users log off, unless you configure the ShutdownDesktopsAfterUse Delivery Group property in the SDK.

You can configure timers for weekdays and weekends, and for peak and nonpeak intervals.

**Partial power management of permanently allocated machines:** For permanently allocated machines, you can set power state timers, but not pools or buffers. The machines are turned on at the start of each peak period, and turned off at the start of each off-peak period; you do not have the fine control that you have with unallocated machines over the number of machines that become available to compensate for machines that are consumed.

To power manage virtual Desktop OS machines:

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a group, and then select **Edit Delivery Group** in the Actions pane.
3. On the **Power Management** page, select **Weekdays** in the Power manage machines dropdown. By default, weekdays are Monday to Friday.
4. For random Delivery Groups, in **Machines to be powered on**, select **Edit** and then specify the pool size during weekdays. Then, select the number of machines to power on.
5. In **Peak hours**, set the peak and off-peak hours for each day.
6. Set the power state timers for peak and non-peak hours during weekdays: In **During peak hours > When disconnected**, specify the delay (in minutes) before suspending any disconnected machine in the Delivery Group, and select Suspend. In **During off-peak hours > When disconnected**, specify the delay before turning off any logged-off machine in the Delivery Group, and select **Shutdown**. This timer is not available for Delivery Groups with random machines.
7. Select **Weekend** in the Power manage machines dropdown, and then configure the peak hours and power state timers for weekends.
8. Click **OK** or **Apply**.

Use the SDK to:

- Shut down, rather than suspend, machines in response to power state timers, or if you want the timers to be based on logoffs, rather than disconnections.
- Change the default weekday and weekend definitions.
Create a restart schedule

A restart schedule specifies when to periodically restart all the machines in a Delivery Group.

1. Select Delivery Groups in the Studio navigation pane.
2. Select a group and then select Edit Delivery Group in the Actions pane.
3. On the Restart Schedule page, if you do not want to restart machines in the Delivery Group automatically, select the No radio button and skip to the last step in this procedure. No restart schedule or rollout strategy will be configured. If a schedule was previously configured, this selection cancels it.
4. If you do want to restart machines in the Delivery Group automatically, select the Yes radio button.
5. For Restart frequency, choose either Daily or the day of the week the restarts will occur.
6. For Begin restart at, using a 24-hour clock, specify the time of day to begin the restart.
7. For Restart duration, choose whether all machines should be started at the same time, or the total length of time to begin restarting all machines in the Delivery Group. An internal algorithm determines when each machine is restarted during that interval.
8. In the left Notification dropdown, choose whether to display a notification message on the affected machines before a restart begins. By default, no message is displayed. If you choose to display a message 15 minutes before the restart begins, you can choose (in the Repeat notification dropdown) to repeat the message every five minutes after the initial message. By default, the message is not repeated.
9. Enter the notification text in the Notification message box; there is no default text. If you want the message to include the number of minutes before restart, include the variable %m% (for example: Warning: Your computer will be automatically restarted in %m% minutes.) If you select a repeat notification interval and your message includes the %m% placeholder, the value decrements by five minutes in each repeated message. Unless you chose to restart all machines at the same time, the notification message displays on each machine in the Delivery Group at the appropriate time before the restart, calculated by the internal algorithm.
10. Click OK or Apply.

You cannot perform an automated power-on or shutdown from Studio, only a restart.

Prevent users from connecting to a machine (maintenance mode)

When you need to temporarily stop new connections to machines, you can turn on maintenance mode for one or all machines in a Delivery Group. You might do this before applying patches or using management tools.

- When a Server OS machine is in maintenance mode, users can connect to existing sessions, but cannot start new sessions.
- When a Desktop OS machine (or a PC using Remote PC Access) is in maintenance mode, users cannot connect or reconnect. Current connections remain connected until they disconnect or log off.

To turn maintenance mode on or off:

1. Select Delivery Groups in the Studio navigation pane.
2. Select a group.
3. To turn on maintenance mode for all machines in the Delivery Group, select Turn On Maintenance Mode in the Actions pane. To turn on maintenance mode for one machine, select View Machines in the Actions pane. Select a machine, and then select Turn On Maintenance Mode in the Actions pane.
4. To turn maintenance mode off for one or all machines in a Delivery Group, follow the previous instructions, but select Turn Off Maintenance Mode in the Actions pane.

Windows Remote Desktop Connection (RDC) settings also affect whether a Server OS machine is in maintenance mode. Maintenance mode is on when any of the following occur:

- Maintenance mode is set to on, as described above.
- RDC is set to Don't allow connections to this computer.
- RDC is not set to Don't allow connections to this computer, and the Remote Host Configuration User Logon Mode setting is either Allow reconnections, but prevent new logons or Allow reconnections, but prevent new logons until the server is restarted.

You can also turn maintenance mode on or off for a connection (which affects the machines that use that connection), or for a Machine Catalog (which affects the machines in that catalog).

Change assignments of machines to users

You can change the assignments of Desktop OS machines, not Server OS machines or machines created through Provisioning Services.

1. Select Delivery Groups in the Studio navigation pane.
2. Select a group.
3. To reallocate more than one machine, select Edit Delivery Group in the Actions pane. On the Machine Allocation (User Assignment) page, select machines and specify the new users. Then lick OK or Apply.
4. To reallocate one machine, select View Machines in the Actions pane. Select a machine, and then select Change User in the Actions pane. Add or remove the user.

Change the maximum number of machines per user

1. Select Delivery Groups in the Studio navigation pane.
2. Select a group and then select Edit Delivery Group in the Actions pane.
3. On the User Settings (or Basic Settings) page, set the desktops per user value.
4. Click OK or Apply.

Load manage

You can load manage Server OS machines only.

Load Management measures the server load and determines which server to select under the current environment conditions. This selection is based on:

Server maintenance mode status: A Server OS machine is considered for load balancing only when maintenance mode is
Server load index: Determines how likely a server delivering Server OS machines is to receive connections. The index is a combination of load evaluators: the number of sessions and the settings for performance metrics such as CPU, disk, and memory use. You specify the load evaluators in load management policy settings.

You can monitor the load index in Director, Studio search, and the SDK.

In Studio, the Server Load Index column is hidden by default. To display it, select a machine, right-select a column heading and then choose Select Column. In the Machine category, select Load Index.

In the SDK, use the Get-BrokerMachine cmdlet. For details, see CTX202150.

A server load index of 10000 indicates that the server is fully loaded. If no other servers are available, users might receive a message that the desktop or application is currently unavailable when they launch a session.

Concurrent logon tolerance policy setting: The maximum number of concurrent requests to log on to the server. (This setting is equivalent to load throttling in XenApp versions earlier than 7.5.)

If all servers are at or higher than the concurrent logon tolerance setting, the next logon request is assigned to the server with the lowest pending logons. If more than one server meets these criteria, the server with the lowest load index is selected.

Remove a machine from a Delivery Group

Removing a machine deletes it from a Delivery Group but does not delete it from the Machine Catalog that the Delivery Group uses. Therefore, that machine is available for assignment to another Delivery Group.

Machines must be shut down before they can be removed. To temporarily stop users from connecting to a machine while you are removing it, put the machine into maintenance mode before shutting it down.

Keep in mind that machines may contain personal data, so use caution before allocating the machine to another user. You may want to reimage the machine.

1. Select Delivery Groups in the Studio navigation pane.
2. Select a group and the select View Machines in the Actions pane.
3. Make sure that the machine is shut down.
4. Select Remove from Delivery Group in the Actions pane.

Restrict access to machines

Any changes you make to restrict access to machines in a Delivery Group supersede previous settings, regardless of the method you use. You can:

Restrict access for administrators using Delegated Administration scopes. You can create and assign a scope that permits administrators to access all applications, and another scope that provides access to only certain applications. See the Delegated Administration article for details.

Restrict access for users through SmartAccess policy expressions that filter user connections made through
NetScaler Gateway.

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select group and then select **Edit Delivery Group** in the Actions pane.
3. On the Access Policy page, select **Connections through NetScaler Gateway**.
4. To choose a subset of those connections, select **Connections meeting any of the following filters**. Then define the NetScaler Gateway site, and add, edit, or remove the SmartAccess policy expressions for the allowed user access scenarios. For details, see the NetScaler Gateway documentation.
5. Click **OK** or **Apply**.

**Restrict access for users through exclusion filters** on access policies that you set in the SDK. Access policies are applied to Delivery Groups to refine connections. For example, you can restrict machine access to a subset of users, and you can specify allowed user devices. Exclusion filters further refine access policies. For example, for security you can deny access to a subset of users or devices. By default, exclusion filters are disabled.

For example, for a teaching lab on a subnet in the corporate network, to prevent access from that lab to a particular Delivery Group, regardless of who is using the machines in the lab, use the following command: `Set-BrokerAccessPolicy -Name VPDesktops_Direct -ExcludedClientIPFilterEnabled $True`

You can use the asterisk (*) wildcard to match all tags that start with the same policy expression. For example, if you add the tag VPDesktops_Direct to one machine and VPDesktops_Test to another, setting the tag in the Set-BrokerAccessPolicy script to VPDesktops_* applies the filter to both machines.

**Update a machine**

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a group and then select **View Machines** in the Action pane.
3. Select a machine and then select **Update Machines** in the Actions pane.

   To choose a different master image, select **Master image**, and then select a snapshot.

   To apply changes and notify machine users, select **Rollout notification to end-users**. Then specify: when to update the master image: now or on the next restart, the restart distribution time (the total time to begin updating all machines in the group), and whether users will be notified of the restart, plus the message they will receive.
Add applications to Delivery Groups

Good to know:

- You cannot add applications to Remote PC Access Delivery Groups.
- An application must belong to at least one Delivery Group.
- You can change an application's properties when you add it to a Delivery Group, or later.
- By default, new applications you add are placed in a folder named Applications. You can specify a different folder.
- If you try to add an application and one with the same name already exists in that folder, you are prompted to rename the application you're adding. If you decline, the application is added with a suffix that makes it unique within that application folder.
- You cannot remove applications from one or more Delivery Groups using the Add Application wizard. That is a separate operation.
- When you add an application to more than one Delivery Group, a visibility issue can occur if you do not have sufficient permission to view the application in all of those Delivery Groups. In such cases, either consult an administrator with greater permissions or have your scope extended to include all the Delivery Groups to which the application was added.
- If you publish two applications with the same name to the same users, change the Application name (for user) property in Studio; otherwise, users will see duplicate names in Receiver.
- Alternatives: The following procedure allows you to add applications to one or more Delivery Groups. You can also add applications to a Delivery Group when you create the group (or later, by selecting the group and then selecting Add Applications in the Actions pane), but the applications are added to only that group.

To add one or more applications:

Step 1: Select Applications in the Studio navigation pane, and then select Add Applications in the Actions pane. The Add Applications wizard opens.

Step 2: Select one or more Delivery Groups where the applications will be available.

Step 3: On the Applications page, click the Add dropdown to display the application sources, and then select the source you want.

- From Start menu: Applications that are discovered on a machine created from the master image in a Machine Catalog used in the selected Delivery Group.
- Manually defined: Applications for which you provide the path to the executable, working directory, optional command
line arguments, and display names for administrators and users.

- **Existing**: Applications previously added to the Site, perhaps in another Delivery Group. (This source is not available if there are no other Delivery Groups or if all applications have been removed.)
- **App-V**: Applications in App-V packages.

If an application source is not available or valid, it is either not selectable or a message is displayed. For example, if no applications have been previously added to any Delivery Groups, the **Existing** source cannot be selected. Similarly, if an application is not compatible with supported session types on the machines in the selected Delivery Groups, it is either not selectable or a message is displayed.

**Step 4**: The applications found on the selected source are listed. Select or specify the applications you want to add, and then click **OK**.

**Step 5**: On the **Summary** page, verify the information and then click **Finish**.

### Duplicate, enable/disable, rename, or delete an application

You might want to duplicate an application to create a different version with different parameters or properties. When you duplicate an application, it is automatically renamed with a unique suffix and placed adjacent to the original.

**Good to know**:

- If you previously duplicated an application in one Delivery Group so that you could add it to another Delivery Group, you can either use the Add Application wizard to add an application to more than one Delivery Group, or change Delivery Group membership through the application's properties.
- Deleting an application removes it from the Delivery Group but not from the master image used in the Machine Catalog (if that was its source). Deleting an application is a different action than removing an application from a Delivery Group; see below.
- Enabling and disabling an application is a different action than enabling and disabling the Delivery Group; see the Edit a Delivery Group article.

To duplicate, enable, disable, or delete an application:

1. Select **Applications** in the Studio navigation pane.
2. Select an application and then select the appropriate task in the Actions pane.

### Remove an application from a Delivery Group

An application must be associated (belong) with at least one Delivery Group. If you attempt to remove an application from a Delivery Group that would remove that application's association with any Delivery Group, you are given the option to delete the application instead. In that case, if you choose not to delete the application, you can add it to a different Delivery Group, and then remove it from the original Delivery Group.

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a Delivery Group. In the lower middle pane, select the **Applications** tab and then the application you want to remove.
3. Select **Remove Application** from the Actions pane.

## Change application properties

To change the properties of an application:

1. Select **Applications** in the Studio navigation pane.
2. Select an application and then select **Edit Application Properties** in the Actions pane.
3. Select the page containing the property you want to change. When you complete the change, click **OK** or **Apply** on the page. *(OK applies the change and closes the Edit Application Properties dialog box; Apply applies the change and leaves the dialog box open.)*

<table>
<thead>
<tr>
<th>Property</th>
<th>Select this page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category/folder in Receiver</td>
<td>Delivery</td>
</tr>
<tr>
<td>Command line arguments</td>
<td>Location</td>
</tr>
<tr>
<td>Delivery Group association</td>
<td>Groups</td>
</tr>
<tr>
<td>Description</td>
<td>Identification</td>
</tr>
<tr>
<td>File extensions</td>
<td>File Type Association</td>
</tr>
<tr>
<td>File type association</td>
<td>File Type Association</td>
</tr>
<tr>
<td>Icon</td>
<td>Delivery</td>
</tr>
<tr>
<td>Keywords for StoreFront</td>
<td>Identification</td>
</tr>
<tr>
<td>Limits (see below)</td>
<td>Delivery</td>
</tr>
<tr>
<td>Name</td>
<td>Identification</td>
</tr>
<tr>
<td>Path to executable</td>
<td>Location</td>
</tr>
<tr>
<td>Shortcut on user's desktop</td>
<td>Delivery</td>
</tr>
<tr>
<td>Visibility</td>
<td>Limit Visibility</td>
</tr>
</tbody>
</table>

---

https://docs.citrix.com  © 1999-2017 Citrix Systems, Inc. All rights reserved.  p.193
Application changes may not take effect for current application users until they log off their sessions.

Configure application limits

Configure application limits to help manage application use. For example, you can use application limits to manage the number of users accessing an application simultaneously. Similarly, application limits can be used to manage the number of simultaneous instances of resource-intensive applications, this can help maintain server performance and prevent deterioration in service.

**Important:** This feature limits the number of application launches that are brokered by the Controller (for example, from Citrix Receiver and StoreFront), and not the number of running applications that could be launched by other methods. This means that application limits assist administrators when managing concurrent usage, but do not provide enforcement in all scenarios. For example, application limits cannot be applied when the Controller is in leased connection mode.

By default, there is no limit on how many application instances can run at the same time. There are two application limit settings; you can configure either or both:

- The maximum number of concurrent instances of an application by all users in the Delivery Group.
- One instance of the application per user in the Delivery Group

If a limit is configured, an error message is generated when a user attempts to launch an instance of the application that will exceed the configured limit.

Examples using application limits:

- **Maximum number of simultaneous instances limit.** In a Delivery Group, you configure the maximum number of simultaneous instances of application Alpha to 15. Later, users in that Delivery Group have 15 instances of that application running at the same time. If any user in that Delivery Group now attempts to launch Alpha, an error message is generated, and Alpha is not launched because it would exceed the configured simultaneous application instance limit (15).

- **One-instance-per-user application limit.** In another Delivery Group, you enable the one-instance-per-user option for application Beta. User Tony launches application Beta successfully. Later in the day, while that application is still running in Tony’s session, he attempts to launch another instance of Beta. An error message is generated and Beta is not launched because it would exceed the one-instance-per-user limit.

- **Maximum number of simultaneous instances and one-instance-per-user limits.** In another Delivery Group, you configure a maximum number of simultaneous instances of 10 and enable the one-instance-per-user option for application Delta. Later, when ten users in that Delivery Group each have an instance of Delta running, any other user in that Delivery Group who tries to launch Delta will receive an error message, and Delta will not be launched. If any of the ten current Delta users attempt to launch a second instance of that application, they will receive an error message and second instance will not be launched.

If application instances are also launched by methods other than Controller brokering (for example, while a Controller is in leased connection mode) and configured limits are exceeded, users will not be able to launch additional instances until they
close sufficient instances to no longer exceed the limits. The instances that exceeded the limit will not be forcibly shut down; they will be allowed to continue until their users close them.

If you disable session roaming, then disable the one-instance-per-user application limit. If you enable the one-instance-per-user application limit, do not configure either of the two values that allow new sessions on new devices. For information about roaming, see the Sessions article.

To configure application limits:

1. Select Applications in the Studio navigation pane and then select an application.
2. Select the Edit Application Properties in the Actions pane.
3. On the Delivery page, choose one of the options listed below. When you are finished, click OK or Apply. (OK applies the change and closes the Edit Application Properties dialog box; Apply applies the change and leaves the dialog box open.)

- Allow unlimited use of the application. There is no limit to the number of instances running at the same time. This is the default.
- Set limits for the application. There are two limit types; specify either or both.
  - Specify the maximum number of instances that can run concurrently
  - Limit to one instance of the application per user

Manage application folders

By default, new applications you add to Delivery Groups are placed in a folder named Applications. You can specify a different folder when you create the Delivery Group, when you add an application, or later.

Good to know:

- You cannot rename or delete the Applications folder, but you can move all the applications it contains to other folders you create.
- A folder name can contain 1-64 characters. Spaces are permitted.
- Folders can be nested up to five levels.
- Folders do not have to contain applications; empty folders are allowed.
- Folders are listed alphabetically in Studio unless you move them or specify a different location when you create them.
- You can have more than one folder with the same name, as long as each has a different parent folder. Similarly, you can have more than one application with the same name, as long as each is in a different folder.
- You must have View Applications permission to see the applications in folders, and you must have Edit Application Properties permission for all applications in the folder to remove, rename, or delete a folder that contains applications.
- Most of the following procedures request actions using the Actions pane in Studio. Alternatively, you can use right-click menus or drag and drop. For example, if you create or move a folder in a location you did not intend, you can drag/drop it to the correct location.

To manage application folders, select Applications in the Studio navigation pane. Use the following list for guidance.

- To view all folders (excluding nested folders), click Show all above the folder list.
- To create a folder at the highest level (not nested), select the Applications folder. To place the new folder under an existing folder other than Applications, select that folder. Then, select Create Folder in the Actions pane. Enter a name.
- To move a folder, select the folder and then select Move Folder in the Actions pane. You can move only one folder at a time unless the folder contains nested folders. Tip: The easiest way to move a folder is to use drag and drop.
To rename a folder, select the folder, and then select **Rename Folder** in the Actions pane. Enter a name.

To delete a folder, select the folder, and then select **Delete Folder** in the Actions pane. When you delete a folder that contains applications and other folders, those objects are also deleted. Deleting an application removes the application assignment from the Delivery Group; it does not remove it from the machine.

To move applications into a folder, select one or more applications. Then, select **Move Application** in the Actions pane. Select the folder. (To move applications to a different folder from within the Create Delivery Group wizard, select **Change** on the **Applications** page in the wizard, and then select or create a folder.)
Manage sessions through Delivery Groups

May 11, 2015

In addition to the procedures below, see the Session management article for information about session reliability, session roaming, auto client reconnect, ICA keep-alive, and workspace control.

Log off or disconnect a session, or send a message to users

1. Select Delivery Groups in the Studio navigation pane.
2. Select a group and then select View Machines in the Actions pane.
3. To log a user off a session, select the session or desktop and select Log off in the Actions pane. The session closes and the machine becomes available to other users, unless it is allocated to a specific user.
4. To disconnect a session, select the session or desktop, and select Disconnect in the Actions pane. Applications continue to run and the machine remains allocated to that user. The user can reconnect to the same machine.
5. To send a message to users, select the session, machine, or user, and then select Send message in the Actions pane. Enter the message.

You can configure power state timers for Desktop OS machines to automatically handle unused sessions. See the Power manage machines section in the Manage machines in a Delivery Group article for details.

Configure session prelaunch and session linger

These features are supported on Server OS machines only.

The session prelaunch and session linger features help specified users access applications quickly, by starting sessions before they are requested (session prelaunch) and keeping application sessions active after a user closes all applications (session linger).

By default, session prelaunch and session linger are not used: a session starts (launches) when a user starts an application, and remains active until the last open application in the session closes.

Considerations:

- The Delivery Group must support applications, and the machines must be running a VDA for Windows Server OS, minimum version 7.6.
- These features are supported only when using Citrix Receiver for Windows, and also require additional Citrix Receiver configuration. For instructions, search for session prelaunch in the product documentation for your Citrix Receiver for Windows version.
- Note that Citrix Receiver for HTML5 is not supported.
- When using session prelaunch, if a user's machine is put into "suspend" or "hibernate" mode, prelaunch will not work (regardless of session prelaunch settings). Users can lock their machines/sessions, but if a user logs off from Citrix Receiver, the session is ended and prelaunch no longer applies.
- When using session prelaunch, physical client machines cannot use the suspend or hibernate power management
functions. Client machine users can lock their sessions but should not log off.

- Prelaunched and lingering sessions consume a license, but only when connected. Unused prelaunched and lingering sessions disconnect after 15 minutes by default. This value can be configured in PowerShell (New/Set-BrokerSessionPreLaunch cmdlet).
- Careful planning and monitoring of your users’ activity patterns are essential to tailoring these features to complement each other. Optimal configuration balances the benefits of earlier application availability for users against the cost of keeping licenses in use and resources allocated.
- You can also configure session prelaunch for a scheduled time of day in Citrix Receiver.

How long unused prelaunched and lingering sessions remain active

There are several ways to specify how long an unused session remains active if the user does not start an application: a configured timeout and server load thresholds. You can configure all of them; the event that occurs first will cause the unused session to end.

- **Timeout:** A configured timeout specifies the number of minutes, hours, or days an unused prelaunched or lingering session remains active. If you configure too short a timeout, prelaunched sessions will end before they provide the user benefit of quicker application access. If you configure too long a timeout, incoming user connections might be denied because the server doesn’t have enough resources.

  You cannot disable this timeout from Studio, but you can in the SDK (New/Set-BrokerSessionPreLaunch cmdlet). If you disable the timeout, it will not appear in the Studio display for that Delivery Group or in the Edit Delivery Group wizard.

- **Thresholds:** Automatically ending prelaunched and lingering sessions based on server load ensures that sessions remain open as long as possible, assuming server resources are available. Unused prelaunched and lingering sessions will not cause denied connections because they will be ended automatically when resources are needed for new user sessions.

  You can configure two thresholds: the average percentage load of all servers in the Delivery Group, and the maximum percentage load of a single server in the Delivery Group. When a threshold is exceeded, the sessions that have been in the prelaunch or lingering state for the longest time are ended, sessions are ended one-by-one at minute intervals until the load falls below the threshold. (While the threshold is exceeded, no new prelaunch sessions are started.)

Servers with VDAs that have not registered with the Controller and servers in maintenance mode are considered fully loaded. An unplanned outage will cause prelaunch and lingering sessions to be ended automatically to free capacity.

To enable session prelaunch

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a Delivery Group, and then click **Edit Delivery Group** in the Actions pane.
3. On the **Application Prelaunch** page, enable session prelaunch by choosing when sessions should launch:
   - When a user starts an application. This is the default setting; session prelaunch is disabled.
   - When any user in the Delivery Group logs on to Citrix Receiver for Windows.
   - When anyone in a list of users and user groups logs on to Citrix Receiver for Windows. Be sure to also specify users or user groups if you choose this option.
A prelaunched session is replaced with a regular session when the user starts an application. If the user does not start an application (the prelaunched session is unused), the following settings affect how long that session remains active.

- When a specified time interval elapses. You can change the time interval (1-99 days, 1-2376 hours, or 1-142,560 minutes).
- When the average load on all machines in the Delivery Group exceeds a specified percentage (1-99%).
- When the load on any machine in the Delivery Group exceeds a specified percentage (1-99%).

Recap: A prelaunched session remains active until one of the following events occurs: a user starts an application, the specified time elapses, or a specified load threshold is exceeded.

To enable session linger:

1. Select Delivery Groups in the Studio navigation pane.
2. Select a Delivery Group, and then click Edit Delivery Group in the Actions pane.
3. On the Application Lingerering page, enable session linger by selecting the Keep sessions active until radio button.
4. Several settings affect how long a lingering session remains active if the user does not start another application. 
   - When a specified time interval elapses. You can change the time interval (1-99 days, 1-2376 hours, or 1-142,560 minutes).
   - When the average load on all machines in the Delivery Group exceeds a specified percentage (1-99%).
   - When the load on any machine in the Delivery Group exceeds a specified percentage (1-99%).

Recap: A lingering session remains active until one of the following events occurs: a user starts an application, the specified time elapses, or a specified load threshold is exceeded.
Remote PC Access

May 25, 2016

Remote PC Access allows an end user to log on remotely from virtually anywhere to the physical Windows PC in the office. The Virtual Delivery Agent (VDA) is installed on the office PC; it registers with the Delivery Controller and manages the HDX connection between the PC and the end user client devices. Remote PC Access supports a self-service model after you set up the whitelist of machines that users are permitted to access, those users can join their office PCs to a Site themselves, without administrator intervention. The Citrix Receiver running on their client device enables access to the applications and data on the office PC from the Remote PC Access desktop session.

A user can have multiple desktops, including more than one physical PC or a combination of physical PCs and virtual desktops.

**Note:** Sleep mode & Hibernation mode for Remote PC Access is not supported. Remote PC Access is valid only for XenDesktop licenses; sessions consume licenses in the same way as other XenDesktop sessions.

Active Directory considerations

Before configuring the Remote PC Access deployment Site, set up your Organizational Units (OUs) and security groups and then create user accounts. Use these accounts to specify users for the Delivery Groups you will use to provide Remote PC Access.

If you modify Active Directory after a machine has been added to a Machine Catalog, Remote PC Access does not reevaluate that assignment. You can manually reassign a machine to a different catalog, if needed.

If you move or delete OUs, those used for Remote PC Access can become out of date. VDAs might no longer be associated with the most appropriate (or any) Machine Catalog or Delivery Group.

Machine Catalog and Delivery Group considerations

A machine can be assigned to only one Machine Catalog and one Delivery Group at a time.

You can put machines in one or more Remote PC Access Machine Catalogs.

When choosing machine accounts for a Machine Catalog, select the lowest applicable OU to avoid potential conflicts with machines in another catalog. For example, in the case of bank/officers/tellers, select tellers.

You can allocate all machines from one Remote PC Access Machine Catalog through one or more Delivery Groups. For example, if one group of users requires certain policy settings and another group requires different settings, assigning the users to different Delivery Groups enables you to filter the HDX policies according to each Delivery Group.

If your IT infrastructure assigns responsibility for servicing users based on geographic location, department, or some other category, you can group machines and users accordingly to allow for delegated administration. Ensure that each administrator has permissions for both the relevant Machine Catalogs and the corresponding Delivery Groups.

For users with office PCs running Windows XP, create a separate Machine Catalog and Delivery Group for those systems.
When choosing machine accounts for that catalog in Studio, select the checkbox indicating that some machines are running Windows XP.

Deployment considerations

You can create a Remote PC Access deployment and then add traditional Virtual Desktop Infrastructure (VDI) desktops or applications later. You can also add Remote PC Access desktops to an existing VDI deployment.

Consider whether to enable the Windows Remote Assistance checkbox when you install the VDA on the office PC. This option allows help desk teams using Director to view and interact with a user sessions using Windows Remote Assistance.

Consider how you will deploy the VDA to each office PC. Citrix recommends using electronic software distribution such as Active Directory scripts and Microsoft System Center Configuration Manager. The installation media contains sample Active Directory scripts.

Review the security considerations for Remote PC Access deployments.

Secure Boot functionality is currently unsupported. Disable Secure Boot if intending to deploy the workstation VDA.

Each office PC must be domain-joined with a wired network connection.

Windows 7 Aero is supported on the office PC, but not required.

Connect the keyboard and mouse directly to the PC or laptop, not to the monitor or other components that can be turned off. If you must connect input devices to components such as monitors, they should not be turned off.

If you are using smart cards, see Smart cards.

Remote PC Access can be used on most laptop computers. To improve accessibility and deliver the best connection experience, configure the laptop power saving options to those of a desktop PC. For example:

- Disable the hibernate feature.
- Disable the sleep feature.
- Set the close lid action to Do Nothing.
- Set the press the power button action to Shut Down.
- Disable video card energy saving features.
- Disable network interface card energy saving features.
- Disable battery saving technologies.

The following are not supported for Remote PC Access devices:

- Docking and undocking the laptop.
- KVM switches or other components that can disconnect a session.
- Hybrid PCs, including All-in-One and NVIDIA Optimus laptops and PCs.

The following XenDesktop features are not supported for Remote PC Access deployments:

- Creating master images and virtual machines
- Delivering hosted applications
- Personal vDisks
Client folder redirection

Install Citrix Receiver on each client device that remotely accesses the office PC.

Multiple users with remote access to the same office PC see the same icon in Citrix Receiver. When any user remotely logs on to the PC, that resource appears as unavailable to other users.

By default, a remote user's session is automatically disconnected when a local user initiates a session on that machine (by pressing CTRL+ALT+DEL). To prevent this automatic action, add the following registry entry on the office PC, and then restart the machine.

**Caution:** Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

```
HKLM\SOFTWARE\Citrix\PortICA\RemotePC "SasNotification"=dword:00000001
```

To further customize the behavior of this feature under
```
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\PortICA\RemotePC
```

**RpcaMode (dword):**

1 = The remote user will always win if he does not respond to the messaging UI in the specified timeout period.

2 = The local user will always win. If this setting is not specified, the remote user will always win by default.

**RpcaTimeout (dword):**

The number of seconds given to the user before the type of mode to enforce is determined. If this setting is not specified, the default value is 30 seconds. The minimum value here should be 30 seconds. The user must restart the machine for these changes to take place.

When user wants to forcibly get the console access: The local user can press Ctr+Alt+Del twice in a gap of 10 seconds to get local control over a remote session and force a disconnect event.

After the registry change and machine restart, if a local user presses CTRL+ALT+DEL to log on to that PC while it is in use by a remote user, the remote user receives a prompt asking whether or not to allow or deny the local user's connection. Allowing the connection will disconnect the remote user's session.

Wake on LAN

Remote PC Access supports Wake on LAN, which gives users the ability to turn on physical PCs remotely. This feature enables users to keep their office PCs turned off when not in use, saving energy costs. It also enables remote access when a machine has been turned off inadvertently, such as during weather events.

The Remote PC Access Wake on LAN feature is supported on both of the following:

- PCs that support Intel Active Management Technology (AMT)
- PCs that have the Wake on LAN option enabled in the BIOS

You must configure Microsoft System Center Configuration Manager (ConfigMgr) 2012 to use the Wake on LAN feature.
ConfigMgr provides access to invoke AMT power commands for the PC, plus Wake-up proxy and magic-packet support. Then, when you use Studio to create a Remote PC Access deployment (or when you add another power management connection to be used for Remote PC Access), you enable power management and specify ConfigMgr access information.

Additionally:

- Using AMT power operations is preferred for security and reliability; however, support is also provided for two non-AMT methods: ConfigMgr Wake-up proxy and raw magic packets.
- On AMT-capable machines only, the Wake on LAN feature also supports the Force-Shutdown and Force-Restart actions in Studio and Director. Additionally, a Restart action is available in StoreFront and Receiver.

For more information, see Configuration Manager and Remote PC Access Wake on LAN.

For information about an experimental Wake on LAN SDK that enables you or a third party Wake on LAN solution to create a connector without the requirement of System Center 2012 R2, see CTX202272.

Configuration sequence and considerations

Before you create the Remote PC Access Site:

If you will use the Remote PC Access power management feature (also known as Remote PC Access Wake on LAN), complete the configuration tasks on the PCs and on Microsoft System Center Configuration Manager (ConfigMgr) before creating the Remote PC Access deployment in Studio. See Configuration Manager and Remote PC Access Wake on LAN for details.

In the Site creation wizard:

- Select the Remote PC Access Site type.
- On the Power Management page, you can enable or disable power management for the machines in the default Remote PC Access Machine Catalog. If you enable power management, specify ConfigMgr connection information.
- On the Users and Machine Accounts pages, specify users and machine accounts.

Creating a Remote PC Access Site creates a default Machine Catalog named Remote PC Access Machines and a default Delivery Group named Remote PC Access Desktops.

If you create another Machine Catalog for use with Remote PC Access:

- On the Operating System page, select Remote PC Access and choose a power management connection. You can also choose not to use power management. If there are no configured power management connections, you can add one after you finish the Machine Catalog creation wizard (connection type = Microsoft Configuration Manager Wake on LAN), and then edit the Machine Catalog, specifying that new connection.
- On the Machine Accounts page, you can select from the machine accounts or Organizational Units (OUs) displayed, or add machine accounts and OUs.

Install the VDA on the office PCs used for local and remote access. Typically, you deploy the VDA automatically using your package management software; however, for proof-of-concept or small deployments, you can install the VDA manually on each office PC.

When installing the VDA from the command line, include the /remotecp option. This prevents the installation of the following components on a desktop (workstation) OS:
During an upgrade, if any of the above components are installed, the installer detects and upgrades them.

After the VDA is installed, the next domain user that logs on to a console session (locally or through RDP) on the office PC is automatically assigned to the Remote PC Access desktop. If additional domain users log on to a console session, they are also added to the desktop user list, subject to any restrictions you have configured.

To use RDP connections outside of your XenApp or XenDesktop environment, you must add users or groups to the Direct Access Users group.

Instruct users to download and install Citrix Receiver onto each client device they will use to access the office PC remotely. Citrix Receiver is available from http://www.citrix.com or the application distribution systems for supported mobile devices.

Configure advanced connection settings

You can edit a power management connection to configure advanced settings. You can enable:

- Wake-up proxy delivered by ConfigMgr.
- Wake on LAN (magic) packets. If you enable Wake on LAN packets, you can select a Wake on LAN transmission method: subnet-directed broadcasts or Unicast.

The PC uses AMT power commands (if they are supported), plus any of the enabled advanced settings. If the PC does not use AMT power commands, it uses the advanced settings.

Troubleshooting

The Delivery Controller writes the following diagnostic information about Remote PC Access to the Windows Application Event log. Informational messages are not throttled. Error messages are throttled by discarding duplicate messages.

- 3300 (informational) - Machine added to catalog
- 3301 (informational) - Machine added to delivery group
- 3302 (informational) - Machine assigned to user
- 3303 (error) - Exception

When power management for Remote PC Access is enabled, subnet-directed broadcasts might fail to start machines that are located on a different subnet from the Controller. If you need power management across subnets using subnet-directed broadcasts, and AMT support is not available, try the Wake-up proxy or Unicast method (ensure those settings are enabled in the advanced properties for the power management connection).
Using App-V with XenApp and XenDesktop

Microsoft Application Virtualization (App-V) lets you deploy, update, and support applications as services. Users access applications without installing them on their own devices. App-V and Microsoft User State Virtualization (USV) provide access to applications and data, regardless of location and connection to the Internet.

The following table lists supported versions.

<table>
<thead>
<tr>
<th>App-V</th>
<th>XenDesktop and XenApp versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery Controller</td>
<td>VDA</td>
</tr>
<tr>
<td>5.0 and 5.0 SP1</td>
<td>XenDesktop 7 through current</td>
</tr>
<tr>
<td></td>
<td>XenApp 7.5 through current</td>
</tr>
<tr>
<td>5.0 SP2</td>
<td>XenDesktop 7 through current</td>
</tr>
<tr>
<td></td>
<td>XenApp 7.5 through current</td>
</tr>
<tr>
<td>5.0 SP3 and 5.1</td>
<td>XenDesktop 7.6 through current</td>
</tr>
<tr>
<td></td>
<td>XenApp 7.6 through current</td>
</tr>
</tbody>
</table>

The App-V client does not support offline access to applications. App-V integration support includes using SMB shares for applications; the HTTP protocol is not supported.
If you're not familiar with App-V, see the Microsoft documentation. Here's a recap of the App-V components mentioned in this article:

- **Management server.** Provides a centralized console to manage App-V infrastructure and delivers virtual applications to both the App-V Desktop Client as well as a Remote Desktop Services Client. The App-V management server authenticates, requests, and provides the security, metering, monitoring, and data gathering required by the administrator. The server uses Active Directory and supporting tools to manage users and applications.

- **Publishing server.** Provides App-V clients with applications for specific users, and hosts the virtual application package for streaming. It fetches the packages from the management server.

- **Client.** Retrieves virtual applications, publishes the applications on the client, and automatically sets up and manages virtual environments at runtime on Windows devices. You install the App-V client on the VDA, where it stores user-specific virtual application settings such as registry and file changes in each user's profile.

Applications are available seamlessly without any pre-configuration or changes to operating system settings. You can launch App-V applications from Server OS and Desktop OS Delivery Groups:

- Through Citrix Receiver
- From the Start menu
- Through the App-V client and Citrix Receiver
- Simultaneously by multiple users on multiple devices
- Through Citrix StoreFront

Modified App-V application properties are implemented when the application is started. For example, for applications with a modified display name or customized icon, the modification appears when users start the application.

Management methods

You can use App-V packages created with the App-V sequencer and then located on either App-V servers or network shares.

- **App-V servers:** Using applications from packages on App-V servers requires ongoing communication between Studio and the App-V servers for discovery, configuration, and downloading to the VDAs. This incurs hardware, infrastructure, and administration overhead. Studio and the App-V servers must remain synchronized, particularly for user permissions.

  This is called the *dual admin* management method because App-V package and application access requires both Studio and the App-V server consoles. This method works best in closely coupled App-V and Citrix deployments.

- **Network share:** Packages placed on a network share removes Studio's dependence on the App-V server and database infrastructure, thereby lowering overhead. (You still need to install the Microsoft App-V client on each VDA.)

  This is called the *single admin* management method because App-V package and application use requires only the Studio console. You browse to the network share and add one or more App-V packages from that location to the Site-level Application Library.

  Application Library is a Citrix term for a caching repository that stores information about App-V packages. The Application Library also stores information about other Citrix application delivery technologies.

You can use one or both management methods simultaneously. In other words, when you add applications to Delivery Groups, the applications can come from App-V packages located on App-V servers and/or on a network share.

When you select **Configuration > App-V Publishing** in the Studio navigation pane, the display shows App-V package
names and sources. The source column indicates whether the packages are located on the App-V server or cached in the Application Library. When you select a package, the details pane lists the applications in the package.

Setup

The following table summarizes the sequence of setup tasks for using App-V in XenApp and XenDesktop.

<table>
<thead>
<tr>
<th>Management method</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single admin</td>
<td>Dual admin</td>
</tr>
<tr>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Deploy App-V</td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Packaging and placement</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configure App-V server addresses in Studio</td>
</tr>
<tr>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Install software on VDA machines</td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Add App-V packages to the Application Library</td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Add App-V applications to Delivery Groups</td>
<td></td>
</tr>
</tbody>
</table>

Deploy Microsoft App-V


Optionally, change App-V publishing server settings. Citrix recommends using the SDK cmdlets on the Controller; see the SDK documentation for details.

- To view publishing server settings, enter `Get-CtxAppvServerSetting -AppVPublishingServer <pubServer>`.
- To ensure that App-V applications launch properly, enter `Set-CtxAppvServerSetting -UserRefreshonLogon 0`.

If you previously used GPO policy settings to manage publishing server settings, the GPO settings override any App-V integration settings, including cmdlet settings. This can result in App-V application launch failure. Citrix recommends that you remove all GPO policy settings and then use the SDK to configure those settings.

Packaging and placement

For either management method, create application packages using the App-V sequencer. See the Microsoft documentation for details.

- For single admin management, make the packages available on a UNC or SMB shared network location. Make sure that the Studio administrator who adds applications to Delivery Groups has at least read access to that location.
For dual admin management, publish the packages on the App-V management server.

Regardless of whether packages are on the App-V server or on a network share, make sure the packages have appropriate security permissions to allow the Studio administrator to access them.

Configure App-V server addresses in Studio

This procedure is valid only for the dual admin management method.

Specify App-V management and publishing server addresses for the dual admin management method either during or after Site creation. You can do this during or after creating the Site.

During Site creation:

- On the App-V page of the wizard, enter the URL of the Microsoft App-V management server, and the URL and port number of the App-V publishing server. Test the connection before continuing with the wizard. If the test fails, see the Troubleshoot section below.

After Site creation:

2. If you have not previously specified App-V server addresses, select Add Microsoft Server in the Actions pane.
3. To change App-V server addresses, select Edit Microsoft Server in the Actions pane.
4. Enter the URL of the Microsoft App-V management server, and the URL and port number of the App-V publishing server.
5. Test the connection to those servers before closing the dialog box. If the test fails, see the Troubleshoot section below.

Later, if you want to remove all links to the App-V management and publishing servers and stop Studio from discovering App-V packages from those servers, select Remove Microsoft Server in the Actions pane. This action is allowed only if no applications in packages on those servers are currently published in any Delivery Groups. If they are, you must remove those applications from the Delivery Groups before you can remove the App-V servers.

Install software on VDA machines

Machines containing VDAs must have two sets of software installed to support App-V: one from Microsoft and the other from Citrix.

Microsoft App-V client

This software retrieves virtual applications, publishes the applications on the client, and automatically sets up and manages virtual environments at runtime on Windows devices. The App-V client stores user-specific virtual application settings, such as registry and file changes in each user's profile.

The App-V client is available from Microsoft. Install a client on each machine containing a VDA, or on the master image that is used in a Machine Catalog to create VMs.

Tip: After you install the App-V client, with Administrator permissions, run the PowerShell Get-AppvClientConfiguration cmdlet, and make sure that EnablePackageScripts is set to 1. If it is not set to 1, run Set-AppvClientConfiguration -EnablePackageScripts $true.

Citrix App-V components

The Citrix App-V component software is installed and enabled by default when you install a VDA; that process also creates an account with local administrator permissions for accessing the App-V publishing components.
You can control this default action during VDA installation. In the graphical interface, clear the **Install App-V publishing components** check box on the **Features** page. In the command line interface, include the `/no_appv` option.

If you expressly disable the Citrix App-V components feature during VDA installation, but later want to use App-V applications: In the Windows machine's Programs and Features list, right-click the **Citrix Virtual Delivery Agent** entry and then select **Change**. A wizard launches. In the wizard, enable the option that installs and enables App-V publishing components.

**Add App-V packages to the Application Library**

This procedure is valid only for the single admin management method.

You must have at least read access to the network share containing the App-V packages.

1. Select **Configuration > App-V Publishing** in the Studio navigation pane.
2. Select **Add Packages** in the Actions pane.
3. Browse to the share containing the App-V packages and select one or more packages.
4. Click **Add**.

**Add App-V applications to Delivery Groups**

The following procedure focuses on how to add App-V applications to Delivery Groups. For complete details about creating a Delivery Group, see the **Create Delivery Groups** article.

**Step 1:** Choose whether you want to create a new Delivery Group or add App-V applications to an existing Delivery Group:

To create a Delivery Group containing App-V applications:

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select **Create Delivery Group** in the Actions pane.
3. On successive pages of the wizard, specify a Machine Catalog and users.

To add App-V applications to existing Delivery Groups:

1. Select **Applications** in the Studio navigation pane.
2. Select **Add Applications** in the Actions pane.
3. Select one or more Delivery Groups where the App-V applications will be added.

**Step 2:** On the **Applications** page of the wizard, click the **Add** dropdown to display application sources. Select **App-V**.

**Step 3:** On the **Add App-V Applications** page, choose the App-V source: the App-V server or the Application Library. The resulting display includes the application names plus their package names and package versions. Select the checkboxes next to the applications you want to add. Then click **OK**.

**Step 4:** Complete the wizard.

**Good to know:**

- If you change an App-V application's properties when adding them to a Delivery Group, the changes are made when the application is started. For example, if you modify an application's display name or icon when adding it to the group, the change appears when a user starts the application.
Remove App-V packages from the Application Library

Removing an App-V package from the Application Library removes it from the Studio App-V Publishing node display; however, it does not remove its applications from Delivery Groups, and those applications can still be launched. The package remains in its physical network location. (This effect differs from removing an App-V application from a Delivery Group.)

1. Select **Configuration > App-V Publishing** in the Studio navigation pane.
2. Select one or more packages to be removed.
3. Select **Remove Package** in the Actions pane.

Troubleshoot

Issues that can occur only when using the dual admin method are marked “(DUAL)”.

(DUAL) The "Test connection" operation returns an error when you specify App-V server addresses in Studio.

- Is the App-V server powered on? Either send a Ping command or check the IIS Manager; each App-V server should be in a Started and Running state.
- Is the Studio administrator also an App-V server administrator?
- Is file sharing enabled on the App-V server? Enter `\<App-V server FQDN>` in Windows Explorer or with the Run command.
- Does the App-V server have the same file sharing permissions as the App-V administrator? On the App-V server, add an entry for `\<App-V server FQDN>` in Stored User Names and Passwords, specifying the credentials of the user who has administrator privileges on the App-V server. For guidance, see [http://support.microsoft.com/kb/306541](http://support.microsoft.com/kb/306541).
- Is the App-V server in Active Directory?

If the Studio machine and the App-V server are in different Active Directory domains that do not have a trust relationship, from the PowerShell console on the Studio machine, run `winrm s winrm/Config/client @(TrustedHosts="\<App-V server FQDN>")`.

If TrustedHosts is managed by GPO, the following error message will display: “The config setting TrustedHosts cannot be changed because use is controlled by policies. The policy would need to be set to “Not Configured” in order to change the config setting”. In this case, add an entry for the App-V server name to the TrustedHosts policy in GPO (Administrative Templates > Windows Components > Windows Remote Management (WinRM) > WinRM Client).

(DUAL) Discovery fails when adding an App-V application to a Delivery Group.

- Is the Studio administrator also an App-V management server administrator?
- Is the App-V management server running? Either send a Ping command or check the IIS Manager; each App-V server should be in a Started and Running state.

If you later edit a Delivery Group containing App-V applications, there is no change in App-V application performance if you change the group's delivery type from "desktops and applications" to "applications only."
• Do packages have the appropriate security permissions for the Studio administrator to access?

App-V applications do not launch.

• (DUAL) Is the publishing server running?
• (DUAL) Do the App-V packages have appropriate security permissions so that users can access them?
• (DUAL) On the VDA, make sure that Temp is pointing to the correct location, and that there is enough space available in the Temp directory.
• (DUAL) On the App-V publishing server, run Get-AppvPublishingServer * to display the list of publishing servers.
• (DUAL) On the App-V publishing server, check whether UserRefreshonLogon is set to False. If not, the first App-V application launch typically fails.
• (DUAL) On the App-V publishing server, as an administrator, run Set-AppvPublishingServer and set UserRefreshonLogon to False.

Is a supported version of the App-V client installed on the machine containing the VDA? Does the VDA have the “enable package scripts” setting enabled?

On the machine containing the App-V client and VDA, from the Registry editor (regedit), go to HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Citrix\AppV. Make sure that the AppVServers key has the following value format: AppVManagementServer+metadata;PublishingServer (for example: http://xmas-demo-appv.blrstrm.com+0+0+1+1+1+0+1;http://xmas-demo-appv.blrstrm.com:8082).

On the machine containing the App-V client and VDA, make sure that CtxAppVCOMAdmin has administrator privileges. This is usually created during VDA installation and added to the Local Administrators Group on the VDA machine. However, depending on the Active Directory policy, this user might lose the administrative association. Run compmgmt.msc and browse to Local Users and Groups Users. If CtxAppVCOMAdmin is not an administrator, edit the group policy so that this user account retains its administrative association.

On the machine or master image containing the App-V client and VDA, check that the PowerShell ExecutionPolicy is set to RemoteSigned. The App-V client provided by Microsoft is not signed, and this ExecutionPolicy allows PowerShell to run unsigned local scripts and cmdlets. Use one of the following two methods to set the ExecutionPolicy: (1) As an administrator, enter the cmdlet: Set-ExecutionPolicy RemoteSigned, or (2) From Group Policy settings, go to Computer Configuration > Policies > Administrative Templates > Windows Components > Windows PowerShell> Turn on Script Execution.

If these steps do not resolve the issues, enable and examine the logs.

Logs

App-V configuration-related logs are located at C:\CtxAppvLogs. The application launch logs are located at: %LOCALAPPDATA%\Citrix\CtxAppvLogs. LOCALAPPDATA resolves to the local folder for the logged-on user. Make sure to check in the local folder of the user for whom application launch failed.

To enable Studio and VDA logs used for App-V, you must have administrator privileges. You will also need a text editor such as Notepad.

To enable Studio logs:

1. Create the folder C:\CtxAppvLogs.
2. Go to C:\ProgramFiles\Citrix\StudioAppVIntegration\SnapIn\Citrix.Appv.Admin.V1. Open CtxAppvCommon.dll.config in a text editor and uncomment the line: <add key=”LogFileName” value=”C:\CtxAppvLogs\log.txt”/>

3. Restart the Broker service to start logging.

To enable VDA logs:
1. Create the folder C:\CtxAppvLogs.
2. Go to C:\ProgramFiles\Citrix\Virtual Desktop Agent. Open CtxAppvCommon.dll.config in a text editor and uncomment the following line: <add key="LogFile" value="C:\CtxAppvLogs\log.txt"/>
3. Uncomment the line and set the value field to 1: <add key="EnableLauncherLogs" value="1"/>
4. Restart the machine to start logging.
AppDisks

Jul 25, 2016

In this article:

- Overview
- Deployment overview
- Requirements
- Create an AppDisk
- Assign an AppDisk to a Delivery Group
- Managing AppDisks

Overview

Managing applications and managing the images they are installed on can be a challenge. The Citrix AppDisks feature is a solution. AppDisks separate applications and groups of applications from the operating system, enabling you to manage them independently.

You can create different AppDisks containing applications designed for individual user groups, and then assemble the AppDisks on a master image of your choice. Grouping and managing applications this way gives you finer control of applications, and reduces the number of master images you maintain. This simplifies IT administration and enables you to be more responsive to user needs. You deliver the applications in AppDisks through Delivery Groups.

If your deployment also includes Citrix AppDNA, you can integrate the AppDisks feature with it; AppDNA allows XenApp and XenDesktop to perform automatic analysis of applications on a per-AppDisk basis. Using AppDNA helps make the most of the AppDisks feature. Without it, application compatibility is not tested or reported.

AppDisks differ from other application-provisioning technologies in two ways: isolation and change management.

- Microsoft App-V allows incompatible applications to exist together by isolating them. The AppDisks feature does not isolate applications. It separates applications (and supporting files and registry keys) from the OS. To the OS and the user, AppDisks look and behave as if they are installed directly on a master image.
- Change management (updating master images and testing the compatibility of updates with installed applications) can be a significant expense. AppDNA reports help identify issues and suggest remediation steps. For example, AppDNA can identify applications that have common dependencies such as .NET, so you can install them on a single common base image. AppDNA can also identify applications that load early in the OS startup sequence, so that you can then ensure they behave as expected.

Good to know:

- Users are unaware of the separation of applications and the OS, or any other aspect of the AppDisks feature. Applications behave as if they are installed on the image. AppDisks containing complex applications may result in a slight delay in desktop startup.
- You can use AppDisks with hosted shared desktops.
- You may be able to share AppDisks across master images and OS platforms (on a per-application basis); however, this will not work for all applications. If you have applications with an install script for a desktop OS that prevents them from working on a server OS, Citrix recommends packaging the applications separately for the two OSs.
In many cases, AppDisks work on different OSs. For example, you can add an AppDisk that was created on a Windows 7 VM to a Delivery Group containing Windows 2008 R2 machines, as long as both OSs have the same bitness (32 bit or 64 bit) and both support the application. However, Citrix recommends you do not add an AppDisk created on a later OS version (such as Windows 10) to a Delivery Group containing machines running an earlier OS version (such as Windows 7), because it might not work correctly.

If you need to provide access to an AppDisk's applications to only a subset of users in a Delivery Group, Citrix recommends using Group Policy to hide an application in an AppDisk from some users. That application's executable file remains available, but will not run for those users.

### Deployment overview

The following list summarizes the steps to deploy AppDisks. Details are provided later in this article.

1. From your hypervisor management console, install a Virtual Delivery Agent (VDA) on a VM.
2. Create an AppDisk, which includes completing steps from your hypervisor management console and in Studio.
3. From your hypervisor management console, install applications on the AppDisk.
5. In Studio, create or edit a Delivery Group and select the AppDisks to include; this is called assigning the AppDisks (even though you use the Manage AppDisks action in Studio). When VMs in the Delivery Group start up, XenApp and XenDesktop coordinate with the AppLibrary, Machine Creation Services (MCS) or Provisioning Services (PVS), and the Delivery Controller to distribute the selected AppDisks.

### Requirements

Using AppDisks has requirements in addition to those listed in the System requirements article.

The AppDisks feature is supported only in deployments containing (at minimum) versions of the Delivery Controller and Studio provided in the XenApp and XenDesktop 7.8 download, including the prerequisites that the installer automatically deploys (such as .NET 4.5.2).

AppDisks can be created on the same Windows OS versions that are supported for VDAs. The machines selected for Delivery Groups that will use AppDisks must have at least VDA version 7.8 installed.

Citrix recommends that you install or upgrade all machines with the most recent VDA version (and then upgrade Machine Catalogs and Delivery Groups, if needed). When creating a Delivery Group, if you select machines that have different VDA versions installed, the Delivery Group will be compatible with the earliest VDA version. (This is called the group's functional level.) For more information about functional level, see the Create Delivery Groups article.

To provision VMs that will be used to create AppDisks, you can use:

- MCS provided with the 7.8 Controller (minimum) or the PVS version provided on the download page with your XenApp and XenDesktop version.
- Supported XenServer releases (see the System requirements article) or VMware minimum version 5.1. (Appdisks cannot be used with other host hypervisors and cloud service types supported for XenApp and XenDesktop.)

The Windows Volume Shadow Service must be enabled on the VM where you are creating an AppDisk. This service is enabled by default.

Delivery Groups used with AppDisks can contain machines from pooled random Machine Catalogs containing server OS or desktop OS machines. You cannot use AppDisks with machines from other catalog types, such as pooled static or dedicated (assigned).

Machines on which Studio is installed must have .NET Framework 3.5 installed (in addition to any other installed .NET versions).

AppDisks can affect storage. For details, see Storage and performance considerations.

If you use AppDNA:

- Review the AppDNA documentation and the AppDisk FAQ.
The AppDNA software must be installed on a different server from a Controller. Use the AppDNA version supplied with this XenApp and XenDesktop release. For other AppDNA requirements, see its documentation.

On the AppDNA server, make sure there is a firewall exception for the default port 8199.

Do not disable an AppDNA connection while creating an AppDisk.

When you create the XenApp or XenDesktop Site, you can enable compatibility analysis with AppDNA on the Additional Features page of the Site creation wizard. You can also enable/disable it later by selecting Configuration > AppDNA in the Studio navigation pane.

Storage and performance considerations

Separating applications and the OS using two disks, and storing those disks in different areas can affect your storage strategy. The following graphic illustrates the MCS and PVS storage architectures. "WC" indicates the write cache, and "Thin" indicates the thin disk used to store differences between a VM's AppDisk and OS virtual disks.

In MCS environments:

You can continue to balance the size of the AppDisks and OS virtual disks (vDisks) using your organization's existing sizing guidelines. If AppDisks are shared between multiple Delivery Groups, the overall storage capacity can be reduced.

OS vDisks and AppDisks are located in the same storage areas, so plan your storage capacity requirements carefully to avoid any negative effect on capacity when you deploy AppDisks. AppDisks incur overhead, so be sure your storage accommodates that overhead and the applications.

There is no net effect on IOPS because the OS vDisks and AppDisks are located in the same storage area. There are no write cache considerations when using MCS.

In PVS environments:

You must allow for the increased capacity and IOPS as applications move from AppDisk storage to the hypervisor-attached storage.

With PVS, OS vDisks and AppDisks use different storage areas. The OS vDisk storage capacity is reduced, but the hypervisor-attached storage is increased. So, you should size your PVS environments to accommodate those changes.

AppDisks in the hypervisor-attached storage require more IOPS while the OS vDisks require fewer.

Write cache: PVS uses a dynamic VHDX file on an NTFS formatted drive; when blocks are written to the write cache, the VHDX file is dynamically extended. When AppDisks are attached to their associated VM, they are merged with...
the OS vDisks to provide a unified view of the file system. This merging typically results in additional data being written to the write caches, which increases the size of the write cache file. You should account for this in your capacity planning.

In either MCS or PVS environments, remember to decrease the size of the OS vDisk to take advantage of the AppDisks you create. If you don’t, plan to use more storage.

When many users in a Site turn on their computers simultaneously (for example, at the beginning of the workday), the multiple startup requests apply pressure on the hypervisor, which can affect performance. For PVS, applications are not located on the OS vDisk, so fewer requests are made to the PVS server. With the resulting lighter load on each target device, the PVS server can stream to more targets. However, be aware that the increased target-server density might negatively affect boot storm performance.

Create an AppDisk

There are two ways to create an AppDisk, install applications on it, and then seal it. Both methods include steps you complete from your hypervisor management console and in Studio. The methods differ in where you complete most the steps.

Regardless of which method you use:

- Allow 30 minutes for AppDisk creation portion.
- If you use AppDNA, following the guidance in the Requirements section above. Do not disable an AppDNA connection while creating an AppDisk.
- When you add applications to an AppDisk, be sure to install applications for all users. Re-arm any applications that use Key Management Server (KMS) activation. For details, see the application’s documentation.
- Files, folders, and registry entries created in user-specific locations during AppDisk creation are not retained. Also, some applications run a first-time-use wizard to create user data during installation. Use a profile management solution to retain this data and prevent the wizard from appearing each time the AppDisk starts.
- If you are using AppDNA, its analysis automatically after the creation process completes. During this interval, the AppDisk’s status in Studio is “Analyzing.”

PVS considerations

AppDisks on machines from Machine Catalogs created by Provisioning Services require additional configuration during AppDisk creation. From the Provisioning Services console:

1. Create a new version of the vDisk associated with the device collection that contains the VM.
2. Place the VM into maintenance mode.
3. During AppDisk creation, select the maintenance version on the boot screen every time the VM restarts.
4. After you seal the AppDisk, place the VM back into production, and delete the vDisk version you created.

Create an AppDisk primarily in Studio

This procedure includes three tasks: create the AppDisk, create applications on the AppDisk, and then seal the AppDisk.

Create an AppDisk:

1. Select AppDisks in the Studio navigation pane and then select Create AppDisk in the Actions pane.
2. Review the information on the **Introduction** page of the wizard and then click **Next**.

3. On the **Create AppDisk** page, select the **Create new AppDisk** radio button. Select either a predefined disk size (small, medium, or large) or specify a disk size in GB; the minimum size is 3 GB. The disk size should be large enough to hold the applications you will add. Click **Next**.

4. On the **Preparation Machine** page, select a random pooled catalog to be used as the master image on which the AppDisk will be built. Note: The display lists all the Machine Catalogs in the Site, separated by type; only those catalogs that contain at least one available machine can be selected. If you choose a catalog that does not contain random pooled VMs, the AppDisk creation will fail. After you select a VM from a random pooled catalog, click **Next**.

5. On the **Summary** page, type a name and description for the AppDisk. Review the information you specified on previous wizard pages. Click **Finish**.

Remember: If you are using PVS, follow the guidance in **PVS considerations**.

After the wizard closes, the Studio display for the new AppDisk indicates "Creating." After the AppDisk is created, the display changes to "Ready to install applications."

**Install applications on the AppDisk:**

From your hypervisor management console, install applications on the AppDisk. (Tip: If you forget the VM name, select **AppDisks** in the Studio navigation pane and then select **Install Applications** in the Actions pane to display its name.) See the hypervisor documentation for information about installing applications. (Remember: You must install applications on the AppDisk from your hypervisor management console. Do not use the Install Applications task in the Studio Actions pane.)

**Seal the AppDisk:**

1. Select **AppDisks** in the Studio navigation pane.
2. Select the AppDisk you created, and then select **Seal AppDisk** in the Actions pane.

After you create the AppDisk, install applications on it, and then seal it, assign it to a **Delivery Group**.

Create an AppDisk on the hypervisor and import it to Studio

In this procedure, you complete the AppDisk creation and preparation tasks from the hypervisor management console and then import AppDisk into Studio.

**Prepare, install applications, and seal an AppDisk on the hypervisor:**

1. From the hypervisor management console, create a VM and install a VDA.
2. Power off the machine and take a snapshot of it.
3. Create a new machine from the snapshot and then add a new disk to it. This disk (which will become the AppDisk) must be large enough to hold all the applications you will install on it.
4. Start the machine and select **Start > Prepare AppDisk**. If this Start menu shortcut is not available on the hypervisor, open a command prompt at C:\Program Files\Citrix\personal vDisk\bin and type: CtxPvD.Exe –s LayerCreationBegin. The machine restarts and prepares the disk. A second restart occurs after several minutes when the preparation completes.
5. Install the applications you want to make available to users.
6. Double-click the **Package AppDisk** shortcut on the machine's desktop. The machine restarts again and the sealing process starts. When the "in process" dialog closes, power off the VM.

**Use Studio to import the AppDisk you created on the hypervisor:**
1. Select **AppDisks** in the Studio navigation pane and then select **Create AppDisk** in the Actions pane.
2. On the **Introduction** page, review the information and then click **Next**.
3. On the **Create AppDisk** page, select the **Import existing AppDisk** radio button. Select the resource (network and storage) where the AppDisk you created resides on the hypervisor. Click **Next**.
4. On the **Preparation Machine** page, browse to the machine, select the disk, and then click **Next**.
5. On the **Summary** page, type a name and description for the AppDisk. Review the information you specified on previous wizard pages. Click **Finish**. Studio imports the AppDisk.

After you import the AppDisk into Studio, **assign it to a Delivery Group**.

### Assign an AppDisk to a Delivery Group

You can assign one or more AppDisks to a Delivery Group when you create the Delivery Group or later. The AppDisks information you provide is essentially the same.

If you are adding AppDisks to a Delivery Group that you are creating, use the following guidance for the **AppDisks** page in the Create Delivery Group wizard. (For information about other pages in that wizard, see the **Create Delivery Groups** article.)

To add (or remove) AppDisks in an existing Delivery Group:

1. Select **Delivery Groups** in the Studio navigation pane.
2. Select a Delivery Group and then select **Manage AppDisks** in the Actions pane. See the following guidance for the **AppDisks** page.
3. When you change the AppDisk configuration in a Delivery Group, a restart of the machines in the group is required. On the **Rollout Strategy** page, follow the guidance in **Create a restart schedule**.

**AppDisks page:**

The **AppDisks** page (in the Create Delivery Group wizard or in the Manage AppDisks flow) lists the AppDisks already deployed for the Delivery Group and their priority. (If you are creating the Delivery Group, the list will be empty.) For more information, see the **AppDisk priority** section.

1. Click **Add**. The Select AppDisks dialog box lists all AppDisks in the left column. AppDisks that are already assigned to this Delivery Group have enabled checkboxes and cannot be selected.
2. Select one or more checkboxes for available AppDisks in the left column. The right column lists the applications on the AppDisk. (Selecting the **Applications** tab above the right column lists applications in a format similar to a Start menu; selecting the **Installed packages** tab lists applications in a format similar to the Programs and Features list.)
3. After selecting one or more available AppDisks, click **OK**.
4. Click **Next** on the AppDisks page.

**AppDisk priority in a Delivery Group**

When a Delivery Group has more than one AppDisk assigned, the **AppDisks** page (in the Create Delivery Group, Edit Delivery Group, and Manage AppDisks displays) lists the AppDisks in descending priority. Entries at the top of the list have the higher priority. Priority indicates the order in which the AppDisks are processed.

You can use the up and down arrows adjacent to the list to change the AppDisk priority. If AppDNA is integrated with your AppDisk deployment, it automatically analyzes the applications and then sets the priority when the AppDisks are assigned to the Delivery Group. Later, if you add or remove AppDisks from the group, clicking **Auto-Order** instructs AppDNA to re-
analyze the current list of AppDisks and then determine the priorities. The analysis (and priority reordering, if needed) may take several moments to complete.

Managing AppDisks

After you create and assign AppDisks to Delivery Groups, you can change the AppDisk's properties through the AppDisks node in the Studio navigation pane. Changes to applications in an AppDisk must be done from the hypervisor management console.

**Important:** You can use the Windows Update service to update applications (such as the Office suite) on an AppDisk. However, do not use the Windows Update Service to apply operating system updates to an AppDisk. Apply operating system updates to the master image, not the AppDisk; otherwise, the AppDisk will not initialize correctly.

- When applying patches and other updates to applications in an AppDisk, apply only those that the application requires. Do not apply updates for other applications.
- When installing Windows updates, first deselect all entries and then select the subset required by the applications on the AppDisks you're updating.
Local App Access and URL redirection

Sep 09, 2015

In this article:

- Introduction
- Requirements, considerations, and limitations
- Interaction with Windows
- Configure Local App Access and URL redirection

Introduction

Local App Access seamlessly integrates locally installed Windows applications into a hosted desktop environment without changing from one computer to another. With Local App Access, you can:

- Access applications installed locally on a physical laptop, PC, or other device directly from the virtual desktop.
- Provide a flexible application delivery solution. If users have local applications that you cannot virtualize or that IT does not maintain, those applications still behave as though they are installed on a virtual desktop.
- Eliminate double-hop latency when applications are hosted separately from the virtual desktop, by putting a shortcut to the published application on the user's Windows device.
- Use applications such as:
  - Video conferencing software such as GoToMeeting.
  - Specialty or niche applications that are not yet virtualized.
  - Applications and peripherals that would otherwise transfer large amounts of data from a user device to a server and back to the user device, such as DVD burners and TV tuners.

In XenApp and XenDesktop, hosted desktop sessions use URL redirection to launch Local App Access applications. URL redirection makes the application available under more than one URL address. It launches a local browser (based on the browser's URL blacklist) by selecting embedded links within a browser in a desktop session. If you navigate to a URL that is not present in the blacklist, the URL is opened in the desktop session again.

URL redirection works only for desktop sessions, not application sessions. The only redirection feature you can use for application sessions is host-to-client content redirection, which is a type of server FTA. This FTA redirects certain protocols to the client, such as http, https, rtsp, or mms. For example, if you only open embedded links with http, the links directly open with the client application. There is no URL blacklist or whitelist support.

When Local App Access is enabled, URLs that are displayed to users as links from locally-running applications, from user-hosted applications, or as shortcuts on the desktop are redirected in one of the following ways:

- From the user's computer to the hosted desktop
- From the XenApp or XenDesktop server to the user's computer
- Rendered in the environment in which they are launched (not redirected)

To specify the redirection path of content from specific Web sites, configure the URL whitelist and URL blacklist on the Virtual Delivery Agent. Those lists contain multi-string registry keys that specify the URL redirection policy settings; for more information, see the Local App Access policy settings.

URLs can be rendered on the VDA with the following exceptions:

- Geo/Locale information — Web sites that require locale information, such as msn.com or news.google.com (opens a
country specific page based on the Geo). For example, if the VDA is provisioned from a data center in the UK and the client is connecting from India, the user expects to see in.msn.com but instead sees uk.msn.com.

- **Multimedia content** — Web sites containing rich media content, when rendered on the client device, give the end users a native experience and also save bandwidth even in high latency networks. Although there is Flash redirection feature, this complements by redirecting sites with other media types such as Silverlight. This is in a very secure environment. That is, the URLs that are approved by the administrator are run on the client while the rest of the URLs are redirected to the VDA.

In addition to URL redirection, you can use File Type Association (FTA) redirection. FTA launches local applications when a file is encountered in the session. If the local app is launched, it must have access to the file to open it. Therefore, you can only open files that reside on network shares or on client drives (using client drive mapping) using local applications. For example, when opening a PDF file, if a PDF reader is a local app, then the file opens using that PDF reader. Because the local app can access the file directly, there is no network transfer of the file through ICA to open the file.

### Requirements, considerations, and limitations

Local App Access is supported on the valid operating systems for VDAs for Windows Server OS and VDAs for Windows Desktop OS, and requires Citrix Receiver for Windows version 4.1 (minimum). The following browsers are supported:

- Internet Explorer 11. You can use Internet Explorer 8, 9, or 10, but Microsoft supports (and Citrix recommends using) version 11.
- Firefox 3.5 through 21.0
- Chrome 10

Review the following considerations and limitations when using Local App Access and URL redirection.

- **Local App Access** is designed for full-screen, virtual desktops spanning all monitors:
  - The user experience can be confusing if Local App Access is used with a virtual desktop that runs in windowed mode or does not cover all monitors.
  - For multiple monitors, when one monitor is maximized it becomes the default desktop for all applications launched in that session, even if subsequent applications typically launch on another monitor.
  - The feature supports one VDA; there is no integration with multiple concurrent VDAs.

- Some applications can behave unexpectedly, affecting users:
  - Users might be confused with drive letters, such as local C: rather than virtual desktop C: drive.
  - Available printers in the virtual desktop are not available to local applications.
  - Applications that require elevated permissions cannot be launched as client-hosted applications.
  - There is no special handling for single-instance applications (such as Windows Media Player).
  - Local applications appear with the Windows theme of the local machine.
  - Full-screen applications are not supported. This includes applications that open to full screen, such as PowerPoint slide shows or photo viewers that cover the entire desktop.

- **Local App Access** copies the properties of the local application (such as the shortcuts on the client's desktop and Start menu) on the VDA; however, it does not copy other properties such as shortcut keys and read-only attributes.

- **Applications** that customize how overlapping window order is handled can have unpredictable results. For example, some windows might be hidden.

- **Shortcuts** are not supported, including My Computer, Recycle Bin, Control Panel, Network Drive shortcuts, and folder shortcuts.

- The following file types and files are not supported: custom file types, files with no associated programs, zip files, and hidden files.

- **Taskbar grouping** is not supported for mixed 32-bit and 64-bit client-hosted or VDA applications, such as grouping 32-bit local applications with 64-bit VDA applications.

- Applications cannot be launched using COM. For example, if you click an embedded Office document from within an Office application, the process launch cannot be detected, and the local application integration fails.

- **URL redirection supports only explicit URLs** (that is, those appearing in the browser's address bar or found using the in-browser navigation, depending on the browser).

- **URL redirection works only with desktop sessions**, not with application sessions.

- The local desktop folder in a VDA session does not allow users to create new files.

- Multiple instances of a locally-running application behave according to the taskbar settings established for the virtual desktop. However, shortcuts to locally-running applications are not grouped with running instances of those applications. They are also not grouped with running instances of hosted applications or pinned shortcuts to hosted applications. Users can close only windows of locally-running
applications from the Taskbar. Although users can pin local application windows to the desktop Taskbar and Start menu, the applications might not launch consistently when using these shortcuts.

Interaction with Windows

The Local App Access interaction with Windows includes the following behaviors.

- Windows 8 and Windows Server 2012 shortcut behavior
  - Windows Store applications installed on the client are not enumerated as part of Local App Access shortcuts.
  - Image and video files are usually opened by default using Windows store applications. However, Local App Access enumerates the Windows store applications and opens shortcuts with desktop applications.

- Local Programs
  - For Windows 7, the folder is available in the Start menu.
  - For Windows 8, Local Programs is available only when the user chooses All Apps as a category from the Start screen. Not all subfolders are displayed in Local Programs.

- Windows 8 graphics features for applications
  - Desktop applications are restricted to the desktop area and are covered by the Start screen and Windows 8 style applications.
  - Local App Access applications do not behave like desktop applications in multi-monitor mode. In multi-monitor mode, the Start screen and the desktop display on different monitors.

- Windows 8 and Local App Access URL Redirection
  - Because Windows 8 Internet Explorer has no add-ons enabled, use desktop Internet Explorer to enable URL redirection.
  - In Windows Server 2012, Internet Explorer disables add-ons by default. To implement URL Redirection, disable Internet Explorer enhanced configuration. Then reset the Internet Explorer options and restart to ensure that add-ons are enabled for standard users.

Configure Local App Access and URL redirection

To use Local App Access and URL redirection with Citrix Receiver:

- Install Citrix Receiver on the local client machine. You can enable both features during Citrix Receiver installation or you can enable Local App Access template using the Group Policy editor.
- Set the Allow local app access policy setting to Enabled. You can also configure URL whitelist and blacklist policy settings for URL redirection. For more information, see Local App Access policy settings.

Enable Local App Access and URL redirection during Citrix Receiver installation

To enable Local App Access and URL redirection for all local applications:

1. Set the Allow local app access policy setting to Enabled. When this setting is enabled, the VDA allows the client to decide whether administrator-published applications and Local App Access shortcuts are enabled in the session. (When this setting is disabled, both administrator-published applications and Local App Access shortcuts do not work for the VDA.) This policy setting applies to the entire machine, as well as the URL redirection policy.
2. Enable Local App Access and URL redirection when you install Citrix Receiver for all users on a machine. This action also registers the browser add-ons required for URL redirection. From the command prompt, run the appropriate command to install the Receiver with the following option:
CitrixReceiver.exe /ALLOW_CLIENTHOSTEDAPPSURL=1
CitrixReceiverWeb.exe /ALLOW_CLIENTHOSTEDAPPSURL=1

Enable the Local App Access template using the Group Policy editor

1. Run `gpedit.msc`.
3. Add the iacaclient.adm template located in the Citrix Receiver Configuration folder (usually in `C:\Program Files (x86)\Citrix\Online Plugin\Configuration`). (After the iacaclient.adm template is added to Computer Configuration, it is also available in User Configuration.)
5. Select `Local App Access settings`.
6. Select `Enabled` and then select `Allow URL Redirection`. For URL redirection, register browser add-ons using the command line, as described below.

Provide access to only published applications

To provide access to only published applications:

1. On the server where the Delivery Controller is installed, run `regedit.exe`.
   1. Navigate to `HKLM\Software\Wow6432Node\Citrix\DesktopStudio`.
   2. Add the REG_DWORD entry `ClientHostedAppsEnabled` with a value of 1. (A 0 value disables Local App Access.)
2. Restart the Delivery Controller server and then restart Studio.
3. Publish Local App Access applications.
   1. Select `Delivery Groups` in the Studio navigation pane and then select the Applications tab.
   2. Select `Create Local Access Application` in the Actions pane.
   3. Select the desktop Delivery Group.
   4. Enter the full executable path of the application on the user's local machine.
   5. Indicate if the shortcut to the local application on the virtual desktop will be visible on the Start menu, the desktop, or both.
   6. Accept the default values on the Name page and then review the settings.
4. Enable Local App Access and URL redirection when you install Citrix Receiver for all users on a machine. This action also registers the browser add-ons required for URL redirection. From the command prompt, run the command to install Citrix Receiver with the following option:
   
   `CitrixReceiver.exe /ALLOW_CLIENTHOSTEDAPPSURL=1
   CitrixReceiverWeb.exe /ALLOW_CLIENTHOSTEDAPPSURL=1`

5. Set the `Allow local app access` policy setting to `Enabled`. When this setting is enabled, the VDA allows the client to decide whether administrator-published applications and Local App Access shortcuts are enabled in the session. (When this setting is disabled, both administrator-published applications and Local App Access shortcuts do not work for the VDA.)

Register browser add-ons

**Note:** The browser add-ons required for URL redirection are registered automatically when you install Citrix Receiver from the command line with the `/ALLOW_CLIENTHOSTEDAPPSURL=1` option.

You can use the following commands to register and unregister one or all add-ons:
To register add-ons on a client device: `<client-installation-folder>\redirector.exe /reg<browser>`

To unregister add-ons on a client device: `<client-installation-folder>\redirector.exe /unreg<browser>`

To register add-ons on a VDA: `<VDAinstallation-folder>\VDARedirector.exe /reg<browser>`

To unregister add-ons on a VDA: `<VDAinstallation-folder>\VDARedirector.exe /unreg<browser>`

where `<browser>` is IE, FF, Chrome, or All.

For example, the following command registers Internet Explorer add-ons on a device running Citrix Receiver.

C:\Program Files\Citrix\ICA Client\redirector.exe/regIE

The following command registers all add-ons on a Windows Server OS VDA.

C:\Program Files (x86)\Citrix\System32\VDARedirector.exe /regAll

URL interception across browsers

- By default, Internet Explorer redirects the URL entered. If the URL is not in the blacklist but is redirected to another URL by the browser or website, the final URL is not redirected, even if it is on the blacklist.

  For URL redirection to work correctly, enable the add-on when prompted by the browser. If the add-ons that are using Internet options or the add-ons in the prompt are disabled, URL redirection does not work correctly.

- The Firefox add-ons always redirect the URLs.

  When an add-on is installed, Firefox prompts to allow/prevent installing the add-on on a new tab page. You must allow the add-on for the feature to work.

- The Chrome add-on always redirects the final URL that is navigated, and not the entered URLs.

  The extensions have been installed externally. If you disable the extension, the URL redirection feature does not work in Chrome. If the URL redirection is required in Incognito mode, allow the extension to run in that mode in the browser settings.

Configure local application behavior on logoff and disconnect

1. On the hosted desktop, run `gpedit.msc`.
2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\Client Hosted Apps\Policies\Session State. For a 64-bit system, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\wow6432node\Citrix\Client Hosted Apps\Policies\Session State.
3. Add the REG_DWORD entry Terminate with one of the values:
   - 1 - Local applications continue to run when a user logs off or disconnects from the virtual desktop. Upon reconnection, local applications are reintegrated if they are available in the local environment.
   - 3 - Local applications close when a user logs off or disconnects from the virtual desktop.
XenApp Secure Browser

Mar 24, 2016

As applications are ported to the web, users must rely on multiple browser vendors and versions in order to achieve compatibility with web-based apps. If the application is an internally hosted application, organizations are often required to install and configure complex VPN solutions in order to provide access to remote users. Typical VPN solutions require a client-side agent that must also be maintained across numerous operating systems.

With the XenApp Secure Browser, users can have a seamless web-based application experience where a hosted web-based application simply appears within the user’s preferred local browser. For example, a user’s preferred browser is Mozilla Firefox but the application is only compatible with Microsoft Internet Explorer. XenApp Secure Browser will display the Internet Explorer compatible application as a tab within the Firefox browser.

Deploying XenApp Secure Browser Edition

Citrix recommends that you leverage the Lifecycle Management Blueprint for the XenApp Secure Browser to simplify the deployment. As part of the XenApp Version 7.8 launch, all existing XenApp and XenDesktop customers with active Software Maintenance (SWM) or Subscription Advantage (SA) have access to the Deploy edition of Citrix Lifecycle Management.

The XenApp Secure Browser Blueprint includes scripts to automate the following tasks:

- Install XenApp, including the Citrix License Server and StoreFront
- Create a XenApp delivery site
- Join the provisioned machines to your existing domain

Using the Citrix Lifecycle Management Blueprint

To use the Citrix Lifecycle Management Blueprint:

1. From the Workspace Cloud home page, navigate to Services; click Request Trial for Lifecycle Management. Once you request the trial, you’ll receive an email notifying you when the trial service is available. This generally takes 5-10 minutes.
2. Click Manage in the email you received when you requested the trail to display the Lifecycle Management Overview page.

Consider the following after downloading the Secure Browser Edition 7.8 ISO:

- Start using the XenApp Secure Browser Blueprint by following the instructions specified in XenApp Secure Installation with a Citrix Lifecycle Management Blueprint.
- After completing the installation, further optimize your environment for webapp delivery by using the configuration steps specified in the XenApp Secure Browser Deployment Guide.

Manually installing XenApp Secure Browser

To manually install XenApp Secure Browser version 7.8:

2. Follow the install instructions for various components of XenApp.

3. Configure the edition and license mode for the Secure Browser edition after installation, by performing the following additional steps:

   a. On the Delivery Controller, start a PowerShell session by clicking the blue icon on the taskbar, or by browsing to Start > All Programs > Accessories > Windows PowerShell > Windows PowerShell.

   Note: On 64-bit systems, this starts the 64-bit version. Both the 32-bit or 64-bit versions are supported.

   b. Type Asnp Citrix* and press Enter to load the Citrix-specific PowerShell modules.

   Note: “Asnp” represents Add-PSSnapin.

   c. Check the current site settings and license mode, by running the Get-ConfigSite cmdlet.

   d. Set the license mode to XenApp Secure Browser edition by running the Set-ConfigSite -ProductCode XDT -ProductEdition BAS.

   e. Confirm that the XenApp Secure Browser edition and license mode is set properly by running the Get-BrokerSite cmdlet.

Note

After completing the installation, further optimize your environment for webapp delivery by using the configuration steps specified in the XenApp Secure Browser Deployment Guide.
Server VDI

Oct 24, 2016

Use the Server VDI (Virtual Desktop Infrastructure) feature to deliver a desktop from a server operating system for a single user.

- Enterprise administrators can deliver server operating systems as VDI desktops, which can be valuable for users such as engineers and designers.
- Service Providers can offer desktops from the cloud; those desktops comply with the Microsoft Services Provider License Agreement (SPLA).

You can use the Enhanced Desktop Experience Citrix policy setting to make the server operating system look like a Windows 7 operating system.

The following features cannot be used with Server VDI:

- Personal vDisks
- HDX 3D Pro
- Hosted applications
- Local App Access
- Direct (non-brokered) desktop connections
- Remote PC Access

For Server VDI to work with TWAIN devices such as scanners, the Windows Server Desktop Experience feature must be installed. In Windows Server 2012, this is an optional feature which you install from Administrative Tools > Server Manager > Features > Add features > Desktop Experience.

Server VDI is supported on the same server operating systems as the VDA for Windows Server OS.

1. Prepare the Windows server for installation: ensure that Remote Desktop Services role services are not installed and that users are restricted to a single session:
   - Use Windows Server Manager to ensure that the Remote Desktop Services role services are not installed. If they were previously installed, remove them.
   - Ensure that the ‘Restrict each user to a single session’ property is enabled.
     - On Windows Server 2008 R2, access this property through Administrative Tools > Remote Desktop Services > Remote Desktop Session Host Configuration. In the Edit settings > General section, the Restrict each user to a single session setting should indicate Yes.
     - On Windows Server 2012, edit the registry to set the Terminal Server setting. In registry key HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\TerminalServer to set DWORD fSingleSessionPerUser to 1.

2. For Windows Server 2008 R2, install Microsoft .NET Framework 3.5 SP1 on the server before installing the VDA.

3. Use the command line interface to install a VDA on a supported server or server master image, specifying the /quiet and /servervdi options. (By default, the installer blocks the Windows Desktop OS VDA on a server operating system; using the command line overrides this behavior.)

   XenDesktopVdaSetup.exe /quiet /servervdi

   You can specify the Delivery Controller or Controllers while installing the VDA using the command line, using the /controllers option.
Use the `/enable_hdx_ports` option to open ports in the firewall, unless the firewall is to be configured manually.

Add the `/masterimage` option if you are installing the VDA on an image, and will use MCS to create server VMs from that image.

Do not include options for features that are not supported with Server VDI, such as `/baseimage`, `/enable_hdx_3d_pro`, or `/xa_server_location`.

4. Create a Machine Catalog for Server VDI.
   1. On the Operating System page, select **Desktop OS**.
   2. On the Summary page, specify a machine catalog name and description for administrators that clearly identifies it as Server VDI; this will be the only indicator in Studio that the catalog supports Server VDI.

   When using Search in Studio, the Server VDI catalog you created is displayed on the Desktop OS Machines tab, even though the VDA was installed on a server.

5. Create a Delivery Group and assign the Server VDI catalog you created in the previous step.

   If you did not specify the Delivery Controllers while installing the VDA, specify them afterward using Citrix policy setting, Active Directory, or by editing the VDA machine's registry values.
Personal vDisk

Feb 24, 2016

The personal vDisk feature retains the single image management of pooled and streamed desktops while allowing users to install applications and change their desktop settings. Unlike traditional Virtual Desktop Infrastructure (VDI) deployments involving pooled desktops, where users lose their customization and personal applications when the administrator changes the master image, deployments using personal vDisks retain those changes. This means administrators can easily and centrally manage their master images while providing users with a customized and personalized desktop experience.

Personal vDisks provide this separation by redirecting all changes made on the user's VM to a separate disk (the personal vDisk), which is attached to the user's VM. The content of the personal vDisk is blended at runtime with the content from the master image to provide a unified experience. In this way, users can still access applications provisioned by their administrator in the master image.

Personal vDisks have two parts, which use different drive letters and are by default equally sized:
- **User profile** - This contains user data, documents, and the user profile. By default this uses drive P: but you can choose a different drive letter when you create a catalog with machines using personal vDisks. The drive used also depends on the EnableUserProfileRedirection setting.
- **Virtual Hard Disk (.vhd) file** - This contains all other items, for example applications installed in C:\Program Files. This part is not displayed in Windows Explorer and, since Version 5.6.7, does not require a drive letter.

Personal vDisks support the provisioning of department-level applications, as well as applications downloaded and installed by users, including those that require drivers (except phase 1 drivers), databases, and machine management software. If a user's change conflicts with an administrator's change, the personal vDisk provides a simple and automatic way to reconcile the changes.

In addition, locally administered applications (such as those provisioned and managed by local IT departments) can also be provisioned into the user's environment. The user experiences no difference in usability; personal vDisks ensure all changes made and all applications installed are stored on the vDisk. Where an application on a personal vDisk exactly matches one on a master image, the copy on the personal vDisk is discarded to save space without the user losing access to the application.

Physically, you store personal vDisks on the hypervisor but they do not have to be in the same location as other disks attached to the virtual desktop. This can lower the cost of personal vDisk storage.

During Site creation, when you create a connection, you define storage locations for disks that are used by VMs. You can separate the Personal vDisks from the disks used by the operating system. Each VM must have access to a storage location for both disks. If you use local storage for both, they must be accessible from the same hypervisor. To ensure this requirement is met, Studio offers only compatible storage locations. Later, you can also add personal vDisks and storage for them to existing hosts (but not machine catalogs) from Configuration > Hosting in Studio.

Back up personal vDisks regularly using any preferred method. The vDisks are standard volumes in a hypervisor's storage tier, so you can back them up, just like any other volume.

The following improvements are included in this release:
- This version of personal vDisk contains performance improvements that reduce the amount of time it takes to apply an
image update to a personal vDisk catalog.

The following known issues are fixed in this release:

- Attempting an in-place upgrade of a base virtual machine from Microsoft Office 2010 to Microsoft Office 2013 resulted in the user seeing a reconfiguration window followed by an error message: "Error 25004. The product key you entered cannot be used on this machine." In the past, it was recommended that Office 2010 be uninstalled in the base virtual machine before installing Office 2013. Now, it is no longer necessary to uninstall Office 2010 when performing an in-place upgrade to the base virtual machine (#391225).
- During the image update process, if a higher version of Microsoft .Net exists on the users personal vDisk, it was overwritten by a lower version from the base image. This caused issues for users running certain applications installed on their personal vDisk which required the higher version, such as Visual Studio (#439009).
- A Provisioning Services imaged disk with personal vDisk install and enabled, cannot be used to create a non-personal vdisk machine catalog. This restriction has been removed (#485189).

New in version 7.6:
- Improved personal vDisk error handling and reporting. In Studio, when you display PvD-enabled machines in a catalog, a "PvD" tab provides monitoring status during image updates, plus estimated completion time and progress. Enhanced state displays are also provided.
- A personal vDisk Image Update Monitoring Tool for earlier releases is available from the ISO media (ISO\Support\Tools\Scripts\PvdTool). Monitoring capabilities are supported for previous releases, however the reporting capabilities will not be as robust compared to the current release.
- Provisioning Services test mode allows you to boot machines with an updated image in a test catalog. After you verify its stability, you can promote the test version of the personal vDisk to production.
- A new feature enables you to calculate the delta between two inventories during an inventory, instead of calculating it for each PvD desktop. New commands are provided to export and import a previous inventory for MCS catalogs. (Provisioning Services master vDisks already have the previous inventory.)

Known issues from 7.1.3 fixed in version 7.6:
- Interrupting a personal vDisk installation upgrade can result in corrupting an existing personal vDisk installation. [#424878]
- A virtual desktop may become unresponsive if the personal vDisk runs for an extended period of time and a non-page memory leak occurs. [#473170]

New known issues in version 7.6:
- The presence of antivirus products can affect how long it takes to run the inventory or perform an update. Performance can improve if you add CtxPvD.exe and CtxPvDSvc.exe to the PROCESS exclusion list of your antivirus product. These files are located in C:\Program Files\Citrix\personal vDisk\bin. [#326735]
- Hard links between files inherited from the master image are not preserved in personal vDisk catalogs. [#368678]
- After upgrading from Office 2010 to 2013 on the Personal vDisk master image, Office might fail to launch on virtual machines because the Office KMS licensing product key was removed during the upgrade. As a workaround, uninstall Office 2010 and reinstall Office 2013 on the master image. [#391225]
- Personal vDisk catalogs do not support VMware Paravirtual SCSI (PVSCSI) controllers. To prevent this issue, use the default controller. [#394039]
- For virtual desktops that were created with Personal vDisk version 5.6.0 and are upgraded to 7, users who logged on to the master virtual machine (VM) previously might not find all their files in their pooled VM. This issue occurs because a new user profile is created when they log on to their pooled VM. There is no workaround for this issue. [#392459]
• Personal vDisks running Windows 7 cannot use the Backup and Restore feature when the Windows system protection feature is enabled. If system protection is disabled, the user profile is backed up, but the userdata.v2.vhd file is not. Citrix recommends disabling system protection and using Backup and Restore to back up the user profile. [#360582]
• When you create a VHD file on the base VM using the Disk Management tool, you might be unable to mount the VHD. As a workaround, copy the VHD to the PvD volume. [#355576]
• Office 2010 shortcuts remain on virtual desktops after this software is removed. To work around this issue, delete the shortcuts. [#402889]
• When using Microsoft Hyper-V, you cannot create a catalog of machines with personal vDisks when the machines are stored locally and the vDisks are stored on Cluster Shared Volumes (CSVs); catalog creation fails with an error. To work around this issue, use an alternative storage setup for the vDisks. [#423969]
• When you log on for the first time to a virtual desktop that is created from a Provisioning Services catalog, the desktop prompts for a restart if the personal vDisk has been reset (using the command ctxpvd.exe -s reset). To work around this issue, restart the desktop as prompted. This is a once-only reset that is not required when you log on again. [#340186]
• If you install .NET 4.5 on a personal vDisk and a later image update installs or modifies .NET 4.0, applications that are dependent on .NET 4.5 fail. To work around this issue, distribute .NET 4.5 from the base image as an image update.
• See also the — Known Issues documentation for the XenApp and XenDesktop 7.6 release.

Known issues from 7.1.1 fixed in version 7.1.3:
• Direct upgrades from personal vDisk 5.6.0 to personal vDisk 7.x may cause the personal vDisk to fail. [#432992]
• Users might only be able to connect intermittently to virtual desktops with personal vDisks. [#437203]
• If a personal vDisk image update operation is interrupted while personal vDisk 5.6.5 or later is upgraded to personal vDisk 7.0 or later, subsequent update operations can fail. [#436145]

Known issues from 7.1 fixed in version 7.1.1:
• Upgrading to Symantec Endpoint Protection 12.1.3 through an image update causes symhelp.exe to report corrupt antivirus definitions. [#423429]
• Personal vDisk can cause pooled desktops to restart if Service Control Manager (services.exe) crashes. [#0365351]

New known issues in version 7.1.1: none

New in version 7.1:
• You can now use Personal vDisk with desktops running Windows 8.1, and event logging has been improved.
• Copy-on-Write (CoW) is no longer supported in this release. When upgrading from Version 7.0 to 7.1 of Personal vDisk, all changes to data managed by CoW are lost. This was an experimental feature in XenDesktop 7 and was disabled by default, so if you did not enable it, you are not affected.

Known issues from 7.0.1 fixed in version 7.1:
• If the value of the Personal vDisk registry key EnableProfileRedirection is set to 1 or ON, and later, while updating the image, you change it to 0 or OFF, the entire Personal vDisk space might be allocated to user-installed applications, leaving no space for user profiles, which remain on the vDisk. If this profile redirection is disabled for a catalog and you enable it during an image update, users might not be able to log on to their virtual desktop. [#381921]
• The Desktop Service does not log the correct error in the Event Viewer when a Personal vDisk inventory update fails.
When upgrading to Personal vDisk 7.x, modified rules are not preserved. This issue has been fixed for upgrades from Version 7.0 to Version 7.1. When upgrading from Version 5.6.5 to Version 7.1, you must first save the rule file and then apply the rules again after the upgrade. [#388664]

Personal vDisks running Windows 8 cannot install applications from the Windows Store. An error message stating, “Your purchase couldn't be completed,” appears. Enabling the Windows Update Service does not resolve this issue, which has now been fixed. However, user-installed applications must be reinstalled after the system restarts. [#361513]

Some symbolic links are missing in Windows 7 pooled desktops with personal vDisks. As a result, applications that store icons in C:\Users\All Users do not display these icons in the Start menu. [#418710]

A personal vDisk does not start if an Update Sequence Number (USN) journal overflow occurs due to a large number of changes made to the system after an inventory update. [#369846]

A personal vDisk does not start with status code 0x20 and error code 0x20000028. [#393627]

Symantec Endpoint Protection 12.1.3 displays the message “Proactive Threat Protection is malfunctioning” and this component’s Live Update Status is not available. [#390204]

New known issues in version 7.1: See the — Known Issues documentation for the XenDesktop 7.1 release.

New in version 7.0.1: Personal vDisk is now more robust to environment changes. Virtual desktops with personal vDisks now register with the Delivery Controller even if image updates fail, and unsafe system shutdowns no longer put the vDisks into a permanently disabled state. In addition, using rules files you can now exclude files and folders from the vDisks during a deployment.

Known issues from 5.6.13 fixed in version 7.0.1:
- Changes to a group’s membership made by users on a pooled virtual desktop might be lost after an image update. [#286227]
- Image updates might fail with a low disk space error even if the personal vDisk has enough space. [#325125]
- Some applications fail to install on virtual desktops with a personal vDisk, and a message is displayed that a restart is required. This is due to a pending rename operation. [#351520]
- Symbolic links created inside the master image do not work on virtual desktops with personal vDisks. [#352585]
- In environments that use Citrix Profile management and personal vDisk, applications that examine user profiles on a system volume might not function properly if profile redirection is enabled. [#353661]
- The inventory update process fails on master images when the inventory is bigger than 2GB. [#359768]
- Image updates fail with error code 112 and personal vDisks are corrupted even if the vDisks have enough free space for the update. [#363003]
- The resizing script fails for catalogs with more than 250 desktops. [#363365]
- Changes made by users to an environment variable are lost when an image update is performed. [#372295]
- Local users created on a virtual desktop with a personal vDisk are lost when an image update is performed. [#377964]
- A personal vDisk may fail to start if an Update Sequence Number (USN) journal overflow occurred due to a large number of changes made to the system after an inventory update. To avoid this, increase the USN journal size to a minimum of 32 MB in the master image and perform an image update. [#369846]
- An issue has been identified with Personal vDisk that prevents the correct functioning of AppSense Environment Manager registry hiving actions when AppSense is used in Replace Mode. Citrix and AppSense are working together to resolve the issue, which is related to the behavior of the RegRestoreKey API when Personal vDisk is installed.[#0353936]
When an application installed on a personal vDisk (PvD) is related to another application of the same version that is installed on the master image, the application on the PvD could stop working after an image update. This occurs if you uninstall the application from the master image or upgrade it to a later version, because that action removes the files needed by the application on the PvD from the master image. To prevent this, keep the application containing the files needed by the application on the PvD on the master image.

For example, the master image contains Office 2007, and a user installs Visio 2007 on the PvD; the Office applications and Visio work correctly. Later, the administrator replaces Office 2007 with Office 2010 on the master image, and then updates all affected machines with the updated image. Visio 2007 no longer works. To avoid this, keep Office 2007 in the master image. [#320915]

When deploying McAfee Virus Scan Enterprise (VSE), use version 8.8 Patch 4 or later on a master image if you use personal vDisk. [#303472]

If a shortcut created to a file in the master image stops working (because the shortcut target is renamed within PvD), recreate the shortcut. [#367602]

Do not use absolute/hard links in a master image. [#368678]

The Windows 7 backup and restore feature is not supported on the personal vDisk. [#360582]

After an updated master image is applied, the local user and group console becomes inaccessible or shows inconsistent data. To resolve the issue, reset the user accounts on the VM, which requires resetting the security hive. This issue was fixed in the 7.1.2 release (and works for VMs created in later releases), but the fix does not work for VMs that were created with an earlier version and then upgraded. [#488044]

When using a pooled VM in an ESX hypervisor environment, users see a restart prompt if the selected SCSI controller type is “VMware Paravirtual.” For a workaround, use an LSI SCSI controller type. [#394039]

After a PvD reset on a desktop created through Provisioning Services, users may receive a restart prompt after logging on to the VM. As a workaround, restart the desktop. [#340186]

Windows 8.1 desktop users might be unable to log on to their PvD. An administrator might see message “PvD was disabled due to unsafe shutdown” and the PvDActivation log might contain the message “Failed to load reg hive \Device\vm\hd\Disk00000001\CitrixPvD\Settings\RingCube.dat” This occurs when a user's VM shuts down unsafely. As a workaround, reset the personal vDisk. [#474071]
Install and upgrade

Nov 05, 2014

Personal vDisk 7.x is supported on XenDesktop version 5.6 through the current version. The “System requirements” documentation for each XenDesktop version lists the supported operating systems for Virtual Delivery Agents (VDAs), and the supported versions of hosts (virtualization resources), and Provisioning Services. For details about Provisioning Services tasks, see the Provisioning Services documentation.

PvD is installed automatically when you install or upgrade a VDA for Desktop OS on a machine. If you update the PvD software after installing the VDA, use the PvD MSI provided here (Citrix account credentials required).

Enabling PvD:
- If you are using Machine Creation Services (MCS), PvD is enabled automatically when you create a machine catalog of desktop OS machines that will use a personal vDisk.
- If you are using Provisioning Services (PVS), PvD is enabled automatically when you run the inventory during the master (base) image creation process, or when auto-update runs the inventory for you.

VDA installation offers options to enable PvD (by selecting the “Personal vDisk” checkbox in the graphical interface or by specifying the /baseimage option in the command line interface). However, omitting this action during the VDA install (which is the default) still allows you to use the same image to create both PvD desktops and non-PvD desktops, because PvD is enabled during the catalog creation process.

You add personal vDisks to hosts when you configure a Site. You can choose to use the same storage on the host for VMs and personal vDisks, or you can use different storage for personal vDisks.

Later, you can also add personal vDisks and their storage to existing hosts (connections), but not machine catalogs.

1. Select Configuration > Hosting in the Studio navigation pane.
2. Select Add Personal vDisk storage in the Actions pane, and specify the storage location.

The easiest way to upgrade personal vDisk from an earlier 7.x version is to simply upgrade your desktop OS VDAs to the version provided with the most recent XenDesktop version. Then, run the PvD inventory.

You can also upgrade just PvD using the PvD MSI from here.

You can use one of two ways to remove the PvD software:
- Uninstall the VDA; this removes the PvD software as well.
- If you updated PvD using the PvD MSI, then you can uninstall it from the Programs list.

If you uninstall PvD and then want to reinstall the same or a newer version, first back up the registry key HKLM\Software\Citrix\personal vDisk\config, which contains environment configuration settings that might have changed. Then, after installing PvD, reset the registry values that might have changed, by comparing them with the backed-up version.
Configure and manage

Nov 12, 2014

This topic covers items you should consider when configuring and managing a personal vDisk (PvD) environment. It also covers best practice guidelines and task descriptions.

For procedures that include working in the Windows registry:
Caution: Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

The following factors affect the size of the main personal vDisk volume:

- **Size of the applications that users will install on their PvDs**
  At restarts, PvD determines the free space remaining in the application area (UserData.v2.vhd). If this falls below 10%, the application area is expanded into any unused profile area space (by default, the space available on the P: drive). The space added to the application area is approximately 50% of the combined free space remaining in both the application area and the profile area.

  For example, if the application area on a 10 GB PvD (which by default is 5 GB) reaches 4.7 GB and the profile area has 3 GB free, the increased space that is added to the application area is calculated as follows:

  \[
  \text{increased space} = \frac{(5.0-4.7)}{2} + \frac{3.0}{2} = 1.65 \text{ GB}
  \]

  The space added to the application area is only approximate because a small allowance is made for storing logs and for overhead. The calculation and the possible resizing is performed on each restart.

- **Size of users’ profiles (if a separate profile management solution is not used)**
  In addition to the space required for applications, ensure there is sufficient space available on personal vDisks to store users’ profiles. Include any non-redirected special folders (such as My Documents and My Music) when calculating space requirements. Existing profile sizes are available from the Control Panel (sysdm.cpl).

  Some profile redirection solutions store stub files (sentinel files) instead of real profile data. These profile solutions might appear to store no data initially but actually consume one file directory entry in the file system per stub file: generally, approximately 4 KB per file. If you use such a solution, estimate the size based on the real profile data, not the stub files.

  Enterprise file sharing applications (such as ShareFile and Dropbox) might synchronize or download data to users’ profile areas on the personal vDisks. If you use such applications, include enough space in your sizing estimates for this data.

- **Overhead consumed by the template VHD containing the PvD inventory**
  The template VHD contains the PvD inventory data (sentinel files corresponding to the master image content). The PvD application area is created from this VHD. Because each sentinel file or folder comprises a file directory entry in the file system, the template VHD content consumes PvD application space even before any applications are installed by the end user. You can determine the template VHD size by browsing the master image after an inventory is taken. Alternatively, use the following equation for an approximately calculation:

  \[
  \text{template VHD size} = \text{(number of files on base image)} \times 4 \text{ KB}
  \]

  Determine the number of files and folders by right-clicking the C: drive on the base VM image and selecting Properties.
For example, an image with 250,000 files results in a template VHD of approximately 1,024,000,000 bytes (just under 1 GB). This space will be unavailable for application installations in the PvD application area.

- **Overhead for PvD image update operations**
  During PvD image update operations, enough space must be available at the root of the PvD (by default, P:) to merge the changes from the two image versions and the changes the user has made to their PvD. Typically, PVD reserves a few hundred megabytes for this purpose, but extra data that was written to the P: drive might consume this reserved space, leaving insufficient for the image update to complete successfully. The PVD pool statistics script (located on the XenDesktop installation media in the Support/Tools/Scripts folder) or the PVD Image Update Monitoring Tool (in the Support/Tools/Scripts\PvdTool folder) can help identify any PVD disks in a catalog that are undergoing an update and that are nearly full.

  The presence of antivirus products can affect how long it takes to run the inventory or perform an update. Performance can improve if you add CtxPvD.exe and CtxPvDSvc.exe to the exclusion list of your antivirus product. These files are located in C:\Program Files\Citrix\personal vDisk\bin. Excluding these executables from scanning by the antivirus software can improve inventory and image update performance by up to a factor of ten.

- **Overhead for unexpected growth (unexpected application installations, and so on)**
  Consider allowing extra (either a fixed amount or a percentage of the vDisk size) to the total size to accommodate unexpected application installations that the user performs during deployment.

You can manually adjust the automatic resizing algorithm that determines the size of the VHD relative to the P: drive, by setting the initial size of the VHD. This can be useful if, for example, you know users will install a number of applications that are too big to fit on the VHD even after it is resized by the algorithm. In this case, you can increase the initial size of the application space to accommodate the user-installed applications.

Preferably, adjust the initial size of the VHD on a master image. Alternatively, you can adjust the size of the VHD on a virtual desktop when a user does not have sufficient space to install an application. However, you must repeat that operation on each affected virtual desktop; you cannot adjust the VHD initial size in a catalog that is already created.

Ensure the VHD is big enough to store antivirus definition files, which are typically large.

Locate and set the following registry keys in HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\personal vDisk\Config. (Do not modify other settings in this registry key.) All settings must be specified on the master image (except for MinimumVHDSizeInMB, which can be changed on an individual machine); settings specified on the master image are applied during the next image update.

- **MinimumVHDSizeMB**
  Specifies the minimum size (in megabytes) of the application part (C:) of the personal vDisk. The new size must be greater than the existing size but less than the size of the disk minus PvDReservedSpaceMB.

  Increasing this value allocates free space from the profile part on the vDisk to C. This setting is ignored if a lower value than the current size of the C: drive is used, or if EnableDynamicResizeOfAppContainer is set to 0.

  Default = 2048

- **EnableDynamicResizeOfAppContainer**
  Enables or disables the dynamic resizing algorithm.
  - When set to 1, the application space (on C) is resized automatically when the free space on C: falls below 10%.
    Allowed values are 1 and 0. A restart is required to effect the resize.
When set to 0, the VHD size is determined according to the method used in XenDesktop versions earlier than 7.x
Default = 1

**EnableUserProfileRedirection**

Enables or disables redirecting the user's profile to the vDisk.
- When set to 1, PvD redirects users' profiles to the personal vDisk drive (P: by default). Profiles are generally redirected to P:\Users, corresponding to a standard Windows profile. This redirection preserves the profiles in case the PvD desktop must be reset.
- When set to 0, all of the space on the vDisk minus PvDReservedSpaceMB is allocated to C:, the application part of the vDisk, and the vDisk drive (P:) is hidden in Windows Explorer. Citrix recommends disabling redirection by setting the value to 0, when using Citrix Profile management or another roaming profile solution. This setting retains the profiles in C:\Users instead of redirecting them to the vDisk, and lets the roaming profile solution handle the profiles.

This value ensures that all of the space on P: is allocated to applications.

It is assumed that if this value is set to 0, a profile management solution is in place. Disabling profile redirection without a roaming profile solution in place is not recommended because subsequent PvD reset operations result in the profiles being deleted.

Do not change this setting when the image is updated because it does not change the location of existing profiles, but it will allocate all the space on the Personal vDisk to C: and hide the PvD.

Configure this value before deploying a catalog. You cannot change it after the catalog is deployed.

Important: Beginning with XenDesktop 7.1, changes to this value are not honored when you perform an image update. Set the key's value when you first create the catalogs from which the profiles will originate. You cannot modify the redirection behavior later.
Default = 1

**PercentOfPvDForApps**

Sets the split between the application part (C:) and the profile part of the vDisk. This value is used when creating new VMs, and during image updates when EnableDynamicResizeOfAppContainer is set to 0.

Changing PercentOfPvDForApps makes a difference only when EnableDynamicResizeOfAppContainer is set to 0. By default, EnableDynamicResizeOfAppContainer is set to 1 (enabled), which means that the AppContainer (which you see as the C drive) only expands when it is close to being full (that is, dynamic) - when less than 10% free space remains.

Increasing PercentOfPvDForApps only increases the maximum space for which the Apps portion is allowed to expand. It does not provision that space for you immediately. You must also configure the split allocation in the master image, where it will be applied during the next image update.

If you have already generated a catalog of machines with EnableDynamicResizeOfAppContainer set to 1, then change that setting to 0 in the master image for the next update, and configure an appropriate allocation split. The requested split size will be honored as long as it is larger than the current allocated size for the C drive.

If you want to maintain complete control over the space split, set this value to 0. This allows full control over the C drive size, and does not rely on a user consuming space below the threshold to expand the drive.

Default = 50% (allocates equal space to both parts)
- **PvDReservedSpaceMB**
  Specifies the size of the reserved space (in megabytes) on the vDisk for storing Personal vDisk logs and other data.

  If your deployment includes XenApp 6.5 (or an earlier version) and uses application streaming, increase this value by the size of the Rade Cache.

  Default = 512

- **PvDResetUserGroup**
  Valid only for XenDesktop 5.6 - Allows the specified group of users to reset a Personal vDisk. Later XenDesktop releases use Delegated Administration for this.

Other settings:

- **Windows Update Service** - Ensure that you set Windows updates to Never Check for Update and the Windows update service to Disabled in the master image. In the event Windows Update Service needs to run on the PvD, setting it to Never Check for Update helps prevent the updates from being installed on the associated machines. Windows 8 Store needs this service to run to install any Modern-style application.

- **Windows updates** - These include Internet Explorer updates and must be applied on the master image.

- **Updates requiring restarts** - Windows updates applied to the master image might require multiple restarts to fully install, depending on the type of patches delivered in those updates. Ensure you restart the master image properly to fully complete the installation of any Windows updates applied to it before taking the PvD inventory.

- **Application updates** - Update applications installed on the master image to conserve space on users' vDisks. This also avoids the duplicate effort of updating the applications on each user's vDisk.

Some software might conflict with the way that PvD composites the user's environment, so you must install it on the master image (rather than on the individual machine) to avoid these conflicts. In addition, although some other software might not conflict with the operation of PvD, Citrix recommends installing it on the master image.

Applications that must be installed on the master image:
- Agents and clients (for example, System Center Configuration Manager Agent, App-V client, Citrix Receiver)
- Applications that install or modify early-boot drivers
- Applications that install printer or scanner software or drivers
- Applications that modify the Windows network stack
- VM tools such as VMware Tools and XenServer Tools

Applications that should be installed on the master image:
- Applications that are distributed to a large number of users. In each case, turn off application updates before deployment:
  - Enterprise applications using volume licensing, such as Microsoft Office, Microsoft SQL Server
  - Common applications, such as Adobe Reader, Firefox, and Chrome
  - Large applications such as SQL Server, Visual Studio, and application frameworks such as .NET

The following recommendations and restrictions apply to applications installed by users on machines with personal vDisks. Some of these cannot be enforced if users have administrative privileges:
- Users should not uninstall an application from the master image and reinstall the same application on their personal vDisk.
- Take care when updating or un installing applications on the master image. After you install a version of an application on
the image, a user might install an add-on application (for example, a plug-in) that requires this version. If such a dependency exists, updating or uninstalling the application on the image might make the add-on malfunction. For example, with Microsoft Office 2010 installed on a master image, a user installs Visio 2010 on their personal vDisk. A later upgrade of Office on the master image might make the locally-installed Visio unusable.

- Software with hardware-dependent licenses (either through a dongle or signature-based hardware) is unsupported.

When using Provisioning Services with PvD:

- The Soap Service account must be added to the Administrator node of Studio and must have the Machine Administrator or higher role. This ensures that the PvD desktops are put into the Preparing state when the Provisioning Services (PVS) vDisk is promoted to production.
- The Provisioning Service versioning feature must be used to update the personal vDisk. When the version is promoted to production, the Soap Service puts the PvD desktops into the Preparing state.
- The personal vDisk size should always be larger than the Provisioning Services write cache disk (otherwise, Provisioning Services might erroneously select the personal vDisk for use as its write cache).
- After you create a Delivery Group, you can monitor the personal vDisk using the PvD Image Update Monitoring Tool or the Resize and poolstats scripts (personal-vdisk-poolstats.ps1).

Size the write cache disk correctly. During normal operation, PvD captures most user writes (changes) and redirects them to the personal vDisk. This implies that you can reduce the size of the Provisioning Services write cache disk. However, when PvD is not active (such as during image update operations), a small Provisioning Services write cache disk can fill up, resulting in machine crashes.

Citrix recommends that you size Provisioning Services write cache disks according to Provisioning Services best practice and add space equal to twice the size of the template VHD on the master image (to accommodate merge requirements). It is extremely unlikely that a merge operation will require all of this space, but it is possible.

When using Provisioning Services to deploy a catalog with PvD-enabled machines:

- Follow the guidance in the Provisioning Services documentation.
- You can change the power action throttling settings by editing the connection in Studio; see below.
- If you update the Provisioning Services vDisk, after you install/update applications and other software and restart the vDisk, run the PvD inventory and then shut down the VM. Then, promote the new version to Production. The PvD desktops in the catalog should automatically enter the Preparing state. If they do not, check that the Soap Service account has machine administrator or higher privileges on the Controller.

The Provisioning Services test mode feature enables you to create a test catalog containing machines using an updated master image. If tests confirm the test catalog's viability, you can promote it to production.

When using Machine Creation Services (MCS) to deploy a catalog with PvD-enabled machines:

- Follow the guidance in the XenDesktop documentation.
- Run a PvD inventory after you create the master image and then power off the VM (PvD will not function correctly if you do not power off the VM). Then, take a snapshot of the master image.
- In the Create Machine Catalog wizard, specify the personal vDisk size and drive letter.
- After you create a Delivery Group, you can monitor the personal vDisk using the PvD Image Update Monitoring Tool or the Resize and poolstats scripts (personal-vdisk-poolstats.ps1).
- You can change the power action throttling settings by editing the connection in Studio; see below.
- If you update the master image, run the PvD inventory after you update the applications and other software on the image, and then power off the VM. Then, take a snapshot of the master image.
- Use the PvD Image Update Monitoring Tool or the personal-vdisk-poolstats.ps1 script to validate that there is sufficient space on each PvD-enabled VM that will use the updated master image.
- After you update the machine catalog, the PvD desktops enter the Preparing state as they individually process the changes in the new master image. The desktops are updated according to the rollout strategy specified during the machine update.
- Use the PvD Image Update Monitoring Tool or the personal-vdisk-poolstats.ps1 script to monitor the PvD in the Preparing state.

Use the rules files to exclude files and folders from the vDisks. You can do this when the personal vDisks are in deployment. The rules files are named custom_*_rules.template.txt and are located in the \config folder. Comments in each file provide additional documentation.

When you enable PvD and after any update to the master image after installation, it is important to refresh the disk's inventory (called "run the inventory") and create a new snapshot.

Because administrators, not users, manage master images, if you install an application that places binary files in the administrator's user profile, the application is not available to users of shared virtual desktops (including those based on pooled machine catalogs and pooled with PvD machine catalogs). Users must install such applications themselves.

It is best practice to take a snapshot of the image after each step in this procedure.

1. Update the master image by installing any applications or operating system updates, and performing any system configuration on the machine.
   For master images based on Windows XP that you plan to deploy with Personal vDisks, check that no dialog boxes are open (for example, messages confirming software installations or prompts to use unsigned drivers). Open dialog boxes on master images in this environment prevent the VDA from registering with the Delivery Controller. You can prevent prompts for unsigned drivers using the Control Panel. For example, navigate to System > Hardware > Driver Signing, and select the option to ignore warnings.

2. Shut down the machine. For Windows 7 machines, click Cancel when Citrix Personal vDisk blocks the shutdown.
3. In the Citrix Personal vDisk dialog box, click Update Inventory. This step may take several minutes to complete.
   Important: If you interrupt the following shutdown (even to make a minor update to the image), the Personal vDisk's inventory no longer matches the master image. This causes the Personal vDisk feature to stop working. If you interrupt the shutdown, you must restart the machine, shut it down, and when prompted click Update Inventory again.
4. When the inventory operation shuts down the machine, take a snapshot of the master image.

You can export an inventory to a network share and then import that inventory to a master image. For details, see Export and import a PvD inventory.

The Citrix Broker Service controls the power state of the machines that provide desktops and applications. The Broker Service can control several hypervisors through a Delivery Controller. Broker power actions control the interaction between a Controller and the hypervisor. To avoid overloading the hypervisor, actions that change a machine's power state are assigned a priority and sent to the hypervisor using a throttling mechanism. The following settings affect the throttling.
To specify these values by editing a connection (Advanced page) in Studio.

To configure connection throttling values:
1. Select Configuration > Hosting in the Studio navigation pane.
2. Select the connection and then select Edit Connection in the Actions pane.
3. You can change the following values:
   - **Simultaneous actions (all types)** - The maximum number of simultaneous in-progress power actions allowed. This setting is specified as both an absolute value and as a percentage of the connection to the hypervisor. The lower of the two values is used.
     Default = 100 absolute, 20%
   - **Simultaneous Personal vDisk inventory updates** - The maximum number of simultaneous Personal vDisk power actions allowed. This setting is specified as both an absolute value and a percentage of the connection. The lower of the two values is used.
     Default = 50 absolute, 25%
   - **Maximum new actions per minute** - The maximum number of new power actions that can be sent to the hypervisor per minute. Specified as an absolute value.
     Default = 10

To calculate the absolute value: determine the total IOPS (rIOPS) supported by the end-user storage (this should be specified by the manufacturer or calculated). Using 350 IOPS per VM (IOPS/VM), determine the number of VMs that should be active at any given time on the storage. Calculate this value by dividing total IOPS by IOPS/VM.

For example, if the end-user storage is 14000 IOPS, the number of active VMs is 14000 IOPS / 350 IOPS/VM = 40.

To help identify optimal values for these settings in your deployment:
1. Using the default values, measure the total response time for an image update of a test catalog. This is the difference between the start of an image update (T1) and when the VDA on the last machine in the catalog registers with the Controller (T2). Total response time = T2 - T1.
2. Measure the input/output operations per second (IOPS) of the hypervisor storage during the image update. This data can serve as a benchmark for optimization. (The default values may be the best setting; alternatively, the system might max out of IOPS, which will require lowering the setting values.)
3. Change the “Simultaneous Personal vDisk inventory updates” value as described below (keeping all other settings unchanged).
   1. Increase the value by 10 and measure the total response time after each change. Continue to increase the value by 10 and test the result, until deterioration or no change in the total response time occurs.
   2. If the previous step resulted in no improvement by increasing the value, decrease the value in increments of 10 and measure the total response time after each decrease. Repeat this process until the total response time remains unchanged or does not improve further. This is likely the optimal PVD power action value.
4. After obtaining the PVD power action setting value, tweak the simultaneous actions (all types) and maximum new actions per minute values, one at a time. Follow the procedure described above (increasing or decreasing in increments) to test different values.

System Center Configuration Manager (Configuration Manager) 2012 requires no special configuration and can be installed in the same way as any other master image application. The following information applies only to System Center Configuration Manager 2007. Configuration Manager versions earlier than Configuration Manager 2007 are not supported.
Complete the following to use Configuration Manager 2007 agent software in a PvD environment.

1. Install the Client Agent on the master image.
   1. Install the Configuration Manager client on the master image.
   2. Stop the ccmexec service (SMS Agent) and disable it.
2. Delete SMS or client certificates from the local computer certificate store as follows:
   - Mixed mode: Certificates (Local Computer)\SMS\Certificates
   - Native mode
     - Certificates (Local Computer)\Personal\Certificates
   - Delete the client certificate that was issued by your certificate authority (usually, an internal Public Key Infrastructure)
3. Delete or rename C:\Windows\smscfg.ini
4. Delete or rename C:\Windows\smscfg.ini

2. Remove information that uniquely identifies the client.
   1. (Optional) Delete or move log files from C:\Windows\System32\CCM\Logs.
   2. Install the Virtual Delivery Agent (if not installed previously), and take the PvD inventory.
3. Validate personal vDisk and start services. Complete these steps once on each PvD desktop, after it has been started for the first time. This can be done using a domain GPO, for example.
   - Confirm that PvD is active by checking for the presence of the registry key HKLM\Software\Citrix\personal vDisk\config\virtual.
   - Set the ccmexec service (SMS agent) to Automatic and start the service. The Configuration Manager client contacts the Configuration Manager server, and retrieves new unique certificates and GUIDs.
Tools

Mar 02, 2017

You can use the following tools and utilities to tailor, expedite, and monitor PvD operations.

The custom rule files provided with PvD let you modify the default behavior of PvD image updates in the following ways:
- The visibility of files on the PvD
- How changes made to the files are merged
- Whether the files are writable

For detailed instructions on the custom rule files and the CoW feature, refer to the comments in the files located in C:\ProgramData\Citrix\personal vDisk\Config on the machine where PvD is installed. The files named "custom_*" describe the rules and how to enable them.

Two scripts are provided to monitor and manage the size of PvDs; they are located in the Support\Tools\Scripts folder on the XenDesktop installation media. You can also use the PvD Image Update Monitoring Tool, which is located in the Support\Tools\Scripts\PvdTool folder; see http://blogs.citrix.com/2014/06/02/introducing-the-pvd-image-update-monitoring-tool/ for details.

Use resize-personalvdisk-pool.ps1 to increase the size of the PvDs in all of the desktops in a catalog. The following snap-ins or modules for your hypervisor must be installed on the machine running Studio:
- XenServer requires XenServerPSSnapin
- vCenter requires vSphere PowerCli
- System Center Virtual Machine Manager requires the VMM console

Use personal-vdisk-poolstats.ps1 to check the status of image updates and to check the space for applications and user profiles in a group of PvDs. Run this script before updating an image to check whether any desktop is running out of space, which helps prevent failures during the update. The script requires that Windows Management Instrumentation (WMI-In) firewall is enabled on the PvD desktops. You can enable it on the master image or through GPO.

If an image update fails, the entry in the Update column gives the reason.

If a desktop becomes damaged or corrupted (by installing a broken application or some other cause), you can revert the application area of the PvD to a factory-default (empty) state. The reset operation leaves user profile data intact.

To reset the application area of the PvD, use one of the following methods:
- Log on to the user's desktop as Administrator. Launch a command prompt, and run the command C:\Program Files\Citrix\Personal vDisk\bin\CtxPvD.exe -s Reset.
- Locate the user's desktop in Citrix Director. Click Reset Personal vDisk and then click OK.

The image update process is an integral part of rolling out new images to PvD desktops; it includes adjusting the existing Personal vDisk to work with the new base image. For deployments that use Machine Creations Services (MCS), you can
export an inventory from an active VM to a network share, and then import it into a master image. A differential is calculated using this inventory in the master image. Although using the export/import inventory feature is not mandatory, it can improve the performance of the overall image update process.

To use the export/import inventory feature, you must be an administrator. If required, authenticate to the file share used for the export/import with “net use.” The user context must be able to access any file shares used for the export/import.

- To export an inventory, run the export command as an administrator on a machine containing a VDA with PvD enabled (minimum version 7.6):
  
  Ctxpvdsvc.exe exportinventory “<path-to-export-location>”

  The software detects the current inventory's location and exports the inventory to a folder named “ExportedPvdInventory” to the specified location. Here's an excerpt from the command output:

  C:\Program Files\Citrix\personal vDisk\bin> .\CtxPvDSvc.exe exportinventory
  \share location\ExportedInventory
  Current inventory source location C:\CitrixPvD\Settings\Inventory\VER-LAS
  ...
  Exporting current inventory to location \ ....
  ...
  Deleting any pre-existing inventory folder at \ ....
  .Successfully exported current inventory to location \ .... Error code = OPS

- To import a previously-exported inventory, run the import command as an administrator on the master image:

To import

Run the import command as an administrator on the master image.

Ctxpvdsvc.exe importinventory “<path-to-exported-inventory>”

The <path to exported inventory> should be the full path to the inventory files, which is usually <network location\ExportedPvdInventory>.

The inventory is obtained from the import location (where it was previously exported using the exportinventory option) and imports the inventory to the inventory store on the master image. Here's an excerpt of the command output:

C:\Program Files\Citrix\personal vDisk\bin> .\CtxPvDSvc.exe importinventory
\share location\ExportedInventory\ExportedPvdInventory
Importing inventory \share location\ExportedInventory\ExportedPvdInventory
...
Successfully added inventory \share location\ExportedInventory\ExportedPvdInventory to the store at c:\ProgramData\Citrix\personal vDisk\InventoryStore

After the export, the network share should include the following filenames. After the import, the inventory store on the master image should include the same file names.

- Components.DAT
- files_rules
- folders_rules
- regkey_rules
- RINGTHREE.DAT
- S-1-5-18.DAT
- SAM.DAT
- SECURITY.DAT
- SNAPSHOT.DAT
- SOFTWARE.DAT
- SYSTEM.CurrentControlSet.DAT
- VDCATALOG.DAT
- vDiskJournalData
Displays, messages, and troubleshooting

Dec 01, 2014

In Studio, when you choose a PvD-enabled machine in a machine catalog, the "PvD" tab provides monitoring status during image updates, plus estimated completion time and progress. The possible state displays during an image update are: Ready, Preparing, Waiting, Failed, and Requested.

An image update can fail for different reasons, including lack of space or a desktop not finding the PvD in sufficient time. When Studio indicates that an image update failed, an error code with descriptive text is provided to help troubleshooting. Use the Personal vDisk Image Update Monitoring Tool or the personal-vdisk-poolstats.ps1 script to monitor image update progress and obtain error codes associated with the failure.

If an image update fails, the following log files can provide further troubleshooting information:

- PvD service log - C:\ProgramData\Citrix\personal vDisk\Logs\PvDSvc.log.txt
- PvD activation log - P:\PVDLOGS\PvDActivation.log.txt

The most recent content is at the end of the log file.

The following errors are valid for PvD version 7.6 and later:

- **An internal error occurred. Review the Personal vDisk logs for further details. Error code %d (%s)**
  
  This is a catch-all for uncategorized errors, so it has no numeric value. All unexpected error encountered during inventory creation or Personal vDisk update are indicated by this error code.
  
  - Collect logs and contact Citrix support.
  
  - If this error occurs during catalog update, roll back the catalog to the previous version of the gold image.
  
- **There are syntax errors in the rule files. Review the logs for further details.**

  Error code 2. The rule file contains syntax errors. The Personal vDisk log file contains the name of the rule file and line number where the syntax error was found. Fix the syntax error in the rule file and retry the operation.

  - The inventory stored in the Personal vDisk corresponding to the previous version of the master image is corrupt or unreadable.

  Error code 3. The last inventory is stored in “UserData.V2.vhd” in “\ProgramData\CitrixPvD\Settings\Inventory\VER-LAST”. Restore the inventory corresponding to the last version of the master image by importing the ‘VER-LAST’ folder from a known working PvD machine associated with the previous version of the master image.

  - The inventory stored in the Personal vDisk corresponding to the previous version of the master image is higher version.

  Error code 4. This is caused by personal vDisk version incompatibility between the last master image and the current master image. Retry updating the catalog after installing the latest version of personal vDisk in the master image.

  - Change journal overflow was detected.

  Error code 5. A USN journal overflow was caused by a large number of changes made to the master image while creating the inventory. If this continues to occur after multiple attempts, use procmon to determine if third party software is creating/deleting a large number of files during inventory creation.

  - The Personal vDisk could not find a disk attached to the system for storing user data.

  Error code 6. First, verify that the PvD disk is attached to the VM through the hypervisor console. This error typically happens due to “Data Leak Prevention” software preventing access to the PvD disk. If the PvD disk is attached to the
VM, try adding an exception for “attached disk” in the “Data Leak Prevention” software configuration.

- **The system has not been reinstalled post-installation. Reboot to implement the changes.**
  Error code 7. Restart the desktop and retry the operation.

- **Corrupt installation. Try re-installing Personal vDisk.**
  Error code 8. Install personal vDisk and try again.

- **Personal vDisk inventory is not up to date. Update the inventory in the master image, and then try again.**
  Error code 9. The personal vDisk inventory was not updated in the master image before shutting down the desktop. Restart the master image and shut down the desktop through the “Update personal vDisk” option, and then create a new snapshot; use that snapshot to update the catalog.

- **An internal error occurred while starting the Personal vDisk. Review the Personal vDisk logs for further details.**
  Error code 10. This could be caused by the PvD driver failing to start a virtualization session due to an internal error or personal vDisk corruption. Try restarting the desktop through the Controller. If the problem persists, collect the logs and contact Citrix Support.

- **The Personal vDisk timed out while trying to find a storage dish for users' personalization settings.**
  Error code 11. This error occurs when the PvD driver fails to find the PvD disk within 30 seconds after restart. This is usually caused by an unsupported SCSI controller type or storage latency. If this occurs with all desktops in the catalog, change the SCSI controller type associated with the “Template VM” / “Master VM” to a type supported by personal vDisk technology. If this occurs with only some desktops in the catalog, it might be due to spikes in storage latency due to a large number of desktops starting at the same time. Try limiting the maximum active power actions setting associated with the host connection.

- **The Personal vDisk has been de-activated because an unsafe system shutdown was detected. Restart the machine.**
  Error code 12. This could be due to a desktop failing to complete the boot process with PvD enabled. Try restarting the desktop. If the problem persists, watch the desktop startup through the hypervisor console and check if the desktop is crashing. If a desktop crashes during startup, restore the PvD from backup (if you maintain one) or reset the PvD.

- **The drive letter specified for mounting the Personal vDisk is not available.**
  Error code 13. This could be caused by PvD failing to mount the PvD disk at the mount specified by the administrator. The PvD disk will fail to mount if the drive letter is already used by other hardware. Select a different letter as the mount point for the personal vDisk.

- **Personal vDisk kernel mode drivers failed to install.**
  Error code 14. Personal vDisk installs drivers during the first inventory update after installation. Some antivirus products prevent installation of the driver when attempted outside the context of an installer. Temporarily disable the antivirus real time scan or add exceptions in the antivirus for PvD drivers during the first time inventory creation.

- **Cannot create a snapshot of the system volume. Make sure that the Volume Shadow Copy service is enabled.**
  Error code 15. This could occur because the Volume Shadow Copy service is disabled. Enable the Volume Shadow Copy service and retry taking an inventory.

- **The change journal failed to activate. Try again after waiting for few minutes.**
  Error code 16. Personal vDisk uses change journal for tracking changes made to master image. During an inventory
update, if PvD detects that the change journal is disabled, it attempts to enable it; this error occurs when that attempt fails. Wait for few minutes and retry.

- **There is not enough free space in the system volume.**
  Error code 17. There is not enough free space available on the C drive of the desktop for the image update operation. Expand the system volume or removed unused files to free space in the system volume. The image update should begin again after the next restart.

- **There is not enough free space in the Personal vDisk storage. Expand Personal vDisk storage to provide more space.**
  Error code 18. There is not enough free space available on the personal vDisk drive when performing an image update operation. Expand personal vDisk storage or remove unused files to free space in the personal vDisk storage. The image update should restart after next reboot.

- **Personal vDisk storage is over-committed. Expand Personal vDisk storage to provide more space.**
  Error code 19. There is not enough free space available on the personal vDisk drive to fully accommodate thick provisioned “UserData.V2.vhd”. Expand the personal vDisk storage or remove unused files to free space in the personal vDisk storage.

- **Corrupt system registry.**
  Error code 20. The system registry is corrupt, damaged, missing, or unreadable. Reset the personal vDisk or restore it from an earlier backup.

- **An internal error occurred while resetting the Personal vDisk. Check Personal vDisk logs for further details.**
  Error code 21. This is a catch-all for all the errors encountered during a personal vDisk reset. Collect the logs and contact Citrix Support.

- **Failed to reset the Personal vDisk because there is not enough free space in the personal vDisk storage.**
  Error code 22. There is not enough free space available on the Personal vDisk drive when performing a reset operation. Expand the personal vDisk storage or remove unused files to free space in the personal vDisk storage.

The following errors are valid for PvD 7.x versions earlier than 7.6:

- **Startup failed. Personal vDisk was unable to find a storage disk for user personalization settings.**
  The PvD software could not find the Personal vDisk (by default, the P: drive) or could not mount it as the mount point selected by the administrator when they created the catalog.
  - Check the PvD service log for following entry: “PvD 1 status --> 18:183”.
  - If you are using a version of PvD earlier than Version 5.6.12, upgrading to the latest version resolves this issue.
  - If you are using Version 5.6.12 or later, use the disk management tool (diskmgmt.msc) to determine whether the P: drive is present as an unmounted volume. If present, run chkdsk on the volume to determine if it is corrupt, and try to recover it using chkdsk.

- **Startup failed. Citrix Personal vDisk failed to start. For further assistance .... Status code: 7, Error code: 0x70**
  Status code 7 implies that an error was encountered while trying to update the PvD. The error could be one of the following:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x20000001</td>
<td>Failed to save the diff package, most likely due to lack of free disk space inside the VHD.</td>
</tr>
<tr>
<td>Error code</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>0x20000004</td>
<td>Failed to acquire required privileges for updating the PvD.</td>
</tr>
<tr>
<td>0x20000006</td>
<td>Failed to load hive from the PVD image or from PVD inventory, most likely due to corrupt PVD image or inventory.</td>
</tr>
<tr>
<td>0x20000007</td>
<td>Failed to load the file system inventory, most likely due to a corrupt PVD image or inventory.</td>
</tr>
<tr>
<td>0x20000009</td>
<td>Failed to open the file containing file system inventory, most likely due to a corrupt PVD image or inventory.</td>
</tr>
<tr>
<td>0x2000000B</td>
<td>Failed to save the diff package, most likely due to lack of free disk space inside the VHD.</td>
</tr>
<tr>
<td>0x20000010</td>
<td>Failed to load the diff package.</td>
</tr>
<tr>
<td>0x20000011</td>
<td>Missing rule files.</td>
</tr>
<tr>
<td>0x20000021</td>
<td>Corrupt PVD inventory.</td>
</tr>
<tr>
<td>0x20000027</td>
<td>The catalog &quot;MojoControl.dat&quot; is corrupt.</td>
</tr>
<tr>
<td>0x2000002B</td>
<td>Corrupt or missing PVD inventory.</td>
</tr>
<tr>
<td>0x2000002F</td>
<td>Failed to register user installed MOF on image update, upgrade to 5.6.12 to fix the issue.</td>
</tr>
<tr>
<td>0x20000032</td>
<td>Check the PVDactivation.log.txt for the last log entry with a Win32 error code.</td>
</tr>
<tr>
<td>0x20</td>
<td>Failed to mount application container for image update, upgrade to 5.6.12 to fix the issue.</td>
</tr>
<tr>
<td>0x70</td>
<td>There is not enough space on the disk.</td>
</tr>
</tbody>
</table>

- **Startup failed. Citrix Personal vDisk failed to start [or Personal vDisk encountered an internal error]. For further assistance ... Status code: 20, Error code 0x20000028**

  The personal vDisk was found but a PVD session could not be created.

  Collect the logs and check SysVol-IvmSupervisor.log for session creation failures:
  1. Check for the following log entry " IvmpNativeSessionCreate: failed to create native session, status XXXXX".
  2. If the status is 0xc00002cf, fix the problem by adding a new version of the master image to the catalog. This status code implies that the USN Journal overflowed due to a large number of changes after an inventory update.
  3. Restart the affected virtual desktop. If the problem persists, contact Citrix Technical Support.

- **Startup failed. Citrix Personal vDisk has been deactivated because an unsafe system shutdown was detected. To retry, select Try again. If the problem continues, contact your system administrator.**
The pooled VM cannot complete its startup with the PvD enabled. First determine why startup cannot be completed. Possible reasons are that a blue screen appears because:

- An incompatible antivirus product is present, for example old versions of Trend Micro, in the master image.
- The user has installed software that is incompatible with PvD. This is unlikely, but you can check it by adding a new machine to the catalog and seeing whether it restarts successfully.
- The PvD image is corrupt. This has been observed in Version 5.6.5.

To check if the pooled VM is displaying a blue screen, or is restarting prematurely:

- Log on to the machine through the hypervisor console.
- Click Try Again and wait for the machine to shut down.
- Start the machine through Studio.
- Use the hypervisor console to watch the machine console as it starts.

Other troubleshooting:

- Collect the memory dump from the machine displaying the blue screen, and send it for further analysis to Citrix Technical Support.
- Check for errors in the event logs associated with the PvD:
  1. Mount UserData.V2.vhd from the root of the P: drive using DiskMgmt.msc by clicking Action > Attach VHD.
  2. Launch Eventvwr.msc.
  3. Open the system event log (Windows\System32\winevt\logs\system.evtx) from UserData.V2.vhd by clicking Action > Open saved logs.
  4. Open the application event log (Windows\System32\winevt\logs\application.evtx) from UserData.V2.vhd by clicking Action > Open saved logs.

- **The Personal vDisk cannot start. The Personal vDisk could not start because the inventory has not been updated. Update the inventory in the master image, then try again. Status code: 15, Error code: 0x0**
  
  The administrator selected an incorrect snapshot while creating or updating the PvD catalog (that is, the master image was not shut down using Update Personal vDisk when creating the snapshot).

If Personal vDisk is not enabled, you can view the following events in Windows Event Viewer. Select the Applications node in the left pane; the Source of the events in the right pane is Citrix Personal vDisk. If Personal vDisk is enabled, none of these events are displayed.

An Event ID of 1 signifies an information message, an ID of 2 signifies an error. Not all events may be used in every version of Personal vDisk.

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Personal vDisk Status: Update Inventory Started.</td>
</tr>
<tr>
<td>1</td>
<td>Personal vDisk Status: Update Inventory completed. GUID: %s.</td>
</tr>
<tr>
<td>1</td>
<td>Personal vDisk Status: Image Update Started.</td>
</tr>
<tr>
<td>1</td>
<td>Personal vDisk Status: Image Update completed.</td>
</tr>
<tr>
<td>1</td>
<td>Reset in progress.</td>
</tr>
<tr>
<td>Event ID</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2</td>
<td>Personal vDisk Status: Update Inventory Failed with: %s.</td>
</tr>
<tr>
<td>2</td>
<td>Personal vDisk Status: Image Update Failed with: %s.</td>
</tr>
<tr>
<td>2</td>
<td>Personal vDisk Status: Image Update Failed with Internal Error.</td>
</tr>
<tr>
<td>2</td>
<td>Personal vDisk Status: Update Inventory Failed with: Internal Error.</td>
</tr>
<tr>
<td>2</td>
<td>Personal vDisk has been disabled because of an improper shutdown.</td>
</tr>
<tr>
<td>2</td>
<td>Image update failed. Error code %d.</td>
</tr>
<tr>
<td>2</td>
<td>Personal vDisk encountered an internal error. Status code[%d] Error code[0x%X]</td>
</tr>
<tr>
<td>2</td>
<td>Personal vDisk reset failed.</td>
</tr>
<tr>
<td>2</td>
<td>Unable to find disk for storing user personalization settings.</td>
</tr>
<tr>
<td>2</td>
<td>There is not enough space available on the storage disk to create a Personal vDisk container.</td>
</tr>
</tbody>
</table>
Remove components

Sep 09, 2015
To remove components, Citrix recommends using the Windows feature for removing or changing programs. Alternatively, you can remove components using the command line, or a script on the installation media.

When you remove components, prerequisites are not removed, and firewall settings are not changed. When you remove a Controller, the SQL Server software and the databases are not removed.

Before removing a Controller, remove it from the Site. Before removing Studio or Director, Citrix recommends closing them.

If you upgraded a Controller from an earlier deployment that included Web Interface, you must remove the Web Interface component separately; you cannot use the installer to remove Web Interface.

From the Windows feature for removing or changing programs:
- To remove a Controller, Studio, Director, License Server, or StoreFront, select Citrix XenApp <version> or Citrix XenDesktop <version>, then right-click and select Uninstall. The installer launches, and you can select the components to be removed.
  Alternatively, you can remove StoreFront by right-clicking Citrix StoreFront and selecting Uninstall.
- To remove a VDA, select Citrix Virtual Delivery Agent <version>, then right-click and select Uninstall. The installer launches and you can select the components to be removed.
- To remove the Universal Print Server, select Citrix Universal Print Server, then right-click and select Uninstall.

From the \x64\XenDesktop Setup directory on the installation media, run the XenDesktopServerSetup.exe command.
- To remove one or more components, use the /remove and /components options.
- To remove all components, use the /removeall option.

For command and parameter details, see Install using the command line.

For example, the following command removes Studio.
\x64\XenDesktop Setup\XenDesktopServerSetup.exe /remove /components studio

From the \x64\XenDesktop Setup directory on the installation media, run the XenDesktopVdaSetup.exe command.
- To remove one or more components, use the /remove and /components options.
- To remove all components, use the /removeall option.

For command and parameter details, see Install using the command line.

For example, the following command removes the VDA and Receiver.
\x64\XenDesktop Setup\XenDesktopVdaSetup.exe /removeall
To remove VDAs using a script in Active Directory; see Install or remove Virtual Delivery Agents using scripts.
Upgrade and migrate

Feb 24, 2016

Upgrading changes deployments to the newest component versions without having to set up new machines or Sites; this is known as an in-place upgrade. You can upgrade:

- From XenDesktop version 5 (or a later version) to the current XenDesktop release
- From XenApp version 7.5 to the current XenApp release

You can also upgrade a XenApp 6.5 worker server to a current VDA for Windows Server OS. This is a supplementary activity to migrating XenApp 6.5.

To upgrade a XenDesktop 5 (or later) farm or a XenApp 7.5 Site:
1. Run the installer on the machines where the core components and VDAs are installed. The software determines if an upgrade is available and installs the newer version.
2. Use the newly upgraded Studio to upgrade the database and the Site.

For more information, see Upgrade a deployment.

For information about installing Controller hotfixes, see Knowledge Center article CTX201988.

To upgrade a XenApp 6.5 worker server to a current VDA:
1. Run the product installer on the XenApp 6.5 worker server. The software removes the server from the XenApp 6.5 farm, removes the XenApp 6.5 software, and installs a current VDA for Windows Server OS.
2. After upgrading the server, add it to Machine Catalogs and Delivery Groups in the current Site.

For more information, see Upgrade a XenApp 6.5 worker to a new VDA for Windows Server OS.

Migrating moves data from an earlier deployment to the newest version. You can migrate a XenApp 6.5 or a XenDesk 4 deployment. Migrating includes installing current components and creating a new Site, exporting data from the older farm, and then importing the data to the new Site.

To migrate from XenApp 6.5:
1. Install core components and create a new XenApp Site.
2. From the XenApp 6.5 controller, use PowerShell cmdlets to export policy and/or farm data to XML files. You can edit the XML file content to tailor the information you will import.
3. From the new Site, use PowerShell cmdlets and the XML files to import policy and/or application data to the new Site.

For more information, see Migrate XenApp 6.x.

To migrate from XenDesktop 4:
1. Install core components and create a new XenDesktop Site.
2. From the XenDesktop 4 farm, use the export command tool to export farm data to an XML file. You can edit the XML file content to tailor the information you will import.
3. From the new Site, use the import command tool and the XML file to import the farm data to the new Site.
For more information, see Migrate XenDesktop 4.
Upgrade a deployment

Aug 15, 2016

In this article:

- Introduction
- Which product component versions can be upgraded
- Requirements, limits, and preparation
- Mixed environment considerations
- VDAs on machines running Windows XP or Windows Vista
- VDAs on machines running Windows 8.x and Windows 7
- Mixed VDA support
- Upgrade sequence

Introduction

You can upgrade certain deployments to newer versions without having to first set up new machines or Sites; this is called an in-place upgrade. You can upgrade:

- From XenDesktop version 5 (or a later version) to the latest released (current) XenDesktop version
- From XenApp version 7.5 (or a later version) to the latest released (current) XenApp version

You can also use the current XenApp installer to upgrade a XenApp 6.5 worker server to a current VDA for Windows Server OS. This is a supplementary activity to migrating XenApp 6.5; see Upgrade a XenApp 6.5 worker to a new VDA for Windows Server OS.

To start an upgrade, you run the installer from the new version to upgrade previously installed core components (Delivery Controller, Citrix Studio, Citrix Director, Citrix License Server) and VDAs. The installer determines which components require upgrading and then starts the upgrade at your command. After upgrading the components, you use the newly upgraded Studio to upgrade the Site database and the Site.

In this content, the word product refers to XenApp 7.x or XenDesktop 7.x, unless otherwise noted.

Which product component versions can be upgraded

Using the product installer and Studio, you can upgrade:

- Delivery Controllers 5 or later
- VDA 5.0 SP1 or later
- Unlike earlier VDA releases, you must use the product installer to upgrade VDAs; you cannot use MSIs.
- If the installer detects Receiver for Windows (Receiver.exe) on the machine, it is upgraded to the Receiver version included on the product installation media.
- If the installer detects Receiver for Windows Enterprise (CitrixReceiverEnterprise.exe) on the machine, it is upgraded to Receiver for Windows Enterprise 3.4.
- Director 1 or later
Database: This upgrades the schema and migrates data for the Site database (plus the Configuration Logging and Monitoring databases, if you're upgrading from an earlier 7.x version)

Personal vDisk

Using the guidance in the feature/product documentation, upgrade the following if needed:

- Provisioning Services (for XenApp 7.x and XenDesktop 7.x, Citrix recommends using the latest released version; the minimum supported version is Provisioning Services 7.0).
- Upgrade the Provisioning Services server using the server rolling upgrade, and the clients using vDisk versioning.
- Provisioning Services 7.x does not support creating new desktops with XenDesktop 5 versions. So, although existing desktops will continue to work, you cannot use Provisioning Services 7.x to create new desktops until you upgrade XenDesktop. Therefore, if you plan a mixed environment of XenDesktop 5.6 and 7.x Sites, do not upgrade Provisioning Services to version 7.
- Microsoft System Center Virtual Machine Manager SCVMM. The current product supports SCVMM 2012 and SCVMM 2012 SP1; XenDesktop 5.x supports earlier versions. Use the following upgrade sequence to avoid downtime:
  1. If you have Controllers running versions earlier than XenDesktop 5.6 FP1, upgrade them to XenDesktop 5.6 FP1 (see the XenDesktop documentation for that version).
  2. Upgrade the SCVMM server to SCVMM 2012; see the Microsoft documentation for instructions.
  3. Upgrade XenDesktop components to the current version.
  4. Optionally, upgrade the SCVMM server to SCVMM 2012 SP1.
- StoreFront.

Requirements, limits, and preparation

- You must use the product installer's graphical or command-line interface to upgrade core components and VDAs; you cannot import or migrate data from an earlier version.
- If you install or upgrade any components to the new version but choose not to upgrade other components (on different machines) that require upgrade, Studio will remind you. For example, if an upgrade includes new versions of the Controller and Studio, and you upgrade only the Controller (but you do not run the installer on the machine where Studio is installed), Studio will not let you continue to manage the Site until you upgrade Studio.
- Before upgrading the Citrix License Server, be sure your Subscription Advantage date is valid for the new product version. If you are upgrading from an earlier 7.x product version, the date must be at least 2016.0217.
- You cannot upgrade XenDesktop Express Edition. Obtain and install a license for a currently supported edition, then upgrade it.
- Before beginning any upgrade activity, back up the database, as described in CTX135207, so you can restore it if any issues are discovered after the database upgrade.
- Optionally, back up templates and upgrade hypervisors, if used.
- If you must continue to run earlier version Sites and current version Sites, see Mixed environment considerations.
- If you have VDAs installed on Windows XP or Windows Vista machines, see VDAs on machines running Windows XP or Windows Vista.
- If you do not plan to upgrade all VDAs to the latest version, review Mixed VDA support.
- If your deployment includes Web Interface, Citrix recommends using StoreFront.
- In addition to being a domain user, you must be a local administrator on the machines where you are upgrading product components.
- Review the upgrade sequence below so you can plan for and mitigate potential outages.
You cannot upgrade:

- From an Early Release or Technology Preview version
- From a XenApp version earlier than 7.5 (except replacing XenApp 6.5 software on a server with a current VDA for Server OS; see Migrate XenApp 6.x)
- From a XenDesktop version earlier than 5.6; see Migrate XenDesktop 4

When you upgrade, you do not choose or specify the product (XenApp or XenDesktop), which was set during the initial installation.

**Mixed environment considerations**

When your environment contains Sites and farms with different product versions (a mixed environment), Citrix recommends using StoreFront to aggregate applications and desktops from different product versions (for example, if you have a XenDesktop 7.1 Site and a XenDesktop 7.5 Site). For details, see the StoreFront documentation.

- In a mixed environment, continue using the Studio and Director versions for each release within each Site, but make sure that different versions are installed on separate machines.
- If you plan to run XenDesktop 5.6 and 7.x Sites simultaneously and use Provisioning Services for both, either deploy a new Provisioning Services for use with the 7.x Site, or upgrade the current Provisioning Services and be unable to provision new workloads in the XenDesktop 5.6 Site.

Within each Site, Citrix recommends upgrading all components. Although you can use earlier versions of some components, all the features in the latest version might not be available. For example, although you can use current VDAs in deployments containing earlier Controller versions, new features in the current release may not be available. VDA registration issues can also occur when using non-current versions. See Mixed VDA considerations below.

- Sites with Controllers at version 5.x and VDAs at version 7.x should remain in that state only temporarily. Ideally, you should complete the upgrade of all components as soon as possible.
- Do not upgrade a standalone Studio version until you are ready to use the new version.

**VDAs on machines running Windows XP or Windows Vista**

You cannot upgrade VDAs installed on machines running Windows XP or Windows Vista to a 7.x version. You must use VDA 5.6 FP1 with certain hotfixes; see CTX140941 for instructions. Although earlier-version VDAs will run in a 7.x Site, they cannot use many of its features, including:

- Features noted in Studio that require a newer VDA version.
- Configuring App-V applications from Studio.
- Configuring Receiver StoreFront addresses from Studio.
- Automatic support for Microsoft Windows KMS licensing when using Machine Creation Services. See CTX128580.
- Information in Director:
  - Logon times and logon end events impacting the logon duration times in the Dashboard, Trends, and User Detail views.
Logon duration breakdown details for HDX connection and authentication time, plus duration details for profile load, GPO load, logon script, and interactive session establishment.

Several categories of machine and connection failure rates.

Activity Manager in the Help Desk and User Details views.

Citrix recommends reimaging Windows XP and Windows Vista machines to a supported operating system version and then installing the latest VDA.

**VDAs on machines running Windows 8.x and Windows 7**

To upgrade VDAs installed on machines running Windows 8.x or Windows 7 to Windows 10, Citrix recommends reimaging Windows 7 and Windows 8.x machines to Windows 10 and then installing the supported VDA for Windows 10. If reimaging is not an option, uninstall the VDA prior to upgrading the operating system, otherwise the VDA will be in an unsupported state.

**Mixed VDA support**

When you upgrade the product to a later version, Citrix recommends you upgrade all the core components and VDAs so you can access all the new and enhanced features in your edition. For example, to use the session prelaunch, session linger, and unauthenticated users features in the 7.6 release, the VDAs must have a minimum version of 7.6 installed.

In some environments, you may not be able to upgrade all VDAs to the most current version. In this scenario, when you create a machine catalog, you can specify the VDA version installed on the machines. By default, this setting specifies the latest recommended VDA version; you need to consider changing this setting only if the machine catalog contains machines with earlier VDA versions. However, mixing VDA versions in a machine catalog can have unintended effects.

As noted above, if your deployment includes Windows XP and Windows Vista systems, you must use an earlier VDA version, and the machine catalog containing those machines must specify VDA version 5.6 FP1. The VDAs will register successfully with the Controller, but those machines will be unable to use many of the new features in the 7.x versions (including StoreFront). This also applies to any machines you add to that catalog that have 7.x version VDAs. The following graphic illustrates this.

![Machine Catalog 01: VDA versions set to 5.6 FP1](image)

In the above case, if you must continue to use older VDAs, place them in a machine catalog by themselves.

If a machine catalog is created with the default recommended VDA version setting, and any of the machines in the catalog has an earlier VDA version installed, those machines will not be able to register with the Controller and will not work.
For example, assume the most recent VDA version is 7.6. You create a machine catalog with the default VDA setting: “7.6 (recommended, to access the latest features).” You add three machines to that catalog: two with VDA 7.6 and one with VDA 7.1.

In this example, the machine with VDA 7.1 will not register with the Controller. If you cannot upgrade that VDA, consider creating a separate machine catalog configured with a VDA setting of “version 7.0 or later” and adding that machine. Although that machine will not be able to take advantage of new 7.6 features, it will be able to register with the Controller.

Upgrade sequence

The upgrade sequence is illustrated below; descriptions follow. If components are installed on different machines, run the installer on each of those machines.
To run the product installer graphical interface, log on to the machine and then insert the media or mount the ISO drive for the new release. Double-click **AutoSelect**. To use the command-line interface, see Install using the command line.

1. If more than one core component is installed on the same server (for example, the Controller, Studio, and License Server) and several of those components have new versions available, they will all be upgraded when you run the installer on that server. If any core components are installed on machines other than the Controller, run the installer on each of those machines (in the preferred order: License Server, StoreFront, and then Director).
2. Upgrade the Provisioning Services servers and clients, using the guidance in the Provisioning Services documentation.
3. Run the product installer on machines containing VDAs. Although you can upgrade VDAs before or after upgrading the Controllers, Citrix recommends you do so before, because it allows you to quickly enable new features after the upgrade. When upgrading VDAs from an earlier 7.x version that are installed on physical machines (including Remote PC Access), use the command-line interface with the parameter: /EXCLUDE "Personal vDisk","Machine Identity Service". For example:

   C:\x64\XenDesktop Setup\XenDesktopVdaSetup.exe /EXCLUDE "Personal vDisk","Machine Identity Service"

4. Run the product installer on half of the Controllers. (This will also upgrade any other core components installed on those servers.) For example, if your Site has four Controllers, run the installer on two of them.
Leaving half of the Controllers active allows users to access the Site. VDAs can register with the remaining Controllers. There may be times when the Site has reduced capacity because fewer Controllers are available. The upgrade causes only a brief interruption in establishing new client connections during the final database upgrade steps. The upgraded Controllers cannot process requests until the entire Site is upgraded.

If your Site has only one Controller, the Site is inoperable during the upgrade.

5. If Studio is installed on a different machine than one of the Controllers you upgraded in the previous step, run the installer on the machine where Studio is installed.

6. From the newly upgraded Studio, upgrade the Site database. For details, see Upgrade the database and Site.

7. From the newly upgraded Studio, select Citrix Studio site-name in the navigation pane. Select the Common Tasks tab. Select Upgrade remaining Delivery Controllers.

8. After completing the upgrade and confirming completion, close and then reopen Studio.

9. In the Site Configuration section of the Common Tasks page, select Perform registration. Registering the Controllers makes them available to the Site.

10. After you select Finish when the upgrade completes, you are offered the opportunity to enroll in the Citrix Customer Experience Improvement Program (CEIP), which collects anonymous information about your deployment. That information is then used to improve product quality, reliability, and performance.

11. After upgrading components, the database, and the Site, use Studio to:
   - Test the newly-upgraded Site. From Studio, select Citrix Studio site-name in the navigation pane. Select the Common Tasks tab and then select Test Site. These tests were run automatically after you upgraded the database, but you can run them again at any time.
   - Update all master images that use the upgraded VDA.
   - Upgrade Machine Catalogs and Delivery Groups.

After upgrading the core components and VDAs, use the newly upgraded Studio to initiate an automatic or manual database and Site upgrade.

• For an automatic database upgrade, the Studio user's permissions must include the ability to update the SQL Server database schema (for example, the db_securityadmin or db_owner database role). For details, see the Databases article.
• If the Studio user does not have those permissions, initiating a manual database upgrade will generate scripts. The Studio user runs some of the scripts from Studio; the database administrator runs other scripts using a tool such as SQL Server Management Studio. If the SQL scripts are run manually, they should be run using either the SQLCMD utility or using the SQL Management Studio in SQLCMD mode. Inaccurate errors may result otherwise.

Important: Citrix strongly recommends you back up the database before upgrading, as described in CTX135207. During a database upgrade, product services are disabled. During that time, Controllers cannot broker new connections for the Site, so plan carefully.

After the database upgrade completes and product services are enabled, Studio tests the environment and configuration, and then generates an HTML report. If problems are identified, you can restore the database backup. After resolving issues, you can upgrade the database again.

Upgrade the database and Site automatically: Launch the newly upgraded Studio. After you choose to start the Site upgrade automatically and confirm that you are ready, the database and Site upgrade proceeds.

Upgrade the database and Site manually: This process includes generating and running scripts.
1. Launch the newly upgraded Studio. After you choose to manually upgrade the Site, the wizard checks for License Server compatibility and requests confirmation. After you confirm that you have backed up the database, the wizard generates
and displays the scripts and a checklist of upgrade steps.

2. Run the following scripts in the order shown:

<table>
<thead>
<tr>
<th>Script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisableServices.ps1</td>
<td>PowerShell script to be run by the Studio user on a Controller to disable product services.</td>
</tr>
<tr>
<td>UpgradeSiteDatabase.sql</td>
<td>SQL script to be run by the database administrator on the server containing the Site database, using a tool such as SQL Server Management Studio.</td>
</tr>
<tr>
<td>UpgradeMonitorDatabase.sql</td>
<td>SQL script to be run by the database administrator on the server containing the Monitor database, using a tool such as SQL Server Management Studio.</td>
</tr>
<tr>
<td>UpgradeLoggingDatabase.sql</td>
<td>SQL script to be run by the database administrator on the server containing the Configuration Logging database, using a tool such as SQL Server Management Studio. Run this script only if this database changes (for example, after applying a hotfix).</td>
</tr>
<tr>
<td>EnableServices.ps1</td>
<td>PowerShell script to be run by the Studio user on a Controller to enable product services.</td>
</tr>
</tbody>
</table>

3. After you complete the displayed checklist tasks, select **Finish upgrade**.
Upgrade a XenApp 6.5 worker to a new VDA

Aug 25, 2014

When you run the current product installer on a XenApp 6.5 worker server, it:

- Removes the server from the XenApp 6.5 farm (this task automatically invokes the XenApp 6.5 installer's command-line interface)
- Removes the XenApp 6.5 software
- Installs a new (XenApp 7.6 or later supported release) VDA for Windows Server OS

When you use the installer's graphical interface, you are guided through the same wizard that you used when installing VDAs for Windows Server OS in your new XenApp Site. Similarly, the command-line interface uses the same commands and parameters you use to install other VDAs.

**NOTE:** Although you can upgrade a XenApp 6.5 worker server, installing the current VDA software on a clean machine provides better security.

You are probably already familiar with using the installer from installing your XenApp core components and other VDAs. Launch the installer (Install using the graphical interface) or issue the command (Install a VDA using the command line) on the XenApp 6.5 worker server.

**Good to know:**

- This upgrade is valid on XenApp 6.5 servers that are configured in session-host only mode (also called session-only or worker servers).
- Uninstalling XenApp 6.5 requires several server restarts. When using the command-line interface, you can use the /NOREBOOT option to inhibit that automatic action; however, you must restart the server for the uninstallation and subsequent installation to proceed.
- If an error occurs during the XenApp uninstallation process, check the uninstall error log referenced in the error message. Uninstall log files reside in the folder "%TEMP%\Citrix\XenDesktop Installation\XenApp 6.5 Uninstall Log Files."
- After the upgrade, review IMA-specific settings and registry entries, plus HDX-related system settings and registries. Some settings may no longer apply or might not work in the same way.
- After you upgrade the XenApp 6.5 worker servers, from Studio in the new XenApp Site, create Machine Catalogs (or edit existing catalogs) for the upgraded workers.
- If you migrated policy and application settings from a XenApp 6.5 controller server (see Migrate XenApp 6.x), assign the Delivery Groups containing the migrated published applications to the machine catalog that hosted those applications in XenApp 6.5.

**Symptoms:** Removal of the XenApp 6.5 software fails. The uninstall log contains the message: "Error 25703. An error occurred while plugging XML into Internet Information Server. Setup cannot copy files to your IIS Scripts directory. Please make sure that your IIS installation is correct."

**Cause:** The issue occurs on systems where (1) during the initial XenApp 6.5 installation, you indicated that the Citrix XML Service (CtxHttp.exe) should not share a port with IIS, and (2).NET Framework 3.5.1 is installed.

**Resolution:**

1. Remove the Web Server (IIS) role using the Windows Remove Server Roles wizard. (You can reinstall the Web Server (IIS) role later.)
2. Restart the server.
3. Using Add/Remove Programs, uninstall the following:
   1. Citrix XenApp 6.5
   2. Microsoft Visual C++ 2005 Redistributable (x64), version 8.0.56336
4. Restart the server.
5. Run the XenApp installer to install the VDA for Windows Server OS.
Migrate XenApp 6.x

Sep 01, 2015

Important: Review this entire article before beginning a migration.

The XenApp 6.x Migration Tool (the migration tool) is a collection of PowerShell scripts containing cmdlets that migrate XenApp 6.x (6.0 or 6.5) policy and farm data. On the XenApp 6.x controller server, you run export cmdlets that gather that data into XML files. Then, from the XenApp 7.6 Controller, you run import cmdlets that create objects using the data gathered during the export.

A video overview of the migration tool is available here.

The following sequence summarizes the migration process; details are provided later.

1. On a XenApp 6.0 or 6.5 controller:
   1. Import the PowerShell export modules.
   2. Run the export cmdlets to export policy and/or farm data to XML files.
2. Copy the XML files (and icons folder if you chose not to embed them in the XML files during the export) to the XenApp 7.6 Controller.
3. On the XenApp 7.6 Controller:
   1. Import the PowerShell import modules.
   2. Run the import cmdlets to import policy and/or farm data (applications), using the XML files as input.
4. Complete post-migration steps.

Before you run an actual migration, you can export your XenApp 6.x settings and then perform a preview import on the XenApp 7.6 site. The preview identifies possible failure points so you can resolve issues before running the actual import. For example, a preview might detect that an application with the same name already exists in the new XenApp 7.6 site. You can also use the log files generated from the preview as a migration guide.

Unless otherwise noted, the term 6.x refers to XenApp 6.0 or 6.5.

This December 2014 release (version 20141125) contains the following updates:

- If you encounter issues using the migration tool on a XenApp 6.x farm, report them to the support forum http://discussions.citrix.com/forum/1411-xenapp-7x/, so that Citrix can investigate them for potential improvements to the tool.
- New packaging - the XAMigration.zip file now contains two separate, independent packages: ReadIMA.zip and ImportFMA.zip. To export from a XenApp 6.x server, you need only ReadIMA.zip. To import to a XenApp 7.6 server, you...
need only ImportFMA.zip.

* The Export-XAFarm cmdlet supports a new parameter (EmbedIconData) that eliminates the need to copy icon data to separate files.
* The Import-XAFarm cmdlet supports three new parameters:
  * MatchServer - import applications from servers whose names match an expression
  * NotMatchServer - import applications from servers whose names do not match an expression
  * IncludeDisabledApps - import disabled applications
* Prelaunched applications are not imported.
* The Export-Policy cmdlet works on XenDesktop 7.x.

The migration tool is available under the XenApp 7.6 Citrix download site. The XAMigration.zip file contains two separate, independent packages:

* ReadIMA.zip - contains the files used to export data from your XenApp 6.x farm, plus shared modules.

<table>
<thead>
<tr>
<th>Module or file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExportPolicy.psm1</td>
<td>PowerShell script module for exporting XenApp 6.x policies to an XML file.</td>
</tr>
<tr>
<td>ExportXAFarm.psm1</td>
<td>PowerShell script module for exporting XenApp 6.x farm settings to an XML file.</td>
</tr>
<tr>
<td>ExportPolicy.psd1</td>
<td>PowerShell manifest file for script module ExportPolicy.psm1.</td>
</tr>
<tr>
<td>ExportXAFarm.psd1</td>
<td>PowerShell manifest file for script module ExportXAFarm.psm1.</td>
</tr>
<tr>
<td>LogUtilities.psm1</td>
<td>Shared PowerShell script module that contains logging functions.</td>
</tr>
<tr>
<td>XmlUtilities.psm1</td>
<td>Shared PowerShell script module that contains XML functions.</td>
</tr>
<tr>
<td>XmlUtilities.psd1</td>
<td>PowerShell manifest file for script module XmlUtilities.psm1.</td>
</tr>
</tbody>
</table>

* ImportFMA.zip - contains the files used to import data to your XenApp 7.6 farm, plus shared modules.

<table>
<thead>
<tr>
<th>Module or file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ImportPolicy.psm1</td>
<td>PowerShell script module for importing policies to XenApp 7.6.</td>
</tr>
<tr>
<td>ImportXAFarm.psm1</td>
<td>PowerShell script module for importing applications to XenApp 7.6</td>
</tr>
<tr>
<td>ImportPolicy.psd1</td>
<td>PowerShell manifest file for script module ImportPolicy.psm1.</td>
</tr>
<tr>
<td>ImportXAFarm.psd1</td>
<td>PowerShell manifest file for script module ImportXAFarm.psm1.</td>
</tr>
<tr>
<td>Module or file</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PolicyData.xsd</td>
<td>XML schema for policy data.</td>
</tr>
<tr>
<td>XAFarmData.xsd</td>
<td>XML schema for XenApp farm data.</td>
</tr>
<tr>
<td>LogUtilities.psm1</td>
<td>Shared PowerShell script module that contains logging functions.</td>
</tr>
<tr>
<td>XmlUtilities.psd1</td>
<td>PowerShell manifest file for script module XmlUtilities.psm1.</td>
</tr>
<tr>
<td>XmlUtilities.psm1</td>
<td>Shared PowerShell script module that contains XML functions.</td>
</tr>
</tbody>
</table>

- Not all policies settings are imported; see Policy settings not imported. Settings that are not supported are ignored and noted in the log file.
- While all application details are collected in the output XML file during the export operation, only server-installed applications are imported into the XenApp 7.6 site. Published desktops, content, and most streamed applications are not supported (see the Import-XAFarm cmdlet parameters in Step-by-step: import data for exceptions).
- Application servers are not imported.
- Many application properties are not imported because of differences between the XenApp 6.x Independent Management Architecture (IMA) and the XenApp 7.6 FlexCast Management Architecture (FMA) technologies; see Application property mapping.
- A Delivery Group is created during the import. See Advanced use for details about using parameters to filter what is imported.
- Only Citrix policy settings created with the AppCenter management console are imported; Citrix policy settings created with Windows Group Policy Objects (GPOs) are not imported.
- The migration scripts are intended for migrations from XenApp 6.x to XenApp 7.6 only.
- Nested folders greater than five levels deep are not supported by Studio and will not be imported. If your application folder structure includes folders more than five levels deep, consider reducing the number of nested folder levels before importing.

The XML files created by the export scripts can contain sensitive information about your environment and organization, such as user names, server names, and other XenApp farm, application, and policy configuration data. Store and handle these files in secure environments.

Carefully review the XML files before using them as input when importing policies and applications, to ensure they contain no unauthorized modifications.

Policy object assignments (previously known as policy filters) control how policies are applied. After importing the policies, carefully review the object assignments for each policy to ensure that there are no security vulnerabilities resulting from the import. Different sets of users, IP addresses, or client names may be applied to the policy after the import. The allow/deny settings may have different meanings after the import.

The scripts provide extensive logging that tracks all cmdlet executions, informative messages, cmdlet execution results,
warnings, and errors.

- Most Citrix PowerShell cmdlet use is logged. All PowerShell cmdlets in the import scripts that create new site objects are logged.
- Script execution progress is logged, including the objects being processed.
- Major actions that affect the state of the flow are logged, including flows directed from the command line.
- All messages printed to the console are logged, including warnings and errors.
- Each line is time-stamped to the millisecond.

Citrix recommends specifying a log file when you run each of the export and import cmdlets.

If you do not specify a log file name, the log file is stored in the current user's home folder (specified in the PowerShell $HOME variable) if that folder exists; otherwise, it is placed in the script's current execution folder. The default log name is "XFarmYYYYMMDDHHmmSS-xxxxxx" where the last six digits constitute a random number.

By default, all progress information is displayed. To suppress the display, specify the NoDetails parameter in the export and import cmdlet.

Generally, a script stops execution when an error is encountered, and you can run the cmdlet again after clearing the error conditions.

Conditions that are not considered errors are logged; many are reported as warnings, and script execution continues. For example, unsupported application types are reported as warnings and are not imported. Applications that already exist in the XenApp 7.6 site are not imported. Policy settings that are deprecated in XenApp 7.6 are not imported.

The migration scripts use many PowerShell cmdlets, and all possible errors might not be logged. For additional logging coverage, use the PowerShell logging features. For example, PowerShell transcripts log everything that is printed to the screen. For more information, see the help for the Start-Transcript and Stop-Transcript cmdlets.

Important: Remember to review this entire article before beginning a migration. You should understand basic PowerShell concepts about execution policy, modules, cmdlets, and scripts. Although extensive scripting expertise is not required, you should understand the cmdlets you execute. Use the Get-Help cmdlet to review each migration cmdlet’s help before executing it. For example:

`Get-Help -full Import-XAFarm`

Specify a log file on the command line and always review the log file after running a cmdlet. If a script fails, check and fix the error identified in the log file and then run the cmdlet again.

**Good to know:**

- To facilitate application delivery while two deployments are running (the XenApp 6.x farm and the new XenApp 7.6 site), you can aggregate both deployments in StoreFront or Web Interface. See the eDocs documentation for your StoreFront or Web Interface release (Manage > Create a store).
- Application icon data is handled in one of two ways:
  - If you specify the EmbedIconData parameter in the Export-XAFarm cmdlet, exported application icon data is embedded in the output XML file.
  - If you do not specify the EmbedIconData parameter in the Export-XAFarm cmdlet, exported application icon data is stored under a folder named by appending the string "-icons" to the base name of the output XML file. For example, if the XmlOutputFile parameter is "FarmData.xml" then the folder "FarmData-icons" is created to store the application icons.
    The icon data files in this folder are .txt files that are named using the browser name of the published application
(although the files are .txt files, the stored data is encoded binary icon data, which can be read by the import script to re-create the application icon). During the import operation, if the icon folder is not found in the same location as the import XML file, generic icons are used for each imported application.

- The names of the script modules, manifest files, shared module, and cmdlets are similar. Use tab completion with care to avoid errors. For example, Export-XAFarm is a cmdlet. ExportXAFarm.psd1 and ExportXAFarm.psm1 are files that cannot be executed.
- In the step-by-step sections below, most <string> parameter values show surrounding quotation marks. These are optional for single-word strings.

For exporting from the XenApp 6.x server:
- The export must be run on a XenApp 6.x server configured with the controller and session-host (commonly known as controller) server mode.
- To run the export cmdlets, you must be a XenApp administrator with permission to read objects. You must also have sufficient Windows permission to run PowerShell scripts; the step-by-step procedures below contain instructions.
- Ensure the XenApp 6.x farm is in a healthy state before beginning an export. Back up the farm database. Verify the farm's integrity using the Citrix IMA Helper utility (CTX133983): from the IMA Datastore tab, run a Master Check (and then use the DSCh eck option to resolve invalid entries). Repairing issues before the migration helps prevent export failures. For example, if a server was removed improperly from the farm, its data might remain in the database; that could cause cmdlets in the export script to fail (for example, Get-XAServer -ZoneName). If the cmdlets fail, the script fails.
- You can run the export cmdlets on a live farm that has active user connections; the export scripts read only the static farm configuration and policy data.

For importing to the XenApp 7.6 server:
- You can import data to XenApp 7.6 deployments (and later supported versions). You must install a XenApp 7.6 Controller and Studio, and create a site before importing the data you exported from the XenApp 6.x farm. Although VDAs are not required to import settings, they allow application file types to be made available.
- To run the import cmdlets, you must be a XenApp administrator with permission to read and create objects. A Full Administrator has these permissions. You must also have sufficient Windows permission to run PowerShell scripts; the step-by-step procedures below contain instructions.
- No other user connections should be active during an import. The import scripts create many new objects, and disruptions may occur if other users are changing the configuration at the same time.

Remember that you can export data and then use the -Preview parameter with the import cmdlets to see what would happen during an actual import, but without actually importing anything. The logs will indicate exactly what would happen during an actual import; if errors occur, you can resolve them before starting an actual import.

A video of an export walk-through is available here.

Complete the following steps to export data from a XenApp 6.x controller to XML files.

1. Download the XAMigration.zip migration tool package from the Citrix download site. For convenience, place it on a network file share that can be accessed by both the XenApp 6.x farm and the XenApp 7.6 site. Unzip XAMigration.zip on the network file share. There should be two zip files: ReadIMA.zip and ImportFMA.zip.
2. Log on to the XenApp 6.x controller as a XenApp administrator with at least read-only permission and Windows permission to run PowerShell scripts.
3. Copy ReadIMA.zip from the network file share to the XenApp 6.x controller. Unzip and extract ReadIMA.zip on the controller to a folder (for example: C:\XAMigration).
4. Open a PowerShell console and set the current directory to the script location. For example:
   ```
   cd C:\XAMigration
   ```
5. Check the script execution policy by running `Get-ExecutionPolicy`.
6. Set the script execution policy to at least RemoteSigned to allow the scripts to be executed. For example:
   ```
   Set-ExecutionPolicy RemoteSigned
   ```
7. Import the module definition files ExportPolicy.psd1 and ExportXAFarm.psd1:
   ```
   Import-Module \ExportPolicy.psd1
   Import-Module \ExportXAFarm.psd1
   ```

   **Good to know:**
   - If you intend to export only policy data, you can import only the ExportPolicy.psd1 module definition file. Similarly, if you intend to export only farm data, import only ExportXAFarm.psd1.
   - Importing the module definition files also adds the required PowerShell snap-ins.
   - Do not import the .psm1 script files.
8. To export policy data, run the `Export-Policy` cmdlet.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-XmlOutputFile</td>
<td>XML output file name; this file will hold the exported data. Must have an .xml extension. The file must not exist, but if a path is specified, the parent path must exist.</td>
</tr>
<tr>
<td>-LogFile</td>
<td>Log file name. An extension is optional. The file is created if it does not exist. If the file exists and the NoClobber parameter is also specified, an error is generated; otherwise, the file's content is overwritten.</td>
</tr>
<tr>
<td>-NoLog</td>
<td>Do not generate log output. This overrides the LogFile parameter if it is also specified.</td>
</tr>
<tr>
<td>-NoClobber</td>
<td>Do not overwrite an existing log file specified in the LogFile parameter. If the log file does not exist, this parameter has no effect.</td>
</tr>
<tr>
<td>-NoDetails</td>
<td>Do not send detailed reports about script execution to the console.</td>
</tr>
<tr>
<td>-SuppressLogo</td>
<td>Do not print the message &quot;XenApp 6.x to XenApp/XenDesktop 7.6 Migration Tool Version #yyyyMMdd-hhmm#&quot; to the console. This message, which identifies the script version, can be helpful during troubleshooting; therefore, Citrix recommends omitting this parameter.</td>
</tr>
</tbody>
</table>

   **Parameter details**
   - See Logging and error handling

   **https://docs.citrix.com** © 1999-2017 Citrix Systems, Inc. All rights reserved.
Example: The following cmdlet exports policy information to the XML file named MyPolicies.xml. The operation is logged to the file named MyPolicies.log.

```
Export-Policy -XmlOutputFile "\MyPolicies.XML"
-LogFile "\MyPolicies.Log"
```

9. To export farm data, run the Export-XAFarm cmdlet, specifying a log file and an XML file.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| -XmlOutputFile "<string>.xml" | XML output file name; this file will hold the exported data. Must have an .xml extension. The file must not exist, but if a path is specified, the parent path must exist.  
Default: None; this parameter is required. |
| -LogFile "<string>"       | Log file name. An extension is optional. The file is created if it does not exist. If the file exists and the NoClobber parameter is also specified, an error is generated; otherwise, the file's content is overwritten.  
Default: See Logging and error handling |
| -NoLog                   | Do not generate log output. This overrides the LogFile parameter if it is also specified.  
Default: False; log output is generated |
| -NoClobber                | Do not overwrite an existing log file specified in the LogFile parameter. If the log file does not exist, this parameter has no effect.  
Default: False; an existing log file is overwritten |
| -NoDetails                | Do not send detailed reports about script execution to the console.  
Default: False; detailed reports are sent to the console |
| -SuppressLogo            | Do not print the message "XenApp 6.x to XenApp/XenDesktop 7.6 Migration Tool Version #yyyyMMdd-hhmm#" to the console. This message, which identifies the script version, can be helpful during troubleshooting; therefore, Citrix recommends omitting this parameter.  
Default: False; the message is printed to the console |
| -IgnoreAdmins             | Do not export administrator information. See Advanced use for how-to-use information.  
Default: False; administrator information is exported |
| -IgnoreApps               | Do not export application information. See Advanced use for how-to-use information.  
Default: False; application information is exported |
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-IgnoreServers</td>
<td>Do not export server information. Default: False; server information is exported</td>
</tr>
<tr>
<td>-IgnoreZones</td>
<td>Do not export zone information. Default: False; zone information is exported.</td>
</tr>
<tr>
<td>-IgnoreOthers</td>
<td>Do not export information such as configuration logging, load evaluators, load balancing policies, printer drivers, and worker groups. Default: False; other information is exported. Note: The purpose of the -IgnoreOthers switch is to allow you to proceed with an export when an error exists that would not affect the actual data being used for the exporting or importing process.</td>
</tr>
<tr>
<td>-AppLimit &lt;integer&gt;</td>
<td>Number of applications to be exported. See Advanced use for how-to-use information. Default: All applications are exported</td>
</tr>
<tr>
<td>-EmbedIconData</td>
<td>Embed application icon data in the same XML file as the other objects. Default: Icons are stored separately. See Requirements, preparation, and best practices for details</td>
</tr>
<tr>
<td>-SkipApps &lt;integer&gt;</td>
<td>Number of applications to be skipped. See Advanced use for how-to-use information. Default: No applications are skipped</td>
</tr>
</tbody>
</table>

#### Example

The following cmdlet exports farm information to the XML file named MyFarm.xml. The operation is logged to the file MyFarm.log. A folder named "MyFarm-icons" is created to store the application icon data files; this folder is at the same location as MyFarm.XML.

```powershell
Export-XAFarm -XmlOutputFile "\MyFarm.XML" -LogFile "\MyFarm.Log"
```

After the export scripts complete, the XML files specified on the command lines contain the policy and XenApp farm data. The application icon files contain icon data files, and the log file indicate what occurred during the export.

A video of an import walk-through is available [here](https://docs.citrix.com). Remember that you can run a preview import (by issuing the Import-Policy or Import-XAFarm cmdlet with the Preview parameter) and review the log files before performing an actual import.

Complete the following steps to import data to a XenApp 7.6 site, using the XML files generating from the export.
1. Log on to the XenApp 7.6 controller as an administrator with read-write permission and Windows permission to run PowerShell scripts.

2. If you have not unzipped the migration tool package XAMigration on the network file share, do so now. Copy ImportFMA.zip from the network file share to the XenApp 7.6 Controller. Unzip and extract ImportFMA.zip on the Controller to a folder (for example: C:\XAMigration).

3. Copy the XML files (the output files generated during the export) from the XenApp 6.x controller to the same location on the XenApp 7.6 Controller where you extracted the ImportFMA.zip files. If you chose not to embed the application icon data in the XML output file when you ran the Export-XAFarm cmdlet, be sure to copy the icon data folder and files to the same location on the XenApp 7.6 controller as the output XML file containing the application data and the extracted ImportFMA.zip files.

4. Open a PowerShell console and set the current directory to the script location.
   cd C:\XAMigration

5. Check the script execution policy by running Get-ExecutionPolicy.

6. Set the script execution policy to at least RemoteSigned to allow the scripts to be executed. For example:
   Set-ExecutionPolicy RemoteSigned

7. Import the PowerShell module definition files ImportPolicy.psd1 and ImportXAFarm.psd1:
   Import-Module \ImportPolicy.psd1
   Import-Module \ImportXAFarm.psd1

   Good to know:
   - If you intend to import only policy data, you can import only the ImportPolicy.psd1 module definition file. Similarly, if you intend to import only farm data, import only ImportXAFarm.psd1.
   - Importing the module definition files also adds the required PowerShell snap-ins. Do not import the .psm1 script files.

8. To import policy data, run the Import-Policy cmdlet, specifying the XML file containing the exported policy data.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-XmlInputFile &quot;&lt;string&gt;.xml&quot;</td>
<td>XML input file name; this file contains data collected from running the Export-Policy cmdlet. Must have an .xml extension. Default: None; this parameter is required.</td>
</tr>
<tr>
<td>-XsdFile &quot; &lt;string&gt;&quot;</td>
<td>XSD file name. The import scripts use this file to validate the syntax of the XML input file. See Advanced use for how-to-use information. Default: PolicyData.XSD</td>
</tr>
<tr>
<td>-LogFile &quot; &lt;string&gt;&quot;</td>
<td>Log file name. If you copied the export log files to this server, consider using a different log file name with the import cmdlet. Default: See Logging and error handling</td>
</tr>
<tr>
<td>-NoLog</td>
<td>Do not generate log output. This overrides the LogFile parameter, if it is also specified. Default: False; log output is generated</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-NoClobber</td>
<td>Do not overwrite an existing log file specified in the LogFile parameter. If the log file does not exist, this parameter has no effect.</td>
</tr>
<tr>
<td></td>
<td>Default: False; an existing log file is overwritten</td>
</tr>
<tr>
<td>-NoDetails</td>
<td>Do not send detailed reports about script execution to the console.</td>
</tr>
<tr>
<td></td>
<td>Default: False; detailed reports are sent to the console</td>
</tr>
<tr>
<td>-SuppressLogo</td>
<td>Do not print the message &quot;XenApp 6.x to XenApp/XenDesktop 7.6 Migration Tool Version #yyyyMMdd-hhmm#&quot; to the console. This message, which identifies the script version, can be helpful during troubleshooting; therefore, Citrix recommends omitting this parameter.</td>
</tr>
<tr>
<td></td>
<td>Default: False; the message is printed to the console</td>
</tr>
<tr>
<td>-Preview</td>
<td>Perform a preview import: read data from the XML input file, but do not import objects to the site. The log file and console indicate what occurred during the preview import. A preview shows administrators what would happen during a real import.</td>
</tr>
<tr>
<td></td>
<td>Default: False; a real import occurs</td>
</tr>
</tbody>
</table>

Example: The following cmdlet imports policy data from the XML file named MyPolicies.xml. The operation is logged to the file named MyPolicies.log.

9. To import applications, run the Import-XAFarm cmdlet, specifying a log file and the XML file containing the exported farm data.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-XmlInputFile &quot;&lt;string&gt;.xml&quot;</td>
<td>XML input file name; this file contains data collected from running the Export-XAFarm cmdlet. Must have an .xml extension.</td>
</tr>
<tr>
<td></td>
<td>Default: None; this parameter is required.</td>
</tr>
<tr>
<td>-XsdFile &quot;&lt;string&gt;&quot;</td>
<td>XSD file name. The import scripts use this file to validate the syntax of the XML input file. See Advanced use for how-to-use information.</td>
</tr>
<tr>
<td></td>
<td>Default: XAFarmData.XSD</td>
</tr>
<tr>
<td>-LogFile &quot;&lt;string&gt;&quot;</td>
<td>Log file name. If you copied the export log files to this server, consider using a different log file name with the import cmdlet.</td>
</tr>
<tr>
<td></td>
<td>Default: See Logging and error handling</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NoLog</td>
<td>Do not generate log output. This overrides the LogFile parameter, if it is also specified.</td>
</tr>
<tr>
<td>-NoClobber</td>
<td>Do not overwrite an existing log file specified in the LogFile parameter. If the log file does not exist, this parameter has no effect.</td>
</tr>
<tr>
<td>-NoDetails</td>
<td>Do not send detailed reports about script execution to the console.</td>
</tr>
<tr>
<td>-SuppressLogo</td>
<td>Do not print the message &quot;XenApp 6.x to XenApp/XenDesktop 7.6 Migration Tool Version #yyyyMMdd-hhmm#&quot; to the console. This message, which identifies the script version, can be helpful during troubleshooting; therefore, Citrix recommends omitting this parameter.</td>
</tr>
<tr>
<td>-Preview</td>
<td>Perform a preview import: read data from the XML input file, but do not import objects to the site. The log file and console indicate what occurred during the preview import. A preview shows administrators what would happen during a real import.</td>
</tr>
<tr>
<td>-DeliveryGroupName &quot;&lt;string&gt;&quot;</td>
<td>Delivery Group name for all imported applications. See Advanced use for how-to-use information.</td>
</tr>
<tr>
<td>-MatchFolder &quot;&lt;string&gt;&quot;</td>
<td>Import only those applications in folders with names that match the string. See Advanced use for how-to-use information.</td>
</tr>
<tr>
<td>-NotMatchFolder &quot;&lt;string&gt;&quot;</td>
<td>Import only those applications in folders with names that do not match the string. See Advanced use for how-to-use information.</td>
</tr>
<tr>
<td>-MatchServer &quot;&lt;string&gt;&quot;</td>
<td>Import only those applications from servers whose names match the string. See Advanced use for how-to-use information.</td>
</tr>
<tr>
<td>-NotMatchServer &quot;&lt;string&gt;&quot;</td>
<td>Import only those applications from servers whose names do not match the string. See Advanced use for how-to-use information.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default: No matching occurs</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>-MatchWorkerGroup &quot;&lt;string&gt;&quot;</td>
<td>Import only those applications published to worker groups with names that match the string. See Advanced use for how-to-use information. Default: No matching occurs</td>
</tr>
<tr>
<td>-NotMatchWorkerGroup &quot;&lt;string&gt;&quot;</td>
<td>Import only those applications published to worker groups with names that do not match the string. See Advanced use for how-to-use information. Default: No matching occurs</td>
</tr>
<tr>
<td>-MatchAccount &quot;&lt;string&gt;&quot;</td>
<td>Import only those applications published to user accounts with names that match the string. See Advanced use for how-to-use information. Default: No matching occurs</td>
</tr>
<tr>
<td>-NotMatchAccount &quot;&lt;string&gt;&quot;</td>
<td>Import only those applications published to user accounts with names that do not match the string. See Advanced use for how-to-use information. Default: No matching occurs</td>
</tr>
<tr>
<td>-IncludeStreamedApps</td>
<td>Import applications of type &quot;StreamedToClientOrServerInstalled&quot;. (No other streamed applications are imported.) Default: Streamed applications are not imported</td>
</tr>
<tr>
<td>-IncludeDisabledApps</td>
<td>Import applications that have been marked as disabled. Default: Disabled applications are not imported</td>
</tr>
</tbody>
</table>

Example: The following cmdlet imports applications from the XML file named MyFarm.xml. The operation is logged to the file named MyFarm.log.
Import-XAFarm -XmlInputFile ".\MyFarm.XML" -LogFile "\MyFarm.Log"

10. After the import completes successfully, complete the post-migration tasks.

After successfully importing XenApp 6.x policies and farm settings into a XenApp 7.6 site, use the following guidance to ensure that the data has been imported correctly.

- Policies and policy settings
  Importing policies is essentially a copy operation, with the exception of deprecated settings and policies, which are not imported. The post-migration check essentially involves comparing the two sides.
1. The log file lists all the policies and settings imported and ignored. First, review the log file and identify which settings and policies were not imported.

2. Compare the XenApp 6.x policies with the policies imported to XenApp 7.6. The values of the settings should remain the same (except for deprecated policy settings, as noted in the next step).
   - If you have a small number of policies, you can perform a side-by-side visual comparison of the policies displayed in the XenApp 6.x AppCenter and the policies displayed in the XenApp 7.6 Studio.
   - If you have a large number of policies, a visual comparison might not be feasible. In such cases, use the policy export cmdlet (Export-Policy) to export the XenApp 7.6 policies to a different XML file, and then use a text diff tool (such as windiff) to compare that file’s data to the data in the XML file used during the policy export from XenApp 6.x.

3. Use the information in the Policy settings not imported section to determine what might have changed during the import. If a XenApp 6.x policy contains only deprecated settings, as a whole policy, it is not imported. For example, if a XenApp 6.x policy contains only HMR test settings, that policy is completely ignored because there is no equivalent setting supported in XenApp 7.6.

   Some XenApp 6.x policy settings are no longer supported, but the equivalent functionality is implemented in XenApp 7.6. For example, in XenApp 7.6, you can configure a restart schedule for Server OS machines by editing a Delivery Group; this functionality was previously implemented through policy settings.

4. Review and confirm how filters will apply to your XenApp 7.6 site versus their use in XenApp 6.x; significant differences between the XenApp 6.x farm and the XenApp 7.6 site could change the effect of filters.

   - Filters

   Carefully examine the filters for each policy. Changes may be required to ensure they still work in XenApp 7.6 as originally intended in XenApp 6.x.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control</td>
<td>Access Control should contain the same values as the original XenApp 6.x filters and should work without requiring changes.</td>
</tr>
<tr>
<td>Citrix CloudBridge</td>
<td>A simple Boolean; should work without requiring changes.</td>
</tr>
<tr>
<td>Client IP Address</td>
<td>Lists client IP address ranges; each range is either allowed or denied. The import script preserves the values, but they may require changes if different clients connect to the XenApp 7.6 VDA machines.</td>
</tr>
<tr>
<td>Client Name</td>
<td>Similar to the Client IP Address filter, the import script preserves the values, but they may require changes if different clients connect to the XenApp 7.6 VDA machines.</td>
</tr>
</tbody>
</table>
   | Organizational Unit| Values might be preserved, depending on whether or not the OUs can be resolved at the time they are imported. Review this filter closely, particularly if the XenApp 6.x and XenApp 7.6 machines reside in different domains. If you do not configure the filter values correctly, the policy may be applied to an incorrect set of OUs.
<p>|                   | The OUs are represented by names only, so there is a small chance that an OU name will be resolved to an OU containing different members from the OUs in the XenApp 6.x domain. Even if |</p>
<table>
<thead>
<tr>
<th>Filter</th>
<th>Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>User or Group</td>
<td>Some of the values of the OU filter are preserved, you should carefully review the values. Values might be preserved, depending on whether or not the accounts can be resolved at the time they are imported. Similar to OUs, the accounts are resolved using names only, so if the XenApp 7.6 site has a domain with the same domain and user names, but are actually two different domains and users, the resolved accounts could be different from the XenApp 6.x domain users. If you do not properly review and modify the filter values, incorrect policy applications can occur.</td>
</tr>
<tr>
<td>Worker Group</td>
<td>Worker groups are not supported in XenApp 7.6. Consider using the Delivery Group, Delivery Group Type, and Tag filters, which are supported in XenApp 7.6 (not in XenApp 6.x).</td>
</tr>
<tr>
<td></td>
<td>• Delivery Group: Allows policies to be applied based on Delivery Groups. Each filter entry specifies a Delivery Group and can be allowed or denied.</td>
</tr>
<tr>
<td></td>
<td>• Delivery Group Type: Allows policies to be applied based on the Delivery Group types. Each filter specifies a Delivery Group type that can be allowed or denied.</td>
</tr>
<tr>
<td></td>
<td>• Tag: Specifies policy application based on tags created for the VDA machines. Each tag can be allowed or denied.</td>
</tr>
</tbody>
</table>

To recap, filters that involve domain user changes require the most attention if the XenApp 6.x farm and the XenApp 7.6 site are in different domains. Because the import script uses only strings of domain and user names to resolve users in the new domain, some of the accounts might be resolved and others might not. While there is only a small chance that different domains and users have the same name, you should carefully review these filters to ensure they contain correct values.

**Applications**

The application importing scripts do not just import applications; they also create objects such as Delivery Groups. If the application import involves multiple iterations, the original application folder hierarchies can change significantly.

1. First, read the migration log files that contain details about which applications were imported, which applications were ignored, and the cmdlets that were used to create the applications.
2. For each application:
   - Visually check to ensure the basic properties were preserved during the import. Use the information in the Application property mapping section to determine which properties were imported without change, not imported, or initialized using the XenApp 6.x application data.
   - Check the user list. The import script automatically imports the explicit list of users into the application's limit visibility list in XenApp 7.6. Check to ensure that the list remains the same.
3. Application servers are not imported. This means that none of the imported applications can be accessed yet. The Delivery Groups that contain these applications must be assigned machine catalogs that contain the machines that have the published applications' executable images. For each application:
   - Ensure that the executable name and the working directory point to an executable that exists in the machines assigned to the Delivery Group (through the machine catalogs).
   - Check a command line parameter (which may be anything, such as file name, environment variable, or executable name). Verify that the parameter is valid for all the machines in the machine catalogs assigned to the Delivery Group.

**Log files**

The log files are the most important reference resources for an import and export. This is why existing log files are not
overwritten by default, and default log file names are unique.

As noted in the “Logging and error handling” section, if you chose to use additional logging coverage with the PowerShell Start-Transcript and Stop-Transcript cmdlets (which record everything typed and printed to the console), that output, together with the log file, provides a complete reference of import and export activity.

Using the time stamps in the log files, you can diagnose certain problems. For example, if an export or import ran for a very long time, you could determine if a faulty database connection or resolving user accounts took most of the time.

The commands recorded in the log files also tell you how some objects are read or created. For example, to create a Delivery Group, several commands are executed to not only create the Delivery Group object itself, but also other objects such as access policy rules that allow application objects to be assigned to the Delivery Group.

The log file can also be used to diagnose a failed export or import. Typically, the last lines of the log file indicate what caused the failure; the failure error message is also saved in the log file. Together with the XML file, the log file can be used to determine which object was involved in the failure.

After reviewing and testing the migration, you can:

1. Upgrade your XenApp 6.5 worker servers to current Virtual Delivery Agents (VDAs) by running the 7.6 installer on the server, which removes the XenApp 6.5 software and then automatically installs a current VDA. See Upgrade a XenApp 6.5 worker to a new VDA for Windows Server OS for instructions.

For XenApp 6.0 worker servers, you must manually uninstall the XenApp 6.0 software from the server. You can then use the 7.6 installer to install the current VDA. You cannot use the 7.6 installer to automatically remove the XenApp 6.0 software.

2. From Studio in the new XenApp site, create machine catalogs (or edit existing catalogs) for the upgraded workers.

3. Add the upgraded machines from the machine catalog to the Delivery Groups that contain the applications installed on those VDAs for Windows Server OS.

By default, the Export-Policy cmdlet exports all policy data to an XML file. Similarly, Export-XAFarm exports all farm data to an XML file. You can use command line parameters to more finely control what is exported and imported.

- **Export applications partially** - If you have a large number of applications and want to control how many are exported to the XML file, use the following parameters:
  - **AppLimit** - Specifies the number of applications to export.
  - **SkipApps** - Specifies the number of applications to skip before exporting subsequent applications.

You can use both of these parameters to export large quantities of applications in manageable chunks. For example, the first time you run Export-XAFarm, you want to export only the first 200 applications, so you specify that value in the AppLimit parameter.

```
Export-XAFarm -XmlOutputFile "Apps1-200.xml" -AppLimit "200"
```

The next time you run Export-XAFarm, you want to export the next 100 applications, so you use the SkipApps parameter to disregard the applications you've already exported (the first 200), and the AppLimit parameter to export the next 100 applications.

```
Export-XAFarm -XmlOutputFile "Apps201-300.xml" -AppLimit "100" -SkipApps "200"
```

- **Do not export certain objects** - Some objects can be ignored and thus do not need to be exported, particularly those objects that are not imported; see Policy settings not imported and Application property mapping. Use the
following parameters to prevent exporting unneeded objects:

- **IgnoreAdmins** - Do not export administrator objects
- **IgnoreServers** - Do not export server objects
- **IgnoreZones** - Do not export zone objects
- **IgnoreOthers** - Do not export configuration logging, load evaluator, load balancing policy, printer driver, and worker group objects
- **IgnoreApps** - Do not export applications; this allows you to export other data to an XML output file and then run the export again to export applications to a different XML output file.

You can also use these parameters to work around issues that could cause the export to fail. For example, if you have a bad server in a zone, the zone export might fail; if you include the IgnoreZones parameter, the export continues with other objects.

- **Delivery Group names** - If you do not want to put all of your applications into one Delivery Group (for example, because they are accessed by different sets of users and published to different sets of servers), you can run Import-XAFarm multiple times, specifying different applications and a different Delivery Group each time. Although you can use PowerShell cmdlets to move applications from one Delivery Group to another after the migration, importing selectively to unique Delivery Groups can reduce or eliminate the effort of moving the applications later.
1. Use the DeliveryGroupName parameter with the Import-XAFarm cmdlet. The script creates the specified Delivery Group if it doesn't exist.
2. Use the following parameters with regular expressions to filter the applications to be imported into the Delivery Group, based on folder, worker group, user account, and/or server names. Enclosing the regular expression in single or double quotation marks is recommended. For information about regular expressions, see http://msdn.microsoft.com/en-us/library/hs600312(v=vs.110).aspx.
   - **MatchWorkerGroup** and **NotMatchWorkerGroup** - For example, for applications published to worker groups, the following cmdlet imports applications in the worker group named “Productivity Apps” to a XenApp 7.6 Delivery Group of the same name:
     ```powershell
     Import-XAFarm -XmlInputFile XAFarm.xml -LogFile XAFarmImport.log -MatchWorkerGroup 'Productivity Apps' -DeliveryGroupName 'Productivity Apps'
     ```
   - **MatchFolder** and **NotMatchFolder** - For example, for applications organized in application folders, the following cmdlet imports applications in the folder named “Productivity Apps” to a XenApp 7.6 Delivery Group of the same name.
     ```powershell
     Import-XAFarm -XmlInputFile XAFarm.xml -LogFile XAFarmImport.log -MatchFolder 'Productivity Apps' -DeliveryGroupName 'Productivity Apps'
     ```
   For example, the following cmdlet imports applications in any folder whose name contains “MS Office Apps” to the default Delivery Group.
     ```powershell
     Import-XAFarm -XmlInputFile .\TheFarmApps.XML -LogFile XAFarmImport.log -MatchFolder ".*/MS Office Apps/.*"
     ```
   - **MatchAccount** and **NotMatchAccount** - For example, for applications published to Active Directory users or user groups, the following cmdlet imports applications published to the user group named “Finance Group” to a XenApp 7.6 Delivery Group named “Finance.”
     ```powershell
     Import-XAFarm -XmlInputFile XAFarm.xml -LogFile XAFarmImport.log -MatchAccount 'DOMAIN\Finance Group' -DeliveryGroupName 'Finance'
     ```
   - **MatchServer** and **NotMatchServer** - For example, for applications organized on servers, the following cmdlet imports applications associated with the server not named “Current” to a XenApp Delivery Group named “Legacy.”
     ```powershell
     Import-XAFarm -XmlInputFile XAFarm.xml -LogFile XAFarmImport.log -NotMatchServer 'Current' -DeliveryGroupName 'Legacy'
     ```
   - **Customization** - PowerShell programmers can create their own tools. For example, you can use the export script as an inventory tool to keep track of changes in a XenApp 6.x farm. You can also modify the XSD files or create your own XSD...
files) to store additional data or data in different formats in the XML files. You can specify a nondefault XSD file with each of the import cmdlets.

Note: Although you can modify script files to meet specific or advanced migration requirements, support is limited to the scripts in their unmodified state. Citrix Technical Support will recommend reverting to the unmodified scripts to determine expected behavior and provide support, if necessary.

- If you are using PowerShell version 2.0 and you added the Citrix Group Policy PowerShell Provider snap-in or the Citrix Common Commands snap-in using the Add-PSSnapIn cmdlet, you might see the error message "Object reference not set to an instance of an object" when you run the export or import cmdlets. This error does not affect script execution and can be safely ignored.
- Avoid adding or removing the Citrix Group Policy PowerShell Provider snap-in in the same console session where the export and import script modules are used, because those script modules automatically add the snap-in. If you add or remove the snap-in separately, you might see one of the following errors:
  - "A drive with the name 'LocalGpo' already exists." This error appears when the snap-in is added twice; the snap-in attempts to mount the drive LocalGpo when it's loaded, and then reports the error.
  - "A parameter cannot be found that matches parameter name 'Controller'." This error appears when the snap-in has not been added but the script attempts to mount the drive. The script is not aware that the snap-in was removed. Close the console and launch a new session. In the new session, import the script modules; do not add or remove the snap-in separately.
- When importing the modules, if you right-click a .psd1 file and select Open or Open with PowerShell, the PowerShell console window will rapidly open and close until you stop the process. To avoid this error, enter the complete PowerShell script module name directly in the PowerShell console window (for example, Import-Module .\ExportPolicy.psd1).
- If you receive a permission error when running an export or import, ensure you are a XenApp administrator with permission to read objects (for export) or read and create objects (for import). You must also have sufficient Windows permission to run PowerShell scripts.
- If an export fails, check that the XenApp 6.x farm is in a healthy state by running the DSMAINT and DSCHECK utilities on the XenApp 6.x controller server.
- If you run a preview import and then later run the import cmdlets again for an actual migration, but discover that nothing was imported, verify that you removed the Preview parameter from the import cmdlets.

The following computer and user policy settings are not imported because they are no longer supported. Please note, unfiltered policies are never imported. The features and components that support these settings have either been replaced by new technologies/components or the settings do not apply because of architectural and platform changes.

**Computer policy settings not imported**

- Connection access control
- CPU management server level
- DNS address resolution
- Farm name
- Full icon caching
- Health monitoring, Health monitoring tests
- License server host name, License server port
- Limit user sessions, Limits on administrator sessions
- Load evaluator name
Logging of logon limit events
- Maximum percent of servers with logon control
- Memory optimization, Memory optimization application exclusion list, Memory optimization interval, Memory optimization schedule: day of month, Memory optimization schedule: day of week, Memory optimization schedule: time
- Offline app client trust, Offline app event logging, Offline app license period, Offline app users
- Prompt for password
- Reboot custom warning, Reboot custom warning text, Reboot logon disable time, Reboot schedule frequency, Reboot schedule randomization interval, Reboot schedule start date, Reboot schedule time, Reboot warning interval, Reboot warning start time, Reboot warning to users, Scheduled reboots
- Shadowing *
- Trust XML requests (configured in StoreFront)
- Virtual IP adapter address filtering, Virtual IP compatibility programs list, Virtual IP enhanced compatibility, Virtual IP filter adapter addresses programs list
- Workload name
- XML service port

* Replaced with Windows Remote Assistance

**User policy settings not imported**
- Auto connect client COM ports, Auto connect client LPT ports
- Client COM port redirection, Client LPT port redirection
- Client printer names
- Concurrent logon limit
- Input from shadow connections *
- Linger disconnect timer interval, Linger terminate timer interval
- Log shadow attempts *
- Notify user of pending shadow connections *
- Pre-launch disconnect timer interval, Pre-launch terminate timer interval
- Session importance
- Single Sign-On, Single Sign-On central store
- Users who can shadow other users, Users who cannot shadow other users *

* Replaced with Windows Remote Assistance

The following application types are not imported.
- Server desktops
- Content
- Streamed applications (App-V is the new method used for streaming applications)

The farm data import script imports only applications. The following application properties are imported without change.

<table>
<thead>
<tr>
<th>IMA Property</th>
<th>FMA Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddToClientDesktop</td>
<td>ShortcutAddedToDesktop</td>
</tr>
</tbody>
</table>
Note: IMA and FMA have different restrictions on folder name length. In IMA, the folder name limit is 256 characters; the FMA limit is 64 characters. When importing, applications with a folder path containing a folder name of more than 64 characters are skipped. The limit applies only to the folder name in the folder path; the entire folder path can be longer than the limits noted. To avoid applications from being skipped during the import, Citrix recommends checking the application folder name length and shortening it, if needed, before exporting.

The following application properties are initialized or uninitialized by default, or set to values provided in the XenApp 6.x data:

<table>
<thead>
<tr>
<th>FMA Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Initialized to the full path name, which contains the IMA properties FolderPath and DisplayName, but stripped of the leading string &quot;Applications&quot;</td>
</tr>
<tr>
<td>ApplicationType</td>
<td>HostedOnDesktop</td>
</tr>
<tr>
<td>CommandLineArguments</td>
<td>Initialized using the XenApp 6.x command line arguments</td>
</tr>
<tr>
<td>IconFromClient</td>
<td>Uninitialized; defaults to false</td>
</tr>
<tr>
<td>IconUid</td>
<td>Initialized to an icon object created using XenApp 6.x icon data</td>
</tr>
<tr>
<td>FMA Property</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>SecureCmdLineArgumentsEnabled</td>
<td>Uninitialized; defaults to true</td>
</tr>
<tr>
<td>UserFilterEnabled</td>
<td>Uninitialized; defaults to false</td>
</tr>
<tr>
<td>UUID</td>
<td>Read-only, assigned by the Controller</td>
</tr>
<tr>
<td>Visible</td>
<td>Uninitialized; defaults to true</td>
</tr>
</tbody>
</table>

The following application properties are partially migrated:

<table>
<thead>
<tr>
<th>IMA Property</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileTypes</td>
<td>Only the file types that exist on the new XenApp site are migrated. File types that do not exist on the new site are ignored. File types are imported only after the file types on the new site are updated.</td>
</tr>
<tr>
<td>IconData</td>
<td>New icon objects are created if the icon data has been provided for the exported applications.</td>
</tr>
<tr>
<td>Accounts</td>
<td>The user accounts of an application are split between the user list for the Delivery Group and the application. Explicit users are used to initialize the user list for the application. In addition, the “Domain Users” account for the domain of the user accounts is added to the user list for the Delivery Group.</td>
</tr>
</tbody>
</table>

The following XenApp 6.x properties are not imported:

<table>
<thead>
<tr>
<th>IMA Property</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApplicationType</td>
<td>Ignored.</td>
</tr>
<tr>
<td>HideWhenDisabled</td>
<td>Ignored.</td>
</tr>
<tr>
<td>AccessSessionConditions</td>
<td>Replaced by Delivery Group access policies.</td>
</tr>
<tr>
<td>AccessSessionConditionsEnabled</td>
<td>Replaced by Delivery Group access policies.</td>
</tr>
<tr>
<td>ConnectionsThroughAccessGatewayAllowed</td>
<td>Replaced by Delivery Group access policies.</td>
</tr>
<tr>
<td>OtherConnectionsAllowed</td>
<td>Replaced by Delivery Group access policies.</td>
</tr>
<tr>
<td>AlternateProfiles</td>
<td>FMA does not support streamed applications.</td>
</tr>
<tr>
<td>OfflineAccessAllowed</td>
<td>FMA does not support streamed applications.</td>
</tr>
<tr>
<td>IMA Property</td>
<td>Comments</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ProfileLocation</td>
<td>FMA does not support streamed applications.</td>
</tr>
<tr>
<td>ProfileProgramArguments</td>
<td>FMA does not support streamed applications.</td>
</tr>
<tr>
<td>ProfileProgramName</td>
<td>FMA does not support streamed applications.</td>
</tr>
<tr>
<td>RunAsLeastPrivilegedUser</td>
<td>FMA does not support streamed applications.</td>
</tr>
<tr>
<td>AnonymousConnectionsAllowed</td>
<td>FMA uses a different technology to support unauthenticated (anonymous) connections.</td>
</tr>
<tr>
<td>ApplicationId, SequenceNumber</td>
<td>IMA-unique data.</td>
</tr>
<tr>
<td>AudioType</td>
<td>FMA does not support advanced client connection options.</td>
</tr>
<tr>
<td>EncryptionLevel</td>
<td>SecureICA is enabled/disabled in Delivery Groups.</td>
</tr>
<tr>
<td>EncryptionRequired</td>
<td>SecureICA is enabled/disabled in Delivery Groups.</td>
</tr>
<tr>
<td>SslConnectionEnabled</td>
<td>FMA uses a different TLS implementation.</td>
</tr>
<tr>
<td>ContentAddress</td>
<td>FMA does not support published content.</td>
</tr>
<tr>
<td>ColorDepth</td>
<td>FMA does not support advanced window appearances.</td>
</tr>
<tr>
<td>MaximizedOnStartup</td>
<td>FMA does not support advanced window appearances.</td>
</tr>
<tr>
<td>TitleBarHidden</td>
<td>FMA does not support advanced window appearances.</td>
</tr>
<tr>
<td>WindowsType</td>
<td>FMA does not support advanced window appearances.</td>
</tr>
<tr>
<td>InstanceLimit</td>
<td>FMA does not support application limits.</td>
</tr>
<tr>
<td>MultipleInstancesPerUserAllowed</td>
<td>FMA does not support application limits.</td>
</tr>
<tr>
<td>LoadBalancingApplicationCheckEnabled</td>
<td>FMA uses a different technology to support load balancing.</td>
</tr>
<tr>
<td>PreLaunch</td>
<td>FMA uses a different technology to support session prelaunch.</td>
</tr>
<tr>
<td>IMA Property</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>CachingOption</td>
<td>EMA uses a different technology to support session prelaunch.</td>
</tr>
<tr>
<td>ServerNames</td>
<td>FMA uses a different technology.</td>
</tr>
<tr>
<td>WorkerGroupNames</td>
<td>FMA does not support worker groups.</td>
</tr>
</tbody>
</table>
Migrate XenDesktop 4

You can transfer data and settings from a XenDesktop 4 farm to a XenDesktop 7.x Site using the Migration Tool, which is available in the Support > Tools > MigrationTool folder on the XenDesktop installation media. The tool includes:

- The export tool, XdExport, which exports XenDesktop 4 farm data to an XML file (default name: XdSettings.xml). The XML file schema resides in the file XdFarm.xsd.
- The import tool, XdImport, which imports the data by running the PowerShell script Import-XdSettings.ps1.

To successfully use the Migration Tool, both deployments must have the same hypervisor version (for example, XenServer 6.2), and Active Directory environment.

You cannot use this tool to migrate XenApp, and you cannot migrate XenDesktop 4 to XenApp.

Tip: You can upgrade XenDesktop 5 (or later XenDesktop versions) to the current XenDesktop version; see Upgrade a deployment.

Not all data and settings are exported. The following configuration items are not migrated because they are exported but not imported:

- Administrators
- Delegated administration settings
- Desktop group folders
- Licensing configuration
- Registry keys

These use cases are not directly supported in migration:

- Merging settings of policies or desktop group or hosting settings.
- Merging private desktops into random Delivery Groups.
- Adjusting existing component settings through the migration tools.

For more information, see What is and is not migrated.

The following figure summarizes the migration process.
The migration process follows this sequence:
1. In the Studio console on the XenDesktop 4 Controller, turn on maintenance mode for all machines to be exported.
2. Export data and settings from your XenDesktop 4 farm to an XML file using XdExport; see Export from a XenDesktop 4 farm.
3. Edit the XML file so that it contains only the data and settings you want to import into your new XenDesktop Site; see Edit the Migration Tool XML file.
4. Import the data and settings from the XML file to your new XenDesktop Site using XdImport; see Import XenDesktop 4 data.
5. To make additional changes, repeat steps 3 and 4. After making changes, you might want to import additional desktops into existing Delivery Groups. To do so, use the Mergedesktops parameter when you import.
6. Complete the post-migration tasks; see Post-migration tasks.

Complete the following before beginning a migration:
- Make sure you understand which data can be exported and imported, and how this applies to your own deployment. See What is and is not migrated.
- Citrix strongly recommends that you manually back up the Site database so that you can restore it if any issues are discovered.
- Install the XenDesktop 7.x components and create a Site, including the database.
- To migrate from XenDesktop 4, all VDAs must be at a XenDesktop 5.x level so that they are compatible with both XenDesktop 4 and XenDesktop 7.x controllers. After the Controller infrastructure is fully running XenDesktop 7.x, Windows 7 VDAs can be upgraded to XenDesktop 7.x. For details, see Migration examples.
Export from a XenDesktop 4 farm

Jul 07, 2014

The export tool, XdExport, extracts data from a single XenDesktop 4 farm and produces an XML file from representations of the data values.

The schema of the XML file resides in the file XdFarm.xsd, which is included in the migration tool download XdExport.zip and XdImport.zip.

Run XdExport on a XenDesktop 4 Controller in the farm from which you want to export data. This machine must have the XenDesktop 4 PowerShell SDK installed. You must have the following permissions to export the data:

- The user identity of at least read-only Citrix administrator of the farm.
- Permission to read the registry.

Although not recommended, you can run the tool while the XenDesktop Controller is in active use (for example, users are logged in to VDAs).

Citrix strongly recommends:

- The XenDesktop 4 Controller on which you run the tool be up-to-date with public hotfixes.
- Not making configuration changes to the Site while the export is running (for example, removing Desktop Groups).

1. Download XdExport.zip and extract the files to the XenDesktop 4 Controller.
2. At a command line prompt, run XdExport.exe with the following optional parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Verbose</td>
<td>Generates messages providing detailed progress information.</td>
</tr>
<tr>
<td>-FilePath &lt;path&gt;</td>
<td>Indicates the location of the XML file to which the farm data is exported. Default = .\XdSettings.xml</td>
</tr>
<tr>
<td>-Overwrite</td>
<td>Overwrites any file existing in the location specified in -FilePath. If you do not supply this parameter and an output file already exists, the tool fails with the message &quot;Error: File already exists. Specify -Overwrite to allow the file to be overwritten.&quot;</td>
</tr>
<tr>
<td>-? or -help</td>
<td>Displays text describing the parameters and exits without exporting any data.</td>
</tr>
</tbody>
</table>

3. If the tool runs successfully, the message Done appears. The XdSettings.xml file resides in the location specified in the FilePath parameter. If the tool fails, an error message appears.
Edit the Migration Tool XML file

Jul 07, 2014

Before importing data to a XenDesktop 7.x Site, check and edit the contents of the XML file generated by the export tool (XdExport), particularly if you migrate in multiple stages and import some users, Delivery Groups, and policies before importing others.

Use any text editor to view or change the file contents; you can use a specialized XML editor such as Microsoft XML Notepad.

Some elements within the XML content must be present for the XML file to be accepted by the import tool (XdImport).

The required XML schema is defined in the XdFarm.xsd file that is supplied as part of the Migration Tool download. When working with this file:
- A minOccurs attribute with a value of 1 or more indicates that particular elements must be present if the parent element is present.
- If the XML file supplied to the Import tool is not valid, the tool halts and an error message appears that should enable you to locate where the problem lies in the XML file.

To import only a subset of Delivery Groups and desktops, edit the contents of the DesktopGroups element. The DesktopGroups element can hold many DesktopGroup elements, and within each DesktopGroup element there is a Desktops element that can contain many Desktop elements.

Do not delete the DesktopGroups element, although you can delete all the DesktopGroup elements and leave it empty. Similarly, within each DesktopGroup element, the Desktops element must be present but can be empty of Desktop elements.

Delete Desktop or DesktopGroup elements to avoid importing particular single machines or entire Delivery Groups. For example, the XML file contains:

```
<DesktopGroups>
  <DesktopGroup name="Group1">
    ...
    <Desktops>
      <Desktop sameName="DOMAIN\MACHINE1$">
        ...
      </Desktop>
    </Desktops>
    ...
  </DesktopGroup>
  <DesktopGroup name="Group2">
    ...
    <Desktops>
      <Desktop samName="DOMAIN\MACHINE2$">
        ...
      </Desktop>
      <Desktop samName="DOMAIN\MACHINE3$">
        ...
      </Desktop>
    </Desktops>
    ...
  </DesktopGroup>
```

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.290
In this example, the edits prevent Group1 group from being imported. Only Machine3 from the Group2 group will be imported:

```xml
<DesktopGroups>
  <DesktopGroup name="Group2">
    ...
    <Desktop samName="DOMAIN\MACHINE3$">
    ...
  </Desktop>
  ...
</DesktopGroup>
</DesktopGroups>
```

In XenDesktop 4, Desktop Groups can be organized in folders, Desktop Groups with the same name can appear in different folders, and the internal desktop group name is the name that appears to users. In this release, Delivery Groups cannot be placed in folders, and each Delivery Group must have a unique internal name, and the name that appears to users can be different from the internal name. To accommodate these differences, you might have to rename Desktop Groups.

For example, in your XenDesktop 4 farm, you could have two different Desktop Groups that appear with the name "My Desktop" to two different users, and you could use Desktop Groups folders to achieve this. If these Delivery Groups are to remain separate in the XenDesktop 7.x Site, you must edit the Desktop Group names in the XML file to make them unique.

If a Delivery Group in the XenDesktop 7.x Site has the same name as a Desktop Group to be imported, and the Delivery Groups are to remain separate in the XenDesktop 7.x Site, you must edit the XenDesktop 4 Desktop Group name in the XML file to keep the name unique in the Site. If the Desktop Group to be imported is really the same as the XenDesktop 7.x Delivery Group, and the machines in the XML file are to be merged into the existing Desktop Group, you do not need to rename the Desktop Group; instead, specify the -MergeDesktops parameter to the Import tool. For example, if the XML file contains:

```xml
<DesktopGroups>
  <DesktopGroup name="My Desktop">
    ...
    <Folder name="Sales">
    ...
  </DesktopGroup>
  <DesktopGroup name="My Desktop">
    ...
    <Folder name="Finance">
    ...
  </DesktopGroup>
</DesktopGroups>
```

Remove the duplicate names as follows:

```xml
<DesktopGroups>
  <DesktopGroup name="Sales Desktops">
    ...
  </DesktopGroup>
  ...
</DesktopGroups>
```
You can delete policies from the XML file, and you can specify unique names to avoid policy name duplication. There is no support for merging policies.

- When you import policy data, either all policies are imported successfully or, if there is any failure, no policy data is imported.
- Importing large numbers of policies with many settings can take several hours.
- If you import policies in batches, their original prioritization may be affected. When you import policies, the relative priorities of the imported policies are maintained, but they are given higher priority than policies already in the Site. For example, if you have four policies to import with priority numbers 1 to 4, and you decide to import them in two batches, you should import policies with priorities 3 and 4 first, because the second batch of policies automatically gets higher priority.

To import only a subset of policies into the XenDesktop 7.x Site, edit the contents of the Policies element. The Policies element can hold many Policy elements. You must not delete the Policies element, although you can delete all the Policy elements and leave it empty. Delete entire Policy elements to avoid importing particular XenDesktop 4 farm policies. For example, if the XML file contains:

```xml
<Policies>
  <Policy name="Sales Policy">
  ...
  </Policy>
...
</Policies>
```

To avoid importing any XenDesktop 4 policies, and avoid clashes with policies already configured in the XenDesktop 7.x Site, edit the file to remove the individual Policy elements as follows:

```xml
<Policies>
</Policies>
```

Alternatively, edit the file so that the policy is imported with a different name as follows:

```xml
<Policies>
  <Policy name="XD4 Sales Policy">
  ...
  </Policy>
...
</Policies>
```
Import XenDesktop 4 data

Jul 07, 2014

The import tool, XdImport, reads settings from XenDesktop 4 that are contained in the XML file produced by the export tool, XdExport, and applies those settings to an existing XenDesktop 7.x Site. The Import tool uses the PowerShell script Import-XdSettings.ps1.

To apply only a subset of the exported data, edit the XML file before running the Import tool. For example, you might want to remove desktop groups and policies that are not needed in your XenDesktop 7.x deployment. The import tool runs successfully if you leave entire elements empty. For example, you can delete all the desktop groups without causing any issues. The tool always validates the XML file before attempting to import any data.

Run XdImport on any machine on which all the XenDesktop 7.x SDKs are installed. You must be a Full XenDesktop administrator identity to run the tool.

Before you import, make sure that you have set up a XenDesktop 7.x Site, including its database. Citrix recommends that you complete the import to XenDesktop 7.x before any user testing or general Site configuration occurs. Merge configurations only when the Site is not in use.

1. Create a XenDesktop 7.x Site.
2. Download XdImport.zip and extract the files to the machine where you will run the tool.
3. In a PowerShell session, run Import-XdSettings.ps1 with the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-HypervisorConnectionCredentials</td>
<td>(Required.) A PowerShell hash table that maps Hypervisor addresses to PSCredential instances as required for the creation of Hypervisor connections. Default = @{}</td>
</tr>
<tr>
<td></td>
<td>Enter credentials for the Hypervisor to which the XenDesktop 4 farm connects. For a single Hypervisor, create the argument as follows:</td>
</tr>
<tr>
<td></td>
<td>$credential = Get-Credential $mappings = @{&quot;http://&lt;HypervisorIP&gt;&quot; = $credential} .\Import-XdSettings.ps1 -FilePath.\XdSettings.xml -HypervisorConnectionCredentials $mappings</td>
</tr>
<tr>
<td></td>
<td>The address specified in the hash table must exactly match the address in the XML file. For example, with both a XenServer and a VMware hypervisor, create the following argument:</td>
</tr>
</tbody>
</table>

https://docs.citrix.com  © 1999-2017 Citrix Systems, Inc. All rights reserved.  p.293
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Filepath &lt;path&gt;</td>
<td>(The value for &lt;path&gt; is required.) The location of the XML file from which the farm data is to be imported.</td>
</tr>
<tr>
<td>-AdminAddress</td>
<td>The name of a Controller in the XenDesktop 7.x Site. Default = localhost</td>
</tr>
<tr>
<td>-MergeDesktops</td>
<td>Adds desktops defined in the XML file to Delivery Groups in the XenDesktop 7.x Site that have the same name as the groups described in the XML file. The associated machines and users are also added. If this parameter is not supplied, no content is added to existing Delivery Groups in the XenDesktop 7.x Site.</td>
</tr>
<tr>
<td>-SkipMachinePolicy</td>
<td>The script does not create a machine policy that contains site-level settings. If you do not supply this parameter and the machine policy for the Site exists, the script fails.</td>
</tr>
<tr>
<td>-WhatIf</td>
<td>Completes a trial run to determine what would be changed in or added to the XenDesktop 7.x Site. Including this parameter sends the information to the log file, but does not change the Site.</td>
</tr>
<tr>
<td>-LogfilePath &lt;path&gt;</td>
<td>Indicates the full path of the log file. The log file contains text describing all writes performed against the XenDesktop 7.x Site. Default = .\Import-XdSettings.log</td>
</tr>
<tr>
<td>-? or -help</td>
<td>Displays information about parameters and exits without importing any data.</td>
</tr>
</tbody>
</table>

If the XML file contains policy data, either all policies are imported successfully or if there is any failure, no policy data is imported. Importing large numbers of policies with many settings can take several hours.

When the script completes, the message Done appears. After successfully importing the data from the XML file, you can either run further export and import iterations, or if you have imported all the relevant data, complete the post-migration tasks.
Post-migration tasks

Jul 07, 2014

After successfully importing data from a XenDesktop 4 farm to a XenDesktop 7.x Site, complete the following tasks before using the new Site for production work:

- Upgrade the Virtual Delivery Agents (VDAs). Although it is not required, Citrix recommends that you upgrade VDAs before upgrading Controllers, Studio, or Director.
  - For Windows Vista and Windows XP, upgrade to XenDesktop 5.6 Feature Pack 1 Virtual Desktop Agent.
  - For Windows 7, upgrade to the XenDesktop 7.x Virtual Delivery Agent.
- Create administrators you need for the XenDesktop 7.x Site.
- Update user devices — Citrix recommends that you update user devices with the latest version of Citrix Receiver to benefit from hotfixes and to receive support for the latest features.
- Modify the imported desktops to use registry-based Controller discovery, and point them to the XenDesktop 7.x Controllers using one of the following methods:
  - Manually edit the registry to remove the unnecessary Organizational Unit (OU) GUID registry entry, and add a ListOfDDCs registry entry.
  - Set up a machine policy to distribute the list of Controllers to the desktops, using the Active Directory policy GPMC.msc. You cannot use Studio to configure this setting.
  Registry-based Controller discovery is the default for XenDesktop 7.x, but Active Directory-based discovery is still available.
- Optionally, implement the following registry key settings described in the best practices for XenDesktop registry-based registration inCTX133384:
  - HeartbeatPeriodMS
  - PrepareSessionConnectionTimeoutSec
  - MaxWorkers
  - DisableActiveSessionReconnect
  - ControllersGroupGuid
  If you do not perform this action, the default XenDesktop 7.x settings for these keys are used.
- Turn off maintenance mode for the imported machines if they were in maintenance mode in XenDesktop 4 before the XML file was generated.
- Check the XenDesktop 7.x settings to make sure that they are correct, particularly if you had changed the PortICAConfig XML file on XenDesktop 4.
- Review all migrated components to make sure that the migration was successful.
In this example, a XenDesktop 4 farm is in use. The XenDesktop 4 farm has 50 desktop groups, where each group contains an average 100 desktops. The XenDesktop 4 desktops are provided through Provisioning Services (PVS), and the machines are running on VMware ESX hypervisors. The VDA installed on all the VMs is the XenDesktop version 4.

Migration steps

1. Upgrade all XenDesktop 4 VDAs to XenDesktop 5.6 Feature Pack 1 VDA software. This allows the VDAs to register with both the XenDesktop 4 controller and the XenDesktop 7 Delivery Controller.
   - For Windows 7 VDAs, see Upgrading the Virtual Desktop Agent on a VM or Blade Computer.
   - For Windows XP and Windows Vista VDAs, see Virtual Desktop Agents on Windows XP or Windows Vista.
2. Make sure that all users log off the XenDesktop 4 farm.
3. Make sure that all these machines are in maintenance mode.
4. Run the export tool (XdExport) on the XenDesktop 4 farm.
5. Install XenDesktop 7 components.
   1. Use Studio to create a full production mode Site.
   2. If Provisioning Services is part of the deployment, upgrade the Provisioning Services server and agents.
   3. Upgrade the License Server and associated licenses.
6. Unzip the import Tool (XdImport) to a local directory on the XenDesktop 7 Controller.
7. Copy the XML file (XdSettings.xml) generated in Step 4 by the export tool to the local directory.
8. From the PowerShell console of the Studio root node on the XenDesktop 7 Site, start a PowerShell session.
9. Run the import tool (XdImport), passing the credentials of the associated hypervisors and the path of the XML file.
10. Manually recreate administrator settings from the Administrator node in the Studio navigation pane; see Delegated Administration for details.
11. Modify the imported desktops to use registry-based Controller discovery; and point them to the new XenDesktop 7 Controller.
12. For VDAs running on Windows 7, Citrix recommends you upgrade those VDAs to use the XenDesktop 7 VDA for Windows Desktop OS, which provides access to all new features.
   After upgrading the VDAs to XenDesktop 7 for machines in a catalog or Delivery Group, upgrade the catalog (see Manage machine catalogs) and Delivery Groups (see Manage settings in Delivery Groups).
13. Turn off maintenance mode for the Delivery Groups.
14. Configure StoreFront to provide the desktops formerly provided through Web Interface. See the StoreFront documentation.

In this example, the migration occurs in a number of steps, each step migrating a subset of the remaining desktops. A XenDesktop 4 farm is in use, and a XenDesktop 7.1 Site has already been created and is in use. The XenDesktop 4 farm has 50 desktop groups, and each group contains an average 100 desktops. The XenDesktop 4 desktops are provided through Provisioning Services, and the machines are running on Citrix XenServer hypervisors. The VDA installed on all the VMs is the XenDesktop version 4.

Migration steps
1. Run the export tool on the XenDesktop 4 farm.
   1. Unzip the Export Tool (XdExport) on one of the Desktop Delivery Controllers in the farm.
   2. As a Citrix Administrator, run the export tool with no parameters.
2. Copy and edit the resulting XML file so that it contains only the groups and desktops that you want to migrate.
3. In the XenDesktop 4 farm, make sure that all users on desktops to be migrated have logged off and turn on maintenance mode for all desktops that are to be migrated.
4. Unzip the Import Tool (XdImport) to a local directory on the XenDesktop 7.1 Delivery Controller.
5. Copy the edited XML to the local directory.
6. From the PowerShell console of the Studio root node on the XenDesktop 7.1 Site, start a PowerShell session.
7. Run the Import Tool (XdImport), passing the credentials of the associated hypervisors and the path of the XML file.
8. Manually recreate Administrator settings from the Administrator node in the Studio navigation pane; see Delegated Administration for details.
9. Modify the imported desktops to use registry-based Controller discovery; and point them to the new XenDesktop 7.1 Controller.
10. Upgrade all VDAs to the appropriate VDA software:
    - For Windows 7 VDAs:
      - Upgrade to XenDesktop 7 Virtual Delivery Agents as described in Upgrading the Virtual Desktop Agent on a VM or Blade Computer
      - After upgrading all VDA software to XenDesktop 7 for machines in a catalog or Delivery Group, upgrade the catalog (see Manage machine catalogs) and Delivery Groups (see Manage settings in Delivery Groups).
      - For Windows XP and Windows Vista VDAs, upgrade to XenDesktop 5.6 FP1; see Virtual Desktop Agents on Windows XP or Windows Vista.
11. Turn off maintenance mode for the Delivery Groups.
12. Configure StoreFront to provide the desktops formerly provided through Web Interface. See the StoreFront documentation.
What is and is not migrated

Apr 27, 2015

Although not all inclusive, the following table describes what happens to the most significant data during migration to this release. Unless noted, the data type is imported.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop Groups</td>
<td>Desktop Groups become Delivery Groups in this release. Desktop Group icons are not exported. SecureICARequired is set to True if the DefaultEncryptionLevel in XenDesktop 4 is not Basic. If a Desktop Group in the XenDesktop 4 farm has the same name as a Delivery Group in the XenDesktop 7.x Site, you can add desktops belonging to the XenDesktop 4 group to a Delivery group of the same name in the target Site. To do this, specify the MergeDesktops parameter when you run the import tool. The settings of the XenDesktop 7.x Delivery Group are not overwritten with the settings of the XenDesktop 4 group. If this parameter is not specified and there is a group with the same name as one defined in the XML file, the tool displays an error and stops before any data is imported.</td>
</tr>
<tr>
<td>Desktops</td>
<td>You cannot add private desktops to a random Delivery Group. Random desktops cannot be added to a static Delivery Group.</td>
</tr>
</tbody>
</table>
| Machines        | Machines are imported into four machine catalogs. The following machine catalogs are automatically created in the XenDesktop 7.x Site by the import tool:  
  ● Imported existing random (for pooled VMs)  
  ● Imported existing static (for assigned VMs)  
  ● Imported physical random (for pooled PCs or blades)  
  ● Imported physical static (for private PCs or blades).  
  Any subsequent import of machines uses the same four machine catalogs.                                                                                          |
| Pool management pools | Includes multi-pool pools, and idle pool settings including schedule.  
  ● PeakBufferSizePercent is set to 10% by default.  
  ● OffPeakBufferSizePercent is set to 10% by default.  
  ● Any unselected days in the Business days setting on XenDesktop 4 are imported as part of the Weekend power time scheme in this release.  
  ● HostingXD4 action times are rounded up to the nearest minute.  
  ● Start times are rounded down to the nearest hour.  
  ● End times are rounded up to the nearest hour.                                                                                                                                                                      |
| Farm settings   | The following farm settings are imported as a Machine policy:  
  ● IcaKeepAlive                                                                                                                                                |
The following table describes how User policy data is exported and imported.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoClientReconnect</td>
<td></td>
</tr>
<tr>
<td>SessionReliability</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The setting to enable Flash player is not imported.</td>
</tr>
</tbody>
</table>

### Policies

Some policy data is imported. Filters, settings, and printers are imported as User policies. For further details of user policy export and import, see the other table in this document.

- New access policy rules are created from XenDesktop 4 group settings.
- When policies are imported, their relative priority order is preserved. However, they are always added with a higher priority than any existing policies on the XenDesktop 7.x Site.
- Policy merging is not supported.

There is no option to import policies into Active Directory. They are always stored in the Site.

### User assignments

### Hypervisor settings

This parameter is required with the XdImport tool.

Hypervisor addresses are exported, but not the credentials required to access those hypervisors. To create hypervisor connections in the XenDesktop 7.x Site, extract the addresses from the XML file and create a PowerShell hash table that maps them to the relevant credential instances. Then specify this hash table in the import tool HypervisorConnectionCredentials parameter. For further details, see Import XenDesktop 4 data.

Merging or updating hypervisor settings for existing Desktop Groups and hypervisor connections is not supported.

### Administrators

(Not imported.) No administrator data is imported, including data about delegated administrators. You create new administrators for your XenDesktop 7.x Site.

### Licensing configuration

(Not imported.) Includes information such as the License Server name and edition. License files are not exported.

### Desktop Group folders

(Not imported.) This release does not support Desktop Group folders. If there are duplicate Desktop Group names (because different folders in the XenDesktop 4 farm contained groups with the same names) and you do not edit names in the XML file, the Import Tool halts.

### Registry keys

(Not imported.) For information on implementing registry keys, see Post-migration tasks.

---

The following table describes how User policy data is exported and imported.
<table>
<thead>
<tr>
<th>XenDesktop 4 category and setting</th>
<th>XML file</th>
<th>XenDesktop 7.x category and setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bandwidth\Visual Effects\Session Limits</td>
<td>Client</td>
<td>Not imported</td>
</tr>
<tr>
<td>OEM Virtual Channels</td>
<td>OEMVCBandwidth</td>
<td></td>
</tr>
<tr>
<td>Client Devices\Resources\Other Turn off OEM virtual channels</td>
<td>DisableOEMVirtualChannels</td>
<td>Not imported</td>
</tr>
<tr>
<td>User Workspace\Time Zones Do not use client’s local time</td>
<td>DoNotUseClientLocalTime</td>
<td>Not imported</td>
</tr>
<tr>
<td>Security\Encryption SecureICA encryption</td>
<td>ClientSecurityRequirement</td>
<td>Not imported</td>
</tr>
<tr>
<td>Bandwidth\SpeedScreen Image acceleration using lossy compression</td>
<td>LossyCompression settings</td>
<td>ICA\Visual Display\Still Images</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lossy compression level</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lossy compression threshold value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Heavyweight compression</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ICA\Visual Display\Moving Images</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Progressive compression level</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Progressive compression threshold value</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects Turn off desktop wallpaper</td>
<td>TurnOffWallpaper</td>
<td>ICA\Desktop UI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Desktop wallpaper</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects Menu animation</td>
<td>TurnOffMenuWindowAnimation</td>
<td>ICA\Desktop UI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Menu animation</td>
</tr>
<tr>
<td>XenDesktop 4 category and setting</td>
<td>XML file</td>
<td>XenDesktop 7.x category and setting</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects\Session Limits Audio</td>
<td>ClientAudioBandwidth__AllowedBandWidth</td>
<td>ICA\Bandwidth Audio</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects\Session Limits Clipboard</td>
<td>ClientClipboardBandwidth__AllowedBandWidth</td>
<td>ICA\Bandwidth Clipboard</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects\Session Limits COM Ports</td>
<td>ClientComBandwidth__AllowedBandWidth</td>
<td>COM port redirection is deprecated in XenDesktop 7.x</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects\Session Limits Drives</td>
<td>ClientDriveBandwidth__AllowedBandWidth</td>
<td>ICA\Bandwidth Drives</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects\Session Limits LPT Ports</td>
<td>ClientLptBandwidth__AllowedBandWidth</td>
<td>LPT port redirection is deprecated in XenDesktop 7.x</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects\Session Limits Overall Session</td>
<td>OverallBandwidth__AllowedBandWidth</td>
<td>ICA\Bandwidth Overall</td>
</tr>
<tr>
<td>Bandwidth\Visual Effects\Session Limits Printer</td>
<td>LimitPrinterBandwidth__AllowedBandWidth</td>
<td>ICA\Bandwidth Printer</td>
</tr>
<tr>
<td>Client Devices\Resources\Audio Microphones</td>
<td>ClientAudioMicrophone__TurnOn</td>
<td>ICA\Audio Microphones</td>
</tr>
<tr>
<td>XML file</td>
<td>XenDesktop 7.x category and setting</td>
<td>XenDesktop 4 category and setting</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Client Devices\Resources\Audio\Sound\Quality</td>
<td>ClientAudioQuality__Quality</td>
<td>ICA\Audio</td>
</tr>
<tr>
<td>DisableClientAudioMapping</td>
<td>Client audio redirection</td>
<td></td>
</tr>
<tr>
<td>Client Devices\Resources\Drives\Connection</td>
<td>ConnectClientDriveAtLogon__TurnOn</td>
<td>ICA\File Redirection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Auto connect drives</td>
</tr>
<tr>
<td>DisableClientDriveMapping__DisableFloppyDrive</td>
<td></td>
<td>Client floppy drives</td>
</tr>
<tr>
<td>Client Devices\Resources\Drives</td>
<td>DisableClientDriveMapping__DisableHardDrive</td>
<td>ICA\File Redirection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Client fixed drives</td>
</tr>
<tr>
<td>DisableClientDriveMapping__DisableCdrom</td>
<td></td>
<td>ICA\File Redirection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Client optical drives</td>
</tr>
<tr>
<td>DisableClientDriveMapping__DisableRemote</td>
<td></td>
<td>ICA\File Redirection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Client network drives</td>
</tr>
<tr>
<td>DisableClientDriveMapping__DisableUSB</td>
<td></td>
<td>ICA\File Redirection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Client removable drives</td>
</tr>
<tr>
<td>CDMAAsyncWrites</td>
<td></td>
<td>ICA\File Redirection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User asynchronous writes</td>
</tr>
<tr>
<td>DisableClientClipboardMapping</td>
<td></td>
<td>ICA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Client clipboard redirection</td>
</tr>
<tr>
<td>DisableClientCOMPortMapping</td>
<td></td>
<td>COM port redirection is deprecated in XenDesktop 7.x</td>
</tr>
<tr>
<td>DisableClientLPTPortMapping</td>
<td></td>
<td>LPT port redirection is</td>
</tr>
</tbody>
</table>

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.302
<table>
<thead>
<tr>
<th>XenDesktop 4 category and setting</th>
<th>XML file</th>
<th>deprecated in XenDesktop 7.x category and setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Devices\Resources\USB</td>
<td>RemoteUSBDevices__DisableRemoteUSBDevices</td>
<td>ICA\USB Devices</td>
</tr>
<tr>
<td>USB</td>
<td></td>
<td>Client USB device redirection</td>
</tr>
<tr>
<td>Printing\Client Printers</td>
<td>ConnectClientPrinterAtLogon__Flag</td>
<td>ICA\Printing\Client Printers</td>
</tr>
<tr>
<td>Auto-creation</td>
<td></td>
<td>Auto-create client printers</td>
</tr>
<tr>
<td>Printing\Client Printers</td>
<td>LegacyClientPrinters__TurnOn</td>
<td>ICA\Printing\Client Printers</td>
</tr>
<tr>
<td>Legacy client printers</td>
<td></td>
<td>Client printer names</td>
</tr>
<tr>
<td>Printing\Client Printers</td>
<td>ModifiedPrinterProperties__WriteMethod</td>
<td>ICA\Printing\Client Printers</td>
</tr>
<tr>
<td>Printer properties retention</td>
<td></td>
<td>Printer properties retention</td>
</tr>
<tr>
<td>Printing\Client Printers</td>
<td>ClientPrintingForNetworkPrinter__TurnOn</td>
<td>ICA\Printing\Client Printers</td>
</tr>
<tr>
<td>Print job routing</td>
<td></td>
<td>Direct connections to print servers</td>
</tr>
<tr>
<td>Printing\Client Printers</td>
<td>DisableClientPrinterMapping</td>
<td>ICA\Printing</td>
</tr>
<tr>
<td>Turn off client printer mapping</td>
<td></td>
<td>Client printer redirection</td>
</tr>
<tr>
<td>Printing\Drivers</td>
<td>PrintDriverAutoInstall__TurnOn</td>
<td>ICA\Printing\Drivers</td>
</tr>
<tr>
<td>Native printer driver auto-install</td>
<td></td>
<td>Automatic installation of inbox printer drivers</td>
</tr>
<tr>
<td>Printing\Drivers</td>
<td>ClientPrintDriverToUse</td>
<td>ICA\Printing\Drivers</td>
</tr>
<tr>
<td>Universal driver</td>
<td></td>
<td>Universal print driver use</td>
</tr>
<tr>
<td>Printing\Session printers</td>
<td>NetworkPrinters</td>
<td>ICA\Printing</td>
</tr>
<tr>
<td>Session printers</td>
<td></td>
<td>Session printers</td>
</tr>
<tr>
<td>Printing\Session printers</td>
<td>DefaultToMainClientPrinter__NetworkDefault</td>
<td>ICA\Printing</td>
</tr>
<tr>
<td>Choose client’s default printer</td>
<td>DefaultToMainClientPrinter__TurnOn</td>
<td>Default printer</td>
</tr>
</tbody>
</table>
Not all XenDesktop 4 components are supported in this release. The following items are not migrated:

- **Virtual Delivery Agent** - Before a XenDesktop 7.x Delivery Controller can manage virtual desktops from XenDesktop 4, you must upgrade the VDAs to a minimum release of XenDesktop 5.x. For information about upgrading VDAs, see Post-migration tasks.

- **Controllers** - You must deploy new Controller servers. You cannot upgrade a XenDesktop 4 Controller to a XenDesktop 7.x Site. XenDesktop 7.x Sites cannot join a XenDesktop 4 farm, and XenDesktop 4 Controllers cannot join a XenDesktop 7.x Site. In addition, each version has different server requirements; XenDesktop 4 requires Windows Server 2003 and XenDesktop 7.x requires later Windows Server versions.

- **Web Interface** - Citrix recommends using StoreFront with XenDesktop 7.x. See the StoreFront documentation for installation and setup details. When the XenDesktop installer detects Web Interface, it installs StoreFront, but does not remove Web Interface.

- **Active Directory Organizational Unit (OU) configuration** - Sharing an Organizational Unit (OU) between two farms or two Sites, or a farm and a Site is not supported. If you plan to configure the new Site to use Active Directory-based Controller discovery rather than the default registry-based Controller discovery, you must create a new OU to support it.

- **PortICACfg XML file** - If you have changed the default settings for this file you may need to configure these settings for the new Site through Group Policy Objects.

- **Configuration logging settings provided through XenDesktop 4 Service Pack 1.**

- **Provisioning Services-related data.**

- **Applications.**

- **List of Controllers.**

- **NetScaler Gateway.**

- **Event log throttling settings.**
Getting Started with Citrix XenApp and XenDesktop Security

XenApp and XenDesktop offer a secure-by-design solution that allows you to tailor your environment to your security needs.

One security concern IT faces with mobile workers is lost or stolen data. By hosting applications and desktops, XenApp and XenDesktop securely separate sensitive data and intellectual property from end-point devices by keeping all data in a data center. When policies are enabled to allow data transfer, all data is encrypted.

The XenDesktop and XenApp data centers also make incident response easier with a centralized monitoring and management service. Director allows IT to monitor and analyze data that is being accessed around the network, and Studio allows IT to patch and remedy most vulnerabilities in the data center instead of fixing the problems locally on each end-user device.

XenApp and XenDesktop also simplify audits and regulatory compliance because investigators can use a centralized audit trail to determine who accessed what applications and data. Director gathers historical data regarding updates to the system and user data usage by accessing Configuration Logging and OData API.

Delegated Administration allows you to set up administrator roles to control access to XenDesktop and XenApp at a granular level. This allows flexibility in your organization to give certain administrators full access to tasks, operations, and scopes while other administrators have limited access.

XenApp and XenDesktop give administrators granular control over users by applying policies at different levels of the network — from the local level to the Organizational Unit level. This control of policies determines if a user, device, or groups of users and devices can connect, print, copy/paste, or map local drives, which could minimize security concerns with third-party contingency workers. Administrators can also use the Desktop Lock feature so end users can only use the virtual desktop while preventing any access to the local operating system of the end-user device.

Administrators can increase security on XenApp or XenDesktop by configuring the Site to use the Transport Layer Security (TLS) protocol of the Controller or between end users and Virtual Delivery Agents (VDA). The protocol can also be enabled on a Site to provide server authentication, data stream encryption, and message integrity checks for a TCP/IP connection.

XenApp and XenDesktop also support multifactor authentication for Windows or a specific application. Multifactor authentication could also be used to manage all resources delivered by XenApp and XenDesktop. These methods include:

- Tokens
- Smart cards
- RADIUS
- Kerberos
- Biometrics

XenDesktop can be integrated with many third-party security solutions, ranging from identity management through to antivirus software. A list of supported products can be found at http://www.citrix.com/ready.

Select releases of XenApp and XenDesktop are certified for Common Criteria standard. For a list of those standards, go to http://www.commoncriteriaportal.org/cc/.
- Security best practices and considerations
- Delegated Administration
- Smart cards
- TLS
Security considerations and best practices

Aug 23, 2016

This document describes:

- General security best practices when using this release, and any security-related differences between this release and a conventional computer environment
- Manage user accounts
- Manage user privileges
- Manage logon rights
- Configure user rights
- Configure service settings
- Deployment scenarios and their security implications
- Remote PC Access security considerations

Your organization may need to meet specific security standards to satisfy regulatory requirements. This document does not cover this subject, because such security standards change over time. For up-to-date information on security standards and Citrix products, consult http://www.citrix.com/security/.

Security best practices

Keep all machines in your environment up to date with security patches. One advantage is that you can use thin clients as terminals, which simplifies this task.

Protect all machines in your environment with antivirus software.

Protect all machines in your environment with perimeter firewalls, including at enclave boundaries as appropriate.

If you are migrating a conventional environment to this release, you may need to reposition an existing perimeter firewall or add new perimeter firewalls. For example, suppose there is a perimeter firewall between a conventional client and database server in the data center. When this release is used, that perimeter firewall must be placed so that the virtual desktop and user device are on one side, and the database servers and Delivery Controllers in the data center are on the other side. Therefore, consider creating an enclave within your data center to contain the database servers and Controllers. Also consider having protection between the user device and the virtual desktop.

All machines in your environment should be protected by a personal firewall. When you install core components and Virtual Delivery Agents (VDAs), you can choose to have the ports required for component and feature communication opened automatically if the Windows Firewall Service is detected (even if the firewall is not enabled). You can also choose to configure those firewall ports manually. If you use a different firewall, you must configure the firewall manually.

**Note:** TCP ports 1494 and 2598 are used for ICA and CGP and are therefore likely to be open at firewalls so that users outside the data center can access them. Citrix recommends that you do not use these ports for anything else, to avoid the possibility of inadvertently leaving administrative interfaces open to attack. Ports 1494 and 2598 are officially registered with the Internet Assigned Number Authority (http://www.iana.org/).

All network communications should be appropriately secured and encrypted to match your security policy. You can secure all communication between Microsoft Windows computers using IPSec; refer to your operating system documentation for
details about how to do this. In addition, communication between user devices and desktops is secured through Citrix SecureICA, which is configured by default to 128-bit encryption. You can configure SecureICA when you are creating or updating a Delivery Group; see Change user settings.

Apply Windows best practice for account management. Do not create an account on a template or image before it is duplicated by Machine Creation Services or Provisioning Services. Do not schedule tasks using stored privileged domain accounts. Do not manually create shared Active Directory machine accounts. These practices will help prevent a machine attack from obtaining local persistent account passwords and then using them to log on to MCS/PVS shared images belonging to others.

Manage user accounts

If the option to install App-V publishing components is selected when installing a Virtual Delivery Agent (VDA), or if this feature is added later, the local administrative account CtxAppVCOMAdmin is added to the VDA. If you use the App-V publishing feature, do not modify this account. If you do not need to use the App-V publishing feature, do not select it at installation time. If you later decide not to use the App-V publishing feature, you can disable or delete this account.

Manage user privileges

Grant users only the capabilities they require. Microsoft Windows privileges continue to be applied to desktops in the usual way: configure privileges through User Rights Assignment and group memberships through Group Policy. One advantage of this release is that it is possible to grant a user administrative rights to a desktop without also granting physical control over the computer on which the desktop is stored.

Note the following when planning for desktop privileges:

- By default, when non-privileged users connect to a desktop, they see the time zone of the system running the desktop instead of the time zone of their own user device. For information on how to allow users to see their local time when using desktops, see Change user settings.
- A user who is an administrator on a desktop has full control over that desktop. If a desktop is a pooled desktop rather than a dedicated desktop, the user must be trusted in respect of all other users of that desktop, including future users. All users of the desktop need to be aware of the potential permanent risk to their data security posed by this situation. This consideration does not apply to dedicated desktops, which have only a single user; that user should not be an administrator on any other desktop.
- A user who is an administrator on a desktop can generally install software on that desktop, including potentially malicious software. The user can also potentially monitor or control traffic on any network connected to the desktop.

Manage logon rights

Logon rights are required for both user accounts and computer accounts. As with Microsoft Windows privileges, logon rights continue to be applied to desktops in the usual way: configure logon rights through User Rights Assignment and group memberships through Group Policy.

The Windows logon rights are: log on locally, log on through Remote Desktop Services, log on over the network (access this computer from the network), log on as a batch job, and log on as a service.
For computer accounts, grant computers only the logon rights they require. The logon right "Access this computer from the network" is required:

- At VDAs, for the computer accounts of Delivery Controllers
- At Delivery Controllers, for the computer accounts of VDAs. See Active Directory OU-based Controller discovery.
- At StoreFront servers, for the computer accounts of other servers in the same StoreFront server group

For user accounts, grant users only the logon rights they require.

According to Microsoft, by default the group Remote Desktop Users is granted the logon right "Allow log on through Remote Desktop Services" (except on domain controllers).

Your organization's security policy may state explicitly that this group should be removed from that logon right. Consider the following approach:

- The Virtual Delivery Agent (VDA) for Server OS uses Microsoft Remote Desktop Services. You can configure the Remote Desktop Users group as a restricted group, and control membership of the group via Active Directory group policies. Refer to Microsoft documentation for more information.
- For other components of XenApp and XenDesktop, including the VDA for Desktop OS, the group Remote Desktop Users is not required. So, for those components, the group Remote Desktop Users does not require the logon right "Allow log on through Remote Desktop Services"; you can remove it. Additionally:
  - If you administer those computers via Remote Desktop Services, ensure that all such administrators are already members of the Administrators group.
  - If you do not administer those computers via Remote Desktop Services, consider disabling Remote Desktop Services itself on those computers.

Although it is possible to add users and groups to the login right "Deny logon through Remote Desktop Services", the use of deny logon rights is not generally recommended. Refer to Microsoft documentation for more information.

Configure user rights

Delivery Controller installation creates the following Windows services:

- Citrix AD Identity Service (NT SERVICE\CitrixADIdentityService): Manages Microsoft Active Directory computer accounts for VMs.
- Citrix Analytics (NT SERVICE\CitrixAnalytics): Collects site configuration usage information for use by Citrix, if this collection been approved by the site administrator. It then submits this information to Citrix, to help improve the product.
- Citrix App Library (NT SERVICE\CitrixAppLibrary): Supports management and provisioning of AppDisks, AppDNA integration, and management of App-V.
- Citrix Broker Service (NT SERVICE\CitrixBrokerService): Selects the virtual desktops or applications that are available to users.
- Citrix Configuration Logging Service (NT SERVICE\CitrixConfigurationLogging): Records all configuration changes and other state changes made by administrators to the site.
- Citrix Configuration Service (NT SERVICE\CitrixConfigurationService): Site-wide repository for shared configuration.
- Citrix Delegated Administration Service (NT SERVICE\CitrixDelegatedAdmin): Manages the permissions granted to administrators.
- Citrix Environment Test Service (NT SERVICE\CitrixEnvTest): Manages self-tests of the other Delivery Controller services.
Citrix Host Service (NT SERVICE\CitrixHostService): Stores information about the hypervisor infrastructures used in a XenApp or XenDesktop deployment, and also offers functionality used by the console to enumerate resources in a hypervisor pool.

Citrix Machine Creation Service (NT SERVICE\CitrixMachineCreationService): Orchestrates the creation of desktop VMs.

Citrix Monitor Service (NT SERVICE\CitrixMonitor): Collects metrics for XenApp or XenDesktop, stores historical information, and provides a query interface for troubleshooting and reporting tools.

Citrix Storefront Service (NT SERVICE\CitrixStorefront): Supports management of StoreFront. (It is not part of the StoreFront component itself.)

Citrix Storefront Privileged Administration Service (NT SERVICE\CitrixPrivilegedService): Supports privileged management operations of StoreFront. (It is not part of the StoreFront component itself.)

Delivery Controller installation also creates the following Windows services. These are also created when installed with other Citrix components:

- Citrix Diagnostic Facility COM Server (NT SERVICE\CdfSvc): Supports the collection of diagnostic information for use by Citrix Support.
- Citrix Telemetry Service (NT SERVICE\CitrixTelemetryService): Collects diagnostic information for analysis by Citrix, such that the analysis results and recommendations can be viewed by administrators to help diagnose issues with the site.

Except for the Citrix Storefront Privileged Administration Service, these services are granted the logon right Log on as a service and the privileges Adjust memory quotas for a process, Generate security audits, and Replace a process level token. You do not need to change these user rights. These privileges are not used by the Delivery Controller and are automatically disabled.

Configure service settings

Except for the Citrix Storefront Privileged Administration service and the Citrix Telemetry Service, the Delivery Controller Windows services listed above in the "Configure user rights" section are configured to log on as the NETWORK SERVICE identity. Do not alter these service settings.

The Citrix Storefront Privileged Administration service is configured to log on Local System (NT AUTHORITY\SYSTEM). This is required for Delivery Controller StoreFront operations that are not normally available to services (including creating Microsoft IIS sites). Do not alter its service settings.

The Citrix Telemetry Service is configured to log on as its own service-specific identity.

You can disable the Citrix Telemetry Service. Apart from this service, and services that are already disabled, do not disable any other of these Delivery Controller Windows services.

Deployment scenario security implications

Your user environment can contain either user devices that are unmanaged by your organization and completely under the control of the user, or user devices that are managed and administered by your organization. The security considerations for these two environments are generally different.

Managed user devices
Managed user devices are under administrative control; they are either under your own control, or the control of another organization that you trust. You may configure and supply user devices directly to users; alternatively, you may provide terminals on which a single desktop runs in full-screen-only mode. Follow the general security best practices described above for all managed user devices. This release has the advantage that minimal software is required on a user device.

A managed user device can be configured to be used in full-screen-only mode or in window mode:

- Full-screen-only mode: Users log on to it with the usual Log On To Windows screen. The same user credentials are then used to log on automatically to this release.
- Users see their desktop in a window: Users first log on to the user device, then log on to this release through a web site supplied with the release.

Unmanaged user devices

User devices that are not managed and administered by a trusted organization cannot be assumed to be under administrative control. For example, you might permit users to obtain and configure their own devices, but users might not follow the general security best practices described above. This release has the advantage that it is possible to deliver desktops securely to unmanaged user devices. These devices should still have basic antivirus protection that will defeat keylogger and similar input attacks.

Data storage considerations

When using this release, you can prevent users from storing data on user devices that are under their physical control. However, you must still consider the implications of users storing data on desktops. It is not good practice for users to store data on desktops; data should be held on file servers, database servers, or other repositories where it can be appropriately protected.

Your desktop environment may consist of various types of desktops, such as pooled and dedicated desktops. Users should never store data on desktops that are shared amongst users, such as pooled desktops. If users store data on dedicated desktops, that data should be removed if the desktop is later made available to other users.

Mixed-version environments

Mixed-version environments are inevitable during some upgrades. Follow best-practice and minimize the time that Citrix components of different versions co-exist. In mixed-version environments, security policy, for example, may not be uniformly enforced.

Note: This is typical of other software products; the use of an earlier version of Active Directory only partially enforces Group Policy with later versions of Windows.

The following scenario describes a security issue that can occur in a specific mixed-version Citrix environment. When Citrix Receiver 1.7 is used to connect to a virtual desktop running the VDA in XenApp and XenDesktop 7.6 Feature Pack 2, the policy setting Allow file transfer between desktop and client is enabled in the Site but cannot be disabled by a Delivery Controller running XenApp and XenDesktop 7.1. It does not recognize the policy setting, which was released in the later version of the product. This policy setting allows users to upload and download files to their virtual desktop, which is the security issue. To work around this, upgrade the Delivery Controller (or a standalone instance of Studio) to version 7.6 Feature Pack 2 and then use Group Policy to disable the policy setting. Alternatively, use local policy on all affected virtual desktops.

Remote PC Access security considerations
Remote PC Access implements the following security features:

- Smart card use is supported.
- When a remote session connects, the office PC's monitor appears as blank.
- Remote PC Access redirects all keyboard and mouse input to the remote session, except CTRL+ALT+DEL and USB-enabled smart cards and biometric devices.
- SmoothRoaming is supported for a single user only.
- When a user has a remote session connected to an office PC, only that user can resume local access of the office PC.

To resume local access, the user presses Ctrl-Alt-Del on the local PC and then logs on with the same credentials used by the remote session. The user can also resume local access by inserting a smart card or leveraging biometrics, if your system has appropriate third-party Credential Provider integration. This default behavior can be overridden by enabling Fast User Switching via Group Policy Objects (GPOs) or by editing the registry.

**Note:** Citrix recommends that you do not assign VDA administrator privileges to general session users.

### Automatic assignments

By default, Remote PC Access supports automatic assignment of multiple users to a VDA. In XenDesktop 5.6 Feature Pack 1, administrators could override this behavior using the RemotePCAccess.ps1 PowerShell script. This release uses a registry entry to allow or prohibit multiple automatic remote PC assignments; this setting applies to the entire Site.

**Caution:** Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

To restrict automatic assignments to a single user:

On each Controller in the Site, set the following registry entry:

```
HKEY_LOCAL_MACHINE\Software\Citrix\DesktopServer
Name: AllowMultipleRemotePCAssignments
Type: REG_DWORD
Data: 0 = Disable multiple user assignment, 1 = (Default) Enable multiple user assignment.
```

If there are any existing user assignments, remove them using SDK commands for the VDA to subsequently be eligible for a single automatic assignment.

- Remove all assigned users from the VDA: `$machine.AssociatedUserNames | %{ Remove-BrokerUser-Name $_ -Machine $machine }`
- Remove the VDA from the Delivery Group: `$machine | Remove-BrokerMachine -DesktopGroup $desktopGroup`

Restart the physical office PC.
Delegated Administration

Feb 24, 2016

The Delegated Administration model offers the flexibility to match how your organization wants to delegate administration activities, using role and object-based control. Delegated Administration accommodates deployments of all sizes, and allows you to configure more permission granularity as your deployment grows in complexity. Delegated Administration uses three concepts: administrators, roles, and scopes.

- **Administrators** — An administrator represents an individual person or a group of people identified by their Active Directory account. Each administrator is associated with one or more role and scope pairs.
- **Roles** — A role represents a job function, and has defined permissions associated with it. For example, the Delivery Group Administrator role has permissions such as 'Create Delivery Group' and 'Remove Desktop from Delivery Group.' An administrator can have multiple roles for a Site, so a person could be a Delivery Group Administrator and a Machine Catalog Administrator. Roles can be built-in or custom.

The built-in roles are:

<table>
<thead>
<tr>
<th>Role</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Administrator</td>
<td>Can perform all tasks and operations. A Full Administrator is always combined with the All scope.</td>
</tr>
<tr>
<td>Read Only Administrator</td>
<td>Can see all objects in specified scopes as well as global information, but cannot change anything. For example, a Read Only Administrator with Scope=London can see all global objects (such as Configuration Logging) and any London-scoped objects (for example, London Delivery Groups). However, that administrator cannot see objects in the New York scope (assuming that the London and New York scopes do not overlap).</td>
</tr>
<tr>
<td>Help Desk Administrator</td>
<td>Can view Delivery Groups, and manage the sessions and machines associated with those groups. Can see the Machine Catalog and host information for the Delivery Groups being monitored, and can also perform session management and machine power management operations for the machines in those Delivery Groups.</td>
</tr>
<tr>
<td>Machine Catalog Administrator</td>
<td>Can create and manage Machine Catalogs and provision the machines into them. Can build Machine Catalogs from the virtualization infrastructure, Provisioning Services, and physical machines. This role can manage base images and install software, but cannot assign applications or desktops to users.</td>
</tr>
<tr>
<td>Delivery Group Administrator</td>
<td>Can deliver applications, desktops, and machines; can also manage the associated sessions. Can also manage application and desktop configurations such as policies and power management settings.</td>
</tr>
<tr>
<td>Host Administrator</td>
<td>Can manage host connections and their associated resource settings. Cannot deliver machines, applications, or desktops to users.</td>
</tr>
</tbody>
</table>

In certain product editions, you can create custom roles to match the requirements of your organization, and delegate permissions with more detail. You can use custom roles to allocate permissions at the granularity of an action or task in a console.

- **Scopes** — A scope represents a collection of objects. Scopes are used to group objects in a way that is relevant to your
organization (for example, the set of Delivery Groups used by the Sales team). Objects can be in more than one scope; you can think of objects being labeled with one or more scopes. There is one built-in scope: 'All,' which contains all objects. The Full Administrator role is always paired with the All scope.

Company XYZ decided to manage applications and desktops based on their department (Accounts, Sales, and Warehouse) and their desktop operating system (Windows 7 or Windows 8). The administrator created five scopes, then labeled each Delivery Group with two scopes: one for the department where they are used and one for the operating system they use.

The following administrators were created:

<table>
<thead>
<tr>
<th>Administrator</th>
<th>Roles</th>
<th>Scopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>domain/fred</td>
<td>Full Administrator</td>
<td>All (the Full Administrator role always has the All scope)</td>
</tr>
<tr>
<td>domain/rob</td>
<td>Read Only Administrator</td>
<td>All</td>
</tr>
<tr>
<td>domain/heidi</td>
<td>Read Only Administrator</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Help Desk Administrator</td>
<td>Sales</td>
</tr>
<tr>
<td>domain/warehouseadmin</td>
<td>Help Desk Administrator</td>
<td>Warehouse</td>
</tr>
<tr>
<td>domain/peter</td>
<td>Delivery Group Administrator</td>
<td>Win7</td>
</tr>
<tr>
<td></td>
<td>Machine Catalog Administrator</td>
<td></td>
</tr>
</tbody>
</table>

- Fred is a Full Administrator and can view, edit, and delete all objects in the system.
- Rob can view all objects in the Site but cannot edit or delete them.
- Heidi can view all objects and can perform help desk tasks on Delivery Groups in the Sales scope. This allows her to manage the sessions and machines associated with those groups; she cannot make changes to the Delivery Group, such as adding or removing machines.
- Anyone who is a member of the warehouseadmin Active Directory security group can view and perform help desk tasks on machines in the Warehouse scope.
- Peter is a Windows 7 specialist and can manage all Windows 7 Machine Catalogs and can deliver Windows 7 applications, desktops, and machines, regardless of which department scope they are in. The administrator considered making Peter a Full Administrator for the Win7 scope; however, she decided against this, because a Full Administrator also has full rights over all objects that are not scoped, such as 'Site' and 'Administrator.'

Generally, the number of administrators and the granularity of their permissions depends on the size and complexity of the deployment.
- In small or proof-of-concept deployments, one or a few administrators do everything; there is no delegation. In this case, create each administrator with the built-in Full Administrator role, which has the All scope.
- In larger deployments with more machines, applications, and desktops, more delegation is needed. Several administrators
might have more specific functional responsibilities (roles). For example, two are Full Administrators, and others are Help Desk Administrators. Additionally, an administrator might manage only certain groups of objects (scopes), such as machine catalogs. In this case, create new scopes, plus administrators with one of the built-in roles and the appropriate scopes.

- Even larger deployments might require more (or more specific) scopes, plus different administrators with unconventional roles. In this case, edit or create additional scopes, create custom roles, and create each administrator with a built-in or custom role, plus existing and new scopes.

For flexibility and ease of configuration, you can create new scopes when you create an administrator. You can also specify scopes when creating or editing Machine Catalogs or connections.

When you create a Site as a local administrator, your user account automatically becomes a Full Administrator with full permissions over all objects. After a Site is created, local administrators have no special privileges.

The Full Administrator role always has the All scope; you cannot change this.

By default, an administrator is enabled. Disabling an administrator might be necessary if you are creating the new administrator now, but that person will not begin administration duties until later. For existing enabled administrators, you might want to disable several of them while you are reorganizing your object/scopes, then re-enable them when you are ready to go live with the updated configuration. You cannot disable a Full Administrator if it will result in there being no enabled Full Administrator. The enable/disable check box is available when you create, copy, or edit an administrator.

When you delete a role/scope pair while copying, editing, or deleting an administrator, it deletes only the relationship between the role and the scope for that administrator; it does not delete either the role or the scope, nor does it affect any other administrator who is configured with that role/scope pair.

To manage administrators, click Configuration > Administrators in the Studio navigation pane, and then click the Administrators tab in the upper middle pane.

- To create an administrator, click Create new Administrator in the Actions pane. Type or browse to the user account name, select or create a scope, and select a role. The new administrator is enabled by default; you can change this.
- To copy an administrator, select the administrator in the middle pane and then click Copy Administrator in the Actions pane. Type or browse to the user account name. You can select and then edit or delete any of the role/scope pairs, and add new ones. The new administrator is enabled by default; you can change this.
- To edit an administrator, select the administrator in the middle pane and then click Edit Administrator in the Actions pane. You can edit or delete any of the role/scope pairs, and add new ones.
- To delete an administrator, select the administrator in the middle pane and then click Delete Administrator in the Actions pane. You cannot delete a Full Administrator if it will result in there being no enabled Full Administrator.

Role names can contain up to 64 Unicode characters; they cannot contain the following characters: \ (backslash), / (forward slash), : (semicolon), ; (colon), # (pound sign), * (asterisk), ? (question mark), = (equal sign), < (left arrow), > (right arrow), | (pipe), [ ] (left or right bracket), ( ) (left or right parenthesis), " (quotation marks), and ' (apostrophe). Descriptions can contain up to 256 Unicode characters.

You cannot edit or delete a built-in role. You cannot delete a custom role if any administrator is using it.

Note: Only certain product editions support custom roles. Editions that do not support custom roles do not have related entries in the Actions pane.
To manage roles, click Configuration > Administrators in the Studio navigation pane, and then click the Roles tab in the upper middle pane.

- To view role details, select the role in the middle pane. The lower portion of the middle pane lists the object types and associated permissions for the role. Click the Administrators tab in the lower pane to display a list of administrators who currently have this role.
- To create a custom role, click Create new Role in the Actions pane. Enter a name and description. Select the object types and permissions.
- To copy a role, select the role in the middle pane and then click Copy Role in the Actions pane. Change the name, description, object types, and permissions, as needed.
- To edit a custom role, select the role in the middle pane and then click Edit Role in the Actions pane. Change the name, description, object types, and permissions, as needed.
- To delete a custom role, select the role in the middle pane and then click Delete Role in the Actions pane. When prompted, confirm the deletion.

When you create a Site, the only available scope is the 'All' scope, which cannot be deleted.

You can create scopes using the procedure below. You can also create scopes when you create an administrator; each administrator must be associated with at least one role and scope pair. When you are creating or editing desktops, machine catalogs, applications, or hosts, you can add them to an existing scope; if you do not add them to a scope, they remain part of the 'All' scope.

Site creation cannot be scoped, nor can Delegated Administration objects (scopes and roles). However, objects you cannot scope are included in the 'All' scope. (Full Administrators always have the All scope.) Machines, power actions, desktops, and sessions are not directly scoped; administrators can be allocated permissions over these objects through the associated machine catalogs or Delivery Groups.

Scope names can contain up to 64 Unicode characters; they cannot include the following characters: \\ (backslash), / (forward slash), : (colon), ; (semicolon), # (pound sign), , (comma), * (asterisk), ? (question mark), = (equal sign), < (left arrow), > (right arrow), | (pipe), [] (left or right bracket), () (left or right parenthesis), " (quotation marks), and ' (apostrophe). Descriptions can contain up to 256 Unicode characters.

When you copy or edit a scope, keep in mind that removing objects from the scope can make those objects inaccessible to the administrator. If the edited scope is paired with one or more roles, ensure that the scope updates you make do not make any role/scope pair unusable.

To manage scopes, click Configuration > Administrators in the Studio navigation pane, and then click the Scopes tab in the upper middle pane.

- To create a scope, click Create new Scope in the Actions pane. Enter a name and description. To include all objects of a particular type (for example, Delivery Groups), select the object type. To include specific objects, expand the type and then select individual objects (for example, Delivery Groups used by the Sales team).
- To copy a scope, select the scope in the middle pane and then click Copy Scope in the Actions pane. Enter a name and description. Change the object types and objects, as needed.
- To edit a scope, select the scope in the middle pane and then click Edit Scope in the Actions pane. Change the name, description, object types, and objects, as needed.
- To delete a scope, select the scope in the middle pane and then click Delete Scope in the Actions pane. When prompted, confirm the deletion.
You can create two types of Delegated Administration reports:

- An HTML report that lists the role/scope pairs associated with an administrator, plus the individual permissions for each type of object (for example, Delivery Groups and Machine Catalogs). You generate this report from Studio. To create this report, click Configuration > Administrators in the navigation pane. Select an administrator in the middle pane and then click Create Report in the Actions pane.

You can also request this report when creating, copying, or editing an administrator.

- An HTML or CSV report that maps all built-in and custom roles to permissions. You generate this report by running a PowerShell script named OutputPermissionMapping.ps1.

To run this script, you must be a Full Administrator, a Read Only Administrator, or a custom administrator with permission to read roles. The script is located in: Program Files\Citrix\DelegatedAdmin\SnapIn\Citrix.DelegatedAdmin.Admin.V1\Scripts\.

Syntax:

```
OutputPermissionMapping.ps1 [-Help] [-Csv] [-Path <string>] [-AdminAddress <string>] [-Show] [<CommonParameters>]
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Help</td>
<td>Displays script help.</td>
</tr>
<tr>
<td>-Csv</td>
<td>Specifies CSV output. Default = HTML</td>
</tr>
<tr>
<td>-Path &lt;string&gt;</td>
<td>Where to write the output. Default = stdout</td>
</tr>
<tr>
<td>-AdminAddress &lt;string&gt;</td>
<td>IP address or host name of the Delivery Controller to connect to. Default = localhost</td>
</tr>
<tr>
<td>-Show</td>
<td>(Valid only when the -Path parameter is also specified) When you write the output to a file, -Show causes the output to be opened in an appropriate program, such as a web browser.</td>
</tr>
<tr>
<td>&lt;CommonParameters&gt;</td>
<td>Verbose, Debug, ErrorAction, ErrorVariable, WarningAction, WarningVariable, OutBuffer, and OutVariable. For details, see the Microsoft documentation.</td>
</tr>
</tbody>
</table>

The following example writes an HTML table to a file named Roles.html and opens the table in a web browser.
```
& "$env:ProgramFiles\Citrix\DelegatedAdmin\SnapIn\Citrix.DelegatedAdmin.Admin.V1\Scripts\OutputPermissionMapping.ps1"
-Path Roles.html -Show
```

The following example writes a CSV table to a file named Roles.csv. The table is not displayed.
```
& "$env:ProgramFiles\Citrix\DelegatedAdmin\SnapIn\Citrix.DelegatedAdmin.Admin.V1\Scripts\OutputPermissionMapping.ps1"
-CSV -Path Roles.csv
```

From a Windows command prompt, the preceding example command is:
```
powershell -command "$env:ProgramFiles\%Citrix\DelegatedAdmin\SnapIn\Citrix.DelegatedAdmin.Admin.V1\Scripts\OutputPermissionMapping.ps1"
```

---

https://docs.citrix.com  © 1999-2017 Citrix Systems, Inc. All rights reserved.  p.317
Get-ConfigRegisteredServiceInstance -ServiceType Broker -Binding XML_HTTPS | Unregister-ConfigRegisteredServiceInstance
Get-BrokerServiceInstance | where Binding -eq "XML_HTTPS" | Register-ConfigServiceInstance
Enable-VdaSSL –Enable

Enable-VdaSSL - Enable -SSLPort 400 'SSLMinVersion "TLS_1.2"
-SSLCipherSuite "GOV"

Enable-VdaSSL -Disable
1. Windows print subsystem
   Citrix UPD

2. Sent over ICA/HDX virtual channel

3. Windows print subsystem
   Print driver

4. Printer

ICA/HDX session
Job sent over ICA virtual channel (fallback)
Job sent to print server

Server OS Machine
User workstation
Print server
Network-based printer
HDX 3D Pro optimizes the performance of graphics-intensive programs and media-rich applications.

Configuration

Install the Virtual Delivery Agent (VDA) for HDX 3D Pro?

- No, install the standard VDA
  Recommended for most desktops, including those enabled with Microsoft RemoteFX
- Yes, install the VDA for HDX 3D Pro
  Recommended if the machine will access a graphics processor for 3D rendering.
Features

- Optimize performance
  Optimize desktop settings. Learn more.

- Use Windows Remote Assistance
  Enable Windows Remote Assistance and open TCP port 3389. Learn more.

- Use Real-Time Audio Transport for audio
  Uses UDP ports 16500 - 16509. Learn more.

- Framewark
  Opens UDP ports 3224-3324. Learn more.

Install CT
Enables CT to pass display channel data through the Firewall.

Personal
Enable Personal Desktops.

Framewark uses a bidirectional UDP port range (default is 3224-3324) to exchange Framewark display channel data with Citrix Receiver.

The port range can be customized later in a policy setting: Framewark display channel port range. You must open local firewall ports if changed.

A UDP network path must be open on any internal (from VDA to Receiver; or VDA to NetScaler Gateway) and external (NetScaler Gateway to Receiver) firewalls.

If NetScaler Gateway is deployed, Framewark datagrams are encrypted using DTLS (default port: UDP 443).

Installation

- ENABLE_HDX_PORTS
  Open up HDX ports in Windows firewall.

- ENABLE_REAL_TIME_TRANSPORT
  Opens UDP ports 16500 - 16509 to enable HDX Real-Time Transport for Audio in Windows Firewall.

- ENABLE_Framehawk_PORTS
  Opens UDP ports 3224 - 3324, used to exchange Framewark display channel data with Citrix Receiver, in Windows Firewall.

- ENABLE_REMOTE_ASSISTANCE
  Enable Remote Assistance

- OPTIMIZE
  Set up registry for faster VDA operation

- PORTNUMBER
  Port number to use for VDA <-> controller communication

- REMOVE
  Remove components (instead of installing)

OK
Firewall

The default ports are listed below.

<table>
<thead>
<tr>
<th>Controller Communications</th>
<th>Remote Assistance</th>
<th>Real Time Audio</th>
<th>Framehawk</th>
</tr>
</thead>
<tbody>
<tr>
<td>80 TCP</td>
<td>3389 TCP</td>
<td>16500 - 16509 UDP</td>
<td>3224 - 3324 UDP</td>
</tr>
<tr>
<td>1494 TCP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2598 TCP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8008 TCP</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Configure firewall rules:

- **Automatically**
  Select this option to automatically create the rules in the Windows Firewall. The rules will be created even if the Windows Firewall is turned off.

- **Manually**
  Select this option if you are not using Windows Firewall or if you want to create the rules yourself.
Intelligent Network Detection for Flash Redirection

Scenario A
Network is public.
Flash Redirection is disabled.
Flash content plays on server.

Scenario B
Network is private.
Dialog box lets user choose.
User enables Flash Redirection
Flash content plays on client device for rest of session.

Scenario C
Network is domain authenticated.
Flash Redirection is enabled.
HDX determines network is secure and correct Flash player is installed.

Yes
Install Flash player?
Yes
Dialog box lets user choose.

No
Flash content is played on client device.
User enables Flash Redirection
Flash content plays on server for rest of session.

User does not enable Flash Redirection
Flash content plays on client device for rest of session.

HDX determines network is secure but no Flash player is installed.

HDX cannot determine network security.

User does not enable Flash Redirection
Flash content plays on client device for rest of session.
User control of Flash redirection

Citrix Receiver – Flash dialog box

Citrix Receiver detects outdated version of Flash Player.

Enable HDX MediaStream Flash Redirection on the user device is configured with the settings Enabled and Ask.

The dialog box offers user an opportunity to install correct version.

HDX client uses intelligent network detection.

User opens Citrix Receiver – Desktop Viewer dialog box and selects Flash tab.

User chooses behavior for Flash content in future sessions.

User chooses Optimize.

User chooses Don’t Optimize.

User chooses Ask Me Later.

Flash Redirection is enabled.

Flash content plays on server.

HDX client uses intelligent network detection.
- Reg file start --

Windows Registry Editor Version 5.00

[HKEY_CLASSES_ROOT\ServerFTAHTML\shell\open\command]
@="\"C:\\Program Files (x86)\\Citrix\\system32\\iexplore.exe\" %1"

[HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\ServerFTA]
@="ServerFTA"

[HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\ServerFTA\Capabilities]
"ApplicationDescription"="Server FTA URL"
"ApplicationIcon"="C:\Program Files (x86)\Citrix\system32\iexplore.exe,0"
"ApplicationName"="ServerFTA"

[HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\ServerFTA\Capabilities\URLAssociations]
"http"="ServerFTAHTML"
"https"="ServerFTAHTML"

[HKEY_LOCAL_MACHINE\SOFTWARE\RegisteredApplications]
"Citrix.ServerFTA"="SOFTWARE\Citrix\ServerFTA\Capabilities"

-- Reg file end --
<?xml version="1.0" encoding="UTF-8"?>

<DefaultAssociations>

<Association Identifier="http" ProgId="ServerFTAHTML" ApplicationName="ServerFTA" />

<Association Identifier="https" ProgId="ServerFTAHTML" ApplicationName="ServerFTA" />

</DefaultAssociations>

-- xml file end --
With HDX 3D Pro you can deliver graphically intensive applications as part of hosted desktops or applications on Desktop OS machines. HDX 3D Pro supports physical host computers (including desktop, blade, and rack workstations) and XenServer VMs with GPU Passthrough and XenServer VMs with Virtual GPU (vGPU).

Using XenServer GPU Passthrough, you can create VMs with exclusive access to dedicated graphics processing hardware. You can install multiple GPUs on the hypervisor and assign VMs to each of these GPUs on a one-to-one basis.

Using XenServer vGPU, multiple virtual machines can directly access the graphics processing power of a single physical GPU. The true hardware GPU sharing provides full Windows 7 or Windows 2008 R2 SP1 desktops suitable for users with complex and demanding design requirements. Supported for NVIDIA GRID K1 and K2 cards, the GPU sharing uses the same NVIDIA graphics drivers that are deployed on non-virtualized operating systems.

HDX 3D Pro offers the following features:

- Adaptive H.264-based deep compression for optimal WAN and wireless performance. HDX 3D Pro uses CPU-based deep compression as the default compression technique for encoding. This provides optimal compression that dynamically adapts to network conditions. The H.264-based deep compression codec no longer competes with graphics rendering for CUDA cores on the NVIDIA GPU. The deep compression codec runs on the CPU and provides bandwidth efficiency.

- Lossless compression option for specialized use cases. HDX 3D Pro also offers a CPU-based lossless codec to support applications where pixel-perfect graphics are required, such as medical imaging. Lossless compression is recommended only for specialized use cases because it consumes significantly more network and processing resources.

  When using lossless compression:
  - The lossless indicator, a system tray icon, notifies the user if the screen displayed is a lossy frame or a lossless frame. This helps when the Visual Quality policy setting specifies Build to lossless. The lossless indicator turns green when the frames sent are lossless.
  - The lossless switch enables the user to change to Always Lossless mode anytime within the session. To select or deselect Lossless anytime within a session, right-click the icon or use the shortcut ALT+SHIFT+1.
  
  For lossless compression: HDX 3D Pro uses the lossless codec for compression regardless of the codec selected through policy.
  
  For lossy compression: HDX 3D Pro uses the original codec, either the default or the one selected through policy.

  Lossless switch settings are not retained for subsequent sessions. To use lossless codec for every connection, select Always lossless in the Visual quality policy setting.

  You can override the default shortcut, ALT+SHIFT+1, to select or deselect Lossless within a session. Configure a new registry setting at HKLM\SOFTWARE\Citrix\HDX3D\LLIndicator.
  
  Name: HKLM_HotKey, Type: String
  The format to configure a shortcut combination is C=0|1, A=0|1, S=0|1, W=0|1, K=val. Keys must be comma "," separated. The order of the keys does not matter.
  
  A, C, S, W and K are keys, where C=Control, A=ALT, S=SHIFT, W=Win, and K=a valid key. Allowed values for K are 0-9, a-z, and any virtual key code. For more information on virtual key codes, see Virtual-Key Codes on MSDN.

  For example:
  
  For F10, set K=0x79
  For Ctrl + F10, set C=1, K=0x79
  For Alt + A, set A=1, K=a or A=1, K=A or K=a, A=1
  For Ctrl + Alt + 5, set C=1, A=1, K=5 or A=1, K=5, C=1
  For Ctrl + Shift + F5, set A=1, S=1, K=0x74

  Caution: Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

- Multiple and high resolution monitor support. For Windows 7 and Windows 8 desktops, HDX 3D Pro supports user devices with up to four monitors. Users can arrange their monitors in any configuration and can mix monitors with different resolutions and orientations. The number of monitors is limited by the capabilities of the host computer GPU, the user device, and the available bandwidth. HDX 3D Pro supports all monitor resolutions and is limited only by the capabilities of the GPU on the host computer.

  HDX 3D Pro also provides limited support for dual-monitor access to Windows XP desktops. For more information about this, see VDAs on machines running Windows XP or Windows Vista.
- Dynamic resolution. You can resize the virtual desktop or application window to any resolution. **Note:** The only supported method to change the resolution is by resizing the VDA session window. Changing resolution from within the VDA session (using Control Panel > Appearance and Personalization > Display > Screen Resolution) is not supported.
- Support for NVIDIA Kepler architecture. HDX 3D Pro supports NVIDIA GRID K1 and K2 cards for GPU passthrough and GPU sharing. NVIDIA GRID vGPU enables multiple VMs to have simultaneous, direct access to a single physical GPU, using the same NVIDIA graphics drivers that are deployed on non-virtualized operating systems.
- Support for VMware vSphere and VMware ESX using Virtual Direct Graphics Acceleration (vDGA) - You can use HDX 3D Pro with vDGA for both RDS and VDI workloads. When using HDX 3D Pro with Virtual Shared Graphics Acceleration (vSGA), support is limited to one monitor. Using vSGA with large 3D models can result in performance issues due to its use of API intercept technology. For more information, see [VMware vSphere 5.1 - Citrix Known Issues](https://docs.citrix.com).

As shown in the following figure:
- The host computer must reside within the same Active Directory domain as the Delivery Controller.
- When a user logs on to Citrix Receiver and accesses the virtual application or desktop, the Controller authenticates the user and contacts the VDA for HDX 3D Pro to broker a connection to the computer hosting the graphical application.
- The VDA for HDX 3D Pro uses the appropriate hardware on the host to compress views of the complete desktop or of just the graphical application.
- The desktop or application views and the user interactions with them are transmitted between the host computer and the user device through a direct HDX connection between Citrix Receiver and the VDA for HDX 3D Pro.
; This is to enable Real-Time Transport

EnableRtpAudio=true

; This is to Allow Real-Time Transport Through gateway

EnableUDPTroughGateway=true

; This is to set audio quality to Medium

AudioBandwidthLimit=1-

; UDP Port range

RtpAudioLowestPort=16500

RtpAudioHighestPort=16509
Network traffic priorities

Sep 29, 2015

Priorities are assigned to network traffic across multiple connections for a session with quality of service (QoS)-supported routers. Four TCP/IP streams (real-time, interactive, background, and bulk) and one UDP/RTP stream (for voice) are available to carry ICA traffic between the user device and the server. Each virtual channel is associated with a specific priority and transported in the corresponding connection. You can set the channels independently, based on the TCP port number used for the connection.

Multiple channel streaming connections are supported for Virtual Delivery Agents (VDAs) installed on Windows 8 and Windows 7 machines. Work with your network administrator to ensure the Common Gateway Protocol (CGP) ports configured in the Multi-Port Policy setting are assigned correctly on the network routers.

Quality of service (QoS) is supported only when multiple session reliability ports, or the CGP ports, are configured.

Caution: Use transport security when using this feature. Citrix recommends using Internet Protocol Security (IPsec) or Transport Layer Security (TLS). TLS connections are supported only when the connections traverse a NetScaler Gateway that supports multi-stream. On an internal corporate network, multi-stream connections with TLS are not supported.

To set quality of service for multiple streaming connections, add the following Citrix policy settings to a policy (see Multi-stream connections policy settings for details):

- **Multi-Port policy** - This setting specifies ports for ICA traffic across multiple connections, and establishes network priorities.
  - Select a priority from the CGP default port priority list; by default, the primary port (2598) has a High priority.
  - Enter additional CGP ports in CGP port1, CGP port2, and CGP port3 as needed, and identify priorities for each. Each port must have a unique priority.

  Explicitly configure the firewalls on VDAs to allow the additional TCP traffic.

- **Multi-Stream computer setting** - This setting is disabled by default. If you use Citrix Cloudbridge with Multi-Stream support in your environment, you do not need to configure this setting. Configure this policy setting when using third-party routers or legacy Branch Repeaters to achieve the desired Quality of Service (QoS).
- **Multi-Stream user setting** - This setting is disabled by default.

For policies containing these settings to take effect, users must log off and then log on to the network.
USB and client drive considerations

Sep 29, 2015

Using HDX USB device redirection, a user can connect a flash drive to a local computer and access it remotely from within a virtual desktop or a desktop hosted application. During a session, users can use plug and play devices, including Picture Transfer Protocol (PTP) devices such as digital cameras, Media Transfer Protocol (MTP) devices such as digital audio players or portable media players, and point-of-sale (POS) devices.

Double-hop USB is not supported for desktop hosted application sessions.

USB redirection is available for the Citrix Receiver for Windows and the Citrix Receiver for Linux.

By default, USB redirection is allowed for certain classes of USB devices, and denied for others; see the Citrix Receiver documentation for details. You can restrict the types of USB devices made available to a virtual desktop by updating the list of USB devices supported for redirection.

**Important**

In environments where security separation between the user device and server is needed, provide guidance to users about the types of USB devices to avoid.

Optimized virtual channels are available to redirect most popular USB devices, and provide performance and bandwidth efficiency over a WAN. The level of support provided depends on the Citrix Receiver installed on the user device. Optimized virtual channels are usually the best option, especially in high latency environments.

For USB redirection purposes, the product handles a SMART board the same as a mouse.

The product supports optimized virtual channels with USB 3.0 devices and USB 3.0 ports, such as a CDM virtual channel used to view files on a camera or to provide audio to a headset. The product also supports Generic USB Redirection of USB 3.0 devices connected to a USB 2.0 port.

Specialty devices for which there is no optimized virtual channel are supported by falling back to a Generic USB virtual channel that provides raw USB redirection. For information on USB devices tested with XenDesktop, see CTX123569.

Some advanced device-specific features, such as Human Interface Device (HID) buttons on a webcam, may not work as expected with the optimized virtual channel; if this is an issue, use the Generic USB virtual channel.

Certain devices are not redirected by default, and are available only to the local session. For example, it would not be appropriate to redirect a network interface card that is attached to the user device's system board by internal USB.

The following Citrix policy settings control USB support:

- **Client USB device optimization rules.** The optimization mode is supported for input devices for class=03, for example, signature devices and drawing tablets. If no rule is specified, then the device is handled as Interactive mode (02). Capture mode (04) is the recommended mode for signature devices.

- **Client USB device redirection.** The default is Prohibited.

- **Client USB device redirection rules.** Rules only apply to devices using Generic USB redirection; therefore, the rules do not apply to devices using specialized or optimized redirection, such as CDM.

- **Client USB Plug and Play device redirection.** The default is Allowed, to permit plug-and-play of PTP, MTP, and POS devices.

---

https://docs.citrix.com  © 1999-2017 Citrix Systems, Inc. All rights reserved.  p.403
About USB Generic Redirection

Generic USB Redirection is for specialty USB devices for which there is no optimized virtual channel. This functionality redirects arbitrary USB devices from client machines to virtual desktops; with this feature, end users have the ability to interact with a wide selection of generic USB devices in the desktop session as if the devices were physically attached.

With Generic USB Redirection:

- Users do not need to install device drivers on the user device
- USB client drivers are installed on the VDA machine

This feature is supported for desktop sessions from VDA for Desktop OS, minimum version 7.6.

This feature is also supported for desktop sessions from VDA for Server OS, minimum version 7.6, with these restrictions:

- The VDA machine must be running Windows Server 2012 R2
- Only single-hop scenarios are supported
- The USB client drivers must be compatible with RDSH for Windows 2012 R2
- USB storage devices, audio devices, smartcard reader, and devices that are not fully virtualized are not supported

For more information on configuring Generic USB Redirection, see CTX137939.

Enable USB support

1. Add the Client USB device redirection setting to a policy and set its value to Allowed.
2. [Optional] To update the list of USB devices available for remoting, add the Client USB device redirection rules setting to a policy and specify the USB policy rules.
3. Enable USB support when you install Citrix Receiver on user devices. If you specified USB policy rules for the VDA in the previous step, specify those same policy rules for Citrix Receiver. For thin clients, consult the manufacturer for details of USB support and any required configuration.

Update the list of USB devices available for remoting (Citrix Receiver for Windows 4.2)

USB devices are automatically redirected when USB support is enabled and the USB user preference settings are set to automatically connect USB devices. USB devices are also automatically redirected when operating in Desktop Appliance mode and the connection bar is not present. In some instances, however, you might not want to automatically redirect all USB devices. For more information, see CTX123015.

Users can explicitly redirect devices that are not automatically redirected by selecting them from the USB device list. To prevent USB devices from ever being listed or redirected, you can specify device rules on the client and the VDA, as explained below.

You can update the range of USB devices available for remoting by specifying USB device redirection rules for both Citrix Receiver and the VDA to override the default USB policy rules.

- Edit the user device registry. An administrative template (ADM file) is included on the installation media so you can change the user device through Active Directory Group Policy: dvd root \os\lang\Support\Configuration\icaclient_usb.adm.
- Edit the administrator override rules for the Server OS machines through group policy rules. The Group Policy
Management Console is included on the installation media:
- For x64: dvd root \os\lang\x64\Citrix Policy\ CitrixGroupPolicyManagement_x64.msi
- For x86: dvd root \os\lang\x86\Citrix Policy\ CitrixGroupPolicyManagement_x86.msi

**Warning**

Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

The product default rules are stored in HKLM\SOFTWARE\Citrix\PortICA\GenericUSB\DeviceRules. Do not edit these product default rules. Instead, use them as a guide for creating administrator override rules as explained below. The GPO overrides are evaluated before the product default rules.

The administrator override rules are stored in HKLM\SOFTWARE\Policies\Citrix\PortICA\GenericUSB\DeviceRules. GPO policy rules take the format `{Allow:|Deny:}` followed by a set of tag=value expressions separated by white space. The following tags are supported:

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VID</td>
<td>Vendor ID from the device descriptor</td>
</tr>
<tr>
<td>PID</td>
<td>Product ID from the device descriptor</td>
</tr>
<tr>
<td>REL</td>
<td>Release ID from the device descriptor</td>
</tr>
<tr>
<td>Class</td>
<td>Class from either the device descriptor or an interface descriptor; see the USB Web site at <a href="http://www.usb.org/">http://www.usb.org/</a> for available USB Class Codes</td>
</tr>
<tr>
<td>SubClass</td>
<td>Subclass from either the device descriptor or an interface descriptor</td>
</tr>
<tr>
<td>Prot</td>
<td>Protocol from either the device descriptor or an interface descriptor</td>
</tr>
</tbody>
</table>

When creating new policy rules, note the following:
- Rules are case-insensitive.
- Rules may have an optional comment at the end, introduced by #. A delimiter is not required, and the comment is ignored for matching purposes.
- Blank and pure comment lines are ignored.
- White space is used as a separator, but cannot appear in the middle of a number or identifier. For example, Deny: Class = 08 SubClass=05 is a valid rule, but Deny: Class=0 Sub Class=05 is not.
- Tags must use the matching operator =. For example, VID=1230.
- Each rule must start on a new line or form part of a semicolon-separated list.
When working with optimized devices such as mass storage, you usually redirect the device using the specialized CDM channel rather than with policy rules. However, you can override this behavior in one of the following ways:

- Manually redirect optimized device using Generic USB redirection, choose Switch to Generic from the Devices tab of the Preferences dialog box.
- Automatically redirect optimized device using Generic USB redirection, set auto-redirection for storage device (for example, AutoRedirectStorage = 1) and set USB user preference settings to automatically connect USB devices; for more information, see CTX123015.

Examples:

- The following example shows an administrator-defined USB policy rule for vendor and product identifiers:
  
  **Allow:** VID=046D PID=C626 # Allow Logitech SpaceNavigator 3D Mouse  
  **Deny:** VID=046D # Deny all Logitech products

- The following example shows an administrator-defined USB policy rule for a defined class, sub-class, and protocol:
  
  **Deny:** Class=EF SubClass=01 Prot=01 # Deny MS Active Sync devices  
  **Allow:** Class=EF SubClass=01 # Allow Sync devices  
  **Allow:** Class=EF # Allow all USB-Miscellaneous devices

Update the list of USB devices available for remoting

By default, USB devices are automatically redirected when USB support is enabled and the USB user preference settings are set to automatically connect USB devices. USB devices are also automatically redirected for Desktop Appliance sites or desktop hosted applications. In some instances, however, you might not want to automatically redirect all USB devices. For more information, see CTX123015.

Desktop Viewer users can redirect devices that are not automatically redirected by selecting them from the USB device list. To prevent USB devices from being listed or redirected, specify device rules on the user device and the VDA.

You can update the range of USB devices available for remoting by specifying USB device redirection rules for both Citrix Receiver and the VDA to override the default USB policy rules. Device rules are enforced for both Citrix Receiver and the VDA. Be sure to change both so that device remoting works as you intend.

- Edit the user device registry (or the .ini files in the case of the Citrix Receiver for Linux). An Administrative template (ADM file) is included on the installation media so you can change the user device through Active Directory Group Policy: dvd root \os\lang\Support\Configuration\icaclient_usb.adm
- Edit the administrator override rules in the VDA registry on the Server OS machines. An ADM file is included on the installation media so you can change the VDA through Active Directory Group Policy: dvd root \os\lang\Support\Configuration\vda_usb.adm.

Warning

Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be
The product default rules are stored in HKLM\SOFTWARE\Citrix\PortICA\GenericUSB\DeviceRules. Do not edit these product default rules. Instead, use them as a guide for creating administrator override rules as explained below. The GPO overrides are evaluated before the product default rules.

The administrator override rules are stored in HKLM\SOFTWARE\Policies\Citrix\PortICA\GenericUSB\DeviceRules. GPO policy rules take the format {Allow:|Deny:} followed by a set of tag=value expressions separated by white space. The following tags are supported:

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VID</td>
<td>Vendor ID from the device descriptor</td>
</tr>
<tr>
<td>PID</td>
<td>Product ID from the device descriptor</td>
</tr>
<tr>
<td>REL</td>
<td>Release ID from the device descriptor</td>
</tr>
<tr>
<td>Class</td>
<td>Class from either the device descriptor or an interface descriptor; see the USB Web site at <a href="http://www.usb.org/">http://www.usb.org/</a> for available USB Class Codes</td>
</tr>
<tr>
<td>SubClass</td>
<td>Subclass from either the device descriptor or an interface descriptor</td>
</tr>
<tr>
<td>Prot</td>
<td>Protocol from either the device descriptor or an interface descriptor</td>
</tr>
</tbody>
</table>

When creating new policy rules, note the following:
- Rules are case-insensitive.
- Rules may have an optional comment at the end, introduced by #. A delimiter is not required, and the comment is ignored for matching purposes.
- Blank and pure comment lines are ignored.
- White space is used as a separator, but cannot appear in the middle of a number or identifier. For example, Deny: Class = 08 SubClass=05 is a valid rule, but Deny: Class=0 Sub Class=05 is not.
- Tags must use the matching operator =. For example, VID=1230.
- Each rule must start on a new line or form part of a semicolon-separated list.

**Important**

If you are using the ADM template file, you must create rules on a single line, as a semicolon-separated list.

When working with optimized devices such as mass storage, you usually redirect the device using the specialized CDM channel rather than with policy rules. However, you can override this behavior in one of the following ways:
- Manually redirect optimized device using Generic USB redirection, choose Switch to Generic from the Devices tab of the...
Preferences dialog box.

- Automatically redirect optimized device using Generic USB redirection; set auto-redirection for storage device (for example, AutoRedirectStorage = 1) and set USB user preference settings to automatically connect USB devices; for more information, see CTX123015.

Examples:

- The following example shows an administrator-defined USB policy rule for vendor and product identifiers:
  
  **Allow:** VID=046D PID=C626 # Allow Logitech SpaceNavigator 3D Mouse
  
  **Deny:** VID=046D # Deny all Logitech products

- The following example shows an administrator-defined USB policy rule for a defined class, sub-class, and protocol:
  
  **Deny:** Class=EF SubClass=01 Prot=01 # Deny MS Active Sync devices
  
  **Allow:** Class=EF SubClass=01 # Allow Sync devices
  
  **Allow:** Class=EF # Allow all USB-Miscellaneous devices

Use and remove USB devices

Users can connect a USB device before or after starting a virtual session.

When using Citrix Receiver for Windows, the following apply:

- Devices connected after a session starts appear immediately in the USB menu of the Desktop Viewer.
- If a USB device is not redirecting properly, you can try to resolve the problem by waiting to connect the device until after the virtual session starts.
- To avoid data loss, use the Windows “Safely Remove Hardware” icon before removing the USB device.

USB mass storage devices

For mass storage devices only, remote access is also available through client drive mapping, where the drives on the user device are automatically mapped to drive letters on the virtual desktop when users log on. The drives are displayed as shared folders with mapped drive letters. To configure client drive mapping, use the Client removable drives setting in the File Redirection Policy Settings section of the ICA Policy Settings.

The main differences between the two types of remoting policy are:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Client drive mapping</th>
<th>Generic USB redirection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled by default</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Read-only access configurable</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Safe to remove device during a session</td>
<td>No</td>
<td>Yes, provided users follow operating system recommendations for safe removal</td>
</tr>
</tbody>
</table>

If both Generic USB and the client drive mapping policies are enabled and a mass storage device is inserted either before or after a session starts, it will be redirected using client drive mapping. When both Generic USB and the client drive mapping policies are enabled and a device is configured for automatic redirection (see http://support.citrix.com/article/CTX123015) and a mass storage device is inserted either before or after a session starts, it will be redirected using Generic USB.
Note

USB redirection is supported over lower bandwidth connections, for example 50 Kbps, however copying large files will not work.

File access for mapped client drives

You can control whether users can copy files from their virtual environments to their user devices. By default, files and folders on mapped client-drives are available in read/write mode from within the session.

To prevent users from adding or modifying files and folders on mapped client-devices, enable the Read-only client drive access policy setting. When adding this setting to a policy, make sure the Client drive redirection setting is set to Allowed and is also added to the policy.
Policies

Sep 29, 2015

Policies are a collection of settings that define how sessions, bandwidth, and security are managed for a group of users, devices, or connection types.

You can apply policy settings to physical and virtual machines or to users. You can apply settings to individual users at the local level or in security groups in Active Directory. The configurations define specific criteria and rules, and if you do not specifically assign the policies, the settings are applied to all connections.

You can apply policies on different levels of the network. Policy settings placed at the Organizational Unit GPO level take the highest precedence on the network. Policies at the Domain GPO level override policies on the Site Group Policy Object level, which override any conflicting policies on both the Microsoft and Citrix Local Policies levels.

All Citrix Local Policies are created and managed in the Citrix Studio console and stored in the Site Database; whereas, Group Policies are created and managed with the Microsoft Group Policy Management Console (GPMC) and stored in Active Directory. Microsoft Local Policies are created in the Windows Operating System and are stored in the registry.

Studio uses a Modeling Wizard to help administrators compare configuration settings within templates and policies to help eliminate conflicting and redundant settings. Administrators can set GPOs using the GPMC to configure settings and apply them to a target set of users at different levels of the network.

These GPOs are saved in Active Directory, and access to the management of these settings is generally restricted for most of IT for security.

Settings are merged according to priority and their condition. Any disabled setting overrides a lower-ranked enabled setting. Unconfigured policy settings are ignored and do not override lower-ranked settings.

Local policies can also have conflicts with group policies in the Active Directory, which could override each other depending on the situation.

All policies are processed in the following order:

1. The end user logs on to a machine using domain credentials.
2. Credentials are sent to the domain controller.
3. Active Directory applies all policies (end user, endpoint, organizational unit, and domain).
4. The end user logs on to Receiver and accesses an application or desktop.
5. Citrix and Microsoft policies are processed for the end user and machine hosting the resource.

6. Active Directory determines precedence for policy settings and applies them to the registries of the endpoint device and to the machine hosting the resource.

7. The end user logs off from the resource. Citrix policies for the end user and endpoint device are no longer active.

8. The end user logs off the user device, which releases the GPO user policies.

9. The end user turns off the device, which releases the GPO machine policies.

When creating policies for groups of users, devices, and machines, some members may have different requirements and would need exceptions to some policy settings. Exceptions are made by way of filters in Studio and the GPMC that determine who or what the policy affects.

**Note:** Mixing Windows and Citrix policies in the same GPO is not supported.

**Related content**

- Work with policies
- Policy templates
- Create policies
- Compare, prioritize, model, and troubleshoot policies
- Default policy settings
- Policy settings reference
Work with policies

Sep 29, 2015

Configure Citrix policies to control user access and session environments. Citrix policies are the most efficient method of controlling connection, security, and bandwidth settings. You can create policies for specific groups of users, devices, or connection types. Each policy can contain multiple settings.

Tools for working with Citrix policies

You can use the following tools to work with Citrix policies.

- **Studio** - If you are a Citrix administrator without permission to manage group policy, use Studio to create policies for your site. Policies created using Studio are stored in the site database and updates are pushed to the virtual desktop either when that virtual desktop registers with the broker or when a user connects to that virtual desktop.

- **Local Group Policy Editor** (Microsoft Management Console snap-in) - If your network environment uses Active Directory and you have permission to manage group policy, you can use the Local Group Policy Editor to create policies for your Site. The settings you configure affect the Group Policy Objects (GPOs) you specify in the Group Policy Management Console.

  Important: You must use the Local Group Policy Editor to configure some policy settings, including those related to registering VDAs with a Controller and those related to Microsoft App-V servers.

Policy processing order and precedence

Group policy settings are processed in the following order:

1. Local GPO
2. XenApp or XenDesktop Site GPO (stored in the Site database)
3. Site-level GPOs
4. Domain-level GPOs
5. Organizational Units

However, if a conflict occurs, policy settings that are processed last can overwrite those that are processed earlier. This means that policy settings take precedence in the following order:

1. Organizational Units
2. Domain-level GPOs
3. Site-level GPOs
4. XenApp or XenDesktop Site GPO (stored in the Site database)
5. Local GPO

For example, a Citrix administrator uses Studio to create a policy (Policy A) that enables client file redirection for the company's sales employees. Meanwhile, another administrator uses the Group Policy Editor to create a policy (Policy B) that disables client file redirection for sales employees. When the sales employees log on to the virtual desktops, Policy B is applied and Policy A is ignored because Policy B was processed at the domain level and Policy A was processed at the XenApp or XenDesktop Site GPO level.

However, when a user launches an ICA or Remote Desktop Protocol (RDP) session, Citrix session settings override the same settings configured in an Active Directory policy or using Remote Desktop Session Host Configuration. This includes settings that are related to typical RDP client connection settings such as Desktop wallpaper, Menu animation, and View window contents while dragging.
When using multiple policies, you can prioritize policies that contain conflicting settings; see Compare, prioritize, model, and troubleshoot policies for details.

Workflow for Citrix policies

The process for configuring policies is as follows:
1. Create the policy.
2. Configure policy settings.
3. Assign the policy to machine and user objects.
4. Prioritize the policy.
5. Verify the effective policy by running the Citrix Group Policy Modeling wizard.

Navigate Citrix policies and settings

In the Local Group Policy Editor, policies and settings appear in two categories: Computer Configuration and User Configuration. Each category has a Citrix Policies node. See the Microsoft documentation for details about navigating and using this snap-in.

In Studio, policy settings are sorted into categories based on the functionality or feature they affect. For example, the Profile management section contains policy settings for Profile management.

- Computer settings (policy settings applying to machines) define the behavior of virtual desktops and are applied when a virtual desktop starts. These settings apply even when there are no active user sessions on the virtual desktop. User settings define the user experience when connecting using ICA. User policies are applied when a user connects or reconnects using ICA. User policies are not applied if a user connects using RDP or logs on directly to the console.

To access policies, settings, or templates, select Policies in the Studio navigation pane.

- The Policies tab lists all policies. When you select a policy, tabs to the right display: Overview (name, priority, enabled/disabled status, and description), Settings (list of configured settings), and Assigned to (user and machine objects to which the policy is currently assigned). For more information, see Create policies.

- The Templates tab lists Citrix-provided and custom templates you created. When you select a template, tabs to the right display: Description (why you might want to use the template) and Settings (list of configured settings). For more information, see Policy templates.

- The Comparison tab enables you to compare the settings in a policy or template with those in other policies or templates. For example, you might want to verify setting values to ensure compliance with best practices. For more information, see Compare, prioritize, model, and troubleshoot policies.

- From the Modelling tab, you can simulate connection scenarios with Citrix policies. For more information, see Compare, prioritize, model, and troubleshoot policies.

To search for a setting in a policy or template:
1. Select the policy or template.
2. Select Edit policy or Edit Template in the Actions pane.
3. On the Settings page, begin to type the name of the setting.

You can refine your search by selecting a specific product version, selecting a category (for example, Bandwidth), or by selecting the View selected only check box or selecting to search only the settings that have been added to the selected policy. For an unfiltered search, select All Settings.

- To search for a setting within a policy:
  1. Select the policy.
  2. Select the Settings tab, begin to type the name of the setting.

You can refine your search by selecting a specific product version or by selecting a category. For an unfiltered search, select
A policy, once created, is completely independent of the template used. You can use the Description field on a new policy to keep track of the source template used.

In Studio, policies and templates are displayed in a single list regardless of whether they contain user, computer or both types of settings and can be applied using both user and computer filters.

In Group Policy Editor, Computer and User settings must be applied separately, even if created from a template that contains both types of settings. In this example choosing to use Very High Definition User Experience in Computer Configuration:

- Legacy Graphics mode is a Computer setting that will be used in a policy created from this template.
- The User settings, grayed out, will not be used in a policy created from this template.
Policy templates

Sep 29, 2015

Templates are a source for creating policies from a predefined starting point. Built-in Citrix templates, optimized for specific environments or network conditions, can be used as:

- A source for creating your own policies and templates to share between sites.
- A reference for easier comparison of results between deployments as you will be able to quote the results, for example, "...when using Citrix template x or y...".
- A method for communicating policies with Citrix Support or trusted third parties by importing or exporting templates.

Policy templates can be imported or exported. For additional templates and updates to the built-in templates, see CTX202000.

For considerations when using templates to create policies, see CTX202330.

Built-in Citrix templates

The following policy templates are available:

- **Very High Definition User Experience.** This template enforces default settings which maximize the user experience. Use this template in scenarios where multiple policies are processed in order of precedence.
- **High Server Scalability.** Apply this template to economize on server resources. This template balances user experience and server scalability. It offers a good user experience while increasing the number of users you can host on a single server. This template does not use video codec for compression of graphics and prevents server side multimedia rendering.
- **High Server Scalability-Legacy OS.** This High Server Scalability template applies only to VDAs running Windows Server 2008 R2 or Windows 7 and earlier. This template relies on the Legacy graphics mode which is more efficient for those operating systems.
- **Optimized for WAN.** This template is intended for task workers in branch offices using a shared WAN connection or remote locations with low bandwidth connections accessing applications with graphically simple user interfaces with little multimedia content. This template trades off video playback experience and some server scalability for optimized bandwidth efficiency.
- **Optimized for WAN-Legacy OS.** This Optimized for WAN template applies only to VDAs running Windows Server 2008 R2 or Windows 7 and earlier. This template relies on the Legacy graphics mode which is more efficient for those operating systems.
- **Security and Control.** Use this template in environments with low tolerance to risk, to minimize the features enabled by default in XenApp and XenDesktop. This template includes settings which will disable access to printing, clipboard, peripheral devices, drive mapping, port redirection, and Flash acceleration on user devices. Applying this template may use more bandwidth and reduce user density per server.

While we recommend using the built-in Citrix templates with their default settings, you will find settings that do not have a specific recommended value, for example, Overall session bandwidth limit, included in the Optimized for WAN templates. In this case, the template exposes the setting so the administrator will understand this setting is likely to apply to the scenario.
If you are working with a deployment (policy management and VDAs) prior to XenApp and XenDesktop 7.6 FP3, and require High Server Scalability and Optimized for WAN templates, please use the Legacy OS versions of these templates when these apply.

**Note**

Built-in templates are created and updated by Citrix. You cannot modify or delete these templates.

Create and manage templates using Studio

To create a new template based on a template:

1. Select **Policies** in the Studio navigation pane.
2. Select the **Templates** tab and then select the template from which you will create the new template.
3. Select **Create Template** in the Actions pane.
4. Select and configure the policy settings to include in the template. Remove any existing settings that should not be included. Enter a name for the template.

After you click **Finish**, the new template appears on the **Templates** tab.

To create a new template based on a policy:
1. Select **Policies** in the Studio navigation pane.

2. Select the **Policies** tab and then select the policy from which you will create the new template.

3. Select **Save as Template** in the Actions pane.

4. Select and configure any new policy settings to include in the template. Remove any existing settings that should not be included. Enter a name and description for the template, and then click **Finish**.

To import a template:

1. Select **Policies** in the Studio navigation pane.

2. Select the **Templates** tab and then select **Import Template**.

3. Select the template file to import and then click **Open**. If you import a template with the same name as an existing template, you can choose to overwrite the existing template or save the template with a different name that is generated automatically.

To export a template:

1. Select **Policies** in the Studio navigation pane.

2. Select the **Templates** tab and then select **Export Template**.

3. Select the location where you want to save the template and then click **Save**.

A .gpt file is created in the specified location.

Create and manage templates using the Group Policy Editor

From the Group Policy Editor, expand Computer Configuration or User Configuration. Expand the Policies node and then select Citrix Policies. Choose the appropriate action below.

<table>
<thead>
<tr>
<th>Task</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new template from an existing policy</td>
<td>On the Policies tab, select the policy and then select Actions &gt; Save as Template.</td>
</tr>
<tr>
<td>Create a new policy from an existing template</td>
<td>On the Templates tab, select the template and then click New Policy.</td>
</tr>
<tr>
<td>Create a new template from an existing template</td>
<td>On the Templates tab, select the template and then click New Template.</td>
</tr>
<tr>
<td>Import a template</td>
<td>On the Templates tab, select Actions &gt; Import.</td>
</tr>
<tr>
<td>Export a template</td>
<td>On the Templates tab, select Actions &gt; Export.</td>
</tr>
<tr>
<td>View template settings</td>
<td>On the Templates tab, select the template and then click the Settings tab.</td>
</tr>
<tr>
<td>View a summary of template properties</td>
<td>On the Templates tab, select the template and then click the Properties tab.</td>
</tr>
<tr>
<td>View template prerequisites</td>
<td>On the Templates tab, select the template and then click the Prerequisites tab.</td>
</tr>
</tbody>
</table>
Templates and Delegated Administration

Policy templates are stored on the machine where the policy management package was installed. This machine is either the Delivery Controller machine or the Group Policy Objects management machine - not the XenApp and XenDesktop Site's database. This means that the policy template files are controlled by Windows administrative permissions rather than Site's Delegated Administration roles and scopes.

As a result, an administrator with read-only permission in the Site can, for example, create new templates. However, because templates are local files, no changes are actually made to your environment.

Custom templates are only visible to the user account that creates them and stored in the user's Windows profile. To expose a custom template further, create a policy from it or export it to a shared location.
Create policies

Sep 22, 2015
Before creating a policy, decide which group of users or devices it should affect. You may want to create a policy based on user job function, connection type, user device, or geographic location. Alternatively, you can use the same criteria that you use for Windows Active Directory group policies.

If you already created a policy that applies to a group, consider editing that policy and configuring the appropriate settings, instead of creating another policy. Avoid creating a new policy solely to enable a specific setting or to exclude the policy from applying to certain users.

When you create a new policy, you can base it on settings in a policy template and customize settings as needed, or you can create it without using a template and add all the settings you need.

Policy settings

Policy settings can be enabled, disabled, or not configured. By default, policy settings are not configured, which means they are not added to a policy. Settings are applied only when they are added to a policy.

Some policy settings can be in one of the following states:

- Allowed or Prohibited allows or prevents the action controlled by the setting. In some cases, users are allowed or prevented from managing the setting's action in a session. For example, if the Menu animation setting is set to Allowed, users can control menu animations in their client environment.
- Enabled or Disabled turns the setting on or off. If you disable a setting, it is not enabled in lower-ranked policies.

In addition, some settings control the effectiveness of dependent settings. For example, Client drive redirection controls whether or not users are allowed to access the drives on their devices. To allow users to access their network drives, both this setting and the Client network drives setting must be added to the policy. If the Client drive redirection setting is disabled, users cannot access their network drives, even if the Client network drives setting is enabled.

In general, policy setting changes that impact machines go into effect either when the virtual desktop restarts or when a user logs on. Policy setting changes that impact users go into effect the next time users log on. If you are using Active Directory, policy settings are updated when Active Directory re-evaluates policies at 90-minute intervals and applied either when the virtual desktop restarts or when a user logs on.

For some policy settings, you can enter or select a value when you add the setting to a policy. You can limit configuration of the setting by selecting Use default value; this disables configuration of the setting and allows only the setting's default value to be used when the policy is applied, regardless of the value that was entered before selecting Use default value.

As best practice:
- Assign policies to groups rather than individual users. If you assign policies to groups, assignments are updated automatically when you add or remove users from the group.
- Do not enable conflicting or overlapping settings in Remote Desktop Session Host Configuration. In some cases, Remote Desktop Session Host Configuration provides similar functionality to Citrix policy settings. When possible, keep all settings consistent (enabled or disabled) for ease of troubleshooting.
- Disable unused policies. Policies with no settings added create unnecessary processing.

Policy assignments
When creating a policy, you assign it to certain user and machine objects; that policy is applied to connections according to specific criteria or rules. In general, you can add as many assignments as you want to a policy, based on a combination of criteria. If you specify no assignments, the policy is applied to all connections.

The following table lists the available assignments:

<table>
<thead>
<tr>
<th>Assignment Name</th>
<th>Applies a policy based on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control</td>
<td>Access control conditions through which a client is connecting.</td>
</tr>
<tr>
<td></td>
<td>- Connection type - Whether to apply the policy to connections made with or without</td>
</tr>
<tr>
<td></td>
<td>NetScaler Gateway.</td>
</tr>
<tr>
<td></td>
<td>- NetScaler Gateway farm name - Name of the NetScaler Gateway virtual server.</td>
</tr>
<tr>
<td></td>
<td>- Access condition - Name of the end point analysis policy or session policy to use.</td>
</tr>
<tr>
<td>Citrix CloudBridge</td>
<td>Whether or not a user session is launched through Citrix CloudBridge.</td>
</tr>
<tr>
<td></td>
<td>Note: You can add only one Citrix CloudBridge assignment to a policy.</td>
</tr>
<tr>
<td>Client IP Address</td>
<td>IP address of the user device used to connect to the session.</td>
</tr>
<tr>
<td></td>
<td>- IPv4 examples: 12.0.0.0, 12.0.0.*., 12.0.0.1-12.0.0.70, 12.0.0.1/24</td>
</tr>
<tr>
<td></td>
<td>- IPv6 examples: 2001:0db8:3c4d:0015:0:0:abcd:ef12, 2001:0db8:3c4d:0015::/54</td>
</tr>
<tr>
<td>Client Name</td>
<td>Name of the user device.</td>
</tr>
<tr>
<td></td>
<td>- Exact match: ClientABCName</td>
</tr>
<tr>
<td></td>
<td>- Using wildcard: Client*Name</td>
</tr>
<tr>
<td>Delivery Group</td>
<td>Delivery Group membership.</td>
</tr>
<tr>
<td>Delivery Group type</td>
<td>Type of desktop or application: private desktop, shared desktop, private application, or shared application.</td>
</tr>
<tr>
<td>Organizational Unit (OU)</td>
<td>Organizational unit.</td>
</tr>
<tr>
<td>Tag</td>
<td>Tags.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: To ensure that policies are applied correctly when using tags, install the hotfix at <a href="https://docs.citrix.com">CTX142439</a>.</td>
</tr>
<tr>
<td>User or Group</td>
<td>User or group name.</td>
</tr>
</tbody>
</table>

When a user logs on, all policies that match the assignments for the connection are identified. Those policies are sorted into priority order and multiple instances of any setting are compared. Each setting is applied according to the priority ranking of the policy. Any policy setting that is disabled takes precedence over a lower-ranked setting that is enabled. Policy
settings that are not configured are ignored.

Important: When configuring both Active Directory and Citrix policies using the Group Policy Management Console, assignments and settings may not be applied as expected. For more information, see CTX127461

A policy named "Unfiltered" is provided by default.

- If you use Studio to manage Citrix policies, settings you add to the Unfiltered policy are applied to all servers, desktops, and connections in a Site.
- If you use the Local Group Policy Editor to manage Citrix policies, settings you add to the Unfiltered policy are applied to all Sites and connections that are within the scope of the Group Policy Objects (GPOs) that contain the policy. For example, the Sales OU contains a GPO called Sales-US that includes all members of the US Sales team. The Sales-US GPO is configured with an Unfiltered policy that includes several user policy settings. When the US Sales manager logs on to the Site, the settings in the Unfiltered policy are automatically applied to the session because the user is a member of the Sales-US GPO.

An assignment’s mode determines if the policy is applied only to connections that match all the assignment criteria. If the mode is set to Allow (the default), the policy is applied only to connections that match the assignment criteria. If the mode is set to Deny, the policy is applied if the connection does not match the assignment criteria. The following examples illustrate how assignment modes affect Citrix policies when multiple assignments are present.

- **Example: Assignments of like type with differing modes** - In policies with two assignments of the same type, one set to Allow and one set to Deny, the assignment set to Deny takes precedence, provided the connection satisfies both assignments. For example:

  Policy 1 includes the following assignments:
  - Assignment A specifies the Sales group; the mode is set to Allow
  - Assignment B specifies the Sales manager's account; the mode is set to Deny

  Because the mode for Assignment B is set to Deny, the policy is not applied when the Sales manager logs on to the Site, even though the user is a member of the Sales group.

- **Example: Assignments of differing type with like modes** - In policies with two or more assignments of differing types, set to Allow, the connection must satisfy at least one assignment of each type in order for the policy to be applied. For example:

  Policy 2 includes the following assignments:
  - Assignment C is a User assignment that specifies the Sales group; the mode is set to Allow
  - Assignment D is a Client IP Address assignment that specifies 10.8.169.* (the corporate network); the mode is set to Allow

  When the Sales manager logs on to the Site from the office, the policy is applied because the connection satisfies both assignments.

  Policy 3 includes the following assignments:
  - Assignment E is a User assignment that specifies the Sales group; the mode is set to Allow
  - Assignment F is an Access Control assignment that specifies NetScaler Gateway connection conditions; the mode is set to Allow

  When the Sales manager logs on to the Site from the office, the policy is not applied because the connection does not satisfy Assignment F.

Create a new policy based on a template, using Studio

1. Select Policies in the Studio navigation pane.
2. Select the Templates tab and select a template.
3. Select Create Policy from Template in the Actions pane.
4. By default, the new policy uses all the default settings in the template (the Use template default settings radio button is selected). If you want to change settings, select the Modify defaults and add more settings radio button, and then add or remove settings.

5. Specify how to apply the policy by selecting one of the following:
   - Assign to selected user and machine objects and then select the user and machine objects to which the policy will apply.
   - Assign to all objects in a site to apply the policy to all user and machine objects in the Site.

6. Enter a name for the policy (or accept the default); consider naming the policy according to who or what it affects, for example Accounting Department or Remote Users. Optionally, add a description. The policy is enabled by default; you can disable it. Enabling the policy allows it to be applied immediately to users logging on. Disabling prevents the policy from being applied. If you need to prioritize the policy or add settings later, consider disabling the policy until you are ready to apply it.

Create a new policy using Studio

1. Select Policies in the Studio navigation pane.
2. Select the Policies tab.
3. Select Create Policy in the Actions pane.
4. Add and configure policy settings.
5. Specify how to apply the policy by choosing one of the following:
   - Assign to selected user and machine objects and then select the user and machine objects to which the policy will apply.
   - Assign to all objects in a site to apply the policy to all user and machine objects in the Site.

Create and manage policies using the Group Policy Editor

From the Group Policy Editor, expand Computer Configuration or User Configuration. Expand the Policies node and then select Citrix Policies. Choose the appropriate action below.

<table>
<thead>
<tr>
<th>Task</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new policy</td>
<td>On the Policies tab, click New.</td>
</tr>
<tr>
<td>Edit an existing policy</td>
<td>On the Policies tab, select the policy and then click Edit.</td>
</tr>
<tr>
<td>Change the priority of an existing policy</td>
<td>On the Policies tab, select the policy and then click either Higher or Lower.</td>
</tr>
<tr>
<td>View summary information about a policy</td>
<td>On the Policies tab, select the policy and then click the Summary tab.</td>
</tr>
<tr>
<td>View and amend policy settings</td>
<td>On the Policies tab, select the policy and then click the Settings tab.</td>
</tr>
<tr>
<td>Task</td>
<td>Instruction</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View and amend policy filters</td>
<td>On the Policies tab, select the policy and then click the Filters tab.</td>
</tr>
<tr>
<td>Enable or disable a policy</td>
<td>On the Policies tab, select the policy and then select either Actions &gt; Enable or Actions &gt; Disable.</td>
</tr>
<tr>
<td>Create a new policy from an existing template</td>
<td>On the Templates tab, select the template and then click New Policy.</td>
</tr>
</tbody>
</table>
Compare, prioritize, model, and troubleshoot policies

You can use multiple policies to customize your environment to meet users’ needs based on their job functions, geographic locations, or connection types. For example, for security you may need to place restrictions on user groups who regularly work with sensitive data. You can create a policy that prevents users from saving sensitive files on their local client drives. However, if some people in the user group do need access to their local drives, you can create another policy for only those users. You then rank or prioritize the two policies to control which one takes precedence.

When using multiple policies, you must determine how to prioritize them, how to create exceptions, and how to view the effective policy when policies conflict.

In general, policies override similar settings configured for the entire Site, for specific Delivery Controllers, or on the user device. The exception to this principle is security. The highest encryption setting in your environment, including the operating system and the most restrictive shadowing setting, always overrides other settings and policies.

Citrix policies interact with policies you set in your operating system. In a Citrix environment, Citrix settings override the same settings configured in an Active Directory policy or using Remote Desktop Session Host Configuration. This includes settings that are related to typical Remote Desktop Protocol (RDP) client connection settings such as Desktop wallpaper, Menu animation, and View window contents while dragging. For some policy settings, such as Secure ICA, the settings in policies must match the settings in the operating system. If a higher priority encryption level is set elsewhere, the Secure ICA policy settings that you specify in the policy or when you are delivering application and desktops can be overridden.

For example, the encryption settings that you specify when creating Delivery Groups should be at the same level as the encryption settings you specified throughout your environment.

Note: In the second hop of double-hop scenarios, when a Desktop OS VDA connects to Server OS VDA, Citrix policies act on the Desktop OS VDA as if it were the user device. For example, if policies are set to cache images on the user device, the images cached for the second hop in a double-hop scenario are cached on the Desktop OS VDA machine.

Compare policies and templates

You can compare settings in a policy or template with those in other policies or templates. For example, you might need to verify setting values to ensure compliance with best practices. You might also want to compare settings in a policy or template with the default settings provided by Citrix.

1. Select Policies in the Studio navigation pane.
2. Click the Comparison tab and then click Select.
3. Choose the policies or templates to compare. To include default values in the comparison, select the Compare to default settings check box.
4. After you click Compare, the configured settings are displayed in columns.
5. To see all settings, select Show All Settings. To return to the default view, select Show Common Settings.

Prioritize policies

Prioritizing policies allows you to define the precedence of policies when they contain conflicting settings. When a user logs on, all policies that match the assignments for the connection are identified. Those policies are sorted into priority order and multiple instances of any setting are compared. Each setting is applied according to the priority ranking of the policy.

You prioritize policies by giving them different priority numbers in Studio. By default, new policies are given the lowest priority. If policy settings conflict, a policy with a higher priority (a priority number of 1 is the highest) overrides a policy with a
lower priority. Settings are merged according to priority and the setting's condition; for example, whether the setting is disabled or enabled. Any disabled setting overrides a lower-ranked setting that is enabled. Policy settings that are not configured are ignored and do not override the settings of lower-ranked settings.

1. Select Policies in the Studio navigation pane. Make sure the Policies tab is selected.
2. Select a policy.
3. Select Lower Priority or Higher Priority in the Actions pane.

Exceptions

When you create policies for groups of users, user devices, or machines, you may find that some members of the group require exceptions to some policy settings. You can create exceptions by:

- Creating a policy only for those group members who need the exceptions and then ranking the policy higher than the policy for the entire group
- Using the Deny mode for an assignment added to the policy

An assignment with the mode set to Deny applies a policy only to connections that do not match the assignment criteria. For example, a policy contains the following assignments:

- Assignment A is a client IP address assignment that specifies the range 208.77.88.*; the mode is set to Allow
- Assignment B is a user assignment that specifies a particular user account; the mode is set to Deny

The policy is applied to all users who log on to the Site with IP addresses in the range specified in Assignment A. However, the policy is not applied to the user logging on to the Site with the user account specified in Assignment B, even though the user's computer is assigned an IP address in the range specified in Assignment A.

Determine which policies apply to a connection

Sometimes a connection does not respond as expected because multiple policies apply. If a higher priority policy applies to a connection, it can override the settings you configure in the original policy. You can determine how final policy settings are merged for a connection by calculating the Resultant Set of Policy.

You can calculate the Resultant Set of Policy in the following ways:

- Use the Citrix Group Policy Modeling Wizard to simulate a connection scenario and discern how Citrix policies might be applied. You can specify conditions for a connection scenario such as domain controller, users, Citrix policy assignment evidence values, and simulated environment settings such as slow network connection. The report that the wizard produces lists the Citrix policies that would likely take effect in the scenario. If you are logged on to the Controller as a domain user, the wizard calculates the Resultant Set of Policy using both site policy settings and Active Directory Group Policy Objects (GPOs).
- Use Group Policy Results to produce a report describing the Citrix policies in effect for a given user and controller. The Group Policy Results tool helps you evaluate the current state of GPOs in your environment and generates a report that describes how these objects, including Citrix policies, are currently being applied to a particular user and controller.

You can launch the Citrix Group Policy Modeling Wizard from the Actions pane in Studio. You can launch either tool from the Group Policy Management Console in Windows.

If you run the Citrix Group Policy Modeling Wizard or Group Policy Results tool from the Group Policy Management Console, site policy settings created using Studio are not included in the Resultant Set of Policy.

To ensure you obtain the most comprehensive Resultant Set of Policy, Citrix recommends launching the Citrix Group Policy Modeling wizard from Studio, unless you create policies using only the Group Policy Management Console.

Use the Citrix Group Policy Modeling Wizard
Open the Citrix Group Policy Modeling Wizard using one of the following:

- Select Policies in the Studio navigation pane, select the Modeling tab, and then select Launch Modeling Wizard in the Actions pane.
- Launch the Group Policy Management Console (gpmc.msc), right-click Citrix Group Policy Modeling in the tree pane, and then select Citrix Group Policy Modeling Wizard.

Follow the wizard instructions to select the domain controller, users, computers, environment settings, and Citrix assignment criteria to use in the simulation. After you click Finish, the wizard produces a report of the modeling results. In Studio, the report appears in the middle pane under the Modeling tab.

To view the report, select View Modeling Report.

Troubleshoot policies

Users, IP addresses, and other assigned objects can have multiple policies that apply simultaneously. This can result in conflicts where a policy may not behave as expected. When you run the Citrix Group Policy Modeling Wizard or the Group Policy Results tool, you might discover that no policies are applied to user connections. When this happens, users connecting to their applications and desktops under conditions that match the policy evaluation criteria are not affected by any policy settings. This occurs when:

- No policies have assignments that match the policy evaluation criteria.
- Policies that match the assignment do not have any settings configured.
- Policies that match the assignment are disabled.

If you want to apply policy settings to the connections that meet the specified criteria, make sure:

- The policies you want to apply to those connections are enabled.
- The policies you want to apply have the appropriate settings configured.
## Default policy settings

Aug 08, 2016

The following tables list policy settings, their default, and the Virtual Delivery Agent (VDA) versions to which they apply.

### ICA

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client clipboard redirection</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Desktop launches</td>
<td>Prohibited</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>ICA listener connection timeout</td>
<td>120000 milliseconds</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>ICA listener port number</td>
<td>1494</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Launching of non-published programs during client connection</td>
<td>Prohibited</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Client clipboard write allowed formats</td>
<td>No formats are specified</td>
<td>VDA 7.6 through current</td>
</tr>
<tr>
<td>Restrict client clipboard write</td>
<td>Prohibited</td>
<td>VDA 7.6 through current</td>
</tr>
<tr>
<td>Restrict session clipboard write</td>
<td>Prohibited</td>
<td>VDA 7.6 through current</td>
</tr>
<tr>
<td>Session clipboard write allowed formats</td>
<td>No formats are specified</td>
<td>VDA 7.6 through current</td>
</tr>
</tbody>
</table>

### ICA/Adobe Flash Delivery/Flash Redirection

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash video fallback prevention</td>
<td>Not configured</td>
<td>VDA 7.6 FP3 through current</td>
</tr>
<tr>
<td>Flash video fallback prevention error *.swf</td>
<td></td>
<td>VDA 7.6 FP3 through current</td>
</tr>
</tbody>
</table>

### ICA/Audio

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Plug N Play</td>
<td>Allowed</td>
<td>VDA for Server OS 7 through current</td>
</tr>
</tbody>
</table>
### Audio quality

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client audio redirection</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Client microphone redirection</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### ICA/Auto Client Reconnect

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto client reconnect</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Auto client reconnect authentication</td>
<td>Do not require authentication</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Auto client reconnect logging</td>
<td>Do not log auto-reconnect events</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### ICA/Bandwidth

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio redirection bandwidth limit</td>
<td>0 Kbps</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Audio redirection bandwidth limit percent</td>
<td>0</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Client USB device redirection bandwidth limit</td>
<td>0 Kbps</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current. VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Client USB device redirection bandwidth limit percent</td>
<td>0</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current. VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Clipboard redirection bandwidth limit</td>
<td>0 Kbps</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Clipboard redirection bandwidth limit percent</td>
<td>0</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>COM port redirection bandwidth limit</td>
<td>0 Kbps</td>
<td>All VDA versions; for VDA 7 through current, configure this setting using the registry</td>
</tr>
<tr>
<td>COM port redirection bandwidth limit percent</td>
<td>0</td>
<td>All VDA versions; for VDA 7 through current, configure this setting using the registry</td>
</tr>
<tr>
<td>File redirection bandwidth limit</td>
<td>0 Kbps</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Name</td>
<td>Default setting</td>
<td>VDA</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>File redirection bandwidth limit</td>
<td></td>
<td>All VDA versions</td>
</tr>
<tr>
<td>HDX MediaStream Multimedia Acceleration bandwidth limit</td>
<td>0 Kbps</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 and VDA for Desktop OS 7 through current VDA for Server OS and VDA for Desktop OS through current</td>
</tr>
<tr>
<td>HDX MediaStream Multimedia Acceleration bandwidth limit percent</td>
<td>0</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>LPT port redirection bandwidth limit</td>
<td>0 Kbps</td>
<td>All VDA versions; for VDA 7 through current, configure this setting using the registry</td>
</tr>
<tr>
<td>LPT port redirection bandwidth limit percent</td>
<td>0</td>
<td>All VDA versions; for VDA 7 through current, configure this setting using the registry</td>
</tr>
<tr>
<td>Overall session bandwidth limit</td>
<td>0 Kbps</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Printer redirection bandwidth limit</td>
<td>0 Kbps</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Printer redirection bandwidth limit percent</td>
<td>0</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>TWAIN device redirection bandwidth limit</td>
<td>0 Kbps</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>TWAIN device redirection bandwidth limit percent</td>
<td>0</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

**ICA/Client Sensors**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow applications to use the physical location of the client device</td>
<td>Prohibited</td>
<td>VDA 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

**ICA/Desktop UI**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop Composition Redirection</td>
<td>Disabled (7.6 FP3 through current)</td>
<td>VDA 5.6, VDA for Desktop OS 7 through current, VDA</td>
</tr>
<tr>
<td></td>
<td>Enabled (5.6 through 7.6 FP2)</td>
<td></td>
</tr>
</tbody>
</table>
### Desktop Composition Redirection

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop Composition Redirection graphics quality</td>
<td>Medium</td>
<td>VDA 5.6, VDA for Desktop OS 7 through current, VDA</td>
</tr>
<tr>
<td>Desktop wallpaper</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Menu animation</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>View window contents while dragging</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### ICA/End User Monitoring

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICA round trip calculation</td>
<td>Enabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>ICA round trip calculation interval</td>
<td>15 seconds</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>ICA round trip calculations for idle connections</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### ICA/Enhanced Desktop Experience

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhanced Desktop Experience</td>
<td>Allowed</td>
<td>VDA for Server OS 7 through current</td>
</tr>
</tbody>
</table>

### ICA/File Redirection

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto connect client drives</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Client drive redirection</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Client fixed drives</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Client floppy drives</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Client network drives</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Client optical drives</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Name</td>
<td>Default setting</td>
<td>VDA</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Client removable drives</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Host to client redirection</td>
<td>Disabled</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Preserve client drive letters</td>
<td>Disabled</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Read-only client drive access</td>
<td>Disabled</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Special folder redirection</td>
<td>Allowed</td>
<td>Web Interface deployments only; VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Use asynchronous writes</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

ICA/Graphics

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display memory limit</td>
<td>65536 Kb</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Display mode degrade preference</td>
<td>Degrade color depth first</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Dynamic windows preview</td>
<td>Enabled</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Image caching</td>
<td>Enabled</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Legacy graphics mode</td>
<td>Disabled</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Maximum allowed color depth</td>
<td>32 bits per pixel</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Notify user when display mode is degraded</td>
<td>Disabled</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Queuing and tossing</td>
<td>Enabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

ICA/Graphics/Caching

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
</table>

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.431
### Persistent cache threshold

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>3000000 bps</td>
<td>Persistent cache threshold</td>
<td>VDA for Server OS 7 through current</td>
</tr>
</tbody>
</table>

### ICA/Graphics/Framehawk

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Framehawk display channel</td>
<td>Disabled</td>
<td>VDA 7.6 FP2 through current</td>
</tr>
<tr>
<td>Framehawk display channel port range</td>
<td>3224,3324</td>
<td>VDA 7.6 FP2 through current</td>
</tr>
</tbody>
</table>

### ICA/Keep Alive

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICA keep alive timeout</td>
<td>60 seconds</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>ICA keep(alives)</td>
<td>Do not send ICA keep alive messages</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### ICA/Local App Access

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow local app access</td>
<td>Prohibited</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>URL redirection black list</td>
<td>No sites are specified</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>URL redirection white list</td>
<td>No sites are specified</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

### ICA/Mobile Experience

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic keyboard display</td>
<td>Prohibited</td>
<td>VDA 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Launch touch-optimized desktop</td>
<td>Allowed</td>
<td>VDA 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This setting is disabled and not available for Windows 10 machines.</td>
</tr>
<tr>
<td>Remote the combo box</td>
<td>Prohibited</td>
<td>VDA 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>
### ICA/Multimedia

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit video quality</td>
<td>Not configured</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Multimedia conferencing</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Optimization for Windows Media multimedia redirection over WAN</td>
<td>Allowed</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Use GPU for optimizing Windows Media multimedia redirection over WAN</td>
<td>Prohibited</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Video load management policy setting</td>
<td>Not configured</td>
<td>VDA 7.6 FP3 through current</td>
</tr>
<tr>
<td>Windows Media client-side content fetching</td>
<td>Allowed</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Windows Media Redirection</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Windows Media Redirection buffer size</td>
<td>5 seconds</td>
<td>VDA 5, 5.5, 5.6 FP1</td>
</tr>
<tr>
<td>Windows Media Redirection buffer size use</td>
<td>Disabled</td>
<td>VDA 5, 5.5, 5.6 FP1</td>
</tr>
</tbody>
</table>

### ICA/Multi-Stream Connections

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio over UDP</td>
<td>Allowed</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Audio UDP port range</td>
<td>16500, 16509</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Multi-Port policy</td>
<td>Primary port (2598) has High Priority</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Name</td>
<td>Default setting</td>
<td>VDA</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multi-Stream computer setting</td>
<td>Disabled</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Multi-Stream user setting</td>
<td>Disabled</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

**ICA/Port Redirection**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto connect client COM ports</td>
<td>Disabled</td>
<td>All VDA versions; for VDA 7.x, configure this setting using the registry</td>
</tr>
<tr>
<td>Auto connect client LPT ports</td>
<td>Disabled</td>
<td>All VDA versions; for VDA 7.x, configure this setting using the registry</td>
</tr>
<tr>
<td>Client COM port redirection</td>
<td>Prohibited</td>
<td>All VDA versions; for VDA 7.x, configure this setting using the registry</td>
</tr>
<tr>
<td>Client LPT port redirection</td>
<td>Prohibited</td>
<td>All VDA versions; for VDA 7.x, configure this setting using the registry</td>
</tr>
</tbody>
</table>

**ICA/Printing**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client printer redirection</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Default printer</td>
<td>Set default printer to the client’s main printer</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Printer assignments</td>
<td>User’s current printer is used as the default printer for the session</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Printer auto-creation event log preference</td>
<td>Log errors and warnings</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Session printers</td>
<td>No printers are specified</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Wait for printers to be created (desktop)</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

**ICA/Printing/Client Printers**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Default setting</td>
<td>VDA</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Auto-create client printers</td>
<td>Auto-create all client printers</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Auto-create generic universal printer</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Client printer names</td>
<td>Standard printer names</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Direct connections to print servers</td>
<td>Enabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Printer driver mapping and compatibility</td>
<td>No rules are specified</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Printer properties retention</td>
<td>Held in profile only if not saved on client</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Retained and restored client printers</td>
<td>Allowed</td>
<td>VDA 5, 5.5, 5.6 FP1</td>
</tr>
</tbody>
</table>

### ICA/Printing/Drivers

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic installation of in-box printer drivers</td>
<td>Enabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal driver preference</td>
<td>EMF; XPS; PCL5c; PCL4; PS</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal print driver usage</td>
<td>Use universal printing only if requested driver is unavailable</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### ICA/Printing/Universal Print Server

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Print Server enable</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal Print Server print data stream (CGP) port</td>
<td>7229</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal Print Server print stream input bandwidth limit (kbps)</td>
<td>0</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal Print Server web service (HTTP/SOAP) port</td>
<td>8080</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### ICA/Printing/Universal Printing
<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal printing EMF processing mode</td>
<td>Spool directly to printer</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal printing image compression limit</td>
<td>Best quality (lossless compression)</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal printing optimization defaults</td>
<td>Image Compression • Desired image quality = Standard quality • Enable heavyweight compression = False</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Image and Font Caching • Allow caching of embedded images = True • Allow caching of embedded fonts = True</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Allow non-administrators to modify these settings = False</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal printing preview preference</td>
<td>Do not use print preview for auto-created or generic universal printers</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Universal printing print quality limit</td>
<td>No limit</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

**ICA/Security**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>SecureICA minimum encryption level</td>
<td>Basic</td>
<td>VDA for Server OS 7 through current</td>
</tr>
</tbody>
</table>

**ICA/Server Limits**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server idle timer interval</td>
<td>0 milliseconds</td>
<td>VDA for Server OS 7 through current</td>
</tr>
</tbody>
</table>

**ICA/Session Limits**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disconnected session timer</td>
<td>Disabled</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Disconnected session timer interval</td>
<td>1440 minutes</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Session connection timer</td>
<td>Disabled</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Name</td>
<td>Default setting</td>
<td>VDA</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Session connection timer interval</td>
<td>1440 minutes</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Session idle timer</td>
<td>Enabled</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Session idle timer interval</td>
<td>1440 minutes</td>
<td>VDA 5, 5.5, 5.6 FP1, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

**ICA/Session Reliability**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session reliability connections</td>
<td>Allowed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Session reliability port number</td>
<td>2598</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Session reliability timeout</td>
<td>180 seconds</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

**ICA/Time Zone Control**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimate local time for legacy clients</td>
<td>Enabled</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Use local time of client</td>
<td>Use server time zone</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

**ICA/TWAIN Devices**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client TWAIN device redirection</td>
<td>Allowed</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>TWAIN compression level</td>
<td>Medium</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

**ICA/USB Devices**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client USB device optimization rules</td>
<td>No rules are specified</td>
<td>VDA 7.6 FP3 through current</td>
</tr>
<tr>
<td>Client USB device redirection</td>
<td>Prohibited</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>
Client USB device redirection rules | No rules are specified | All VDA versions
---|---|---
Client USB Plug and Play device redirection | Allowed | VDA for Server OS 7 through current, VDA for Desktop OS 7 through current

ICA/Visual Display

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferred color depth for simple graphics</td>
<td>24 bits per pixel</td>
<td>VDA 7.6 FP3 through current</td>
</tr>
<tr>
<td>Target frame rate</td>
<td>30 fps</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Visual quality</td>
<td>Medium</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Use video codec for compression</td>
<td>Use video codec when available</td>
<td>VDA 7.6 FP3 through current</td>
</tr>
</tbody>
</table>

ICA/Visual Display/Moving Images

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum image quality</td>
<td>Normal</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Moving image compression</td>
<td>Enabled</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Progressive compression level</td>
<td>None</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Progressive compression threshold value</td>
<td>2147483647 Kbps</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Target minimum frame rate</td>
<td>10 fps</td>
<td>VDA 5.5, 5.6 FP1, VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

ICA/Visual Display/Still Images
### Extra color compression
- Default setting: Disabled
- VDA: All VDA versions

### Extra color compression threshold
- Default setting: 8192 Kbps
- VDA: All VDA versions

### Heavyweight compression
- Default setting: Disabled
- VDA: All VDA versions

### Lossy compression level
- Default setting: Medium
- VDA: All VDA versions

### Lossy compression threshold value
- Default setting: 2147483647 Kbps
- VDA: All VDA versions

### ICA/WebSockets

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebSockets connections</td>
<td>Prohibited</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>WebSockets port number</td>
<td>8008</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>WebSockets trusted origin server list</td>
<td>The wildcard, *, is used to trust all Receiver for Web URLs</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

### Load Management

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent logon tolerance</td>
<td>2</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>CPU usage</td>
<td>Disabled</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>CPU usage excluded process priority</td>
<td>Below Normal or Low</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Disk usage</td>
<td>Disabled</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Maximum number of sessions</td>
<td>250</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Memory usage</td>
<td>Disabled</td>
<td>VDA for Server OS 7 through current</td>
</tr>
<tr>
<td>Memory usage base load</td>
<td>Zero load: 768MB</td>
<td>VDA for Server OS 7 through current</td>
</tr>
</tbody>
</table>
## Profile Management/Advanced settings

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable automatic configuration</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Log off user if a problem is encountered</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Number of retries when accessing locked files</td>
<td>5</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Process Internet cookie files on logoff</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

## Profile Management/Basic settings

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active write back</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Enable Profile management</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Excluded groups</td>
<td>Disabled. Members of all user groups are processed.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Offline profile support</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Path to user store</td>
<td>Windows</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Process logons of local administrators</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Processed groups</td>
<td>Disabled. Members of all user groups are processed.</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

## Profile Management/Cross-Platform Settings

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-platform settings user groups</td>
<td>Disabled. All user groups specified in Processed groups are processed</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Enable cross-platform settings</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Path to cross-platform definitions</td>
<td>Disabled. No path is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Name</td>
<td>Default setting</td>
<td>VDA</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Path to cross-platform settings store</td>
<td>Disabled. Windows\PM_CM is used.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Source for creating cross-platform settings</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

**Profile Management/File System/Exclusions**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclusion list - directories</td>
<td>Disabled. All folders in the user profile are synchronized.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Exclusion list - files</td>
<td>Disabled. All files in the user profile are synchronized.</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

**Profile Management/File System/Synchronization**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directories to synchronize</td>
<td>Disabled. Only non-excluded folders are synchronized.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Files to synchronize</td>
<td>Disabled. Only non-excluded files are synchronized.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Folders to mirror</td>
<td>Disabled. No folders are mirrored.</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

**Profile Management/Folder Redirection**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grant administrator access</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Include domain name</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

**Profile Management/Folder Redirection/AppData(Roaming)**

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppData(Roaming) path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Redirection settings for AppData(Roaming)</td>
<td>Contents are redirected to the UNC path specified in the AppData(Roaming) path policy settings</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>
### Profile Management/Folder Redirection/Contacts

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contacts path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Redirection settings for Contacts</td>
<td>Contents are redirected to the UNC path specified in the Contacts path policy settings</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### Profile Management/Folder Redirection/Desktop

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Redirection settings for Desktop</td>
<td>Contents are redirected to the UNC path specified in the Desktop path policy settings</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### Profile Management/Folder Redirection/Documents

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Redirection settings for Documents</td>
<td>Contents are redirected to the UNC path specified in the Documents path policy settings</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### Profile Management/Folder Redirection/Downloads

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downloads path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Redirection settings for Downloads</td>
<td>Contents are redirected to the UNC path specified in the Downloads path policy settings</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### Profile Management/Folder Redirection/Favorites

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorites path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Redirection settings for Favorites</td>
<td>Contents are redirected to the UNC path specified in the Favorites path policy settings</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>
### Profile Management/Folder Redirection/Links

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Links path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA</td>
</tr>
<tr>
<td>Redirection settings for Links</td>
<td>Contents are redirected to the UNC path specified in the Links path policy settings</td>
<td>All VDA</td>
</tr>
</tbody>
</table>

### Profile Management/Folder Redirection/Music

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Music path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA</td>
</tr>
<tr>
<td>Redirection settings for Music</td>
<td>Contents are redirected to the UNC path specified in the Music path policy settings</td>
<td>All VDA</td>
</tr>
</tbody>
</table>

### Profile Management/Folder Redirection/Pictures

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pictures path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA</td>
</tr>
<tr>
<td>Redirection settings for Pictures</td>
<td>Contents are redirected to the UNC path specified in the Pictures path policy settings</td>
<td>All VDA</td>
</tr>
</tbody>
</table>

### Profile Management/Folder Redirection/Saved Games

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved Games path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA</td>
</tr>
<tr>
<td>Redirection settings for Saved Games</td>
<td>Contents are redirected to the UNC path specified in the Saved Games path policy settings</td>
<td>All VDA</td>
</tr>
</tbody>
</table>

### Profile Management/Folder Redirection/Searches

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searches path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA</td>
</tr>
<tr>
<td>Redirection settings for Searches</td>
<td>Contents are redirected to the UNC path specified in the Searches path</td>
<td>All VDA</td>
</tr>
</tbody>
</table>
## Searches

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile Management/Folder Redirection/Start Menu</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Menu path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Redirection settings for Start Menu</td>
<td>Contents are redirected to the UNC path specified in the Start Menu path policy settings</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

## Profile Management/Folder Redirection/Video

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video path</td>
<td>Disabled. No location is specified.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Redirection settings for Video</td>
<td>Contents are redirected to the UNC path specified in the Video path policy settings</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

## Profile Management/Log settings

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Directory actions</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Common information</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Common warnings</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Enable logging</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>File system actions</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>File system notifications</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Logoff</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Logon</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Name</td>
<td>Default setting</td>
<td>VDA versions</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Maximum size of the log file</td>
<td>1048576</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Path to log file</td>
<td>Disabled. Log files are saved in the default location: %SystemRoot%\System32\Logfiles\UserProfileManager.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Personalized user information</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Policy values at logon and logoff</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Registry actions</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Registry differences at logoff</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

Profile Management/Profile handling

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay before deleting cached profiles</td>
<td>0</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Delete locally cached profiles on logoff</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Local profile conflict handling</td>
<td>Use local profile</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Migration of existing profiles</td>
<td>Local and roaming</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Path to the template profile</td>
<td>Disabled. New user profiles are created from the default user profile on the device where a user first logs on.</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Template profile overrides local profile</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Template profile overrides roaming profile</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Template profile used as a Citrix mandatory profile for all logons</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

Profile Management/Registry

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA versions</th>
</tr>
</thead>
</table>

---

https://docs.citrix.com  © 1999-2017 Citrix Systems, Inc. All rights reserved.  p.445
Exclusion list

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>All VDA versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Default setting</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>All VDA versions</td>
<td>All VDA versions</td>
<td></td>
</tr>
</tbody>
</table>

Profile Management/Streamed user profiles

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always cache</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Always cache size</td>
<td>0 Mb</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Profile streaming</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Streamed user profile groups</td>
<td>Disabled</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Timeout for pending area lock files (days)</td>
<td>1 day</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

Receiver

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>StoreFront accounts list</td>
<td>No stores are specified</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>

Virtual Delivery Agent

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller registration IPv6 netmask</td>
<td>No netmask is specified</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Controller registration port</td>
<td>80</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Controller SIDs</td>
<td>No SIDs are specified</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Controllers</td>
<td>No controllers are specified</td>
<td>All VDA versions</td>
</tr>
<tr>
<td>Enable auto update of controllers</td>
<td>Enabled</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
<tr>
<td>Only use IPv6 controller</td>
<td>Disabled</td>
<td>VDA for Server OS 7 through current, VDA for Desktop OS 7 through current</td>
</tr>
</tbody>
</table>
### Site GUID

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site GUID</td>
<td>No GUID is specified</td>
<td>All VDA versions</td>
</tr>
</tbody>
</table>

### Virtual IP

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual IP loopback support</td>
<td>Disabled</td>
<td>VDA 7.6 through current</td>
</tr>
<tr>
<td>Virtual IP virtual loopback programs list</td>
<td>None</td>
<td>VDA 7.6 through current</td>
</tr>
</tbody>
</table>

### HDX 3D Pro

<table>
<thead>
<tr>
<th>Name</th>
<th>Default setting</th>
<th>VDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable lossless</td>
<td>Enabled</td>
<td>VDA 5.5, 5.6 FP1</td>
</tr>
<tr>
<td>HDX 3D Pro quality settings</td>
<td></td>
<td>VDA 5.5, 5.6 FP1</td>
</tr>
</tbody>
</table>
Policies contain settings that are applied when the policy is enforced. Descriptions in this section also indicate if additional settings are required to enable a feature or are similar to a setting.

Quick reference

The following tables list the settings you can configure within a policy. Find the task you want to complete in the left column, then locate its corresponding setting in the right column.

### Audio

<table>
<thead>
<tr>
<th>For this task</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control whether to allow the use of multiple audio devices</td>
<td>Audio Plug N Play</td>
</tr>
<tr>
<td>Control whether to allow audio input from microphones on the user device</td>
<td>Client microphone redirection</td>
</tr>
<tr>
<td>Control audio quality on the user device</td>
<td>Audio quality</td>
</tr>
<tr>
<td>Control audio mapping to speakers on the user device</td>
<td>Client audio redirection</td>
</tr>
</tbody>
</table>

### Bandwidth for user devices

<table>
<thead>
<tr>
<th>To limit bandwidth used for</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client audio mapping</td>
<td>• Audio redirection bandwidth limit or&lt;br&gt;• Audio redirection bandwidth limit percent</td>
</tr>
<tr>
<td>Cut-and-paste using local clipboard</td>
<td>• Clipboard redirection bandwidth limit or&lt;br&gt;• Clipboard redirection bandwidth limit percent</td>
</tr>
<tr>
<td>Access in a session to local client drives</td>
<td>• File redirection bandwidth limit or&lt;br&gt;• File redirection bandwidth limit percent</td>
</tr>
<tr>
<td>HDX MediaStream Multimedia Acceleration</td>
<td>• HDX MediaStream Multimedia Acceleration bandwidth limit or&lt;br&gt;• HDX MediaStream Multimedia Acceleration bandwidth limit percent</td>
</tr>
</tbody>
</table>
## To limit bandwidth used for

<table>
<thead>
<tr>
<th>Client session</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Overall session bandwidth limit</td>
</tr>
</tbody>
</table>
| Printing       | ● Printer redirection bandwidth limit or  
                           ● Printer redirection bandwidth limit percent |
| TWAIN devices (such as a camera or scanner) | ● TWAIN device redirection bandwidth limit or  
                                   ● TWAIN device redirection bandwidth limit percent |
| USB devices    | ● Client USB device redirection bandwidth limit or  
                                    ● Client USB device redirection bandwidth limit percent |

## Redirection of client drives and user devices

### For this task

| Control whether or not drives on the user device are connected when users log on to the server | Auto connect client drives |
| Control cut-and-paste data transfer between the server and the local clipboard | Client clipboard redirection |
| Control how drives map from the user device | Client drive redirection |
| Control whether users' local hard drives are available in a session | ● Client fixed drives and  
                                    ● Client drive redirection |
| Control whether users' local floppy drives are available in a session | ● Client floppy drives and  
                                    ● Client drive redirection |
| Control whether users' network drives are available in a session | ● Client network drives and  
                                    ● Client drive redirection |
| Control whether users' local CD, DVD, or Blu-ray drives are available in a session | ● Client optical drives and  
                                    ● Client drive redirection |
| Control whether users' local removable drives are available in a session | ● Client removable drives and  
                                    ● Client drive redirection |
<p>| Control whether users' TWAIN devices, such as scanners and | ● Client TWAIN device redirection |</p>
<table>
<thead>
<tr>
<th>For this task</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>cameras, are available in a session and control compression of image data transfers</td>
<td>TWAIN compression redirection</td>
</tr>
<tr>
<td>Control whether USB devices are available in a session</td>
<td>• Client USB device redirection and</td>
</tr>
<tr>
<td></td>
<td>• Client USB device redirection rules</td>
</tr>
<tr>
<td>Improve the speed of writing and copying files to a client disk over a WAN</td>
<td>Use asynchronous writes</td>
</tr>
</tbody>
</table>

### Content redirection

<table>
<thead>
<tr>
<th>For this task</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control whether to use content redirection from the server to the user device</td>
<td>Host to client redirection</td>
</tr>
</tbody>
</table>

### Desktop UI

<table>
<thead>
<tr>
<th>For this task</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control whether or not Desktop wallpaper is used in users' sessions</td>
<td>Desktop wallpaper</td>
</tr>
<tr>
<td>View window contents while a window is dragged</td>
<td>View window contents while dragging</td>
</tr>
</tbody>
</table>

### Graphics and multimedia

<table>
<thead>
<tr>
<th>For this task</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control the maximum number of frames per second sent to user devices from virtual desktops</td>
<td>Target frame rate</td>
</tr>
<tr>
<td>Control the visual quality of images displayed on the user device</td>
<td>Visual quality</td>
</tr>
<tr>
<td>Control whether Flash content is rendered in sessions</td>
<td>Flash default behavior</td>
</tr>
<tr>
<td>Control whether websites can display Flash content when accessed in sessions</td>
<td>• Flash server-side content fetching URL list</td>
</tr>
<tr>
<td></td>
<td>• Flash URL compatibility list</td>
</tr>
</tbody>
</table>
### Prioritize Multi-Stream network traffic

<table>
<thead>
<tr>
<th>For this task</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify ports for ICA traffic across multiple connections and establish network priorities</td>
<td>Multi-Port policy</td>
</tr>
<tr>
<td>Enable support for multi-stream connections between servers and user devices</td>
<td>Multi-Stream (computer and user settings)</td>
</tr>
</tbody>
</table>

### Print

<table>
<thead>
<tr>
<th>For this task</th>
<th>Use this policy setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control creation of client printers on the user device</td>
<td>• Auto-create client printers and</td>
</tr>
<tr>
<td></td>
<td>• Client printer redirection</td>
</tr>
<tr>
<td>Control the location where printer properties are stored</td>
<td>Printer properties retention</td>
</tr>
<tr>
<td>Control whether print requests are processed by the client or the server</td>
<td>Direct connections to print servers</td>
</tr>
<tr>
<td>Control whether users can access printers connected to their user devices</td>
<td>Client printer redirection</td>
</tr>
<tr>
<td>Control installation of native Windows drivers when automatically creating client and network printers</td>
<td>Automatic installation of in-box printer drivers</td>
</tr>
<tr>
<td>Control when to use the Universal Printer Driver</td>
<td>Universal print driver usage</td>
</tr>
<tr>
<td>Choose a printer based on a roaming user's session information</td>
<td>Default printer</td>
</tr>
</tbody>
</table>

Note: Policies cannot be used to enable a screen saver in a desktop or application session. For users who require screen savers, the screen saver can be implemented on the user device.
ICA policy settings

Sep 29, 2015
The ICA section contains policy settings related to ICA listener connections and mapping to the clipboard.

Client clipboard redirection

This setting allows or prevents the clipboard on the user device being mapped to the clipboard on the server.

By default, clipboard redirection is allowed.

To prevent cut-and-paste data transfer between a session and the local clipboard, select Prohibit. Users can still cut and paste data between applications running in sessions.

After allowing this setting, configure the maximum allowed bandwidth the clipboard can consume in a client connection using the Clipboard redirection bandwidth limit or the Clipboard redirection bandwidth limit percent settings.

Client clipboard write allowed formats

When the Restrict client clipboard write setting is Enabled, host clipboard data cannot be shared with the client endpoint but you can use this setting to allow specific data formats to be shared with the client endpoint clipboard. To use this setting, enable it and add the specific formats to be allowed.

The following clipboard formats are system defined:
- CF_TEXT
- CF_BITMAP
- CF_METAFILEPICT
- CF_SYLK
- CF_DIF
- CF_TIFF
- CF_OEMTEXT
- CF_DIB
- CF_PALETTE
- CF_PENDATA
- CF_RIFF
- CF_WAVE
- CF_UNICODETEXT
- CF_ENHMETAFILE
- CF_HDROP
- CF_LOCALE
- CF_DIBV5
- CF_OWNERDISPLAY
- CF_DSPTEXT
- CF_DSPBITMAP
- CF_DSPMETAFILEPICT
- CF_DISPENHMETAFILE

The following custom formats are predefined in XenApp and XenDesktop:
- CFX_RICHTEXT
HTML Format is disabled by default. To enable this feature:

- Make sure **Client clipboard redirection** is set to allowed.
- Make sure **Restrict client clipboard write** is set to enabled.
- Add an entry for **HTML Format** (and any other formats you want supported) in **Client clipboard write allowed formats**.

**Note:** Enabling HTML format clipboard copy support (HTML Format) will copy any scripts (if they exist) from the source of the copied content to the destination. Check that you trust the source before proceeding to copy. If you do copy content containing scripts, they will only be live if you save the destination file as an HTML file and execute it.

Additional custom formats can be added. The custom format name must match the formats to be registered with the system. Format names are case-sensitive.

This setting does not apply if either **Client clipboard redirection** or **Restrict client clipboard write** is set to **Prohibited**.

**Desktop launches**

This setting allows or prevents non-administrative users in a VDA's Direct Access Users group connecting to a session on that VDA using an ICA connections.

By default, non-administrative users cannot connect to these sessions.

This setting has no effect on non-administrative users in a VDA's Direct Access Users group who are using a RDP connection; these users can connect to the VDA whether this setting is enabled or disabled. This setting has no effect on non-administrative users not in a VDA's Direct Access Users group; these users cannot connect to the VDA whether this setting is enabled or disabled.

**ICA listener connection timeout**

**Note:** This setting applies only to Virtual Delivery Agents 5.0, 5.5, and 5.6 Feature Pack 1.

This setting specifies the maximum wait time for a connection using the ICA protocol to be completed.

By default, the maximum wait time is 120000 milliseconds, or two minutes.

**ICA listener port number**

This setting specifies the TCP/IP port number used by the ICA protocol on the server.

By default, the port number is set to 1494.

Valid port numbers must be in the range of 0-65535 and must not conflict with other well-known port numbers. If you change the port number, restart the server for the new value to take effect. If you change the port number on the server, you must also change it on every Citrix Receiver or plug-in that connects to the server.

**Launching of non-published programs during client connection**

This setting specifies whether to allow launching initial applications through RDP on the server.
By default, launching initial applications through RDP on the server is not allowed.

Restrict client clipboard write

If this setting is Allowed, host clipboard data cannot be shared with the client endpoint. You can allow specific formats by enabling the Client clipboard write allowed formats setting.

By default, this is set to Prohibited.

Restrict session clipboard write

When this setting is Allowed, client clipboard data cannot be shared within the user session. You can allow specific formats by enabling the Session clipboard write allowed formats setting.

By default, this is set to Prohibited.

Session clipboard write allowed formats

When the Restrict session clipboard write setting is Allowed, client clipboard data cannot be shared with session applications, but you can use this setting to allow specific data formats to be shared with the session clipboard.

The following clipboard formats are system defined:
- CF_TEXT
- CF_BITMAP
- CF_METAFILEPICT
- CF_SYLK
- CF_DIF
- CF_TIFF
- CF_OEMTEXT
- CF_DIB
- CF_PALETTE
- CF_PENDATA
- CF_RIFF
- CF_WAVE
- CF_UNICODETEXT
- CF_ENHMETAFILE
- CF_HDROP
- CF_LOCALE
- CF_DIBV5
- CF_OWNERDISPLAY
- CF_DSPTEXT
- CF_DSPBITMAP
- CF_DSPMETAFILEPICT
- CF_DISPENHMETAFILE

The following custom formats are predefined in XenApp and XenDesktop:
- CFX_RICHTEXT
- CFX_OfficeDrawingShape
- CFX_BIFF8
- HTML Format
HTML Format is disabled by default. To enable this feature:

- Make sure **Client clipboard redirection** is set to allowed.
- Make sure **Restrict session clipboard write** is set to enabled.
- Add an entry for **HTML Format** (and any other formats you want supported) in **Session clipboard write allowed formats**.

**Note:** Enabling HTML Format clipboard copy support (HTML Format) will copy any scripts (if they exist) from the source of the copied content to the destination. Check that you trust the source before proceeding to copy. If you do copy content containing scripts, they will only be live if you save the destination file as an HTML file and execute it.

Additional custom formats can be added. The custom format name must match the formats to be registered with the system. Format names are case-sensitive.

This setting does not apply if either the **Client clipboard redirection** setting or **Restrict session clipboard write** setting is set to Prohibited.
Auto Client Reconnect policy settings

Sep 29, 2015
The Auto Client Reconnect section contains policy settings for controlling the automatic reconnection of sessions.

Auto client reconnect

This setting allows or prevents automatic reconnection by the same client after a connection has been interrupted.

By default, automatic reconnection is allowed.

Allowing automatic reconnection allows users to resume working where they were interrupted when a connection was broken. Automatic reconnection detects broken connections and then reconnects the users to their sessions.

However, automatic reconnection can result in a new session being launched (instead of reconnecting to an existing session) if the Citrix Receiver cookie, which contains the key to the session ID and credentials, is not used. The cookie is not used if it has expired, for example, because of a delay in reconnection, or if credentials must be reentered. Auto client reconnect is not triggered if users intentionally disconnect.

For application sessions, when automatic reconnection is allowed, Citrix Receiver attempts to reconnect to the session until there is a successful reconnection or the user cancels the reconnection attempts.

For desktop sessions, when automatic reconnection is allowed, Citrix Receiver attempts to reconnect to the session for a specified period of time, unless there is a successful reconnection or the user cancels the reconnection attempts. By default, this period of time is five minutes. To change this period of time, edit this registry on the user device:

HKLM\Software\Citrix\ICA Client\Transport\Reconnect\Retry\MaxTimeSeconds; DWORD; <seconds>
where <seconds> is the number of seconds after which no more attempts are made to reconnect the session.

Auto client reconnect authentication

This setting requires authentication for automatic client reconnections.

By default, authentication is not required.

When a user initially logs on, their credentials are encrypted, stored in memory, and a cookie is created containing the encryption key that is sent to Citrix Receiver. When this setting is configured, cookies are not used. Instead, a dialog box is displayed to users requesting credentials when Citrix Receiver attempts to reconnect automatically.

Auto client reconnect logging

This setting enables or disables the recording of auto client reconnections in the event log.

By default, logging is disabled.

When logging is enabled, the server's System log captures information about successful and failed automatic reconnection events. A site does not provide a combined log of reconnection events for all servers.
Audio policy settings

Sep 30, 2014
The Audio section contains policy settings that permit user devices to send and receive audio in sessions without reducing performance.

Audio over UDP real-time transport
This setting allows or prevents the transmission and receipt of audio between the VDA and user device over RTP using the User Datagram Protocol (UDP). When this setting is disabled, audio is sent and received over TCP.

By default, audio over UDP is allowed.

Audio Plug N Play
This setting allows or prevents the use of multiple audio devices to record and play sound.
By default, the use of multiple audio devices is allowed.
This setting applies only to Windows Server OS machines.

Audio quality
This setting specifies the quality level of sound received in user sessions.
By default, sound quality is set to High - high definition audio.

To control sound quality, choose one of the following options:

- Select Low - for low speed connections for low-bandwidth connections. Sounds sent to the user device are compressed up to 16 Kbps. This compression results in a significant decrease in the quality of the sound but allows reasonable performance for a low-bandwidth connection.

- Select Medium - optimized for speech to deliver Voice over IP (VoIP) applications, to deliver media applications in challenging network connections with lines less than 512 Kbps, or significant congestion and packet loss. This codec offers very fast encode time, making it ideal for use with softphones and Unified Communications applications when you require server-side media processing. Audio sent to the user device is compressed up to 64 Kbps; this compression results in a moderate decrease in the quality of the audio played on the user device, while providing low latency and consuming low bandwidth. If VoIP quality is unsatisfactory, ensure that the Audio over UDP Real-time Transport policy setting is set to Allowed.

- Select High - high definition audio for connections where bandwidth is plentiful and sound quality is important. Clients can play sound at its native rate. Sounds are compressed at a high quality level maintaining up to CD quality, and using up to 112 Kbps of bandwidth. Transmitting this amount of data can result in increased CPU utilization and network congestion.

Bandwidth is consumed only while audio is recording or playing. If both occur at the same time, the bandwidth consumption is doubled.

To specify the maximum amount of bandwidth, configure the Audio redirection bandwidth limit or the Audio redirection bandwidth limit percent settings.
This setting specifies whether applications hosted on the server can play sounds through a sound device installed on the user device. This setting also specifies whether users can record audio input.

By default, audio redirection is allowed.

After allowing this setting, you can limit the bandwidth consumed by playing or recording audio. Limiting the amount of bandwidth consumed by audio can improve application performance but may also degrade audio quality. Bandwidth is consumed only while audio is recording or playing. If both occur at the same time, the bandwidth consumption doubles. To specify the maximum amount of bandwidth, configure the Audio redirection bandwidth limit or the Audio redirection bandwidth limit percent settings.

On Windows Server OS machines, ensure that the Audio Plug N Play setting is Enabled to support multiple audio devices.

Important: Prohibiting Client audio redirection disables all HDX audio functionality.

Client microphone redirection

This setting enables or disables client microphone redirection. When enabled, users can use microphones to record audio input in a session.

By default, microphone redirection is allowed.

For security, users are alerted when servers that are not trusted by their devices try to access microphones. Users can choose to accept or not accept access. Users can disable the alert on Citrix Receiver.

On Windows Server OS machines, ensure that the Audio Plug N Play setting is Enabled to support multiple audio devices.

If the Client audio redirection setting is disabled on the user device, this rule has no effect.
Bandwidth policy settings

Sep 25, 2014
The Bandwidth section contains policy settings to avoid performance problems related to client session bandwidth use. Important: Using these policy settings with the Multi-Stream policy settings may produce unexpected results. If you use Multi-Stream settings in a policy, ensure these bandwidth limit policy settings are not included.

Audio redirection bandwidth limit
This setting specifies the maximum allowed bandwidth, in kilobits per second, for playing or recording audio in a user session.
By default, no maximum (zero) is specified.
If you enter a value for this setting and a value for the Audio redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

Audio redirection bandwidth limit percent
This setting specifies the maximum allowed bandwidth limit for playing or recording audio as a percentage of the total session bandwidth.
By default, no maximum (zero) is specified.
If you enter a value for this setting and a value for the Audio redirection bandwidth limit setting, the most restrictive setting (with the lower value) is applied.
If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.

Client USB device redirection bandwidth limit
This setting specifies the maximum allowed bandwidth, in kilobits per second, for the redirection of USB devices to and from the client.
By default, no maximum (zero) is specified.
If you enter a value for this setting and a value for the Client USB device redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

Client USB device redirection bandwidth limit percent
This setting specifies the maximum allowed bandwidth for the redirection of USB devices to and from the client as a percentage of the total session bandwidth.
By default, no maximum (zero) is specified.
If you enter a value for this setting and a value for the Client USB device redirection bandwidth limit setting, the most restrictive setting (with the lower value) is applied.
If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.

Clipboard redirection bandwidth limit
This setting specifies the maximum allowed bandwidth, in kilobits per second, for data transfer between a session and the local clipboard.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the Clipboard redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

Clipboard redirection bandwidth limit percent

This setting specifies the maximum allowed bandwidth for data transfer between a session and the local clipboard as a percentage of the total session bandwidth.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the Clipboard redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.

COM port redirection bandwidth limit

Note: For the Virtual Delivery Agent 7.x, configure this setting using the registry; see Configure COM Port and LPT Port Redirection settings using the registry.

This setting specifies the maximum allowed bandwidth in kilobits per second for accessing a COM port in a client connection. If you enter a value for this setting and a value for the COM port redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

COM port redirection bandwidth limit percent

Note: For the Virtual Delivery Agent 7.x, configure this setting using the registry; see Configure COM Port and LPT Port Redirection settings using the registry.

This setting specifies the maximum allowed bandwidth for accessing COM ports in a client connection as a percentage of the total session bandwidth.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the COM port redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.

File redirection bandwidth limit

This setting specifies the maximum allowed bandwidth, in kilobits per second, for accessing a client drive in a user session.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the File redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) takes effect.

File redirection bandwidth limit percent
This setting specifies the maximum allowed bandwidth limit for accessing client drives as a percentage of the total session bandwidth.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the File redirection bandwidth limit setting, the most restrictive setting (with the lower value) is applied.

If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.

HDX MediaStream Multimedia Acceleration bandwidth limit

This setting specifies the maximum allowed bandwidth limit, in kilobits per second, for delivering streaming audio and video using HDX MediaStream Multimedia Acceleration.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the HDX MediaStream Multimedia Acceleration bandwidth limit percent setting, the most restrictive setting (with the lower value) takes effect.

HDX MediaStream Multimedia Acceleration bandwidth limit percent

This setting specifies the maximum allowed bandwidth for delivering streaming audio and video using HDX MediaStream Multimedia Acceleration as a percentage of the total session bandwidth.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the HDX MediaStream Multimedia Acceleration bandwidth limit setting, the most restrictive setting (with the lower value) takes effect.

If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.

LPT port redirection bandwidth limit

Note: For the Virtual Delivery Agent 7.x, configure this setting using the registry; see Configure COM Port and LPT Port Redirection settings using the registry.

This setting specifies the maximum allowed bandwidth, in kilobits per second, for print jobs using an LPT port in a single user session.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the LPT port redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

LPT port redirection bandwidth limit percent

Note: For the Virtual Delivery Agent 7.x, configure this setting using the registry; see Configure COM Port and LPT Port Redirection settings using the registry.

This setting specifies the bandwidth limit for print jobs using an LPT port in a single client session as a percentage of the total session bandwidth.

By default, no maximum (zero) is specified.
If you enter a value for this setting and a value for the LPT port redirection bandwidth limit setting, the most restrictive setting (with the lower value) is applied.

If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.

Overall session bandwidth limit

This setting specifies the total amount of bandwidth available, in kilobits per second, for user sessions.

The maximum enforceable bandwidth cap is 10 Mbps (10,000 Kbps). By default, no maximum (zero) is specified.

Limiting the amount of bandwidth consumed by a client connection can improve performance when other applications outside the client connection are competing for limited bandwidth.

Printer redirection bandwidth limit

This setting specifies the maximum allowed bandwidth, in kilobits per second, for accessing client printers in a user session.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the Printer redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

Printer redirection bandwidth limit percent

This setting specifies the maximum allowed bandwidth for accessing client printers as a percentage of the total session bandwidth.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the Printer redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.

TWAIN device redirection bandwidth limit

This setting specifies the maximum allowed bandwidth, in kilobits per second, for controlling TWAIN imaging devices from published applications.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the TWAIN device redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.

TWAIN device redirection bandwidth limit percent

This setting specifies the maximum allowed bandwidth for controlling TWAIN imaging devices from published applications as a percentage of the total session bandwidth.

By default, no maximum (zero) is specified.

If you enter a value for this setting and a value for the TWAIN device redirection bandwidth limit percent setting, the most restrictive setting (with the lower value) is applied.
restrictive setting (with the lower value) is applied.

If you configure this setting, you must also configure the Overall session bandwidth limit setting, which specifies the total amount of bandwidth available for client sessions.
The Client Sensors section contains policy settings for controlling how mobile device sensor information is handled in a user session.

Allow applications to use the physical location of the client device

This setting determines whether applications running in a session on a mobile device are allowed to use the physical location of the user device.

By default, the use of location information is prohibited.

When this setting is prohibited, attempts by an application to retrieve location information return a “permission denied” value.

When this setting is allowed, a user can prohibit use of location information by denying a Citrix Receiver request to access the location. Android and iOS devices prompt at the first request for location information in each session.

When developing hosted applications that use the Allow applications to use the physical location of the client device setting, consider the following:

- A location-enabled application should not rely on location information being available because:
  - A user might not allow access to location information.
  - The location might not be available or might change while the application is running.
  - A user might connect to the application session from a different device that does not support location information.

- A location-enabled application must:
  - Have the location feature off by default.
  - Provide a user option to allow or disallow the feature while the application is running.
  - Provide a user option to clear location data that is cached by the application. (Citrix Receiver does not cache location data.)

- A location-enabled application must manage the granularity of the location information so that the data acquired is appropriate to the purpose of the application and conforms to regulations in all relevant jurisdictions.

- A secure connection (for example, using TLS or a VPN) should be enforced when using location services. Citrix Receiver should connect to trusted servers.

- Consider obtaining legal advice regarding the use of location services.
Desktop UI policy settings

Aug 08, 2016

The Desktop UI section contains policy settings that control visual effects such as desktop wallpaper, menu animations, and drag-and-drop images, to manage the bandwidth used in client connections. You can improve application performance on a WAN by limiting bandwidth usage.

Desktop Composition Redirection

This setting specifies whether to use the processing capabilities of the graphics processing unit (GPU) or integrated graphics processor (IGP) on the user device for local DirectX graphics rendering to provide users with a more fluid Windows desktop experience. When enabled, Desktop Composition Redirection delivers a highly responsive Windows experience while maintaining high scalability on the server.

By default, Desktop Composition Redirection is disabled.

To turn off Desktop Composition Redirection and reduce the bandwidth required in user sessions, select Disabled when adding this setting to a policy.

Desktop Composition Redirection graphics quality

This setting specifies the quality of graphics used for Desktop Composition Redirection.

By default, this is set to high.

Choose from High, Medium, Low, or Lossless quality.

Desktop wallpaper

This setting allows or prevents wallpaper showing in user sessions.

By default, user sessions can show wallpaper.

To turn off desktop wallpaper and reduce the bandwidth required in user sessions, select Prohibited when adding this setting to a policy.

Menu animation

This setting allows or prevents menu animation in user sessions.

By default, menu animation is allowed.

Menu animation is a Microsoft personal preference setting for ease of access. When enabled, it causes a menu to appear after a short delay, either by scrolling or fading in. An arrow icon appears at the bottom of the menu. The menu appears when you point to that arrow.

Menu animation is enabled on a desktop if this policy setting is set to Allowed and the menu animation Microsoft personal preference setting is enabled.

Note: Changes to the menu animation Microsoft personal preference setting are changes to the desktop. This means that if the desktop is set to discard changes when the session ends, a user who has enabled menu animations in a session may not have menu animation available in subsequent sessions on the desktop. For users who require menu animation, enable
the Microsoft setting in the master image for the desktop or ensure that the desktop retains user changes.

View window contents while dragging

This setting allows or prevents the display of window contents when dragging a window across the screen.

By default, viewing window contents is allowed.

When set to Allowed, the entire window appears to move when you drag it. When set to Prohibited, only the window outline appears to move until you drop it.
End user monitoring policy settings

Jul 24, 2014
The End User Monitoring section contains policy settings for measuring session traffic.

ICA round trip calculation
This setting determines whether ICA round trip calculations are performed for active connections.
By default, calculations for active connections are enabled.
By default, each ICA round trip measurement initiation is delayed until some traffic occurs that indicates user interaction. This delay can be indefinite in length and is designed to prevent the ICA round trip measurement being the sole reason for ICA traffic.

ICA round trip calculation interval
This setting specifies the frequency, in seconds, at which ICA round trip calculations are performed.
By default, ICA round trip is calculated every 15 seconds.

ICA round trip calculations for idle connections
This setting determines whether ICA round trip calculations are performed for idle connections.
By default, calculations are not performed for idle connections.
By default, each ICA round trip measurement initiation is delayed until some traffic occurs that indicates user interaction. This delay can be indefinite in length and is designed to prevent the ICA round trip measurement being the sole reason for ICA traffic.
Enhanced desktop experience policy setting

Jul 24, 2014

The Enhanced Desktop Experience policy setting sessions running on server operating systems to look like local Windows 7 desktops, providing users with an enhanced desktop experience.

By default, this setting is allowed.

If a user profile with Windows Classic theme already exists on the virtual desktop, enabling this policy does not provide an enhanced desktop experience for that user. If a user with a Windows 7 theme user profile logs on to a virtual desktop running Windows Server 2012 for which this policy is either not configured or disabled, that user sees an error message indicating failure to apply the theme.

In both cases, resetting the user profile resolves the issue.

If the policy changes from enabled to disabled on a virtual desktop with active user sessions, the look and feel of those sessions is inconsistent with both the Windows 7 and Windows Classic desktop experience. To avoid this, ensure you restart the virtual desktop after changing this policy setting. You must also delete any roaming profiles on the virtual desktop. Citrix also recommends deleting any other user profiles on the virtual desktop to avoid inconsistencies between profiles.

If you are using roaming user profiles in your environment, ensure the Enhanced Desktop Experience feature is enabled or disabled for all virtual desktops that share a profile.

Citrix does not recommend sharing roaming profiles between virtual desktops running server operating systems and client operating systems. Profiles for client and server operating systems differ, and sharing roaming profiles across both types can lead to inconsistencies in profile properties when a user moves between the two.
File Redirection policy settings

Jul 24, 2014
The File Redirection section contains policy settings relating to client drive mapping and client drive optimization.

Auto connect client drives

This setting allows or prevents automatic connection of client drives when users log on.

By default, automatic connection is allowed.

When adding this setting to a policy, make sure to enable the settings for the drive types you want automatically connected. For example, to allow automatic connection of users' CD-ROM drives, configure this setting and the Client optical drives setting.

The following policy settings are related:
- Client drive redirection
- Client floppy drives
- Client optical drives
- Client fixed drives
- Client network drives
- Client removable drives

Client drive redirection

This setting enables or disables file redirection to and from drives on the user device.

By default, file redirection is enabled.

When enabled, users can save files to all their client drives. When disabled, all file redirection is prevented, regardless of the state of the individual file redirection settings such as Client floppy drives and Client network drives.

The following policy settings are related:
- Client floppy drives
- Client optical drives
- Client fixed drives
- Client network drives
- Client removable drives

Client fixed drives

This setting allows or prevents users from accessing or saving files to fixed drives on the user device.

By default, accessing client fixed drives is allowed.

When adding this setting to a policy, make sure the Client drive redirection setting is present and set to Allowed. If these settings are disabled, client fixed drives are not mapped and users cannot access these drives manually, regardless of the state of the Client fixed drives setting.

To ensure fixed drives are automatically connected when users log on, configure the Auto connect client drives setting.
Client floppy drives
This setting allows or prevents users from accessing or saving files to floppy drives on the user device.

By default, accessing client floppy drives is allowed.

When adding this setting to a policy, make sure the Client drive redirection setting is present and set to Allowed. If these settings are disabled, client floppy drives are not mapped and users cannot access these drives manually, regardless of the state of the Client floppy drives setting.

To ensure floppy drives are automatically connected when users log on, configure the Auto connect client drives setting.

Client network drives
This setting allows or prevents users from accessing and saving files to network (remote) drives through the user device.

By default, accessing client network drives is allowed.

When adding this setting to a policy, make sure the Client drive redirection setting is present and set to Allowed. If these settings are disabled, client network drives are not mapped and users cannot access these drives manually, regardless of the state of the Client network drives setting.

To ensure network drives are automatically connected when users log on, configure the Auto connect client drives setting.

Client optical drives
This setting allows or prevents users from accessing or saving files to CD-ROM, DVD-ROM, and BD-ROM drives on the user device.

By default, accessing client optical drives is allowed.

When adding this setting to a policy, make sure the Client drive redirection setting is present and set to Allowed. If these settings are disabled, client optical drives are not mapped and users cannot access these drives manually, regardless of the state of the Client optical drives setting.

To ensure optical drives are automatically connected when users log on, configure the Auto connect client drives setting.

Client removable drives
This setting allows or prevents users from accessing or saving files to USB drives on the user device.

By default, accessing client removable drives is allowed.

When adding this setting to a policy, make sure the Client drive redirection setting is present and set to Allowed. If these settings are disabled, client removable drives are not mapped and users cannot access these drives manually, regardless of the state of the Client removable drives setting.

To ensure removable drives are automatically connected when users log on, configure the Auto connect client drives setting.

Host to client redirection
This setting enables or disables file type associations for URLs and some media content to be opened on the user device. When disabled, content opens on the server.
By default, file type association is disabled.

These URL types are opened locally when you enable this setting:
- Hypertext Transfer Protocol (HTTP)
- Secure Hypertext Transfer Protocol (HTTPS)
- Real Player and QuickTime (RTSP)
- Real Player and QuickTime (RTSPU)
- Legacy Real Player (PNM)
- Microsoft Media Server (MMS)

Preserve client drive letters

This setting enables or disables mapping of client drives to the same drive letter in the session.

By default, client drive letters are not preserved.

When adding this setting to a policy, make sure the Client drive redirection setting is present and set to Allowed.

Read-only client drive access

This setting allows or prevents users and applications from creating or modifying files or folders on mapped client drives.

By default, files and folders on mapped client drives can be modified.

If set to Enabled, files and folders are accessible with read-only permissions.

When adding this setting to a policy, make sure the Client drive redirection setting is present and set to Allowed.

Special folder redirection

This setting allows or prevents Citrix Receiver and Web Interface users to see their local Documents and Desktop special folders from a session.

By default, special folder redirection is allowed.

This setting prevents any objects filtered through a policy from having special folder redirection, regardless of settings that exist elsewhere. When this setting is prohibited, any related settings specified for StoreFront, Web Interface, or Citrix Receiver are ignored.

To define which users can have special folder redirection, select Allowed and include this setting in a policy filtered on the users you want to have this feature. This setting overrides all other special folder redirection settings.

Because special folder redirection must interact with the user device, policy settings that prevent users from accessing or saving files to their local hard drives also prevent special folder redirection from working.

When adding this setting to a policy, make sure the Client fixed drives setting is present and set to Allowed.

Use asynchronous writes

This setting enables or disables asynchronous disk writes.

By default, asynchronous writes are disabled.

Asynchronous disk writes can improve the speed of file transfers and writing to client disks over WANs, which are typically...
characterized by relatively high bandwidth and high latency. However, if there is a connection or disk fault, the client file or files being written may end in an undefined state. If this happens, a pop-up window informs the user of the files affected. The user can then take remedial action such as restarting an interrupted file transfer on reconnection or when the disk fault is corrected.

Citrix recommends enabling asynchronous disk writes only for users who need remote connectivity with good file access speed and who can easily recover files or data lost in the event of connection or disk failure.

When adding this setting to a policy, make sure that the Client drive redirection setting is present and set to Allowed. If this setting is disabled, asynchronous writes will not occur.
Flash Redirection policy settings

Sep 29, 2015

The Flash Redirection section contains policy settings for handling Flash content in user sessions.

Flash acceleration

This setting enables or disables Flash content rendering on user devices instead of the server. By default, client-side Flash content rendering is enabled.

Note: This setting is used for legacy Flash redirection with the Citrix online plug-in 12.1. When enabled, this setting reduces network and server load by rendering Flash content on the user device. Additionally, the Flash URL compatibility list setting forces Flash content from specific websites to be rendered on the server.

On the user device, the Enable HDX MediaStream for Flash on the user device setting must be enabled as well.

When this setting is disabled, Flash content from all websites, regardless of URL, is rendered on the server. To allow only certain websites to render Flash content on the user device, configure the Flash URL compatibility list setting.

Flash background color list

This setting enables you to set key colors for given URLs.

By default, no key colors are specified.

Key colors appear behind client-rendered Flash and help provide visible region detection. The key color specified should be rare; otherwise, visible region detection might not work properly.

Valid entries consist of a URL (with optional wildcards at the beginning or end) followed by a 24-bit RGB color hexadecimal code. For example: http://citrix.com 000003.

Ensure that the URL specified is the URL for the Flash content, which might be different from the URL of the website.

Warning

Using Registry Editor incorrectly can cause serious problems that can require you to reinstall the operating system. Citrix cannot guarantee that problems resulting from incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Make sure you back up the registry before you edit it.

On VDA machines running Windows 8 or Windows 2012, this setting might fail to set key colors for the URL. If this occurs, edit the registry on the VDA machine.

For 32-bit machines, use this registry setting:

[HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\HdxMediaStreamForFlash\Server\PseudoServer]
"ForceHDXFlashEnabled"=dword:00000001

For 64-bit machines, use this registry setting:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\HdxMediaStreamForFlash\Server\PseudoServer]
"ForceHDXFlashEnabled"=dword:00000001

Flash backwards compatibility

This setting enables or disables the use of original, legacy Flash redirection features with older versions of Citrix Receiver (formerly the Citrix online plug-in).

By default, this setting is enabled.

On the user device, the Enable HDX MediaStream for Flash on the user device setting must also be enabled.

Second generation Flash redirection features are enabled for use with Citrix Receiver 3.0. Legacy redirection features are supported for use with the Citrix online plug-in 12.1. To ensure second generation Flash redirection features are used, both the server and the user device must have second generation Flash redirection enabled. If legacy redirection is enabled on either the server or the user device, legacy redirection features are used.

Flash default behavior

This setting establishes the default behavior for second generation Flash acceleration.

By default, Flash acceleration is enabled.

To configure this setting, choose one of the following options:

- Enable Flash acceleration. Flash Redirection is used.
- Block Flash Player. Flash Redirection and server-side rendering are not used. The user cannot view any Flash content.
- Disable Flash acceleration. Flash Redirection is not used. The user can view server-side rendered Flash content if a version of Adobe Flash Player for Windows Internet Explorer compatible with the content is installed on the server.

This setting can be overridden for individual Web pages and Flash instances based on the configuration of the Flash URL compatibility list setting. Additionally, the user device must have the Enable HDX MediaStream for Flash on the user device setting enabled.

Flash event logging

This setting enables Flash events to be recorded in the Windows application event log.

By default, logging is allowed.

On computers running Windows 7 or Windows Vista, a Flash redirection-specific log appears in the Applications and Services Log node.

Flash intelligent fallback

This setting enables or disables automatic attempts to employ server-side rendering for Flash Player instances where client-side rendering is either unnecessary or provides a poor user experience.

By default, this setting is enabled.

Flash latency threshold

This setting specifies a threshold between 0-30 milliseconds to determine where Adobe Flash content is rendered.

By default, the threshold is 30 milliseconds.
During startup, HDX MediaStream for Flash measures the current latency between the server and user device. If the latency is under the threshold, HDX MediaStream for Flash is used to render Flash content on the user device. If the latency is above the threshold, the network server renders the content if an Adobe Flash player is available there.

When enabling this setting, make sure the Flash backwards compatibility setting is also present and set to Enabled.

Note: Applies only when using HDX MediaStream Flash redirection in Legacy mode.

Flash video fallback prevention

This setting specifies if and how "small" flash content is rendered and displayed to users.

By default, this setting is not configured.

To configure this setting, choose one of the following options:

- **Only small content.** Only intelligent fallback content will be rendered on the server; other Flash content will be replaced with an error *.swf.
- **Only small content with a supported client.** Only intelligent fallback content will be rendered on the server if the client is currently using Flash Redirection; other content will be replaced with an error *.swf.
- **No server side content.** All content on the server will be replaced with an error *swf.

To use this policy setting you should specify an error *.swf file. This error *.swf will replace any content that you do not want to be rendered on the VDA.

Flash video fallback prevention error *.swf

This setting specifies the URL of the error message which is displayed to users to replace Flash instances when the server load management policies are in use. For example:

```
http://domainName.tld/sample/path/error.swf
```

Flash server-side content fetching URL list

This setting specifies websites whose Flash content can be downloaded to the server and then transferred to the user device for rendering.

By default, no sites are specified.

This setting is used when the user device does not have direct access to the Internet; the server provides that connection. Additionally, the user device must have the Enable server-side content fetching setting enabled.

Second generation Flash redirection includes a fallback to server-side content fetching for Flash .swf files. If the user device is unable to fetch Flash content from a Web site, and the Web site is specified in the Flash server-side content fetching URL list, server-side content fetching occurs automatically.

When adding URLs to the list:

- Add the URL of the Flash application instead of the top-level HTML page that initiates the Flash Player.
- Use an asterisk (*) at the beginning or end of the URL as a wildcard.
- Use a trailing wildcard to allow all child URLs (http://www.citrix.com/*).
- The prefixes http:// and https:// are used when present, but are not required for valid list entries.

Flash URL compatibility list
This setting specifies the rules which determine whether Flash content on certain websites is rendered on the user device, rendered on the server, or blocked from rendering.

By default, no rules are specified.

When adding URLs to the list:
- Prioritize the list with the most important URLs, actions, and rendering locations at the top.
- Use an asterisk (*) at the beginning or end of the URL as a wildcard.
- Use a trailing wildcard to refer to all child URLs (http://www.citrix.com/*).
- The prefixes http:// and https:// are used when present, but are not required for valid list entries.
- Add to this list websites whose Flash content does not render correctly on the user device and select either the Render on Server or Block options.
Graphics policy settings

The Graphics section contains policy settings for controlling how images are handled in user sessions.

Display memory limit

This setting specifies the maximum video buffer size in kilobytes for the session.

By default, the display memory limit is 65536 kilobytes.

For connections requiring more color depth and higher resolution, increase the limit. Calculate the maximum memory required using the equation:

\[
\text{Memory depth in bytes} = \frac{(\text{color-depth-in-bits-per-pixel})}{8} \times (\text{vertical-resolution-in-pixels}) \times (\text{horizontal-resolution-in-pixels})
\]

For example, with a color depth of 32, vertical resolution of 600, and a horizontal resolution of 800, the maximum memory required is \((32 / 8) \times (600) \times (800) = 1920000\) bytes, which yields a display memory limit of 1920 KB.

Color depths other than 32-bit are available only if the Legacy graphics mode policy setting is enabled.

HDX allocates only the amount of display memory needed for each session. So, if only some users require more than the default, there is no negative impact on scalability by increasing the display memory limit.

Display mode degrade preference

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.

This setting specifies whether color depth or resolution degrades first when the session display memory limit is reached.

By default, color depth is degraded first.

When the session memory limit is reached, you can reduce the quality of displayed images by choosing whether color depth or resolution is degraded first. When color depth is degraded first, displayed images use fewer colors. When resolution is degraded first, displayed images use fewer pixels per inch.

To notify users when either color depth or resolution are degraded, configure the Notify user when display mode is degraded setting.

Dynamic windows preview

This setting enables or disables the display of seamless windows in Flip, Flip 3D, Taskbar Preview, and Peek window preview modes.

<table>
<thead>
<tr>
<th>Windows Aero preview option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taskbar Preview</td>
<td>When the user hovers over a window's taskbar icon, an image of that window appears above the taskbar.</td>
</tr>
<tr>
<td>Windows Peek</td>
<td>When the user hovers over a taskbar preview image, a full-sized image of the window appears on the screen.</td>
</tr>
<tr>
<td>Windows Aero preview option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Flip 3D</td>
<td>When the user presses TAB+Windows logo key, large images of the open windows cascade across the screen.</td>
</tr>
</tbody>
</table>

By default, this setting is enabled.

**Image caching**

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.

This setting enables or disables the caching and retrieving of sections of images in sessions. Caching images in sections and retrieving these sections when needed makes scrolling smoother, reduces the amount of data transmitted over the network, and reduces the processing required on the user device.

By default, the image caching setting is enabled.

Note: The image caching setting controls how images are cached and retrieved; it does not control whether images are cached. Images are cached if the Legacy graphics mode setting is enabled.

**Legacy graphics mode**

This setting disables the rich graphics experience, providing fallback to the legacy graphics experience to improve scalability over a WAN or mobile connection.

By default, this setting is disabled and users are provided with the rich graphics experience.

**Maximum allowed color depth**

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.

This setting specifies the maximum color depth allowed for a session.

By default, the maximum allowed color depth is 32 bits per pixel.

This setting applies only to ThinWire drivers and connections. It does not apply to VDAs that have a non-ThinWire driver as the primary display driver, such as VDAs that use a Windows Display Driver Model (WDDM) driver as the primary display driver. For Desktop OS VDAs using a WDDM driver as the primary display driver, such as Windows 8, this setting has no effect. For Windows Server OS VDAs using a WDDM driver, such as Windows Server 2012 R2, this setting might prevent users from connecting to the VDA.

Setting a high color depth requires more memory. To degrade color depth when the memory limit is reached, configure the Display mode degrade preference setting. When color depth is degraded, displayed images use fewer colors.

**Notify user when display mode is degraded**

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.

This setting displays a brief explanation to the user when the color depth or resolution is degraded.

By default, notifying users is disabled.

**Queuing and tossing**
Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.
This setting discards queued images that are replaced by another image.

By default, queuing and tossing is enabled.

This improves response when graphics are sent to the user device. Configuring this setting can cause animations to become choppy because of dropped frames.
Caching policy settings

Jul 24, 2014
The Caching section contains policy settings that enable caching image data on user devices when client connections are limited in bandwidth.

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.
This setting caches bitmaps on the hard drive of the user device. This enables re-use of large, frequently-used images from previous sessions.

By default, the threshold is 3000000 bits per second.

The threshold value represents the point below which the Persistent Cache feature will take effect. For example, using the default value, bitmaps are cached on the hard drive of the user device when bandwidth falls below 3000000 bps.
Framehawk policy settings

Dec 01, 2015
The Framehawk section contains policy settings that enable and configure the Framehawk display channel on the server.

Framehawk display channel

When enabled, the server attempts to use the Framehawk display channel for the user's graphics and input remoting. That display channel will use UDP to provide a better user experience on networks with high loss and latency characteristics; however, it may also use more server resources and bandwidth than other graphics modes.

By default, the Framehawk display channel is disabled.

Framehawk display channel port range

This policy setting specifies the range of UDP port numbers (in the form \text{lowest port number},\text{highest port number}) the VDA uses to exchange Framehawk display channel data with the user device. The VDA attempts to use each port, starting with the lowest port number and incrementing for each subsequent attempt. The port handles inbound and outbound traffic.

By default, the port range is 3224,3324.
Keep alive policy settings

Jul 24, 2014
The Keep Alive section contains policy settings for managing ICA keep-alive messages.

This setting specifies the number of seconds between successive ICA keep-alive messages.

By default, the interval between keep-alive messages is 60 seconds.

Specify an interval between 1-3600 seconds in which to send ICA keep-alive messages. Do not configure this setting if your network monitoring software is responsible for closing inactive connections.

This setting enables or disables sending ICA keep-alive messages periodically.

By default, keep-alive messages are not sent.

Enabling this setting prevents broken connections from being disconnected. If the server detects no activity, this setting prevents Remote Desktop Services (RDS) from disconnecting the session. The server sends keep-alive messages every few seconds to detect if the session is active. If the session is no longer active, the server marks the session as disconnected.

ICA keep-alive does not work if you are using session reliability. Configure ICA keep-alive only for connections that are not using Session Reliability.

Related policy settings: Session reliability connections.
Local App Access policy settings

Jul 24, 2014

The Local App Access section contains policy settings that manage the integration of users' locally-installed applications with hosted applications in a hosted desktop environment.

This setting allows or prevents the integration of users' locally-installed applications with hosted applications within a hosted desktop environment.

When a user launches a locally-installed application, that application appears to run within their virtual desktop, even though it is actually running locally.

By default, local app access is prohibited.

This setting specifies websites that are redirected to and launched in the local Web browser. This might include websites requiring locale information, such as msn.com or newsgoogle.com, or websites containing rich media content that are better rendered on the user device.

By default, no sites are specified.

This setting specifies websites that are rendered in the environment in which they are launched.

By default, no sites are specified.
Mobile experience policy settings

Sep 29, 2015
The Mobile Experience section contains policy settings for handling the Citrix Mobility Pack.

This setting enables or disables the automatic display of the keyboard on mobile device screens.

By default, the automatic display of the keyboard is disabled.

This setting is disabled and not available for Windows 10 machines.

This setting determines the overall Citrix Receiver interface behavior by allowing or prohibiting a touch-friendly interface that is optimized for tablet devices.

By default, a touch-friendly interface is used.

To use only the Windows interface, set this policy setting to Prohibited.

This setting determines the types of combo boxes you can display in sessions on mobile devices. To display the device-native combo box control, set this policy setting to Allowed. When this setting is allowed, a user can change a Citrix Receiver for iOS session setting to use the Windows combo box.

By default, the Remote the combo box feature is prohibited.
Multimedia policy settings

Sep 29, 2015
The Multimedia section contains policy settings for managing streaming audio and video in user sessions.

This setting specifies the maximum video quality level allowed for an HDX connection. When configured, maximum video quality is limited to the specified value, ensuring that multimedia Quality of Service (QoS) is maintained within an environment.

By default, this setting is not configured.

To limit the maximum video quality level allowed, choose one of the following options:

- 1080p/8.5mbps
- 720p/4.0mbps
- 480p/720kbps
- 380p/400kbps
- 240p/200kbps

Note: Playing multiple videos simultaneously on the same server consumes large amounts of resources and may impact server scalability.

This setting allows or prevents support for video conferencing applications.

By default, video conferencing support is allowed.

When adding this setting to a policy, make sure the Windows Media Redirection setting is present and set to Allowed.

When using multimedia conferencing, make sure the following conditions are met:

- Manufacturer-supplied drivers for the web cam used for multimedia conferencing must be installed.
- The web cam must be connected to the user device before initiating a video conferencing session. The server uses only one installed web cam at any given time. If multiple web cams are installed on the user device, the server attempts to use each web cam in succession until a video conferencing session is created successfully.

This setting enables real-time multimedia transcoding, allowing audio and video media streaming to mobile devices, and enhancing the user experience by improving how Windows Media content is delivered over a WAN.

By default, the delivery of Windows Media content over the WAN is optimized.

When adding this setting to a policy, make sure the Windows Media Redirection setting is present and set to Allowed.

When this setting is enabled, real-time multimedia transcoding is deployed automatically as needed to enable media streaming, providing a seamless user experience even in extreme network conditions.

This setting enables real-time multimedia transcoding to be done in the Graphics Processing Unit (GPU) on the Virtual
Delivery Agent (VDA), to improve server scalability. GPU transcoding is available only if the VDA has a supported GPU for hardware acceleration. Otherwise, transcoding falls back to the CPU.

Note: GPU transcoding is supported only on NVIDIA GPUs.
By default, using the GPU on the VDA to optimize the delivery of Windows Media content over the WAN is prohibited.

When adding this setting to a policy, make sure the Windows Media Redirection and Optimization for Windows Media multimedia redirection over WAN settings are present and set to Allowed.

Administrators can use the Video fallback prevention policy setting to specify the methods that will be attempted to deliver streamed content to users.

By default, this setting is not configured. This allows Client Side Fetching to RAVE to Server Side fallbacks.

To configure this setting, choose one of the following options:

- **Server Fetched - Server Rendered.** Allow Client Side Fetching to RAVE to Server Side fallbacks.
- **Server Fetched - Client Rendered.** Allow Client Side Fetching to RAVE fallback, however, block RAVE to Server Side Rendering fallback.
- **Client Fetched - Client Rendered.** Block Client Side Fetching to RAVE to Server Side Rendering fallbacks.

When the content does not play, the error message "Company has blocked video because of lack of resources" displays in the player window.

This setting enables a user device to stream multimedia files directly from the source provider on the Internet or Intranet, rather than through the host server.

By default, the streaming of multimedia files to the user device direct from the source provider is allowed.

Allowing this setting improves network utilization and server scalability by moving any processing on the media from the host server to the user device. It also removes the requirement that an advanced multimedia framework such as Microsoft DirectShow or Media Foundation be installed on the user device; the user device requires only the ability to play a file from a URL.

When adding this setting to a policy, make sure the Windows Media Redirection setting is present and set to Allowed. If this setting is disabled, the streaming of multimedia files to the user device direct from the source provider is also disabled.

This setting controls and optimizes the way servers deliver streaming audio and video to users.

By default, the delivery of streaming audio and video to users is allowed.

Allowing this setting increases the quality of audio and video rendered from the server to a level that compares with audio and video played locally on a user device. The server streams multimedia to the client in the original, compressed form and allows the user device to decompress and render the media.

Windows Media redirection optimizes multimedia files that are encoded with codecs that adhere to Microsoft DirectShow, DirectX Media Objects (DMO), and Media Foundation standards. To play back a given multimedia file, a codec compatible
with the encoding format of the multimedia file must be present on the user device.

By default, audio is disabled on Citrix Receiver. To allow users to run multimedia applications in ICA sessions, turn on audio or give users permission to turn on audio in their Citrix Receiver interface.

Select Prohibited only if playing media using Windows Media redirection appears worse than when rendered using basic ICA compression and regular audio. This is rare but can happen under low bandwidth conditions, for example, with media with a very low frequency of key frames.

This setting specifies a buffer size from 1 to 10 seconds for multimedia acceleration.

By default, the buffer size is 5 seconds.

This setting enables or disables using the buffer size specified in the Windows Media Redirection buffer size setting.

By default, the buffer size specified is not used.

If this setting is disabled or if the Windows Media Redirection buffer size setting is not configured, the server uses the default buffer size value (5 seconds).
Multi-stream connections policy settings

Aug 08, 2014

The Multi-Stream Connections section contains policy settings for managing Quality of Service (QoS) prioritization for multiple ICA connections in a session.

This setting allows or prevents audio over UDP on the server.

By default, audio over UDP is allowed on the server.

When enabled, this setting opens a UDP port on the server to support all connections configured to use Audio over UDP Realtime Transport.

This setting specifies the range of port numbers (in the form lowest port number,highest port number) used by the Virtual Delivery Agent (VDA) to exchange audio packet data with the user device. The VDA attempts to use each UDP port pair to exchange data with the user device, starting with the lowest and incrementing by two for each subsequent attempt. Each port handles both inbound and outbound traffic.

By default, this is set to 16500,16509.

This setting specifies the TCP ports to be used for ICA traffic and establishes the network priority for each port.

By default, the primary port (2598) has a High priority.

When you configure ports, you can assign the following priorities:
- Very High - for real-time activities, such as webcam conferences
- High - for interactive elements, such as screen, keyboard, and mouse
- Medium - for bulk processes, such as client drive mapping
- Low - for background activities, such as printing

Each port must have a unique priority. For example, you cannot assign a Very High priority to both CGP port 1 and CGP port 3.

To remove a port from prioritization, set the port number to 0. You cannot remove the primary port and you cannot modify its priority level.

When configuring this setting, restart the server. This setting takes effect only when the Multi-Stream computer setting policy setting is enabled.

This setting enables or disables Multi-Stream on the server.

By default, Multi-Stream is disabled.

If you use Citrix Cloudbridge with Multi-Stream support in your environment, you do not need to configure this setting.
Configure this policy setting when using third-party routers or legacy Branch Repeaters to achieve the desired Quality of Service (QoS).

When configuring this setting, reboot the server to ensure changes take effect. Important: Using this policy setting in conjunction with bandwidth limit policy settings such as Overall session bandwidth limit may produce unexpected results. When including this setting in a policy, ensure that bandwidth limit settings are not included.

This setting enables or disables Multi-Stream on the user device. By default, Multi-Stream is disabled for all users.

This setting takes effect only on hosts where the Multi-Stream computer setting policy setting is enabled. Important: Using this policy setting with bandwidth limit policy settings such as Overall session bandwidth limit may produce unexpected results. When including this setting in a policy, ensure that bandwidth limit settings are not included.
Port redirection policy settings

Sep 15, 2014
The Port Redirection section contains policy settings for client LPT and COM port mapping.

Note: For the Virtual Delivery Agent 7.x, configure these settings using the registry; see Configure COM Port and LPT Port Redirection settings using the registry.

This setting enables or disables automatic connection of COM ports on user devices when users log on to a site.

By default, client COM ports are not automatically connected.

This setting enables or disables automatic connection of LPT ports on user devices when users log on to a site.

By default, client LPT ports are not connected automatically.

This setting allows or prevents access to COM ports on the user device.

By default, COM port redirection is prohibited.

The following policy settings are related:
- COM port redirection bandwidth limit
- COM port redirection bandwidth limit percent

This setting allows or prevents access to LPT ports on the user device.

By default, LPT port redirection is prohibited.

LPT ports are used only by legacy applications that send print jobs to the LPT ports and not to the print objects on the user device. Most applications today can send print jobs to printer objects. This policy setting is necessary only for servers that host legacy applications that print to LPT ports.

The following policy settings are related:
- LPT port redirection bandwidth limit
- LPT port redirection bandwidth limit percent
Printing policy settings

Aug 26, 2014
The Printing section contains policy settings for managing client printing.

This setting controls whether client printers are mapped to a server when a user logs on to a session.

By default, client printer mapping is allowed. If this setting is disabled, the PDF printer for the session is not auto-created.

Related policy settings: auto-create client printers

This setting specifies how the default printer on the user device is established in a session.

By default, the user's current printer is used as the default printer for the session.

To use the current Remote Desktop Services or Windows user profile setting for the default printer, select Do not adjust the user's default printer. If you choose this option, the default printer is not saved in the profile and it does not change according to other session or client properties. The default printer in a session will be the first printer auto-created in the session, which is either:

- The first printer added locally to the Windows server in Control Panel > Devices and Printers.
- The first auto-created printer, if there are no printers added locally to the server.

You can use this option to present users with the nearest printer through profile settings (known as proximity printing).

This setting provides an alternative to the Default printer and Session printers settings. Use the individual Default printer and Session printers settings to configure behaviors for a site, large group, or organizational unit. Use the Printer assignments setting to assign a large group of printers to multiple users.

This setting specifies how the default printer on the listed user devices is established in a session.

By default, the user's current printer is used as the default printer for the session.

It also specifies the network printers to be auto-created in a session for each user device. By default, no printers are specified.

- When setting the default printer value:
  - To use the current default printer for the user device, select Do not adjust.

  To use the current Remote Desktop Services or Windows user profile setting for the default printer, select Do no adjust. If you choose this option, the default printer is not saved in the profile and it does not change according to other session or client properties. The default printer in a session will be the first printer auto-created in the session, which is either:

  - The first printer added locally to the Windows server in Control Panel > Devices and Printers.
  - The first auto-created printer, if there are no printers added locally to the server.

  When setting the session printers value: to add printers, type the UNC path of the printer you want to auto-create.
After adding the printer, you can apply customized settings for the current session at every logon.

This setting specifies the events that are logged during the printer auto-creation process. You can choose to log no errors or warnings, only errors, or errors and warnings.

By default, errors and warnings are logged.

An example of a warning is an event in which a printer's native driver could not be installed and the Universal print driver is installed instead. To use the Universal print driver in this scenario, configure the Universal print driver usage setting to Use universal printing only or Use universal printing only if requested driver is unavailable.

This setting specifies the network printers to be auto-created in a session.

By default, no printers are specified.

To add printers, type the UNC path of the printer you want to auto-create. After adding the printer, you can apply customized settings for the current session at every logon.

This setting allows or prevents a delay in connecting to a session so that server desktop printers can be auto-created.

By default, a connection delay does not occur.
Client printers policy settings

Sep 29, 2015
The Client Printers section contains policy settings for client printers, including settings to autocreate client printers, retain printer properties, and connect to print servers.

This setting specifies the client printers that are auto-created. This setting overrides default client printer auto-creation settings.

By default, all client printers are auto-created.

This setting takes effect only if the Client printer redirection setting is present and set to Allowed.

When adding this setting to a policy, select an option:
- Auto-create all client printers automatically creates all printers on a user device.
- Auto-create the client’s default printer only automatically creates only the printer selected as the default printer on the user device.
- Auto-create local (non-network) client printers only automatically creates only printers directly connected to the user device through an LPT, COM, USB, TCP/IP, or other local port.
- Do not auto-create client printers turns off autocreation for all client printers when users log on. This causes the Remote Desktop Services (RDS) settings for autocreating client printers to override this setting in lower priority policies.

Note: Hotfixes that address the issues with this policy setting are available as Knowledge Center articles CTX141565 and CTX141566.
This setting enables or disables autocreation of the generic Citrix Universal Printer object for sessions where a user device compatible with Universal Printing is in use.

By default, the generic Universal Printer object is not autocreated.

The following policy settings are related:
- Universal print driver usage
- Universal driver preference

This setting selects the naming convention for auto-created client printers.

By default, standard printer names are used.

Select Standard printer names to use printer names such as “HPLaserJet 4 from clientname in session 3.”

Select Legacy printer names to use old-style client printer names and preserve backward compatibility for users or groups using MetaFrame Presentation Server 3.0 or earlier. An example of a legacy printer name is “Client/clientname#/HPLaserJet 4.” This option is less secure.

Note: This option is provided only for backwards compatibility with legacy versions of XenApp and XenDesktop.
This setting enables or disables direct connections from the virtual desktop or server hosting applications to a print server for client printers hosted on an accessible network share.

By default, direct connections are enabled.

Enable direct connections if the network print server is not across a WAN from the virtual desktop or server hosting applications. Direct communication results in faster printing if the network print server and the virtual desktop or server hosting applications are on the same LAN.

Disable direct connections if the network is across a WAN or has substantial latency or limited bandwidth. Print jobs are routed through the user device where they are redirected to the network print server. Data sent to the user device is compressed, so less bandwidth is consumed as the data travels across the WAN.

If two network printers have the same name, the printer on the same network as the user device is used.

This setting specifies the driver substitution rules for auto-created client printers.

By default, no rules are specified.

When you define driver substitution rules, you can allow or prevent printers to be created with the specified driver. Additionally, you can allow created printers to use only universal print drivers. Driver substitution overrides or maps printer driver names the user device provides, substituting an equivalent driver on the server. This gives server applications access to client printers that have the same drivers as the server, but different driver names.

You can add a driver mapping, edit an existing mapping, override custom settings for a mapping, remove a mapping, or change the order of driver entries in the list. When adding a mapping, enter the client printer driver name and then select the server driver you want to substitute.

This setting specifies whether or not to store printer properties and where to store them.

By default, the system determines if printer properties are stored on the user device, if available, or in the user profile.

When adding this setting to a policy, select an option:
- **Saved on the client device only** is for user devices that have a mandatory or roaming profile that is not saved. Choose this option only if all the servers in your farm are running XenApp 5 and above and your users are using Citrix online plug-in versions 9 through 12.x, or Citrix Receiver 3.x.
- **Retained in user profile only** is for user devices constrained by bandwidth (this option reduces network traffic) and logon speed or for users with legacy plug-ins. This option stores printer properties in the user profile on the server and prevents any properties exchange with the user device. Use this option with MetaFrame Presentation Server 3.0 or earlier and MetaFrame Presentation Server Client 8.x or earlier. Note that this is applicable only if a Remote Desktop Services (RDS) roaming profile is used.
- **Held in profile only if not saved on client** allows the system to determine where printer properties are stored. Printer properties are stored either on the user device, if available, or in the user profile. Although this option is the most flexible, it can also slow logon time and use extra bandwidth for system-checking.
- **Do not retain printer properties** prevents storing printer properties.
This setting enables or disables the retention and re-creation of printers on the user device. By default, client printers are auto-retained and auto-restored.

Retained printers are user-created printers that are created again, or remembered, at the start of the next session. When XenApp recreates a retained printer, it considers all policy settings except the Auto-create client printers setting.

Restored printers are printers fully customized by an administrator, with a saved state that is permanently attached to a client port.
Drivers policy settings

Jul 24, 2014

The Drivers section contains policy settings related to printer drivers.

This setting enables or disables the automatic installation of printer drivers from the Windows in-box driver set or from driver packages staged on the host using pnputil.exe /a.

By default, these drivers are installed as needed.

This setting specifies the order in which universal printer drivers are used, beginning with the first entry in the list.

By default, the preference order is:
- EMF
- XPS
- PCL5c
- PCL4
- PS

You can add, edit, or remove drivers, and change the order of drivers in the list.

This setting specifies when to use universal printing.

By default, universal printing is used only if the requested driver is unavailable.

Universal printing employs generic printer drivers instead of standard model-specific drivers, potentially simplifying the burden of driver management on host computers. The availability of universal print drivers depends on the capabilities of the user device, host, and print server software. In certain configurations, universal printing might not be available.

When adding this setting to a policy, select an option:
- Use only printer model specific drivers specifies that the client printer uses only the standard model-specific drivers that are auto-created at logon. If the requested driver is unavailable, the client printer cannot be auto-created.
- Use universal printing only specifies that no standard model-specific drivers are used. Only universal print drivers are used to create printers.
- Use universal printing only if requested driver is unavailable uses standard model-specific drivers for printer creation if they are available. If the driver is not available on the server, the client printer is created automatically with the appropriate universal driver.
- Use printer model specific drivers only if universal printing is unavailable uses the universal print driver if it is available. If the driver is not available on the server, the client printer is created automatically with the appropriate model-specific printer driver.
Universal Print Server policy settings

Sep 29, 2015

The Universal Print Server section contains policy settings for handling the Universal Print Server.

This setting enables or disables the Universal Print Server feature on the virtual desktop or the server hosting applications. Apply this policy setting to Organizational Units (OUs) containing the virtual desktop or server hosting applications.

By default, the Universal Print Server is disabled.

When adding this setting to a policy, select one of the following options:

- **Enabled with fallback to Windows native remote printing.** Network printer connections are serviced by the Universal Print Server, if possible. If the Universal Print Server is not available, the Windows Print Provider is used. The Windows Print Provider continues to handle all printers previously created with the Windows Print Provider.

- **Enabled with no fallback to Windows native remote printing.** Network printer connections are serviced by the Universal Print Server exclusively. If the Universal Print Server is unavailable, the network printer connection fails. This setting effectively disables network printing through the Windows Print Provider. Printers previously created with the Windows Print Provider are not created while a policy containing this setting is active.

- **Disabled.** The Universal Print Server feature is disabled. No attempt is made to connect with the Universal Print Server when connecting to a network printer with a UNC name. Connections to remote printers continue to use the Windows native remote printing facility.

This setting specifies the TCP port number used by the Universal Print Server print data stream Common Gateway Protocol (CGP) listener. Apply this policy setting only to OUs containing the print server.

By default, the port number is set to 7229.

Valid port numbers must be in the range of 1 to 65535.

This setting specifies the upper boundary (in kilobits per second) for the transfer rate of print data delivered from each print job to the Universal Print Server using CGP. Apply this policy setting to OUs containing the virtual desktop or server hosting applications.

By default, the value is 0, which specifies no upper boundary.

This setting specifies the TCP port number used by the Universal Print Server's web service (HTTP/SOAP) listener. The Universal Print Server is an optional component that enables the use of Citrix universal print drivers for network printing scenarios. When the Universal Print Server is used, printing commands are sent from XenApp and XenDesktop hosts to the Universal Print Server via SOAP over HTTP. This setting modifies the default TCP port on which the Universal Print Server listens for incoming HTTP/SOAP requests.

You must configure both host and print server HTTP port identically. If you do not configure the ports identically, the host software will not connect to the Universal Print Server. This setting changes the VDA on XenApp and XenDesktop.
addition, you must change the default port on the Universal Print Server.

By default, the port number is set to 8080.

Valid port numbers must be in the range of 0 to 65535.
Universal printing policy settings

Jul 24, 2014
The Universal Printing section contains policy settings for managing universal printing.

This setting controls the method of processing the EMF spool file on the Windows user device.

By default, EMF records are spooled directly to the printer.

When adding this setting to a policy, select an option:
- Reprocess EMFs for printer forces the EMF spool file to be reprocessed and sent through the GDI subsystem on the user device. You can use this setting for drivers that require EMF reprocessing but that might not be selected automatically in a session.
- Spool directly to printer, when used with the Citrix Universal print driver, ensures the EMF records are spooled and delivered to the user device for processing. Typically, these EMF spool files are injected directly to the client's spool queue. For printers and drivers that are compatible with the EMF format, this is the fastest printing method.

This setting specifies the maximum quality and the minimum compression level available for images printed with the Citrix Universal print driver.

By default, the image compression limit is set to Best quality (lossless compression).

If No Compression is selected, compression is disabled for EMF printing only.

When adding this setting to a policy, select an option:
- No compression
- Best quality (lossless compression)
- High quality
- Standard quality
- Reduced quality (maximum compression)

When adding this setting to a policy that includes the Universal printing optimization defaults setting, be aware of the following:
- If the compression level in the Universal printing image compression limit setting is lower than the level defined in the Universal printing optimization defaults setting, images are compressed at the level defined in the Universal printing image compression limits setting.
- If compression is disabled, the Desired image quality and Enable heavyweight compression options of the Universal printing optimization defaults setting have no effect in the policy.

This setting specifies the default values for printing optimization when the universal print driver is created for a session.

- Desired image quality specifies the default image compression limit applied to universal printing. By default, Standard Quality is enabled, meaning that users can only print images using standard or reduced quality compression.
- Enable heavyweight compression enables or disables reducing bandwidth beyond the compression level set by Desired image quality, without losing image quality. By default, heavyweight compression is disabled.
• Image and Font Caching settings specify whether or not to cache images and fonts that appear multiple times in the print stream, ensuring each unique image or font is sent to the printer only once. By default, embedded images and fonts are cached. Note that these settings apply only if the user device supports this behavior.

• Allow non-administrators to modify these settings specifies whether or not users can change the default print optimization settings within a session. By default, users are not allowed to change the default print optimization settings.

Note: All of these options are supported for EMF printing. For XPS printing, only the Desired image quality option is supported.

When adding this setting to a policy that includes the Universal printing image compression limit setting, be aware of the following:

• If the compression level in the Universal printing image compression limit setting is lower than the level defined in the Universal printing optimization defaults setting, images are compressed at the level defined in the Universal printing image compression limits setting.

• If compression is disabled, the Desired image quality and Enable heavyweight compression options of the Universal printing optimization defaults setting have no effect in the policy.

This setting specifies whether or not to use the print preview function for auto-created or generic universal printers.

By default, print preview is not used for auto-created or generic universal printers.

When adding this setting to a policy, select an option:
• Do not use print preview for auto-created or generic universal printers
• Use print preview for auto-created printers only
• Use print preview for generic universal printers only
• Use print preview for both auto-created and generic universal printers

This setting specifies the maximum dots per inch (dpi) available for generating printed output in a session.

By default, No Limit is enabled, meaning users can select the maximum print quality allowed by the printer to which they connect.

If this setting is configured, it limits the maximum print quality available to users in terms of output resolution. Both the print quality itself and the print quality capabilities of the printer to which the user connects are restricted to the configured setting. For example, if configured to Medium Resolution (600 DPI), users are restricted to printing output with a maximum quality of 600 DPI and the Print Quality setting on the Advanced tab of the Universal Printer dialog box shows resolution settings only up to and including Medium Quality (600 DPI).

When adding this setting to a policy, select an option:
• Draft (150 DPI)
• Low Resolution (300 DPI)
• Medium Resolution (600 DPI)
• High Resolution (1200 DPI)
• No Limit
Security policy settings

Apr 22, 2015
The Security section contains the policy setting for configuring session encryption and encryption of logon data.

This setting specifies the minimum level at which to encrypt session data sent between the server and a user device.

**Important:** For the Virtual Delivery Agent 7.x, this policy setting can be used only to enable the encryption of the logon data with RC5 128-bit encryption. Other settings are provided only for backwards compatibility with legacy versions of XenApp and XenDesktop.

For the VDA 7.x, encryption of session data is set using the basic settings of the VDA's Delivery Group. If Enable Secure ICA is selected for the Delivery Group, session data is encrypted with RC5 (128 bit) encryption. If Enable Secure ICA is not selected for the Delivery Group, session data is encrypted with Basic encryption.

When adding this setting to a policy, select an option:
- **Basic** encrypts the client connection using a non-RC5 algorithm. It protects the data stream from being read directly, but it can be decrypted. By default, the server uses Basic encryption for client-server traffic.
- **RC5 (128 bit) logon only** encrypts the logon data with RC5 128-bit encryption and the client connection using Basic encryption.
- **RC5 (40 bit)** encrypts the client connection with RC5 40-bit encryption.
- **RC5 (56 bit)** encrypts the client connection with RC5 56-bit encryption.
- **RC5 (128 bit)** encrypts the client connection with RC5 128-bit encryption.

The settings you specify for client-server encryption can interact with any other encryption settings in your environment and your Windows operating system. If a higher priority encryption level is set on either a server or user device, settings you specify for published resources can be overridden.

You can raise encryption levels to further secure communications and message integrity for certain users. If a policy requires a higher encryption level, Citrix Receivers using a lower encryption level are denied connection.

SecureICA does not perform authentication or check data integrity. To provide end-to-end encryption for your site, use SecureICA with TLS encryption.

SecureICA does not use FIPS-compliant algorithms. If this is an issue, configure the server and Citrix Receivers to avoid using SecureICA.
Server limits policy settings

Sep 01, 2015
The Server Limits section contains the policy setting for controlling idle connections.

This setting determines, in milliseconds, how long an uninterrupted user session is maintained if there is no input from the user.

By default, idle connections are not disconnected (server idle timer interval = 0).

Note
When this policy setting is used, an "Idle timer expired" dialog box might appear to users when the session has been idle for the specified time. This is a Microsoft dialog box that is not controlled by Citrix policy settings. For more information, see http://support.citrix.com/article/CTX118618.
Session limits policy settings

Jul 24, 2014

The Session Limits section contains policy settings that control how long sessions remain connected before they are forced to log off.

This setting enables or disables a timer that specifies how long a disconnected, locked desktop can remain locked before the session is logged off.

By default, disconnected sessions are not logged off.

This setting specifies how many minutes a disconnected, locked desktop can remain locked before the session is logged off.

By default, the time period is 1440 minutes (24 hours).

This setting enables or disables a timer that specifies the maximum duration of an uninterrupted connection between a user device and a desktop.

By default, this timer is disabled.

This setting specifies the maximum number of minutes for an uninterrupted connection between a user device and a desktop.

By default, the maximum duration is 1440 minutes (24 hours).

This setting enables or disables a timer that specifies how long an uninterrupted user device connection to a desktop will be maintained if there is no input from the user.

By default, this timer is enabled.

This setting specifies how many minutes an uninterrupted user device connection to a desktop will be maintained if there is no input from the user.

By default, idle connections are maintained for 1440 minutes (24 hours).
Session reliability policy settings

Jul 24, 2014
The Session Reliability section contains policy settings for managing session reliability connections.

This setting allows or prevents sessions to remain open during a loss of network connectivity.

By default, session reliability is allowed.

Session reliability keeps sessions active and on the user’s screen when network connectivity is interrupted. Users continue to see the application they are using until network connectivity resumes.

With session reliability, the session remains active on the server. To indicate that connectivity is lost, the user’s display freezes and the cursor changes to a spinning hourglass until connectivity is restored. The user continues to access the display during the interruption and can resume interacting with the application when the network connection is restored.

Session reliability reconnects users without reauthentication prompts. If you do not want users to be able to reconnect to interrupted sessions without having to reauthenticate, configure the Auto client reconnect authentication setting to require authentication. Users are then prompted to reauthenticate when reconnecting to interrupted sessions.

If you use both session reliability and auto client reconnect, the two features work in sequence. Session reliability closes (or disconnects) the user session after the amount of time specified in the Session reliability timeout setting. After that, the auto client reconnect settings take effect, attempting to reconnect the user to the disconnected session.

This setting specifies the TCP port number for incoming session reliability connections.

By default, the port number is set to 2598.

This setting specifies the length of time, in seconds, the session reliability proxy waits for a user to reconnect before allowing the session to be disconnected.

By default, this is set to 180 seconds, or three minutes.

Although you can extend the amount of time a session is kept open, this feature is designed to be convenient to the user and it does not prompt the user for reauthentication. As you extend the amount of time a session is kept open, chances increase that a user may get distracted and walk away from the user device, potentially leaving the session accessible to unauthorized users.
Time zone control policy settings

Jul 24, 2014
The Time Zone Control section contains policy settings related to using local time in sessions.

This setting enables or disables estimating the local time zone of user devices that send inaccurate time zone information to the server.

By default, the server estimates the local time zone when necessary.

This setting is intended for use with legacy Citrix Receivers or ICA clients that do not send detailed time zone information to the server. When used with Citrix Receivers that send detailed time zone information to the server, such as supported versions of Citrix Receiver for Windows, this setting has no effect.

This setting determines the time zone setting of the user session. This can be either the time zone of the user session or the time zone of the user device.

By default, the time zone of the user session is used.

For this setting to take effect, enable the Allow time zone redirection setting in the Group Policy Editor (User Configuration > Administrative Templates > Windows Components > Remote Desktop Services > Remote Desktop Session Host > Device and Resource Redirection).
TWAIN devices policy settings

Jul 24, 2014

The TWAIN devices section contains policy settings related to mapping client TWAIN devices, such as digital cameras or scanners, and optimizing image transfers from server to client.

Note

TWAIN 2.0 is not currently supported.

This setting allows or prevents users from accessing TWAIN devices on the user device from image processing applications hosted on servers. By default, TWAIN device redirection is allowed.

The following policy settings are related:

- TWAIN compression level
- TWAIN device redirection bandwidth limit
- TWAIN device redirection bandwidth limit percent

This setting specifies the level of compression of image transfers from client to server. Use Low for best image quality, Medium for good image quality, or High for low image quality. By default, medium compression is applied.
USB devices policy settings

Jul 24, 2014

The USB devices section contains policy settings for managing file redirection for USB devices.

Client USB device optimization rules can be applied to devices to disable optimization, or to change the optimization mode.

When a user plugs in a USB input device, the host checks if the device is allowed by the USB policy settings. If the device is allowed, the host then checks the **Client USB device optimization rules** for the device. If no rule is specified, then the device is handled as Interactive mode (02). Capture mode (04) is the recommended mode for signature devices. See descriptions below for available modes.

**Good to know**

- For the use of Wacom signature pads and tablets, Citrix recommends that you disable the screen saver. Steps on how to do this are at the end of this section.
- Support for the optimization of Wacom STU signature pads and tablets series of products has been preconfigured in the installation of XenApp and XenDesktop policies.
- Signature devices work across XenApp and XenDesktop and do not require a driver to be used as a signature device. Wacom has additional software that can be installed to customize the device further. See [http://www.wacom.com/](http://www.wacom.com/).
- Drawing tablets. Certain drawing input devices may present as an HID device on PCI/ACPI buses and are not supported. These devices should be attached on a USB host controller on the client to be redirected inside a XenDesktop session.

Policy rules take the format of tag=value expressions separated by whitespace. The following tags are supported:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>The optimization mode is supported for input devices for class=03. Supported modes are: No optimization - value 01. Interactive mode - value 02. Recommended for devices such as pen tablets and 3D Pro mice. Capture mode - value 04. Preferred for devices such as signature pads.</td>
</tr>
<tr>
<td>VID</td>
<td>Vendor ID from the device descriptor.</td>
</tr>
<tr>
<td>PID</td>
<td>Product ID from the device descriptor.</td>
</tr>
<tr>
<td>REL</td>
<td>Release ID from the device descriptor.</td>
</tr>
<tr>
<td>Class</td>
<td>Class from either the device descriptor or an interface descriptor.</td>
</tr>
</tbody>
</table>
SubClass  Subclass from either the device descriptor or an interface descriptor.

Prot  Protocol from either the device descriptor or an interface descriptor.

Examples

Mode=00000004 VID=1230 PID=1230 class=03 # Input device operating in capture mode

Mode=00000002 VID=1230 PID=1230 class=03 # Input device operating in interactive mode (default)

Mode=00000001 VID=1230 PID=1230 class=03 # Input device operating without any optimization

Mode=00000100 VID=1230 PID=1230 # Device setup optimization disabled (default)

Mode=00000200 VID=1230 PID=1230 # Device setup optimization enabled

Disabling the optimization mode using a registry setting

The optimization mode can be disabled system-wide by a registry flag:

HKLM\System\CurrentControlSet\Services\icausb\Parameters

DisableInputOptimization DWORD - set value to 1

A system restart is required for this registry change to take effect.

Disabling the screen saver for Wacom signature pad devices

For the use of Wacom signature pads and tablets, Citrix recommends that you disable the screen saver as follows:

1. Install the Wacom-STU-Driver after redirecting the device.
2. Install Wacom-STU-Display MSI to gain access to the signature pad control panel.
3. Go to Control Panel > Wacom STU Display > STU430 or STU530, and select the tab for your model.
4. Click Change, then select Yes when the UAC security window pops up.
5. Select Disable slideshow, then Apply.

After the setting is set for one signature pad model, it is applied to all models.

This setting allows or prevents redirection of USB devices to and from the user device.

By default, USB devices are not redirected.

This setting specifies redirection rules for USB devices.

By default, no rules are specified.

When a user plugs in a USB device, the host device checks it against each policy rule in turn until a match is found. The first match for any device is considered definitive. If the first match is an Allow rule, the device is remoted to the virtual desktop.

https://docs.citrix.com  © 1999-2017 Citrix Systems, Inc. All rights reserved.
If the first match is a Deny rule, the device is available only to the local desktop. If no match is found, default rules are used.

Policy rules take the format {Allow:|Deny:} followed by a set of tag= value expressions separated by whitespace. The following tags are supported:

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VID</td>
<td>Vendor ID from the device descriptor</td>
</tr>
<tr>
<td>PID</td>
<td>Product ID from the device descriptor</td>
</tr>
<tr>
<td>REL</td>
<td>Release ID from the device descriptor</td>
</tr>
<tr>
<td>Class</td>
<td>Class from either the device descriptor or an interface descriptor</td>
</tr>
<tr>
<td>SubClass</td>
<td>Subclass from either the device descriptor or an interface descriptor</td>
</tr>
<tr>
<td>Prot</td>
<td>Protocol from either the device descriptor or an interface descriptor</td>
</tr>
</tbody>
</table>

When creating new policy rules, remember:

- Rules are case-insensitive.
- Rules may have an optional comment at the end, introduced by #.
- Blank and pure comment lines are ignored.
- Tags must use the matching operator = (for example, VID=1230_).
- Each rule must start on a new line or form part of a semicolon-separated list.
- Refer to the USB class codes available from the USB Implementers Forum, Inc. web site.

Examples of administrator-defined USB policy rules:

- Allow: VID=1230 PID=0007 # ANOther Industries, ANOther Flash Drive
- Deny: Class=08 subclass=05 # Mass Storage
- To create a rule that denies all USB devices, use "DENY:" with no other tags.

This setting allows or prevents plug-and-play devices such as cameras or point-of-sale (POS) devices to be used in a client session.

By default, plug-and-play device redirection is allowed. When set to Allowed, all plug-and-play devices for a specific user or group are redirected. When set to Prohibited, no devices are redirected.
Visual display policy settings

Sep 29, 2015
The Visual Display section contains policy settings for controlling the quality of images sent from virtual desktops to the user device.

Preferred color depth for simple graphics

Allows lowering of the color depth at which simple graphics are set to 16 bits per pixel, potentially improving responsiveness over low bandwidth connections, at the cost of a slight degradation of image quality. This option is supported only when a video codec is not used to compress graphics.

By default, this is set to 24 bits per pixel.

Target frame rate

This setting specifies the maximum number of frames per second sent from the virtual desktop to the user device.

By default, the maximum is 30 frames per second.

Setting a high number of frames per second (for example, 30) improves the user experience, but requires more bandwidth. Decreasing the number of frames per second (for example, 10) maximizes server scalability at the expense of user experience. For user devices with slower CPUs, specify a lower value to improve the user experience.

Use video codec for compression

Allows use of a video codec to compress graphics when video decoding is available on the endpoint. When video decoding is not available on the endpoint, or when you specify Do not use video codec a combination of still image compression and bitmap caching is used.

By default, this is set to Use video codec when available.

Visual quality

This setting specifies the desired visual quality for images displayed on the user device.

By default, this is set to Medium.

To specify the quality of images, choose one of the following options:

- **Low**
- **Medium** - Offers the best performance and bandwidth efficiency in most use cases
- **High** - Recommended if you require visually lossless image quality
- **Build to lossless** - Sends lossy images to the user device during periods of high network activity and lossless images after network activity reduces; this setting improves performance over bandwidth-constrained network connections
- **Always lossless** - In cases where preserving image data is vital (for example, when displaying X-ray images where no loss of quality is acceptable), select Always lossless to ensure lossy data is never sent to the user device.

If the Legacy graphics mode setting is enabled, the Visual quality setting has no effect in the policy.
Moving images policy settings

Sep 29, 2015

The Moving Images section contains settings that enable you to remove or alter compression for dynamic images.

Minimum image quality

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.
This setting specifies the minimum acceptable image quality for Adaptive Display. The less compression used, the higher the quality of images displayed. Choose from Ultra High, Very High, High, Normal, or Low compression.

By default, this is set to Normal.

Moving image compression

This setting specifies whether or not Adaptive Display is enabled. Adaptive Display automatically adjusts the image quality of videos and transitional slides in slide shows based on available bandwidth. With Adaptive Display enabled, users should see smooth-running presentations with no reduction in quality.
By default, Adaptive Display is enabled.

For VDA versions 7.0 through 7.6, this setting applies only when Legacy graphics mode is enabled. For VDA versions 7.6 FP1 and later, this setting applies when Legacy graphics mode is enabled, or when the legacy graphics mode is disabled and a video codec is not used to compress graphics.

When legacy graphics mode is enabled, the session must be restarted before policy changes take effect. Adaptive Display is mutually exclusive with Progressive Display; enabling Adaptive Display disables Progressive Display and vice versa. However, both Progressive Display and Adaptive Display can be disabled at the same time. Progressive Display, as a legacy feature, is not recommended for XenApp or XenDesktop. Setting Progressive threshold Level will disable Adaptive Display.

Progressive compression level

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.
This setting provides a less detailed but faster initial display of images.

By default, no progressive compression is applied.

The more detailed image, defined by the normal lossy compression setting, appears when it becomes available. Use Very High or Ultra High compression for improved viewing of bandwidth-intensive graphics such as photographs.

For progressive compression to be effective, its compression level must be higher than the Lossy compression level setting.
Note: The increased level of compression associated with progressive compression also enhances the interactivity of dynamic images over client connections. The quality of a dynamic image, such as a rotating three-dimensional model, is temporarily decreased until the image stops moving, at which time the normal lossy compression setting is applied.

The following policy settings are related:

- Progressive compression threshold value
- Progressive heavyweight compression

Progressive compression threshold value
Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.
This setting represents the maximum bandwidth in kilobits per second for a connection to which progressive compression is applied. This is applied only to client connections under this bandwidth.

By default, the threshold value is 2147483647 kilobits per second.

The following policy settings are related:
- Progressive compression threshold value
- Progressive heavyweight compression

Target minimum frame rate

This setting specifies the minimum frame rate per second the system attempts to maintain, for dynamic images, under low bandwidth conditions.
By default, this is set to 10fps.

For VDA versions 7.0 through 7.6, this setting applies only when Legacy graphics mode is enabled. For VDA versions 7.6 FP1 and later, this setting applies when the Legacy graphics mode is disabled or enabled.
Still images policy settings

Sep 29, 2015
The Still Images section contains settings that enable you to remove or alter compression for static images.

Extra color compression

This setting enables or disables the use of extra color compression on images delivered over client connections that are limited in bandwidth, improving responsiveness by reducing the quality of displayed images.

By default, extra color compression is disabled.

When enabled, extra color compression is applied only when the client connection bandwidth is below the Extra color compression threshold value. When the client connection bandwidth is above the threshold value or Disabled is selected, extra color compression is not applied.

Extra color compression threshold

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.

This setting represents the maximum bandwidth in kilobits per second for a connection below which extra color compression is applied. If the client connection bandwidth drops below the set value, extra color compression, if enabled, is applied.

By default, the threshold value is 8192 kilobits per second.

Heavyweight compression

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.

This setting enables or disables reducing bandwidth beyond progressive compression without losing image quality by using a more advanced, but more CPU-intensive, graphical algorithm.

By default, heavyweight compression is disabled.

If enabled, heavyweight compression applies to all lossy compression settings. It is supported on Citrix Receiver but has no effect on other plug-ins.

The following policy settings are related:

- Progressive compression level
- Progressive compression threshold value

Lossy compression level

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.

This setting controls the degree of lossy compression used on images delivered over client connections that are limited in bandwidth. In such cases, displaying images without compression can be slow.

By default, medium compression is selected.

For improved responsiveness with bandwidth-intensive images, use high compression. Where preserving image data is vital;
for example, when displaying X-ray images where no loss of quality is acceptable, you may not want to use lossy compression.

Related policy setting: Lossy compression threshold value

Lossy compression threshold value

Note: For the Virtual Delivery Agent 7.x, this policy setting applies only when the Legacy graphics mode policy setting is enabled.
This setting represents the maximum bandwidth in kilobits per second for a connection to which lossy compression is applied.

By default, the threshold value is 2147483647 kilobits per second.

Adding the Lossy compression level setting to a policy and including no specified threshold can improve the display speed of high-detail bitmaps, such as photographs, over a LAN.

Related policy setting: Lossy compression level
WebSockets policy settings

Jul 24, 2014

The WebSockets section contains policy settings for accessing virtual desktops and hosted applications with Citrix Receiver for HTML5. The WebSockets feature increases security and reduces overhead by conducting two-way communication between browser-based applications and servers without opening multiple HTTP connections.

WebSockets connections

This setting allows or prohibits WebSockets connections.

By default, WebSocket connections are prohibited.

WebSockets port number

This setting identifies the port for incoming WebSocket connections.

By default, the value is 8008.

WebSockets trusted origin server list

This setting provides a comma-separated list of trusted origin servers, usually Citrix Receiver for Web, expressed as URLs. Only WebSockets connections originating from one of these addresses is accepted by the server.

By default, the wildcard * is used to trust all Citrix Receiver for Web URLs.

If you choose to type an address in the list, use this syntax:

<protocol>://<Fully qualified domain name of host>[:port]

The protocol should be HTTP or HTTPS. If the port is not specified, port 80 is used for HTTP and port 443 is used for HTTPS.

The wildcard * can be used within the URL, except as part of an IP address (10.105.*.*).
Load management policy settings

Jul 24, 2014

The Load Management section contains policy settings for enabling and configuring load management between servers delivering Windows Server OS machines.

For information about calculating the load evaluator index, see CTX202150.

Concurrent logon tolerance

This setting specifies the maximum number of concurrent logons a server can accept.

By default, this is set to 2.

CPU usage

This setting specifies the level of CPU usage, as a percentage, at which the server reports a full load. When enabled, the default value at which the server reports a full load is 90%.

By default, this setting is disabled and CPU usage is excluded from load calculations.

CPU usage excluded process priority

This setting specifies the priority level at which a process' CPU usage is excluded from the CPU Usage load index.

By default, this is set to Below Normal or Low.

Disk usage

This setting specifies the disk queue length at which the server reports a 75% full load. When enabled, the default value for disk queue length is 8.

By default, this setting is disabled and disk usage is excluded from load calculations.

Maximum number of sessions

This setting specifies the maximum number of sessions a server can host. When enabled, the default setting for maximum number of sessions a server can host is 250.

By default, this setting is enabled.

Memory usage

This setting specifies the level of memory usage, as a percentage, at which the server reports a full load. When enabled, the default value at which the server reports a full load is 90%.

By default, this setting is disabled and memory usage is excluded from load calculations.

Memory usage base load

This setting specifies an approximation of the base operating system's memory usage and defines, in MB, the memory usage below which a server is considered to have zero load.

By default, this is set to 768 MB.
Profile management policy settings

Nov 20, 2014

The Profile Management section contains policy settings for enabling profile management and specifying which groups to include in and exclude from profile management processing.

Other information (such as the names of the equivalent .ini file settings and which version of profile management is required for a policy setting) is available in Profile Management Policies.
Advanced policy settings

Jul 25, 2014

The Advanced settings section contains policy settings relating to the advanced configuration of Profile management.

Disable automatic configuration

This setting enables profile management to examine your environment, for example, to check for the presence of Personal vDisks and configure Group Policy accordingly. Only Profile management policies in the Not Configured state are adjusted, so any customizations made previously are preserved. This feature speeds up deployment and simplifies optimization. No configuration of the feature is necessary, but you can disable automatic configuration when upgrading (to retain settings from earlier versions) or when troubleshooting. Automatic configuration does not work in XenApp or other environments.

By default, automatic configuration is allowed.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, automatic configuration is turned on so Profile management settings might change if your environment changes.

Log off user if a problem is encountered

This setting enables Profile management to log a user off if a problem is encountered; for example, if the user store is unavailable. When enabled, an error message is displayed to the user before they are logged off. When disabled, users are given a temporary profile.

By default, this setting is disabled and users are given a temporary profile if a problem is encountered.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, a temporary profile is provided.

Number of retries when accessing locked files

This setting specifies the number of attempts Profile management makes to access locked files.

By default, this is set to five retries.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, the default value is used.

Process Internet cookie files on logoff

This setting enables Profile management to process index.dat on logoff to remove Internet cookies left in the file system after sustained browsing that can lead to profile bloat. Enabling this setting increases logoff times, so only enable it if you experience this issue.

By default, this setting is disabled and Profile management does not process index.dat on logoff.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, no processing of Index.dat takes place.
Basic policy settings

The Basic settings section contains policy settings relating to the basic configuration of Profile management.

Active write back

This setting enables modified files and folders (but not registry settings) to be synchronized to the user store during a session, before logoff.

By default, synchronization to the user store during a session is disabled.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, it is enabled.

Enable Profile management

This setting enables Profile management to process logons and logoffs.

By default, this setting is disabled to facilitate deployment.

Important: Citrix recommends enabling Profile management only after carrying out all other setup tasks and testing how Citrix user profiles perform in your environment.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, Profile management does not process Windows user profiles in any way.

Excluded groups

This setting specifies which computer local groups and domain groups (local, global, and universal) are excluded from Profile management processing.

When enabled, Profile management does not process members of the specified user groups.

By default, this setting is disabled and members of all user groups are processed.

Specify domain groups in the form <DOMAIN NAME>\<GROUP NAME>.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, members of all user groups are processed.

Offline profile support

This setting enables offline profile support, allowing profiles to synchronize with the user store at the earliest opportunity after a network disconnection.

By default, support for offline profiles is disabled.

This setting is applicable to laptop or mobile users who roam. When a network disconnection occurs, profiles remain intact on the laptop or device even after restarting or hibernating. As mobile users work, their profiles are updated locally and are
synchronized with the user store when the network connection is re-established.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, support for offline profiles is disabled.

Path to user store

This setting specifies the path to the directory (user store) in which user settings, such as registry settings and synchronized files, are saved.

By default, the Windows directory on the home drive is used.

If this setting is disabled, user settings are saved in the Windows subdirectory of the home directory.

The path can be:

- **A relative path.** This must be relative to the home directory, typically configured as the \#homeDirectory\ attribute for a user in Active Directory.
- **An absolute UNC path.** This typically specifies a server share or a DFS namespace.
- **Disabled or unconfigured.** In this case, a value of \#homeDirectory\\Windows is assumed.

Use the following types of variables when configuring this policy setting:

- System environment variables enclosed in percent signs (for example, %ProfVer%). Note that system environment variables generally require additional setup.
- Attributes of the Active Directory user object enclosed in hashes (for example, #sAMAccountName#).
- Profile management variables. For more information, see the Profile management documentation.

You can also use the %username% and %userdomain% user environment variables and create custom attributes to fully define organizational variables such as location or users. Attributes are case-sensitive.

Examples:

- `\server\share\#sAMAccountName#` stores the user settings to the UNC path `\server\share\JohnSmith` (if #sAMAccountName# resolves to JohnSmith for the current user)
- `\server\profiles\%USERNAME%.%USERDOMAIN%\CTX_PROFILEVER!!CTX_OSBITNESS!` might expand to `\server\profiles\JohnSmith.DOMAINCONTROLLER1\v2x64`

Important: Whichever attributes or variables you use, check that this setting expands to the folder one level higher than the folder containing NTUSER.DAT. For example, if this file is contained in `\server\profiles\JohnSmith.Finance\v2x64\UPM_Profile`, set the path to the user store as `\server\profiles\JohnSmith.Finance\v2x64`, not the \UPM_Profile subfolder.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, the Windows directory on the home drive is used.

Process logons of local administrators

This setting specifies whether or not logons of members of the BUILTIN\Administrators group are processed. This allows domain users with local administrator rights, typically users with assigned virtual desktops, to bypass processing, log on, and troubleshoot a desktop experiencing problems with Profile management.

If this setting is disabled or not configured on server operating systems, Profile management assumes that logons by domain users, but not local administrators, must be processed. On desktop operating systems, local administrator logons
are processed.

By default this setting is disabled, and local administrator logons are not processed.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, local administrator logons are not processed.

Processed groups

This setting specifies which computer local groups and domain groups (local, global, and universal) are included in Profile management processing.

When enabled, Profile management processes only members of the specified user groups.

By default, this setting is disabled and members of all user groups are processed.

Specify domain groups in the form `<DOMAIN NAME>\<GROUP NAME>`.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, members of all user groups are processed.
Cross-platform policy settings

Jul 25, 2014

The Cross-Platform section contains policy settings relating to configuring the Profile management cross-platform settings feature.

Cross-platform settings user groups

This setting specifies the Windows user groups whose profiles are processed when the cross-platform settings feature is enabled.

By default, this setting is disabled and all user groups specified in the Processed Group policy setting are processed.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, all user groups are processed.

Enable cross-platform settings

This setting enables or disables the cross-platforms settings feature, that allows you to migrate users' profiles and roam them when a user connects to the same application running on multiple operating systems.

By default the cross-platform settings feature is disabled.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, no cross-platform settings are applied.

Path to cross-platform definitions

This setting specifies the network location, as a UNC path, of the definition files copied from the download package.

Note: Users must have read access, and administrators write access, to this location and it must be either a Server Message Block (SMB) or Common Internet File System (CIFS) file share.

By default, no path is specified.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, no cross-platform settings are applied.

Path to cross-platform settings store

This setting specifies the path to the cross-settings store, the folder in which users' cross-platform settings are saved. This path can be either a UNC path or a path relative to the home directory.

Note: Users must have write access to the cross-settings store.

By default, this setting is disabled and the path Windows\PM_CP is used.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, the default value is used.

Source for creating cross-platform settings
This setting specifies a platform as the base platform if this setting is enabled for that platform's OU. Data from the base platform's profiles is migrated to the cross-platform settings store.

Each platform's own set of profiles are stored in a separate OU. This means you must decide which platform's profile data to use to seed the cross-platform settings store. This is referred to as the base platform.

When enabled, Profile management migrates the data from the single-platform profile to the store if the cross-platform settings store contains a definition file with no data, or if the cached data in a single-platform profile is newer than the definition's data in the store.

Important: If this setting is enabled in multiple OUs, or multiple user or machine objects, the platform that the first user logs on to becomes the base profile.
By default, this setting is disabled and Profile management does not migrate the data from the single-platform profile to the store.
File system policy settings

Jul 25, 2014
The File System section contains policy settings for configuring which files and directories in a user's profile are synchronized between the system where the profile is installed and the user store.
The Exclusions section contains policy settings for configuring which files and directories in a user's profile are excluded from the synchronization process.

Exclusion list - directories

This setting specifies a list of folders in the user profile that are ignored during synchronization.

Specify folder names as paths relative to the user profile (%USERPROFILE%). By default, this setting is disabled and all folders in the user profile are synchronized.

Example: Desktop ignores the Desktop folder in the user profile

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, all folders in the user profile are synchronized.

Exclusion list - files

This setting specifies a list of files in the user profile that are ignored during synchronization.

Specify file names as paths relative to the user profile (%USERPROFILE%). Note that wildcards are allowed and are applied recursively.

Example: Desktop\Desktop.ini ignores the file Desktop.ini in the Desktop folder

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, all files in the user profile are synchronized.
Synchronization policy settings

Jul 25, 2014

The Synchronization section contains policy settings for specifying which files and folders in a user's profile are synchronized between the system on which the profile is installed and the user store.

Directories to synchronize

This setting specifies any files you want Profile management to include in the synchronization process that are located in excluded folders. By default, Profile management synchronizes everything in the user profile. It is not necessary to include subfolders of the user profile by adding them to this list. For more information, see Include and exclude items.

Paths on this list must be relative to the user profile.

Example: Desktop\exclude\include ensures that the subfolder called include is synchronized even if the folder called Desktop\exclude is not

By default, this setting is disabled and no folders are specified.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, only non-excluded folders in the user profile are synchronized.

Files to synchronize

This setting specifies any files you want Profile management to include in the synchronization process that are located in excluded folders. By default, Profile management synchronizes everything in the user profile. It is not necessary to include files in the user profile by adding them to this list. For more information, see Include and exclude items.

Paths on this list must be relative to the user profile. Relative paths are interpreted as being relative to the user profile. Wildcards can be used but are allowed only for file names. Wildcards cannot be nested and are applied recursively.

Examples:
- AppData\Local\Microsoft\Office\Access.qat specifies a file below a folder that is excluded in the default configuration
- AppData\Local\MyApp\*.cfg specifies all files with the extension .cfg in the profile folder AppData\Local\MyApp and its subfolders

By default, this setting is disabled and no files are specified.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, only non-excluded files in the user profile are synchronized.

Folders to mirror

This setting specifies which folders relative to a user's profile root folder to mirror. Configuring this policy setting can help solve issues involving any transactional folder (also known as a referential folder), that is a folder containing interdependent files, where one file references others.

Mirroring folders allows Profile management to process a transactional folder and its contents as a single entity, avoiding profile bloat. Be aware that, in these situations the "last write wins" so files in mirrored folders that have been modified in more than one session will be overwritten by the last update, resulting in loss of profile changes.
For example, you can mirror the Internet Explorer cookies folder so that Index.dat is synchronized with the cookies that it indexes.

If a user has two Internet Explorer sessions, each on a different server, and they visit different sites in each session, cookies from each site are added to the appropriate server. When the user logs off from the first session (or in the middle of a session, if the active write back feature is configured), the cookies from the second session should replace those from the first session. However, instead they are merged, and the references to the cookies in Index.dat become out of date. Further browsing in new sessions results in repeated merging and a bloated cookie folder.

Mirroring the cookie folder solves the issue by overwriting the cookies with those from the last session each time the user logs off so Index.dat stays up to date.

By default, this setting is disabled and no folders are mirrored.

If this setting is not configured here, the value from the .ini file is used.

If this policy is not configured here or in the .ini file, no folders are mirrored.
Folder redirection policy settings

Jul 25, 2014
The Folder Redirection section contains policy settings that specify whether to redirect folders that commonly appear in profiles to a shared network location.

Grant administrator access
This setting enables an administrator to access the contents of a user's redirected folders.
By default, this setting is disabled and users are granted exclusive access to the contents of their redirected folders.

Include domain name
This setting enables the inclusion of the %userdomain% environment variable as part of the UNC path specified for redirected folders.
By default, this setting is disabled and the %userdomain% environment variable is not included as part of the UNC path specified for redirected folders.
AppData(Roaming) policy settings

Jul 25, 2014
The AppData(Roaming) section contains policy settings for specifying whether to redirect the contents the AppData(Roaming) folder to a shared network location.

AppData(Roaming) path
This setting specifies the network location to which the contents of the AppData(Roaming) folder are redirected.
By default, this setting is disabled and no location is specified.
If this setting is not configured here, Profile management does not redirect the specified folder.

Redirection settings for AppData(Roaming)
This setting specifies how to redirect the contents of the AppData(Roaming) folder.
By default, contents are redirected to a UNC path.
If this setting is not configured here, Profile management does not redirect the specified folder.
Contacts policy settings

Jul 25, 2014
The Contacts section contains policy settings for specifying whether to redirect the contents the Contacts folder to a shared network location.

Contacts path
This setting specifies the network location to which the contents of the Contacts folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.

Redirection settings for Contacts
This setting specifies how to redirect the contents of the Contacts folder.

By default, contents are redirected to a UNC path.

If this setting is not configured here, Profile management does not redirect the specified folder.
Desktop policy settings

Jul 25, 2014
The Desktop section contains policy settings for specifying whether to redirect the contents the Desktop folder to a shared network location.

Desktop path
This setting specifies the network location to which the contents of the Desktop folder are redirected.
By default, this setting is disabled and no location is specified.
If this setting is not configured here, Profile management does not redirect the specified folder.

Redirection settings for Desktop
This setting specifies how to redirect the contents of the Desktop folder.
By default, contents are redirected to a UNC path.
If this setting is not configured here, Profile management does not redirect the specified folder.
Documents policy settings

Mar 25, 2015
The Documents section contains policy settings for specifying whether to redirect the contents the Documents folder to a shared network location.

Documents path

This setting specifies the network location to which files in the Documents folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.

The Documents path setting must be enabled not only to redirect files to the Documents folder, but also to redirect files to the Music, Pictures, and Videos folders.

Redirection settings for Documents

This setting specifies how to redirect the contents of the Documents folder.

By default, contents are redirected to a UNC path.

To control how to redirect the contents of the Documents folder, choose one of the following options:

- Redirect to the following UNC path. Redirects content to the UNC path specified in the Documents path policy setting.
- Redirect to the users home directory. Redirects content to the users home directory, typically configured as the #homeDirectory# attribute for a user in Active Directory.

If this setting is not configured here, Profile management does not redirect the specified folder.
Downloads policy settings

Jul 25, 2014

The Downloads section contains policy settings that specify whether to redirect the contents the Downloads folder to a shared network location.

Downloads path

This setting specifies the network location to which files in the Downloads folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.

Redirection settings for Downloads

This setting specifies how to redirect the contents of the Downloads folder.

By default, contents are redirected to a UNC path.

If this setting is not configured here, Profile management does not redirect the specified folder.
Favorites policy settings

Jul 25, 2014

The Favorites section contains policy settings that specify whether to redirect the contents the Favorites folder to a shared network location.

Favorites path

This setting specifies the network location to which the contents of the Favorites folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.

Redirection settings for Favorites

This setting specifies how to redirect the contents of the Favorites folder.

By default, contents are redirected to a UNC path.

If this setting is not configured here, Profile management does not redirect the specified folder.
Links policy settings

Jul 25, 2014
The Links section contains policy settings that specify whether to redirect the contents the Links folder to a shared network location.

Links path
This setting specifies the network location to which the contents of the Links folder are redirected.

By default, this setting is disabled and no location is specified.
If this setting is not configured here, Profile management does not redirect the specified folder.

Redirection settings for Links
This setting specifies how to redirect the contents of the Links folder.

By default, contents are redirected to a UNC path.
If this setting is not configured here, Profile management does not redirect the specified folder.
Music policy settings

Mar 25, 2015
The Music section contains policy settings that specify whether to redirect the contents the Music folder to a shared network location.

Music path
This setting specifies the network location to which the contents of the Music folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.

Redirection settings for Music
This setting specifies how to redirect the contents of the Music folder.

By default, contents are redirected to a UNC path.

To control how to redirect the contents of the Music folder, choose one of the following options:
- Redirect to the following UNC path. Redirects content to the UNC path specified in the Music path policy setting.
- Redirect relative to Documents folder. Redirects content to a folder relative to the Documents folder.

To redirect content to a folder relative to the Documents folder, the Documents path setting must be enabled.

If this setting is not configured here, Profile management does not redirect the specified folder.
Pictures policy settings

Mar 25, 2015

The Pictures section contains policy settings that specify whether to redirect the contents the Pictures folder to a shared network location.

Pictures path

This setting specifies the network location to which the contents of the Pictures folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.

Redirection settings for Pictures

This setting specifies how to redirect the contents of the Pictures folder.

By default, contents are redirected to a UNC path.

To control how to redirect the contents of the Pictures folder, choose one of the following options:

- Redirect to the following UNC path. Redirects content to the UNC path specified in the Pictures path policy setting.
- Redirect relative to Documents folder. Redirects content to a folder relative to the Documents folder.

To redirect content to a folder relative to the Documents folder, the Documents path setting must be enabled.

If this setting is not configured here, Profile management does not redirect the specified folder.
Saved Games policy settings

Jul 25, 2014
The Saved Games section contains policy settings that specify whether to redirect the contents the Saved Games folder to a shared network location.

Redirection settings for Saved Games

This setting specifies how to redirect the contents of the Saved Games folder.

By default, contents are redirected to a UNC path.

If this setting is not configured here, Profile management does not redirect the specified folder.

Saved Games path

This setting specifies the network location to which the contents of the Saved Games folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.
Searches policy settings

Jul 25, 2014
The Searches section contains policy settings that specify whether to redirect the contents the Searches folder to a shared network location.

Redirection settings for Searches
This setting specifies how to redirect the contents of the Searches folder.
By default, contents are redirected to a UNC path.
If this setting is not configured here, Profile management does not redirect the specified folder.

Searches path
This setting specifies the network location to which the contents of the Searches folder are redirected.
By default, this setting is disabled and no location is specified.
If this setting is not configured here, Profile management does not redirect the specified folder.
Start menu policy settings

Jul 25, 2014

The Start Menu section contains policy settings that specify whether to redirect the contents of the Start Menu folder to a shared network location.

Redirection settings for Start Menu

This setting specifies how to redirect the contents of the Start Menu folder.

By default, contents are redirected to a UNC path.

If this setting is not configured here, Profile management does not redirect the specified folder.

Start Menu path

This setting specifies the network location to which the contents of the Start Menu folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.
Video policy settings

Mar 25, 2015
The Video section contains policy settings that specify whether to redirect the contents the Video folder to a shared network location.

Redirection settings for Video

This setting specifies how to redirect the contents of the Video folder.

By default, contents are redirected to a UNC path.

To control how to redirect the contents of the Video folder, choose one of the following options:
- Redirect to the following UNC path. Redirects content to the UNC path specified in the Video path policy setting.
- Redirect relative to Documents folder. Redirects content to a folder relative to the Documents folder.

To redirect content to a folder relative to the Documents folder, the Documents path setting must be enabled.

If this setting is not configured here, Profile management does not redirect the specified folder.

Video path

This setting specifies the network location to which the contents of the Video folder are redirected.

By default, this setting is disabled and no location is specified.

If this setting is not configured here, Profile management does not redirect the specified folder.
Log policy settings

Jul 25, 2014
The Log section contains policy settings that configure Profile management logging.

Active Directory actions
This setting enables or disables verbose logging of actions performed in Active Directory.
By default, this setting is disabled.
When enabling this setting, make sure the Enable logging setting is also enabled.
If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, errors and general information are logged.

Common information
This setting enables or disables verbose logging of common information.
By default, this setting is disabled.
When enabling this setting, make sure the Enable logging setting is also enabled.
If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, errors and general information are logged.

Common warnings
This setting enables or disables verbose logging of common warnings.
By default, this setting is disabled.
When enabling this setting, make sure the Enable logging setting is also enabled.
If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, errors and general information are logged.

Enable logging
This setting enables or disables Profile management logging in debug (verbose logging) mode. In debug mode, extensive status information is logged in the log files located in "%SystemRoot%\System32\Logfiles\UserProfileManager".
By default, this setting is disabled and only errors are logged.
Citrix recommends enabling this setting only if you are troubleshooting Profile management.
If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, only errors are logged.
File system actions
This setting enables or disables verbose logging of actions performed in the file system.
By default, this setting is disabled.
When enabling this setting, make sure the Enable logging setting is also enabled.
If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, errors and general information are logged.

File system notifications
This setting enables or disables verbose logging of file system notifications.
By default, this setting is disabled.
When enabling this setting, make sure the Enable logging setting is also enabled.
If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, errors and general information are logged.

Logoff
This setting enables or disables verbose logging of user logoffs.
By default, this setting is disabled.
When enabling this setting, make sure the Enable logging setting is also enabled.
If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, errors and general information are logged.

Logon
This setting enables or disables verbose logging of user logons.
By default, this setting is disabled.
When enabling this setting, make sure the Enable logging setting is also enabled.
If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, errors and general information are logged.

Maximum size of the log file
This setting specifies the maximum permitted size for the Profile management log file, in bytes.
By default, this setting is set to 1048576 bytes (1MB).
Citrix recommends increasing the size of this file to 5 MB or more, if you have sufficient disk space. If the log file grows beyond the maximum size, an existing backup of the file (.bak) is deleted, the log file is renamed to .bak, and a new log file is created.
The log file is created in %SystemRoot%\System32\Logfiles\UserProfileManager.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, the default value is used.

Path to log file

This setting specifies an alternative path to save the Profile management log file.

By default, this setting is disabled and log files are saved in the default location:
%SystemRoot%\System32\Logfiles\UserProfileManager.

The path can point to a local drive or a remote network-based drive (UNC path). Remote paths can be useful in large distributed environments but they may create significant network traffic, which may be inappropriate for log files. For provisioned, virtual machines with a persistent hard drive, set a local path to that drive. This ensures log files are preserved when the machine restarts. For virtual machines without a persistent hard drive, setting a UNC path allows you to retain the log files, but the system account for the machines must have write access to the UNC share. Use a local path for any laptops managed by the offline profiles feature.

If a UNC path is used for log files, Citrix recommends that an appropriate access control list is applied to the log file folder to ensure that only authorized user or computer accounts can access the stored files.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, the default location %SystemRoot%\System32\Logfiles\UserProfileManager is used.

Personalized user information

This setting enables or disables verbose logging of personalized user information.

By default, this setting is disabled.

When enabling this setting, make sure the Enable logging setting is also enabled.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, errors and general information are logged.

Policy values at logon and logoff

This setting enables or disables verbose logging of policy values when a user logs on and off.

By default, this setting is disabled.

When enabling this setting, make sure the Enable logging setting is also enabled.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, errors and general information are logged.

Registry actions
This setting enables or disables verbose logging of actions performed in the registry.

By default, this setting is disabled.

When enabling this setting, make sure the Enable logging setting is also enabled.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, errors and general information are logged.

Registry differences at logoff

This setting enables or disables verbose logging of any differences in the registry when a user logs off.

By default, this setting is disabled.

When enabling this setting, make sure the Enable logging setting is also enabled.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, errors and general information are logged.
Profile handling policy settings

Jul 25, 2014
The Profile handling section contains policy settings that specify how Profile management handles user profiles.

Delay before deleting cached profiles
This setting specifies an optional extension to the delay, in minutes, before Profile management deletes locally cached profiles at logoff.

A value of 0 deletes the profiles immediately at the end of the logoff process. Profile management checks for logoffs every minute, so a value of 60 ensures that profiles are deleted between one and two minutes after users log off (depending on when the last check occurred). Extending the delay is useful if you know that a process keeps files or the user registry hive open during logoff. With large profiles, this can also speed up logoff.

By default, this is set to 0 and Profile management deletes locally cached profiles immediately.

When enabling this setting, ensure the Delete locally cached profiles on logoff is also enabled.

If this setting is not configured here, the value from the .ini file is used.

Delete locally cached profiles on logoff
This setting specifies whether locally cached profiles are deleted after a user logs off.

When this setting is enabled, a user's local profile cache is deleted after they have logged off. Citrix recommends enabling this setting for terminal servers.

By default, this setting is disabled and a users local profile cache is retained after they log off.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, profiles are deleted immediately.

Local profile conflict handling
This setting configures how Profile management behaves if a user profile exists both in the user store and as a local Windows user profile (not a Citrix user profile).

By default, Profile management uses the local Windows profile, but does not change it in any way.

To control how Profile management behaves, choose one of the following options:
- Use local profile. Profile management uses the local profile, but does not change it in any way.
- Delete local profile. Profile management deletes the local Windows user profile, and then imports the Citrix user profile from the user store.
- Rename local profile. Profile management renames the local Windows user profile (for backup purposes) and then imports the Citrix user profile from the user store.

If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, existing local profiles are used.

Migration of existing profiles

This setting specifies the types of profile migrated to the user store during logon if a user has no current profile in the user store.

Profile management can migrate existing profiles "on the fly" during logon if a user has no profile in the user store. After this, the user store profile is used by Profile management in both the current session and any other session configured with the path to the same user store.

By default, both local and roaming profiles are migrated to the user store during logon.

To specifies the types of profile migrated to the user store during logon, choose one of the following options:

- Local and roaming profiles
- Local
- Roaming
- None (Disabled)

If you select None, the system uses the existing Windows mechanism to create new profiles, as if in a environment where Profile management is not installed.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, existing local and roaming profiles are migrated.

Path to the template profile

This setting specifies the path to the profile you want Profile management to use as a template to create new user profiles.

The specified path must be the full path to the folder containing the NTUSER.DAT registry file and any other folders and files required for the template profile.

Note: Do not include NTUSER.DAT in the path. For example, with the file \myservername\myprofiles\template\ntuser.dat, set the location as \myservername\myprofiles\template.

Use absolute paths, which can be either UNC paths or paths on the local machine. Use the latter, for example, to specify a template profile permanently on a Citrix Provisioning Services image. Relative paths are not supported.

Note: This setting does not support expansion of Active Directory attributes, system environment variables, or the %USERNAME% and %USERDOMAIN% variables.

By default, this setting is disabled and new user profiles are created from the default user profile on the device where a user first logs on.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, no template is used.

Template profile overrides local profile

This setting enables the template profile to override the local profile when creating new user profiles.

If a user has no Citrix user profile, but a local Windows user profile exists, by default the local profile is used (and migrated to the user store, if this is not disabled). Enabling this policy setting allows the template profile to override the local profile used
when creating new user profiles.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, no template is used.

Template profile overrides roaming profile

This setting enables the template profile to override a roaming profile when creating new user profiles.

If a user has no Citrix user profile, but a roaming Windows user profile exists, by default the roaming profile is used (and migrated to the user store, if this is not disabled). Enabling this policy setting allows the template profile to override the roaming profile used when creating new user profiles.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, no template is used.

Template profile used as a Citrix mandatory profile for all logons

This setting enables Profile management to use the template profile as the default profile for creating all new user profiles.

By default, this setting is disabled and new user profiles are created from the default user profile on the device where a user first logs on.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, no template is used.
Registry policy settings

Jul 25, 2014

The Registry section contains policy settings that specify which registry keys are included or excluded from Profile management processing.

Exclusion list

This setting specifies the list of registry keys in the HKCU hive excluded from Profile management processing when a user logs off.

When enabled, keys specified in this list are excluded from processing when a user logs off.

By default, this setting is disabled, and all registry keys in the HKCU hive are processed when a user logs off.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, no registry keys are excluded from processing.

Inclusion list

This setting specifies the list of registry keys in the HKCU hive included in Profile management processing when a user logs off.

When enabled, only keys specified in this list are processed when a user logs off.

By default, this setting is disabled, and all registry keys in the HKCU hive are processed when a user logs off.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, all of HKCU is processed.
Streamed user profiles policy settings

Jul 25, 2014

The Streamed user profiles section contains policy settings that specify how Profile management processes streamed user profiles.

Always cache

This setting specifies whether or not Profile management caches streamed files as soon as possible after a user logs on. Caching files after a user logs on saves network bandwidth, enhancing the user experience.

Use this setting with the Profile streaming setting.

By default, this setting is disabled and streamed files are not cached as soon as possible after a user logs on.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, it is disabled.

Always cache size

This setting specifies a lower limit, in megabytes, on the size of files that are streamed. Profile management caches any files this size or larger as soon as possible after a user logs on.

By default, this is set to 0 (zero) and the cache entire profile feature is used. When the cache entire profile feature is enabled, Profile management fetches all profile contents in the user store, after a user logs on, as a background task.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, it is disabled.

Profile streaming

This setting enables and disables the Citrix streamed user profiles feature. When enabled, files and folders contained in a profile are fetched from the user store to the local computer only when they are accessed by users after they have logged on. Registry entries and files in the pending area are fetched immediately.

By default, profile streaming is disabled.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, it is disabled.

Streamed user profile groups

This setting specifies which user profiles within an OU are streamed, based on Windows user groups.

When enabled, only user profiles within the specified user groups are streamed. All other user profiles are processed normally.

By default, this setting is disabled and all user profiles within an OU are processed normally.

If this setting is not configured here, the value from the .ini file is used.
If this setting is not configured here or in the .ini file, all user profiles are processed.

Timeout for pending area lock files

This setting specifies the number of days after which users' files are written back to the user store from the pending area, in the event that the user store remains locked when a server becomes unresponsive. This prevents bloat in the pending area and ensures the user store always contains the most up-to-date files.

By default, this is set to 1 (one) day.

If this setting is not configured here, the value from the .ini file is used.

If this setting is not configured here or in the .ini file, the default value is used.
Receiver policy settings

Note: Unless otherwise noted, "Receiver" refers to Citrix Receiver.

The Receiver section contains policy settings that specify a list of StoreFront addresses to push to Citrix Receiver for Windows running on the virtual desktop.

StoreFront accounts list

This setting specifies a list of StoreFront stores administrators can choose to push to Citrix Receiver for Windows running on the virtual desktop. When creating a Delivery Group, administrators can select which stores to push to Citrix Receiver for Windows running on virtual desktops within that group.

By default, no stores are specified.

For each store, specify the following information as a semicolon-delimited entry:

- Store name. The name displayed to users of the store.
- Store URL. The URL for the store.
- Store enabled state. Whether or not the store is available to users. This is either On or Off.
- Store description. The description displayed to users of the store.

For example: Sales Store;https://sales.mycompany.com/Citrix/Store/discovery;On;Store for Sales staff
Virtual Delivery Agent policy settings

Jul 25, 2014

The Virtual Delivery Agent (VDA) section contains policy settings that control communication between the VDA and controllers for a site.

Important: The VDA requires information provided by these settings to register with a Delivery Controller, if you are not using the auto-update feature. Because this information is required for registration, you must configure the following settings using the Group Policy Editor, unless you provide this information during the VDA installation:

- Controller registration IPv6 netmask
- Controller registration port
- Controller SIDs
- Controllers
- Only use IPv6 controller registration
- Site GUID

Controller registration IPv6 netmask

This policy setting allows administrators to restrict the VDA to only a preferred subnet (rather than a global IP, if one is registered). This setting specifies the IPv6 address and network where the VDA will register. The VDA will register only on the first address that matches the specified netmask. This setting is valid only if the Only use IPv6 controller registration policy setting is enabled.

By default this setting is blank.

Controller registration port

Use this setting only if the Enable auto update of controllers setting is disabled.

This setting specifies the TCP/IP port number the VDA uses to register with a Controller when using registry-based registration.

By default, the port number is set to 80.

Controller SIDs

Use this setting only if the Enable auto update of controllers setting is disabled.

This setting specifies a space-separated list of controller Security Identifiers (SIDs) the VDA uses to register with a Controller when using registry-based registration. This is an optional setting which may be used with the Controllers setting to restrict the list of Controllers used for registration.

By default, this setting is blank.

Controllers

Use this setting only if the Enable auto update of controllers setting is disabled.

This setting specifies a space-separated list of controller Fully Qualified Domain Names (FQDNs) the VDA uses to register with a Controller when using registry-based registration. This is an optional setting that may be used with the Controller SIDs setting.
By default, this setting is blank.

Enable auto update of controllers

This setting enables the VDA to register with a Controller automatically after installation.

After the VDA registers, the Controller with which it registered sends a list of the current controller FQDNs and SIDs to the VDA. The VDA writes this list to persistent storage. Each Controller also checks the Site database every 90 minutes for Controller information; if a Controller has been added or removed since the last check, or if a policy change has occurred, the Controller sends updated lists to its registered VDAs. The VDA will accept connections from all the Controllers in the most recent list it received.

By default, this setting is enabled.

Only use IPv6 controller registration

This setting controls which form of address the VDA uses to register with the Controller:
- When enabled, the VDA registers with the Controller using the machine's IPv6 address. When the VDA communicates with the Controller, it uses the following address order: global IP address, Unique Local Address (ULA), link-local address (if no other IPv6 addresses are available).
- When disabled, the VDA registers and communicates with the Controller using the machine's IPv4 address.

By default, this setting is disabled.

Site GUID

Use this setting only if the Enable auto update of controllers setting is disabled.

This setting specifies the Globally Unique Identifier (GUID) of the site the VDA uses to register with a Controller when using Active Directory-based registration.

By default, this setting is blank.
HDX 3D Pro policy settings

Jul 25, 2014
The HDX 3D Pro section contains policy settings for enabling and configuring the image quality configuration tool for users. The tool enables users to optimize use of available bandwidth by adjusting in real time the balance between image quality and responsiveness.

Enable lossless
This setting specifies whether or not users can enable and disable lossless compression using the image quality configuration tool. By default, users are not given the option to enable lossless compression.

When a user enables lossless compression, the image quality is automatically set to the maximum value available in the image configuration tool. By default, either GPU or CPU-based compression can be used, according to the capabilities of the user device and the host computer.

HDX 3D Pro quality settings
This setting specifies the minimum and maximum values that define the range of image quality adjustment available to users in the image quality configuration tool.

Specify image quality values of between 0 and 100, inclusive. The maximum value must be greater than or equal to the minimum value.
Virtual IP policy settings

Aug 06, 2014
The Virtual IP section contains policy settings that control whether sessions have their own virtual loopback address.

Virtual IP loopback support

When this setting is enabled, each session has its own virtual loopback address. When disabled, sessions do not have individual loopback addresses.

By default, this setting is disabled.

Virtual IP virtual loopback programs list

This setting specifies the application executables that can use virtual loopback addresses. When adding programs to the list, specify only the executable name; you do not need to specify the entire path.

By default, no executables are specified.
Configure COM Port and LPT Port Redirection settings using the registry

Jul 24, 2014
Policy settings for COM Port and LPT Port Redirection are located under HKLM\Software\Citrix\GroupPolicy\Defaults\Deprecated on the VDA image or machine.

To enable COM port and LPT port redirection, add new registry keys of type REG_DWORD, as follows:
Caution: Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

<table>
<thead>
<tr>
<th>Registry key</th>
<th>Description</th>
<th>Permitted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AllowComPortRedirection</td>
<td>Allow or prohibit COM port redirection</td>
<td>1 (Allow) or 0 (Prohibit)</td>
</tr>
<tr>
<td>LimitComBw</td>
<td>Bandwidth limit for COM port redirection channel</td>
<td>Numeric value</td>
</tr>
<tr>
<td>LimitComBWPercent</td>
<td>Bandwidth limit for COM port redirection channel as a percentage of total session bandwidth</td>
<td>Numeric value between 0 and 100</td>
</tr>
<tr>
<td>AutoConnectClientComPorts</td>
<td>Automatically connect COM ports from the user device</td>
<td>1 (Allow) or 0 (Prohibit)</td>
</tr>
<tr>
<td>AllowLptPortRedirection</td>
<td>Allow or prohibit LPT port redirection</td>
<td>1 (Allow) or 0 (Prohibit)</td>
</tr>
<tr>
<td>LimitLptBw</td>
<td>Bandwidth limit for LPT port redirection channel</td>
<td>Numeric value</td>
</tr>
<tr>
<td>LimitLptBWPercent</td>
<td>Bandwidth limit for LPT port redirection channel as a percentage of total session bandwidth</td>
<td>Numeric value between 0 and 100</td>
</tr>
<tr>
<td>AutoConnectClientLptPorts</td>
<td>Automatically connect LPT ports from the user device</td>
<td>1 (Allow) or 0 (Prohibit)</td>
</tr>
</tbody>
</table>

After configuring these settings, modify your machine catalogs to use the new master image or updated physical machine. Desktops are updated with the new settings the next time users log off.
Connector for Configuration Manager 2012 policy settings

Jun 18, 2014
The Connector for Configuration Manager 2012 section contains policy settings for configuring the Citrix Connector 7.5 agent.

Important: Warning, logoff, and reboot message policies apply only to deployments to Server OS machine catalogs that are managed manually or by Provisioning Services. For those machine catalogs, the Connector service alerts users when there are pending application installs or software updates.

For catalogs managed by MCS, use Studio to notify users. For manually managed Desktop OS catalogs, use Configuration Manager to notify users. For Desktop OS catalogs managed by Provisioning Services, use Provisioning Services to notify users.

Advance warning frequency interval
This setting defines the interval between appearances of the advance warning message to users.

Intervals are set using the format ddd.hh:mm:ss, where:

- ddd is days, an optional parameter, with a range of 0 to 999.
- hh is hours with a range of 0 to 23.
- mm is minutes with a range of 0 to 59.
- ss is seconds with a range of 0 to 59.

By default, the interval setting is 1 hour (01:00:00).

Advance warning message box body text
This setting contains the editable text of the message to users notifying them of upcoming software updates or maintenance that requires them to log off.

By default, the message is: {TIMESTAMP} Please save your work. The server will go offline for maintenance in {TIMELEFT}.

Advance warning message box title
This setting contains the editable text of the title bar of the advance warning message to users.

By default, the title is: Upcoming Maintenance

Advance warning time period
This setting defines how far before maintenance the advance warning message first appears.

The time is set using the format ddd.hh:mm:ss, where:

- ddd is days, an optional parameter, with a range of 0 to 999.
- hh is hours with a range of 0 to 23.
- mm is minutes with a range of 0 to 59.
- ss is seconds with a range of 0 to 59.

By default, the setting is 16 hours (16:00:00), indicating that the first advance warning message appears approximately 16
hours before maintenance.

Final force logoff message box body text
This setting contains the editable text of the message alerting users that a forced logoff has begun.

By default, the message is: The server is currently going offline for maintenance

Final force logoff message box title
This setting contains the editable text of the title bar of the final force logoff message.

By default, the title is: Notification From IT Staff

Force logoff grace period
This setting defines the period of time between notifying users to log off and the implementation of the forced logoff to process the pending maintenance.

The time is set using the format ddd:hh:mm:ss, where:
- ddd is days, an optional parameter, with a range of 0 to 999.
- hh is hours with a range of 0 to 23.
- mm is minutes with a range of 0 to 59.
- ss is seconds with a range of 0 to 59.

By default, the force logoff grace period setting is 5 minutes (00:05:00).

Force logoff message box body text
This setting contains the editable text of the message telling users to save their work and log off prior to the start of a forced logoff.

By default, the message contains the following: {TIMESTAMP} Please save your work and log off. The server will go offline for maintenance in {TIMELEFT}

Force logoff message box title
This setting contains the editable text of the title bar of the force logoff message.

By default, the title is: Notification From IT Staff

Image-managed mode

The Connector agent automatically detects if it is running on a machine clone managed by Provisioning Services or MCS. The agent blocks Configuration Manager updates on image-managed clones and automatically installs the updates on the master image of the catalog.

After a master image is updated, use Studio to orchestrate the reboot of MCS catalog clones. The Connector Agent automatically orchestrates the reboot of PVS catalog clones during Configuration Manager maintenance windows. To override this behavior so that software is installed on catalog clones by Configuration Manager, change Image-managed mode to Disabled.

Reboot message box body text
This setting contains the editable text of the message notifying users when the server is about to be restarted.

By default, the message is: The server is currently going offline for maintenance

Regular time interval at which the agent task is to run

This setting determines how frequently the Citrix Connector agent task runs.

The time is set using the format ddd:hh:mm:ss, where:
- ddd is days, an optional parameter, with a range of 0 to 999.
- hh is hours with a range of 0 to 23.
- mm is minutes with a range of 0 to 59.
- ss is seconds with a range of 0 to 59.

By default, the regular time interval setting is 5 minutes (00:05:00).
Manage

Feb 24, 2016
Managing a XenApp or XenDesktop Site covers a variety of items and tasks.

Licensing

A valid connection to the Citrix License Server is required when you create a Site. Later, you can complete several licensing tasks from Studio, including adding licenses, changing license types or models, and managing license administrators. You can also access the License Administration Console from Studio.

Zones

In a geographically disperse deployment, you can use zones to keep applications and desktops closer to end users, which can improve performance. When you install and configure a Site, all Controllers, Machine Catalogs, and host connections are in one primary zone. Later, you can use Studio to create satellite zones containing those items. After your Site has more than one zone, you will be able to indicate in which zone any newly-created Machine Catalogs, host connections, or added Controllers will be placed. You can also move items between zones.

Connections and resources

If you are using a hypervisor or cloud service to host machines that will deliver applications and desktops to users, you create your first connection to that hypervisor or cloud service when you create a Site. The storage and network details for that connection form its resources. Later, you can change that connection and its resources, and create new connections. You can also manage the machines that use a configured connection.

Connection leasing

Connection leasing supplements the SQL Server high availability best practices by enabling users to connect and reconnect to their most recently used applications and desktops, even when the Site database is not available. While connection leasing can improve connection resiliency and user productivity, this article covers the considerations related to the availability, operation, and performance of other features when a Controller is in leased connection mode.

Virtual IP and virtual loopback

The Microsoft virtual IP address feature provides a published application with a unique dynamically-assigned IP address for each session. The Citrix virtual loopback feature allows you to configure applications that depend on communications with localhost (127.0.0.1 by default) to use a unique virtual loopback address in the localhost range (127.*).

Delivery Controllers

Before a VDA can facilitate delivery of applications and desktops, it must register (establish communication) with a Controller. Controller addresses can be specified when you install the VDA, in Citrix policy settings, registry settings, and in several other ways. It is critical that VDAs get current information as Controllers are added, moved, and removed in the Site. This article describes how and when VDAs registers, methods for updating Controller information, and how to add, remove, and move Controllers.

Sessions

Maintaining session activity is critical to providing the best user experience. Several features can optimize the reliability of...
sessions, reduce inconvenience, downtime, and loss of productivity.

- Session reliability
- Auto Client Reconnect
- ICA Keep-Alive
- Workspace control
- Session roaming

**Using search in Studio**

When you want to view information about machines, sessions, Machine Catalogs, applications, or Delivery Groups in Studio, use the flexible search feature.

**IPv4/ipv6**

This release of XenApp and XenDesktop supports pure IPv4, pure IPv6, and dual-stack deployments that use overlapping IPv4 and IPv6 networks. This article describes and illustrates these deployments. It also describes the Citrix policy settings that determine use of IPv4 or IPv6.

**Client folder redirection**

Client folder redirection changes the way client-side files are accessible on the host-side session. When you enable only client drive mapping on the server, client-side full volumes are automatically mapped to the sessions as Universal Naming Convention (UNC) links. When you enable client folder redirection on the server and the user configures it on the Windows desktop device, the portion of the local volume specified by the user is redirected.

**User profiles**

By default, Citrix Profile management is installed automatically when you install a VDA. If you use this profile solution, review this article for general information and see the Profile management documentation for full details.
Licensing

Aug 31, 2016

**Note**

Studio and Director do not support Citrix License Server VPX. For more information about Citrix License Server VPX, see the Citrix Licensing documentation.

From Studio, you can manage and track licensing, if the license server is in the same domain as Studio or in a trusted domain. For information about other licensing tasks, see the licensing documentation.

You must be a full license administrator to complete the tasks described below, except for viewing license information. To view license information in Studio, an administrator must have at least the Read Licensing Delegated Administration permission; the built-in Full Administrator and Read-Only Administrator roles have that permission.

The following table lists the supported editions and license models:

<table>
<thead>
<tr>
<th>Products</th>
<th>Editions</th>
<th>License models</th>
</tr>
</thead>
<tbody>
<tr>
<td>XenApp</td>
<td>● Platinum</td>
<td>Concurrent</td>
</tr>
<tr>
<td></td>
<td>● Enterprise</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Advanced</td>
<td></td>
</tr>
<tr>
<td>XenDesktop</td>
<td>● Platinum</td>
<td>● User/Device</td>
</tr>
<tr>
<td></td>
<td>● Enterprise</td>
<td>● Concurrent</td>
</tr>
<tr>
<td></td>
<td>● App</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● VDI</td>
<td></td>
</tr>
</tbody>
</table>

To view license information, select **Configuration > Licensing** in the Studio navigation pane. A summary of license usage and settings for the Site is displayed with a list of all the licenses currently installed on the specified license server.

To download a license from Citrix:

1. Select **Configuration > Licensing** in the Studio navigation pane.
2. Select **Allocate Licenses** in the Actions pane.
3. Type the License Access Code, which is supplied in an email from Citrix.
4. Select a product and click **Allocate Licenses**. All the licenses available for that product are allocated and downloaded.
   After you allocate and download all the licenses for a specific License Access Code, you cannot use that License Access Code again. To perform additional transactions with that code, log on to My Account.

To add licenses that are stored on your local computer or on the network:

1. Select **Configuration > Licensing** in the Studio navigation pane.
2. Select **Add Licenses** in the Actions pane.
3. Browse to a license file and add it to the license server.
To change the license server:

1. Select **Configuration > Licensing** in the Studio navigation pane.
2. Select **Change License Server** in the Actions pane.
3. Type the address of the license server in the form name:port, where name is a DNS, NetBIOS, or IP address. If you do not specify a port number, the default port (27000) is used.

To select the type of license to use:

- When configuring the Site, after you specify the license server, you are prompted to select the type of license to use. If there are no licenses on the server, the option to use the product for a 30-day trial period without a license is automatically selected.
- If there are licenses on the server, their details are displayed and you can select one of them. Or, you can add a license file to the server and then select that one.

To change the product edition and licensing model:

1. Select **Configuration > Licensing** in the Studio navigation pane.
2. Select **Edit Product Edition** in the Actions pane.
3. Update the appropriate options.

To access the License Administration Console, in the Actions pane, select **License Administration Console**. The console either appears immediately, or if the dashboard is configured as password-protected, you are prompted for License Administration Console credentials. For details about how to use the console, see the licensing documentation.

To add a licensing administrator:

1. Select **Configuration > Licensing** in the Studio navigation pane.
2. Select the Licensing Administrators tab in the middle pane.
3. Select **Add licensing administrator** in the Actions pane.
4. Browse to the user you want to add as an administrator and choose permissions.

To change a licensing administrator's permissions or delete a licensing administrator:

1. Select **Configuration > Licensing** in the Studio navigation pane.
2. Select the Licensing Administrators tab in the middle pane and then select the administrator.
3. Select either **Edit licensing administrator** or **Delete licensing administrator** in the Actions pane.

To add a licensing administrator group:

1. Select **Configuration > Licensing** in the Studio navigation pane.
2. Select the Licensing Administrators tab in the middle pane.
3. Select **Add licensing administrator group** in the Actions pane.
4. Browse to the group you want to act as licensing administrators and choose permissions. Adding an Active Directory Group gives licensing administrator permissions to the users within that group.

To change a licensing administrator group's permissions or delete a licensing administrator group:

1. Select **Configuration > Licensing** in the Studio navigation pane.
2. Select the Licensing Administrators tab in the middle pane and then select the administrator group.
3. Select either **Edit licensing administrator group** or **Delete licensing administrator group** in the Actions pane.
Zones

Feb 24, 2016

Deployments that span widely-dispersed locations connected by a WAN can face challenges due to network latency and reliability. There are two options that mitigate those challenges:

- Deploy multiple Sites, each with their own SQL Server Site database.

  This option is recommended for large enterprise deployments. Multiple Sites are managed separately, and each requires its own SQL Server Site database. Each Site is a separate XenApp deployment.

- Configure multiple zones within a single Site.

  Configuring zones can help users in remote regions connect to resources without necessarily forcing their connections to traverse large segments of the WAN. Using zones allows effective Site management from a single Citrix Studio console, Citrix Director, and the Site database. This saves the costs of deploying, staffing, licensing, and operating additional Sites containing separate databases in remote locations.

  Zones can be helpful in deployments of all sizes. You can use zones to keep applications and desktops closer to end users, which improves performance. A zone can have one or more Controllers installed locally for redundancy and resiliency, but it is not required.

Throughout this article the term local refers to the zone being discussed. For example, "A VDA registers with a local Controller" means that a VDA registers with a Controller in the zone where the VDA is located.

Zones in this release are similar, but not identical to zones in XenApp version 6.5 and earlier. For example, in this implementation of zones, there are no data collectors. All Controllers in the Site communicate with one Site database in the primary zone. Also, failover and preferred zones work differently in this release.

Zone types

A Site always has one primary zone. It can also optionally have one or more satellite zones. Satellite zones can be used for disaster recovery, geographically-distant datacenters, branch offices, a cloud, or an availability zone in a cloud.

Primary zone

The primary zone has the default name "Primary," which contains the SQL Server Site database (and high availability SQL servers, if used), Studio, Director, Citrix StoreFront, Citrix License Server, and NetScaler Gateway. The Site database should always be in the primary zone.

The primary zone should also have at least two Controllers for redundancy, and may have one or more VDAs with applications that are tightly-coupled with the database and infrastructure.

Satellite zone

A satellite zone contains one or more VDAs, Controllers, StoreFront servers, and NetScaler Gateway servers. Under normal operations, Controllers in a satellite zone communicate directly with the database in the primary zone.

A satellite zone, particularly a large one, might also contain a hypervisor that is used to provision and/or store
machines for that zone. When you configure a satellite zone, you can associate a hypervisor or cloud service connection with it. (Be sure any Machine Catalogs that use that connection are in the same zone.)

A Site can have different types of satellite zones, based on your unique needs and environment. The following figure illustrates a primary zone and examples of satellite zones.

- **The Primary zone** contains two Controllers, Studio, Director, StoreFront, License Server, and the Site database (plus high availability SQL Server deployments). The Primary zone also contains several VDAs and a NetScaler Gateway.

- **Satellite zone 1 - VDAs with Controller**

  Satellite zone 1 contains a Controller, VDAs, and a StoreFront server. VDAs in this satellite zone register with the local Controller. The local Controller communicates with the Site database and license server in the primary zone.

  If the WAN fails, the connection leasing feature allows the Controller in the satellite zone to continue brokering connections to VDAs in that zone. Such a deployment can be effective in an office where workers use a local StoreFront site and the local Controller to access their local resources, even if the WAN link connecting their office to the corporate network fails.

- **Satellite zone 2 - VDAs with redundant Controllers**

  Satellite zone 2 contains two Controllers, VDAs, and a StoreFront server. This is the most resilient zone type, offering protection against a simultaneous failure of the WAN and one of the local Controllers.
Where VDAs register and where Controllers fail over

In a Site containing primary and satellite zones, with VDAs at minimum version 7.7:

- A VDA in the primary zone registers with a Controller in the primary zone. A VDA in the primary zone will never attempt to register with a Controller in a satellite zone.
- A VDA in a satellite zone registers with a local Controller, if possible. (This is considered the preferred Controller.) If no local Controllers are available (for example, because the local Controllers cannot accept more VDA registrations or the local Controllers have failed), the VDA will attempt to register with a Controller in the primary zone. In this case, the VDA stays registered in the primary zone, even if a Controller in satellite zone becomes available again. A VDA in a satellite zone will never attempt to register with a Controller in another satellite zone.
- When auto-update is enabled for VDA discovery of Controllers, and you specify a list of Controller addresses during VDA installation, a Controller is randomly selected from that list for initial registration (regardless of which zone the Controller resides in). After the machine with that VDA is restarted, the VDA will start to prefer registering with a Controller in its local zone.
- If a Controller in a satellite zone fails, it fails over to another local Controller, if possible. If no local Controllers are available, it fails over to a Controller in the primary zone.
- If you move a Controller in or out of a zone, and auto-update is enabled, VDAs in both zones receive updated lists indicating which Controllers are local and which are in the primary zone, so they know with whom they can register and accept connections from.
- Controllers in the primary zone keep connection leasing data for all zones. Controllers in satellite zones keep connection leasing data for their own zone and the primary zone, but not data for any other satellite zones.

For Sites containing VDA versions earlier than 7.7:

- A VDA in a satellite zone will accept requests from Controllers in their local zone and the primary zone. (VDAs at minimum version 7.7 can accept Controller requests from other satellite zones.)
- A VDA in a satellite zone will register with a Controller in the primary zone or the local zone at random. (VDAs at minimum version 7.7 prefer the local zone.)

Considerations, requirements, and best practice

- You can place the following items in a zone: Controllers, Machine Catalogs, and host connections. If a Machine Catalog uses a host connection, both the catalog and the connection should be in the same zone.
- When you create a production Site and then create the first Machine Catalog and Delivery Group, all items are in the primary zone – you cannot create satellite zones until after you complete that initial setup. (If you create an empty Site, the primary zone will initially contain only a Controller; you can create satellite zones before or after creating a Machine Catalog and Delivery Group.)
- When you create the first satellite zone containing one or more items, all other items in your Site remain in the primary zone.
- The primary zone is named 'Primary' by default; you can change that name. Although the Studio display indicates which zone is the primary zone, it is best practice to use an easily-identifiable name for the primary zone. You can reassign the
primary zone (that is, make another zone the primary zone), but it should always contain the Site database and any high availability servers.

- The Site database should always be in the primary zone.
- After you create a zone, you can later move items from one zone to another. Note that this flexibility allows you to potentially separate items that work best in close proximity - for example, moving a Machine Catalog to a different zone than the connection (host) that creates the machines in the catalog, could affect performance. So, consider potential unintended effects before moving items between zones. Keep a catalog and the host connection it uses in the same zone.
- For optimal performance, install Studio and Director only in the primary zone. If you want another Studio instance in a satellite zone (for example, if a satellite zone containing Controllers is being used as failover in the event the primary zone becomes inaccessible), run Studio as a locally-published application. You can also access Director from a satellite zone because it is a web application.
- Ideally, NetScaler Gateway in a satellite zone should be used for user connections coming into that zone from other zones or external locations, although you can use it for connections within the zone.

Create and manage zones

A Full Administrator can perform all zone creation and management tasks. However, you can also create a custom role that allows you to create, edit, or delete a zone. Moving items between zones does not require zone-related permissions (except zone read permission); however, you must have edit permission for the items you are moving. For example, to move a Machine Catalog from one zone to another, you must have edit permission for that Machine Catalog. For more information, see the Delegated Administration article.

If you use Provisioning Services: The Provisioning Services console provided with this release is not aware of zones, so Citrix recommends using Studio to create Machine Catalogs that you want to place in satellite zones. Use the Studio wizard to create the catalog, specifying the correct satellite zone. Then, use the Provisioning Services console to provision machines in that catalog. (If you create the catalog using the Provisioning Services wizard, it will be placed in the primary zone, and you will need to use Studio to move it to the satellite zone later.)

Create a zone

1. Select Configuration > Zones in the Studio navigation pane.
2. Select Create Zone in the Actions pane.
3. Enter a name for the zone, and a description (optional). The name must be unique within the Site.
4. Select the items to place in the new zone. You can filter or search the list of items from which you can select. You can also create an empty zone; simply do not select any items.
5. Click Save.

As an alternative to this method, you can select one or more items in Studio and then select Create Zone in the Actions pane.

Change a zone name or description

1. Select Configuration > Zones in the Studio navigation pane.
2. Select a zone and then select Edit Zone in the Actions pane.
3. Change the zone name and/or description. If you change the name of the primary zone, make sure the zone remains easily identifiable as the primary zone.
4. Click OK or Apply.
Move items from one zone to another zone

1. Select Configuration > Zones in the Studio navigation pane.
2. Select one or more items.
3. Complete one of these actions: either drag the items to the destination zone, or select Move Items in the Actions pane and then specify which zone to move them to.

A confirmation message lists the items you selected and asks if you are sure you want to move all of them.

**Remember:** When a Machine Catalog uses a host connection to a hypervisor or cloud service, both the catalog and the connection should be in the same zone. Otherwise, performance can be affected. If you move one, move the other, too.

Delete a zone

A zone must be empty before it can be deleted. You cannot delete the primary zone.

1. Select Configuration > Zones in the Studio navigation pane.
2. Select a zone.
3. Select Delete Zone from the Actions pane. If the zone is not empty (it contains items), you are asked to choose the zone where those items will be moved.
4. Confirm the deletion.

Other actions that include specifying zones

When you add a host connection or create a Machine Catalog (other than during Site creation), you can specify a zone where the item will be assigned, if you have already created at least one satellite zone.

In most cases, the primary zone is the default. When using Machine Creation Services to create a Machine Catalog, the zone that is configured for the host connection is automatically selected.

If the Site contains no satellite zones, the primary zone is assumed and the zone selection box does not appear.
Connections and resources

Sep 14, 2016

In this article:

- Introduction
- Create a connection and resources
- Create a connection and resources from an existing connection
- Add storage
- Edit storage
- Edit a connection
- Turn maintenance mode on or off for a connection
- Delete a connection
- Rename a connection
- View machine details on a connection
- Manage machines on a connection
- Delete, rename, or test resources
- Use IntelliCache for XenServer connections
- Connection timers

Introduction

You create your first connection to hosting resources when you create a Site. Later, you can change that connection and create new ones. Configuring a connection includes selecting the connection type from among the supported hypervisors or cloud services. The storage and network you select form the resources for that connection.

Read Only Administrators can view connection and resource details; you must be a Full Administrator to perform connection and resource management tasks.

Connection type information sources

You can use the supported virtualization platforms to host and manage machines in your XenApp or XenDesktop environment. You can use the supported cloud deployment solutions to host product components and provision virtual machines. These solutions pool computing resources to build public, private, and hybrid Infrastructure as a Service (IaaS) clouds.

For details, see the following information sources.

**VMware**

- VMware virtualization environment article.
- VMware product documentation.

**Microsoft Hyper-V**

- Microsoft System Center Virtual Machine Manager virtualization environment article.
- Microsoft documentation.

**Microsoft Azure**

- Microsoft Azure virtualization environments article.
- Microsoft documentation.

When you create a connection in Studio, you can automatically import information from a Publish Settings file you downloaded from

Amazon Web Services (AWS)

- Citrix XenDesktop on AWS
- AWS documentation.
- When you create a connection in Studio, you must provide the API key and secret key values. You can export the key file containing those values from AWS and then import them. You must also provide the region, availability zone, VPC name, subnet addresses, domain name, security group names, and credentials.
- The credentials file for the root AWS account (retrieved from the AWS console) is not formatted the same as credentials files downloaded for standard AWS users. Therefore, Studio cannot use the file to populate the API key and secret key fields. Ensure that you are using AWS IAM credentials files.

Citrix CloudPlatform

- CloudPlatform documentation.
- When you create a connection in Studio, you must provide the API key and secret key values. You can export the key file containing those values from CloudPlatform and then import those values.

Citrix XenServer

- Citrix XenServer documentation.
- When you create a connection, you must provide the credentials for a VM Power Admin or higher-level user.
- Citrix recommends using HTTPS to secure communications with XenServer. To use HTTPS, you must replace the default SSL certificate installed on XenServer; see CTX128656.
- You can configure high availability if it is enabled on the XenServer. Citrix recommends that you select all servers in the pool (from Edit High Availability) to allow communication with XenServer if the pool master fails.
- You can select a GPU type and group, or passthrough, if the XenServer supports vGPU. The display indicates if the selection has dedicated GPU resources.

Nutanix Acropolis

- CTX202032
- https://portal.nutanix.com/#/page/docs

Create a connection and resources

The hosting resources must be available before you create a connection.

1. Select Configuration > Hosting in the Studio navigation pane.
2. Select Add Connections and Resources in the Actions pane.
3. Select Create a new Connection.
4. On the Connection page, select the connection type and enter a connection name. Choose a name that will help administrators identify the host type and deployment address.
5. Additional required information depends on the selected connection type.
6. Choose the tools you will use to create virtual machines. For hypervisors that provide GPU resources, choose Studio Tools.
7. On the Storage page, select storage types and devices. When using Machine Creation Services, select the network and storage resources for the new virtual machines. If you use shared storage on XenServer connections, you can enable IntelliCache to reduce load on the storage device. For information about using IntelliCache, see below.
8. If the connection has GPU capabilities, select the option to use graphics virtualization and then select a GPU type and group.
9. Enter a name for the resources.
Create a connection and resources from an existing connection

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select **Add Connection and Resources** in the Actions pane.
3. Select **Use an existing Connection** and then choose the relevant connection.
4. Choose the tools you will use to create virtual machines. For hypervisors that provide GPU resources, choose **Studio Tools**. If the Connection has GPU capabilities, select the option to use graphics virtualization and then select a GPU type and group.
5. Enter a name for the resources.

### Add storage

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select a connection and then select **Add Storage** in the Actions pane.
3. Select the storage to add.

### Edit storage

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select a resources entry under a connection and then select **Edit Storage** in the Actions pane.
3. On the **Standard Storage** page, select or clear the check boxes for the storage locations that will store virtual machines. If you clear a storage location that was accepting new machines, it will no longer accept new machines. Existing machines will continue using that location (and write data to it); so it is possible for a storage location to become full even after it stops accepting new machines.
   If Personal vDisk storage is used, select or clear the check boxes on the **PvD Storage** page, too.

### Edit a connection

Do not use this procedure to rename a connection or to create a new connection. Those are different operations.

You cannot change the GPU settings for a connection, because machine catalogs accessing this resource must use an appropriate GPU-specific master image. Create a new connection.

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select the connection and then select **Edit Connection** in the Actions pane.
3. Follow the guidance below for the settings available when you edit a connection.

**Connection Properties page:**

- To change the connection address and credentials, select **Edit settings** and then enter the new information.
- To specify the high-availability servers for a XenServer connection, select **Edit HA servers**. Citrix recommends that you
select all servers in the pool to allow communication with XenServer if the pool master fails.

**Advanced page:**

For a Microsoft System Center Configuration Manager (Conf Mgr) Wake on LAN connection type, which is used with Remote PC Access, enter Conf Mgr Wake Proxy, magic packets, and packet transmission information.

The throttling threshold settings enable you to specify a maximum number of power actions allowed on a connection. These settings can help when power management settings allow too many or too few machines to start at the same time.

- The **Simultaneous actions (all types)** and **Simultaneous Personal vDisk inventory updates** settings specify two values: a maximum absolute number that can occur simultaneously on this connection, and a maximum percentage of all machines that use this connection. You must specify both absolute and percentage values; the actual limit applied is the lower of the values.

  For example, in a deployment with 34 machines, if **Simultaneous actions (all types)** is set to an absolute value of 10 and a percentage value of 10, the actual limit applied is 3 (that is, 10 percent of 34 rounded to the nearest whole number, which is less than the absolute value of 10 machines).

- The **Maximum new actions per minute** is an absolute number; there is no percentage value.

Each connection type has specific default values that are appropriate for most cases and should generally not be changed.

**Note:** Enter information in the **Connection options** field only under the guidance of a Citrix Support representative.

**Turn maintenance mode on or off for a connection**

Turning on maintenance mode for a connection prevents any new power action from affecting any machine stored on the connection. Users cannot connect to a machine when it is in maintenance mode. If users are already connected, maintenance mode takes effect when they log off.

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select the connection. To turn maintenance mode on, select **Turn On Maintenance Mode** in the Actions pane. To turn maintenance mode off, select **Turn Off Maintenance Mode**.

You can also turn maintenance mode on or off for individual machines; see below. Additionally, you can turn maintenance mode on or off for machines in Machine Catalogs or Delivery Groups.

**Delete a connection**

**Caution:** Deleting a connection can result in the deletion of large numbers of machines and loss of data. Ensure that user data on affected machines is backed up or no longer required.

Before deleting a connection, ensure that:

- All users are logged off from the machines stored on the connection.
- No disconnected user sessions are running.
- Maintenance mode is turned on for pooled and dedicated machines.
- All machines in Machine Catalogs used by the connection are powered off.
A Machine Catalog becomes unusable when you delete a connection that is referenced by that catalog. If this connection is referenced by a catalog, you have the option to delete the catalog. Before you delete a catalog, make sure it is not used by other connections.

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select the connection and then select **Delete Connection** in the Actions pane.
3. If this connection has machines stored on it, you are asked whether the machines should be deleted. If they are to be deleted, specify what should be done with the associated Active Directory computer accounts.

**Rename a connection**

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select the connection and then select **Rename Connection** in the Actions pane.

**View machine details on a connection**

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select the connection and then select **View Machines** in the Actions pane.

The upper pane lists the machines accessed through the connection. Select a machine to view its details in the lower pane. Session details are also provided for open sessions.

Use the search feature to find machines quickly. Either select a saved search from the list at the top of the window, or create a new search. You can either search by typing all or part of the machine name, or you can build an expression to use for an advanced search. To build an expression, click **Unfold**, and then select from the lists of properties and operators.

**Manage machines on a connection**

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select a connection and then select **View Machines** in the Action pane.
3. Select one of the following in the Actions pane. Some actions may not be available, depending on the machine state and the connection host type.

   - **Start**: Starts the machine if it is powered off or suspended.
   - **Suspend**: Pauses the machine without shutting it down, and refreshes the list of machines.
   - **Shut down**: Requests the operating system to shut down.
   - **Force shut down**: Forcibly powers off the machine, and refreshes the list of machines.
   - **Restart**: Requests the operating system to shut down and then start the machine again. If the operating system cannot comply, the desktop remains in its current state.
   - **Enable maintenance mode**: Temporarily stops connections to a machine. Users cannot connect to a machine in this state. If users are connected, maintenance mode takes effect when they log off. (You can also turn maintenance mode on or off for all machines accessed through a connection, see above.)
   - **Remove from Delivery Group**: Removing a machine from a Delivery Group does not delete it from the Machine Catalog that the Delivery Group uses. You can remove a machine only when no user is connected to it; turn on maintenance mode to temporarily prevent users from connecting while you are removing the machine.
Delete, rename, or test resources

1. Select **Configuration > Hosting** in the Studio navigation pane.
2. Select the resource and then select the appropriate entry in the Actions pane: **Delete Resources**, **Rename Resources**, or **Test Resources**.

Use IntelliCache for XenServer connections

Using IntelliCache, hosted VDI deployments are more cost-effective because you can use a combination of shared storage and local storage. This enhances performance and reduces network traffic. The local storage caches the master image from the shared storage, which reduces the amount of reads on the shared storage. For shared desktops, writes to the differencing disks are written to local storage on the host and not to shared storage.

- Shared storage must be NFS when using IntelliCache.
- Citrix recommends that you use a high performance local storage device to ensure the fastest possible data transfer.

To use IntelliCache, you must enable it in both this product and XenServer.

- When installing XenServer, select **Enable thin provisioning (Optimized storage for XenDesktop)**. Citrix does not support mixed pools of servers that have IntelliCache enabled and servers that do not. For more information, see the XenServer documentation.
- In XenApp and XenDesktop, IntelliCache is disabled by default. You can change the setting only when creating a XenServer connection; you cannot disable IntelliCache later. When you add a XenServer connection from Studio:
  - Select **Shared** as the storage type.
  - Select the **Use IntelliCache** check box.

Connection timers

You can use policy settings to configure three connection timers:

- **Maximum connection timer**: Determines the maximum duration of an uninterrupted connection between a user device and a virtual desktop. Use the **Session connection timer** and **Session connection timer interval** policy settings.
- **Connection idle timer**: Determines how long an uninterrupted user device connection to a virtual desktop will be maintained if there is no input from the user. Use the **Session idle timer** and **Session idle timer interval** policy settings.
- **Disconnect timer**: Determines how long a disconnected, locked virtual desktop can remain locked before the session is logged off. Use the **Disconnected session timer** and **Disconnected session timer interval** policy settings.
When you update any of these settings, ensure they are consistent across your deployment.
Connection leasing

To ensure that the Site database is always available, Citrix recommends starting with a fault-tolerant SQL Server deployment by following high availability best practices from Microsoft. However, network issues and interruptions may prevent Delivery Controllers from accessing the database, resulting in users not being able to connect to their applications or desktop.

The connection leasing feature supplements the SQL Server high availability best practices by enabling users to connect and reconnect to their most recently used applications and desktops, even when the Site database is not available.

Although users may have a large number of published resources available, they often use only a few of them regularly. When you enable connection leasing, each Controller caches user connections to those recently used applications and desktops during normal operations (when the database is available).

The leases generated on each Controller are uploaded to the Site database for periodic synchronization to other Controllers on the Site. In addition to leases, each Controller’s cache holds application, desktop, icon, and worker information. The lease and related information is stored on each Controller’s local disk. If the database becomes unavailable, the Controller enters leased connection mode and “replays” the cached operations when a user attempts to connect or reconnect to a recently used application or desktop from StoreFront.

Connections are cached for a lease period of two weeks. So, if the database becomes unavailable, the desktops and applications that the user launched in the previous two weeks remain accessible to that user through StoreFront. However, desktops and applications that have not been launched during the previous two-week lease period are not accessible when the database is unavailable. For example, if a user last launched an application three weeks ago, its lease has expired, and that user cannot launch that application if the database becomes unavailable now. Leases for long-running active or disconnected application or desktop sessions are extended so that they are not they are not considered expired.

By default, connection leasing affects the entire Site; however, you can revoke all leases for specific users, which prevents them from accessing any applications or desktops when the Controller is in leased connection mode. Several other registry settings apply on a Controller basis.

While connection leasing can improve connection resiliency and user productivity, there are considerations related to the availability, operation, and performance of other features.

Connection leasing is supported for server-hosted applications and desktops, and static (assigned) desktops; it is not supported for pooled VDI desktops or for users who have not been assigned a desktop when the database becomes unavailable.

When the Controller is in leased connection mode:

- Administrators cannot use Studio, Director, or the PowerShell console.
- Workspace Control is not available. When a user logs on to Citrix Receiver, sessions do not automatically reconnect; the user must relaunch the application.
- If a new lease is created immediately before the database becomes unavailable, but the lease information has not yet been synchronized across all Controllers, the user might not be able to launch that resource after the database becomes unavailable.
- Server-hosted application and desktop users may use more sessions than their configured session limits. For example:
A session may not roam when a user launches it from one device (connecting externally through NetScaler Gateway) when the Controller is not in leased connection mode and then connects from another device on the LAN when the Controller is in leased connection mode.

● Session reconnection may fail if an application launches just before the database becomes unavailable; in such cases, a new session and application instance are launched.

● Static (assigned) desktops are not power-managed. VDAs that are powered off when the Controller enters leased connection mode remain unavailable until the database connection is restored, unless the administrator manually powers them on.

● If session prelaunch and session linger are enabled, new prelaunch sessions are not started. Prelaunched and lingering sessions will not be ended according to configured thresholds while the database is unavailable.

● Load management within the Site may be affected. Server-based connections are routed to the most recently used VDA. Load evaluators (and especially, session count rules) may be exceeded.

● The Controller will not enter leased connection mode if you use SQL Server Management Studio to take the database offline. Instead, use one of the following Transact-SQL statements:
  
  - ALTER DATABASE <database-name> SET OFFLINE WITH ROLLBACK IMMEDIATE
  - ALTER DATABASE <database-name> SET OFFLINE WITH ROLLBACK AFTER <seconds>

  Either statement cancels any pending transactions and causes the Controller to lose its connection with the database. The Controller then enters leased connection mode.

When connection leasing is enabled, there are two brief intervals during which users cannot connect or reconnect: (1) from the time the database becomes unavailable to when the Controller enters leased connection mode, and (2) from the time the Controller changes from leased connection mode to when database access is fully restored and the VDAs have re-registered.

If you configure a nondefault session roaming value, session reconnection reverts to its default value when a Controller enters leased connection mode. For details, see Connection leasing and session roaming.

See the Zones article for information about where connection leasing data is kept.

For more considerations, see XenDesktop 7.6 Connection Leasing Design Considerations.

When configuring your deployment to accommodate connection leasing:

● VDAs must be at minimum version 7.6, and the Machine Catalogs and Delivery Groups that use those machines must be at that minimum level (or a later supported version).

● The Site database size requirements will increase.

● Each Controller needs additional disk space for the cached lease files.

Connection leasing is enabled by default.

You can turn connection leasing off or on from the PowerShell SDK or the Windows registry. From the PowerShell SDK, you can also remove current leases. The following PowerShell cmdlets affect connection leasing; see the cmdlet help for details.

- Set-BrokerSite -ConnectionLeasingEnabled [Strue | |false] - Turns connection leasing on or off. Default = Strue
- Get-BrokerServiceAddedCapability - Outputs “ConnectionLeasing” for the local Controller.
- Get-BrokerLease - Retrieves either all or a filtered set of current leases.
- Remove-BrokerLease - Marks either one or a filtered set of leases for deletion.
- Update-BrokerLocalLeaseCache – Updates the connection leasing cache on the local Controller. The data is

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.580
resynchronized during the next synchronization.
Virtual IP and virtual loopback

Note: These features are valid only for Windows Server 2008 R2 and Windows Server 2012 R2 machines. They do not apply to Windows Desktop OS machines.

The Microsoft virtual IP address feature provides a published application with a unique dynamically-assigned IP address for each session. The Citrix virtual loopback feature allows you to configure applications that depend on communications with localhost (127.0.0.1 by default) to use a unique virtual loopback address in the localhost range (127.*)

Certain applications, such as CRM and Computer Telephony Integration (CTI), use an IP address for addressing, licensing, identification, or other purposes and thus require a unique IP address or a loopback address in sessions. Other applications may bind to a static port, so attempts to launch additional instances of an application in a multiuser environment will fail because the port is already in use. For such applications to function correctly in a XenApp environment, a unique IP address is required for each device.

Virtual IP and virtual loopback are independent features. You can use either or both.

Administrator action synopsis:
- To use Microsoft virtual IP, enable and configure it on the Windows server.
- To use Citrix virtual loopback, configure two settings in a Citrix policy.

When virtual IP is enabled and configured on the Windows server, each configured application running in a session appears to have a unique address. Users access these applications on a XenApp server in the same way they access any other published application. A process requires virtual IP in either of the following cases:
- The process uses a hard-coded TCP port number
- The process uses Windows sockets and requires a unique IP address or a specified TCP port number

To determine if an application needs to use virtual IP addresses:
1. Obtain the TCPView tool from Microsoft. This tool lists all applications that bind specific IP addresses and ports.
2. Disable the Resolve IP Addresses feature so that you see the addresses instead of host names.
3. Launch the application and use TCPView to see which IP addresses and ports are opened by the application and which process names are opening these ports.
4. Configure any processes that open the IP address of the server, 0.0.0.0, or 127.0.0.1.
5. To ensure that an application does not open the same IP address on a different port, launch an additional instance of the application.

How Microsoft Remote Desktop (RD) IP virtualization works
- Virtual IP addressing must be enabled on the Microsoft server.
  
For example, in a Windows Server 2008 R2 environment, from Server Manager, expand Remote Desktop Services > RD Session Host Connections to enable the RD IP Virtualization feature and configure the settings to dynamically assign IP addresses using the Dynamic Host Configuration Protocol (DHCP) server on a per-session or per-program basis. See the Microsoft documentation for instructions.

- After the feature is enabled, at session start-up, the server requests dynamically-assigned IP addresses from the DHCP server.
- The RD IP Virtualization feature assigns IP addresses to remote desktop connections per-session or per-program. If you
assign IP addresses for multiple programs, they share a per-session IP address.

- After an address is assigned to a session, the session uses the virtual address rather than the primary IP address for the system whenever the following calls are made: bind, closesocket, connect, WSAClose, WSACloseListener, getsockname, sendto, WSASendTo, gethostbyaddr, getnameinfo, getaddrinfo

When using the Microsoft IP virtualization feature within the Remote Desktop session hosting configuration, applications are bound to specific IP addresses by inserting a “filter” component between the application and Winsock function calls. The application then sees only the IP address it should use. Any attempt by the application to listen for TCP or UDP communications is bound to its allocated virtual IP address (or loopback address) automatically, and any originating connections opened by the application originate from the IP address bound to the application.

In functions that return an address (such as GetAddrInfo(), which is controlled by a Windows policy), if the local host IP address is requested, virtual IP looks at the returned IP address and changes it to the virtual IP address of the session. Applications that attempt to get the IP address of the local server through such name functions see only the unique virtual IP address assigned to that session. This IP address is often used in subsequent socket calls, such as bind or connect.

Often, an application requests to bind to a port for listening on the address 0.0.0.0. When an application does this and uses a static port, you cannot launch more than one instance of the application. The virtual IP address feature also looks for 0.0.0.0 in these call types and changes the call to listen on the specific virtual IP address, which enables more than one application to listen on the same port on the same computer because they are all listening on different addresses. The call is changed only if it is in an ICA session and the virtual IP address feature is enabled. For example, if two instances of an application running in different sessions both try to bind to all interfaces (0.0.0.0) and a specific port (such as 9000), they are bound to VIPAddress1:9000 and VIPAddress2:9000 and there is no conflict.

Enabling the Citrix virtual IP loopback policy settings allows each session to have its own loopback address for communication. When an application uses the localhost address (default = 127.0.0.1) in a Winsock call, the virtual loopback feature simply replaces 127.0.0.1 with 127.X.X.X, where X.X.X is a representation of the session ID + 1. For example, a session ID of 7 is 127.0.0.8. In the unlikely event that the session ID exceeds the fourth octet (more than 255), the address rolls over to the next octet (127.0.1.0), to the maximum of 127.255.255.255.

A process requires virtual loopback in either of the following cases:
- The process uses the Windows socket loopback (localhost) address (127.0.0.1)
- The process uses a hard-coded TCP port number

Use the virtual loopback policy settings for applications that use a loopback address for interprocess communication. No additional configuration is required. Virtual loopback has no dependency on Virtual IP, so you do not have to configure the Microsoft server.

- Virtual IP loopback support. When enabled, this policy setting allows each session to have its own virtual loopback address. This setting is disabled by default. The feature applies only to applications specified with the Virtual IP virtual loopback programs list policy setting.
- Virtual IP virtual loopback programs list. This policy setting specifies the applications that use the virtual IP loopback feature. This setting applies only when the Virtual IP loopback support policy setting is enabled.

Related feature

You can use the following registry settings to ensure that virtual loopback is given preference over Virtual IP; this is called preferred loopback. However, proceed with caution:
- Preferred loopback is supported on Windows 2008 R2 only.

https://docs.citrix.com
- Use preferred loopback only if both Virtual IP and virtual loopback are enabled; otherwise, you may have unintended results.
- Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

Run regedit on the servers where the applications reside.
- `HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\VIP` (`HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\VIP` for 32-bit machines)
- Name: PreferLoopback, Type: REG_DWORD, Data: 1
- Name: PreferLoopbackProcesses, Type: REG_MULTI_SZ, Data: <list of processes>
Delivery Controllers

Aug 31, 2016

The Delivery Controller is the server-side component that is responsible for managing user access, plus brokering and optimizing connections. Controllers also provide the Machine Creation Services that create desktop and server images.

A Site must have at least one Controller. After you install the initial Controller, you can add more Controllers when you create a Site, or later. There are two primary benefits from having more than one Controller in a Site.

- **Redundancy** — As best practice, a production Site should always have at least two Controllers on different physical servers. If one Controller fails, the others can manage connections and administer the Site.
- **Scalability** — As Site activity grows, so does CPU utilization on the Controller and database activity. Additional Controllers provide the ability to handle more users and more applications and desktop requests, and can improve overall responsiveness.

Each Controller communicates directly with the Site database. In a Site with more than one zone, the Controllers in every zone communicate with the Site database in the primary zone.

**Tip:** Do not change the computer name or the domain membership of a Controller after the Site is configured.

How VDAs discover Controllers

Before a VDA can be used, it must register (establish communication) with a Controller on the Site. The VDA finds a Controller by checking a list of Controllers called the ListOfDDCs. The ListOfDDCs comprises one or more DNS entries or IP addresses that point the VDA to Controllers on the Site. For load balancing, the VDA automatically distributes connections across all Controllers in the list.

In addition to the ListOfDDCs, the ListOfSIDs indicates which machine Security IDs (SIDs) the VDA allows to contact it as a Controller. The ListOfSIDs can be used to decrease the load on Active Directory or to avoid possible security threats from a compromised DNS server.

It is important to ensure that the ListOfDDCs and ListOfSIDs on all VDAs contain current information as Controllers are added and removed in the Site. If the lists are not updated, a VDA might reject session launches that were brokered by an unlisted Controller. Invalid entries can delay the startup of the virtual desktop system software. To keep the lists current, you can:

- Use the auto-update feature, which automatically updates the ListOfDDCs and ListOfSIDs as Controllers are added or removed. By default, auto-update is enabled.
- Self-manage — that is, manually update policy or registry settings that identify Controllers.

Information in the ListOfDDCs and ListOfSIDs can come from several places in a deployment. The VDA checks the following locations, in order, stopping at the first place it finds the lists:

1. A persistent storage location maintained for the auto-update feature. This location contains Controller information when auto-update is enabled and after the VDA successfully registers for the first time after installation. (This storage also holds machine policy information, which ensures that policy settings are retained across restarts.) For its initial registration after installation, or when auto-update is disabled, the VDA checks the following locations.
2. Policy settings (Controllers, Controller SIDs).
3. The Controller information under the Virtual Desktop Agent key in the registry. The VDA installer initially populates these values, based on Controller information you specify when installing the VDA.
4. OU-based Controller discovery. This is a legacy method maintained for backward compatibility.
5. The Personality.ini file created by Machine Creation Services.

If a ListOfDDCs specifies more than one Controller, the VDA attempts to connect to them in random order. The ListOfDDCs can also contain Controller groups, which are designated by brackets surrounding two or more Controller entries. The VDA attempts to connect to each Controller in a group before moving to other entries in the ListOfDDCs.

For XenDesktop users who have upgraded from versions earlier than 7.0, the auto-update feature replaces the CNAME function from the earlier version. You can manually re-enable the CNAME function, if desired; however, for DNS aliasing to work consistently, you cannot use both the auto-update feature and the CNAME function. See CTX137960 for information about re-enabling the CNAME functionality.

See the Zones article for information about where VDAs attempt to register in a Site that has more than one zone.

Considerations for choosing auto-update or self-manage

The policy setting that enables/disables auto-update is enabled by default.

The following types of deployments cannot use auto-update, and must self-manage.

- Deployments that use Controller groups.
- Deployments that use ListOfSIDs for security reasons. (Deployments that use ListOfSIDs to decrease the Active Directory load can use auto-update.)
- Deployments that use Provisioning Services without a write-back disk.
- Deployments that use the Controllers or Controller SIDs policy setting.

Auto-update

The Enable auto update of Controllers policy setting is located in the Virtual Delivery Agent category. To enable auto-update, enable the policy setting; this is the default. To disable auto-update, disable the policy setting.

When auto-update is enabled and you install a VDA, the VDA attempts to register with one of the Controller values you specified when you installed the VDA. The installer writes the Controller information you specify during VDA installation to the ListOfDDCs registry value.

After the VDA registers, the Controller with which it registered sends a list of the current Controller Fully Qualified Domain Names (FQDNs) and Security IDs (SIDs) to the VDA. The VDA writes this list to the auto-update persistent storage. Each Controller also checks the Site Configuration Database every 90 minutes for Controller information – if a Controller has been added or removed since the last check, or if a policy change has occurred, the Controller sends updated lists to its registered VDAs. The VDA will accept connections from all the Controllers in the most recent list it received.

If a VDA receives a list that does not include the Controller it is registered with (in other words, that Controller was removed
from the Site), the VDA re-registers, choosing among the Controllers in the list. After a VDA registers or re-registers, it receives an updated list.

For example:

1. A deployment has three Controllers: A, B, and C. A VDA is installed and registers with Controller B (which was specified during VDA installation).
2. Two Controllers (D and E) are added to the Site. Within 90 minutes, VDAs receive updated lists and will accept connections from Controllers A, B, C, D, and E. (The load will not be spread equally to all Controllers until the VDAs are restarted.)
3. Controller B is removed from the Site. Within 90 minutes, VDAs receive updated lists because there has been a Controller change since the last check. The VDA installed in step 1 is registered with Controller B, which is no longer on the list, so that VDA re-registers, choosing among the Controllers in the current list (A, C, D, and E).

Self-manage

If you do not use auto-update, you must update the Citrix policy setting or registry values for each VDA in the Site after you add, move, or remove Delivery Controllers in the Site. Registry changes can also be updated using Group Policy Object.

To self-manage using Citrix policy settings:

1. Update the FQDN values specified in the Controllers policy setting. This policy setting is located in the Virtual Delivery Agent category.
2. If you also use ListOfSIDs in your deployment, update the SID values specified in the Controller SIDspolicy setting.

To self-manage using the registry:

Caution: Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

1. Update the ListOfDDCs registry key, which lists the FQDNs of all the Controllers in the Site. (This key is the equivalent of the Active Directory Site OU.) Separate multiple values with spaces. Surround Controller groups with brackets.

   HKEY_LOCAL_MACHINE\Software\Citrix\VirtualDesktopAgent\ListOfDDCs (REG_SZ)

   If the HKEY_LOCAL_MACHINE\Software\Citrix\VirtualDesktopAgent registry location contains both the ListOfDDCs and FarmGUID keys, ListOfDDCs is used for Controller discovery; FarmGUID is present if a site OU was specified during VDA installation.

2. Optionally, update the ListOfSIDs registry key:

   HKEY_LOCAL_MACHINE\Software\Citrix\VirtualDesktopAgent\ListOfSIDs (REG_SZ)

Add, remove, or move Controllers

To add, remove, or move a Controller, you must have the server role and database role permissions listed in the Databases article.

Note: Installing a Controller on a node in an SQL clustering or SQL mirroring installation is not supported.
If your deployment uses database mirroring:

- Before adding, removing, or moving a Controller, ensure that the principal and mirrored databases are both running. In addition, if you are using scripts with SQL Server Management Studio, enable SQLCMD mode before executing the scripts.
- To verify mirroring after adding, removing, or moving a Controller, run the PowerShell `get-configdbconnection` cmdlet to ensure that the Failover Partner has been set in the connection string to the mirror.

After you add, remove, or move a Controller:

- If auto-update is enabled, the VDAs will receive an updated list of Controllers within 90 minutes.
- If auto-update is not enabled, ensure that the Controller policy setting or ListOfDDCs registry key are updated for all VDAs. After moving a Controller to another Site, update the policy setting or registry key on both Sites.

You can add Controllers when you create a Site and later. You cannot add Controllers installed with an earlier version of this software to a Site that was created with this version.

1. Run the installer on a server containing a supported operating system. Install the Delivery Controller component and any other core components you want. Complete the installation wizard.
2. If you have not yet created a Site, launch Studio; you are prompted to create a Site. On the Databases page in the Site creation wizard, click the Select button and then add the address of the server where you installed the additional Controller. **Important:** If you plan to generate scripts that will initialize the databases, add the Controllers before you generate the scripts.
3. If you have already created a Site, point Studio to the server where you installed the additional Controller. Click **Scale your deployment** and enter the Site address.

Removing a Controller from a Site does not uninstall the Citrix software or any other component; it removes the Controller from the database so that it can no longer be used to broker connections and perform other tasks. If you remove a Controller, you can later add it back to the same Site or to another Site. A Site requires at least one Controller, so you cannot remove the last one listed in Studio.

When you remove a Controller from a Site, the Controller logon to the database server is not removed. This avoids potentially removing a logon that is used by other products' services on the same machine. The logon must be removed manually if it is no longer required; the securityadmin server role permission is needed to remove the logon.

**Important:** Do not remove the Controller from Active Directory until after you remove it from the Site.

1. Make sure the Controller is powered on so that Studio loads in less than one hour. Once Studio loads the Controller you want to remove, power off the Controller when prompted to do so.
2. Select **Configuration > Controllers** in the Studio navigation pane and then select the Controller you want to remove.
3. Select **Remove Controller** in the Actions pane. If you do not have the correct database roles and permissions, you are offered the option of generating a script that allows your database administrator to remove the Controller for you.
4. You might need to remove the Controller's machine account from the database server. Before doing this, check that another service is not using the account.

After using Studio to remove a Controller, traffic to that Controller might linger for a short amount of time to ensure proper completion of current tasks. If you want to force the removal of a Controller in a very short time, Citrix recommends...
you shut down the server where it was installed, or remove that server from Active Directory. Then, restart the other Controllers on the Site to ensure no further communication with the removed Controller.

If your Site contains more than one zone, you can move a Controller to a different zone. See the Zones article for information about how this can affect VDA registration and other operations.

1. Select Configuration > Controllers in the Studio navigation pane and then select the Controller you want to move.
2. Select Move in the Actions pane.
3. Specify the zone where you want to move the Controller.

You cannot move a Controller to a Site that was created with an earlier version of this software.

1. On the Site where the Controller is currently located (the old Site), select Configuration > Controllers in the Studio navigation pane and then select the Controller you want to move.
2. Select Remove Controller in the Actions pane. If you do not have the correct database roles and permissions, you are offered the option of generating a script that allows someone with those permissions (such as a database administrator) to remove the Controller for you. A Site requires at least one Controller, so you cannot remove the last one listed in Studio.
3. On the Controller you are moving, open Studio, reset the services when prompted, select Join existing site, and enter the address of the new Site.

If a VDA was provisioned using Provisioning Services or is an existing image, you can move a VDA to another Site (from Site 1 to Site 2) when upgrading, or when moving a VDA image that was created in a test Site to a production Site. VDAs provisioned using Machine Creation Services (MCS) cannot be moved from one Site to another because MCS does not support changing the ListOfDDCs a VDA checks to register with a Controller; VDAs provisioned using MCS always check the ListOfDDCs associated with the Site in which they were created.

There are two ways to move a VDA to another Site: using the installer or Citrix policies.

**Installer:** Run the installer and add a Controller, specifying the FQDN (DNS entry) of a Controller in Site 2.

**Important:** Specify Controllers in the installer only when the Controllers policy setting is not used.

**Group Policy Editor:** The following example moves multiple VDAs between Sites.

1. Create a policy in Site 1 that contains the following settings, then filter the policy to the Delivery Group level to initiate a staged VDA migration between the Sites.
   Controllers - containing FQDNs (DNS entries) of one or more Controllers in Site 2.
   Enable auto update of Controllers - set to disabled.
2. Each VDA in the Delivery Group is alerted within 90 minutes of the new policy. The VDA ignores the list of Controllers it receives (because auto-update is disabled); it selects one of the Controllers specified in the policy, which lists the Controllers in Site 2.
3. When the VDA successfully registers with a Controller in Site 2, it receives the Site 2 ListOfDDCs and policy information, which has auto-update enabled by default. Since the Controller with which the VDA was registered in Site 1 is not on the list sent by the Controller in Site 2, the VDA re-registers, choosing among the Controllers in the Site 2 list. From then on, the VDA is automatically updated with information from Site 2.
Active Directory OU-based Controller discovery

This Delivery Controller discovery method is supported primarily for backward compatibility, and is valid only for Virtual Delivery Agents (VDAs) for Windows Desktop OS, not VDAs for Windows Server OS. Active Directory-based discovery requires that all computers in a Site are members of a domain, with mutual trusting relationships between the domain used by the Controller and the domain(s) used by desktops. If you use this method, you must configure the GUID of the OU in each desktop registry.

To perform an OU-based Controller discovery, run the Set-ADControllerDiscovery.ps1 PowerShell script on the Controller (each Controller contains this script in the folder $Env:ProgramFiles\Citrix\Broker\Service\Setup Scripts). To run the script, you must have CreateChild permissions on a parent OU, plus full administration rights.

When you create a Site, a corresponding Organizational Unit (OU) must be created in Active Directory if you want desktops to discover the Controllers in the Site through Active Directory. The OU can be created in any domain in the forest that contains your computers. As best practice, the OU should also contain the Controllers in the Site, but this is not enforced or required. A domain administrator with appropriate privileges can create the OU as an empty container, then delegate administrative authority over the OU to a Citrix administrator.

The script creates several essential objects. Only standard Active Directory objects are created and used. It is not necessary to extend the schema.

- A Controllers security group. The computer account of all Controllers in the Site must be a member of this security group. Desktops in a Site accept data from Controllers only if they are members of this security group. Ensure that all Controllers have the 'Access this computer from the network' privilege on all virtual desktops running the VDA. You can do this by giving the Controllers security group this privilege. If Controllers do not have this privilege, VDAs will not register.

- A Service Connection Point (SCP) object that contains information about the Site, such as the Site name. If you use the Active Directory Users and Computers administrative tool to inspect a Site OU, you might need to enable Advanced Features in the View menu to see SCP objects.

- A container called RegistrationServices, which is created in the Site OU. This contains one SCP object for each Controller in the Site. Each time the Controller starts, it validates the contents of its SCP and updates it, if necessary.

If multiple administrators are likely to add and remove Controllers after the initial installation, they need permissions to create and delete children on the RegistrationServices container, and Write properties on the Controllers security group; these permissions are granted automatically to the administrator who runs the Set-ADControllerDiscovery.ps1 script. The domain administrator or the original installing administrator can grant these permissions, and Citrix recommends setting up a security group to do this.

When you are using a Site OU:

- Information is written to Active Directory only when installing or uninstalling this software, or when a Controller starts and needs to update the information in its SCP (for example, because the Controller was renamed or because the communication port was changed). By default, the Set-ADControllerDiscovery.ps1 script sets up permissions on the objects in the Site OU appropriately, giving each Controller Write access to its SCP. The contents of the objects in the Site OU are used to establish trust between desktops and Controllers. Ensure that:
  - Only authorized administrators can add or remove computers from the Controllers security group, using the security group's access control list (ACL).
Only authorized administrators and the respective Controller can change the information in the controller’s SCP.

If your deployment uses replication, be aware of potential delays; see the Microsoft documentation for details. This is particularly important if you create the Site OU in a domain that has domain controllers in multiple Active Directory sites.

Depending on the location of desktops, Controllers, and domain controllers, changes that are made to Active Directory when you are initially creating the Site OU, installing or uninstalling Controllers, or changing Controller names or communication ports might not be visible to desktops until that information is replicated to the appropriate domain controller. The symptoms of such replication delay include desktops that cannot establish contact with Controllers and are therefore not available for user connections.

This software uses several standard computer object attributes in Active Directory to manage desktops. Depending on your deployment, the machine object’s fully qualified domain name, as stored in the desktop’s Active Directory record, can be included as part of the connection settings that are returned to the user to make a connection. Ensure that this information is consistent with information in your DNS environment.

To move a Controller to another Site using OU-based Controller discovery, follow the directions above for moving a Controller. After you remove the Controller from the old Site (step 2), run the PowerShell script `Set-ADControllerDiscovery -sync`. This script synchronizes the OU with the current set of Controllers. After joining the existing Site (step 3), run the same script on any Controller in the new Site.

To create a Site, the Citrix administrator who runs the script must have rights over the Site OU to create objects (SCP, container, and security group).

(If the Site OU is not present, the administrator must have rights to create that as well. Citrix recommends that the AD domain administrator pre-create that OU and delegate rights to it to the Citrix Site administrator identity. Optionally, the script can also create the Site OU. To allow this, the administrator needs the “create OU” right on the new OU's parent OU. However, as noted, Citrix does not recommend this.)

Later, to add or remove a Controller from the Site, the Citrix administrator must have rights to add/remove a machine from the security group, and create/delete an SCP.

During normal operations, Controllers and VDAs need read rights to all objects in the OU and below. VDAs access the OU as their own machine identity; that machine identity needs at least read rights in the OU to be able to discover Controllers. A Controller also needs the rights to set properties on its own SCP object in the container.

Granting the Citrix administrator full rights to the child OUs will permit all these actions. However, if your deployment has stricter security requirements (such as restricting who can use the script for which action), you can use the Delegation of Control wizard to set specific rights. The following example procedure grants rights to create the Site.

1. Create an OU to contain the child objects (Service Connection Point (SCP), container, and security group).
2. Select the OU, then right-click and select Delegate Control.
3. In the Delegation of Control wizard, specify the domain user to delegate control to for the OU.
4. On the Tasks to Delegate page, select Create a custom task to delegate.
5. On the Active Directory Object type page, accept the default This folder, existing objects in this folder, and creation of new objects in this folder.
6. On the Permissions page, select Permissions Create All Child Objects.
7. Finish the wizard to confirm the privileges.
Maintaining session activity is critical to providing the best user experience. Losing connectivity due to unreliable networks, highly variable network latency, and range limitations of wireless devices can lead to user frustration. Being able to move quickly between workstations and access the same set of applications each time they log on is a priority for many mobile workers such as health-care workers in a hospital.

Use the following features to optimize the reliability of sessions, reduce inconvenience, downtime, and loss of productivity; using these features, mobile users can roam quickly and easily between devices.

- Session reliability
- Auto Client Reconnect
- ICA Keep-Alive
- Workspace control
- Session roaming

The Logon interval section describes how to change the default setting.

You can also log a user off of a session, disconnect a session, and configure session prelaunch and linger; see the Manage sessions through Delivery Groups article.

**Session reliability**

Session Reliability keeps sessions active and on the user's screen when network connectivity is interrupted. Users continue to see the application they are using until network connectivity resumes.

This feature is especially useful for mobile users with wireless connections. For example, a user with a wireless connection enters a railroad tunnel and momentarily loses connectivity. Ordinarily, the session is disconnected and disappears from the user's screen, and the user has to reconnect to the disconnected session. With Session Reliability, the session remains active on the machine. To indicate that connectivity is lost, the user's display freezes and the cursor changes to a spinning hourglass until connectivity resumes on the other side of the tunnel. The user continues to access the display during the interruption and can resume interacting with the application when the network connection is restored. Session Reliability reconnects users without reauthentication prompts.

Citrix Receiver users cannot override the Controller setting.

You can use Session Reliability with Transport Layer Security (TLS). TLS encrypts only the data sent between the user device and NetScaler Gateway.

Enable and configure Session Reliability with the following policy settings:

- The Session reliability connections policy setting allows or prevents session reliability.
- The Session reliability timeout policy setting has a default of 180 seconds, or three minutes. Although you can extend the amount of time Session Reliability keeps a session open, this feature is designed for user convenience and therefore does not prompt the user for reauthentication. As you extend the amount of time a session is kept open, chances increase that a user may get distracted and walk away from the user device, potentially leaving the session accessible to unauthorized users.
Incoming session reliability connections use port 2598, unless you change the port number in the Session reliability port number policy setting.

If you do not want users to be able to reconnect to interrupted sessions without having to reauthenticate, use the Auto Client Reconnect feature. You can configure the Auto client reconnect authentication policy setting to prompt users to reauthenticate when reconnecting to interrupted sessions.

If you use both Session Reliability and Auto Client Reconnect, the two features work in sequence. Session Reliability closes, or disconnects, the user session after the amount of time you specify in the Session reliability timeout policy setting. After that, the Auto Client Reconnect policy settings take effect, attempting to reconnect the user to the disconnected session.

Auto Client Reconnect

With the Auto Client Reconnect feature, Citrix Receiver can detect unintended disconnections of ICA sessions and reconnect users to the affected sessions automatically. When this feature is enabled on the server, users do not have to reconnect manually to continue working.

For application sessions, Citrix Receiver attempts to reconnect to the session until there is a successful reconnection or the user cancels the reconnection attempts.

For desktop sessions, Citrix Receiver attempts to reconnect to the session for a specified period of time, unless there is a successful reconnection or the user cancels the reconnection attempts. By default, this period of time is five minutes. To change this period of time, edit this registry on the user device:

HKLM\Software\Citrix\ICA Client\TransportReconnectRetryMaxTimeSeconds; DWORD;<seconds>

where <seconds> is the number of seconds after which no more attempts are made to reconnect the session.

Enable and configure Auto Client Reconnect with the following policy settings:

- **Auto client reconnect**: Enables or disables automatic reconnection by Citrix Receiver after a connection has been interrupted.
- **Auto client reconnect authentication**: Enables or disables the requirement for user authentication after automatic reconnection.
- **Auto client reconnect logging**: Enables or disables logging of reconnection events in the event log. Logging is disabled by default. When enabled, the server's system log captures information about successful and failed automatic reconnection events. Each server stores information about reconnection events in its own system log; the site does not provide a combined log of reconnection events for all servers.

Auto Client Reconnect incorporates an authentication mechanism based on encrypted user credentials. When a user initially logs on, the server encrypts and stores the user credentials in memory, and creates and sends a cookie containing the encryption key to Citrix Receiver. Citrix Receiver submits the key to the server for reconnection. The server decrypts the credentials and submits them to Windows logon for authentication. When cookies expire, users must reauthenticate to reconnect to sessions.

Cookies are not used if you enable the Auto client reconnection authentication setting. Instead, users are presented with a dialog box to users requesting credentials when Citrix Receiver attempts to reconnect automatically.

For maximum protection of user credentials and sessions, use encryption for all communication between clients and the Site.
Disable Auto Client Reconnect on Citrix Receiver for Windows by using the icaclient.adm file. For more information, see the documentation for your Citrix Receiver for Windows version.

Settings for connections also affect Auto Client Reconnect:

- By default, Auto Client Reconnect is enabled through policy settings at the Site level, as described above. User reauthentication is not required. However, if a server's ICA TCP connection is configured to reset sessions with a broken communication link, automatic reconnection does not occur. Auto Client Reconnect works only if the server disconnects sessions when there is a broken or timed out connection. In this context, the ICA TCP connection refers to a server's virtual port (rather than an actual network connection) that is used for sessions on TCP/IP networks.
- By default, the ICA TCP connection on a server is set to disconnect sessions with broken or timed out connections. Disconnected sessions remain intact in system memory and are available for reconnection by Citrix Receiver.
- The connection can be configured to reset or log off sessions with broken or timed-out connections. When a session is reset, attempting to reconnect initiates a new session; rather than restoring a user to the same place in the application in use, the application is restarted.
- If the server is configured to reset sessions, Auto Client Reconnect creates a new session. This process requires users to enter their credentials to log on to the server.
- Automatic reconnection can fail if Citrix Receiver or the plug-in submits incorrect authentication information, which might occur during an attack or the server determines that too much time has elapsed since it detected the broken connection.

ICA Keep-Alive

Enabling the ICA Keep-Alive feature prevents broken connections from being disconnected. When enabled, if the server detects no activity (for example, no clock change, no mouse movement, no screen updates), this feature prevents Remote Desktop Services from disconnecting that session. The server sends keep-alive packets every few seconds to detect if the session is active. If the session is no longer active, the server marks the session as disconnected.

**Note:** ICA Keep-Alive works only if you are not using Session Reliability. Session Reliability has its own mechanisms to prevent broken connections from being disconnected. Configure ICA Keep-Alive only for connections that do not use Session Reliability.

ICA Keep-Alive settings override keep-alive settings that are configured in Microsoft Windows Group Policy.

Enable and configure ICA Keep-Alive with the following policy settings:

- **ICA keep alive timeout.** Specifies the interval (1-3600 seconds) used to send ICA keep-alive messages. Do not configure this option if you want your network monitoring software to close inactive connections in environments where broken connections are so infrequent that allowing users to reconnect to sessions is not a concern. The default interval is 60 seconds: ICA Keep-Alive packets are sent to user devices every 60 seconds. If a user device does not respond in 60 seconds, the status of the ICA sessions changes to disconnected.

- **ICA keep alives.** Sends or prevents sending ICA keep-alive messages.

Workspace control

Workspace control lets desktops and applications follow a user from one device to another. This ability to roam enables a
user to access all desktops or open applications from anywhere simply by logging on, without having to restart the
desktops or applications on each device. For example, workspace control can assist health-care workers in a hospital who
need to move quickly among different workstations and access the same set of applications each time they log on. If you
configure workspace control options to allow it, these workers can disconnect from multiple applications at one client
device and then reconnect to open the same applications at a different client device.

Workspace control affects the following activities:

- **Logging on:** By default, workspace control enables users to reconnect automatically to all running desktops and
  applications when logging on, bypassing the need to reopen them manually. Through workspace control, users can open
disconnected desktops or applications, as well as any that are active on another client device. Disconnecting from a
desktop or application leaves it running on the server. If you have roaming users who need to keep some desktops or
applications running on one client device while they reconnect to a subset of their desktops or applications on another
client device, you can configure the logon reconnection behavior to open only the desktops or applications that the user
disconnected from previously.

- **Reconnecting:** After logging on to the server, users can reconnect to all of their desktops or applications at any time by
clicking Reconnect. By default, Reconnect opens desktops or applications that are disconnected, plus any that are
currently running on another client device. You can configure Reconnect to open only those desktops or applications
that the user disconnected from previously.

- **Logging off:** For users opening desktops or applications through StoreFront, you can configure the Log Off command
to log the user off from StoreFront and all active sessions together, or log off from StoreFront only.

- **Disconnecting:** Users can disconnect from all running desktops and applications at once, without needing to disconnect
  from each individually.

Workspace control is available only for Citrix Receiver users who access desktops and applications through a Citrix
StoreFront connection. By default, workspace control is disabled for virtual desktop sessions, but is enabled for hosted
applications. Session sharing does not occur by default between published desktops and any published applications running
inside those desktops.

User policies, client drive mappings, and printer configurations change appropriately when a user moves to a new client
device. Policies and mappings are applied according to the client device where the user is currently logged on to the session.
For example, if a health care worker logs off from a client device in the emergency room of a hospital and then logs on to a
workstation in the hospital's x-ray laboratory, the policies, printer mappings, and client drive mappings appropriate for the
session in the x-ray laboratory go into effect at the session startup.

You can customize which printers appear to users when they change locations. You can also control whether users can
print to local printers, how much bandwidth is consumed when users connect remotely, and other aspects of their printing
experiences.

For information about enabling and configuring workspace control for users, see the StoreFront documentation.

**Session roaming**

By default, sessions roam between client devices with the user. When the user launches a session and then moves to
another device, the same session is used and applications are available on both devices. The applications follow, regardless
of the device or whether current sessions exist. In many cases, printers and other resources assigned to the application also
follow.
While this default behavior offers many advantages, it might not be ideal in all cases. You can prevent session roaming using the PowerShell SDK.

Example 1: A medical professional is using two devices, completing an insurance form on a desktop PC, and looking at patient information on a tablet.

- If session roaming is enabled, both applications appear on both devices (an application launched on one device is visible on all devices in use). This might not meet security requirements.
- If session roaming is disabled, the patient record does not appear on the desktop PC, and the insurance form does not appear on the tablet.

Example 2: A production manager launches an application on the PC in his office. The device name and location determine which printers and other resources are available for that session. Later in the day, he goes to an office in the next building for a meeting that will require him to use a printer.

- If session roaming is enabled, the production manager would probably be unable to access the printers near the meeting room, because the applications he launched earlier in his office resulted in the assignment of printers and other resources near that location.
- If session roaming is disabled, when he logs on to a different machine (using the same credentials), a new session is started, and nearby printers and resources will be available.

To configure session roaming, use the following entitlement policy rule cmdlets with the "SessionReconnection" property. Optionally, you can also specify the "LeasingBehavior" property; see Connection leasing and session roaming below.

For desktop sessions:

```
Set-BrokerEntitlementPolicyRule <Delivery-Group-name> -SessionReconnection <value> -LeasingBehavior Allowed|Disallowed
```

For application sessions:

```
Set-BrokerAppEntitlementPolicyRule <Delivery-Group-name> -SessionReconnection <value> -LeasingBehavior Allowed|Disallowed
```

Where `<value>` can be one of the following:

- **Always.** Sessions always roam, regardless of the client device and whether the session is connected or disconnected. This is the default value.
- **DisconnectedOnly.** Reconnect only to sessions that are already disconnected; otherwise, launch a new session. (Sessions can roam between client devices by first disconnecting them, or using Workspace Control to explicitly roam them.) An active connected session from another client device is never used; instead, a new session is launched.
- **SameEndpointOnly.** A user gets a unique session for each client device they use. This completely disables roaming. Users can reconnect only to the same device that was previously used in the session.

The "LeasingBehavior" property is described below.

**Effects from other settings**

Disabling session roaming is affected by the application limit "Allow only one instance of the application per user" in the application's properties in the Delivery Group.
If you disable session roaming, then disable the “Allow only one instance ...” application limit.
If you enable the “Allow only one instance ...” application limit, do not configure either of the two values that allow new sessions on new devices.

If you're not familiar with connection leasing, see the Connection leasing article.

When a Controller enters leased connection mode, session reconnection reverts to its default value, reconnecting the user to only one of the active or disconnected sessions for the desktop or application.

For additional security, if you configured a nondefault session roaming value, and have multiple users who share the same logon credentials on multiple devices, consider disabling the connection leasing feature for the Delivery Group that includes that user account.

Why? In this scenario, one session is shared among all devices. This could be undesirable if, for example, one person has sensitive information displayed that is not meant to be seen by someone else who reconnects with the same credentials while the Controller is in leased connection mode.

Disabling connection leasing in the entitlement policy eliminates this possibility: a user will not be able to see the session of another user with the same logon, even when the Controller is in leased connection mode. Other entitlement policies can remain as-is; individual user accounts can use the connection leasing functionality through separate entitlements.

To disable connection leasing in an entitlement policy, add the “LeasingBehavior Disallowed” property to the entitlement policy cmdlet. If you disable connection leasing, you must manually delete any launch leases that have already been created and cached for that entitlement policy; otherwise, users will still be able to reconnect during a database outage.

Logon interval

If a virtual machine containing a desktop VDA closes before the logon process completes, you can allocate more time to the process. The default for 7.6 and later versions is 180 seconds (the default for 7.0-7.5 is 90 seconds).

On the machine (or the master image used in a Machine Catalog), set the following registry key:

Key: HKLM\SOFTWARE\Citrix\PortICA
Value: AutoLogonTimeout
Type: DWORD

Specify a decimal time in seconds, in the range 0-3600.

If you change a master image, update the catalog.

Note: This setting applies only to VMs with desktop (workstation) VDAs; Microsoft controls the logon timeout on machines with server VDAs.
Use Search in Studio

Sep 09, 2015
Use the Search feature to view information about specific machines, sessions, machine catalogs, applications, or Delivery Groups.

1. Select Search in the Studio navigation pane.
   Note: You cannot search within the machine catalogs or Delivery Groups tabs using the Search box. Use the Search node in the navigation pane.
   To display additional search criteria in the display, click the plus sign next to the Search drop-down fields. Remove search criteria by clicking the minus button.

2. Enter the name or use the drop-down list to select another search option for the item you want to find.
3. Optionally, save your search by selecting Save as. The search appears in the Saved searches list.

Alternatively, click the Expand Search icon (dual downward angle brackets) to display a drop-down list of search properties; you can perform an advanced search by building an expression from the properties in the drop-down list.

Tips to enhance a search:
- To display additional characteristics to include in the display on which you can search and sort, right click any column and select Select columns.
- To locate a user device connected to a machine, use Client (IP) and Is, and enter the device IP address.
- To locate active sessions, use Session State, Is, and Connected.
- To list all of the machines in a Delivery Group, select Delivery Groups in the navigation pane, then select the group, and then select View Machines in the Actions pane.
Tags

Jan 13, 2016

Tags are strings that identify items such as machines, applications, Delivery Groups, and policies. After creating a tag and then adding it to an item, you can tailor certain operations to apply only to items that have a specified tag:

- Tailor search displays in Studio.

For example, if you want to display only applications that have been optimized for testers, add a tag named “test” to those applications. Then, filter the Studio search with the tag “test”. Similarly, if you want to display only Delivery Groups that contain test team members, add a “tester” tag to Delivery Groups that contain test team members and then filter the Studio search with the “tester” tag.

- Apply (assign) Citrix policies to applications, machines, or Delivery Groups that have (or do not have) a specified tag.

For example, if you want to apply a Citrix policy only to the more powerful workstations, add a tag named “high power” to those machines. Then, on the Assign Policy page of the Create Policy wizard, select that tag and also the Enable checkbox. You can also add a tag to a Delivery Group and then apply a Citrix policy to that group.

Manage tags

Select a machine, application, or Delivery Group in Studio and then select Manage Tags in the Actions pane. The Manage Tags dialog box lists all the tags that have been created in the Site, not just for the item you selected.

- An enabled checkbox indicates that tag has already been added to the selected item.
- If you select a group, a checkbox containing a hyphen indicates that some, but not all items in that group have that tag added.

The following actions are available from the Manage Tags dialog box:

- To add or remove a tag, enable or clear the checkbox next to the tags you want to add or remove.
- To create a tag, select Create tag. Enter a name and description. Tag names must be unique and are not case-sensitive. Then click OK.
- To edit a tag, select a tag and then select Edit tag. Enter a new name and/or description, and then click Save. You can edit only one tag at a time.
- To delete one or more tags, select the tags and then select Delete tag. The Delete Tag dialog box lists how many items currently use the tags you selected. Click an item to display more information; for example, if two machines are affected, clicking that item displays the two machine names. After you see which items will be affected, confirm whether you want to delete the tags.
IPv4/IPv6 support

Sep 09, 2015

This release supports pure IPv4, pure IPv6, and dual-stack deployments that use overlapping IPv4 and IPv6 networks.

IPv6 communications are controlled with two Virtual Delivery Agent (VDA) connection-related Citrix policy settings:
- A primary setting that enforces the use of IPv6: Only use IPv6 Controller registration.
- A dependent setting that defines an IPv6 netmask: Controller registration IPv6 netmask.

When the Only use IPv6 Controller registration policy setting is enabled, VDAs register with a Delivery Controller for incoming connections using an IPv6 address.

The following figure illustrates a dual-stack IPv4/IPv6 deployment. In this scenario, a worker is a VDA installed on a hypervisor or on a physical system, and is used primarily to enable connections for applications and desktops. Components that support dual IPv6 and IPv4 are running on operating systems that use tunneling or dual protocol software.

These Citrix products, components, and features support only IPv4:
- Provisioning Services
- XenServer Version 6.x
- VDAs not controlled by the **Only use IPv6 Controller registration** policy setting
- XenApp versions earlier than 7.5, XenDesktop versions earlier than 7, and EdgeSight

In this deployment:
- If a team frequently uses an IPv6 network and the administrator wants them to use IPv6 traffic, the administrator will publish IPv6 desktops and applications for those users based on a worker image or Organizational Unit (OU) that has the primary IPv6 policy setting turned on (that is, Only use IPv6 Controller registration is enabled).
If a team frequently uses an IPv4 network, the administrator will publish IPv4 desktops and applications for those users based on a worker image or OU that has the primary IPv6 policy setting turned off (that is, Only use IPv6 Controller registration is disabled), which is the default.

The following figure illustrates a pure IPv6 deployment. In this scenario:
- The components are running on operating systems configured to support an IPv6 network.
- The primary Citrix policy setting (Only use IPv6 Controller registration) is enabled for all VDAs; they must register with the Controller using an IPv6 address.

Two Citrix policy settings affect support for a pure IPv6 or dual stack IPv4/IPv6 implementation. Configure the following connection-related policy settings:
- **Only use IPv6 Controller registration**: Controls which form of address the Virtual Delivery Agent (VDA) uses to register with the Delivery Controller. Default = Disabled
  - When the VDA communicates with the Controller, it uses a single IPv6 address chosen in the following precedence: global IP address, Unique Local Address (ULA), link-local address (only if no other IPv6 addresses are available).
  - When disabled, the VDA registers and communicates with the Controller using the machine's IPv4 address.
- **Controller registration IPv6 netmask**: A machine can have multiple IPv6 addresses; this policy setting allows administrators to restrict the VDA to only a preferred subnet (rather than a global IP, if one is registered). This setting specifies the network where the VDA will register: the VDA registers only on the first address that matches the specified netmask. This setting is valid only if the Only use IPv6 Controller registration policy setting is enabled. Default = Empty string

**Important**: Use of IPv4 or IPv6 by a VDA is determined solely by these policy settings. In other words, to use IPv6 addressing, the VDA must be controlled by a Citrix policy with the **Only use IPv6 Controller registration** setting enabled.

If your environment contains both IPv4 and IPv6 networks, you will need separate Delivery Group configurations for the
IPv4-only clients and for the clients who can access the IPv6 network. Consider using naming, manual Active Directory group assignment, or Smart Access filters to differentiate users.

Reconnection to a session may fail if the connection is initiated on an IPv6 network, and then attempts are made to connect again from an internal client that has only IPv4 access.
Client folder redirection

Sep 09, 2015

Client folder redirection changes the way client-side files are accessible on the host-side session. When you enable only client drive mapping on the server, client-side full volumes are automatically mapped to the sessions as Universal Naming Convention (UNC) links. When you enable client folder redirection on the server and the user configures it on the user device, the portion of the local volume specified by the user is redirected.

Only the user-specified folders appear as UNC links inside sessions instead of the complete file system on the user device. If you disable UNC links through the registry, client folders appear as mapped drives inside the session.

Client folder redirection is supported on Windows Desktop OS machines only.

Client folder redirection for an external USB drive will not be saved on detaching and reattaching the device.

Enable client folder direction on the server. Then, on the client device, specify which folders to redirect (the application you use to specify the client folder options is included with the Citrix Receiver supplied with this release).

Caution: Editing the registry incorrectly can cause serious problems that may require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the registry before you edit it.

1. On the server:
   1. Create a key: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\Client Folder Redirection.
   2. Create a REG_DWORD value.
      - Name: CFROnlyModeAvailable
      - Type: REG_DWORD
      - Data: Set to 1

2. On the user device:
   1. Ensure the latest version of Citrix Receiver is installed.
   2. From the Citrix Receiver installation directory, start CtxCFRUI.exe.
   3. Select the Custom radio button and add, edit, or remove folders.
   4. Disconnect and reconnect your sessions for the setting to take effect.
User profiles

Sep 25, 2015

By default, Citrix Profile management is installed silently on master images when you install the Virtual Delivery Agent, but you do not have to use Profile management as a profile solution.

To suit your users' varying needs, you can use XenApp and XenDesktop policies to apply different profile behavior to the machines in each Delivery Group. For example, one Delivery Group might require Citrix mandatory profiles, whose template is stored in one network location, while another Delivery Group requires Citrix roaming profiles stored in another location with several redirected folders.

- If other administrators in your organization are responsible for XenApp and XenDesktop policies, work with them to ensure that they set any profile-related policies across your Delivery Groups.
- Profile management policies can also be set in Group Policy, in the Profile management .ini file, and locally on individual virtual machines. These multiple ways of defining profile behavior are read in the following order:
  1. Group Policy (.adm or .admx files)
  2. XenApp and XenDesktop policies in the Policy node
  3. Local policies on the virtual machine that the user connects to
  4. Profile management .ini file

  For example, if you configure the same policy in both Group Policy and the Policy node, the system reads the policy setting in Group Policy and ignores the XenApp and XenDesktop policy setting.

Whichever profile solution you choose, Director administrators can access diagnostic information and troubleshoot user profiles. For more information, see the Director documentation.

If you use the Personal vDisk feature, Citrix user profiles are stored on virtual desktops' Personal vDisks by default. Do not delete the copy of a profile in the user store while a copy remains on the Personal vDisk. Doing so creates a Profile management error, and causes a temporary profile to be used for logons to the virtual desktop.

The desktop type is automatically detected, based on the Virtual Delivery Agent installation and, in addition to the configuration choices you make in Studio, sets Profile management defaults accordingly.

The policies that Profile management adjusts are shown in the table below. Any non-default policy settings are preserved and are not overwritten by this feature. Consult the Profile management documentation for information about each policy. The types of machines that create profiles affect the policies that are adjusted. The primary factors are whether machines are persistent or provisioned, and whether they are shared by multiple users or dedicated to just one user.

Persistent systems have some type of local storage, the contents of which can be expected to persist when the system turns off. Persistent systems may employ storage technology such as storage area networks (SANs) to provide local disk mimicking. In contrast, provisioned systems are created "on the fly" from a base disk and some type of identity disk. Local storage is usually mimicked by a RAM disk or network disk, the latter often provided by a SAN with a high speed link. The provisioning technology is generally Provisioning Services or Machine Creation Services (or a third-party equivalent). Sometimes provisioned systems have persistent local storage, which may be provided by Personal vDisks; these are classed as persistent.

Together, these two factors define the following machine types:

- **Both persistent and dedicated** -- Examples are Desktop OS machines with a static assignment and a Personal vDisk

https://docs.citrix.com © 1999-2017 Citrix Systems, Inc. All rights reserved. p.604
that are created with Machine Creation Services, desktops with Personal vDisks that are created with VDI-in-a-Box, physical workstations, and laptops

- **Both persistent and shared** -- Examples are Server OS machines that are created with Machine Creation Services
- **Both provisioned and dedicated** -- Examples are Desktop OS machines with a static assignment but without a Personal vDisk that are created with Provisioning Services
- **Both provisioned and shared** -- Examples are Desktop OS machines with a random assignment that are created with Provisioning Services and desktops without Personal vDisks that are created with VDI-in-a-Box

The following Profile management policy settings are suggested guidelines for the different machine types. They work well in most cases, but you may want to deviate from these as your deployment requires.

Important: Delete locally cached profiles on logoff, Profile streaming, and Always cache are enforced by the auto-configuration feature. Adjust the other policies manually.

**Persistent machines**

<table>
<thead>
<tr>
<th>Policy</th>
<th>Both persistent and dedicated</th>
<th>Both persistent and shared</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete locally cached profiles on logoff</td>
<td>Disabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Profile streaming</td>
<td>Disabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Always cache</td>
<td>Enabled (note 1)</td>
<td>Disabled (note 2)</td>
</tr>
<tr>
<td>Active write back</td>
<td>Disabled</td>
<td>Disabled (note 3)</td>
</tr>
<tr>
<td>Process logons of local administrators</td>
<td>Enabled</td>
<td>Disabled (note 4)</td>
</tr>
</tbody>
</table>

**Provisioned machines**

<table>
<thead>
<tr>
<th>Policy</th>
<th>Both provisioned and dedicated</th>
<th>Both provisioned and shared</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete locally cached profiles on logoff</td>
<td>Disabled (note 5)</td>
<td>Enabled</td>
</tr>
<tr>
<td>Profile streaming</td>
<td>Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Always cache</td>
<td>Disabled (note 6)</td>
<td>Disabled</td>
</tr>
<tr>
<td>Active write back</td>
<td>Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Process logons of local administrators</td>
<td>Enabled</td>
<td>Enabled (note 7)</td>
</tr>
</tbody>
</table>
1. Because Profile streaming is disabled for this machine type, the Always cache setting is always ignored.
2. Disable Always cache. However, you can ensure that large files are loaded into profiles as soon as possible after logon by enabling this policy and using it to define a file size limit (in MB). Any file this size or larger is cached locally as soon as possible.
3. Disable Active write back except to save changes in profiles of users who roam between XenApp servers. In this case, enable this policy.
4. Disable Process logons of local administrators except for Hosted Shared Desktops. In this case, enable this policy.
5. Disable Delete locally cached profiles on logoff. This retains locally cached profiles. Because the machines are reset at logoff but are assigned to individual users, logons are faster if their profiles are cached.
6. Disable Always cache. However, you can ensure that large files are loaded into profiles as soon as possible after logon by enabling this policy and using it to define a file size limit (in MB). Any file this size or larger is cached locally as soon as possible.
7. Enable Process logons of local administrators except for profiles of users who roam between XenApp and XenDesktop servers. In this case, disable this policy.

Folder redirection lets you store user data on network shares other than the location where the profiles are stored. This reduces profile size and load time but it might impact network bandwidth. Folder redirection does not require that Citrix user profiles are employed. You can choose to manage user profiles on your own, and still redirect folders.

Configure folder redirection using Citrix policies in Studio.
- Ensure that the network locations used to store the contents of redirected folders are available and have the correct permissions. The location properties are validated.
- Redirected folders are set up on the network and their contents populated from users' virtual desktops at logon.

Note: Configure folder redirection using only Citrix Policies or Active Directory Group Policy Objects, not both. Configuring folder redirection using both policy engines may result in unpredictable behavior.

In deployments with multiple operating systems (OSs), you might want some of a user's profile to be shared by each OS. The rest of the profile is not shared and is used only by one OS. To ensure a consistent user experience across the OSs, you need a different configuration for each OS. This is advanced folder redirection. For example, different versions of an application running on two OSs might need to read or edit a shared file, so you decide to redirect it to a single network location where both versions can access it. Alternatively, because the Start Menu folder contents are structured differently in two OSs, you decide to redirect only one folder, not both. This separates the Start Menu folder and its contents on each OS, ensuring a consistent experience for users.

If your deployment requires advanced folder redirection, you must understand the structure of your users' profile data and determine which parts of it can be shared between OSs. This is important because unpredictable behavior can result unless folder redirection is used correctly.

To redirect folders in advanced deployments:
- Use a separate Delivery Group for each OS.
- Understand where your virtual applications, including those on virtual desktops, store user data and settings, and understand how the data is structured.
- For shared profile data that can safely roam (because it is structured identically in each OS), redirect the containing folders in each Delivery Group.
- For non-shared profile data that cannot roam, redirect the containing folder in only one of the Desktop Groups. Typically
the one with the most used OS or the one where the data is most relevant. Alternatively, for non-shared data that cannot roam between OSs, redirect the containing folders on both systems to separate network locations.

**Example advanced deployment** - This deployment has applications, including versions of Microsoft Outlook and Internet Explorer, running on Windows 8 desktops and applications, including other versions of Outlook and Internet Explorer, delivered by Windows Server 2008. To achieve this, you have already set up two Delivery Groups for the two OSs. Users want to access the same set of Contacts and Favorites in both versions of those two applications.

Important: The following decisions and advice are valid for the OSs and deployment described. In your organization, the folders you choose to redirect and whether you decide to share them depend on a number of factors that are unique to your specific deployment.

- Using policies applied to the Delivery Groups, you choose the following folders to redirect.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Redirected in Windows 8?</th>
<th>Redirected in Windows Server 2008?</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Documents</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Application Data</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Contacts</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Desktop</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Downloads</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Favorites</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Links</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>My Music</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>My Pictures</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>My Videos</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Searches</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Saved Games</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Start Menu</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

- For the shared, redirected folders:
- After analyzing the structure of the data saved by the different versions of Outlook and Internet Explorer, you decide
it is safe to share the Contacts and Favorites folders

- You know the structure of the My Documents, My Music, My Pictures, and My Videos folders is standard across OSs, so it is safe to store these in the same network location for each Delivery Group
- For the non-shared, redirected folders:
  - You do not redirect the Desktop, Links, Searches, or Start Menu folders folder in the Windows Server Delivery Group because data in these folders is organized differently in the two OSs. It therefore cannot be shared.
  - To ensure predictable behavior of this non-shared data, you redirect it only in the Windows 8 Delivery Group. You choose this, rather than the Windows Server Delivery Group, because Windows 8 will be used more often by users in their day-to-day work; they will only occasionally access the applications delivered by the server. Also, in this case the non-shared data is more relevant to a desktop environment rather than an application environment. For example, desktop shortcuts are stored in the Desktop folder and might be useful if they originate from a Windows 8 machine but not from a Windows Server machine.
- For the non-redirected folders:
  - You do not want to clutter your servers with users' downloaded files, so you choose not to redirect the Downloads folder
  - Data from individual applications can cause compatibility and performance issues, so you decide not to redirect the Application Data folder


In Citrix Profile management (but not in Studio), a performance enhancement allows you to prevent folders from being processed using exclusions. If you use this feature, do not exclude any redirected folders. The folder redirection and exclusion features work together, so ensuring no redirected folders are excluded allows Profile management to move them back into the profile folder structure again, while preserving data integrity, if you later decide not to redirect them. For more information on exclusions, see To include and exclude items.
Citrix Insight Services

Aug 31, 2016

Citrix Insight Services (CIS) is the Citrix flagship platform for diagnostics and troubleshooting. It enables technical users (customers, partners, and engineers) to self-diagnose and fix problems and optimize their environments. For details and the latest information about CIS and how it works, see https://cis.citrix.com (Citrix account credentials required).

This XenApp and XenDesktop release supports the following CIS tools and technologies.

Citrix Customer Experience Improvement Program (CEIP)

When you opt in to CEIP, anonymous statistics and usage information are sent to Citrix to help Citrix improve the quality and performance of Citrix products. For details, see http://more.citrix.com/XD-CEIP.

You can opt in to CEIP when you perform the following tasks. This is not a comprehensive list; the opportunities to opt in continue to grow.

- Create a XenApp or XenDesktop Site.
- Upgrade a XenApp or XenDesktop Site.
- Install the Universal Print Server UpsServer component on print servers from the command line.
- Install the Session Recording Server.

Call Home Technology Preview

Citrix Call Home performs periodic collection of your system and product configuration, plus performance, error, and other information. This information is then sent to CIS for Citrix support and product teams to resolve issues proactively.

For the latest Call Home information, see the following (Citrix account credentials required):

- About: https://www.citrix.com/community/cx/call-home.html
Monitor

Apr 24, 2015

Administrators and help-desk personnel can monitor XenApp and XenDesktop Sites using a variety of features and tools. Using these tools, you can monitor:

- User sessions and session use
- Logon performance
- Connections and machines, including failures
- Load evaluation
- Historical trends
- Infrastructure

**Citrix Director**

Director is a real-time web tool you can use to monitor, troubleshoot, and perform support tasks for end users. For details, see the Director articles.

**Session Recording**

Session Recording allows you to record the on-screen activity of any user's session, over any type of connection, from any server running XenApp subject to corporate policy and regulatory compliance. Session Recording records, catalogs, and archives sessions for retrieval and playback.

Session Recording uses flexible policies to trigger recordings of application sessions automatically. This enables IT to monitor and examine user activity of applications — such as financial operations and healthcare patient information systems — supporting internal controls for regulatory compliance and security monitoring. Similarly, Session Recording also aids in technical support by speeding problem identification and time-to-resolution.

For details, see the Session Recording articles.

**Configuration Logging**

Configuration Logging is a feature that allows administrators to keep track of administrative changes to a Site. Configuration Logging can help administrators diagnose and troubleshoot problems after configuration changes are made, assist change management and track configurations, and report administration activity.

You can view and generate reports about logged information from Studio. You can also view logged items in Director with the Trend View interface to provide notifications of configuration changes. This feature is useful for administrators who do not have access to Studio.

The Trends View gives historical data of configuration changes over a period of time so administrators can assess what changes were made to the Site, when they were made, and who made them to find the cause of an issue. This view sorts configuration information into three categories:

- Connection Failures
- Failed Desktop Machines
- Failed Server Machines
For details about how to enable and configure Configuration Logging, see the Configuration Logging article. The Director articles describe how to view logged information from that tool.

**Monitor Service API using the OData protocol**

Administrators can use the Site's Monitor Service API to search historical data using the OData protocol. This allows IT to analyze historical trends for planning purposes, to perform detailed troubleshooting of connection and machine failures, and extract information for feeding into other tools and processes.

The Monitor Service schema provides the following types of data:

- Data relating to connection failures
- Machines in a failure state
- Session usage
- Logon duration
- Load balancing data

For details, see the Monitor Service OData API articles.

**Personal vDisk diagnostic tool**

Use the PvD diagnostic tool to monitor changes made by users to the user and application parts of their personal vDisks, such as applications they have installed and files they have modified.

For details, see the Personal vDisk monitoring article.
Session Recording

Mar 24, 2016

Session Recording allows you to record the on-screen activity of any user session hosted from a Server OS VDI machine, over any type of connection, subject to corporate policy and regulatory compliance. Session Recording records, catalogs, and archives sessions for retrieval and playback.

Session Recording uses flexible policies to trigger recordings of application sessions automatically. This enables IT to monitor and examine user activity of applications - such as financial operations and healthcare patient information systems - supporting internal controls for regulatory compliance and security monitoring. Similarly, Session Recording also aids in technical support by speeding problem identification and time-to-resolution.

Enhanced security through logging and monitoring. Session Recording allows organizations to record on-screen user activity for applications that deal with sensitive information. This is especially critical in regulated industries such as healthcare and finance. Where personal information that must not be recorded is involved, policy controls allow selective recording.

Powerful activity monitoring. Session Recording captures and archives screen updates, including mouse activity and the visible output of keystrokes in secured video recordings to provide a record of activity for specific users, applications, and servers.

Session Recording is not designed or intended to contribute to the collection of evidence for legal proceedings. Citrix recommends that organizations using Session Recording use other techniques for evidence collection, such as conventional video records combined with traditional text-based eDiscovery tools.

Faster problem resolution. When users call with a problem that is hard to reproduce, help desk support staff can enable recording of user sessions. When the issue recurs, Session Recording provides a time-stamped visual record of the error, which can then be used for faster troubleshooting.
Get started with Session Recording

Mar 16, 2016

After you perform the following steps, you can begin recording and reviewing XenApp and XenDesktop sessions.

1. Become familiar with the Session Recording components.
2. Select the deployment scenario for your environment.
3. Verify the installation requirements.
4. Install the Windows roles and features prerequisites.
5. Install Session Recording.
6. Configure the Session Recording components to permit recording and viewing of sessions.

Session Recording consists of five components:

- **Session Recording Agent**. A component installed on each Server OS and VDI machine to enable recording. It is responsible for recording session data.
- **Session Recording Server**. A server that hosts:
  - The Broker. An IIS 6.0+ hosted Web application that handles the search queries and file download requests from the Session Recording Player, handles policy administration requests from the Session Recording Policy Console, and evaluates recording policies for each XenApp and XenDesktop session.
  - The Storage Manager. A Windows service that manages the recorded session files received from each Session Recording-enabled computer running XenApp and XenDesktop.
- **Session Recording Player**. A user interface that users access from a workstation to play recorded XenApp and XenDesktop session files.
- **Session Recording Database**. A component that manages the SQL Server database for storing recorded session data. When this component is installed, it creates a database named CitrixSessionRecording. You cannot change the name.
- **Session Recording Policy Console**. A console used to create policies to specify which sessions are recorded.

This illustration shows the Session Recording components and their relationship with each other:

In the deployment example illustrated here, the Session Recording Agent, Session Recording Server, Session Recording Database, Session Recording Policy Console, and Session Recording Player all reside behind a security firewall. The Session Recording Agent is installed on a Server OS machine. A second server hosts the Session Recording Policy Console, a third server acts as the Session Recording Server, and a fourth server hosts the Session Recording Database. The Session Recording Player is installed on a workstation. A client device outside the firewall communicates with the Server OS machine on which the Session Recording Agent is installed. Inside the firewall, the Session Recording Agent, Session Recording Policy Console, Session Recording Player, and Session Recording Database all communicate with the Session Recording Server.
Plan your deployment

Mar 02, 2016

Session Recording does not support Desktop Composition Redirection (DCR) display mode. By default Session Recording disables DCR in a session if the session is to be recorded by recording policy. You can configure this behavior in Session Recording Agent properties.

Depending upon your environment, you can deploy the Session Recording components in different scenarios.

A Session Recording deployment does not have to be limited to a single site. With the exception of the Session Recording Agent, all components are independent of the server site. For example, you can configure multiple sites to use a single Session Recording Server.

Alternatively, if you have a large site with many agents and plan to record many graphically intense applications (for example, AutoCAD applications), or you have many sessions to record, a Session Recording Server can experience a high performance demand. To alleviate performance issues, you can install multiple Session Recording Servers on different computers and point the Session Recording Agents to the different computers. Keep in mind that an agent can point to only one server at a time.

These are the two suggested configurations for a Session Recording deployment:

- Deploy the Session Recording Agent on single Server OS machine.
- Deploy the Session Recording Agent on multiple Server OS or workstation OS machines on a site.

Server site deployment

Use this type of deployment for recording sessions for one or more sites. The Session Recording Agent is installed on each Server OS machine in a site. The site resides in a data center behind a security firewall. The Session Recording Administration components (Session Recording Database, Session Recording Server, Session Recording Policy Console) are installed on other servers and the Session Recording Player is installed on a workstation, all behind the firewall but not in the data center. Outside the firewall, in an unsecured network environment, are XenApp clients, such as a workstation, mobile devices, and a laptop computer.
To enable Session Recording components to communicate with each other, ensure you install them in the same domain or across trusted domains that have a transitive trust relationship. The system cannot be installed into a workgroup or across domains that have an external trust relationship.

Session Recording does not support the clustering of two or more Session Recording Servers in a deployment.

Due to its intense graphical nature and memory usage when playing back large recordings, Citrix does not recommend installing the Session Recording Player as a published application.

The Session Recording installation is configured for TLS/HTTPS communication. Ensure that you install a certificate on the Session Recording Server and that the root certificate authority (CA) is trusted on the Session Recording components.

If you install the Session Recording Database on a stand-alone server running SQL Server 2014 Express Edition, SQL Server 2012 Express Edition, or SQL Server 2008 R2 Express Edition, the server must have TCP/IP protocol enabled and SQL Server Browser service running. These settings are disabled by default, but they must be enabled for the Session Recording Server to communicate with the database. See the Microsoft documentation for information about enabling these settings.

Consider the effects of session sharing when planning your Session Recording deployment. Session sharing for published applications can conflict with Session Recording recording policy rules for published applications. Session Recording matches the active policy with the first published application that a user opens. After the user opens the first application, any subsequent applications opened during the same session continue to follow the policy that is in force for the first application. For example, if a policy states that only Microsoft Outlook should be recorded, the recording commences when the user opens Outlook. However, if the user opens a published Microsoft Word second (while Outlook is running), Word also is recorded. Conversely, if the active policy does not specify that Word should be recorded, and the user launches Word before Outlook (which should be recorded, according to the policy), Outlook is not recorded.

Though you can install the Session Recording Server on a Delivery Controller, Citrix does not recommend you do so because of performance issues.

You can install the Session Recording Policy console on a Delivery Controller.

You can install both the Session Recording Server and Session Recording Policy console on the same system.
Security recommendations

Nov 30, 2016
Session Recording is designed to be deployed within a secure network and accessed by administrators, and as such, is secure. Out-of-the-box deployment is designed to be simple and security features such as digital signing and encryption can be configured optionally.

Communication between Session Recording components is achieved through Internet Information Services (IIS) and Microsoft Message Queuing (MSMQ). IIS provides the web services communication link between each Session Recording component. MSMQ provides a reliable data transport mechanism for sending recorded session data from the Session Recording Agent to the Session Recording Server.

Consider these security recommendations when planning your deployment:

- Ensure you properly isolate the different administrator roles in the corporate network, in the Session Recording system, or on individual machines. By not doing so, security threats that can impact the system functionality or abuse the system might occur. Citrix recommends that you assign different administrator roles to different persons or accounts that you do not allow general session users to have administrator privileges to the VDA system.
- XenApp and XenDesktop administrators should not grant VDA local admin role to any users of published apps or desktops. If the local admin role is a requirement, protect the Session Recording Agent components with Windows mechanisms or 3rd-party solutions.
- Separately assign the Session Recording database administrator and Session Recording policy administrator.
- Citrix recommends that you do not assign VDA administrator privileges to general session users, especially when using Remote PC Access.
- Session Recording Server local administration account must be strictly protected
- Control access to machines installed with Session Recording Player. If a user is not authorized as the Player role, do not grant that user local administrator role for any player machine. Disable anonymous access.
- Citrix recommends using a physical machine as a storage server for Session Recording.

- Session Recording records session graphics activities without regard to the sensitivity of the data. Under certain circumstances, sensitive data (including but not limited to user credentials, privacy information, and third-party screens) might be recorded unintentionally. Take the following measures to prevent risks:
  - Disable core memory dump for VDA machines unless for specific troubleshooting cases.
    To disable core memory dump:
    1. Right-click My Computer, and then click Properties.
    2. Click the Advanced tab, and then under Startup and Recovery, click Settings.
    3. Under Write Debugging Information, select (none).
    See the Microsoft article [https://support.microsoft.com/en-us/kb/307973](https://support.microsoft.com/en-us/kb/307973).
  - Ensure log on credentials or security information does not appear in all local and Web applications published or used inside the corporation or they are recorded by Session Recording.
  - Users should close any application that might expose sensitive information before switching to a remote ICA session.
+ Session owners should notify attendees that online meetings and remote assistance software might get recorded if a desktop session is being recorded.

+ Allow only automatic authentication methods (for example, single sign on, smartcard) for accessing published desktops or applications.

- Session Recording relies on certain hardware and hardware infrastructure (for example, corporate network devices, operation system) to function properly and to meet security needs. Take measures at the infrastructure levels to prevent damage or abuse to those infrastructures and make the Session Recording function secure and reliable.
- Properly protect and keep network infrastructure supporting Session Recording available.
- Citrix recommends using a 3rd-party security solution or Windows mechanism to protect Session Recording components. Session Recording components include:
  - On Session Recording Server
    - Processes: SsRecStoragemanager.exe and SsRecAnalyticsService.exe
    - Services: CitrixSsRecStorageManager and CitrixSsRecAnalyticsService
    - All files in Session Recording Server installation folder
    - Registry keys at HKLM\Software\Citrix\SmartAuditor\Server
  - On Session Recording Agent
    - Process: SsRecAgent.exe
    - Service: CitrixSmAudAgent
    - All files in Session Recording Agent installation folder
    - Registry keys at HKLM\Software\Citrix\SmartAuditor\Agent
  - Set the access control list (ACL) for Message Queuing (MSMQ) at Session Recording Server to restrict VDA or VDI machines that can send MSMQ data to the Session Recording Server and prevent unauthorized machines from sending data to the Session Recording Server.

    1) Install server feature Directory Service Integration on each Session Recording Server and VDA or VDI machine where Session Recording is enabled, and then restart the Message Queuing service.

    2) From the Windows Start menu on each Session Recording Server, open Administrative Tools > Computer Management.

    3) Open Services and Applications > Message Queuing > Private Queues.

    4) Click on the private queue citrixsmauddata to open the Properties page and select the Security tab.
5) Add the computers or security groups of the VDA machines that will send MSMQ data to this server and grant them Send Message permission.
Properly protect the event log for the Session Record Server and Session Recording Agents. Citrix recommends leveraging a Windows or 3rd-party remote logging solution to protect the event log or redirect the event log to the remote server.

Ensure servers running Session Recording components are physically secure. If possible, lock these computers in a secure room to which only authorized personnel can gain direct access.

Isolate servers running Session Recording components on a separate subnet or domain.

Protect the recorded session data from users accessing other servers by installing a firewall between the Session Recording Server and other servers.

Keep the Session Recording Admin Server and SQL database up to date with the latest security updates from Microsoft.

Restrict nonadministrators from logging on to the administration machine.

Strictly limit who is authorized to make recording policy changes and view recorded sessions.

Install digital certificates, use the Session Recording file signing feature, and set up TLS communications in IIS.

Set up MSMQ to use HTTPS as its transport by setting the MSMQ protocol listed in the Session Recording Agent Properties dialog box to HTTPS. For more information, see Troubleshoot MSMQ.

Use TLS 1.0 and disable SSLv2, SSLv3, and RC4 cipher on the Session Recording Server and Session Recording Database. For more information, see the Microsoft articles http://support.microsoft.com/default.aspx?scid=kb%3ben-us%3d187498 and http://support.microsoft.com/kb/245030/en-us.

Use playback protection. Playback protection is a Session Recording feature that encrypts recorded files before they are downloaded to the Session Recording Player. By default, this option is enabled and is in the Session Recording Server.
Properties.

- Follow NSIT guidance for cryptographic key lengths and cryptographic algorithms.

For information about configuring Session Recording features, see http://support.citrix.com/article/CTX200868.
Scalability considerations

Apr 23, 2015

Installing and running Session Recording requires few additional resources beyond what is necessary to run XenApp. However, if you plan to use Session Recording to record a large number of sessions or if the sessions you plan to record will result in large session files (for example, graphically intense applications), consider the performance of your system when planning your Session Recording deployment.

For more information about building a highly scalable Session Recording system, see http://support.citrix.com/article/CTX200869.

In this article:

Hardware recommendations
Disk and storage hardware
Network capacity
Computer processing capacity
Deploy multiple Session Recording servers
Database scalability

Consider how much data you will be sending to each Session Recording Server and how quickly the servers can process and store this data. The rate at which your system can store incoming data must be higher than the data input rate.

To estimate your data input rate, multiply the number of sessions recorded by the average size of each recorded session and divide by the period of time for which you are recording sessions. For example, you might record 5,000 Microsoft Outlook sessions of 20MB each over an 8-hour work day. In this case, the data input rate is approximately 3.5MBps. (5,000 sessions times 20MB divided by 8 hours, divided by 3,600 seconds per hour.)

You can improve performance by optimizing the performance of a single Session Recording Server or by installing multiple Session Recording Servers on different computers.

Disk and storage hardware are the most important factors to consider when planning a Session Recording deployment. The write performance of your storage solution is especially important. The faster data can be written to disk, the higher the performance of the system overall.

Storage solutions suitable for use with Session Recording include a set of local disks controlled as RAID arrays by a local disk controller or by an attached Storage Area Network (SAN).

Note: Session Recording should not be used with Network-Attached Storage (NAS), due to performance and security problems associated with writing recording data to a network drive. For a local drive set up, a disk controller with built-in cache memory enhances performance. A caching disk controller must have a battery backup facility to ensure data integrity in case of a power failure.
A 100Mbps network link is suitable for connecting a Session Recording Server. A gigabit Ethernet connection may improve performance, but does not result in 10 times greater performance than a 100Mbps link.

Ensure that network switches used by Session Recording are not shared with third-party applications that may compete for available network bandwidth. Ideally, network switches are dedicated for use with the Session Recording Server.

Consider the following specification for the computer on which a Session Recording Server is installed:

- A dual CPU or dual-core CPU is recommended
- 2GB to 4GB of RAM is recommended

Exceeding these specifications does not significantly improve performance.

If a single Session Recording Server does not meet your performance needs, you can install more Session Recording Servers on different machines. In this type of deployment, each Session Recording Server has its own dedicated storage, network switches, and database. To distribute the load, point the Session Recording Agents in your deployment to different Session Recording Servers.

The Session Recording Database requires Microsoft SQL Server 2014, Microsoft SQL Server 2012, or Microsoft SQL Server 2008 R2. The volume of data sent to the database is very small because the database stores only metadata about the recorded sessions. The files of the recorded sessions themselves are written to a separate disk. Typically, each recorded session requires only about 1KB of space in the database, unless the Session Recording Event API is used to insert searchable events into the session.

The Express Editions of Microsoft SQL Server 2014, Microsoft SQL Server 2012, and Microsoft SQL Server 2008 R2 impose a database size limitation of 10GB. At 1KB per recording session, the database can catalog about four million sessions. Other editions of Microsoft SQL Server have no database size restrictions and are limited only by available disk space. As the number of sessions in the database increases, performance of the database and speed of searches diminishes only negligibly.

If you are not making customizations through the Session Recording Event API, each recorded session generates four database transactions: two when recording starts, one when the user logs onto the session being recorded, and one when recording ends. If you used the Session Recording Event API to customize sessions, each searchable event recorded generates one transaction. Because even the most basic database deployment can handle hundreds of transactions per second, the processing load on the database is unlikely to be stressed. The impact is light enough that the Session Recording Database can run on the same SQL Server as other databases, including the XenApp or XenDesktop data store database.

If your Session Recording deployment requires many millions of recorded sessions to be cataloged in the database, follow Microsoft guidelines for SQL Server scalability.
Install Session Recording

Mar 14, 2016
This article contains these sections:

Installation checklist

Use a script to add Windows roles and features prerequisites
Install Session Recording Administration components
Install the Session Recording Database
Install the Session Recording Server
Configure Director to use the Session Recording Server
Install the Session Recording Agent
Install the Session Recording Player
Automating installations
Upgrade Session Recording
Uninstall Session Recording

Before you start the installation, complete this list:

<table>
<thead>
<tr>
<th>Step</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the prequisites before starting the installation. See System Requirements and Use a script to add Windows roles and features prerequisites.</td>
<td></td>
</tr>
<tr>
<td>Select the machines on which to install each Session Recording component and ensure that each computer meets the hardware and software requirements for the component or components to be installed on it.</td>
<td></td>
</tr>
</tbody>
</table>
If you use the SSL protocol for communication between the Session Recording components, install the correct certificates in your environment.

Install any hotfixes required for the Session Recording components. The hotfixes are available from the Citrix Support.

Configure Director to create and activate Session Recording policies. For more information, see Configure Director to use the Session Recording Server.

Notes:

- Citrix recommends dividing the published applications into separate Delivery Groups based on the recording policies, because session sharing for published applications can conflict with active policies if they are in the same Delivery Group. Session Recording matches the active policy with the first published application that a user opens.
- If you are planning to use Machine Creation Services (MCS) or Provisioning Services with XenApp, prepare the server for a unique QMId; see the description in Known issues. Failure to do this step might result in lost recording data.
- SQL server requires that TCP/IP is enabled, the SQL Server Browser service is running, and Windows Authentication is used.
- If you want to use HTTPS, configure server certificates for TLS/HTTPS.

Session Recording installation files:

- **Session Recording Administration files**
  - Broker_PowerShellSnapin_x64.msi
  - SessionRecordingAdministrationx64.msi

- **Session Recording Agent files**
  - SessionRecordingAgentx64.msi

- **Session Recording Player files**
  - SessionRecordingPlayer.msi

For Session Recording to work properly, you must add some Windows roles and features as prerequisites before installing the Session Recording components. Because you might have difficulty finding and installing some of the roles and features, this article contains a procedure using a Citrix-supplied script. Run the script to install the Windows roles and features prerequisites before the installation of Session Recording components.

To install Windows roles and features prerequisites

1. If you want to use the Citrix scripts, see Scripts for Windows roles and features prerequisites.
2. Do the following on the machine on which you plan to install Session Recording Administration components:
   a) Make sure the execution policy is set to RemoteSigned or Unrestricted in PowerShell.
      
      ```powershell
      Set-ExecutionPolicy RemoteSigned
      ```
   b) Start a command prompt as an administrator and run this command:
      
      ```powershell
      powershell.exe -file InstallPrereqsforSessionRecordingAdministration.ps1
      ```
The script displays the features that are successfully added and then stops.

c) After the scripts execute, ensure the execution policy is set to a proper value based on company policy.

3. Do the following on the machine on which you plan to install the Session Recording Agent component:
   a) Make sure the execution policy is set to RemoteSigned or Unrestricted in PowerShell.
      
      ```powershell
      Set-ExecutionPolicy RemoteSigned
      ```
   
   b) Start a command prompt as an administrator and run this command:
      
      ```powershell.exe -file InstallPrereqsforSessionRecordingAgent.ps1
      ```
      
      The script displays the features that are successfully added and then stops.
   
   c) After the scripts execute, ensure the execution policy is set to a proper value based on company policy.

4. After the Windows roles and features are installed, proceed with the Session Recording installation.

The Session Recording Administration components are the Session Recording Database, Session Recording Server, and the Session Recording Policy Console. You can choose which of these components to install on a server.

Before installing the Session Recording Administration components, ensure you have all the prerequisites installed. See Session Recording system requirements.

To improve security, you can remove these permissions after installing the database.

1. Run the Broker_PowerShellSnapIn_x64.msi and follow the instructions to complete the installation.
2. Start the Windows command prompt as Administrator, and then run the command `msiexec /i SessionRecordingAdministrationx64.msi` or double-click the .msi file.
3. On the installation UI, select Next and accept the license agreement.
4. On the Session Recording Administration Setup screen, select the Session Recording Administration components you want to install.

Before installing the Session Recording Database, ensure you have all the prerequisites installed. See Session Recording system requirements.

There are typically these three types of Session Recording Database component and Microsoft SQL Server deployments:

- **Deployment 1**: Install the Session Recording Server and Session Recording Database on the same server and the Microsoft SQL Server on a remote machine. **(Recommended)**
- **Deployment 2**: Install the Session Recording Server, Session Recording Database, and the Microsoft SQL Server on the same machine.
- **Deployment 3**: Install the Session Recording Server on a server and install both the Session Recording Database and Microsoft SQL Server on the same machine but different than the Session Recording Server machine. **(Not recommended)**

1. On the Database Configuration page:
Deployments 1 and 2: Type `localhost` in the Session Recording Server computer account field.

Deployment 3: Type the name of the computer hosting the Session Recording Server in the following format: `domain\computer-name`. The Session Recording Server computer account is the user account for accessing the database.

If the database instance is not a named instance as you configured when you set up the instance, you can use only the computer name of the SQL Server. If you have named the instance, use `computer-name\instance-name` as the database instance name. To determine the server instance name you are using, run `select @@servername` on the SQL Server; the return value is the exact database instance name.

Click **Test** to test the connection to the SQL Server. Make sure the current user has the public SQL Server role permission; otherwise the test fails for permission limitation. Then click **Next** to continue the installation.

2. Follow the instructions to complete the installation. During the installation, if the current user is not the database administrator, a dialog box prompts for the credentials of a database administrator with sysadmin server role permission. Enter the correct credentials and then click **OK** to continue the installation. The installation creates the new Session Recording Database and adds the machine account of the Session Recording Server as **db-owner**.

After the installation completes, the sysadmin server role permission is no longer necessary and can be safely removed for the current user.
Important
You cannot change the CitrixSessionRecording database name.

Before installing the Session Recording Server, ensure you have all the prerequisites installed. See Session Recording system requirements.

1. Enter the name of your SQL server in the Database Instance Name text box. If you are using a named instance, enter computer-name\instance-name; otherwise enter a computer-name only.
2. Click Test to test the connection to the SQL server. Make sure the current user has the public SQL Server role permission; otherwise the test fails for permission limitation. Then click Next to continue the installation and follow the instructions to complete the installation.
3. At the end of the installation wizard, you can choose to participate in the Citrix Customer Experience Improvement Program. When you join this program, anonymous statistics and usage information is sent to Citrix; for more information, see About the Citrix Customer Experience Improvement Program (CEIP).

You can use the Director console to create and activate Session Recording policies.

1. For an https connection, install the certificate to trust the Session Recording Server in the Trusted Root Certificates of the Director server.
2. To configure the Director server to use the Session Recording Server, run the command: C:\inetpub\wwwroot\Director\tools\DirectorConfig.exe /configsessionrecording
3. Enter the IP/FQDN of the Session Recording Server, the port number, and the connection type (http/https) from the Session Recording Agent to Session Recording Broker on the Director server.

The Session Recording Agent must be installed on the VDA or VDI machine on which you want to record sessions.

1. Use the Server Manager to install .NET Framework 3.5 and Microsoft Message Queuing (MSMQ) with HTTP support on the XenApp 7.8 Server OS VDA or the XenDesktop 7.8 VDI.
2. Start the Windows command prompt as Administrator, and then run the command: msiexec /i SessionRecordingAgentx64.msi
   or
   msiexec /i SessionRecordingAgent.msi

   or double click the .msi file.

   Use the correct .msi file based on platform type: SessionRecordingAgent.msi for 32 bit systems and SessionRecordingAgentx64.msi for 64 bit systems.
3. On the installation UI, select Next and accept the license agreement.
4. In the Session Recording Agent Configuration page, enter the name of the computer where you installed the Session Recording Server and the protocol and port information for the connection to the Session Recording Server.
The Session Recording default installation uses HTTPS/TLS to secure communications. If TLS is not configured, use HTTP. To do so, deselect SSL in the IIS Management Console by navigating to the Session Recording Broker site. Open the SSL settings and uncheck the Require SSL box.

5. Follow the instructions to complete the installation.

Install the Session Recording Player on the Session Recording Server or one or more workstations in the domain for users who view session recordings.

Run the SessionRecordingPlayer.msi and follow the instructions to complete the installation.

To install Session Recording Agent on multiple servers, write a script that uses silent installation.

The following command line installs the Session Recording Agent and creates a log file to capture the install information.

For 64 bit systems:
msiexec /i SessionRecordingAgentx64.msi
sessionrecordingservername=yourservername sessionrecordingbrokerprotoco=yourbrokerprotocol
sessionrecordingbrokerport=yourbrokerport /l*v yourinstallationlog /q

For 32 bit systems:

msiexec /i SessionRecordingAgent.msi sessionrecordingservername=yourservername
sessionrecordingbrokerprotoco=yourbrokerprotocol sessionrecordingbrokerport=yourbrokerport /l*v yourinstallationlog /q

where:

yourservername is the NetBIOS name or FQDN of the computer hosting the Session Recording Server. If not specified, this value defaults to localhost.

yourbrokerprotocol is either HTTP or HTTPS, and represents the protocol that Session Recording Agent uses to communicate with Session Recording Broker; this value defaults to HTTPS if not specified.

yourbrokerport is an integer representing the port Session Recording Agent uses to communicate with Session Recording Broker. If not specified, this value defaults to zero, which directs Session Recording Agent to use the default port number for the selected protocol: 80 for HTTP or 443 for HTTPS.

/l*v specifies verbose mode logging

yourinstallationlog is the location of the setup log file created.

/q specifies quiet mode.

You can upgrade certain deployments to newer versions without having to first set up new machines or sites. You can upgrade from Session Recording 7.6.0 (or a later version) to the latest released (current) Session Recording version.

Note: You cannot upgrade from a Technology Preview version.

- You must use Session Recording installer's graphical or command-line interface to upgrade Session Recording components on the machine where you installed corresponding Session Recording components.
- Before beginning any upgrade activity, back up the database named CitrixSessionRecording in the SQL Server instance, so you can restore it if any issues are discovered after the database upgrade.
- In addition to being a domain user, you must be a local administrator on the machines where you are upgrading the Session Recording components.
- If Session Recording Server and Session Recording Database are not installed on the same server, you must have the database sysadmin role permission to upgrade Session Recording Database; otherwise, you are asked for sysadmin role credentials during the upgrade.
- If you do not plan to upgrade all the Session Recording Agents at the same time, Session Recording Agent 7.6.0 (or a later version) can work with the latest released (current) Session Recording Server. However, some new features and bug fixes might not take effect.
- Any sessions launched during the upgrade of Session Recording Server are not recorded.
- If there are live recording sessions when the upgrade process starts, there is very small chance the recording cannot be completed.
Review the upgrade sequence below so you can plan and mitigate potential outages.

1. If Session Recording Database and Session Recording Server are installed on different servers, stop the Session Recording Storage Manager service manually on Session Recording Server, and then upgrade Session Recording Database first.
2. Ensure Session Recording Broker is running with IIS service. Upgrade Session Recording Server. If Session Recording Database and Session Recording Server are installed on the same server, Session Recording Database will also be upgraded.
3. Session Recording service is back online automatically when the upgrade of Session Recording Server is completed.
4. Upgrade Session Recording Agent (on master image).
5. Upgrade Session Recording Policy Console with or after Session Recording Server.
6. Upgrade Session Recording Player.

To remove Session Recording components from a server or workstation, use the uninstall or remove programs available through the Windows Control Panel. To remove the Session Recording Database, you must have the same sysadmin SQL server role permissions as when you installed it.
Scripts to add Windows roles and features prerequisites

Jan 25, 2016

You can use the following scripts to install Windows roles and features prerequisites that are required for Session Recording to work properly. For more information, see Use a script to add Windows roles and features prerequisites.

```powershell
<#
.Synopsis
Installs Prereqs for Session Recording Administration

.Description
Install below windows feature on this machine:
- Application Development - ASP.NET 4.5 on Server 2012 and Server 2012 R2, Application Development - ASP.NET on Server
- Security - Windows Authentication
- Management Tools - IIS 6 Management Compatibility
  IIS 6 Metabase Compatibility
  IIS 6 WMI Compatibility
  IIS 6 Scripting Tools
  IIS 6 Management Console
- Microsoft Message Queuing (MSMQ), with Active Directory integration disabled, and MSMQ HTTP support enabled.
#>

function AddFeatures($featurename)
{
    try
    {
        $feature=Get-WindowsFeature | ? {$_._DisplayName -eq $featurename -or $_.Name -eq $featurename}
```
Add-WindowsFeature $feature

}
catch
{
    Write-Host "Addition of Windows feature $featurename failed"
    Exit 1
}
Write-Host "Addition of Windows feature $featurename succeeded"

}$system= gwmi win32_operatingSystem | select name

if (-not (($system -Like '*Microsoft Windows Server 2012*') -or ($system -Like '*Microsoft Windows Server 2008 R2*')))
{
    Write-Host("This is not a supported server platform. Installation aborted.")
    Exit
}

# Start to install Windows feature
Import-Module ServerManager

if ($system -Like '*Microsoft Windows Server 2012*')
{
    AddFeatures('Web-Asp-Net45') #ASP.NET 4.5
}
if($system -like '*Microsoft Windows Server 2008 R2*')
.Synopsis
Installs Prereqs for Session Recording Administration

.Description

Install below windows feature on this machine:
- Microsoft Message Queuing (MSMQ), with Active Directory integration disabled, and MSMQ HTTP support enabled.

#>
function AddFeatures($featurename)
{
    try
    {
        $feature=Get-WindowsFeature | ? { $_.Display Name -eq $featurename -or $_.Name -eq $featurename }
        Add-WindowsFeature $feature
catch
{
    Write-Host "Addition of Windows feature $featurename failed"
    Exit 1
}

Write-Host "Addition of Windows feature $featurename succeeded"

# Start to install Windows feature

$system = gwmi win32_operatingSystem | select name

if (-not (($system -Like '*Microsoft Windows Server 2012*') -or ($system -Like '*Microsoft Windows Server 2008 R2*') -or ($system -Like '*Microsoft Windows 7*') -or ($system -Like '*Microsoft Windows 8*') -or ($system -Like '*Microsoft Windows 10*'))
{
    Write-Host("This is not a supported platform. Installation aborted.")
    Exit
}

if ($system -Like '*Microsoft Windows Server*')
{
    Import-Module ServerManager
    AddFeatures('MSMQ') #Message Queuing
    AddFeatures('MSMQ-HTTP-Support')#MSMQ HTTP Support
}
else
{

try
{
    if($system -Like "*Microsoft Windows 7*")
    {
        dism /online /enable-feature /featurename:MSMQ-Container
        dism /online /enable-feature /featurename:MSMQ-Server
        dism /online /enable-feature /featurename:MSMQ-HTTP
    }
    else
    {
        dism /online /enable-feature /featurename:MSMQ-HTTP /all
    }
}
catch
{
    Write-Host "Addition of Windows feature MSMQ HTTP Support failed"
    Exit 1
}
write-Host "Addition of Windows feature MSMQ HTTP Support succeeded"
Configure Session Recording

Sep 02, 2015

After you install the Session Recording components, perform these steps to configure Session Recording to record XenApp or XenDesktop sessions and allow users to view them:

- Authorize users to play recordings
- Authorize users to administer recording policies
- Set the active recording policy to one that records sessions
- Configure custom policies
- Configure Session Recording Player to connect to the Session Recording Server

Authorize users to play recorded sessions

When you install Session Recording, no users have permission to play recorded sessions. You must assign permission to each user, including the administrator. A user without permission to play recorded sessions receives the following error message when trying to play a recorded session:

1. Log on as administrator to the computer hosting the Session Recording Server.
2. Start the Session Recording Authorization Console.
3. In the Session Recording Authorization Console, select Player.
4. Add the users and groups you want to authorize to view recorded sessions and they will populate the right pane.

Authorize users to administer recording policies
When you install Session Recording, domain administrators grant permission to control the recording policies by default. You can change the authorization setting.

1. Log on as administrator to the machine hosting the Session Recording Server.
3. Add the users and groups who can administer recording policies.

Set the active recording policy to record sessions

The active recording policy specifies session recording behavior on all VDAs or VDIs that have Session Recording Agent installed and connected to the Session Recording Server. When you install Session Recording, the active recording policy is Do not record. Sessions cannot be recorded until you change the active recording policy.

**Important:** A policy can contain many rules, but there can be only one active policy running at a time.

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console.
3. If you are prompted by a Connect to Session Recording Server pop-up window, ensure that the name of the computer hosting the Session Recording Server, protocol, and port are correct.
4. In the Session Recording Policy Console, expand Recording Policies. This displays the recording policies available when you install Session Recording, with a check mark indicating which policy is active:
   - Do not record. This is the default policy. If you do not specify another policy, no sessions are recorded.
   - Record everyone with notification. If you choose this policy, all sessions are recorded. A pop-up window appears notifying the user that recording is occurring.
   - Record everyone without notification. If you choose this policy, all sessions are recorded. A pop-up window does not appear notifying the user that recording is occurring.
5. Select the policy you want to make the active policy.
6. From the menu bar, choose Action > Activate Policy.

**Note:** Session Recording allows you to create your own recording policy. When you create recording policies, they appear in the Recording Policies folder within the Session Recording Policy Console. The generic recording policy might not fit your requirements. You can configure policies and rules based on users, VDA and VDI servers, Delivery Groups, and applications. For more information about custom policies, see Create custom recording policies.

**Configure Session Recording Player**

Before a Session Recording Player can play sessions, you must configure it to connect to the Session Recording Server that stores the recorded sessions. Each Session Recording Player can be configured with the ability to connect to multiple Session Recording Servers, but can connect to only one Session Recording Server at a time. If the Player is configured with the ability to connect to multiple Session Recording Servers, users can change which Session Recording Server the Player...
connects to by selecting a check box on the **Connections** tab at **Tools > Options**.

1. Log on to the workstation where Session Recording Player is installed.
2. Start the Session Recording Player.
3. From the Session Recording Player menu bar, choose **Tools > Options**.
4. In the **Connections** tab, click Add.
5. In the **Hostname** field, type the name or Internet protocol (IP) address of the computer hosting the Session Recording Server and select the protocol. By default Session Recording is configured to use HTTPS/SSL to secure communications. If SSL is not configured, select HTTP.
6. If you want to configure the Session Recording Player with the ability to connect to more than one Session Recording Server, repeat Steps 4 and 5 for each Session Recording Server.
7. Ensure that the check box for the Session Recording Server you want to connect to is selected.

The connection between the Session Recording Agent and the Session Recording Server is typically configured when the Session Recording Agent is installed. To configure this connection after Session Recording Agent is installed, use Session Recording Agent Properties.

1. Log on to the server where Session Recording Agent is installed.
2. From the **Start** menu, choose **Session Recording Agent Properties**.
3. Click the **Connections** tab.
4. In the **Session Recording Server** field, type the server name or its Internet protocol (IP) address.
5. In the **Session Recording Storage Manager message queue** section, select the protocol that is used by the Session Recording Storage Manager to communicate and modify the default port number, if necessary.
6. In the **Message life** field, accept the default of 7200 seconds (two hours) or type a new value for the number of seconds each message is retained in the queue if there is a communication failure. After this period of time elapses, the message is deleted and the file is playable until the point where the data is lost.
7. In the **Session Recording Broker** section, select the communication protocol the Session Recording Broker uses to communicate and modify the default port number, if necessary.
8. When prompted, restart the **Session Recording Agent Service** to accept the changes.
Grant access rights to users

Feb 25, 2015

Note: For security reasons, grant users only the rights they need to perform specific functions, such as viewing recorded sessions.

You grant rights to Session Recording users by assigning them to roles using the Session Recording Authorization Console on the Session Recording Server. Session Recording users have three roles:

- **Player.** Grants the right to view recorded XenApp sessions. There is no default membership in this role.
- **PolicyQuery.** Allows the servers hosting the Session Recording Agent to request recording policy evaluations. By default, authenticated users are members of this role.
- **PolicyAdministrator.** Grants the right to view, create, edit, delete, and enable recording policies. By default, administrators of the computer hosting the Session Recording Server are members of this role.

Session Recording supports users and groups defined in Active Directory.

1. Log on to computer hosting the Session Recording Server, as administrator or as a member of the Policy Administrator role.
2. Start the Session Recording Authorization Console.
3. Select the role to which you want to assign users.
4. From the menu bar, choose Action > Assign Windows Users and Groups.
5. Add the users and groups.

Any changes made to the console take effect during the update that occurs once every minute.
Create and activate recording policies

Apr 23, 2015

Use the Session Recording Policy Console to create and activate policies that determine which sessions are recorded.

You can activate system policies available when Session Recording is installed or create and activate your own custom policies. Session Recording system policies apply a single rule to all users, published applications, and servers. Custom policies specifying which users, published applications, and servers are recorded.

The active policy determines which sessions are recorded. Only one policy is active at a time.

Use system policies

Session Recording provides these system policies:

- **Do not record.** If you choose this policy, no sessions are recorded. This is the default policy; if you do not specify another policy, no sessions are recorded.
- **Record everyone with notification.** If you choose this policy, all sessions are recorded. A pop-up window appears notifying the user that recording is occurring.
- **Record everyone without notification.** If you choose this policy, all sessions are recorded. A pop-up window does not appear notifying the user that recording is occurring.

System policies cannot be modified or deleted.

To activate a policy

1. Log on to the server where the Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console.
3. If you are prompted by a Connect to Session Recording Server pop-up window, ensure that the name of the Session Recording Server, protocol, and port are correct. Click OK.
4. In the Session Recording Policy Console, expand Recording Policies.
5. Select the policy you want to make the active policy.
6. From the menu bar, choose Action > Activate Policy.

Create custom recording policies

When you create your own policy, you make rules to specify which users and groups, published applications, and servers have their sessions recorded. A wizard within the Session Recording Policy Console helps you create rules. To obtain the list of published applications and servers, you must have the site administrator read permission. Configure that on this site's Delivery Controller.

For each rule you create, you specify a recording action and a rule criteria. The recording action applies to sessions that meet the rule criteria.

For each rule, choose one recording action:

- **Do not record.** (Choose Disable session recording within the rules wizard.) This recording action specifies that sessions that meet the rule criteria are not recorded.
- **Record with notification.** (Choose Enable session recording with notification within the rules wizard.) This recording action specifies that sessions that meet the rule criteria are recorded. A pop-up window appears notifying the user that
recording is occurring.

- Record without notification. (Choose Enable session recording without notification within the rules wizard.) This recording action specifies that sessions that meet the rule criteria are recorded. Users are unaware that they are being recorded.

For each rule, choose at least one of the following to create the rule criteria:

- Users or Groups. You create a list of users or groups to which the recording action of the rule applies.
- Published Resources. You create a list of published applications or desktops to which the recording action of the rule applies. Within the rules wizard, choose the XenApp/XenDesktop site or sites on which the applications or desktops are available.
- Delivery Groups or Machines. You create a list of Delivery Groups or machines to which the recording action of the rule applies. Within the rules wizard, choose the location where the Delivery Groups or machines reside.

When you create more than one rule in a recording policy, some sessions may match the criteria for more than one rule. In these cases, the rule with the highest priority is applied to the session.

The recording action of a rule determines its priority:

- Rules with the Do not record action have the highest priority
- Rules with the Record with notification action have the next highest priority
- Rules with the Record without notification action have the lowest priority

Some sessions may not meet any rule criteria in a recording policy. For these sessions, the recording action of the policies fallback rule applies. The recording action of the fallback rule is always Do not record. The fallback rule cannot be modified or deleted.

Configure custom policies

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console and select Recording Policies in the left pane and from the menu bar, choose Action > Add New Policy.
3. Right click the New policy and select Add Rule.
4. Select a recording option - In the Rules wizard, select Enable Session Recording with notification (or without notification), and then click Next.
5. Select the rule criteria - You can choose one or any combination of the three options:
   - Users or Groups
   - Published Resources
   - Delivery Groups or Machines
6. Edit the rule criteria - To edit, click the underlined values. The values are underlined based on the criteria you chose in the previous step.
7. Follow the wizard to finish the configuration.

Using Active Directory Groups

Session Recording allows you to use Active Directory groups when creating policies. Using Active Directory groups instead of individual users simplifies creation and management of rules and policies. For example, if users in your company's finance department are contained in an Active Directory group named Finance, you can create a rule that applies to all members of this group by selecting the Finance group within the rules wizard when creating the rule.
White Listing Users

You can create Session Recording policies that ensure that the sessions of some users in your organization are never recorded. This is called white listing these users. White listing is useful for users who handle privacy-related information or when your organization does not want to record the sessions of a certain class of employees.

For example, if all managers in your company are members of an Active Directory group named Executive, you can ensure that these users’ sessions are never recorded by creating a rule that disables session recording for the Executive group. While the policy containing this rule is active, no sessions of members of the Executive group are recorded. The sessions of other members of your organization are sessions recorded based on other rules in the active policy.

Create a new policy

Note: When using the rules wizard, you may be prompted to “click on underlined value to edit” when no underlined value appears. Underlined values appear only when applicable. If no underline values appear, ignore the step.
1. Log on to the server where Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console.
3. If you are prompted by a Connect to Session Recording Server pop-up window, ensure that the name of the Session Recording Server, protocol, and port are correct. Click OK.
4. In the Session Recording Policy Console, select Recording Policies.
5. From the menu, choose Add New Policy. A policy called New Policy appears in the left pane.
6. Right-click the new policy and choose Rename from the menu.
7. Type a name for the policy you are about to create and press Enter or click anywhere outside the new name.
8. Right-click the policy, choose Add New Rule from the menu to launch the rules wizard.
9. Follow the instructions to create the rules for this policy.

Modify a policy

1. Log on to the server where the Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console.
3. If you are prompted by a Connect to Session Recording Server pop-up window, ensure that the name of the Session Recording Server, protocol, and port are correct. Click OK.
4. In the Session Recording Policy Console, expand Recording Policies.
5. Select the policy you want to modify. The rules for the policy appear in the right pane.
6. Add a new rule, modify a rule, or delete a rule:
   - From the menu bar, choose Action > Add New Rule. If the policy is active, a pop-up window appears requesting confirmation of the action. Use the rules wizard to create a new rule.
   - Select the rule you want to modify, right-click, and choose Properties. Use the rules wizard to modify the rule.
   - Select the rule you want to delete, right-click, and choose Delete Rule.

Delete a policy

Note: You cannot delete a system policy or a policy that is active.
1. Log on to the server where the Session Recording Policy Console is installed.
2. Start the Session Recording Policy Console.
3. If you are prompted by a Connect to Session Recording Server pop-up window, ensure that the name of the Session Recording Server, protocol, and port are correct. Click OK.
4. In the Session Recording Policy Console, expand Recording Policies.
5. In the left pane, select the policy you want to delete. If the policy is active, you must activate another policy.
6. From the menu bar, choose Action > Delete Policy.
7. Select Yes to confirm the action.

Understanding rollover behavior

When you activate a policy, the previously active policy remains in effect until the user's session ends; however, in some cases, the new policy takes effect when the file rolls over. Files roll over when they have reached the maximum size limit. For information on maximum file sizes for recordings, see Specify file size for recordings.

The following table details what happens when you apply a new policy while a session is being recorded and a rollover occurs:

<table>
<thead>
<tr>
<th>If the previous policy was:</th>
<th>And the new policy is:</th>
<th>After a rollover the policy will be:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not record</td>
<td>Any other policy</td>
<td>No change. The new policy takes effect only when the user logs on to a new session.</td>
</tr>
<tr>
<td>Record without notification</td>
<td>Do not record</td>
<td>Recording stops.</td>
</tr>
<tr>
<td></td>
<td>Record with notification</td>
<td>Recording continues and a notification message appears.</td>
</tr>
<tr>
<td>Record with notification</td>
<td>Do not record</td>
<td>Recording stops.</td>
</tr>
<tr>
<td></td>
<td>Record without notification</td>
<td>Recording continues. No message appears the next time a user logs on.</td>
</tr>
</tbody>
</table>
Create notification messages

Feb 02, 2015

If the active recording policy specifies that users are notified when their sessions are recorded, a pop-up window appears displaying a notification message after users type their credentials. The following message is the default notification: “Your activity with one or more of the programs you recently started is being recorded. If you object to this condition, close the programs.” The user clicks OK to dismiss the window and continue the session.

The default notification message appears in the language of the operating system of the computers hosting the Session Recording Server.

You can create custom notifications in languages of your choice; however, you can have only one notification message for each language. Your users see the notification message in the language corresponding to their user preferred locale settings.

To create a new notification message

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Notifications tab.
4. Click Add.
5. Choose the language for the message and type the new message. You can create only one message for each language.

After accepting and activating, the new message appears in the Language-specific notification messages box.
Disable or enable recording

Mar 24, 2015

You install the Session Recording Agent on each Server OS machine for which you want to record sessions. Within each agent is a setting that enables recording for the server on which it is installed. After recording is enabled, Session Recording evaluates the active recording policy, which determines which sessions are recorded.

When you install the Session Recording Agent, recording is enabled. Citrix recommends that you disable Session Recording on servers that are not recorded because they experience a small impact on performance, even if no recording takes place.

To disable or enable recording on a server

1. Log on to the server where the Session Recording Agent is installed.
2. From the Start menu, choose Session Recording Agent Properties.
3. Under Session Recording, select or clear the Enable session recording for this Server OS VDA check box to specify whether or not sessions can be recorded for this server.
4. When prompted, restart the Session Recording Agent Service to accept the change.

Note: When you install Session Recording, the active policy is Do not record (no sessions are recorded on any server). To begin recording, use the Session Recording Policy Console to activate a different policy.

Enable custom event recording

Session Recording allows you to use third-party applications to insert custom data, known as events, into recorded sessions. These events appear when the session is viewed using the Session Recording Player. They are part of the recorded session file and cannot be modified after the session is recorded.

For example, an event might contain the following text: "User opened a browser." Each time a user opens a browser during a session that is being recorded, the text is inserted into the recording at that point. When the session is played using the Session Recording Player, the viewer can locate and count the times that the user opened a browser by noting the number of markers that appear in the Events and Bookmarks list in the Session Recording Player.

To insert custom events into recordings on a server:

- Use Session Recording Agent Properties to enable a setting on each server where you want to insert custom events. You must enable each server separately; you cannot globally enable all servers in a site.
- Write applications built on the Event API that runs within each user’s XenApp session (to inject the data into the recording).

The Session Recording installation includes an event recording COM application (API) that allows you to insert text from third-party applications into a recording. You can use the API from many programming languages including Visual Basic, C++, or C#. The Session Recording Event API .dll is installed as part of the Session Recording installation. You can find it at C:\Program Files\Citrix\SessionRecording\Agent\Bin\Interop.UserApi.dll.

To enable custom event recording on a server

1. Log on to the server where the Session Recording Agent is installed.
2. From the Start menu, choose Session Recording Agent Properties.
3. In Session Recording Agent Properties, click the Recording tab.
4. Under **Custom event recording**, select the **Allow third party applications to record custom data on this server** check box.
Enable or disable live session playback and playback protection

Feb 25, 2015
Enable or disable live session playback

Using Session Recording Player, you can view a session after or while it is being recorded. Viewing a session that is currently recording is similar to seeing actions happening live; however, there is actually a one to two second delay as the data propagates from the XenApp or XenDesktop server.

Some functionality is not available when viewing sessions that have not completed recording:

- A digital signature cannot be assigned until recording is complete. If digital signing is enabled, you can view live playback sessions, but they are not digitally signed and you cannot view certificates until the session is completed.
- Playback protection cannot be applied until recording is complete. If playback protection is enabled, you can view live playback sessions, but they are not encrypted until the session is completed.
- You cannot cache a file until recording is complete.

By default, live session playback is enabled.

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Allow live session playback check box.

Enable or disable playback protection

As a security precaution, Session Recording automatically encrypts recorded files before they are downloaded for viewing in the Session Recording Player. This playback protection prevents them from being copied and viewed by anyone other than the user who downloaded the file. The files cannot be played back on another workstation or by another user. Encrypted files are identified with an .icle extension; unencrypted files are identified with an .icl extension. The files remain encrypted while they reside in the cache on the workstation where the Session Recording Player is installed until they are opened by an authorized user.

Citrix recommends that you use HTTPS to protect the transfer of data.

By default, playback protection is enabled.

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Encrypt session recording files downloaded for playback check box.
Enable and disable digital signing

Feb 02, 2015

If you installed certificates on the computers on which the Session Recording components are installed, you can enhance the security of your Session Recording deployment by assigning digital signatures to session recording.

By default, digital signing is disabled. After you select the certificate to sign the recordings, Session Recording grants read permission to the Session Recording Storage Manger Service.

To enable digital signing

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Browse to the certificate that enables secure communication among the computers on which the Session Recording components are installed.

To disable digital signing

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Click Clear.
Specify where recordings are stored

Feb 03, 2015

Use Session Recording Server Properties to specify where recordings are stored and where archived recordings are restored.

Note: To archive files or restore deleted files, use the icldb command.

To specify the location for recorded files

By default, recordings are stored in the drive\SessionRecordings directory of the computer hosting the Session Recording Server. You can change the directory where the recordings are stored, add additional directories to load-balance across multiple volumes, or make use of additional space. Multiple directories in the list indicates recordings are load-balanced across the directories. You can add a directory multiple times. Load balancing cycles through the directories.

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Storage tab.
4. Use the File storage directories list to manage the directories where recordings are stored.

After you select the directories, Session Recording grants its service with Full Control permission to these directories.

You can create file storage directories on the local drive, the SAN volume, or a location specified by a UNC network path. Network mapped drive letters are not supported. Do not use Session Recording with Network-Attached Storage (NAS), due to serious performance and security problems associated with writing recording data to a network drive.

To specify a restore directory for archived files

By default, archived recordings are restored to the drive\SessionRecordingsRestore directory of the computer hosting the Session Recording Server. You can change the directory where the archived recordings are restored.

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Storage tab.
4. In the Restore directory for archived files field, type the directory for the restored archive files.
Specify file size for recordings

Feb 02, 2015

As recordings grow in size, the files can take longer to download and react more slowly when you use the seek slider to navigate during playback. To control file size, specify a threshold limit for a file. When the recording reaches this limit, Session Recording closes the file and opens a new one to continue recording. This action is called a rollover.

**Important:** The rollover setting does not apply to VDI desktop sessions for XenDesktop 7.8 and Session Recording Agent. In those cases, each recording file has a maximum size limit of 1GB and activities are not recorded after that limit is reached.

You can specify two thresholds for a rollover:

- **File size.** When the file reaches the specified number of megabytes, Session Recording closes the file and opens a new one. By default, files roll over after reaching 50 megabytes; however, you can specify a limit from 10 megabytes to one gigabyte.

- **Duration.** After the session records for the specified number of hours, the file is closed and a new file is opened. By default, files roll over after recording for 12 hours; however, you can specify a limit from one to 24 hours.

Session Recording checks both fields to determine which event occurs first to determine when to rollover. For example, if you specify 17MB for the file size and six hours for the duration and the recording reaches 17MB in three hours, Session Recording reacts to the 17MB file size to close the file and open a new one.

To prevent the creation of many small files, Session Recording does not rollover until at least one hour elapses (this is the minimum number that you can enter) regardless of the value specified for the file size. The exception to this rule is if the file size surpasses one gigabyte.

To specify a maximum limit for a file

1. Log on to the computer hosting the Session Recording Server.
2. From the Start menu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Rollover tab.
4. Enter an integer between 10 and 1024 to specify the maximum file size in megabytes.
5. Enter an integer between 1 and 24 to specify the maximum recording duration in hours.
View recordings

Feb 25, 2015

Use Session Recording Player to view, search, and bookmark recorded XenApp or XenDesktop sessions.

If sessions are recorded with the live playback feature enabled, you can view sessions that are in progress, with a delay of a few seconds, as well as sessions that are completed.

Sessions that have a longer duration or larger file size than the limits configured by your Session Recording administrator appear in more than one session file.

Note: A Session Recording administrator must grant users the right to access to recorded Server OS machine sessions. If you are denied access to viewing sessions, contact your Session Recording administrator.

When Session Recording Player is installed, the Session Recording administrator typically sets up a connection between the Session Recording Player and a Session Recording Server. If this connection is not set up, the first time you perform a search for files, you are prompted to set it up. Contact your Session Recording administrator for set up information.

To launch the Session Recording Player

1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
   The Session Recording Player appears.

This illustration shows the Session Recording Player with callouts indicating its major elements. The functions of these elements are described throughout following articles.

To display or hide window elements

The Session Recording Player has window elements that toggle on and off.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose View.
4. Choose the elements that you want to display. Selecting an element causes it to appear immediately. A check mark indicates that the element is selected.
To change Session Recording Servers

If the Session Recording administrator set up your Session Recording Player with the ability to connect to more than one Session Recording Server, you can select the Session Recording Server that the Session Recording Player connects to. The Session Recording Player can connect to only one Session Recording Server at a time.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Connections.
4. Select the Session Recording Server to which you want to connect.
Open and play recordings

Feb 04, 2015

You can open session recordings in Session Recording Player in three ways:

- Perform a search using the Session Recording Player. Recorded sessions that meet the search criteria appear in the search results area.
- Access recorded session files directly from your local disk drive or a share drive.
- Access recorded session files from a Favorites folder

When you open a file that was recorded without a digital signature, a warning appears telling you that the origin and integrity of the file was not verified. If you are confident of the integrity of the file, click Yes in the warning pop-up window to open the file.

To open and play a recording in the search results area

1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Perform a search.
4. If the search results area is not visible, select Search Results in the Workspace pane.
5. In the search results area, select the session you want to play.
6. Do any of the following:
   - Double-click the session
   - Right-click and select Play
   - From the Session Recording Player menu bar, select Play > Play

To open and play a recording by accessing the file

Recorded session file names begin with an _i_, followed by a unique alphanumeric file ID, followed by the .icl and .icle file extension: .icl for recordings without playback protection applied, .icle for recordings with playback protection applied. Session Recording saves recorded session files in a directory structure that incorporates the date the session was recorded. For example, the file for a session recorded on December 22, 2014, is saved in folder path 2014\12\22.

1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Do any of the following:
   - From the Session Recording Player menu bar, select File > Open and browse for the file
   - Using Windows Explorer, navigate to the file and drag the file into the Player window
   - Using Windows Explorer, navigate to and double-click the file
   - If you created Favorites in the Workspace pane, select Favorites and open the file from the Favorites area in the same way you open files from the search results area

Use favorites

Creating Favorites folders allows you to quickly access recordings that you view frequently. These Favorites folders reference recorded session files that are stored on your workstation or on a network drive. You can import and export these files to other workstations and share these folders with other Session Recording Player users.

Note: Only users with access rights to Session Recording Player can download the recorded session files associated with Favorites folders. Contact your Session Recording administrator for access rights.
To create a Favorites subfolder:

1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. In the Session Recording Player, select the Favorites folder in your Workspace pane.
4. From the menu bar, choose File > Folder > New Folder. A new folder appears under the Favorites folder.
5. Type the folder name, then press Enter or click anywhere to accept the new name.

Use the other options that appear in the File > Folder menu to delete, rename, move, copy, import, and export the folders.
Search for recorded sessions

Mar 24, 2015

Session Recording Player allows you to perform quick searches, perform advanced searches, and specify options that apply to all searches. Results of searches appear in the search results area of the Session Recording Player.

Note: To display all available recorded sessions, up to the maximum number of sessions that may appear in a search, perform a search without specifying any search parameters.

To perform a quick search

1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Define your search criteria:
   - Enter a search criterion in the Search field. To assist you:
   - Move the mouse pointer over the Search label to display a list of parameters to use as a guideline
   - Click the arrow to the right of the Search field to display the text for the last 64 searches you performed
   - Use the drop-down list to the right of the Search field to select a period or duration specifying when the session was recorded.
4. Click the binocular icon to the right of the drop-down list to start the search.

To perform an advanced search

Tip: Advanced searches might take up to 20 seconds to return results containing more than 150K entities. Citrix recommends using more accurate search conditions such as a date range or user to reduce the result number.

1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. In the Session Recording Player window, click Advanced Search on the tool bar or choose Tools > Advanced Search.
4. Define your search criteria in the tabs of the Advanced Search dialog box:
   - Common allows you to search by domain or account authority, site, group, Server OS machine, application, or file ID.
   - Date/Time allows you to search date, day of week, and time of day.
   - Events allows you to search on custom events that your Session Recording administrator inserted to the sessions.
   - Other allows you to search by session name, client name, client address, and recording duration. It also allows you to specify, for this search, the maximum number of search results displayed and whether or not archived files are included in the search.
   - As you specify search criteria, the query you are creating appears in the pane at the bottom of the dialog box.
5. Click Search to start the search.

Tip: You can save and retrieve advanced search queries. Click Save within the Advanced Search dialog box to save the current query. Click Open within the Advanced Search dialog box to retrieve a saved query. Queries are saved as files with an .isq extension.

To set search options

Session Recording Player search options allow you to limit maximum number of session recordings that appear in search results and to specify whether or not search results include archived session files.
1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Search.
4. In the Maximum result to display field, type the number of search results you want to display. A maximum of 500 results...
5. To set whether or not archived files are included in searches, select or clear Include archived files.

Can be displayed.
Play recorded sessions

Mar 23, 2015

After you open a recorded session in the Session Recording Player, you can navigate through the recorded sessions using these methods:

- Use the player controls to play, stop, pause, and increase or decrease playback speed
- Use the seek slider to move forward or backward

If you have inserted markers into the recording or if the recorded session contains custom events, you can also navigate through the recorded session by going to those markers and events.

Note:
- During playback of a recorded session, a second mouse pointer may appear. The second pointer appears at the point in the recording when the user navigated within Internet Explorer and clicked an image that was originally larger than the screen but was scaled down automatically by Internet Explorer. While only one pointer appears during the session, two may appear during playback.
- This version of Session Recording does not support SpeedScreen Multimedia Acceleration for XenApp or the Flash quality adjustment policy setting for XenApp. When this option is enabled, playback displays a black square.
- Session Recording cannot record the Lync webcam video when using the HDX RealTime Optimization Pack.

Use player controls

You can click the player controls under the Player window or access them by choosing Play from the Session Recording Player menu bar. Use Player controls to:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Play icon" /></td>
<td>Play the selected session file.</td>
</tr>
<tr>
<td><img src="image" alt="Pause icon" /></td>
<td>Pause playback.</td>
</tr>
<tr>
<td><img src="image" alt="Stop icon" /></td>
<td>Stop playback. If you click Stop, then Play, the recording restarts at the beginning of the file.</td>
</tr>
<tr>
<td><img src="image" alt="Slow down icon" /></td>
<td>Halve the current playback speed down to a minimum of one-quarter normal speed.</td>
</tr>
<tr>
<td><img src="image" alt="Fast forward icon" /></td>
<td>Double the current playback speed up to a maximum of 32 times normal speed.</td>
</tr>
</tbody>
</table>

Use the seek slider

Use the seek slider below the Player window to jump to a different position within the recorded session. You can drag the seek slider to the point in the recording you want to view or click anywhere on the slider bar to move to that location.

You can also use the following keyboard keys to control the seek slider:

<table>
<thead>
<tr>
<th>Key</th>
<th>Seek action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Seek to the beginning.</td>
</tr>
<tr>
<td>Key:</td>
<td>Seek action:</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>End</td>
<td>Seek to the end.</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Seek forward five seconds.</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Seek backward five seconds.</td>
</tr>
<tr>
<td>Move mouse wheel one notch down</td>
<td>Seek forward 15 seconds.</td>
</tr>
<tr>
<td>Move mouse wheel one notch up</td>
<td>Seek backward 15 seconds.</td>
</tr>
<tr>
<td>Ctrl + Right Arrow</td>
<td>Seek forward 30 seconds.</td>
</tr>
<tr>
<td>Ctrl + Left Arrow</td>
<td>Seek backward 30 seconds.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Seek forward one minute.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Seek backward one minute.</td>
</tr>
<tr>
<td>Ctrl + Move mouse wheel one notch down</td>
<td>Seek forward 90 seconds.</td>
</tr>
<tr>
<td>Ctrl + Move mouse wheel one notch up</td>
<td>Seek backward 90 seconds.</td>
</tr>
<tr>
<td>Ctrl + Page Down</td>
<td>Seek forward six minutes.</td>
</tr>
<tr>
<td>Ctrl + Page Up</td>
<td>Seek backward six minutes.</td>
</tr>
</tbody>
</table>

Note: To adjust the speed of the seek slider: From the Session Recording Player menu bar, choose Tools > Options > Player and drag the slider to increase or decrease the seek response time. A faster response time requires more memory. The response might be slow depending on the size of the recordings and your machine's hardware.

To change the playback speed:

You can set Session Recording Player to play recorded sessions in exponential increments from one-quarter normal playback speed to 32 times normal playback speed.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Play Speed.
4. Choose a speed option.

The speed adjusts immediately. A number indicating the increased or decreased speed appears below the Player window controls. Text indicating the exponential rate appears briefly in green in the Player window.
To skip over spaces where no action occurred

Fast review mode allows you to set Session Recording Player to skip the portions of recorded sessions in which no action takes place. This setting saves time for playback viewing; however, it does not skip animated sequences such as animated mouse pointers, flashing cursors, or displayed clocks with second hand movements.
1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Fast Review Mode.

The option toggles on and off. Each time you choose it, its status appears briefly in green in the Player window.
Use events and bookmarks

You can use events and bookmarks to help you navigate through recorded sessions.

Events are inserted into sessions as they are recorded, using the Event API and a third-party application. Events are saved as part of the session file. You cannot delete or alter them using the Session Recording Player.

Bookmarks are markers you insert into the recorded sessions using the Session Recording Player. Bookmarks are associated with the recorded session until you delete them, but they are not saved as part of the session file. By default, each bookmark is labeled with the text Bookmark, but you can change this to any text annotation up to 128 characters long.

Events and bookmarks appear as dots under the Player window. Events appear as yellow dots; bookmarks appear as blue dots. Moving the mouse over these dots displays the text label associated with them. You can also display the events and bookmarks in the events and bookmarks list of the Session Recording Player. They appear in this list with their text labels and the times in the recorded session at which they appear, in chronological order.

You can use events and bookmarks to help you navigate through recorded sessions. By going to an event or bookmark, you can skip to the point in the recorded session where the event or bookmark is inserted.

To display events and bookmarks in the list

The events and bookmarks list displays the events and bookmarks inserted in the recorded session that is currently playing. It can show events only, bookmarks only, or both.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Move the mouse pointer into the events and bookmarks list area and right-click to display the menu.
4. Choose Show Events Only, Show Bookmarks Only, or Show All.

To insert a bookmark

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Begin playing the recorded session to which you want to add a bookmark.
4. Move the seek slider to the position where you want to insert the bookmark.
5. Move the mouse pointer into the Player window area and right-click to display the menu.
6. Add a bookmark with the default label Bookmark or create an annotation:
   - To add a bookmark with the default label Bookmark, choose Add Bookmark.
   - To add a bookmark with a descriptive text label that you create, choose Add Annotation. Type the text label you want to assign to the bookmark, up to 128 characters. Click OK.

To add or change an annotation

After a bookmark is created, you can add an annotation to it or change its annotation.

1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the events and bookmarks list is displaying bookmarks.
5. Select the bookmark in the events and bookmarks list and right-click to display the menu.
6. Choose Edit Annotation.
7. In the window that appears, type the new annotation and click OK.

To delete a bookmark

1. Log on to the workstation where Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the events and bookmarks list is displaying bookmarks.
5. Select the bookmark in the events and bookmarks list and right-click to display the menu.
6. Choose Delete.

To go to an event or bookmark

Going to an event or bookmark causes the Session Recording Player to go to the point in the recorded session where the event or bookmark is inserted.
1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. Begin playing a session recording containing events or bookmarks.
4. Go to an event or bookmark:
   - In the area below the Player window, click the dot representing the event or bookmark to go to the event or bookmark.
   - In the events and bookmarks list, double-click the event or bookmark to go to it. To go to the next event or bookmark, select any event or bookmark from the list, right-click to display the menu, and choose Seek to Bookmark.
Change the playback display

Feb 02, 2015

Options allow you to change how recorded sessions appear in the Player window. You can pan and scale the image, show the playback in full-screen mode, display the Player window in a separate window, and display a red border around the recorded session to differentiate it from the Player window background.

To display the Player window in full-screen format

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose View > Player Full Screen.
4. To return to the original size, press ESC or F11.

To display the Player window in a separate window

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose View > Player in Separate Window. A new window appears containing the Player window. You can drag and resize the window.
4. To embed the Player window in the main window, choose View > Player in Separate Window, or press F10.

To scale the session playback to fit the Player window

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Panning and Scaling > Scale to Fit.
   - Scale to Fit (Fast Rendering) shrinks the image while providing a good quality image. Images are drawn quicker than when using the High Quality option but the images and text are not as sharp. Use this option if you are experiencing performance issues when using the High Quality mode.
   - Scale to Fit (High Quality) shrinks the image while providing high quality images and text. Using this option may cause the images to be drawn more slowly than the Fast Rendering option.

To pan the image

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Play > Panning and Scaling > Panning. The pointer changes to a hand and a small representation of the screen appears in the top right of the Player window.
4. Drag the image. The small representation indicates where you are in the image.
5. To stop panning, choose one of the scaling options.

To display a red border around the session recording

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Player.
4. Select the Show border around session recording check box.
   - Tip: If the Show border around session recording check box is not selected, you can temporarily view the red border by
clicking and holding down the left mouse button while the pointer is in the Player window.
Cache recorded session files

Feb 02, 2015

Each time you open a recorded session file, the Session Recording Player downloads the file from the location where the recordings are stored. If you download the same files frequently, you can save download time by caching the files on your workstation. Cached files are stored on your workstation in this folder:

userprofile\AppData\Local\Citrix\SessionRecording\Player\Cache

You can specify how much disk space is used for the cache. When the recordings fill the specified disk space, Session Recording deletes the oldest, least used recordings to make room for new recordings. You can empty the cache at any time to free up disk space.

To enable caching

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. If you want to limit the amount of disk space used for caching, select the Limit amount of disk space to use check box and specify the number of megabytes to be used for cache.
6. Click OK.

To empty cache

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Start menu, choose Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools > Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. In the Session Recording Player, choose Tools > Options > Cache.
6. Click Purge Cache, and then OK to confirm the action.
Troubleshooting Session Recording

Mar 24, 2015
This troubleshooting information contains solutions to some issues you might encounter during and after installing Session Recording components:

- Components failing to connect to each other
- Sessions failing to record
- Problems with the Session Recording Player or Session Recording Policy Console
- Issues involving your communication protocol

Session Recording Agent cannot connect

When Session Recording Agent cannot connect, the Exception caught while sending poll messages to Session Recording Broker event message is logged, followed by the exception text. The exception text provides the reason why the connection failed. These reasons include:

- The underlying connection was closed. Could not establish a trust relationship for the SSL/TLS secure channel. This exception means that the Session Recording Server is using a certificate that is signed by a CA that the server on which the Session Recording Agent resides does not trust, or have a CA certificate for. Alternatively, the certificate may have expired or been revoked.

  Resolution: Verify that the correct CA certificate is installed on the server hosting the Session Recording Agent or use a CA that is trusted.

- The remote server returned an error: (403) forbidden. This is a standard HTTPS error displayed when you attempt to connect using HTTP (nonsecure protocol). The computer hosting the Session Recording Server rejects the connection because it accepts only secure connections.

  Resolution: Use Session Recording Agent Properties to change the Session Recording Broker protocol to HTTPS.

- The Session Recording Broker returned an unknown error while evaluating a record policy query. Error code 5 (Access Denied). See the Event log on the Session Recording Server for more details. This error occurs when sessions are started and a request for a record policy evaluation is made. The error is a result of the Authenticated Users group (this is the default member) being removed from the PolicyQuery role of the Session Recording Authorization Console.

  Resolution: Add the Authenticated Users group back into this role, or add each server hosting each Session Recording Agent to the PolicyQuery role.

- The underlying connection was closed. A connection that was expected to be kept alive was closed by the server. This error means that the Session Recording Server is down or unavailable to accept requests. This could be due to IIS being offline or restarted, or the entire server may be offline.

  Resolution: Verify that the Session Recording Server is started, IIS is running on the server, and the server is connected to the network.

Installation of Session Recording Server components fails

The installation of the Session Recording Server components fails with error codes 2503 and 2502.

Resolution:
Check the access control list (ACL) of folder C:\windows\Temp to ensure the Local Users and Groups have write permission for this folder. If not, manually add write permission.

Session Recording Server cannot connect to the Session Recording Database

When the Session Recording Server cannot connect to the Session Recording Database, you may see a message similar to one of the following:

Event Source:

**A network-related or instance-specific error occurred while establishing a connection to SQL Server.** This error appears in the applications event log with ID 2047 in the Event Viewer of the computer hosting the Session Recording Server.

Citrix Session Recording Storage Manager Description: Exception caught while establishing database connection. This error appears in the applications event log in the Event Viewer of the computer hosting the Session Recording Server.

Unable to connect to the Session Recording Server. Ensure that the Session Recording Server is running. This error message appears when you launch the Session Recording Policy Console.

Resolution:

- The Express Edition of Microsoft SQL Server 2008 R2, Microsoft SQL Server 2012, or Microsoft SQL Server 2014 is installed on a stand-alone server and does not have the correct services or settings configured for Session Recording. The server must have TCP/IP protocol enabled and SQL Server Browser service running. See the Microsoft documentation for information about enabling these settings.
- During the Session Recording installation (administration portion), incorrect server and database information was given. Uninstall the Session Recording Database and reinstall it, supplying the correct information.
- The Session Recording Database Server is down. Verify that the server has connectivity.
- The computer hosting the Session Recording Server or the computer hosting the Session Recording Database Server cannot resolve the FQDN or NetBIOS name of the other. Use the ping command to verify the names can be resolved.
- Check the firewall configuration on the Session Recording Database to ensure the SQL Server connections are allowed. Refer to Microsoft article: https://msdn.microsoft.com/en-us/library/cc646023.aspx.

Logon failed for user 'NT_AUTHORITY\ANONYMOUS LOGON'. This error message means that the services are logged on incorrectly as .\administrator.

Resolution: Restart the services as local system user and restart the SQL services.

Sessions are not recording

If your application sessions are not recording successfully, start by checking the application event log in the Event Viewer on the Server OS machine running the Session Recording Agent and Session Recording Server. This may provide valuable diagnostic information.

If sessions are not recording, these issues might be the cause:

- **Component connectivity and certificates.** If the Session Recording components cannot communicate with each other, this can cause session recordings to fail. To troubleshoot recording issues, verify that all components are configured correctly to point to the correct computers and that all certificates are valid and correctly installed.
- **Non-Active Directory domain environments.** Session Recording is designed to run in a Microsoft Active Directory...
domain environment. If you are not running in an Active Directory environment, you may experience recording issues. Ensure that all Session Recording components are running on computers that are members of an Active Directory domain.

- **Session sharing conflicts with the active policy.** Session Recording matches the active policy with the first published application that a user opens. Subsequent applications opened during the same session continue to follow the policy that is in force for the first application. To prevent session sharing from conflicting with the active policy, publish the conflicting applications on separate Server OS machines.

- **Recording is not enabled.** By default, installing the Session Recording Agent on a Server OS machine enables the server for recording. Recording will not occur until an active recording policy is configured to allow this.

- **The active recording policy does not permit recording.** For a session to be recorded, the active recording policy must permit the sessions for the user, server, or published application to be recorded.

- **Session Recording services are not running.** For sessions to be recorded, the Session Recording Agent service must be running on the Server OS machine and the Session Recording Storage Manager service must be running on the computer hosting the Session Recording Server.

- **MSMQ is not configured.** If MSMQ is not correctly configured on the server running the Session Recording Agent and the computer hosting the Session Recording Server, recording problems may occur.

### Unable to view live session playback

If you experience difficulties when viewing recordings using the Session Recording Player, the following error message may appear on the screen:

```
Download of recorded session file failed. Live session playback is not permitted. The server has been configured to disallow this feature. This error indicates that the server is configured to disallow the action.
```

Resolution: In the Session Recording Server Properties dialog box, choose the Playback tab and select the Allow live session playback check box.

### Recordings are corrupt or incomplete

When recordings are becoming corrupted or incomplete when viewing them using the Session Recording Player, you might also see warnings in the Event logs on the Session Recording Agent.

**Event Source:** Citrix Session Recording Storage Manager

**Description:** Data lost while recording file <icl file name>

This usually happens when Machine Creation Services (MCS) or Provisioning Services is used to create VDAs with a configured master image and Microsoft Message Queuing (MSMQ) installed. In this condition the VDAs have the same QMIds for MSMQ.

Resolution: Create the unique QMId for each VDA. A workaround is introduced in [Known Issues](#).

### Test connection of the database instance failed when installing the Session Recording Database or Session Recording Server

When you install Session Recording Database or Session Recording Server, the test connection fails with the error message **Database connection test failed. Please correct Database instance name** even if the database instance name is correct.

Resolution: Make sure the current user has the public SQL Server role permission to correct the permission limitation failure.
Verify component connections

Apr 22, 2015

During the setup of Session Recording, the components may not connect to other components. All the components communicate with the Session Recording Server (Broker). By default, the Broker (an IIS component) is secured using the IIS default Web site certificate. If one component cannot connect to the Session Recording Server, the other components may also fail when attempting to connect.

The Session Recording Agent and Session Recording Server (Storage Manager and Broker) log connection errors in the applications event log in the Event Viewer of the computer hosting the Session Recording Server, while the Session Recording Policy Console and Session Recording Player display connection error messages on screen when they fail to connect.

Verify Session Recording Agent is connected

1. Log on to the server where the Session Recording Agent is installed.
2. From the Start menu, choose Session Recording Agent Properties.
3. In Session Recording Server Properties, click Connection.
4. Verify that the value for Session Recording Server is the correct server name of the computer hosting the Session Recording Server.
5. Verify that the server given as the value for Session Recording Server can be contacted by the Server OS machine.

Note: Check the application event log for errors and warnings.

Verify Session Recording Server is connected

Caution: Using Registry Editor can cause serious problems that can require you to reinstall the operating system. Citrix cannot guarantee that problems resulting from incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk.
1. Log on to the computer hosting the Session Recording Server.
2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
4. Verify the value of SmAudDatabaseInstance correctly references the Session Recording Database you installed in your SQL Server instance.

Verify Session Recording Database is connected

1. Using a SQL Management tool, open your SQL instance that contains the Session Recording Database you installed.
2. Open the Security permissions of the Session Recording Database.
3. Verify the Session Recording Computer Account has access to the database. For example, if the computer hosting the Session Recording Server is named SsRecSrv in the MIS domain, the computer account in your database should be configured as MIS\SsRecSrv$. This value is configured during the Session Recording Database installation.

Test IIS connectivity

Testing connections to the Session Recording Server IIS site by using a Web browser to access the Session Recording Broker Web page can help you determine whether problems with communication between Session Recording components stem from misconfigured protocol configuration, certification issues, or problems starting Session Recording Broker.

To verify IIS connectivity for the Session Recording Agent
1. Log on to the server where the Session Recording Agent is installed.
2. Launch a Web browser and type the following address:
   - For HTTPS: `https://servername/SessionRecordingBroker/RecordPolicy.rem?wsdl`, where `servername` is the name of the computer hosting the Session Recording Server
   - For HTTP: `http://servername/SessionRecordingBroker/RecordPolicy.rem?wsdl`, where `servername` is the name of the computer hosting the Session Recording Server
3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain administrator account.

If you see an XML document within your browser, this verifies that the computer running the Session Recording Agent is connected to the computer hosting the Session Recording Server using the configure protocol.

To verify IIS connectivity for the Session Recording Player

1. Log on to the workstation where the Session Recording Player is installed.
2. Launch a Web browser and type the following address:
   - For HTTPS: `https://servername/SessionRecordingBroker/Player.rem?wsdl`, where `servername` is the name of the computer hosting the Session Recording Server
   - For HTTP: `http://servername/SessionRecordingBroker/Player.rem?wsdl`, where `servername` is the name of the computer hosting the Session Recording Server
3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain administrator account.

If you see an XML document within your browser, this verifies that the computer running the Session Recording Player is connected to the computer hosting the Session Recording Server using the configure protocol.

To verify IIS connectivity for the Session Recording Policy Console

1. Log on to the server where the Session Recording Policy Console is installed.
2. Launch a Web browser and type the following address:
   - For HTTPS: `https://servername/SessionRecordingBroker/PolicyAdministration.rem?wsdl`, where `servername` is the name of the computer hosting the Session Recording Server
   - For HTTP: `http://servername/SessionRecordingBroker/PolicyAdministration.rem?wsdl`, where `servername` is the name of the computer hosting the Session Recording Server
3. If you are prompted for NT LAN Manager (NTLM) authentication, log on with a domain administrator account.

If you see an XML document within your browser, this verifies that the computer running the Session Recording Policy Console is connected to the computer hosting the Session Recording Server using the configure protocol.

Troubleshoot certificate issues

If you are using HTTPS as your communication protocol, the computer hosting the Session Recording Server must be configured with a server certificate. All component connections to the Session Recording Server must have root certificate authority (CA). Otherwise, attempted connections between the components fail.

You can test your certificates by accessing the Session Recording Broker Web page as you would when testing IIS connectivity. If you are able to access the XML page for each component, the certificates are configured correctly.

Here are some common ways certificate issues cause connections to fail:

- **Invalid or missing certificates.** If the server running the Session Recording Agent does not have a root certificate to trust the server certificate, cannot trust and connect to the Session Recording Server over HTTPS, causing connectivity to fail. Verify that all components trust the server certificate on the Session Recording Server.
- **Inconsistent naming.** If the server certificate assigned to the computer hosting the Session Recording Server is created
using a fully qualified domain name (FQDN), then all connecting components must use the FQDN when connecting to the Session Recording Server. If a NetBIOS name is used, configure the components with a NetBIOS name for the Session Recording Server.

- **Expired certificates.** If a server certificate expired, connectivity to the Session Recording Server through HTTPS fails. Verify the server certificate assigned to the computer hosting the Session Recording Server is valid and has not expired. If the same certificate is used for the digital signing of session recordings, the event log of the computer hosting the Session Recording Server provides error messages that the certificate expired or warning messages when it is about to expire.
Search for recordings if the Session Recording Player fails

Feb 04, 2015
If you experience difficulties when searching for recordings using the Session Recording Player, the following error messages may appear on the screen:

- Search for recorded session files failed. The remote server name could not be resolved: servername. Where servername is the name of the server to which the Session Recording Player is attempting to connect. The Session Recording Player cannot contact the Session Recording Server. Two possible reasons for this are an incorrectly typed server name or the DNS cannot resolve the server name.
  Resolution: From the Player menu bar, choose Tools > Options > Connections and verify that the server name in the Session Recording Servers list is correct. If it is correct, from a command prompt, run the ping command to see if the name can be resolved. When the Session Recording Server is down or offline, the search for recorded session files failed error message is Unable to contact the remote server.

- Unable to contact the remote server. This error occurs when the Session Recording Server is down or offline.
  Resolution: Verify that the Session Recording Server is connected.

- Access denied error. An access denied error can occur if the user was not given permission to search for and download recorded session files.
  Resolution: Assign the user to the Player role using the Session Recording Authorization Console.

- Search for recorded session files failed. The underlying connection was closed. Could not establish a trust relationship for the SSL/TLS secure channel. This exception is caused by the Session Recording Server using a certificate that is signed by a CA that the client device does not trust or have a CA certificate for.
  Resolution: Install the correct or trusted CA certificate workstation where the Session Recording Player is installed.

- The remote server returned an error: (403) forbidden. This error is a standard HTTPS error that occurs when you attempt to connect using HTTP (nonsecure protocol). The server rejects the connection because, by default, it is configured to accept only secure connections.
  Resolution: From the Session Recording Player menu bar, choose Tools > Options > Connections. Select the server from the Session Recordings Servers list, and then click Modify. Change the protocol from HTTP to HTTPS.

Troubleshoot MSMQ

If your users see the notification message but the viewer cannot find the recordings after performing a search in the Session Recording Player, there could be a problem with MSMQ. Verify that the queue is connected to the Session Recording Server (Storage Manager) and use a Web browser to test for connection errors (if you are using HTTP or HTTPS as your MSMQ communication protocol).

To verify that the queue is connected:

1. Log on to the server hosting the Session Recording Agent and view the outgoing queues.
2. Verify that the queue to the computer hosting the Session Recording Server has a connected state.
   - If the state is waiting to connect, there are a number of messages in the queue, and the protocol is HTTP or HTTPS (corresponding to the protocol selected in the Connections tab in the Session Recording Agent Properties dialog box), perform Step 3.
If the state is **connected** and there are no messages in the queue, there might be a problem with the server hosting the Session Recording Server. Skip Step 3 and perform Step 4.

3. If there are a number of messages in the queue, launch a Web browser and type the following address:
   - For HTTPS: **https://servername/msmq/private$/$CitrixSmAudData**, where *servername* is the name of the computer hosting the Session Recording Server
   - For HTTP: **http://servername/msmq/private$/$CitrixSmAudData**, where *servername* is the name of the computer hosting the Session Recording Server

   If the page returns an error such as The server only accepts secure connections, change the MSMQ protocol listed in the Session Recording Agent Properties dialog box to HTTPS. Otherwise, if the page reports a problem with the Web site security certificate, there may be a problem with a trust relationship for the TLS secure channel. In that case, install the correct CA certificate or use a CA that is trusted.

4. If there are no messages in the queue, log on to the computer hosting the Session Recording Server and view private queues. Select citrixsmauddata. If there are a number of messages in the queue (Number of Messages Column), verify that the Session Recording StorageManager service is started. If it is not, restart the service.
Change your communication protocol

Feb 03, 2015

For security reasons, Citrix does not recommend using HTTP as a communication protocol. The Session Recording installation is configured to use HTTPS. If you want to use HTTP instead of HTTPS, you must change several settings.

To use HTTP as the communication protocol

1. Log on to the computer hosting the Session Recording Server and disable secure connections for Session Recording Broker in IIS.
2. Change the protocol setting from HTTPS to HTTP in each Session Recording Agent Properties dialog box:
   1. Log on to each server where the Session Recording Agent is installed.
   2. From the Start menu, choose Session Recording Agent Properties.
   3. In Session Recording Agent Properties, choose the Connections tab.
   4. In the Session Recording Broker area, select HTTP from the Protocol drop-down list and choose OK to accept the change. If you are prompted to restart the service, choose Yes.
3. Change the protocol setting from HTTPS to HTTP in the Session Recording Player settings:
   1. Log on to each workstation where the Session Recording Player is installed.
   2. From the Start menu, choose Session Recording Player.
   3. From the Session Recording Player menu bar, choose Tools > Options > Connections, select the server, and choose Modify.
   4. Select HTTP from the Protocol drop-down list and click OK twice to accept the change and exit the dialog box.
4. Change the protocol setting from HTTPS to HTTP in the Session Recording Policy Console:
   1. Log on to the server where the Session Recording Policy Console is installed.
   2. From the Start menu, choose Session Recording Policy Console.
   3. Choose HTTP from the Protocol drop-down list and choose OK to connect. If the connection is successful, this setting is remembered the next time you start the Session Recording Policy Console.

To revert to HTTPS as the communication protocol

1. Log on to the computer hosting the Session Recording Server and enable secure connections for the Session Recording Broker in IIS.
2. Change the protocol setting from HTTP to HTTPS in each Session Recording Agent Properties dialog box:
   1. Log on to each server where the Session Recording Agent is installed.
   2. From the Start menu, choose Session Recording Agent Properties.
   3. In Session Recording Agent Properties, choose the Connections tab.
   4. In the Session Recording Broker area, select HTTPS from the Protocol drop-down list and choose OK to accept the change. If you are prompted to restart the service, choose Yes.
3. Change the protocol setting from HTTP to HTTPS in the Session Recording Player settings:
   1. Log on to each workstation where the Session Recording Player is installed.
   2. From the Start menu, choose Session Recording Player.
   3. From the Session Recording Player menu bar, choose Tools > Options > Connections, select the server, and choose Modify.
   4. Select HTTPS from the Protocol drop-down list and click OK twice to accept the change and exit the dialog box.
4. Change the protocol setting from HTTP to HTTPS in the Session Recording Policy Console:
   1. Log on to the server where the Session Recording Policy Console is installed.
   2. From the Start menu, choose Session Recording Policy Console.
3. Choose HTTPS from the Protocol drop-down list and choose OK to connect. If the connection is successful, this setting is remembered the next time you start the Session Recording Policy Console.
Reference: Manage your database records

Feb 03, 2015

The ICA Log database (ICLDB) utility is a database command-line utility used to manipulate the session recording database records. This utility is installed during the Session Recording installation in the drive:\Program Files\Citrix\SessionRecording\Server\Bin directory at the server hosting the Session Recording Server software.

Quick reference chart

The following table lists the commands and options that are available for the ICLDB utility. Type the commands using the following format:


<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>archive</td>
<td>Archives the session recording files older than the retention period specified. Use this command to archive files.</td>
</tr>
<tr>
<td>dormant</td>
<td>Displays or counts the session recording files that are considered dormant. Dormant files are session recordings that were not completed due to data loss. Use this command to verify if you suspect that you are losing data. You can verify if the session recording files are becoming dormant for the entire database, or only recordings made within the specified number of days, hours, or minutes.</td>
</tr>
<tr>
<td>import</td>
<td>Imports session recording files into the Session Recording database. Use this command to rebuild the database if you lose database records. Additionally, use this command to merge databases (if you have two databases, you can import the files from one of the databases).</td>
</tr>
<tr>
<td>locate</td>
<td>Locates and displays the full path to a session recording file using the file ID as the criteria. Use this command when you are looking for the storage location of a session recording file. It is also one way to verify if the database is up-to-date with a specific file.</td>
</tr>
<tr>
<td>remove</td>
<td>Removes the references to session recording files from the database. Use this command (with caution) to clean up the database. Specify the retention period to be used as the criteria. You can also remove the associated physical file.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>removeall</td>
<td>Removes all of the references to session recording files from the Session Recording Database and returns the database to its original state. The actual physical files are not deleted; however you cannot search for these files in the Session Recording Player. Use this command (with caution) to clean up the database. Deleted references can be reversed only by restoring from your backup.</td>
</tr>
<tr>
<td>version</td>
<td>Displays the Session Recording Database schema version.</td>
</tr>
<tr>
<td>/l</td>
<td>Logs the results and errors to the Windows event log.</td>
</tr>
<tr>
<td>/f</td>
<td>Forces the command to run without prompts.</td>
</tr>
<tr>
<td>/s</td>
<td>Suppresses the copyright message.</td>
</tr>
<tr>
<td>/?</td>
<td>Displays help for the commands.</td>
</tr>
</tbody>
</table>
Session Recording may include third party software components licensed under the following terms. This list was generated using third party software as of the date listed. This list may change with specific versions of the product and may not be complete; it is provided “As-is.” TO THE EXTENT PERMITTED BY APPLICABLE LAW, CITRIX AND ITS SUPPLIERS MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE, WITH REGARD TO THE LIST OR ITS ACCURACY OR COMPLETENESS, OR WITH RESPECT TO ANY RESULTS TO BE OBTAINED FROM USE OR DISTRIBUTION OF THE LIST. BY USING OR DISTRIBUTING THE LIST, YOU AGREE THAT IN NO EVENT SHALL CITRIX BE HELD LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY OTHER DAMAGES WHATSOEVER RESULTING FROM ANY USE OR DISTRIBUTION OF THIS LIST.

MMC .NET Library

Licensed under the Common Public License, Version 1.0
### Authentication

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Response Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymize Authentication</td>
<td>Disabled</td>
<td>HTTP 401 Challenge</td>
</tr>
<tr>
<td>ASP.NET Impersonation</td>
<td>Disabled</td>
<td>HTTP 401 Challenge</td>
</tr>
<tr>
<td>Basic Authentication</td>
<td>Disabled</td>
<td>HTTP 302 Login/Redirect</td>
</tr>
<tr>
<td>Forms Authentication</td>
<td>Enabled</td>
<td>HTTP 302 Login/Redirect</td>
</tr>
<tr>
<td>Windows Authentication</td>
<td>Enabled</td>
<td>HTTP 401 Challenge</td>
</tr>
</tbody>
</table>
Service.AutoDiscoveryAddresses = SiteAController,SiteBController
Service.AutoDiscoveryAddressesXA = FarmAController,FarmBController

DirectorConfig.exe /xenapp FarmControllerName

UI.TaskManager.EnableApplications = false
Get-Item WSMAN:\localhost\Client\TrustedHosts

Set-Item WSMAN:\localhost\Client\TrustedHosts -Value "<FQDN SCOM Management Server>,<Old Values>"

C:\inetpub\wwwroot\Director\tools\DirectorConfig.exe /configscom
winrm set winrm/config/winrs @
{MaxConcurrentUsers = "20"}
Set-Item WSMan:\localhost\Shell\MaxConcurrentUsers 20

winrm set winrm/config/winrs @{MaxShellsPerUser="20"}

Set-Item WSMan:\localhost\Shell\MaxShellsPerUser 20

winrm set winrm/config/winrs @{MaxMemoryPerShellMB="1024"}

Set-Item WSMan:\localhost\Shell\MaxMemoryPerShellMB 1024
Service.Connector.WinRM.Identity = Service

ConfigRemoteMgmt.exe /configwinrmuser domain\name

ConfigRemoteMgmt.exe /configwinrmuser domain\HelpDeskUsers

ConfigRemoteMgmt.exe /configwinrmuser domain\DirectorServer$

ConfigRemoteMgmt.exe /configwinrmuser domain\name /all

ConfigRemoteMgmt.exe /configwinrmuser domain\HelpDeskUsers /all
ConfigRemoteMgmt.exe
SDks and APIs

Oct 22, 2015
Several SDKs and APIs are available with this release.

**XenApp and XenDesktop SDK:** The XenApp and XenDesktop SDK is based on a number of Microsoft Windows PowerShell version 3.0 snap-ins that allow you to perform the same tasks as you would with the Citrix Studio console as well as tasks you cannot do with Studio alone.

For more information, see [Citrix Developer](https://docs.citrix.com).

**Citrix Group Policy SDK:** The Citrix Group Policy SDK allows you to display and configure Group Policy settings and filters. It uses a PowerShell provider to create a virtual drive that corresponds to the machine and user settings and filters. The provider appears as an extension to New-PSDrive. To use the Group Policy SDK, either Studio or the XenApp and XenDesktop SDK must be installed. See the Group Policy SDK section below for more information.

**Monitor Service OData API:** You can use the Monitor Service OData API to:

- Analyze historical trends for future planning
- Perform detailed troubleshooting of connection and machine failures
- Extract information for feeding into other tools and processes; for example, using Microsoft Excel's PowerPivot tables to display the data in different ways
- Build a custom user interface on top of the data that the API provides

For details, see the Monitor Service OData API articles.

### XenApp and XenDesktop SDK

Beginning with version 7.x, XenApp and XenDesktop share a unified architecture and management: the FlexCast Management Architecture. This means that XenApp provides many features previously only available in XenDesktop; elements of the SDK that relate to common features therefore apply equally to both XenApp and XenDesktop, even though the commands themselves refer only to XenDesktop.

### Differences between the XenDesktop 5 and XenDesktop 7 SDKs

If you are familiar with the XenDesktop 5 SDK, the following list summarizes the differences in 7.x versions of the XenApp and XenDesktop SDK.

- **New high-level SDK** — XenDesktop 7 provides a new high-level SDK that enables you to script and automate site creation and maintenance quickly and easily. The high-level SDK insulates you from much of the complexity of the low-level SDKs, so you can create a new Site simply by running two cmdlets.

- **New low-level SDKs** — Individual low-level SDKs are provided for the new XenDesktop 7 services, including a dedicated and enhanced SDK for the Delegated Administration Service (DAS), which was previously part of the Broker SDK in XenDesktop 5. There are also SDKs for new features including the Monitor Service, Environment Test, and Configuration Logging.

- **Windows Server OS Machine Catalogs and Delivery Groups** — You can use the XenDesktop 7 SDK to deliver cost-effective applications and desktops hosted on server operating systems.

- **Desktop OS Machine applications** — Desktop OS Machine applications have changed significantly at the SDK level. If
you have existing scripts for running applications on Desktop OSs, you will have to update these scripts for XenDesktop 7, because there is little backwards compatibility.

- **Apply settings to machines in Delivery Groups** — In XenDesktop 7, using configuration slots, you can apply settings to machines in a specific delivery group, rather than to all machines in a site. This enables you to configure, for a given delivery group, which settings apply to that group. A number of pre-defined configuration slots are provided that contain different types of settings, such as settings for StoreFront addresses for use with Receiver or App-V publishing server locations. You can use one collection of settings from a slot to affect only a particular delivery group, and a different collection of settings from the same slot to affect another delivery group. You can use names appropriate to your particular deployment; for example, "Sales Department policy."

- **Catalog types replaced** — In XenDesktop 7, catalog types have been replaced by catalogs with individual properties. However, for backwards compatibility, you can still use existing scripts that employ catalog types, such as single image (pooled) and thin clone (dedicated) etc., but internally these are converted into sets of properties.

  **Caution:** Backwards compatibility with XenDesktop 5 catalog types has been maintained where possible and practicable. However, when writing new scripts, do not use catalog types; instead, specify catalogs with individual properties.

- **Desktop object replaced** — In XenDesktop 5, the Desktop object is one of the main types of SDK object used in Broker SDK scripts. The Desktop object describes both the machine and the session on the machine. In XenDesktop 7, this object is replaced by the Session object and the Machine object, both of which have been expanded to do the work of the Desktop object. However, for backwards compatibility, you can still use existing scripts that employ the Desktop object.

  **Caution:** Backwards compatibility with XenDesktop 5 has been maintained where possible and practicable. However, when writing new scripts, do not use the Desktop object; instead, specify Session and Machine objects.

**Differences in policy rules**

There are differences between the SDK and the Studio console in terms of policy rules. Entitlement and assignment policy rules are independent entities in the SDK; in the console, these entities are not visible as they are seamlessly merged with the Delivery Group. Also, access policy rules are less restrictive in the SDK.

**Use the SDK**

The SDK comprises of a number of PowerShell snap-ins installed automatically by the installation wizard when you install the Delivery Controller or Studio component.

Permissions: You must run the shell or script using an identity that has Citrix administration rights. Although members of the local administrators group on the Controller automatically have full administrative privileges to allow XenApp or XenDesktop to be installed, Citrix recommends that for normal operation, you create Citrix administrators with the appropriate rights, rather than use the local administrators account. If you are running Windows Server 2008 R2, you must run the shell or script as a Citrix administrator, and not as a member of the local administrators group.

To access and run the cmdlets:

1. Start a shell in PowerShell 3.0: Open Studio, select the **PowerShell** tab, and then click **Launch PowerShell**.
2. To use SDK cmdlets within scripts, set the execution policy in PowerShell. For more information about PowerShell execution policy, see the Microsoft documentation.
3. Add the snap-ins you require into the PowerShell environment using the **Add -PSSnapin** cmdlet in the Windows PowerShell console.

V1 and V2 denote the version of the snap-in (XenDesktop 5 snap-ins are version 1; XenDesktop 7 snap-ins are version
2. For example, to install XenDesktop 7 snap-ins, type `Add-PSSnapin Citrix.ADIdentity.Admin.V2`. To import all the cmdlets, type: `Add-PSSnapin Citrix.*.Admin.V*`

After adding the snap-ins, you can access the cmdlets and their associated help.

**Group Policy SDK**

To use the Group Policy SDK, either Studio or the XenApp and XenDesktop SDK must be installed.

To add the Group Policy SDK, type `Add-PSSnapin citrix.common.grouppolicy`. (To access help, type: `help New-PSDrive -path localgpo:`)

To create a virtual drive and load it with settings, type: `New-PSDrive <Standard Parameters> [-PSPProvider] CitrixGroupPolicy -Controller <string>` where the Controller string is the fully qualified domain name of a Controller in the Site you want to connect to and load settings from.
In addition to using the Citrix Director console to display historical data, you can query data using the Monitor Service's API. You can use the API to:

- Analyze historical trends for future planning
- Perform detailed troubleshooting of connection and machine failures
- Extract information for feeding into other tools and processes; for example, using Microsoft Excel's PowerPivot tables to display the data in different ways
- Build a custom user interface on top of the data that the API provides

The Monitor Service API uses the Open Data (OData) protocol, which is a Web protocol for querying and updating data, built upon Web technologies such as HTTP. For more information about the OData protocol, see: http://www.odata.org.

The Monitor Service API is built on top of SQL Server databases using Windows Communication Foundation (WCF) Data Services that are populated during processing and consolidation. Two endpoints are exposed using WCF with vsHttpBinding. The base address is: http:// {dc-host}/Citrix/Monitor/OData/v2. You can also use TLS to secure endpoints; see Securing endpoints using TLS for more information.

1. The Data endpoint exposes read-only access directly to the database entities and can be accessed using the OData query language. This endpoint allows highly flexible access in terms of filtering and column selection. The Data API URI is: http://{dc-host}/Citrix/Monitor/OData/v2/Data. For more information about accessing the Monitor Service data, see Accessing data using the API.

2. The Methods endpoint exposes service operations that are used by Citrix Director to retrieve data that requires complex grouping and high performance standards, such as queries on the Dashboard and Trends pages. The Methods API URI is: http://{dc-host}/Citrix/Monitor/OData/v2/Methods. Methods are used only in Director itself so are not used by the majority of Citrix customers. They are therefore not documented here.

What's new in this release?

The version of the API included with XenApp and XenDesktop 7.6 provides the following new features:

- **Hotfix inventory.** Using the User Details view or Machine view in Director, you can see a list of all the Citrix hotfixes that have been installed on a machine. You can use the API to extract this data and create custom reports (for example, the state of installed hotfixes over an entire site) or pull it into an analytics engine. New classes have been introduced and the Machine class has been extended to support tracking Citrix hotfixes installed on the controller and VDAs.
- **Anonymous session troubleshooting.** Sessions can be run as a set of pooled local user accounts. The API has a new IsAnonymous property for the Session class (default value FALSE).
- **Hosted application usage reporting.** Director provides new capacity reports that show the usage of hosted applications over time. The API allows you to report on the details of each application instance running in a user session.

All the updates to data are fully documented in the API Reference at http://support.citrix.com/help/monitorserviceapi/7.6/.

The GetSessionSummary method has been deprecated at this release.
Accessing data using the API

Sep 29, 2014

The following types of data are available through the Monitor Service API:

- Data relating to connection failures
- Machines in a failure state
- Session usage
- Logon duration
- Load balancing data
- Hotfixes applied to a machine
- Hosted application usage


To use the Monitor Service OData API, you must be a XenApp or XenDesktop administrator. To call the API, you require read-only privileges; however, the data returned is determined by XenApp or XenDesktop administrator roles and permissions. For example, Delivery Group Administrators can call the Monitor Service API but the data they can obtain is controlled by Delivery Group access set up using Citrix Studio. For more information about XenApp or XenDesktop administrator roles and permissions, see [Delegated Administration](#).

**Querying the data**

The Monitor Service API is a REST-based API that can be accessed using an OData consumer. OData consumers are applications that consume data exposed using the OData protocol. OData consumers vary in sophistication from simple web browsers to custom applications that can take advantage of all the features of the OData Protocol. For more information about OData consumers, see: [http://www.odata.org/ecosystem#consumers](http://www.odata.org/ecosystem#consumers).

Every part of the Monitor Service data model is accessible and can be filtered on the URL. OData provides a query language in the URL format you can use to retrieve entries from a service. For more information, see: [http://msdn.microsoft.com/en-us/library/ff478141.aspx](http://msdn.microsoft.com/en-us/library/ff478141.aspx).

The query is processed on the server side and can be filtered further using the OData protocol on the client side.

The data modeled falls into three categories: aggregate data (the summary tables), current state of objects (machines, sessions, etc), and log data, which is really historical events (connections, for example).

Note: Enums are not supported in the OData protocol; integers are used in their place. To determine the values returned by the Monitor Service OData API, see [http://support.citrix.com/help/monitorserviceapi/7.6/](http://support.citrix.com/help/monitorserviceapi/7.6/).

**Aggregation of data values**

The Monitor Service collects a variety of data, including user session usage, user logon performance details, session load balancing details, and connection and machine failure information. Data is aggregated differently depending on its category. Understanding the aggregation of data values presented using the OData Method APIs is critical to interpreting the data. For example:

- Connected Sessions and Machine Failures occur over a period of time, therefore they are exposed as maximums over a time period.
- LogOn Duration is a measure of length of time, therefore is exposed as an average over a time period.
- LogOn Count and Connection Failures are counts of occurrences over a period of time, therefore are exposed as sums over a time period.

**Concurrent data evaluation**

Sessions must be overlapping to be considered concurrent. However, when the time interval is 1 minute, all sessions in that minute (whether or not they overlap) are considered concurrent: the size of the interval is so small that the performance overhead involved in calculating the precision is not worth the value added. If the sessions occur in the same hour, but not in the same minute, they are not considered to overlap.

**Correlation of summary tables with raw data**

The data model represents metrics in two different ways:
- The summary tables represent aggregate views of the metrics in per minute, hour, and day time granularities.
- The raw data represents individual events or current state tracked in the session, connection, application and other objects.

When attempting to correlate data across API calls or within the data model itself, it is important to understand the following concepts and limitations:

- **No summary data for partial intervals.** Metrics summaries are designed to meet the needs of historical trends over long periods of time. These metrics are aggregated into the summary table for complete intervals. There will be no summary data for a partial interval at the beginning (oldest available data) of the data collection nor at the end. When viewing aggregations of a day (Interval=1440), this means that the first and most recent incomplete days will have no data. Although raw data may exist for those partial intervals, it will never be summarized. You can determine the earliest and latest aggregate interval for a particular data granularity by pulling the min and max SummaryDate from a particular summary table. The SummaryDate column represents the start of the interval. The Granularity column represents the length of the interval for the aggregate data.
- **Correlating by time.** Metrics are aggregated into the summary table for complete intervals as described above. They can be used for historical trends, but raw events may be more current in the state than what has been summarized for trend analysis. Any time-based comparison of summary to raw data needs to take into account that there will be no summary data for partial intervals that may occur or for the beginning and ending of the time period.
- **Missed and latent events.** Metrics that are aggregated into the summary table may be slightly inaccurate if events are missed or latent to the aggregation period. Although the Monitor Service attempts to maintain an accurate current state, it does not go back in time to recompute aggregation in the summary tables for missed or latent events.
- **Connection High Availability.** During connection HA there will be gaps in the summary data counts of current connections, but the session instances will still be running in the raw data.
- **Data retention periods.** Data in the summary tables is retained on a different grooming schedule from the schedule for raw event data. Data may be missing because it has been groomed away from summary or raw tables. Retention periods may also differ for different granularities of summary data. Lower granularity data (minutes) is groomed more quickly than higher granularity data (days). If data is missing from one granularity due to grooming, it may be found in a higher granularity. Since the API calls only return the specific granularity requested, receiving no data for one granularity does not mean the data doesn't exist for a higher granularity for the same time period.
- **Time zones.** Metrics are stored with UTC time stamps. Summary tables are aggregated on hourly time zone boundaries. For time zones that don't fall on hourly boundaries, there may be some discrepancy as to where data is aggregated.

**Data granularity and retention**
The granularity of aggregated data retrieved by Director is a function of the time (T) span requested. The rules are as follows:
- \(0 < T \leq 1\) hour uses per-minute granularity
- \(0 < T \leq 30\) days uses per-hour granularity
- \(T > 31\) days uses per-day granularity

Requested data that does not come from aggregated data comes from the raw Session and Connection information. This data tends to grow fast, and therefore has its own grooming setting. Grooming ensures that only relevant data is kept long term. This ensures better performance while maintaining the granularity required for reporting. For customers who are not licensed to use the Platinum edition, grooming begins at day 8 regardless of the default grooming retention. Platinum customers can change the grooming retention to their desired number of retention days, otherwise the default is used.

The following settings are used to control grooming:

<table>
<thead>
<tr>
<th>Setting name</th>
<th>Affected grooming</th>
<th>Default value (days)</th>
<th>Accessed using</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroomSessionsRetentionDays</td>
<td>Session and SessionDetail records</td>
<td>7 for non-Platinum users, 90 for Platinum</td>
<td>Cmdlet (set/get-monitorconfiguration)</td>
</tr>
<tr>
<td>GroomSummariesRetentionDays</td>
<td>DesktopGroupSummary, FailureLogSummary and LoadIndexSummary records. Aggregated data - daily granularity.</td>
<td>7 for non-Platinum users, 90 for Platinum</td>
<td>Cmdlet (set/get-monitorconfiguration)</td>
</tr>
<tr>
<td>GroomHourlyRetentionDays</td>
<td>Aggregated data - hourly granularity</td>
<td>32 days</td>
<td>Monitor.Configuration Database Table. See note below.</td>
</tr>
<tr>
<td>GroomMinuteRetentionDays</td>
<td>Aggregated data - minute granularity</td>
<td>3 days</td>
<td>Monitor.Configuration Database Table. See note below.</td>
</tr>
<tr>
<td>GroomFailuresRetentionDays</td>
<td>MachineFailureLog and ConnectionFailureLog records</td>
<td>7 for non-Platinum users, 90 for Platinum</td>
<td>Cmdlet (set/get-monitorconfiguration)</td>
</tr>
<tr>
<td>GroomLoadIndexesRetentionDays</td>
<td>LoadIndex records</td>
<td>7 for non-</td>
<td>Cmdlet (set/get-monitorconfiguration)</td>
</tr>
<tr>
<td>Setting name</td>
<td>Affected grooming</td>
<td>Platinum users</td>
<td>90 for Platinum</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>GroomDeletedRetentionDays</td>
<td>Machine, Catalog, DesktopGroup and Hypervisor entities that have a LifecycleState of 'Deleted'. This will also delete any related Session, SessionDetail, Summary, Failure or LoadIndex records.</td>
<td>7 for non-Platinum users, 90 for Platinum</td>
<td></td>
</tr>
<tr>
<td>GroomMachineHotfixHistoryRetentionDays</td>
<td>Hotfixes applied to the VDA and Controller machines</td>
<td>90 for both non-Platinum and Platinum users</td>
<td></td>
</tr>
</tbody>
</table>

Caution: Modifying values on the Monitor Service database requires restarting the service for the new values to take effect. You are advised to make changes to the Monitor Service database only under the direction of Citrix Support.

Retaining data for long periods will have the following implications on table sizes:

- **Hourly data.** If hourly data is allowed to stay in the database for up to two years, a site of 1000 delivery groups could cause the database to grow as follows:
  
  1000 delivery groups x 24 hours/day x 365 days/year x 2 years = 17,520,000 rows of data. The performance impact of such a large amount of data in the aggregation tables is significant. Given that the dashboard data is drawn from this table, the requirements on the database server may be large. Excessively large amounts of data may have a dramatic impact on performance.

- **Session and event data.** This is the data that is collected every time a session is started and a connection/reconnection is made. For a large site (100K users), this data will grow very fast. For example, two years worth of these tables would gather more than a TB of data, requiring a high-end enterprise-level database.
Securing endpoints using TLS

This document explains how to use TLS to secure the Monitor Service OData API endpoints. If you choose to use TLS, you must configure TLS on all Delivery Controllers in the site; you cannot use a mixture of TLS and non-TLS.

To secure Monitor Service endpoints using TLS, you must perform the following configuration. Some steps need to be done only once per site, others must be run from every machine hosting the Monitor Service in the site. The steps are described below.

Part 1: Certificate registration with the system

1. Create a certificate using a trusted certificate manager. The certificate must be associated with the port on the machine that you wish to use for OData TLS.

2. Configure the Monitor Service to use this port for TLS communication. The steps depend on your environment and how this works with certificates. The following example shows how to configure port 449:

   - Associate the certificate with a port:
     ```
     netsh http add sslcert ipport=0.0.0.0:449 certhash=97bb629e50d556c80528f4991721ad4f28fb74e9 appid='{00000000-0000-0000-0000-000000000000}'
     ```
     Tip: In a PowerShell command window, ensure you put single quotes around the GUID in the appID, as shown above, or the command will not work. Note that a line break has been added to this example for readability only.

Part 2: Modify the Monitor Service configuration settings

1. From any Delivery Controller in the site, run the following PowerShell commands once. This removes the Monitor Service registration with the Configuration Service.

   ```
   asnp citrix.*
   $serviceGroup = get-configregisteredserviceinstance -servicetype Monitor | Select -First 1 ServiceGroupUid
   remove-configserviceGroup -ServiceGroupUid $serviceGroup.ServiceGroupUid
   ```

2. Do the following on all Controllers in the site:
   - Using a cmd prompt, locate the installed Citrix Monitor directory (typically in C:\Program Files\Citrix\Monitor\Service).
     Within that directory run:
     ```
     Citrix.Monitor.Exe -CONFIGUREFIREWALL -ODataPort 449 -RequireODataSsl
     ```
   - Run the following PowerShell commands:
     ```
     asnp citrix.* (if not already run within this window)
     get-MonitorServiceInstance | register-ConfigServiceInstance
     Get-ConfigRegisteredServiceInstance -ServiceType Config | Reset-MonitorServiceGroupMembership
     ```
Examples

Sep 24, 2014

The following examples show how to export Monitor Service data using the OData API.

Example 1 - Raw XML

1. Place the URL for each data set into a web browser that is running with the appropriate administrative permissions for the XenApp or XenDesktop Site. Citrix recommends using the Chrome browser with the Advanced Rest Client add-in.
2. View the source.

Example 2 - PowerPivot with Excel

These instructions assume that you have already installed Microsoft Excel and PowerPivot.

Open Excel (running with the appropriate administrative permissions for the XenApp or XenDesktop Site).

If you are using Excel 2010:

1. Click the PowerPivot tab.
2. Click PowerPivot Window.
3. Click From Data Feeds in the ribbon.
4. Choose a Friendly Connection Name (for example: XenDesktop Monitoring Data) and enter the data feed url: http://{dc-host}/Citrix/Monitor/OData/v2/Data (or https: if you are using TLS).
5. Click Next.
6. Select the tables you want to import into Excel and click Finish. The data is retrieved.
7. You can now use PowerPivot to view and analyze the data with PivotTables and PivotCharts. For more information, see the Learning Center: http://www.microsoft.com/en-us/bi/LearningCenter.aspx

If you are using Excel 2013:

1. Click the Data tab.
2. Choose From Other Sources > From OData Data Feed
3. Enter the data feed url: http://{dc-host}/Citrix/Monitor/OData/v1/Data (or https: if you are using TLS) and click Next.
4. Select the tables you want to import into Excel and click Next.
5. Accept name defaults or customize names and click Finish.
6. Choose Connection Only or Pivot Report. The data is retrieved.
7. You can now use PowerPivot to view and analyze the data with PivotTables and PivotCharts. For more information, see the Learning Center: http://www.microsoft.com/en-us/bi/LearningCenter.aspx

Example 3 - LINQPad

These instructions assume that you have already installed LINQPad.

1. Run LINQPad with the appropriate administrative permissions for the XenApp or XenDesktop Site.
   - Tip: the easiest way is to download, install and run on the Delivery Controller.
2. Click the Add connection link.
3. Choose WCF Data Services 5.1 (OData 3) and click Next.
4. Enter the data feed URL: http://{dc-host}/Citrix/Monitor/OData/v2/Data (or https: if you are using TLS). If necessary, enter the username and password to access the Delivery Controller. Click OK.
5. You can now run LINQ queries against the data feed and export the data as needed. For example, right-click Catalogs and choose `Catalogs.Take(100)`. This returns the first 100 Catalogs in the database. Choose Export>Export to Excel with formatting.

For further worked examples of how to use the API with LINQPad, see http://blogs.citrix.com/2014/01/14/creating-director-custom-reports-for-monitoring-xendesktop/.